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INTRODUCTION 

Welcome to the fascinating world of SAP. This book helps you crack the tricks of mastering SAP HANA 

Customization 
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 Conditions and Flows 

 Conditions and Flows 

Use 

In this section, you make the basic settings for linking to financial accounting. The following settings are 

mandatory: 

Definition of condition . types and conditon groups Definition 

of flow types. 

Assignment of reference . flow types 

Specification of distribution . formulas and calculation formulas 

Secification of condition . purposes 

 Calculation and Distribution Formulas 

 Calculation Formulas 

Use 

In this section, you create (external) calculation formulas that are based on internal calculation 

formulas. These formulas are used for determining the condition amount. The system determines the 

condition amount using the following parameters: 

- The unit price of the condition 

- A maximum of two parameters. The values for these are entered either in the calculation formula 

defined here, or you enter them on the condition. 

- The internal calculation formula that specifies how the calculation is made 

You specify how the unit price and the condition amount are rounded using the rounding type. 



 

 

Requirements 

Internal calculation formulas are provided by SAP in the standard system and are fixed.They each need an 

external calculation formula, which you have to create and assign in this activity. The following internal 

calculation formulas are available: 

- Calculation Formula : Fixed Amount 

- Calculation Formula : Area - Calculation Formula : Each 

- Calculation Formula : Object Measurement 

- Calculation Formula : % Share of Condition 

- Calculation Formula : Sales-Based Rent 

- Calculation Formula : % Share of Source Condition (External Condition) 

- Calculation Formula : Rental Object Condition 

- Calculation Formula : Factor - Condition Group 

- Calculation Formula : Differing Measurement 

- Calculation Formula : Amount/Object 

- Calculation Formula : Amount/Occupancy Status 

- Calculation Formula : Amount/Tenant Changeover 

- Calculation Formula : % Share of Condition Group 

- Calculation Formula : Sales-Based Rent Modifiable 

- Calculation Formula : Immediate Billing for Room Usage 

- Calculation Formula : Periodic Billing for Room Usage 

- Calculation Formula : Fixed Amount - Possession Dates 

- Calculation Formula : BAdI Calculation 

Note 

Calculation formulas , , , and  are implemented in the same way as the methods of the 

RECD_CALC_RULE BAdI. If you want to implement your own calculation methods that are similar to 

one of the methods described, you can use the implementation of one of these methods as a template. 

Standard settings 

SAP provides at least one external calculation formula for each internal calculation formula. 

Recommendation 

Delete calculation formulas that are not needed. 



 

 

For frequently used formulas (such as Calculation Based on Space), create calculation formulas with 

parameters that cannot be changed in the application. If needed, create your own condition types (such as 

Basic Rent per Square Foot), in which the calculation formula is entered as a default. 

Activities 

You can change external calculation formulas by: 

- Renaming them 

- Making more specific entries for them. This means you can, for example, define the external 

formulas, Retail space in sq. feet and Office space in sq. feet, which are both based on the internal 

formula Space. 

If you want to define additional external calculation formulas, choose New Entries. Or copy an entry that is 

already assigned to the internal calculation formula you need, and use it as a template. 

1. Enter a unique ID in the Calculation Formula field. Enter a short, medium and long name for the 

formula. 

2. In the Internal Formula field, select the internal calculation formula you want. Confirm your entry. 

After that, the fields for the allowed parameters of the formula are available for input. 

3. The internal calculation formula also determines if distribution is made as in the calculation, or if 

you have to assign a distribution formula to the external calculation formula. In that case, the 

External Distribution field becomes available for input after you confirm your entries (choose 

Enter). 

Example:Internal calculation formula 'Fixed Amount:' one common condition amount is specified 

for all calculation objects of the object group. Distribution of the condition amount to the objects 

therefore has to be defined by assigning a distribution formula. In Customizing, enter the value for 

these formulas that you would like to use for distribution. For example, choose distribution using a 

total measurement type (such as Residential/Usable Space) that is entered or derived on all of the 

objects. 

Other calculation formulas (for instance measurement or condition of rental object) calculate the 

condition amount by adding individual amounts from each calculation object. These kinds of 

calculation formulas do not need their own distribution formulas. If you want to assign a different 

distribution formula for them anyway, set the Distribution Formula Independent of Calculation 

Formula indicator. 

 Distribution Formulas 

Use 



 

 

In this section, you create external distribution formulas that are based on internal distribution formulas. 

Requirements 

The following distribution formulas are provided in standard Customizing: 

- Distribution Formula: Divided Equally 

- Distribution Formula: Area/Object Measurement/Differing Measurement 

- Distribution Formula: By Object 

To ensure correct reporting for cost and revenue planning, you have to make sure that all costs and revenue 

on a contract that can be assigned to objects are actually posted to these objects. 

If an object is directly assigned to a condition, then all costs and revenue can be posted directly to the 

object when there is a posting. 

However, a direct transfer is not possible if: 

- No object assignment was made, so that the system is not able to recognize the object to be posted 

- The condition is linked to an object group, so that multiple objects could be affected by the transfer 

In these cases, distribution formulas define how the object or objects to be posted are found, and how the 

costs or revenue are distributed proportionally to these objects. 

The resulting amounts then appear in the object cash flow of the contract, and are posted during periodic 

posting for the contract. 

For example, for customer lease-outs: 

Partner-related cash flow: 

Debit: Customer 

               Credit: Revenue ( Contract ) Object cash 

flow: 

Debit: Revenue Clearing ( Contract ) 

               Credit: Revenue (distribution object) 

Activities 

For distribution formulas, the possible activities are 

Renaming . 

Making more specific .entries. This means you can, for example, define the formulas, Retail space in sq. feet 

and Office space in sq. feet, both of which are based on the internal distribution 

formula Area. 

If you want to define additional distribution formulas, choose New Entries. 

Enter a unique ID in the External Formula field. Enter a short, medium and long name for the formula. 

In the Internal Formula field, select the internal distribution formula you want. Choose the object type for 

distribution and posting. 



 

 

Save your entries. 

 Implement Enhancements ( BAdI ) 

 Calculation Formula for Conditions 

Use 

Using this Business Add-In (BAdI) you can determine the time-dependent calculation factors that are 

multiplied with the unit price. 

Implementation of this Business Add-In (BAdI) is mandatory for each external calculation formula that is 

defined in Customizing (under Calculation Formulas) on the basis of internal calculation formula  ( = 

BAdI calculation). 

You can process all user-specific calculation formulas within the same Business Add-In implementation. 

This means that you do not have to create a separate implementation of the BAdI for each calculation 

formula. 

Activities 

1. Create a BAdI implementation that contains the following methods: 

- GET_ATTRIBUTES - GET_PARAMETER 

- GET_UNITS 

- GET_VALUES 

- GET_FLEXIBLE 

Each method contains the ID_CALCRULEEXT parameter, which is used to control the 

implementation (dependent on the formula). 

2. Activate the BAdI implementation. 

Method description 

- GET_ATTRIBUTES 

The method returns the following attributes: 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @A@ CF_DISTRIBUTE: Defines whether or not the calculation can be distributed 

- @A@ CF_ADJUSTABLE: Defines whether or not the condition can be adjusted 

- @A@ CF_UNITPRICE_HIDE: Defines whether or not the unit price can be hidden 

- @A@ CF_DEPEND_CONDITION: Defines whether or not the calculation is dependent on 

conditions 



 

 

- @A@ CF_DEPEND_OBJECT: Defines whether or not the calculation is dependent on object 

data 

- @A@ CF_UNIQUE_VALUES: Defines whether or not the calculation returns one-time 

amounts 

- @A@ CF_UNIQUE_VALUES_MULTI: Defines whether or not the calculation returns multiple 

one-time amounts 

- @A@ CD_INFO_IDENT: Defines the help text ID 

- @A@ CD_GUI_FM_PARA_PBO: Defines the PBO function module for maintenance of 

formula parameters 

- @A@ CD_GUI_FM_PARA_PAI: Defines the PAI function module for maintenance of formula 

parameters 

Using the CD_GUI_FM_PARA_PBO and CD_GUI_FM_PARA_PAI parameters, you can link 

to a special interface for maintaining formula parameters. The function groups 

RECD_GUI_CALC_RULE_ and RECD_GUI_CALC_RULE_ serve as examples for this. 

- GET_PARAMETER 

The method returns the following parameters: 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @@ ID_PARA_NO: Defines the number of the parameter 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CT_PARA_VALUES: Defines the list of parameter values ( F ) 

- @A@ CD_PARA_INFO: Defines the description of the parameter 

- @A@ CF_PARA_CHECK: Defines whether or not a standard check of the parameter is 

performed 

- GET_UNITS 

The method returns the following units: 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CD_UNIT_UNITPRICE: Defines the unit of the unit price 

- @A@ CD_UNIT_CALCVALUE: Defines the unit of the calculation factor 

- GET_VALUES 

The method returns the following calculation factors: 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 



 

 

- @@ ID_PARA_: Defines parameter  - @@ ID_PARA_: Defines parameter  

- @@ ID_ABS_FROM: Defines the absolute start of the calculation 

- @@ ID_ABS_TO: Defines the absolute end of the calculation 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @@ IT_OBJECT_CONTRACT: Defines the contract object 

- @@ IT_OBJECT_CONDITION: Defines the condition objects 

- @A@ CT_CALC_VALUES: Defines the time-dependent calculation factors 

- @A@ CT_ DIST_VALUES: Defines the time-dependent distribution factors 

- @A@ CT_CALC_USED_OBJECTS: Defines the objects that are considered by the 

calculation 

- @A@ CT_DIST_USED_OBJECTS: Defines the objects that are considered by the distribution 

- GET_FLEXIBLE 

The method returns the following flexible values: 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CF_FLEXIBLE: Defines whether or not the formula supports flexible intervals 

- @A@ CD_FLEXIBLE_FROM: Defines the start date of the flexible interval 

- @A@ CD_FLEXIBLE_TO: Defines the end date of the flexible interval 

Using this method, you can define a condition so that it is valid beyond the term of the object. 

Dependent on the actual condition object, the table of condition objects is structured as follows: 

- The condition object is a concrete object. 

The table of condition objects contains the concrete object. 

- The condition object is an object group. 

The table of condition objects contains the object group and the objects in the object group. 

- The condition object is the contract. 

The table of condition objects is identical to the table of contract objects. 

Note the following: 



 

 

- Do not directly access the database (SELECT statements) on tables where the data could be being 

processed. Use only the API_RE_xx_GET_DETAIL function module for data retrieval. (Here xx 

stands for the English abbreviation for the object type, for instance CN for the real estate 

contract.) 

- Do not use statements that execute actions on the interface, for example, MESSAGE without 

RAISING, CALL SCREEN and so on. Also, do not use COMMIT WORK or ROLLBACK 

WORK. 

Example 

SAP provides the external calculation formulas that are based on these internal calculation formulas:  

(amount per object),  (amount per rental object status),  ( amount per tenant changeover) and  

(% share of condition group). You implement these external calculation formulas in the following 

classes: 

- CL_RECD_CALC_RULE_ - CL_RECD_CALC_RULE_ -

 CL_RECD_CALC_RULE_ 

- CL_RECD_CALC_RULE_ 

These classes have the same structure as a corresponding BAdI implementation for the BAdI definition 

RECD_CALC_RULE. They can serve as a guide for the implementation of your own formulas. 

Notes for Developers 

 Distribution Formula for Conditions 

Use 

Using this Business Add-In (BAdI) you can determine a time-dependent distribution for a calculation. 

Implementation of this Business Add-In (BAdI) is mandatory for each external distribution formula that is 

defined in Customizing (under Distribution Formulas) on the basis of internal distribution formula  ( = 

BAdI distribution). 

You can process all customer-specific distribution formulas you need in the same Business Add-In 

implementation. This means that you do not have to create a separate implementation of the BAdI for 

each formula. 

Activities 

. Implement the BAdI and define the following methods: 

- GET_ATTRIBUTES - GET_PARAMETER 



 

 

- GET_UNIT 

- GET_VALUES 

- GET_FLEXIBLE 

Each method contains the ID_DISTRULEEXT parameter, which is used to control the implementation 

(dependent on the formula). 

. Activate the BAdI implementation. 

Method description 

- GET_ATTRIBUTES 

The method returns the following attributes: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @A@ CF_DEPEND_OBJECT: Defines whether or not the distribution is dependent on object 

data 

- @A@ CD_INFO_IDENT: Defines the help text ID 

- @A@ CD_GUI_FM_PARA_PBO: Defines the PBO function module for maintenance of 

formula parameters 

- @A@ CD_GUI_FM_PARA_PAI: Defines the PAI function module for maintenance of formula 

parameters 

Using the CD_GUI_FM_PARA_PBO and CD_GUI_FM_PARA_PAI parameters, you can link to a 

special interface for maintaining formula parameters. The function group 

RECD_GUI_DIST_RULE_ serves as an example for this. 

- GET_PARAMETER 

The method returns the following parameter values: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @@ ID_PARA_NO: Defines the number of the parameter 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CT_PARA_VALUES: Defines the list of parameter values (input help) - @A@ 

CD_PARA_INFO: Defines the description of the parameter 

- @A@ CF_PARA_CHECK: Defines whether or not the standard check of the parameter is 

performed 

- GET_UNIT 

The method returns the following units: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @@ IO_OBJECT: Defines the object that has the condition 



 

 

- @@ IS_CONDITION: Defines the condition 

- @A@ CD_UNIT_DISTVALUE: Defines the unit of the distribution factor 

- GET_VALUES 

The method returns the following calculation factors: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @@ ID_PARA_: Defines parameter  - @@ ID_PARA_: Defines parameter  

- @@ ID_ABS_FROM: Defines the absolute start of the calculation 

- @@ ID_ABS_TO: Defines the absolute end of the calculation 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @@ IT_OBJECT_CONTRACT: Defines the contract objects 

- @@ IT_OBJECT_CONDITION: Defines the condition objects 

- @@ IT_OBJECT_DISTRIBUTION: Defines the distribution objects 

- @A@ CT_ DIST_VALUES: Defines the time-dependent distribution factors 

- @A@ CT_DIST_USED_OBJECTS: Defines the objects that are considered by the distribution 

Dependent on the actual condition object, the table of condition objects is structured as follows: 

- If the condition object is a concrete object, then the table contains the concrete object. 

- If the condition object is an object group, then the table of condition objects contains the object 

group and the objects in the object group. 

- If the condition object is the contract, then the table is identical to the table of contract objects. 

- GET_FLEXIBLE 

This method returns the following flexible values: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CF_FLEXIBLE: Defines whether or not the formula supports flexible intervals 

- @A@ CD_FLEXIBLE_FROM: Defines the start date of the flexible interval 

- @A@ CD_FLEXIBLE_TO: Defines the end date of the flexible interval 

Using this method, you can define a condition so that it is allowed to be valid beyond the term of the 

object. 

Note the following: 



 

 

- Do not directly access the database (SELECT statements) on tables where the data could be being 

processed. Use only the API_RE_xx_GET_DETAIL function module for data retrieval. (Here xx 

stands for the English abbreviation for the object type, for instance CN for the real estate 

contract.) 

- Do not use statements that execute actions on the interface, for example, MESSAGE without 

RAISING, CALL SCREEN and so on. Also, do not use COMMIT WORK or ROLLBACK 

WORK. 

Example 

The distribution formula based on internal formula  (Aggregation), which is provided by SAP, is 

implemented in the class CL_RECD_DIST_RULE_. 

This class has the same structure as a corresponding BAdI implementation for the BAdI 

definition RECD_DIST_RULE. Therefore, you can use the class as a guide for the 

implementation of your own formulas. Notes for Developers 

 Condition Types and Condition Groups 

 Define Condition Types 

Use 

In this section, you specify condition types for your contracts. 

Requirements 

You created the necessary flow types in the Flow Types IMG activity. 

Activities 

Check if the existing condition types are sufficient for your enterprise. For more detailed information on the 

condition types, double click on the condition type. 

If you need additional condition types, then create them by choosing New Entries (or @U@): 

1. Assign the following default values to the condition types as needed: 

- Unit price 

Example: Fees or surcharges that are the same for most contracts (condition type Security deposit 

as  times basic rent) 

- Calculation formula 

You create calculation formulas in the Calculation Formulas IMG activity. 



 

 

- Distribution formula 

You create distribution formulas in the Distribution Formulas IMG activity. 

2. Assign a flow type to each condition type. 

3. Assign the necessary attributes to the condition types for service charge settlement and for sales-based 

rent settlement, for example: 

- Advance payment attribute - AP Service Charges/Operating Costs condition type 

- AP Sales-Based Rent attribute  - AP Sales-Based Rent condition type 

@S@ You use the attribute to specify how these condition types are treated during certain 

processes. For example, you can assign a sales rule only to conditions that have an attribute that 

allows this. 

If no attribute is assigned then, for example, the advance payment for sales-based rent is posted 

regularly, but it is not settled during sales-based rent settlement. 

Set the Revenue indicator for advance payments for operating costs or for sales-based rent, if you 

want them to be posted as revenue. 

@S@ Remember that the settings you make here have to agree with the account determination 

(Condition Type -> Flow Type -> Account Symbol -> Account): 

- Indicator is set ('X')  -> Account Determination: 

 Customer Receivable Credit:   revenue 

- Indicator is not set (' ') 

-> Account Determination: 

 J Customer Advance Payment Credit:  K Customer Adv.Payment Made 

@A@ The system does not check for agreement! However, the periodic posting is incorrect if this 

indicator does not agree with the account determination. 

If you want to delete a condition type, first check in the Define Condition Groups and Assign Condition 

Types IMG activity if it has dependent entries. Delete these entries if there are any. Then delete the entries 

in this table. 

 Define Condition Purpose 

Use 

In this step you specify, based on the internal condition purposes, how and if the condition is considered 

during periodic posting. 

Requirements 

The following internal condition purposes are predefined in standard Customizing: 

- Statistical (is not posted, but can be used as a reference for calculations or as a comparison value) 

- One-Time Statistical 



 

 

- One-Time Posting 

- Posted 

Activities 

You can perform the following for the internal condition purposes: 

Rename . 

Specify more details .for them, that is, for example, you can assign the 

ZK>Vacancy Rent and Market Rent external condition purposes to the Statistical 

internal purpose. This combination can be useful for rental object conditions, for 

instance. 

The assignment of an external condition purpose to a condition has to be made in the application. In the 

contract, you can use the same condition type with different condition purposes. 

Setting the CtrP (contract purpose) indicator means that the condition purpose (for example, actual rent) is 

valid for contract conditions. 

Set the Def. (default) indicator, if you want the condition purpose to appear in the contract as a default 

value. 

Set the ROPp (rental object purpose) indicator, if you want the condition purpose (for example, market rent) 

to be valid for rental object conditions. 

Set the RODf (rental object default) indicator, if you want the condition purpose to appear in the rental 

object as a default value. 

Set the TrPp (transfer purpose) indicator if you want the condition with this condition purpose to appear 

for selection in the contract when you choose @D@ Proposed conditions. 

 Condition Groups 

 Define Condition Groups and Assign Condition Types 

Use 

In this step you define condition groups condition groups and assign condition types to them. 

@S@ Condition groups are mandatory. The only condition types available in the contract or rental object 

(dependent on the contract or usage type) are those that you have assigned to the given condition group for 

the object type. 

You also need condition groups if you want to use proposed conditions. In this case, the condition groups 

define the condition types for which automatic values should be proposed (Define Proposed Conditions). 

You may: 



 

 

a) Use the same condition groups that you assign to usage types of rental objects or contract types 

b) Define other condition groups 

Before the condition types can be adopted, the system automatically compares the resulting condition types 

with the condition types that are actually allowed on the object. 

You can also use condition groups to show totals for multiple condition types in one column in reporting. To 

do so, you assign a condition group to a report profile using a condition profile. You should also define 

special condition groups for reporting, such as, net rent before service charges, or advance payments for 

operating costs. 

Requirements 

You have specified the condition types you need in the Condition Types IMG activity. 

Activities 

Check the existing condition . groups. 

Create additional condition . groups if you need them, and define which condition types are allowed in 

which condition groups. You can add condition types to a condition group at any time. 

However, you are not allowed to remove condition types if they were already used in 

rental objects or contracts of the usage type or contract type. 

.Assign condition groups in the Assign Condition Group to Rental Object per Usage Type step 

and the Assign Condition Group to Contract per Contract Type step. 

Keep in mind that you no longer distinguish between condition types for flat rates and advance payments 

using the condition group (as was the case in Classic RE). Instead you make this distinction in the attribute 

of the condition type. 

Example 

You create a condition group for vendor contracts (commercial) with conditions that generate postings to the 

vendor account (for example, basic office rent, basic warehouse rent, advance payment for operating costs, 

advance payment for heating costs, and so on). 

Note 

You can also use condition groups when you define report profiles; see Configure Condition Profiles. 

If you want to calculate surcharges fro the settlement result from the service charge settlement, which you 

relate to basic rent, you can also work with condition groups. For more information, see Define Calculation 

of Surcharges. 



 

 

 Assign Condition Group to Contract per Contract Type 

Use 

In this step, you assign the condition groups, which you created for contract conditions, to contract types. 

 You define contract types in the Contract Type IMG activity. 

 Assign Condition Group to Rental Object per Usage Type 

Use 

In this step, you assign condition groups, which you created for rental object conditions, to usage types of 

rental objects. 

 You specify the usage types for rental objects in Customizing in the Usage Types step. 

 Flow Types 

 Define Flow Types 

Use 

In this section, you define flow types. This is a prerequisite for creating condition types and for account 

determination. Flow types classify flows in: 

a) The cash flow 

b) Accounting 

With certain transactions, postings cannot be made using the flow type that was originally assigned (the 

flow type derived from the condition type). For these transactions, you have to assign reference flow types 

using a relationship key in the Assign Reference Flow Types IMG activity. 

Standard settings 



 

 

Standard Customizing contains all flow types for the condition types provided in the standard system. The 

first two numbers of the flow type key are the same as those of the condition type it belongs to. Flow 

types that are directly assigned to condition types have a number ending with "." Reference flow types, 

however, have a number ending with same two figures depending on the type of relationship. It is 

advisable to use the same or a similar type of logic for flow types you define yourself. 

Activities 

- Create unique keys for flows that are for posting and for statistical flows, or copy the flow types you 

want use from standard Customizing. For each condition type that you want to be able to post, you 

have to enter a flow type. You then have to link this flow type with the condition type in the Assign 

Flow Type to Condition Type IMG activity. It is possible that you might need additional reference 

flow types for a flow type (for example, for credit memos, receivables, own usage, vacancy, 

settlement of service charges). You also have to create these reference flow types here. Enter a name 

for each flow type. 

- For each flow type, specify if it is debit or a credit posting. For contracts that post to subledger 

accounts (customer or vendor account, contract account), you have to set the debit/credit indicator 

according to which side the posting to the subledger account is made on. 

- If you want cash flow amounts for this flow type to be updated in cash management, then set the 

Relevant to CM indicator. 

- If you want the system to calculate accruals and/or deferrals for cash flow items with this flow type, 

then enter the accrual type for accruals and deferrals. 

- In the Summarization Flow Type column, enter the flow type that you want the system to use for 

document summarization during periodic posting (rather than the original flow type). 

Example 

 Assign Reference Flow Types 

Use 

In this step, you assign reference flow types to flow types. 

Definition 

With certain business transactions, postings cannot be made using the flow type that was originally 

assigned (the flow type derived from the condition type). For such transactions, reference flow types must 

be assigned in this activity using a relationship key. 

- Example of a Relationship Key 

-  Follow-Up Postings Due to Condition Increase 



 

 

You use this reference flow type when rent receivables are increased retroactively (that is, after a 

debit position posting). Flow types that are referenced by the reference flow type can be the basic 

flow types (that are assigned directly to a condition type) or can be flow types for own use and 

vacancy. 

-  Follow-Up Postings Due to Condition Reduction 

You use this reference flow type when rent receivables are reduced retroactively (that is, after the 

debit position posting). Flow types that are referenced by the reference flow type can be the basic 

flow types (that are assigned directly to a condition type) or can be flow types for own use and 

vacancy. The reference flow type usually consists of the reversed account determination (whereby the 

debit and credit postings are transposed) of the account determination in the original flow type. 

-  Distribution Postings (Object Transfers) 

In the real estate contract, the periodic posting function generates a primary posting on the basis of 

the condition type. In the case of vendor contracts, this posting debits costs to the contract and 

credits payables, while in the case of customer contracts it debits receivables and credits 

revenue (contract). If it is specified in the contract that the costs are to be distributed to the objects 

(this should normally be the case to enable the costs and revenues on the objects to be seen in 

Controlling), a reference flow type determined via relationship key  has to be specified for the costs 

to be transferred to the objects. For vendor contracts, the transfer posting debits costs (object) and 

credits cost allocation (contract) and for customer contracts, it debits revenue allocation 

(contract) and credits revenue (object). 

-  Own Use 

The reference flow type for this relationship key is used when the cash flow is generated from a 

contract with contract type Internal Contract. 

Caution: 

All flow types for condition types that are to be used on internal contracts require a reference flow 

type here. Otherwise you cannot activate the contract. 

Specify a G/L account posting for account determination. For reference flow types assigned to these 

with relationship keys  Follow-Up Postings Due to Condition Increase and   Follow-Up Postings Due 

to Condition Reduction, you also need to specify reference flow types with relationship key  Own 

Use. 

-  Vacancy 

The reference flow type is used for the vacancy debit position of the rental objects ( only for the time 

during which there is no active occupancy contract for the rental object). 

Caution: 

Vacancy flows are only generated and posted for condition types if a reference flow is defined here for 

the corresponding flow type. 

By defining vacancy flow types, you can control whether a condition type on the rental object is for 

information purposes only (default value for the contract) or whether vacancy postings are to be made 

for this condition type. 

Specify a G/L account posting for account determination. For flow types assigned to these with 

relationship keys  Follow-Up Postings Due to Condition Increase and  Follow-Up Postings Due to 

Condition Reduction, you also have to enter reference flow types with relationship key  Vacancy. 



 

 

- For information about the reference flow types for service charge settlement ( relationship key in the 

range  - ), see Reference Flow Types for Service Charge Settlement. 

-  Installment Payment 

You use this reference flow type to post an installment payment for an item posted with RE-FX. The 

posting specification is debit customer, credit customer.The open item originally posted is cleared. 

To define an installment payment for items that were posted to a customer account without a flow 

type, specify a reference flow type with this relationship type for the empty flow type. 

-   Irrecoverable Debt 

You use this reference flow type to write off an item posted with RE-FX (because no more 

payments are expected on the receivable, for example). The posting specification is debit costs, 

credit customer. The open item originally posted is cleared. 

To be able to write off items that were posted to a customer account without a flow type, you specify a 

reference flow type with this relationship type for the empty flow type. 

Reference Flow Types for Balance Sheet Valuation of Rental Contracts/Leases 

You use the functions for balance sheet valuation for leases. In this case, you require reference flow types 

for the following relationship keys based on the flow types specified in the valuation rules: 

- CE Posted Initial Costs or CE Statistical Initial Costs 

Initial costs can be modeled as a one-time condition directly using the rental contract/lease. They 

are managed as statistical conditions or as posting conditions depending on whether they are used 

as input only in the balance sheet valuation or whether they are also posted as vendor payables 

using the periodic posting for the contract. The initial costs are reflected in the present value of the 

leased asset in both cases. 

To post the payment, the Payment Flow Type from the Customizing for valuation rules is used for the 

lease installment payments to be paid periodically. However, for postings for initial costs, the reference 

flow types specified here are used. 

- CE Positive Liability Difference and CE Negative Liability Difference 

Note the information for the Payment Flow Type field in Customizing for valuation rules. 

- CE Negative Linearization 

Note the information for the 

Linearization Flow Type field in Customizing for the valuation rules. 

- CE Direct Balance Sheet Posting 

You want to post the valuation postings directly to the general ledger rather than to the asset 

subledger. To do this, specify reference flow types for which account determination does not point to 

assets, but directly to general ledger accounts. 

Note the information for the Integration Type field in Customizing for valuation rules. 



 

 

 Assign Flow Type to Condition Type 

Use 

You can assign defined flow types to the condition type. 

Assign the flow types that you want to be used for periodic posting for external contracts. The system 

derives all other flow types from the reference flow types. 

Requirements 

First define flow types in Customizing. 

Activities 

In addition to assigning flow types, you can make other settings here for Condition Types. 

 Conditions in Foreign Currency 

 Conditions in Foreign Currency 

Use 

You need to make settings here if you want to have conditions on contracts, rental objects, or contract offers 

that are in a currency that differs from the local currency of the company code. 

Requirements 

To be able to use a different currency in a company code, you have to set the Differing Condition 

Currency indicator for that company code in the Make Basic Settings in Company Code IMG activity. 

Activities 

For the system to be able to properly handle conditions in a foreign currency, you have to answer the 

following questions for the conditions of the contract, rental object, or contract offer: 

- What is the currency of the condition amount? 



 

 

You can enter the currency directly when processing conditions (if the setting for differing condition 

currencies was activated in the basic settings of the company code). 

- Which exchange rate is used for calculating the amount in your local currency? 

The user assigns a currency translation rule when processing the posting term (see the Define 

Currency Translation Rule IMG activity). The rule is then used for all conditions to which this 

posting term is assigned. The currency translation rule defines the following: 

- Which translation date rule is used? 

The translation date rule defines, dependent on the process, how the currency translation date is 

determined. 

- Which exchange rate type is used? 

- Should documents that result from the posting term have the condition currency as the transaction 

currency? 

(If the indicator is not set, then the currency of the condition is used only to calculate the posting 

amount. However, the document is posted in the local currency.) 

If you need conditions in a foreign currency, then define currency translation rules and translation date 

rules. 

Specify which currency translation rules are allowed for each contract type and each usage type. Also 

specify one currency translation rule as a default. 

 Activate Conditions in Foreign Currency per Company Code 

Use 

To be able to define conditions with different currencies in a company code, you have to set the Differing 

Condition Currency indicator for the company code. 

Activities 

Set this indicator for the company codes in which you want to define conditions in foreign currencies. 

You can then enter a currency translation rule on your posting terms. If you normally create foreign 

currency conditions in one particular currency, then enter that currency in the Currency field. The 

system then proposes this currency for all conditions that have a currency translation rule. 

 Specification of Translation Date 

 Define Translation Date Shift Rule 

Use 



 

 

The translation date shift rule defines how the system determines a translation date on the basis of a 

starting date that was entered. 

You have to define translation date shift rules if the following applies: You use conditions in a foreign 

currency, and you do not want the system to use a fixed date for the currency translation; instead the date 

entered should only serve as the starting date for determining the translation date. 

Example 

You have defined conditions with currency EUR in a company code with local currency USD. The 

exchange rate from dollars (USD) to euros (EUR) is entered daily in the exchange rate table. You run 

periodic posting on a monthly basis at the end of each month (with the posting date as the first day of the 

next month). For periodic posting, you want the system to use the exchange rate that was valid two days 

before the end of the month, that is on the third to the last day of the previous month. 

In that case, you define a translation date shift rule, such as BEG-. You have to set up this rule so that it 

initially shifts the entered date to the first of the month, and then moves it three days backward. 

You then assign this translation date shift rule to the process REPP - Periodic Posting in the translation 

date rule. You use the posting date (PSTNGDATE) as the base date for the translation. Set the error 

response to Error. 

Activities 

- To create a translation date shift rule, choose New Entries. Enter a name (you assign this later in 

the currency translation rule) and a description. 

- On the detail screen for the translation date shift rule, specify how the starting date is shifted. You 

have the following options: 

- Shift in Relation to Period  

You can specify here that the date is shifted to the beginning or end of the week, month, quarter, 

or year in which the starting date lies. 

- Shift by Days, Months, Years 

You can specify here that the starting date is shifted by n days + n months + n years. If you want 

the resulting date to be before the starting date (as is common for currency translation), then n, n, 

and n must be negative numbers. 

- Shift in Relation to Calendar 

You can specify here that the shift is made in relation to a public holiday calendar. Specify to 

what number working day the date should be shifted, and enter a calendar that can be used to 

determine the working days. 

- You can use the No. field to specify the sequence in which the system performs the translation for 

these three group boxes. Enter a different number in each of the group boxes where you made 

entries. 

Example 



 

 

1. For translation date shift rule BEG- (two days before month end), which was described above, 

you make the following settings: 

- Shift in Relation to Period No.  

Shift To: First Day of Period 

Move By:  Month 

- Shift by Days, Months, Years 

No.  

Move (+/-) By: Days: -, Months: , Years:  

- Shift in Relation to Calendar No.  

Leave all fields blank. 

2. If you do not want to shift to the third to last calendar day of the previous month, but instead to 

the third to last working day of the previous month, then make the following entries: 

- Shift in Relation to Period No.  

Shift To: First Day of Period 

Move By:  Month 

- Shift by Days, Months, Years 

No.  Move (+/-) By: Days: -, Months: , Years:  

- Shift in Relation to Calendar No.  

Move to nth (+/-): 

Number: - 

Unit: Working day 

Calendar: <appropriate calendar for your location> 

In contrast to the calculation without considering a public holiday calendar, the date is not 

shifted by n days, but instead is shifted to the nth day. Therefore the entry number  is necessary 

in this example, in order to first shift to the last day of the previous month. 

 Specify Calculation of Translation Date Based on Process 

Use 

The translation date rule specifies, dependent on the process, the date that is used for the currency 

translation. You assign the translation date rule to the currency translation rule. 

Standard settings 

Currency translation rule DEFAULT is already defined in standard Customizing. This rule calculates all 

exchange rates related to the cash flow using the posting date or due date. For all processes that are not  

related to the cash flow, the system uses the current date for the translation (that is, the most recent available 

exchange rate). 

Activities 



 

 

Choose New Entries to create a new translation date rule. Enter a meaningful name and a short description. 

- Select the rule you created. In the navigation area on the left side of the screen, choose Process-

Dependent Determination of Date. Choose New Entries . Choose the input help for the Process 

field to see the processes for which you can make settings. 

The input help shows all processes for which currency translation might be necessary. For example: 

You want to generally use the current exchange rate and do not want the system to issue an error 

message if this is not yet entered in the system. In that case, it is sufficient to make a setting for the 

process DEFAULT . The system then always uses it as long as there is not other specific setting for 

the current process. For a description of the different processes in the system related to currency 

translation, see the process documentation. 

In some cases you may want to have the system determine the translation date for a given process 

differently for simulations than in update mode. In those cases you have make two entries in this 

table for the same translation process. Set the Simulation indicator for one of the entries but not for 

the other. For some processes, it is not helpful to make this distinction between simulation and 

update runs. The process documentation contains information on which processes these are. The 

basic distinction is as follows: 

- A process that does not write any data that is dependent on the exchange rate to the database, 

reads the exchange rate for the simulation. 

- A process that saves data gets the exchange rate for update mode (simulation indicator is not set). 

If you execute a simulation run for a process, for which there is both an update run and a simulation 

run, then the system first tries to determine the exchange rate using the date rule set up for the 

update run. Only if this is not possible (exchange rate does not exist on date and the error response 

is set to Error), then the system reads the exchange rate for the simulation run. If there are no 

settings for a simulation run for the particular process, then the system uses the settings for the 

DEFAULT  process with the simulation indicator set. For this reason, you should only make a 

setting for simulation that differs from the setting for the update run, if the error response for the 

update run is set to Error. 

- The translation base date is the date that serves as the basis for determining the exchange rate. 

You enter a character string here that represents the date. The dates that are allowed depend on 

the process. The following dates, for example, can be used for the calculation when the cash flow 

is generated: 

- Due date 

- Start date of period 

- End date of period 

- Today's date 

For service charge settlement, on the other hand, the following dates can be used: 

- Document date 

- Posting date 

- Due date 

- Today's date 

To see which date fields are available, use the input help. 



 

 

For the default process, you always have to use the current date (today's date). 

- Specify how the system should respond when an error occurs. For all processes that run in 

simulation mode, enter Warning or Accept. For all other processes, enter Error, if you want to 

make sure that the currency translation is made using the exchange rate of a particular date. Enter 

Warning or Accept, if you also want to allow the use of the last exchange rate before the day 

determined. 

- In the Number of Days field, specify how old the exchange rate is allowed to be. 

- Using the translation date shift rule, you can set up a more complex rule for calculating the date 

on which the exchange rate is read. The translation base date is the basis for this calculation. 

 Currency Translation 

 Define Currency Translation Rule 

Use 

You define currency translation rules here. 

In processing for the posting term (in the application), the user specifies the currency translation rule to be 

used. The rule is then used for all conditions to which this posting term is assigned. 

Activities 

Specify the following for the currency translation rule: 

- Which translation date rule is used? 

The translation date rule defines, dependent on the process, how the currency translation date is 

determined. 

- Which exchange rate type is used? 

- Should documents that result from the posting term have the condition currency as the transaction 

currency? 

(If the indicator is not set, then the currency of the condition is used only to calculate the posting 

amount. However, the document is posted in the local currency.) 



 

 

 Use of Translation Rule 

 Specify Possible Currency Translation Rules per Contract Type 

Use 

Here you specify the contract types for which currency translation rules are allowed. 

Activities 

For all contract types, for which you want to allow setting up conditions in foreign currency, enter the 

possible currency translation rules. For each contract type, designate one rule as the default currency 

translation rule. 

Use caution if you use currency translation rules that are for posting in the foreign currency, as well as 

those that are for posting in the local currency. In this case, make sure that the currency translation rules 

are assigned correctly. For example, it is advisable to allow posting only in the foreign currency for 

vendor contracts (if the vendor invoices you in the foreign currency), 

 Specify Allowed Currency Translation Rules per Usage Type 

Use 

Here you specify the usage types for which currency translation rules are allowed. 

Activities 

For all usage types, for which you want to allow setting up conditions in foreign currency, enter the 

possible currency translation rules. For each usage type, designate one rule as the default currency 

translation rule. 

Note that for rental objects, postings are always made in the local currency. Therefore, it is not logical to 

allow currency translation rules here that allow posting in a foreign currency. 

 Default Conditions 

 Define Default Conditions 

Use 



 

 

In this step, you define condition types per condition group for default conditions. 

Activities 

You can use condition . groups that were already created (in the Create Condition 

Groups and Assign Condition Types IMG activity), or you can create new condition 

groups. 

.Create default conditions for the condition groups by specifying condition types per condition 

purpose. You define condition purposes in the Condition Purpose IMG activity. Using the One-Time Cond. 

indicator, you specify if condition amounts are only posted once, or if they recur periodically. If you do not want 

the condition to be considered during periodic posting, set the Stat.Condit. (statistical condition) indicator. Define 

calculation formulas.  and distribution formulas. 

 Define Derivation Steps 

Use 

The derivation of a condition group can take place in multiple steps. You have to define a rule for each of 

these steps. The system processes these rules in the sequence in which they are listed in the overview 

dialog. As soon as a condition group and condition purpose can be determined, the derivation ends. That 

is, the following steps are not processed. For this reason, you should define object-specific processing 

steps at the beginning, with the subsequent steps becoming more general. 

For example, you can specify that the condition group of a rental object be found in the first step using 

object-specific characteristics, such as the usage type and the business entity. For objects with a usage type 

that cannot be captured by this rule, you then define an another derivation step that is less specific and uses 

the business entity, for example, to determine a condition group. 

Activities 

To create additional derivation steps, choose @I@ Display <-> Change in the initial screen. 

Choose @Y@ Create Step to define a new step. In the Create Step dialog box, choose Derivation rule. 

You can enter up to six source fields. The system maps the selected source fields to target fields. The 

target fields are predefined and specify the condition group as well as the condition purpose. 

Example: Derivation by Usage Type and Contract Type 

You want to define the company code, business entity usage type and contract type fields as source fields. 



 

 

Save, and choose @W@ Maintain Rule Values to define rule values for the derivation step. Enter the 

value range (for which you want the derivation to be made) for the source fields. In the Condition Group 

and Condition Purpose columns, you enter the condition group and condition purpose you want to be 

derived. 

Example 

For rental objects of company code  with usage type  (Store), which are assigned to a contract with contract 

type CO (Commercial lease-out), you want the conditions of condition group DC to be assigned (these 

correspond to condition purpose Market rent). 

Define the following rule: 

CoCd BE  to  BE                Usage Type Contract Type Assigned Group  Condition Purpose 

                                   CO              @G@ DC         Market rent 

 Calculation of Periods and Due Dates 

 Due Date Correction Rule 

Use 

The due dates for a condition are specified by the frequency term. Here you first specify how due dates 

fall in relation to the calculation period by entering the payment form (due at the start, middle, or end of 

the period). 

In order to reflect more complex methods for determining the due date (for example, always due on rd 

business day of month), you can relate the frequency term to a due date correction rule. 

Here you can define these more complex rules for determining due dates. Keep in mind that the 

specifications you make here always apply in relation to the due date determined by the payment form. 

On the contract, you can still manually change both the due date itself in the cash flow, as well as the 

parameters of the due date correction rule defined here (with the exception of the parameters for due 

dates of follow-up postings). It is therefore not necessary to enter rules in Customizing for absolute 

exceptions. 

The due date in the cash flow is transferred to Financial Accounting. This date controls payment and 

dunning processes for accounts payable and accounts receivable processes. During periodic posting, 

the items to be posted can be selected either by due date or by calculation date. 

Standard settings 



 

 

SAP provides an empty rule. This rule corresponds to the way due dates were determined in Classic RE and 

in RE-FX up to and including Release . 

Activities 

Define the due date correction rule that should be used as the standard for most contracts, and give this rule 

the key " " (default setting). Subsequent changes you make in Customizing are applicable only when they 

affect due dates for follow-up postings, and only when there is a contract or rental object with follow-up 

posting items that are not yet posted. 

Define the following parameters for your due date correction rules: 

Due Date Correction 

First specify how the due date should be corrected (moved). You have two basic options. First, you can 

shift the originally calculated due date by a given number of days, months and/or years. The shift can be 

forward (" - " sign) or backward (no positive/negative sign). Second, you can specify that the due date is 

always a given weekday (for example, "rd Monday," together with a monthly frequency and "in advance" 

payment form would mean the rent is always due on the third Monday in the month) or you can specify 

that it is the nth business day. If you use a business day, then you also have to enter the calendar that is 

used to determine what days are business days. 

In the No. field in front of the due date correction rule, you can specify the sequence in which the due dates 

determined by the payment form are corrected. 

Example: 

A three-month rent should be due on the rd business day of the rd month. You define the 

following rule: 

No.  Move (+/-) By      Days 

                         Months      

                         Years 

No.  Move (+/-) To     Working Day 

                         Calendar USA  

In the frequency term of the contract, you choose  months as the frequency, and the payment form "in 

advance." 

On the other hand, if you agreed that rent is due on the rd business day of the month, and you give the 

tenant two months in which to pay, then you should set the rule as follows: 

No.  Move (+/-) By      Days 

                         Months      

                         Years 

No.  Move (+/-) To     Working Day 

                         Calendar USA  

The rule only appears in maintenance of the frequency rule if you entered a number here. The system 

displays the rules in the contract in ascending order based on the number entered here. It can be usefulto 

enter a number but leave the parameter empty, if you want to define the correction on the contract. 



 

 

Behavior of Due Dates at Start and End 

If you do not make any entries here, then the system uses the due date determined by the rules defined 

above, even if the contract starts or ends in the middle of a period. The result could be that rent due in 

advance would then be due before the start date of the contract. You can prevent this by setting the 

appropriate indicator here. The due date is then moved to the start date or the end date of the contract as 

specified. 

Due Dates for Follow-Up Postings 

Follow-up postings are created when data relevant to the cash flow (values affecting determination of the 

condition amount, or data of the frequency term) is changed, and the change affects calculation periods 

that were already posted. 

If the due date relates to payments, then it is usually not possible to calculate it using the "normal" rule 

for follow-up postings, since the tenant is usually not informed of the change until after the due date 

determined in this way. 

For credit memos and receivables, you can decide separately how the due date is calculated. 

The options are: 

Due Date: Due Date As in Source Flow 

The due date is determined according to the rule that is already set. SAP recommends that you set the 

"Move to Current Date" indicator, at least for follow-up postings. The result is that the due date is moved 

to the current date (the system date at the time of the change) if the due date is before this date. 

Due Date As Entered 

When follow-up postings result from a change to the contract, the system asks in the application dialog 

when these should be due. For all follow-up postings that are due before the date determined by the set rule, 

the system moves the due dates to this date. 

Move +/- Days 

Here you can specify that the due date determined in this way for follow-up postings is moved forward or 

backward by this number of days. 

You can make separate settings for follow-up postings from the object cash flow and from the partner-

related cash flow. If your object transfers are always synchronous with periodic posting of payments, 

then SAP recommends setting the "As Partnr-Rel.CashFlow" (as partner-related cash flow) indicator. 

Otherwise, it can make sense to leave the due dates originally determined in the object cash flow as they 

are. (This makes the cash flow easier to understand, and the due date is irrelevant from an accounting 

perspective in the object cash flow.) 

 Handling of Partner Changes 

Use 

Using the due date correction rule, you can influence how partner changes are handled. 



 

 

 Define Fixed Periods (For Example, Quarter Days) 

Use 

Here you can specify that an annual rent is divided into equal portions, although the periods themselves 

are of unequal length. This procedure is standard in certain countries (for example, the use of quarter days 

in the United Kingdom). 

If you do not define any Fixed Periods here, then this field does not appear when you process the frequency 

term in the rental object or contract master data. In this way, you can avoid incorrect entries in this field. 

Activities 

If you need fixed periods, then proceed as follows to define these periods: 

- First enter the name you want to use for the fixed periods in the Fixed Periods table. (This name is 

used as a reference in the contract or rental object.) 

- Select an entry in the table and choose Periods of Fixed Period in the dialog structure. 

- In the table that appears, you need an entry for each period into which the year is divided up. For 

each period, you specify the following: 

- The number of the periods (each entry has to be numbered sequentially starting with ) 

- The day and the month on which the (next) period begins. (The first period in the table is, in this 

sense, the next period for the last period in the table.) - Specify one period that is used for 

recording any rounding differences. 

Example 

The following documentation describes the functions of fixed periods and contains a sample calculation. 

Fixed Periods 

In Customizing you can specify how a calendar year can be split into periods for calculating the cash 

flow. Each possible split into periods is given a key. In the frequency term of the contract or rental object 

you can then refer to this key and specify that the annual amount should be split into equal partial 

amounts for these periods (which can have varying lengths). 

Example: 

The following periods are specified for the key Fixed Periods: QUARTER_UK (quarter days): 

No.    Day    Month    Rounding Difference 

1                    x 

2         



 

 

3         

4               

These periods are used as a basis for generating the cash flow. The annual amount is divided by the 

number of periods and the same amount is calculated for each (full) period. Rounding differences are 

added to the correspondingly flagged period (exactly one), for example the first period. 

For example, if an amount of  EUR is agreed as the condition amount per year, this would result in a 

period amount of  Euro in our example. The following cash flow is generated: 

.... 

Calc. from        Calc. to                Amount 

... 

//        //               

//        //               

//        //               

//        //               ...  

If fixed periods are used, the following applies: 

- The same amount is paid in each full period. 

- The amount is calculated by dividing the annual condition amount by the number of periods defined in 

Customizing. 

- Exactly one period can be flagged in Customizing to which any rounding differences are added. If no 

period has been flagged, the rounding differences are not taken into account. The total of all the 

amounts from each period may be slightly higher or lower than the annual condition amount. 

- The due date(*) is calculated on the basis of the total period. If periods are split, the due date remains 

the same 

Example: 

Total period: // through // and in advance => Due date // Split on // due to increased condition 

amount: 

// through // => Due date // 

// through // => Due date // 

Possible calculation methods for the pro rata calculation of amounts are period-specific and by year. 

With a period-specific calculation, the period amount is divided by the number of days in the period 

and multiplied by the number of days in the partial period. For the calculation by year, the 

calculation of the partial period is based on the annual amount. This is divided by  (or  in a leap 

year) and multiplied by the number of days in the period. If the partial periods are not completely in 

a leap year, two partial amounts are calculated: 

Example 

Calculation method by year. On / the annual condition amount was increased from  EUR to  EUR: 

Period (X): // through // =>  /  *  =  



 

 

Period (X+): // through // 

This period (X+) is split internally for the pro rata calculation: 

// through // =>  /  *  = ... 

// through // =>  /  * ( +  +  ) = ... The total for period (X+) is . 

- If a date is entered in the  user-selected start field, the rounding difference will be added to the 

period which is set in Customizing as relative to this date. 

Example 

In Customizing, period  (/ through /) is flagged as the Period for Rounding Differences. The start of the 

period is set as //. The rounding difference will be added to the period containing /. In  this would be 

the period // through // 

(*) The due date is determined in accordance with the payment form and the due date correction rule. 

The due date correction rule specifies how the date determined from the payment form (in advance, mid-

period, in arrears) is moved.  In addition you can specify whether or not the due dates should be moved at 

the start or end of a contract or rental object to the start or end. 

 Templates for Terms 

 Define Templates for Frequency Terms 

Use 

In this Customizing activity, you can define templates that you can use to create frequency terms in real 

estate contracts, real estate offers, or rental objects. The templates defined here override the conditions 

predefined by SAP for the term category frequency. 

Activities 

1. Enter a unique, alphanumeric name for the new template. You use this name in the Customizing 

activity Assign Frequency Term Templates. 

2. Enter a name for the template. If you want to create a frequency term for a real estate contract, real 

estate offer, or rental object, you see this name when you select the template. Exception: If, in the 

Customizing activity Assign Frequency Term Templates, you assign just one template for the 

combination of object type and differentiation criterion or make just one assignment at object type 

level, the assigned template is used automatically to create the term and selection is not required. 

The name of the template is used as the name for the new term. 

3. Enter the frequency and select the remaining properties. 

You can also select a due date. You define the due date in the Customizing activity Due Date 

Correction Rule. 

4. Assign the template to an object type (Customizing activity Assign Frequency Term Templates). 



 

 

 Assign Frequency Term Templates 

Use 

In this Customizing activity, you specify which frequency term templates can be used for which object 

types. You can also restrict the use to specific differentiation criteria. 

Example 

You can specify which frequency term templates are to be made available for real estate contracts 

with the contract type Residential Lease-Out. 

You can differentiate for the following object types: 

- Real estate contract (according to contract type) 

- Real estate offer (according to contract type) 

- Rental object (according to usage type) 

If you select the New Creation indicator for an entry (assignment of a template to an object type or a 

combination of object type and differentiation criterion), when an object (such as a contract) is created for 

this object type or combination of object type/differentiation criterion, a frequency term is created 

automatically based on the assigned template. If you have set the indicator for no assignment, when an 

object is created for the object type or combination of object type/differentiation criterion without an 

assigned template, a term is created based on the conditions predefined by SAP for the frequency term 

type. A frequency term created in this way contains <standard> in the name. The templates assigned for 

this object type or combination of object type/differentiation criterion are then available for creating 

further templates. 

Example 

Object Type Differentiation Criterion Term Template No. New Creation 

IS (Real Estate Contract) TemplateIS <blank> X  

IS (Real Estate Contract) CO (Commercial Lease-Out) MonthlyR  X 

IS (Real Estate Contract) CO (Residential Lease-Out) MonthlyR  X 

IS (Real Estate Contract) CO (Residential Lease-Out) DueDateN  < blank > 

IS (Real Estate Contract) CO (Residential Lease-Out) AnnualR  < blank > 

IM (Rental Object) TemplateIM <blank> X  

Explanation : When a real estate contract is created with the contract type Residential 

Lease-Out (CO), two frequency terms are created automatically based on the TemplateIS and MonthlyR 

templates (the New Creation indicator is selected for these templates). TemplateIS is also taken into 

account because differentiation criterion was not specified for this template and this template therefore 

applies in general for all real estate contracts. When you edit a contract, you can create frequency terms 

based on the four templates TemplateIS, MonthlyR, DueDateN, or AnnualR. 

Explanation : When you create a real estate contract with the contract type Internal Lease-Out (CO), a 

frequency term is created automatically based on the TemplateIS template because no specific template was 

assigned for this contract type. 



 

 

Requirements 

You have defined the templates for the frequency terms. 

Activities 

Select the object type (such as IS - Real Estate Contract) and perhaps a differentiation criterion (such as CO 

- Residential Lease-Out) and assign a template. 

You can assign any number of templates to an object type or a combination of object type and differentiation 

criterion. 

If you have selected the New Creation indicator, note the following: 

The number that you assign to the entry here is applied as the number of the term when you use the 

template. When you create an entry in this activity for an object type or for a combination of object type 

and differentiation criterion, there must always be exactly one assignment for which the Number field is 

empty. The term created based on this entry is the standard term. If you make further assignments for the 

same object type or combination of object type and differentiation criterion, the numbers must not be 

identical. You should also take this into account, however, if you have not selected the New Creation 

indicator. 

Examples for New Creation Assignment at 

object type level only: 

Object Type Differentiation Criterion Term Template No. New Creation 

IS (Real Estate Contract) TemplateIS <blank> X 

IS (Real Estate Contract) MonthlyR  < blank>/X 

IS (Real Estate Contract) DueDateN  

Assignments for object type and differentiation criterion: 

< blank>/X 

Object Type Differentiation Criterion Term Template No. New Creation 

IS (Real Estate Contract) TemplateIS <blank> X 

IS (Real Estate Contract) MonthlyR  < blank>/X 

IS (Real Estate Contract) CO (Commercial Lease-Out) AnnualR  < blank>/X 

IS (Real Estate Contract) CO (Residential Lease-Out) DueDateN  < blank>/X 

Assignments at differentiation criterion level: 

If, for each differentiation criterion (such as contract type), you want to use a different template to 

create the standard term, you either must not create an entry for which the DifCrt remains empty, 

that is, you must not assign a template to the object type that applies for all objects (such as 

contracts) for this object type (case ), or you need to create a separate entry for which the No. field 

is empty (case ) for all differentiation criteria that are possible for this object type. 

Case : 

Object Type Differentiation Criterion Term Template No. New Creation 



 

 

IS (Real Estate Contract) CO (Commercial Lease-Out) AnnualR <blank> X 

IS (Real Estate Contract) CO (Residential Lease-Out) DueDateN <blank> X 

Note: In this case, the conditions predefined by SAP for the frequency term type are used in real 

estate contracts with other contract types (such as Internal Lease-Out ( CO )) and the term created 

as a result is the standard term. 

Case : 

Object Type Differentiation Criterion Term Template No. New 

Creation 

IS (Real Estate Contract) TemplateIS  X 

IS (Real Estate Contract) AS (Assessment Contract) MonthlyR <blank> X 

IS (Real Estate Contract) ... ... <blank> X 

IS (Real Estate Contract) CO (Commercial Lease-Out) AnnualR <blank> X 

IS (Real Estate Contract) CO (Residential Lease-Out) DueDateN <blank> X 

IS (Real Estate Contract) ... ... <blank> X 

... ...  ... <blank> X 

Note: If you did not create an entry for contract type CO, only the TemplateIS template would be 

available for creating a term in contracts with contract type CO, and the term created with this would 

have the number ; this means there would be no standard term. A standard term must always exist, 

however. 

Assignment only at differentiation criterion level: 

Object Type Differentiation Criterion Term Template No. New Creation 

IS (real estate contract) CO (Commercial Lease-Out) MonthlyR <blank> X 

IS (Real Estate Contract) CO (Residential Lease-Out) MonthlyR <blank> X 

IS (Real Estate Contract) CO (Residential Lease-Out) DueDateN  < blank>/X 

Note: In this example, the conditions predefined by SAP for the frequency term type are used for 

frequency terms in real estate contracts with other contract types (such as Internal Lease-Out ( CO )). 

 Reason for Change 

 Define Reason for Change 

Use 

Here you enter possible change reasons for conditions. 



 

 

A change reason has to be entered for a condition when you change the condition while processing the 

contract or rental object. 

- If you did not enter a standard reason (with blank key) for the condition type, then you have to enter a 

reason when the condition is changed. 

- If the change to the condition is the result of an adjustment, then you can make the change reason 

dependent on the adjustment rule. You can still overwrite this change reason at the time of the 

adjustment run. 

Activities 

- For each condition type, enter the possible reasons it can change. 

- Do not enter condition types that do not require change reasons. 

- There could be condition types for which you want to allow change reasons, but where they should 

not be mandatory. For these condition types, you enter the normal change reasons, but in addition you 

enter a change reason with a blank key. This blank key is then used as the standard default. 

 Implement Enhancements ( BAdI ) 

 Specify Defaults and Perform Consistency Check per Condition 

Use 

You can use this Business Add-In (BAdI) to influence the standard behavior of conditions. 

Activities 

The following methods of the BAdI are called automatically when the condition is being processed: 

- CHECK_ALL 

This method is called when the user chooses the Check pushbutton. 

The returned messages (CT_MESSAGE parameter) are displayed in the same list as the messages 

from standard processing. 

The ID_ACTIVITY parameter specifies if the object is currently in create mode () or change mode (). 

- MODIFY_DUEDATE 



 

 

This method is called when calculation entries are updated. 

By modifying the parameter CD_DUEDATEUP  modifying the parameter CD_DUEDATEUP, you 

have the option of adjusting the due date for follow-up postings that was set manually. 

- GET_ADJUSTMENT_RULE 

The method is called when conditions are created. 

If the method returns an adjustment rule (parameter CD_ADJMRULE), then the system searches for 

or creates this adjustment rule in the contract or rental object and assigns it to the condition. 

If the CF_ADJMRULE_NEW parameter is set, then a new adjustment rule is created. 

If you want to always exclude a condition from automatic adjustment, then set the 

CF_NOT_ADJUSTABLE parameter. 

- GET_TAKE_ADJUSTMENT_RULE 

This method controls how a default value is provided (parameter CF_TAKE_ADJMRULE) for the 

adjustment rule transfer indicator when proposed conditions are added. 

- GET_LOCK_CONTEXT 

You can use this method to lock conditions to being changed, as follows: 

- CF_LOCKED: Locks input fields (exception: memo) 

- CF_COPY_LOCKED: Prevents the condition from being copied 

- CF_DELETE_LOCKED: Prevents the condition from being deleted 

- EF_BOOK_UNLOCK_LOCKED: Prevents the removal of posting locks 

- CD_XLOCKED: Specifies the reason for the lock in text form (for display when condition 

changed) 

Using table CT_UNLOCK_FIELD, you can exclude individual fields from being locked: 

- CONDVALIDFROM: Condition start date 

- CONDVALIDTO: Condition end date 

- CALCRULE: Calculation formula 

- DISTRULE: Distribution formula 

- DUEDATEUP: Due date of follow-up posting 

- TERMNOPY: Posting term 

- TERMNORH: Frequency term 

- TERMNOOA: Organizational assignment term 

- TERMNOAJ: Adjustment term 

- TERMNOSR: Sales rule term 

- TERMNOMR: Peak sales rule term 



 

 

- TERMNOPYSCS: Service charge settlement posting term 

- TERMNOPYSCSACT: Service charge settlement posting term active/inactive 

- UNITPRICE : unit price 

- CONDCURR: Currency 

- CHECK_ALL, GET_ADJUSTMENT_RULE and GET_LOCK_CONTEXT 

The data of the condition is available in these methods in the IS_CONDITION parameter. In 

addition, the IO_OBJEKT parameter specifies the object that has the condition ( contract or rental 

object). 

- GET_BEHAVIOR_CONTEXT 

This method controls if the CFPOSTINGFROM field is ready for input: 'DATE  ST POSTING' for 

the condition using the parameter 'CF_DISABLE_CFPOSTINGFROM'. The data of the condition is 

available in the IO_CONDITION parameter. 

- SET_DERIVATION_FIELDS 

Using this method, you can fill your customer-specific additional fields of the structure 

'RECDDERIVATEIONFIELDS' for the derivation of the condition group. The object that has the 

condition is available in the parameter IO_OBJEKT . For more information about this topic, see 

Define Derivation Steps 

Note 

When implementing the BAdI, you are not allowed to use statements that affect the interface, such as 

direct output of messages using the statement MESSAGE. Notes for Developers 

 Calculation Formula for Conditions 

Use 

Using this Business Add-In (BAdI) you can determine the time-dependent calculation factors that are 

multiplied with the unit price. 

Implementation of this Business Add-In (BAdI) is mandatory for each external calculation formula that is 

defined in Customizing (under Calculation Formulas) on the basis of internal calculation formula  ( = 

BAdI calculation). 

You can process all user-specific calculation formulas within the same Business Add-In implementation. 

This means that you do not have to create a separate implementation of the BAdI for each calculation 

formula. 



 

 

Activities 

1. Create a BAdI implementation that contains the following methods: 

- GET_ATTRIBUTES - GET_PARAMETER 

- GET_UNITS 

- GET_VALUES 

- GET_FLEXIBLE 

Each method contains the ID_CALCRULEEXT parameter, which is used to control the 

implementation (dependent on the formula). 

2. Activate the BAdI implementation. 

Method description 

- GET_ATTRIBUTES 

The method returns the following attributes: 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @A@ CF_DISTRIBUTE: Defines whether or not the calculation can be distributed 

- @A@ CF_ADJUSTABLE: Defines whether or not the condition can be adjusted 

- @A@ CF_UNITPRICE_HIDE: Defines whether or not the unit price can be hidden 

- @A@ CF_DEPEND_CONDITION: Defines whether or not the calculation is dependent on 

conditions 

- @A@ CF_DEPEND_OBJECT: Defines whether or not the calculation is dependent on object 

data 

- @A@ CF_UNIQUE_VALUES: Defines whether or not the calculation returns one-time 

amounts 

- @A@ CF_UNIQUE_VALUES_MULTI: Defines whether or not the calculation returns multiple 

one-time amounts 

- @A@ CD_INFO_IDENT: Defines the help text ID 

- @A@ CD_GUI_FM_PARA_PBO: Defines the PBO function module for maintenance of 

formula parameters 

- @A@ CD_GUI_FM_PARA_PAI: Defines the PAI function module for maintenance of formula 

parameters 

Using the CD_GUI_FM_PARA_PBO and CD_GUI_FM_PARA_PAI parameters, you can link 

to a special interface for maintaining formula parameters. The function groups 

RECD_GUI_CALC_RULE_ and RECD_GUI_CALC_RULE_ serve as examples for this. 

- GET_PARAMETER 

The method returns the following parameters: 



 

 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @@ ID_PARA_NO: Defines the number of the parameter 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CT_PARA_VALUES: Defines the list of parameter values ( F ) 

- @A@ CD_PARA_INFO: Defines the description of the parameter 

- @A@ CF_PARA_CHECK: Defines whether or not a standard check of the parameter is 

performed 

- GET_UNITS 

The method returns the following units: 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CD_UNIT_UNITPRICE: Defines the unit of the unit price 

- @A@ CD_UNIT_CALCVALUE: Defines the unit of the calculation factor 

- GET_VALUES 

The method returns the following calculation factors: 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @@ ID_PARA_: Defines parameter  - @@ ID_PARA_: Defines parameter  

- @@ ID_ABS_FROM: Defines the absolute start of the calculation 

- @@ ID_ABS_TO: Defines the absolute end of the calculation 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @@ IT_OBJECT_CONTRACT: Defines the contract object 

- @@ IT_OBJECT_CONDITION: Defines the condition objects 

- @A@ CT_CALC_VALUES: Defines the time-dependent calculation factors 

- @A@ CT_ DIST_VALUES: Defines the time-dependent distribution factors 

- @A@ CT_CALC_USED_OBJECTS: Defines the objects that are considered by the 

calculation 

- @A@ CT_DIST_USED_OBJECTS: Defines the objects that are considered by the distribution 

- GET_FLEXIBLE 

The method returns the following flexible values: 



 

 

- @@ ID_CALCRULEEXT: Defines the external calculation formula 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CF_FLEXIBLE: Defines whether or not the formula supports flexible intervals 

- @A@ CD_FLEXIBLE_FROM: Defines the start date of the flexible interval 

- @A@ CD_FLEXIBLE_TO: Defines the end date of the flexible interval 

Using this method, you can define a condition so that it is valid beyond the term of the object. 

Dependent on the actual condition object, the table of condition objects is structured as follows: - The 

condition object is a concrete object. 

The table of condition objects contains the concrete object. 

- The condition object is an object group. 

The table of condition objects contains the object group and the objects in the object group. 

- The condition object is the contract. 

The table of condition objects is identical to the table of contract objects. 

Note the following: 

- Do not directly access the database (SELECT statements) on tables where the data could be being 

processed. Use only the API_RE_xx_GET_DETAIL function module for data retrieval. (Here xx 

stands for the English abbreviation for the object type, for instance CN for the real estate 

contract.) 

- Do not use statements that execute actions on the interface, for example, MESSAGE without 

RAISING, CALL SCREEN and so on. Also, do not use COMMIT WORK or ROLLBACK 

WORK. 

Example 

SAP provides the external calculation formulas that are based on these internal calculation formulas:  

(amount per object),  (amount per rental object status),  ( amount per tenant changeover) and  

(% share of condition group). You implement these external calculation formulas in the following 

classes: 

- CL_RECD_CALC_RULE_ - CL_RECD_CALC_RULE_ -

 CL_RECD_CALC_RULE_ 

- CL_RECD_CALC_RULE_ 

These classes have the same structure as a corresponding BAdI implementation for the BAdI definition 

RECD_CALC_RULE. They can serve as a guide for the implementation of your own formulas. 

Notes for Developers 



 

 

 Distribution Formula for Conditions 

Use 

Using this Business Add-In (BAdI) you can determine a time-dependent distribution for a 

calculation. 

Implementation of this Business Add-In (BAdI) is mandatory for each external distribution formula that is 

defined in Customizing (under Distribution Formulas) on the basis of internal distribution formula  ( = 

BAdI distribution). 

You can process all customer-specific distribution formulas you need in the same Business Add-In 

implementation. This means that you do not have to create a separate implementation of the BAdI for 

each formula. 

Activities 

. Implement the BAdI and define the following methods: 

- GET_ATTRIBUTES - GET_PARAMETER 

- GET_UNIT 

- GET_VALUES 

- GET_FLEXIBLE 

Each method contains the ID_DISTRULEEXT parameter, which is used to control the implementation 

(dependent on the formula). 

. Activate the BAdI implementation. 

Method description 

- GET_ATTRIBUTES 

The method returns the following attributes: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @A@ CF_DEPEND_OBJECT: Defines whether or not the distribution is dependent on object 

data 

- @A@ CD_INFO_IDENT: Defines the help text ID 

- @A@ CD_GUI_FM_PARA_PBO: Defines the PBO function module for maintenance of 

formula parameters 

- @A@ CD_GUI_FM_PARA_PAI: Defines the PAI function module for maintenance of formula 

parameters 



 

 

Using the CD_GUI_FM_PARA_PBO and CD_GUI_FM_PARA_PAI parameters, you can link to a 

special interface for maintaining formula parameters. The function group 

RECD_GUI_DIST_RULE_ serves as an example for this. 

- GET_PARAMETER 

The method returns the following parameter values: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @@ ID_PARA_NO: Defines the number of the parameter 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CT_PARA_VALUES: Defines the list of parameter values (input help) - @A@ 

CD_PARA_INFO: Defines the description of the parameter 

- @A@ CF_PARA_CHECK: Defines whether or not the standard check of the parameter is 

performed 

- GET_UNIT 

The method returns the following units: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CD_UNIT_DISTVALUE: Defines the unit of the distribution factor 

- GET_VALUES 

The method returns the following calculation factors: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @@ ID_PARA_: Defines parameter  - @@ ID_PARA_: Defines parameter  

- @@ ID_ABS_FROM: Defines the absolute start of the calculation 

- @@ ID_ABS_TO: Defines the absolute end of the calculation 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @@ IT_OBJECT_CONTRACT: Defines the contract objects 

- @@ IT_OBJECT_CONDITION: Defines the condition objects 

- @@ IT_OBJECT_DISTRIBUTION: Defines the distribution objects 

- @A@ CT_ DIST_VALUES: Defines the time-dependent distribution factors 

- @A@ CT_DIST_USED_OBJECTS: Defines the objects that are considered by the distribution 



 

 

Dependent on the actual condition object, the table of condition objects is structured as follows: 

- If the condition object is a concrete object, then the table contains the concrete object. 

- If the condition object is an object group, then the table of condition objects contains the object 

group and the objects in the object group. 

- If the condition object is the contract, then the table is identical to the table of contract objects. 

- GET_FLEXIBLE 

This method returns the following flexible values: 

- @@ ID_DISTRULEEXT: Defines the external distribution formula 

- @@ IO_OBJECT: Defines the object that has the condition 

- @@ IS_CONDITION: Defines the condition 

- @A@ CF_FLEXIBLE: Defines whether or not the formula supports flexible intervals 

- @A@ CD_FLEXIBLE_FROM: Defines the start date of the flexible interval 

- @A@ CD_FLEXIBLE_TO: Defines the end date of the flexible interval 

Using this method, you can define a condition so that it is allowed to be valid beyond the term of the 

object. 

Note the following: 

- Do not directly access the database (SELECT statements) on tables where the data could be being 

processed. Use only the API_RE_xx_GET_DETAIL function module for data retrieval. (Here xx 

stands for the English abbreviation for the object type, for instance CN for the real estate 

contract.) 

- Do not use statements that execute actions on the interface, for example, MESSAGE without 

RAISING, CALL SCREEN and so on. Also, do not use COMMIT WORK or ROLLBACK 

WORK. 

Example 

The distribution formula based on internal formula  (Aggregation), which is provided by SAP, is 

implemented in the class CL_RECD_DIST_RULE_. 

This class has the same structure as a corresponding BAdI implementation for the BAdI 

definition RECD_DIST_RULE. Therefore, you can use the class as a guide for the 

implementation of your own formulas. Notes for Developers 



 

 

 Real Estate Search 

 Offered Object 

 Offered Object 

Use 

The offered object is an object you can search for using the data of an RE search request. 

From a technical viewpoint, the offered object improves performance during the search for 

rental objects. The system automatically generates offered objects for rental objects that will soon be 

vacant. (You specify how far in advance this should take place.) During the generation of offered objects, 

the system stores the conditions, measurements, and fixtures and fittings characteristics of the objects so 

that they can easily and effectively be compared with the data of the RE search request. 

Activities 

In the following IMG activities, you specify how offered objects are generated from rental objects. 

If you change or add to Customizing settings after offered objects have already been generated, then you 

have to update the offered objects. 

 Define Number Range for Offered Object 

Use 

Here you specify the number range interval to be used for the numbers of offered objects. 

Standard settings 

In standard Customizing, the first number for offered objects is the number . 

Activities 

Enter a number range for interval . Do not set the External indicator, since offered objects are created 

automatically by the system. 

You do not need to define any other intervals except interval . The system ignores any other intervals. 



 

 

 Specify Control Parameters for Updating Offered Objects 

Use 

Here you specify the basic settings for how the system generates offered objects for rental objects. 

Activities 

The settings you make are for combinations of Rental Object Type and Usage Type that you want to 

search for using the real estate search. For example, you might not want to rent out vacant rental spaces 

again in exactly the same form. (You might only want to rent them out again from the pooled space, after 

the rental space has been returned to it.) In that case, you do not make any settings for the Rental Space 

object type. 

You specify the following for each combination of rental object type and usage type: 

- Consideration Period 

Here you enter the number of months in advance of its becoming vacant that a rental object should 

be available in the real estate search. 

Example: 

Notice is given on an apartment in January . The notice date is June , . If you enter a consideration 

period of at least , then the system already generates an offered object for the apartment when the 

notice is activated. Any real estate searches looking for an apartment starting from July ,  will then 

find this apartment immediately. If you enter a smaller number of months for the consideration 

period, then a search in January cannot find the apartment that is becoming vacant in July. 

The system uses the number of months you enter for the consideration period to determine when 

offered objects are generated for the rental objects. The offered objects are generated using the 

RFREOROFFEROBJECTSCREATE report. (We recommend you schedule this report as a monthly 

batch job.) 

If you do not enter a consideration period, then the system generates offered objects as soon as the 

vacancy becomes known, no matter how far in the future the vacancy is. In that case, you do not 

have to run the update report RFREOROFFEROBJECTSCREATE regularly. 

- Vacant Days 

Here you enter the minimum number of days a rental object has to be vacant before the system 

generates an offered object for it. If you leave this field blank, the system creates an offered object 

for a rental object even if it is vacant for only one day. 

Example: 

You enter a consideration period of  months for the apartment on which notice was given in January 

for June , . In January a new lease beginning on August ,  is signed for the apartment. 

At the beginning of February, the RFREOROFFEROBJECTSCREATE report updates the offered 

objects. 

If you entered a value between  and  days for the vacant days, then the system creates an offered 

object for this apartment for the period from July ,  to July . . The search, however, only finds this 

object if you search explicitly for an apartment for a limited time period in July . 

If you enter a value greater than , then the system assumes that it is not beneficial to lease for this 

short period, and does not create an offered object for this apartment. In that case, you would not find 

this apartment during the search, even if you explicitly search for an apartment for this limited time 

period. 

Recommendation: 



 

 

For each usage type, set the number of vacant days to the minimum number of days that a fixed-

term lease should have in order for the rental to be cost effective. 

- Key Date Data 

Certain data that is time-dependent on the rental object (conditions, measurements, fixtures and 

fittings characteristics) is not managed as time-dependent on the offered object. The purpose is to 

improve performance and increase clarity.  Therefore, the system needs to know the key date up to 

which you want the data of the offered object to be valid. If you leave the Key Date Data field blank, 

then the system uses the first day of the vacancy period as the key date. This may not be accurate, if 

renovations are regularly done at the beginning of the vacancy period and these renovations change 

the fixtures and fittings, the measurements, and conditions of the rental object. To address this 

problem, you can enter the number of days that are added to the start of the vacancy period in order to 

determine the key date. 

When renovations are planned, you should enter the planned changes on the rental object with a valid-

from date that, at the latest, is the same as the resulting key date, so that the changes are already 

available in the search. 

- Min. Meas. % 

Here you enter the minimum percentage of the measurement of a pooled space that has to be 

available in order for an offered object to be generated. For other rental object types, the system 

ignores the value. 

Since the pooled space itself can never be leased out, the generation of an offered object for a 

pooled space is not triggered by the start of the vacancy period for the pooled space. Instead, 

generation of an offered object is triggered when this minimum percentage of available 

measurement values is exceeded. 

 Specify Fixtures and Fittings Characteristics for Real Estate Search 

Use 

Here you specify the fixtures and fittings characteristics of the rental object that are relevant for the real 

estate search. 

Requirements 

You already defined fixtures and fittings characteristics in Customizing. 

Activities 

You can define a maximum of eighty fixtures and fittings characteristics as relevant for the real estate 

search. (This restriction is for technical reasons and helps improve performance.) You enter sequence 

numbers from  to , and then assign the numbers to fixtures and fittings characteristics. 

The numbers ( - ) also determine the sequence in which the fixtures and fittings characteristics are 

displayed on the RE search request and in the offered object in the application. 



 

 

You specify which characteristics can be used in a given RE search request. You do so in Customizing for 

the RE search request, dependent on the RE search request type. 

Note 

The fixtures and fittings characteristics are stored on the RE search request using the sequence numbers you 

assign here. You are therefore  not allowed to change the assignment to these numbers later. 

However, it is not a problem if you later assign additional fixtures and fittings characteristics to numbers that 

are not yet assigned. You then have to update the offered objects ( report 

RFREOROFFEROBJECTSCREATE). 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business 

Data Toolset. 

Standard settings 



 

 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields 

of a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, and 

display fields in display mode.) If it is not possible to make a setting for a field group, then the system 

determines how the field is treated (usually dependent on the situation, or on the contents of other 

fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 



 

 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of the 

view accordingly (consider the detail screen). Then assign the field groups to the view. You can assign 

your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it is 

surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you want 

to this section. The item number specifies the sequence in which the views are arranged in the section. For 



 

 

technical reasons, if you make your own assignments from sections to views, the item numbers have to be 

in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 



 

 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Number Assignment, Validation, Substitution 

Use 



 

 

The Business Add-In supports enhancements to the standard functions of offered objects. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 RE Search Request 

 RE Search Request 

Use 

The RE search request describes a real estate object from the viewpoint of the person looking for the 

object ( prospect ). 

It allows you to enter generic data about the rental object that the prospect is looking for. The data is not 

limited to the data directly on the rental object, but can also include data on the business entity or the 

building. 

Activities 

In this section, you define what Customizing data is available for entry on the RE search request. 

Note 



 

 

The rental object describes an existing physical object as exactly as possible, whereas when searching for 

objects, you normally require more generic entries. Therefore, for the RE search request, some new terms 

have been introduced in Customizing. These reflect concrete entries on the rental object, but are necessarily 

more general. 

You can also search for offered objects without having a stored RE search request. In this case, you use the 

same Customizing data as for entering an RE search request. 

 Define Number Range for RE Search Request 

Use 

Here you specify how numbers are assigned for RE search requests. 

Standard settings 

Standard Customizing is set up for internal number assignment beginning with the number . 

Activities 

Set up a number range for interval . Defining other intervals is pointless, since the system ignores them. 

It makes sense to choose internal number assignment, since it is likely a large number of RE search requests 

will be created, so it would help if the numbers are assigned automatically. 

 RE Search Request Type, Meas. Types, Condition Types, Fixt./Fitt. Char. 

Use 

In this section you define the real estate search request types for the real estate search. 

Requirements 

You already made the following settings in Customizing: 

- Define Condition Groups and Assign Condition Types 

- Define Fixtures and Fittings Characteristics for Buildings and Rental Objects 



 

 

- Specify Fixtures and Fittings Characteristics for Real Estate Search 

Activities 

Create an RE search request type for all object types that you want to differentiate between when you 

search. 

Assign the following to each RE search request type: 

. Usage types 

Select the RE search request type. Choose Assignment of Usage Types and assign usage types to the 

rental objects that belong to the RE search request. 

Make sure that every usage type that you want to be able to search for using the real estate search is 

assigned to at least one RE search request type. 

Note that you are required to enter a measurement type for pooled spaces; otherwise the system 

does not generate any offered objects for pooled spaces. Using the measurement type of the pooled 

space, you can control which part of the pooled space is relevant for the RE search request type. 

Example: 

You have a pooled space, "Shopping Mall," for which warehouse space and retail space are 

defined. You can assign the "Shopping Mall" usage type with the "warehouse space" measurement 

type to the "Store" RE search request type. In addition, you can assign the "Store" usage type (for 

stores that are defined as rental units and can be rented as a whole) to the same RE search request 

type. You assign the "Shopping Mall" usage type with the "Warehouse Space" measurement type to 

a second RE search request type called "Warehouse." The measurement type that has to be entered 

for the usage type also has to be set up in the definition of the measurement types (so that it is 

possible to search for this measurement type, see below). 

2. Measurement Types 

a) Select RE search requests. Assign the measurements that you want to search for to them by 

choosing Definition of Measurement Types. Currently you can assign a maximum of four 

measurement types. 

For apartments, for example, you want to be able to search for the size of the apartment and the 

number of rooms. Then enter the appropriate measurement types in the order you want them to 

appear in the RE search request. Using the Logical Link field, you specify if all of the criteria 

have to be met during the search, or if it is enough if one of the criteria is met. 

b) Set the Show indicator for the measurement types that are most commonly searched for. These 

measurement types then appear on the first screen of the RE search request. For measurement 

types that you seldom search for, do not set the Show indicator. 

c) Define how tolerant the search should be using the % Upward Var. and % Downward Var. 

fields. For measurements, it makes sense to allow a higher upward variance than lower 

variance. 

3. Condition Types 



 

 

a) Assign the condition groups that you want to search for to the selected RE search requests by 

choosing Definition of Condition Types. Currently you can assign a maximum of four condition 

groups. You have to assign the condition types to the condition groups that you want to search 

for in Customizing. You could use the same condition groups here that you use in the 

Information System (for example, Basic Rent, Service Charges). 

b) Using condition purposes, you specify which conditions of the rental object should be 

considered. Normally you use vacancy rent or market rent. 

Recommendation: 

Choose the same condition purpose here that you set as a default value for the condition type in 

Customizing for condition groups. 

c) Specify the currency, the payment frequency and the calculation method, that you want for the 

RE search request. The system does not expect that these entries apply for the rental objects 

you search for. Instead, the system converts the values as needed at the time the offered objects 

are created. For example, it can convert a price per square foot into a fixed price. If you have 

condition groups with different calculation methods or payment frequencies for the same RE 

search request type, then the name of the condition group should indicate what kind of group it 

is. 

For example, if the calculation method is Price per Measurement, then you have to specify the 

measurement type that the calculation is based on. 

d) For the following indicators, you follow the same guidelines as for measurement types: Show, 

% Upward Var. and Logical Link. Note that by setting the logical link OR,it is possible to 

search for either a price per measurement or a fixed price. In 

this case, you should name the condition groups accordingly. 

e) If you want to copy the conditions from the last real estate contract, then set the Contract 

Conditions indicator. 

4. Fixtures and Fittings Characteristics 

Assign fixtures and fittings characteristics that are relevant for this RE search request type to the 

selected RE search request type. Choose Assignment of Fixt./Fittings Characteristics. You have to 

define fixtures and fittings characteristics first in Customizing for master data. You have to assign a 

sequence number to the fixtures and fittings characteristics in Customizing for the Real Estate 

Search. 

 Specify Contract Types for Real Estate Search 

Use 

To be able to generate a contract from an RE search request or a contract offer, you first have to assign the 

RE search request or contract offer to the contract types for which you want generating a contract to be 

possible. 



 

 

Activities 

- For all contract types that are relevant for the real estate search, and which relate to offered 

objects (normally these are occupancy contracts), assign the following: 

- Assignment object type: I - RE search request 

- Assignment object type: I - Contract offer 

- Specify that the object assignment is allowed. Choose Informational Only as the assignment 

option. 

- If you also use the "contract offer" application dialog for contracts that do not relate to objects 

(such as, service contracts), then assign the following to these contracts: 

- Assignment type: I - Contract offer 

- Specify that the object assignment is allowed. Choose Informational Only as the assignment 

option. 

If you do not make this setting for any given contract types, then you can create contract offers for 

them, but the contract offers cannot be converted to contracts. 

 Search Criteria Related to Data of Rental Object 

 Neighborhood: Define Preferred Values 

Use 

You can enter up to three values for a neighborhood on the business entity and on the rental object. This 

allows you to classify real estate objects further, regardless of their actual postal data. 

In the RE search request, you can enter several values for the neighborhood that the prospect prefers. (You 

enter them in a string with each neighborhood separated by spaces.) 

In both these master data objects and in the RE search request, you can enter values that were not explicitly 

entered in Customizing. However, to increase the likelihood of hits, you should enter values here that you 

search for frequently. 

If you enter a neighborhood in an RE search request, then the standard search only finds those rental 

objects where at least one of the neighborhoods being searched for is entered on the rental object or the 

business entity it belongs to. 

Activities 

Enter the neighborhoods here that you search for frequently. 



 

 

 Specify District Locations for RE Search Request 

Use 

Here you enter the district locations that you want to have available in the RE search request. 

Normally, the level of granularity is not as fine as the district locations on the object in the usage view 

(business entity) . 

Activities 

Enter the district locations and then assign them to district locations of the usage view. 

 Assign District Locations to Those of Usage View 

Use 

A prospect can select multiple district locations that interest him or her from the District Locations for RE 

Search Requests. 

The system has to be able to recognize which district locations of the usage view correspond to those in the 

RE search request so that it can find the correct objects. Therefore, you have to assign district locations from 

the RE search request and those of the usage view to each other. 

Requirements 

You defined  District Locations for RE Search Requests. 

Activities 

Assign the district locations to each other. Usually you assign one district location of the RE search request 

to several district locations of the business entity. However, you can also assign one district location of the 

business entity to several district locations of the RE search request. 

Example 

District locations of the RE search request: City 

Suburb 

Country 

District locations of the business entity: City center 

Inner city 

Outer district 



 

 

City section ( urban ) 

Suburb ( urban ) 

Suburb ( rural ) 

Country 

Example assignment: 

RE search request: City 

Business entity: City center, inner city, outer district, city section (urban), suburb ( urban ) 

RE search request: Suburb 

Business entity: Suburb (urban), suburb ( rural ) 

RE search request:  Country 

Business entity: City section (rural), suburb (rural), country 

 Define Transport Connections for RE Search Request 

Use 

Here you enter the transport connections that you want to have available in the RE search request. 

Normally, the level of granularity is not as fine as on the transport connections in the usage view (business 

entity) . 

Activities 

Enter the transport connections and then assign them to the transport connections of the usage view. 

 Assign Transport Connections to Those of Usage View 

Use 

A prospect can select multiple transport connections that interest him or her from the transport requests for 

RE search requests. 

The system has to be able to recognize which transportation connections of the usage view correspond to 

those in the RE search request so that it can find the correct objects. Therefore, you have to assign 

transport connections from the RE search request and those of the usage view to each other. 



 

 

Standard settings 

You defined transport connections for RE search requests. 

Activities 

Assign the transport connections to each other. Usually you assign one transport connection of the RE 

search request to several transport connections of the business entity. However, you can also assign one 

transport connection of the business entity to several transport connections of the RE search request. 

Example 

Transport connections of the RE search request: Expressway Local public 

transport 

Train ( Metroliner ) 

Transport connections of the business entity: Bus 

Bus/streetcar 

Bus/streetcar/intercity train 

Intercity train 

Expressway 

Expressway/intercity train 

All 

Example assignment: 

RE search request: Expressway 

Business entity: Expressway, Expressway/intercity train, All 

RE search request: Local public transport 

Business entity: Bus, Bus/streetcar, Bus/streetcar/intercity train, All 

RE search request: Train ( Metroliner ) 

Business entity: Intercity train, Expressway/intercity train, All 

 Statistical Data: Source Data 

 Specify Prospect Sources 

Use 

In the RE search request, you can enter where the prospoct came from. This information can be used in 

reporting. You enter the possible values for where the prospect came from here. 



 

 

These values are not used during a standard search for real estate objects. However, you can search for them 

when you perform an extended search from the offered object. 

Reporting on statistical data is only possible in the standard system if you save the RE search request. It is 

not possible when you use an ad hoc search. 

 Specify Reasons for Search 

Use 

In the RE search request, you can enter reasons that the prospect is interested in a new real estate object 

(with your company). This information can be used in reporting. You enter the possible reasons here. 

These values are not used during a standard search for real estate objects. However, you can search for them 

when you perform an extended search from the offered object. 

Reporting on statistical data is only possible in the standard system if you save the RE search request. It is 

not possible when you use an ad hoc search. 

 Specify Sources of Inquiry 

Use 

In the RE search request, you can enter the medium that the prospect used to make an inquiry about leasing 

a property with your company. This information can be used in reporting. You enter the possible sources 

of inquiry here. 

These values are not used during a standard search for real estate objects. However, they could be 

interesting, for example, for performing a cost/benefit analysis of advertising measures. 

In addition, you can search for this criterion when you perform an extended search from the offered object. 



 

 

Reporting on statistical data is only possible in the standard system if you save the RE search request. It is 

not possible when you use an ad hoc search. 

 Statistical Data: Processing Indicator and Status 

 Specify Processing Indicators 

Use 

You can enter a processing indicator in the RE search request. The indicator could be used, for example, to 

classify prospective tenants based on their credit standing. You enter the possible processing indicators here. 

These values are not used during a standard search for real estate objects. However, you can search for them 

when you perform an extended search from the offered object. 

In addition, the system can display the processing indicator in the hit list when you search for RE search 

requests for an offered object. 

 Specify Processing Status 

Use 

You can enter a processing status in the RE search request. You can use the status, for example, to keep 

track of RE search requests for which you already sent a number of unsuccessful offers. You enter the 

possible statuses here. 

These values are not used during a standard search for real estate objects. However, you can search for them 

when you perform an extended search from the offered object. 

In addition, the system can display the processing status in the hit list when you search for RE search 

requests for an offered object. 



 

 

Standard settings 

Using the values provided in standard Customizing, you can apply the processing status as a criteria to 

help in deciding which prospect to offer an apartment, when there are several suitable RE search 

requests for an offered object. However, keep in mind that you have to enter the status manually. 

 Specify Preselection Indicator 

Use 

Using the preselection indicator, you can classify an RE search request as selected in advance. 

You enter the possible preselection reasons here. 

These values are not used during a standard search for real estate objects. However, you can search for 

them when you perform an extended search from the offered object. In addition, the system can display the 

preselection indicator in the hit list when you search for RE search requests for an offered object. 

Depending on how you use the indicator, you should report on it in correspondence ( for example, letters 

for offer). 

Example 

You can use this preselection, for example, if the prospect has not yet actually made a request for an 

apartment, but you have some reason to believe that he will need an apartment in the near future. 

There could be several reasons for this. For instance, the prospect is already a tenant of yours, but you know 

that plans are for his apartment to be used for another purpose, and you want to offer him a different one. 

Another reason could be that you know certain of your tenants have adult children who may soon be looking 

for their own apartments. 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 



 

 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields 

of a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, and 

display fields in display mode.) If it is not possible to make a setting for a field group, then the system 

determines how the field is treated (usually dependent on the situation, or on the contents of other 

fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 



 

 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of the 

view accordingly (consider the detail screen). Then assign the field groups to the view. You can assign 

your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it is 

surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 



 

 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you want 

to this section. The item number specifies the sequence in which the views are arranged in the section. For 

technical reasons, if you make your own assignments from sections to views, the item numbers have to be 

in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 



 

 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Number Assignment, Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of RE search requests. For an 

overview of the possible enhancement methods, see this text. 



 

 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 Search Result 

 Enter Reasons for Search Status 

Use 

In the hit list for a search based on an RE search request, the processor can assign a status to a 

combination of an RE search request and the offered object found. 

The statuses are predefined: 

S - Prospect Rejects Object 

S - Prospect Favors Object 

S - Processor Rejects Prospect 

S - Processor Favors Prospect 

S - Offer Created 

S - Lease-Out Created 

S - Custom Text 

The status serves as a reminder. When processing the RE search request again later, the status tells the 

processor, for example, if the object was already offered to the prospect, and possibly how the prospect 

responded. 

Activities 

You can enter additional reasons here for each of the predefined statuses. You define reasons for each 

status. This means, for status S, for example, you can enter up to  different reasons why the prospect 

could reject the object. 



 

 

The reasons entered for status S allow you to evaluate the reasons your real estate portfolio does not 

correspond to the needs of prospective tenants. 

You can use status S to make comments on combinations of RE search requests and offered objects, which 

are not considered by the system in further searches. The entries you make here are for information only. 

 Implement Enhancements ( BAdI ) 

Use 

This BAdI is called when you search for 

- Offered objects 

- Meeting rooms 

It allows you to influence the conditions for selection and the results of the search. 

Offered objects 

Meeting rooms 

- Method WHERE_CLAUSE_MODIFY 

You can use the CHANGING parameters to influence the WHERE conditions for the selection of 

meeting rooms. 

Notes for Developers 

 Contract Offer 

 Define Partner Transfer When Contract Created from Offer 

Use 

If you want to generate contracts from contract offers, then the roles of the partners also have to be 

changed accordingly, for example, from prospect to tenant. 

Activities 



 

 

Enter a new role here for each role, for which you want the partner to be transferred. You have to make an 

entry here even if the role itself does not change when the partner is transferred (you enter the same role 

twice). Any partners on the contract offer that have roles not entered in this table are not copied from the 

contract offer to the contract. 

 Define Number Range for Contract Offer 

Use 

Here you specify how numbers are assigned for contract offers. 

Standard settings 

Standard Customizing is set up for internal number assignment beginning with the number . 

Activities 

Set up a number range for interval . Defining other intervals is pointless, since the system ignores them. 

 Specify Contract Types for Real Estate Search 

Use 

To be able to generate a contract from an RE search request or a contract offer, you first have to assign the 

RE search request or contract offer to the contract types for which you want generating a contract to be 

possible. 

Activities 

- For all contract types that are relevant for the real estate search, and which relate to offered 

objects (normally these are occupancy contracts), assign the following: 

- Assignment object type: I - RE search request 

- Assignment object type: I - Contract offer 

- Specify that the object assignment is allowed. Choose Informational Only as the assignment 

option. 



 

 

- If you also use the "contract offer" application dialog for contracts that do not relate to objects 

(such as, service contracts), then assign the following to these contracts: 

- Assignment type: I - Contract offer 

- Specify that the object assignment is allowed. Choose Informational Only as the assignment 

option. 

If you do not make this setting for any given contract types, then you can create contract offers for 

them, but the contract offers cannot be converted to contracts. 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 



 

 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields 

of a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, and 

display fields in display mode.) If it is not possible to make a setting for a field group, then the system 

determines how the field is treated (usually dependent on the situation, or on the contents of other 

fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 



 

 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of the 

view accordingly (consider the detail screen). Then assign the field groups to the view. You can assign 

your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it is 

surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you want 

to this section. The item number specifies the sequence in which the views are arranged in the section. For 

technical reasons, if you make your own assignments from sections to views, the item numbers have to be 

in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 



 

 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 



 

 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Number Assignment, Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of  contract offers. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications 



 

 

Notes for Developers 

 Accommodation Entitlement Certificate 

 Specify Fixtures/Fittings for Accommodation Entitlement Certificate 

Use 

You enter the different types of accommodation entitlement certificates needed for an apartment on the 

rental object as fixtures and fittings characteristics. For the real estate search to be able to consider these 

characteristics, you have to specify here which characteristics these are. 

Requirements 

- For each accommodation entitlement type you want to use, you created a separate fixtures and 

fittings characteristic in the  Define Fixt./Fittings Characteristics for Buildings and Rental Object 

IMG activity. 

You specified in that activity that these characteristics are relevant for rental objects. 

- In the  Specify Structure of Fixt./Fittings Characteristics Independent of RLR IMG activity, you 

created an Accommodation Entitlement characteristic group and an Accommodation Entitlement 

characteristic class. You assigned the fixtures and fitting characteristic to this group and class. 

Standard settings 

In Customizing in the standard system, the following fixtures and fittings characteristics are defined for 

accommodation entitlement certificates (AEC). They are assigned to group  and class : 

- ORCL - ORCL - ORCL 

- ORGENE 

Activities 

Enter the characteristic group that you defined in the Characteristic Group field. If there is one fixtures and 

fittings characteristic that includes all accommodation entitlement certificates, enter it in the Publicly 

Subsidized field. 

Characteristics defined in this way can be entered in the RE search request (the number is not limited) to 

indicate that the prospect possesses these accommodation entitlement certificates. Assuming that the 

rental object has a fixtures and fittings characteristic from this group, the standard search for RE search 

requests from the rental object only finds an RE search request if the appropriate fixtures and fittings 

characteristic is entered on the RE search request (or the fixtures and fittings characteristic is designated 

as General). 

If you search for an offered object from an RE search request on which an accommodation entitlement 

certificate was entered, and condition amounts are also entered, then you have to decide if you want to 

search using AEC data only, condition amount only, or with both. 



 

 

 Specify Levels of Priority for Accomodation Entitlement Certificate 

Use 

You can enter a level of priority for an accommodation entitlement certificate. This is for informational 

purposes only. 

Activities 

Specify the levels of priority you want to use. 

 Specify Person Group for Accommodation Entitlement Certificate 

Use 

You can enter a person group for an accommodation entitlement certificate. This is only for informational 

purposes. 

Activities 

Specify a person group. 

 Specify Additional Information for AEC 

Use 

You can enter additional information for an accommodation entitlement certificate. This is for informational 

purposes only. 

Activities 



 

 

Specify the additional information you need. 

 Accounting 

 FI Documents Related to RE 

 Activate RE-FX for Financial Accounting 

Use 

Note that the "RE" application has to be active. Set the indicator to activate "RE" if necessary. 

documentation 

Standard settings 

In the standard system "RE" is active as a default. 

 Define RE-Specific Account Properties 

Use 

In Customizing for your accounting system, you can specify that particular accounts can be used for real 

estate objects. This is dependent on the account group. 

In this step, you can make detailed settings for these accounts. Accounts for which you make no further 

settings can be used for all real estate objects. However, you cannot use such accounts to directly post 

service charges to rental objects and contracts. 

Activities 

Define the account properties as follows: 

Choose New Entries. 

Enter an internal key and a name for the account property. 

Example 

. 



 

 

You want certain accounts to be available only for certain object types. 

You create the account property NAC - Non-Apportionable Costs. This account property is only allowed 

for the object types business entity, property, building, rental object, and contract ( but not settlement unit). 

Select the corresponding object types. Account assignment to settlement units is then not possible for 

accounts that have this property. 

. 

You want to be able to assign costs directly to rental objects or contracts, and these costs should be 

charged to the corresponding rental object/tenant of the contract. 

Select the rental object and contract fields, and specify a service charge key with the property RO - 

Directly Posted or RO/Contract Directly Posted. In the IMG activity Accounts Allowed for Individual 

Service Charge Keys you can also assign more than one service charge key to the account property. 

@AH@ Account properties for directly posted accounts should be allowed only for rental objects and 

possibly contracts, and not be permitted for any other object type. 

. 

You want certain accounts to be used only for a particular service charge key. 

Enter "Permitted for Certain Service Charge Keys" in the SU field. In the activity Accounts Allowed for 

Individual Service Charge Keys, enter the service charge keys for which the accounts are to be posted 

with this property. If you are using only one service charge key, you can also enter it directly. 

If you want to post settlement units independently of the service charge key, enter "Generally Permitted" in 

the SU field. 

 Define Accounts Allowed for Individual Service Charge Keys 

Use 

In the RE-Specific Account Properties IMG activity, you can specify that certain accounts can only be used 

for settlement units with specific service charge keys. To do so, you choose the entry "Permitted for 

Certain Service Charge Keys" in the SU (settlment unit) field. 

In this activity, assign all service charge keys, for which you want to allow posting, to an account property. 

If you assigned any service charge keys that are for "directly postable costs," then the account properties 

have to be set up so that they are allowed for rental objects, or for both rental object and contract. 

Requirements 

First maintain the account properties 

Note 

For directly posted costs, the system makes checks during posting to see which settlement unit or 

settlement period the posting belongs to. In addition, the system uses the account property and the 

account to determine the service charge keys that are compatible with them. Then it tries to find the 



 

 

posted rental object in a settlement unit that has one of these service charge keys. This indirect 

assignment between the rental object and the directly postable settlement unit therefore has to be unique. 

In order to ensure that settlement master data is not created incorrectly, set up the system so that for each 

account exactly one service charge key can be used for a directly postable rental object. You may also 

want to allow exactly one service charge key to be used for a directly postable rental object/contract. The 

same account can also be used for other settlement units. 

 Assign RE-Specific Properties to G/L Account 

Use 

In this activity, you assign the RE-specific account properties, which you already defined, to the G/L 

accounts to which they apply. 

 Automatically Generated Accounting Documents 

 Set Up Number Range for Automatically Created Posting 

Documents 

Use 

A reference document number is assigned for documents that are automatically generated in Flexible Real 

Estate Management (RE-FX). This number is structured as follows: 

- Unique eight-digit number for the posting process and the calendar year 

- Four-digit number that represents the calendar year 

- Eight-digit sequence number for the posted document for this posting process ( beginning with ) 

The number is saved in Financial Accounting (FI) in the reference key field in the document header of the 

posted document. In addition, certain processes transfer a number to the reference document number field. 

This number consists of the number of the process, an ID for the process, and the fiscal year. 

A number range is required for the following processes: 

- REPP: Periodic Postings: Contracts 

- REVP: Periodic Postings: Objects ( Vacancy ) 

- REIT: Input Tax Distribution 

- REOP: One-Time Postings 

- RESC: Service Charge Settlement 



 

 

- RESR: Sales Settlement 

- REAL: Accrual/Deferral 

- RERV: Reversal (of one of the processes named above) 

Activities 

Choose Change Intervals and create a number range interval with the number  for all years in which 

postings are made. Enter limits for the interval (normally  - ). Do not set the Ext (External Number 

Assignment) indicator. 

Note that a number assigned by the system (Current Number field) cannot be reset, otherwise it is no 

longer possible to correctly assign the posted documents to the processes. 

 Allow Integrated Posting 

Use 

You specify here if you want to allow integrated postings: Integrated Postings. 

 Taxes 

 Taxes 

Use 

In this section, you define the tax types and tax groups you plan to use. If you use value added tax: There 

is no value added tax indicator in RE-FX. You must therefore define other tax indicators and then assign 

these to the value-added tax codes in your accounting system. 



 

 

 Define Tax Types 

Use 

In this activity you enter the necessary tax types. 

Specifying tax types is mandatory. Tax types are country-dependent. 

You can define multiple tax types for each country. 

 Create Tax Groups 

Use 

Specifying tax groups is mandatory. The tax group determines the tax rate for a transaction. The tax 

group, together with the country, the tax type,  and possibly the region determines the tax percentage 

rate. 

Example 

You can define the following tax groups: 

Tax Group Meaning 

Full Full Tax Rate 

Half Half Tax Rate 

None No Taxation 

Activities 

Define your tax groups. Then assign the corresponding tax code to them in Customizing for Financial 

Accounting. 

 Default Value for Tax Rate per Contract Type 

Use 

For each contract type, you specify here which tax group and which tax type is proposed by the system 

when a contract is created. For contract types that are not relevant for tax ( internal contracts, G/L 

account contracts), you can also specify that these contract types are treated as tax exempt. 

Activities 

If you set the Tax Exempt indicator, then the tax type and tax group are not entered during master data 

processing of contracts with this contract type. In that case, leave the Tax Type and Tax Group fields 

blank in this view, otherwise the cash flow generation would incorrectly use the tax type and tax group 

entered here. 



 

 

 Account Determination 

 Account Determination 

Use 

In this section, you make settings for account determination. 

Based on your flow types, you create account symbols for account determination, independent of your 

accounting system. These account symbols are then replaced by G/L accounts in your accounting system 

during actual use. 

For automatic postings, you also create  account determination values . 

The account determination process 

Account determination controls how posting is made to specific accounts. This control is based on flow 

types. Flow types point to the desired accounts using account symbols. 

In Flexible Real Estate Management, postings are initiated by conditions. The conditions point to flow 

types, which in turn use account symbols to point to the accounts. 

For example, condition type ' Basic Rent' points to flow type ''.  Credit and debit account symbols are 

assigned to flow type ''. These then point to the account to be posted, depending on the chart of accounts. 

Requirements 

1. The accounts have been created in the accounting system. 

2. The flow types have been created in Flexible Real Estate Management 

 Account Symbols 

Use 

In this activity, you define account symbols that are then replaced in your accounting system by accounts, 

dependent on the chart of accounts. (For more information, see the Replace Account Symbols IMG activity.) 

The posting specifications in RE-FX do not contain accounts. Instead they contain account symbols that 

refer to accounts in the accounting system. 



 

 

 Account Determination Values 

Use 

In addition to account symbols, you can define account determination values. You enter them in posting 

rules on the contract or rental object, and they control account determination for automatic postings. 

 Assign Account Symbol to Flow Type 

Use 

In this  step, you assign account symbols to the flow types defined in the Define Flow Types IMG activity. 

 Summarize Documents 

 Activate Document or Tax Summarization in Company Code 

Use 

Here you can specify the company codes in which debit/credit line items and tax items should be 

summarized. 

Example 

For more information and examples about tax summarization, see this text. 

 Make Settings for Summarization Flow Type 

Use 

During periodic posting, items can be summarized for different flow types. 



 

 

Here you set how the summarization should take place for each flow type that is to be used as a 

summarization flow type. 

Requirements 

Summarization is only made in the company codes in which this is set in the Activate Document or Tax 

Summarization in Company Code IMG activity. 

The summarization flow types are technically normal flow types. You have defined this in the Flow Types 

IMG activity. 

Activities 

You should make settings for all flow types here that you (want to) use in the flow types IMG activity in the 

summarization flow types column. 

Notes 

- Note that flow types, which are set as summarization flow types there, but are missing here, are not 

summarized! 

- Summarization only takes place when the same account symbol was assigned for the original flow type 

in account determination. 

- The summarization is always period-based, for example, SC advance payments are only summarized 

within the respective settlement period, but not outside it. 

Settings 

Make the following settings for each summarization flow type: 

- Control of Due Dates: 

How should the due date of the line items to be summarized be entered in the summarized item? 

- Tolerances: 

- A tolerance in days for the summarization of credit memos with different due dates. 

- A tolerance in days for the summarization of receivables with different due dates. 

- Settling receivable/credit memo: 

Set this indicator to settle receivables and credit memos with each other. 

Then check in the flow types IMG activity whether the desired summarization flow types are assigned to all 

flow types. 



 

 

 Summarization in the Case of Different Tax Codes 

Use 

You have activated line item summarization in the company code. As with credit items, debit items with 

differing tax codes (or tax type/tax group) are not summarized in the standard system. If you want to 

summarize items with differing tax codes, you can create a customer-specific implementation of the BAdI 

BADI_RERA_DOC (method BEFORE_POST). Use the example class 

CL_EXM_IM_RERA_DOC_TAXCOMPRESS as a template. 

Important 

- Advance payments that are to be included in service charge settlement or sales-based settlement 

must not be summarized in this way. 

- The BAdI changes the RE document before posting and is run for all automatic posting processes 

that are initiated from RE. Check whether other implementations are already active in your system 

and ensure that these are compatible with the new implementation to be created. 

- Note that the sequence can lead to problems when such items are processed further. For example, the 

tax data cannot be displayed correctly on the tenant account sheet or in invoice printing because the 

tax information is lost in the line item. The formation of installment payments or irrecoverable debts 

can lead to problems. 

First test all subsequent processes carefully before you activate this BAdI implementation in the production 

environment. 

Documentation BAdI_RERA_DOC 

 Enhancements 

 Periodic Posting: Restrict Selection of Cash Flow Records 

Use 

The BAdI allows you to intervene in the process of periodic posting using your own customer-specific 

parameters. 

This applies to cash flow records that would be posted in one document in the standard system. You can 

additionally filter these documents using the BAdI method SUPPRESS_CF_ITEM. Notes for 

Developers 



 

 

 Prevent Object Transfers 

Use 

You can use this BAdI if you want to suppress object transfers (transfer from the contract to assigned rental 

objects) during periodic posting and service charge settlement. In that case the real estate contract remains 

the object to which account assignment is made in the revenue posting. 

Activities 

Implement the method SUPPRESS_TRANSFER_POSTING and set the parameter cf_suppress_transfer 

there to 'X'. 

Also see the example implementation in class CL_EXM_IM_RERA_TRANSFER_POST. 

Example 

In the example, the distribution postings are controlled dependent on the contract type of the contract. 

For contracts with customer accounts, the distributions are suppressed, but not for other contract types. 

Notes for Developers 

 Change RE Document Before Posting 

Use 

Using this BAdI, you can change document data of an RE document before the FI document data is 

created, meaning that it is also before the data is transferred to the Accounting Interface. 

You can use the following methods: 

- BEFORE_POST 

- BEFORE_POST_EXTERNAL 

- AFTER_POST 

- BEFORE_REVERSE 

- AFTER_REVERSE 

Using the BEFORE methods, you can change or check the data before it is posted or reversed. Using the 

AFTER methods, you can react to the posting or reversal and, for example, send your own messages or 

update your own tables. 

The BAdI is executed for all RE posting processes, such as: 



 

 

- Periodic posting 

- Input tax distribution 

- Service charge settlement 

- Sales-based settlement 

However, the BAdI is not executed for pure FI postings (such as, FB, FB), even if there is account 

assignment to real estate objects. 

Important: Only change non-critical data, such as payment data, dunning data, segment text, and so on. 

Never change critical data such as accounts or amounts. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

The following parameters are available for the methods BEFORE_POST and 

BEFORE_REVERSE: 

- ID_PROCESSMODE: Mode of the process (simulation/update run) 

- CS_HEADER: Document header data (can be changed) 

- CT_ITEM: Line item data (can be changed) 

- CT_WT_ITEM: Withholding tax data for line items (withholding tax type and withholding tax code) 

- CT_MESSAGE: Messages (can be changed) 

If you insert an error message in CT_MESSAGE, then the document is not posted. In this way, you can 

prevent the posting using your own checks, if you wish. 

The following parameters are available for the BEFORE_POST_EXTERNAL method: 

- ID_PROCESSMODE: Mode of the process (simulation/update run) 

- CS_HEADER: Document header data (can be changed) 

- CT_ITEM_RE_DOC: Line item data of RE document 

- CT_ITEM_EX_DOC: Line item data of external document (can be changed) 

- CT_WT_ITEM: Withholding tax data for line items (withholding tax type and withholding tax code) 

- CT_MESSAGE: Messages (can be changed) 

If you insert an error message in CT_MESSAGE, then the document is not posted. In this way, you can 

prevent the posting using your own checks, if you wish. 



 

 

Method BEFORE_POST_EXTERNAL can be used, for example, to summarize the items of external 

document CT_ITEM_EX_DOC according to specified criteria. However, in that case, it is important to 

adjust the item references in the unchanged RE document CT_ITEM_RE_DOC accordingly. 

The following parameters are available for the AFTER_POST method: -

 ID_PROCESSMODE: Mode of the process (simulation/update run) -

 IS_HEADER: Document header data (no changes allowed) 

- IT_ITEM: Line item data (no changes allowed) 

- IT_WT_ITEM:  Withholding tax data for line items (no changes allowed) 

- CT_MESSAGE: Messages (can be changed) 

Once the posting is made, changes are no longer allowed. However, you can add your own messages to 

CT_MESSAGE. 

The following parameters are available for the AFTER_REVERSE method: 

- ID_PROCESSMODE: Mode of the process (simulation/update run) 

- ID_REVERSAL_REF: Reference key of the reversal document (no changes allowed) 

- ID_LOGSYSTEM: Logical system (no changes allowed) 

- IS_HEADER: Document header data (no changes allowed) 

- IT_ITEM: Line item data (no changes allowed) 

- IT_WT_ITEM:  Withholding tax data for line items (no changes allowed) 

- CT_MESSAGE: Messages (can be changed) 

The data in IS_HEADER, IT_ITEM and IT_WT_ITEM relates to the original document that was 

reversed. 

Example 

As an example, you write a reference of your choice in the EXTREF, EXTREF or EXTREF field. The 

contents of these fields is transferred, when an FI document is posted, to the BSEG-XREF, XREF, or 

XREF fields, where the contents are then available to other processes.  This procedure is used, for 

example, in Switzerland for the ISR (inpayment slip with reference) reference. 

Also refer to the sample code of the BEFORE_POST method. Choose Goto -> Sample Code -> Display. 

Note: 

The system runs through this BAdI before document summarization. In this way, changes to the line items 

are taken into account during the summarization. 



 

 

The GENDATA field of the item table is not considered during summarization and is not transferred to the 

document. It is a purely technical field, which is suitable for transporting data to the BAdI 

REEX_FI_BAPI. 

See also 

For information on using BAdIs, see this documentation. 

Notes for Developers 

 Change Document Split 

Use 

This Business Add-In (BAdI) can be used to implement your own customer-specific document splitting. 

This applies to cash flow records that would be posted in one document in the standard system. You can 

further break these documents down using your own criteria. However, you can only refine the split that 

would be made in the standard system. It is not possible to merge documents together (for instance, to 

group line items together in one document if they would normally have different document types). 

The following methods are provided: 

- SPLIT_DOCUMENT: Splits the document based on any customer criteria 

- SET_NUMBER_OF_RECORDS_PER_DOC:  Specifies the maximum number of records per 

document 

. 

The BAdI is executed during periodic posting and periodic posting for vacancy. 

The BAdI is not allowed to be used for documents from input tax distribution, service charge settlement, 

and sales-based settlement, as well as documents from one-time postings. For each of these documents 

the document structure is fixed. 

Activities 

Create a BAdI implementation and implement the methods SPLIT_DOCUMENT and 

SET_NUMBER_OF_RECORDS_PER_DOC as you require. Then activate the BAdI implementation. 

The SPLIT_DOCUMENT method contains the following parameters: 

- ID_PROCESSMODE:  Mode of the process (simulation/update run), cannot be changed 

- CT_POSTING_RECORD: Posting records (cash flow records to be posted); you can change the 

sorting of this table, and if you wish, place the 'SPLIT' field at another position. But do not 

change any other fields. 



 

 

- CT_MESSAGE: Messages (can be changed); normally does not have to be filled; if you add an 

error message to CT_MESSAGE, then the document is not posted. If you add a warning or 

information message, the document is posted, but the message is entered in the posting log. 

The SET_NUMBER_OF_RECORDS_PER_DOC method has the following parameters: 

- ID_PROCESSMODE:  Mode of the process (simulation/update run), cannot be changed 

- IT_POSTING_RECORD: Posting records (cash flow records to be posted); you cannot 

change this table. 

- CD_REC_PER_DOC: Number of cash flow records within the accounting document. In the 

standard system, the default value is . You can change this value. Keep in mind that an FI 

document can have a maximum of  line items. 

Example 

For the method SPLIT_DOCUMENT, there is an example implementation that splits the cash flow records 

to be posted according to their due dates. The result is that in each document all the items have the same 

due date. 

For the method SET_NUMBER_OF_RECORDS_PER_DOC, there is an example implementation that 

increases the number of cash flow records within the accounting document if line item summarization is 

active in the company code. Notes for Developers 

 Prevent Clearing of Items by RE Processes 

Use 

You use this Business Add-In (BAdI) if you want to suppress clearing in the context of service charge 

settlement, sales-based settlement, COA settlement, and so on, for example because clearing should take 

place outside of the settlement using your own programs. 

You can also influence the selection of items for clearing with respect to rental contracts (transaction 

RERACL). 

Requirements 

The advance payment items posted by the service charge settlement then remain open. You have to clear 

them manually, for example using transaction FB, or using your own customer-specific program. 

To be able to clear non-payable special G/L indicators, you have to set message REEXFI  to a warning in 

transaction OBA. 

If it afterwards becomes necessary to reverse the service charge settlement, you first have to reset 

manually made clearings using transaction FBRA. 



 

 

Activities 

Implement the method SUPPRESS_CLEARING and set the parameter cf_suppress_clearing there to 'X'. 

Implement the method MODIFY_CLEARING_ITEM_LIST if you want to change the list of open items 

that are intended for automatic clearing (Clearing for RE Contracts RERACL). This makes it possible, 

for example, to exclude certain contracts from clearing. 

Also see the example implementation. 

Notes for Developers 

 Reversal - Additional Checks 

Use 

You use this Business Add-In (BAdI) if you want to intervene in the document selection of the reversal 

process, or if you want to output errors based on your own checks. 

Activities 

Implement the method MODIFY_DOC_SEL_FOR_REPP_REV, if you want to execute checks for all of 

the documents selected during reversal of periodic posting ( RERAPPRV ). 

Parameters: 

ID_PROCESS: predefined as REPP 

IS_REV_OPTIONS: Options that were selected in the selection screen of RERAPPRV, for example, 

selected contracts or processes 

IT_PROCEDURE: Transactions, for which documents were deleted 



 

 

CT_DOCGUID_LIST: List of the selected documents that are to be reversed 

CT_MESSAGE: If you assign a message (type E) to CT_MESSAGE, the message is displayed in the 

selection screen of RERAPPRV and the reversal is not performed. Warning message or information 

messages are not taken into account. 

Also see the example implementation in class 

CL_EXM_IM_RERA_REVERSAL. 

Example 

In the example, the system first reads all RE documents using their GUID. In addition, it gets the FI 

document header information (table BKPF). 

Now, for example, you could use your own customer table to check for each selected document if the 

document is allowed to be deleted, or if another document also has to be deleted, and so on. 

Notes for Developers 

 Integration FI-GL, FI-AR, FI-AP 

 Integration FI-GL, FI-AR, FI-AP 

Use 

In this section, you make settings within your accounting system for the General Ledger and Accounts 

Payable and Receivable. 

 Account Determination 

 Replace Account Symbols 

Use 

The account symbols you specified in the Account Symbols IMG activity have to be replaced 



 

 

by G/L accounts in the accounting system, dependent on the chart of accounts. Account determination is 

then able to find these G/L accounts. 

Activities 

Note: 

- If you are posting to accounts in the subsidiary ledgers (accounts payable or receivable, account type 

D or K in the Assign Account Symbol to Flow Type IMG activity) leave the account blank. Enter 

only the special G/L indicator, if needed. 

- If you want to use a different account for postings in previous fiscal years, enter the account you 

want to use as the different account. 

 Define Document Type Determination 

Use 

In this section, you create defaults for determining document types. 

You define document types in Financial Accounting (FI) in the Define Document Types IMG activity. 

Standard settings 

Not all posting processes use a flow type for posting. Flow types are used primarily in periodic posting. If 

there are several flow types in one document, then the system uses the setting from the first flow type 

found. 

You do not have to make settings here for the following processes: 

- RERV - Reversal Process: For reversals, the system uses the document type entered in Customizing for 

Financial Accounting (see Define Document Types). 

- REAL - Accrual/Deferral: For accruals and deferrals, the system uses the document type entered in 

Customizing for the Accrual Engine (see Define Set of Rules). 

Activities 

Document types can be dependent on: 



 

 

- RE posting processes (periodic posting, service charge settlement, and so on) 

- Transactions (receivables, transfers, and so on) 

- Flow types 

You can leave the Posting Procedure and the Flow Type blank for any given process you enter. If there is 

no entry for a posting process, then the posting interface of the FI component automatically uses document 

type 'AB' (accounting document). 

 Taxes 

 Assign Tax Codes 

Use 

In this step. you assign a tax code in your accounting system to the tax types and tax groups that you 

defined in Flexible Real Estate Management. You define tax codes in Customizing for your accounting 

system. 

The tax code is needed for calculating tax on sales/purchases. The tax code assignment is both country-

dependent and time-dependent. 

Example 

Changes in the value-added tax rate then only have to be made in Customizing, rather than in all affected 

contracts. 

 Assign Tax Code (for FI Document) 

Use 



 

 

In this step. you assign a tax code in your accounting system to the tax types and tax groups that you 

defined in Flexible Real Estate Management. You define tax codes in Customizing for your accounting 

system. 

The tax code is needed for calculating tax on sales/purchases. The tax code assignment is both country-

dependent and time-dependent. 

Example 

Changes in the value-added tax rate then only have to be made in Customizing, rather than in all affected 

contracts. 

Note 

You have to make this assignment in order for FI documents to be correctly read in RE. This assignment is 

relevant, for example, for service charge settlement and input tax distribution. 

 Assign Tax Transaction Key 

Use 

In this step you assign a tax type to the tax transaction key. This assignment is both country-dependent and 

time-dependent. The tax transaction key specifies which tax account is posted. 



 

 

 Dunning 

 Define Dunning Groupings 
Use 

Dunning notices are normally created per business partner. In special cases, it can make sense to group 

together the open items of a business partner based on certain criteria, and dun these as a group. 

In order to group items together for dunning, you have to define grouping keys. (These are two-character, 

alphanumeric keys.) The contents of certain line items are the determining factors for the grouping. For each 

key, you enter up to two fields from these line items. When items have the same contents in these fields, 

then they are dunned together. 

Example 

You are using Financial Assets Management, and want to send your business partners a separate dunning 

notice for each rental object. You define a grouping key that relates to the contract number field. Inthis way, 

you can dun open items together that have the same contract number. 

Activities 

.In Financial Accounting, define the grouping keys you need in the Define Dunning 

Groupings IMG activity, and enter the dunnable incoming payment methods in the 

Determine Dunnable Payment Methods IMG activity in Customizing for Flexible 

RealEstate Management. 

.Make sure that a grouping key is entered in the master records of those business partners, for 

whom you want to group items together for dunning. 

Result: 

In addition to those items that are dunned based on the logic in Financial Accounting, all items are also 

dunned that have a dunnable payment method in the item or in the customer master record. 

If grouping key  'Contract Number/Contract Type' is entered in the customer master record, then all open 

items of the real estate contract are automatically dunned as dictated by the dunning level. 

Requirements 

All postings have to be made with contract type  and a contract number as a reference. 

Further Settings 

If you want dunning to be per customer, you have to make settings in the Define Dunning Areas IMG 

activity. 

 Define dunning areas 

Use 



 

 

In this activity, you specify all dunning areas that you want to be considered RE dunning areas. This ensures 

that postings without a reference appear on the dunning form (for example, a payment that was posted with a 

corresponding RE dunning area). 

Dunning areas are used when more than one organizational unit in a company code is responsible for 

dunning. These organizational units are then designated as dunning areas. The dunning area could be a 

division, a sales organization or a business area, for example. 

The individual dunning areas can use the same dunning procedure or different dunning procedures. 

- If they use different dunning procedures, then the dunning area has to be entered in the customer or 

vendor master record. 

- If they use the same dunning procedures, then the system uses the standard dunning procedure. The 

dunning area then has to be entered in the line item. The system then enters the dunning area, with 

its data, automatically in the master record. 

@S@ The use of dunning areas is optional. 

Requirements 

In order for the dunning area field to be ready for input in the line item, you have to specify that dunning 

takes place separately for different dunning areas. This is done in the company-code-specific settings for 

dunning. For more information, refer to Define Dunning Procedure. 

Activities 

Define the dunning areas you need. 

Make sure that the company codes involved are set up for dunning by dunning areas. 

Make sure that the dunning areas, with their dunning procedures, are entered in the master records of your 

business partners, if your dunning areas use different dunning procedures. 

 Assign Application/Role Category/Dunning Parameter 

Use 

In this activity, you can specify which business partners are to be sent dunning notices. 

Activities 



 

 

Assign a business partner role category to the application category for business partner management and 

specify based on the dunning level whether it is the dunning recipient, alternative dunning recipient, or not 

a dunning recipient. 

Example 

Application Category Role Category  Indicator  Dunning Level 

General Real Estate Contract Mast.Tenant Cust. Dunning Recipient 

General Real Estate Contract Tenant (w/o Cust. Account)  Alternative dunning recipient  

 Determine Dunnable Payment Methods 

In this activity, you determine which incoming payment methods can be dunned. 

Activities 

Define any payment methods as dunnable if you want them to be dunned in Flexible Real Estate 

Management. For more information, see Define Dunning Groupings. 

 Payments 

 Payable Special General Ledger Processes ( Debit-Side ) 

Payable special G/L transactions ( debit-side ) 

Special G/L transactions are required for advance payment postings (operating costs, heating expenses, 

sales-based rent). You create these G/L transactions in Customizing of Financial Accounting. See also 

Accounts Receivable and Accounts Payable. 

In this table, you determine: 

1. Which special G/L transactions to display and which to pay. If you make an entry here, the payment 

program includes only those items that have one of the special G/L transactions named. The entries 

in this table also influence the items that are displayed in the tenant account sheet. 

2. Which reconciliation accounts are not to be selected by the payment program. This step influences 

the performance of the payment program. Enter the reconciliation accounts of the special G/L 

transactions that cannot be paid. These items will then not be selected. 

Example 



 

 

The settings of the standard delivery are such that advance payments are posted on the debit-side with 

special G/L indicator J, and on the credit side with special G/L indicator K. Postings with special G/L 

indicator J represent a transaction that has to be paid by the tenant. Those with a K represent noted items 

that are automatically cleared during the service charge settlement. Consequently you should only enter 

the J indicator in this table and not K. 

The reconciliation account of special G/L transaction K is account . This account should be excluded from 

the selection to increase the performance of the payment program. 

Further notes 

Note that this table belongs to Customizing of Financial Accounting. 

 Other Settings for FI 

Use 

In this view, you make FI-specific settings that are company-code dependent. See the documentation for the 

fields. 

 Incoming Payments Control 

 Posting Key for Bank Debit Posting (Incoming Payments) 

Use 

Enter the posting key here that should be used for account statement entry for a bank posting. 

Recommendation 

Usually posting key  is used. 

 Enter Posting Keys for Clearing and Advance Payment 

Use 

In this step, you enter the posting keys for clearing transactions. The system uses these keys for 

automatic creation of line items. The payment program also uses these posting keys. In the Real 

Estate environment, the settings for the EINGZAHL activity are used to find the posting key for 

automatic clearing. 

The setting is also used to determine the posting key for payments on account during account statement 

entry. 



 

 

Recommendation: 

If you use the posting keys of the standard system, you can adopt the entered posting keys without changing 

them. 

Activities 

1. Check the standard settings. 

2. Change the standard settings if necessary. 

 Determine Incoming Payment Control 

In this section, you determine according to which rules the automatic incoming payment clears open items. 

Priorities (sort rules) are determined by means of the fields of the open item data structure. The open 

items are sorted according to these rules. The open items are cleared in the sorted sequence. 

The sort rules can then be applied in case where the incoming payment plus the credit balance drops below 

the totals of the open items. 

The rules are defined in three steps: 

1. Define order criteria 

For company code and contract type (always  for Real Estate), data fields from the open item table 

are defined as criteria, according to which the open items are sorted in ascending or descending 

order. Furthermore, you have to determine whether sorting is to be done directly or indirectly. 

a) Direct sorting sorts by the order criterion. 

b) Indirect sorting determines whether the sorting is done directly by the field contents or whether a 

priority is assigned, according to which sorting is carried out. Indirect sorting is then defined in 

detail. Indirect sorting allows sorting not directly by the defining argument 'Flow type' but that a 

priority is assigned to a special value of a flow type (for example, ''), by which sorting is then 

carried out (see point ). 

2. Determine the sequence of the order criteria 

You have to arrange the defining arguments in a sequence using number values ( lowest number = 

highest priority), by which sorting is carried out. 

Important: If no unique sequence was found after the open items were sorted using all the order 

criteria, the system proceeds as follows: 

a) First: Clearing the open items according to a unique sort sequence 

b) Then: Clearing the open items in a random sequence. 

Clearing is carried out in this described sequence until the incoming payment is exhausted. No 

partial clearing or residual item formation is carried out. Incoming amounts not used are posted as 

unqualified down payment of the customer and processed together with later incoming payments. 



 

 

In the configuration menu (basic settings in the client), you can determine the tax code that is to be 

used for this posting. The posting rules for the unqualified down payment are defined via the flow 

category 'UAN' ("Assign internal movement types" activity). The flow type referring to the 

respective posting rule in the account determination is defined for the flow category. 

3. Define indirect sorting 

For the company code, contract type (always  for Real Estate) and order criterion, sort 

sequences are assigned to the field values for indirect sorting. That is, that the respective sort 

priorities or sequences are defined for all values the table field can take on for the order criterion. 

Activities 

1. Order criteria for assigning incoming payment 

a) Determine your work area by specifying 

- Company code and 

- Contract type 

b) To make new entries, choose the 'New entries' function and enter the following line by line: 

- an indicator for the order criterion. 

- the name of the order criterion. 

- the field name of the field to be examined. 

- the sort direction for the evaluation of the order criterion ( ascending/descending ). 

- the processing method (indirect/direct sorting) 

In case of the indirect method, the referenced values are used as keys for an assignment table. 

The assignment table assigns a priority to these values, for example flow type. The set of 

priorities found is sorted and determines the sequence of assignment. 

c) Save your entries. 

2. Sequence of the order criteria Assignment for incoming payment 

a) Determine your work area by specifying 

- the company code and 

- the contract type 

b) To make new entries, choose the 'New entries' function and enter the following line by line: 

- a number between  and  to assign a priority to an order criterion. The highest priority is , the 

lowest priority is . You do not necessarily have to define the priorities as a sequence without 

gaps. 

- the indicator for the order criterion. The name of the order criterion is assigned to the 

indicator. 

c) Save your entries 



 

 

3. Value assignment for indirect order criteria Incoming payment 

In this table, you define the 'indirect method' for the determination of the assignment sequence of 

open items. By means of the 'indirect method', you assign different priorities to a table field 

depending on the field value (field contents). You have to determine the individual priorities for all 

order criteria, to which the indirect method is assigned ( see point ). 

a) Determine your working group by specifying 

- the company code, 

- the contract type and -

 the order criterion. 

b) To make new entries, choose the 'New entries' function and enter the following line by line: 

- the internal value. 

Here you have to specify the field value (for example, flow type ), to which a priority is to be 

assigned. For field values you do not define here, the lowest priority is assumed for sorting. 

Important: Numeric values have to be specified with leading zeros and the number of 

positions has to be entered left-justified, just as in the table field of the order criterion. 

- the priority. 

You assign a priority to each value. Sorting is carried out according to this priority in ascending 

or descending order, depending on the sort sequence of the order criterion. 

Note 

For more information on specific settings for Real Estate, refer to the documentation for the Real Estate 

IMG activity Electronic Account Statement Entry. 

 Prepare Account Statement Entry 

 Electronic Account Statement Entry 

Prerequisites 

The Business Transaction Events (BTE) must be active. Check the following setting: 

1. Start transaction FIBF. 

2. Choose Settings --> Identification --> SAP Applications.  

3. Check whether the Active field is set for the Real Estate (RE-FX) application. 

Procedure 



 

 

In RE-FX you can automatically process incoming payments and returned debit memos using account 

statement entry with different file formats (such as MultiCash or DTAUS). 

The method is based on the standard function electronic account statement entry in Financial Accounting 

(FI). The IMG activities are in Customizing for Financial Accounting under Bank Accounting and are also 

summarized in RE-FX. 

Account statement entry is divided into three steps: 

1. File import 

2. Analysis of the note to payee for each line item 

3. Corresponding postings 

Since RE-FX intervenes in the standard FI function (to assign an incoming payment directly to a 

contract, for example), the Customizing settings for the individual steps are explained in the following. 

. File Import 

Make the settings for the electronic account statement, particularly: 

1. Enter the house bank and the corresponding house bank accounts. 

2. Make the global settings for the electronic bank statement: 

- Create account symbols and assign accounts. 

- Create posting rules and assign them to the external transactions (see step  Analysis of Note to 

Payee). 

3. Configure returns processing 

For more information, see the documentation for the individual IMG activities. 

. Analysis of Note to Payee 

There are a number of standard and application-specific interpretation algorithms available for analyzing the 

note to payee of a line item. 

To assign incoming payments, standard FI (interpretation algorithm ) carries out a search for a document 

number or a reference document number of the open item. 

Tenants, however, do not usually know the document number, so they will enter the rental agreement 

number as the assignment criterion in the Note to Payee field. 

- To interpret the data on the data medium differently from the standard procedure, assign the Real 

Estate-specific interpretation algorithm () in the activity Make Global Settings for Electronic Bank 

Statement under Assign External Transaction Types to Posting Rules. If you have entered the RE-

specific algorithm  for a bank account and an external transaction, the RE-specific analysis of the 

note to payee in BTE (see Prerequisites) is run. Otherwise the module is exited and other 

applications (such as Treasury) can register for the transaction. 

- With returned debit memos, FI standard processing is used (see Configure Returns Processing). You 

should nevertheless enter the RE-specific algorithm  for this transaction because only then can the 



 

 

search for a clearing document number find the RE agreement and transfer it to the subsidiary ledger 

document. This makes it possible to assign the new open item and any fee to the agreement. 

Note: The interpretation algorithm  REAL ESTATE: First Standard, Then Rental Agreement Search is a 

setting for Classic RE and triggers the same search in RE-FX as for algorithm . 

. Corresponding Postings 

- If the incoming payment could be assigned to a rental agreement, the system now searches for the 

open items of the customer for that rental agreement. 

- If their sum is greater than the incoming payment, the open items are sorted according to rules that 

you define in Customizing. The open items are cleared in the predefined sequence until the 

incoming payments are depleted. 

- Choose the sort criteria for the open items in the activity Determine Incoming Payment Control. 

- In the following activity, enter a processing type for the posting rule that is to clear the open items: 

Account Statement Entry: Assign Transactions 

Example:  Returned debit memo (outgoing payments) or  incoming payments 

- If a difference remains, you can specify in the IMG whether an unqualified down payment or a new 

residual item should be posted. 

- You make the settings for account determination for the unqualified down payment in the IMG 

activity of Financial Accounting with the transaction EINZAHL: Define 

Posting Keys for Clearing 

Overpayments are posted to the customer account with this account determination. 

- For new residual items, check the indicator in the IMG activity of RE-FX: Basic Settings in 

Company Code. 

If the residual items indicator in the company code is set, open items are partially 

cleared and a new open item is posted for the remainder If the indicator 

is not set, an unqualified down payment is posted. 

 Define House Banks 

Use 

Each house bank of a company code is represented by a bank ID in the SAP system, every account at a 

house bank by an account ID. 

In the SAP system, you use the bank ID and the account ID to specify bank details. These specifications are 

used, for example, for automatic payment transactions to determine the bank details for payment. 

Standard settings 

Several house banks are supplied as examples in the standard system in order to enable configuration of the 

payment program. 



 

 

Note 

For domestic banks, you should enter the bank number in the "bank key" field and for foreign banks, you 

should enter the SWIFT code in this field. 

For Belgium, the first three house bank ID items must be numeric. 

Do not forget to create a G/L account for the specified bank account. The G/L account is to be managed 

in the same currency as the account at the bank. 

Activities 

1. Work out the specifications you have to enter in the system for your house banks. 

2. Define your house banks and the corresponding accounts in the system under a bank ID or an account 

ID. 

Additional information 

If you have already carried out the step   "Copy bank directory", you have already created house banks in 

the system or have updated the house bank data that already existed. 

If this is the case, in this step you only have to create the house banks that were not created in the "Copy 

bank directory" step. You can also add any data that may be required to house banks that were copied 

along with the bank directory. 

 Make Global Settings for Electronic Bank Statement 

Use 

Use 

In this Customizing activity, you can make basic settings for the account statement. There are six main 

steps to be carried out: 

1. Create account symbol 

Specify G/L accounts (such as bank, cash receipt, outgoing checks) to which postings are to be 

made from the account statement. You assign account symbols to the G/L account numbers. These 

are required for the posting rules in step . 

2. Assign accounts to account symbols 



 

 

Define postings to be triggered by possible transactions in the account statement (such as bank 

transfer, debit memo). 

Note: In the posting specifications debit -> credit that you define here, use the account symbols from 

step , not the G/L account numbers. This prevents similar posting rules being defined several times, 

the only difference between them being the accounts to which postings are made. 

3. Create keys for posting rules 

Assign the posting rules to the possible transactions in the account statement file. A list of such 

assignments where one external transaction code is assigned to one posting rule is called a 

transaction type. 

4. Define posting rules 

Create a posting specification for each posting rule. You thereby specify how a given business 

transaction is to be posted. 

5. Create a transaction type 

Create the names and descriptions of the various transaction types you require. 

In this activity you assign (external) business transaction codes to an (internal) posting rule. As a 

result, you can use the same posting specifications for different business transaction codes. 

6. Assign bank accounts to transaction types 

Assign the bank details to a transaction type, for which the account statements are to be imported. 

All the house bank accounts at a particular bank are usually assigned to the same transaction type. 

Requirements 

You have already entered your house bank data for the account details. If not, define your house bank 

data in Customizing under Bank Accounting -> Bank Accounts -> Define House Banks. 

Create account symbols 

In this activity you create the account symbols that you later need for defining the posting specifications. 

Before the posting rule is used, the account symbols are replaced with the relevant accounts to which 

posting is to be made. 

Example 

Create the account symbols BANK and CASH RECEIPT so that you can later define a posting rule for cash 

receipt. 

Activities 

1. Define an ID for each account symbol. 

2. Enter a description in the text field. 

Assign accounts to account symbols 

In this activity you define the account determination procedure for each individual account symbol. 

Example : 



 

 

Assigning G/L account  to account symbol BANK Chart of 

Accounts: INT (sample chart of accounts): 

Account symbol Acct mod. Currency G/LAcct 

BANK + +  

Example : 

To avoid having to define a separate account symbol for every single house bank account ( with a 

different G/L account in each case), the G/L account field can contain a masked output. 

Chart of Accounts: INT (sample chart of accounts) 

Account symbol Acct mod. Currency G/LAcct 

BANK + + ++++++++++ 

Here, the account determination replaces the account symbol BANK with the G/L account number of the 

house bank account defined in the house bank master data. The appropriate masking can also be used for 

the bank subaccounts. 

Example : 

Standard procedure for defining bank subaccounts 

Chart of Accounts: INT (sample chart of accounts) 

Account symbol G/LAcct 

BANK ++++++++++ 

CASH RECEIPT ++++++++ 

INCOMING CHECKS ++++++++ 

You can influence account determination further by making entries in the Account modification and 

Currency fields. 

Example  a : 

You wish to manage incoming checks in foreign currency (such as USD) in a different clearing account to 

incoming checks in local currency (such as EUR). You can do so by making the following setting. 

Chart of Accounts: INT (sample chart of accounts) 

Account symbol Acct mod. Currency G/LAcct 

INC. CHECKS + + ++++++++ 

INC. CHECKS + USD ++++++++ 

Example  b : 

You wish to process the business transaction credit memo for rent in a different account than is 

otherwise used for the credit memo posting rule. For this business transaction, you specify an account 

modification and the account to which posting is to be made (such as ). 



 

 

Chart of Accounts: INT (sample chart of accounts) 

Account symbol Acct mod. Currency G/LAcct 

INC. CHECKS + + ++++++++ 

INC. CHECKS RENT +  

In addition, the field FEBEP-KFMOD has to be filled for the given transactions, either in the function 

enhancement for the electronic accounts statement (see the Customizing activity Develop Enhancements 

for Electronic Bank Statement (General)), or by using the search string search with the target field 

Account Modification (see the Customizing activity Define Search String for Electronic Bank 

Statement). 

Note 

Note that masked entries (using a plus sign +) are always based on a ten character account number. If you 

are using a shorter account number (six characters, for example), the entries must be right-aligned. 

Create keys for posting rules 

In this activity you enter descriptions for the necessary posting rules. Each posting rule represents a 

business transaction from the SAP System that is included in the account statement, such as: 

- Incoming check 

- Credit memo 

- Debit memo 

- and so on 

Example 

You create the posting rule  (cash receipt via interim account) for cash receipt. 

Activities 

1. Define an ID for each posting rule. 

2. Enter a description in the text field. 

Define posting rules 

In this activity you create posting specifications for each posting rule. You use the posting specifications to 

specify how a certain business transaction (such as a credit memo) is to be posted. 

Posting specifications consist of one or two posting records debit -> credit, where the first posting record 

is called posting area , and usually represents a G/L account posting ( BANK -> CASH RECEIPT, for 

example). The optional second posting record is called posting area  (CASH RECEIPT -> CUSTOMER, 

for example). 

Depending on whether a posting transaction affects bank accounting only, or also affects subledger 

accounting, define the posting rules either for the first posting area only, or for both the first and the 

second posting areas. 

Example  



 

 

For the transaction "check credit memo", you only need posting rules for G/L accounts because the 

customer account has already been cleared as a result of the check deposit. For a bank transfer, however, 

you will need a second posting area in addition to the posting rules for the G/L accounts in order to clear 

the customer account. 

Activities 

Define the posting rules for posting area  and : 

1. Enter the posting type (posting or clearing G/L accounts or subledger accounts, reversing clearing). 

2. Enter the accounts (that is, the account symbols) and posting keys for both the debit and credit sides of 

the posting record. Depending on the type of posting (clearing/posting), it may be necessary to leave 

the fields on either the debit or credit side blank. For example, with posting type  (credit clearing for 

subledger accounts), the system uses the note to payee information to try to identify and clear an 

appropriate open item. In this case, there is no need to specify the account and posting key beforehand 

since they will be determined automatically during the open item search. 

3. Specify the document type. 

4. If required, make entries in the optional fields for compression, special G/L indicators, and posting 

keys for payment on account. 

Example 

Posting rule  

PArea PK (D): Account (Deb.) PK (C): Account (Cred.) DT PstType 

  BANK CASH RECEIPT SB    

  CASH RECEIPT DZ    

Create a transaction type 

In this activity you create the names and descriptions of the various transaction types you require. House 

banks that use identical lists of business transaction codes (external transactions) can be assigned to the 

same transaction type later. 

Example 

You create transaction type MC for account statements in MultiCash format. 

Activities 

Create the names and descriptions of the various transaction types you require. 

Assign external transaction codes to posting rules 

In this activity you assign (external) transactions to an (internal) posting rule. This means that the same 

posting specifications can be used for different business transaction codes. 

Example 

1. Business transaction code  is for debit memos by direct debit 



 

 

2. Business transaction code  is for debit memos by automatic debit 

3. Business transaction code  is for debit memos by transfer order 

From the point of view of your organization, the external business transactions listed above use identical 

posting procedures and must therefore be assigned to the same posting rule (for debit memos). The same 

posting rules can also be used for different bank details, even if different business transaction codes are used 

(if different file formats are used, for example). 

Activities 

1. For each transaction type, assign a posting rule to each external transaction key. 

2. In the +/- Sign field, enter + or - to indicate whether payments are incoming or outgoing. 

3. If necessary, define an interpretation algorithm if open items are to be cleared automatically as a 

result of the posting. 

Remark 

The Processing Type field is currently only used for the formats BACS (England), BAI (USA), and 

BRADESCO/ITAU ( Brazil ). 

For business transaction codes for messages in format camt, you have to place the prefix <> before the 

business transaction code of the bank. Example for a business transaction code in the statement file: 

<BkTxCd><Domn><Cd>PAYM</Cd><Fmly><Cd></Cd><SubFmlyCd>< 

/SubFmlyCd></Fmly></Domn><Prtry><Cd></Cd></Prtry></BkTxCd> 

For this example, you would make the entry <>PAYM in Customizing. 

Note regarding unknown external transactions 

If the bank uses an external transaction that you have not yet entered in Customizing, the system 

terminates the processing of the account statement. 

In order to ensure that the processing of the account statement does not terminate, you can define the 

external transaction UNALLOCATED. 

Example 

To have the system post the unknown external transaction in bank accounting, but assign them to the 

worklist for postprocessing in the subledger, proceed as follows (for example): 

Create two posting rules UNA (unknown cash receipt transaction) and UNA (unknown cash disbursement 

transaction): 

Posting rule Posting area Debit Account Credit Account 

UNA  Bank  Cash Receipt 

UNA  Cash Receipt     

UNA  Cash disbursement  Bank  

UNA      Cash disbursement  

Posting type 

Then set up the external transaction UNALLOCATED for each of the transaction types you use, as follows: 



 

 

External transaction+/- Sign Posting rule Interpretation algorithm 

UNALLOCATED + UNA No interpretation 

UNALLOCATED - UNA No interpretation 

Assign bank accounts to transaction types 

In this activity you assign each of your bank accounts to a transaction type. 

You can specify a worklist of G/L accounts. This enables you to search several bank subaccounts for open 

items that the system could not clear during posting of the account statement when you postprocess the 

account statement. 

If you select the field No Automatic Clearing, an open item remains, even if the amount of the open item 

agrees with that in the account statement. 

Example 

- In the account statements you receive from bank X and bank Y, the business transaction code  

indicates that the transaction involves a credit memo. This transaction is represented by the posting 

rule  in your organization. 

- Bank Z uses different business transaction codes than banks X and Y. A different posting rule should 

be used for business transaction code  in this case. It is also possible that a totally different business 

transaction code is used for credit memos for the file formats used by bank Z, and that posting rule  

must be assigned to this code. In this scenario, you would use two transaction types: One transaction 

type for bank Z and another transaction type for banks X and Y. 

In addition, you can assign your house bank accounts to a currency class. This setting is necessary for the 

Spanish CSR format. 

Activities 

Assign your banks to a transaction type and, if necessary, a currency class. The banks are identified by their 

bank key and external account number. 

Further notes 

For more information, see the SAP Library under Financials -> Financial Accounting -> 

Bank Accounting -> Electronic Bank Statement. 

For information on the settings specifically for Real Estate, refer to the RE-specific IMG documentation, 

Electronic Account Statement Entry. 

 Configure Returns Processing 

Use 



 

 

Here you specify how the electronic account statement processes returned debit memos. 

- Assign Internal Return Reasons to External (return reasons): 

You assign a combination of an external transaction and an external returns reason to an internal 

returns reason, dependent on the bank details. 

If you want to make the same assignment for all bank details of a transaction category then you can 

enter the transaction type, and leave the fields for the bank details blank. If the bank statement does 

not contain a return reason, or if you want to define the same return activities for all return reasons, 

then enter only the external business transaction code and leave the External Returns Reason blank. 

- Return Activities: 

Here you specify the account to which the return line items and fees should be posted. You also 

specify if clearing should be reversed for the source document (also see Reverse Clearing). 

- Change Open Items: 

If you set the Reverse Clearing indicator in the Return Activities, then you can have the system 

automatically change the customer items that are reopened, per company code. For this procedure, 

you can 

- Set a dunning or payment block 

- Change or delete the payment method 

If you do not enter anything in these fields, then the system does not change these documents. 

 Business Add-In: Processing of Returns 

Use 

This Business Add-In (BAdI) is used in the component Electronic bank statement (FI-BL-PT-BS-EL). 

With this BAdI you can control the processing of returns. On the basis of the 

bank statement data (Import Parameter I_FEBKO (header data), 

I_FEBEP(Line item) and the table T_FEBRE (Payment note)) you can decide if a line item is a return and if 

there are bank charges. You can also search for the returns reason and charges in the payment note. 

The BAdI is called up directly after importing the bank statement data. 

Requirements 

Standard settings 



 

 

The Business Add-In is not active in the standard system. 

Activities 

After calling up the IMG activity, a dialog box appears, in which you can enter a name for the 

implementation. 

If you have already made other implementations for this BAdI, another dialog box appears, in which the 

existing implementations are displayed. In this case, choose Create, and proceed as follows: 

1. In the dialog box, enter a name for the BAdI implementation in the Implementation field, and choose 

Create. 

The screen for creating BAdI implementations is now displayed. 

2. Enter a short text for the implementation in the Short text for implementation field. 

3. From the tab index, choose Interface. 

The Name of implemented class field is already filled on the tab page, as a class name was 

automatically assigned to the implementation when you named it. 

4. Save your entries, and assign the implementation to a development class. 

5. Place the cursor on the method, and double-click to enter method processing. 

6. Enter the code for the implementation between the statements method <Interface name> ~ 

<Name of method>  and endmethod. 

7. Save and implement your code. Return to the Edit Implementation screen. 

8. Save the entries on the Edit Implementation screen. 

Note: You can also create an implementation, and then activate it at a later time. In such a case, end 

the processing stage at this point. 

9. Choose Activate 

The code you stored in the method will be run when the application program is executed. 

Example 

To display example coding, select Goto -> Example coding -> Display . 

If the standard program finds a return reason, then only the charge in the payment note is searched for in the 

example coding. 

If the standard program finds no return reason, then the return reason is also searched for in the example 

coding. 

Also see: 

Method 

Return inbank statement 



 

 

 Account Statement Entry: Assign Transactions 

In this section you determine which procedures in account statement entry are to be considered as 

incoming payments in the real estate management sense. The procedures are either considered as returned 

debit memos or as incoming payments. If none of the assignments apply, the payments are treated 

according to the standard logic of FI Financial Accounting (for instance check deposit, outgoing payments 

to vendors etc.) 

You define the procedures for account statement entry in Financial Accounting Customizing. 

Also read Electronic Account Statement Entry. 

 Account Statement Entry: Test Tool 

 Generate Data for the Electronic Account Statement Entry 

Test Environment for Electronic Account Statement Entry 

The test environment is designed to help you during implementation of the electronic account statement in 

the Real Estate component with: 

a) Generating test data (credit memos or returned debit memos) that can be modified as required. 

b) Generating these files in the required format (MULTICASH or DTAUS) as a data file. 

Attention: This test environment is for use only in your test system. Do not use it in your productive 

system! 

Prerequisites 

You must maintain a house bank and a house bank account in the company code for which the account 

statements are to be produced. You must also maintain the general ledger account in the master data for 

the house bank account (for example, G/L account ). For the DTAUS bank procedure, you must maintain 

a bank procedure account number in the contract. 

The following external transaction keys must be assigned to the transaction type, which is linked to the 

house bank (Refer to Assign external transactions): 

- MULTICASH Format: 

- Transfer credit memo:  - Returned debit memo :  - Format DTAUS: 

- Transfer credit memo:   

- Returned debit memo :   

Test Procedure 

1. Creating test data 



 

 

Choose the action Generate test data for the electronic statement entry (Refer to Report 

documentation) 

You must make the following preparations in the Real Estate component: 

- To simulate a credit memo (incoming payment): Create one or more rental agreements and carry 

out a debit position to generate open items. 

- To simulate a returned debit memo (outgoing payment): Clear open items for rental agreements 

using, for example, the payment program. 

2. Processing test data 

The data can also be over-modified, for example, "mutilating" a rental agreement number. In this 

case, choose the action Change test data to multicash format or Change test data to DTAUS 

format. 

3. Generating a data file for testing purposes 

To generate the prepared data in the required format (multicash or DTAUS) as a data file for the 

account statement entry, choose the action Generate data for the electronic account statement 

entry. (Refer to Report documentation) 

4. Using this generated data you can now test the account statement entry. The files are further processed 

using the program RFEBKA (Account statement import) or via menu path: Accounting -> Real estate 

management -> Rental management -> Rental accounting: 

     Incoming paymenty -> Account statement entry or   

Country specifics -> Bank procedure 

 Change Test Data to Multicash Format 

Test Environment for Electronic Account Statement Entry 

The test environment is designed to help you during implementation of the electronic account statement in 

the Real Estate component with: 

a) Generating test data (credit memos or returned debit memos) that can be modified as required. 

b) Generating these files in the required format (MULTICASH or DTAUS) as a data file. 

Attention: This test environment is for use only in your test system. Do not use it in your productive 

system! 

Prerequisites 

You must maintain a house bank and a house bank account in the company code for which the account 

statements are to be produced. You must also maintain the general ledger account in the master data for 



 

 

the house bank account (for example, G/L account ). For the DTAUS bank procedure, you must maintain 

a bank procedure account number in the contract. 

The following external transaction keys must be assigned to the transaction type, which is linked to the 

house bank (Refer to Assign external transactions): 

- MULTICASH Format: 

- Transfer credit memo:  - Returned debit memo :  - Format DTAUS: 

- Transfer credit memo:   

- Returned debit memo :   

Test Procedure 

1. Creating test data 

Choose the action Generate test data for the electronic statement entry (Refer to Report 

documentation) 

You must make the following preparations in the Real Estate component: 

- To simulate a credit memo (incoming payment): Create one or more rental agreements and carry 

out a debit position to generate open items. 

- To simulate a returned debit memo (outgoing payment): Clear open items for rental agreements 

using, for example, the payment program. 

2. Processing test data 

The data can also be over-modified, for example, "mutilating" a rental agreement number. In this 

case, choose the action Change test data to multicash format or Change test data to DTAUS 

format. 

3. Generating a data file for testing purposes 

To generate the prepared data in the required format (multicash or DTAUS) as a data file for the 

account statement entry, choose the action Generate data for the electronic account statement 

entry. (Refer to Report documentation) 

4. Using this generated data you can now test the account statement entry. 

The files are further processed using the program RFEBKA (Account statement import) or via 

menu path: Accounting -> Real estate management -> Rental management -> Rental accounting: 

     Incoming paymenty -> Account statement entry or   

Country specifics -> Bank procedure 

 Change Test Data to DTAUS Format 

Test Environment for Electronic Account Statement Entry 

The test environment is designed to help you during implementation of the electronic account statement in 

the Real Estate component with: 



 

 

a) Generating test data (credit memos or returned debit memos) that can be modified as required. 

b) Generating these files in the required format (MULTICASH or DTAUS) as a data file. 

Attention: This test environment is for use only in your test system. Do not use it in your productive 

system! 

Prerequisites 

You must maintain a house bank and a house bank account in the company code for which the account 

statements are to be produced. You must also maintain the general ledger account in the master data for 

the house bank account (for example, G/L account ). For the DTAUS bank procedure, you must maintain 

a bank procedure account number in the contract. 

The following external transaction keys must be assigned to the transaction type, which is linked to the 

house bank (Refer to Assign external transactions): 

- MULTICASH Format: 

- Transfer credit memo:  - Returned debit memo :  - Format DTAUS: 

- Transfer credit memo:   

- Returned debit memo :   

Test Procedure 

1. Creating test data 

Choose the action Generate test data for the electronic statement entry (Refer to Report 

documentation) 

You must make the following preparations in the Real Estate component: 

- To simulate a credit memo (incoming payment): Create one or more rental agreements and carry 

out a debit position to generate open items. 

- To simulate a returned debit memo (outgoing payment): Clear open items for rental agreements 

using, for example, the payment program. 

2. Processing test data 

The data can also be over-modified, for example, "mutilating" a rental agreement number. In this 

case, choose the action Change test data to multicash format or Change test data to DTAUS 

format. 

3. Generating a data file for testing purposes 

To generate the prepared data in the required format (multicash or DTAUS) as a data file for the 

account statement entry, choose the action Generate data for the electronic account statement 

entry. (Refer to Report documentation) 

4. Using this generated data you can now test the account statement entry. 

The files are further processed using the program RFEBKA (Account statement import) or via 

menu path: Accounting -> Real estate management -> Rental management -> Rental accounting: 



 

 

     Incoming paymenty -> Account statement entry or   

Country specifics -> Bank procedure 

 Generate Data File for Electronic Account Statement Entry 

Test Environment for Electronic Account Statement Entry 

The test environment is designed to help you during implementation of the electronic account statement in 

the Real Estate component with: 

a) Generating test data (credit memos or returned debit memos) that can be modified as required. 

b) Generating these files in the required format (MULTICASH or DTAUS) as a data 

file. 

Attention: This test environment is for use only in your test system. Do not use it in your productive 

system! 

Prerequisites 

You must maintain a house bank and a house bank account in the company code for which the account 

statements are to be produced. You must also maintain the general ledger account in the master data for 

the house bank account (for example, G/L account ). For the DTAUS bank procedure, you must maintain 

a bank procedure account number in the contract. 

The following external transaction keys must be assigned to the transaction type, which is linked to the 

house bank (Refer to Assign external transactions): 

- MULTICASH Format: 

- Transfer credit memo:  - Returned debit memo :  - Format DTAUS: 

- Transfer credit memo:   

- Returned debit memo :   

Test Procedure 

1. Creating test data 

Choose the action Generate test data for the electronic statement entry (Refer to Report 

documentation) 

You must make the following preparations in the Real Estate component: 

- To simulate a credit memo (incoming payment): Create one or more rental agreements and carry 

out a debit position to generate open items. 

- To simulate a returned debit memo (outgoing payment): Clear open items for rental agreements 

using, for example, the payment program. 



 

 

2. Processing test data 

The data can also be over-modified, for example, "mutilating" a rental agreement number. In this 

case, choose the action Change test data to multicash format or Change test data to DTAUS 

format. 

3. Generating a data file for testing purposes 

To generate the prepared data in the required format (multicash or DTAUS) as a data file for the 

account statement entry, choose the action Generate data for the electronic account statement 

entry. (Refer to Report documentation) 

4. Using this generated data you can now test the account statement entry. The files are further processed 

using the program RFEBKA (Account statement import) or via menu path: Accounting -> Real estate 

management -> Rental management -> Rental accounting: 

     Incoming paymenty -> Account statement entry 

or   Country specifics -> Bank procedure 

 COA Mandate: Assign Flow Types for Account Statement 

Use 

In order to be able to represent inflows and outflows in the report for the reserve fund statement for a 

condominium owners' association, you need to assign flow types to flows that are posted using the 

electronic bank statement. 

 Enhancements 

 Change Account Determination ( BAdI ) 

Use 

You can use this BAdI to determine the G/L account HKONT and to influence the use of the special G/L 

indicator UMSKZ in RE posting processes. 

When the REPLACE_ALL interface method is implemented, the standard implementation for determining 

these fields is completely replaced. If no account is determined, this causes an error message in the posting 

interface. The error message is output in the log of the relevant posting process. 

When the CHANGE_KEYDATE interface method is implemented, the original due date that was 

transferred can be changed in the standard implementation. As a result, the system can determine a 



 

 

different account, which was entered in Customizing, if the fiscal year of this key date differs from the 

fiscal year of the posting date. If an (optional) RE line item is transferred by the standard implementation, 

then any date from the RERA_DOC_ITEM_EX structure can be used. 

Requirements 

The standard behavior of account determination has to be changed because the existing functions are not 

sufficient. 

Activities 

Implement one of the methods of the BAdI using transaction SE. 

Example 

1. Implementation of the REPLACE_ALL interface method: You want to use your own table instead of 

the standard table for account determination TIVEXFIREPSYMB. 

2. Implementation of the CHANGE_KEYDATE interface method: The RE line item IS_DOCITEM is 

transferred by the calling program. The key date CD_KEYDATE (in the 

standard the original due date) is overwritten by the current due date 

IS_DOCITEM-BLINEDATE that was entered manually in the cash flow. Notes for 

Developers 

 Change Document Data ( BAdI ) 

Use 

The REEX_FI_BAPI BAdI makes it possible to change document data before it is transferred to the 

Accounting Interface. To do this, implement the BAPIDOC_MODIFY method. 

The BAdI is executed for all RE posting processes, such as periodic postings, input tax distribution, service 

charge settlement, sales-based settlement, and so on. However, it is not executed for pure FI postings (such 

as FB, FB, and so on), even if there is account assignment to real estate objects. 

Caution: Only change non-critical data, such as payment data, dunning data, segment text, and so on. 

Never change critical data such as accounts or amounts. 

Requirements 

You want to change document data, for example in periodic postings. 

Activities 

Implement the BAPIDOC_MODIFY method of the BAdI using transaction SE. 



 

 

The parameters are: 

ID_MODE: Mode of the posting run (E: update run, S: simulation) 

ID_PROCEDURE: Procedure (such as REDP for customer receivables, RETP for G/L account transfers, 

RECP for vendor payables, and so on) 

IS_RE_HEADER: Document header data of RE document 

IT_RE_ITEM: Table of line item data of RE document 

CS_BAPI_HEADER: Document header data 

CT_BAPI_ITEMS_AR: Document line items of debit items (except amounts and RE data) 

CT_BAPI_ITEMS_AP: Document line items of credit items (except amounts and RE data) 

CT_BAPI_ITEMS_GL: Document line items of G/L account items (except amounts and RE data) 

CT_BAPI_ITEMS_TAX: Tax lines 

CT_BAPI_ITEMS_AMOUNT: Amount items 

CT_BAPI_ITEMS_RE: Data of RE, such as contract number 

CT_BAPI_ITEMS_WT: Withholding tax types and withholding tax codes for the corresponding items 

Example 

The following example describes how the BAdI can be used. 

In contract maintenance for customer contracts, you defined payment method 'E' (bank debit). For credit 

memos, you want to replace this with 'U' (bank transfer), if the contract is already ended on the posting 

date. 

In a loop over the debit items in table CT_BAPI_ITEMS_AR, you check if the credit memos have 

payment method E. After that, the end date of the contract is determined and compared with the posting 

date of the document. If the contract is ended, the payment method is changed to 'U.' 

Refer to the sample code (Goto -> Sample Code -> Display). Notes for 

Developers 

 One-Time Postings 

 One-Time Postings 

Use 

Using the One-Time Postings function, you can post documents in Financial Accounting ( FI ) with 

reference to data in Real Estate Management ( RE-FX ). 



 

 

The data entry screens for one-time postings are considerably simplified, as compared to the normal FI 

interface, and better adapted to the needs of real estate management. 

You first enter the posting activity and the company code. Based on the settings made in Customizing for the 

posting activity, the system constructs one or more documents that you can then add to (for example, by 

entering the invoice amount or the concrete real estate object). 

Activities 

In this section, you specify the following: 

- You set up posting activities. 

- You assign them to posting activity groups. 

- You specify the field status variants for the posting activities. 

- You specify how the settlement reference date is determined based on the service charge key. 

You start one-time postings either using the RE Navigator (transaction RE) from the object overview for the 

company code, or using transaction RERAOP - One-Time Postings. 

If you want to set up individual transactions for each posting activity, you can set up parameter transactions 

for this in the customer namespace using transaction SE. Use transaction RERAOP_SC as a template. 

Overwrite the value SC (in the Value column in the Default Values table) with the key of your posting 

activity. 

You can then link the parameter transactions you created in this way with your role menu. 

 Define Posting Activities 

Use 

Using the One-Time Postings function, you can post documents in Financial Accounting ( FI ) with 

reference to data in Real Estate Management ( RE-FX ). 

The data entry screens for one-time postings are considerably simplified, as compared to the normal FI 

interface, and better adapted to the needs of real estate management. 

You first enter the posting activity and the company code. Based on the settings made in Customizing for the 

posting activity, the system constructs one or more documents that you can then add to (for example, by 

entering the invoice amount or the concrete real estate object). 

Based on the Customizing settings you make for the posting activity, the system determines the following 

(among other information): 

- How many documents are to be posted 

- How many items the documents being posted have 



 

 

- Default data for the document header and the line items (especially account symbols, bank details, 

account assignment objects, and percentage of total amount) 
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Field status variants for the document header and line item data 

Here you specify what part of the data determined by the system can be manually overwritten by the 

user. 

- If and how distribution should be made to objects of the contract 

Standard settings 

Some posting activities are delivered with standard Customizing, such as: 

- Posting of vendor invoices with reference to real estate objects 

- Posting of one-time receivables for contract partner with customer account 

- Posting of costs of condominium owners association ( COA) 

You can copy these Customizing settings and use them as a template for defining your own posting 

activities. 

For example, if you are using condominium owners' association (COA) management, then you could 

define a separate posting activity for each service charge key that is used for the condominium owners 

association. To post an incoming invoice then, the user only has to enter the amount and the vendor. The 

system determines all other data, including the settlement unit, automatically. 

Activities 

- Define the posting activities you need. (The simplest way is copying from standard Customizing.) 

Make the settings for the posting activity. For information on the meanings of the different settings, 

see the field documentation. 

- In the detail screen for the Posting Activity, make settings for all documents that are posted using 

this posting activity. 

In the application transaction, the user enters Basic Data in the upper part of the screen. The system 

then derives other data for the document (document header and line items) from this basic data. 

Here you specify what this basic data is: 

- Does the posting activity reference a real estate contract or a rental object? 

- Does the document require you to enter a customer or vendor partner explicitly, or is it possible for 

the system to derive the customer or vendor from the real estate contract or rental object? 

- In which company codes is the posting activity allowed to be used? 

- Should a house bank account be entered explicitly for the posting activity? This house bank is used 

for all payments resulting from the posting. (This is useful, for example for COA postings to special 

asset accounts.) 

- What are the general settings in document entry? 
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- Which help text is displayed when the user chooses @AI@ with the quick info text Posting Activity 

Help? 

Help texts are defined for the posting activities delivered by SAP, for instance, for posting 

activity CNC: Vendor Invoice for Tenant:  

RERA_OP_EXAMPLE_CNC. 

You can enter your own help texts. In transaction SE, enter General Text in the Document 

Class field and choose Create. Or enter the name of your help text in the field for it in this 

dialog, and choose change mode to be able to process the text. For your own texts, choose 

names from the customer name range (beginning with Y or Z). 

For posting activities, for which you do not want to write your own texts, you can use the 

standard text RERA_OP_EXAMPLE_GENERAL. 

- In the detail screen for the Documents, make settings for the individual documents that are posted 

using this posting activity. 

- Most posting activities only post one document. However, you can post several documents using the 

same posting activity (for instance, when a vendor invoice is passed on to a tenant using another 

document). 

- The documents can also post in different company codes. In this case, there is no clearing posting. 

Instead, the documents are posted independently from each other as entered. 

- Is the activity subject to taxes? 

- In the detail screen for the Document Line Items, you specify the account the document posts to, by 

entering the account type and account symbol. In addition, you can define the following: 

- If and how the account assignment object, and possibly the customer or vendor account, are derived 

from the basic data (for G/L account items) 

- The default values for dunning and payment data (for debit or credit line items, these values can also 

be copied from the contract in the basic data) 

- The tax code used for posting this item 

- If a distribution formula is used, and which one 

If a distribution formula is used, multiple line items might be generated, depending on the 

objects that the contract in the basic data is assigned to. 

Dependent on the distribution key and the contract, the system determines the objects to which 

account assignment is made. Then it distributes the amount in the basic data of the posting to 

these objects based on the distribution formula. The line items generated are essentially the 

same as those generated by the object cash flow of a contract using this distribution formula, 

as far as the CO account assignment and amount are concerned. 

- Save the posting activity once all of your settings are made. 

- On the detail screen for the Posting Activity, assign the posting activity to an existing posting 

activity group. Or define a new posting activity group and assign the posting activity to it. 

- Define a field status variant for the basic data, and assign it on the detail screen for the Posting 

Activity. 

Assign a field status to the Line Items on the detail screen. If there is no suitable field status yet, 

define one in the Field Status Variants for Line Items IMG activity. Note: The field status variant is 
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not allowed to contradict the field status variant entered in Financial Accounting (FI) for the 

account group of the account, which is derived from the account symbol of the item. This means, 

for example, you have to make sure that all fields that are defined there as required entry fields 

receive values from your one-time postings. Either the values for these fields have to be derived, or 

they also have to be required entry fields (in the case of manual entry). 

- Save your settings. 

- Before you set a posting activity to active in your production system, you should test it carefully 

using transaction RERAOP (or RE) to make sure it does what you intended. 

- After going live, you might find that users still perform certain postings in the RE context using FI 

transactions. In that case, you might consider if you want to define posting activities for these 

postings also. 

 Define Groups for Posting Activities 

Use 

In order to structure posting activities, you can define groups of posting activities. The posting activity 

group is displayed as a node in the navigation tree in the RE Navigator (RE). The posting activities are 

displayed below the group. 

Activities 

Define the posting activity groups and then assign posting activities to the groups. 

If you want the group (and its posting activities) to be displayed in the navigation tree, then set the Active 

indicator. 

To prevent a group of posting activities from being used, deselect the indicator. 

 Define Rule for Proposing Settlement Reference Date 

Use 
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Here you define, dependent on the service charge key and the settlement variant, how the settlement 

reference date should be determined based on the document date. 

The settings you make here are used as follows: 

- Only for one-time postings 

- Only if you defined the line item in the Define Posting Activities IMG activity, so that the 

settlement reference date is proposed 

If the Prop.Sett.Rf.Dt (Propose Settlement Reference Date) indicator is set there, but no setting is 

made here in this IMG activity for the service charge key or the settlement variant that the 

settlement unit belongs to, then the system uses the document date as the settlement reference date. 

Activities 

For all appropriate service charge keys, define how the system should determine the default value for the 

settlement reference date. For more information, see Determine Settlement Reference Date. 

 Field Status 

 Define Field Status Variants for Basic Data 

Use 

Using the field status variant of the basic data, you can control which data is visible in the upper part of 

the screen when you enter one-time postings. You also specify which fields are ready for input and which 

fields are required entry fields. 

Activities 

- Define different field status variants for different types of posting activities. Usually one field status 

variant for basic data is enough, for example, for all posting activities that post to vendor invoices 

on a real estate object. 

- You can use standard Customizing as a guide when you create your own new field status variants. 

You can copy the field status variant that most closely approximates your requirements and use it as 

a reference. 

Select the field status variant you want to change. Choose Fld Status to set the field status of the 

individual fields. If you set the Suppress indicator, the field is not displayed on the screen. Even if 

the field is not displayed, the system might determine a value for the field and transfer the value to 
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Financial Accounting. Therefore, to make the entry screen more concise, you can suppress fields, 

for which the system determines the values, when you do not want these values to be overwritten 

by the user (and the user does not need the information in the field). 

- In the Define Posting Activities IMG activity, assign the field status variants in the detail screen of 

the Posting Activity. 

 Define Field Status Variants for Line Items 

Use 

Using the field status variant of the line items, you can control which data is visible for each line item on 

the lower part of the screen when you enter one-time postings You also specify which fields are ready for 

input and which fields are required entry fields. 

Activities 

- At the minimum, define a field status variant for each account type that you need for one-time 

postings. In addition, you could also define different field status variants dependent on the context 

of the posting activity. 

- You can use standard Customizing as a guide when you create your own new field status variants. 

You can copy the field status variant that most closely approximates your requirements and use it as 

a reference. 

- Select the field status variant you want to change. Choose Fld Status to set the field status of the 

individual fields. If you set the Suppress indicator, the field is not displayed on the screen. Even if 

the field is not displayed, the system might determine a value for the field and transfer the value to 

Financial Accounting. Therefore, to make the entry screen more concise, you can suppress fields, 

for which the system determines the values, when you do not want these values to be overwritten by 

the user (and the user does not need the information in the field). 

However, you should always have the system display the account assignment object, for example, 

even if it is not modifiable. Remember that whether or not the account assignment object is 

modifiable depends on whether the derivation of the account assignment object is required, and not 

on the field status. 

- In the Define Posting Activities IMG activity, assign the field status variants to each line item in the 

detail screen for the line items. 



______________________________________________________________

SAP System  

______________________________________________________________  

SAP AG 154 

 Allow Partly Automatic Creation of Company-Code-Dependent Data 

Use 

In the course of condominium owners' association (COA) management, one vendor can be the business 

partner of different COAs. To be able to post to this vendor in a COA (that is, in the COA company code, 

see company code type), the following requirements have to be met: 

- The vendor master record has to exist. 

- The company-code-dependent data of the vendor has to exist. 

Normally this is not the case for the first posting to this vendor in the COA. 

During one-time posting, the system checks if the vendor exists in the company code. If this vendor does 

not exist, and if you set the Create Customer/Vendor? indicator in this activity, then the system displays a 

pushbutton in the one-time posting transaction in the application. You can choose this pushbutton to 

create a vendor in the company code. 

If the current company code is a mandate company code, then the system first tries to copy the company-

code-dependent data of the reference company code. If the vendor also does not exist in the reference 

company code, then the system creates the vendor using the default values you entered in Customizing. 

It is not possible for the system to also create the data of the vendor that is not company-code-dependent 

from the one-time posting in the application. If you choose, you can create this data in another session. 

Activities 

If you want the system to behave as explained above, then set the indicator in the reference company 

code and in any existing mandate company codes. The system then copies the indicator for any new 

mandates you create. 

 Search Strategy 

 Vendor 
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 Define Search Strategies for Vendor 

Use 

The vendor in the basic data of a posting activity can often be derived from other data ( for example, from 

the contract). If it is not possible to derive the vendor in this way, you can specify a search strategy here 

for the vendor. The result is that, in the context of this posting activity, the system first proposes those 

vendors in the search help that are specified by the search strategy. This makes it easier for you to select, 

since the number of proposed values is smaller. In addition, one of these "preferred" vendors can be 

designated as a default value. 

Activities 

Define the search strategies for the VENDOR search field as follows: 

Enter a name for the search strategy. 

Specify how the search takes place: 

- Name 

Text of search strategy (informational only) 

- Search Method 

This is a method that is predefined in the system. The method describes how the search is 

performed. The way the system processes the values for the search strategy depends on the method 

you select here. Choose a method using the input help. 

- Active? 

You can only use search strategies. For example, if you copied the search strategies from standard 

Customizing, then set the Active? indicator for those that you want to actually use in your system. 

- Other Values 

Set this indicator, if you also want the standard search help to be available. The system then displays 

a Further Values row, in addition to the values returned by the search strategy.  From there you can 

navigate to the standard search help. 

The following search methods for the vendor are predefined in the system: 

- <blank>     Individual values for vendor 

You enter the values for each search strategy in the value table. 

- ROLE       Partners for a role (example implementation of BAdI 

In the value table, you enter the partner roles the system searches for. The search strategy then 

returns all vendors for the partners with this role. 
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 Specifiy Possible Vendors for Search Strategy 

Use 

You enter the possible values here for a search strategy that was already defined. For search strategies 

with the individual values method, enter the vendors in the Differentiation Criterion column. For search 

strategies with the role method, enter the role or roles in the Differentiation Criterion column. 

Activities 

For each search strategy, enter the search values that are needed based on the search method: 

Where you enter these values is dependent on the search method used by the search strategy. For search 

methods where the values for the strategy are simply entered, you enter the values directly in the 

Differentiation Criterion field. In that case, you can specify only one value for each search strategy as a 

default value. 

For search methods that recognize a differentiation criterion (such as, the location of the current object), 

you have to enter the possible values for each differentiation criterion in the Field Contents field. 

You can use wildcard characters here: An asterisk (*) replaces any number of characters, while a plus 

sign (+) replaces exactly one character. If more than one value is possible for a differentiation criterion, 

then enter a number to distinguish the values in the Seq. Number (sequence number) field.  You are only 

allowed to designate one value as the default value for each combination of search strategy and 

differentiation criteria. 

To help you select possible values more easily, you can choose Propose Values. Position the cursor on the 

search strategy, for which you want to propose values (or, if there is no entry yet for search strategy, on 

the search field). Then choose Propose Values.  The system displays a search help appropriate for the 

search strategy. You can select the values there that you need for this search strategy. 

Note on transport: 

If you enter vendor numbers in the table, transporting to another system only makes sense if the vendor 

numbers are the same in both systems!! 

Example 

Search strategy /INS: 

Insurance 

with individual values search method, contains these vendors in the Differentiation Criterion 

column  - ABC Insurance Co.  - XY Insurance, Ltd. 

Search strategy 

/ENERGY: Energy provider with ROLE search method, contains this role in the Differentiation 

Criterion column 
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ZZENER - Energy provider 

 Service Charge Key 

 Define Search Strategies for Service Charge Key 

Use 

You use this activity if you want to be able to select a service charge key for an item of a posting activity 

from a number of various service charge keys. This requires entering a search strategy for this service 

charge key.  The result is that the service charge keys specified by the search strategy appear in the input 

help for each line item. This makes it easier for you to select, since the number of proposed values is 

small. 

Activities 

Define the search strategies for the SCSCKEY search field as follows: 

Enter a name for the search strategy. 

Specify how the search takes place: 

- Name 

Text of search strategy (informational only) 

- Search Method 

This is a method that is predefined in the system. The method describes how the search is 

performed. The way the system processes the values for the search strategy depends on the method 

you select here. Choose a method using the input help. 

- Active? 

You can only use search strategies. For example, if you copied the search strategies from standard 

Customizing, then set the Active? indicator for those that you want to actually use in your system. 

- Other Values 

Set this indicator, if you also want the standard search help to be available. The system then displays 

a Further Values row, in addition to the values returned by the search strategy.  From there you can 

navigate to the standard search help. 
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For service charge keys, the only search method supported by the system is the < blank > (individual 

values) method. You enter the possible service charge keys for all defined search strategies in the  value 

table. 

 Specify Possible Service Charge Keys for Each Search Strategy 

Use 

You enter the possible values here for a search strategy that was already defined. For search strategies 

with the individual values method, enter the service charge key in the Differentiation Criterion column. 

Activities 

For each search strategy, enter the search values that are needed based on the search method: 

Where you enter these values is dependent on the search method used by the search strategy. For search 

methods where the values for the strategy are simply entered, you enter the values directly in the 

Differentiation Criterion field. In that case, you can specify only one value for each search strategy as a 

default value. 

For search methods that recognize a differentiation criterion (such as, the location of the current object), 

you have to enter the possible values for each differentiation criterion in the Field Contents field. 

You can use wildcard characters here: An asterisk (*) replaces any number of characters, while a plus 

sign (+) replaces exactly one character. If more than one value is possible for a differentiation criterion, 

then enter a number to distinguish the values in the Seq. Number (sequence number) field.  You are only 

allowed to designate one value as the default value for each combination of search strategy and 

differentiation criteria. 

To help you select possible values more easily, you can choose Propose Values. Position the cursor on the 

search strategy, for which you want to propose values (or, if there is no entry yet for search strategy, on 

the search field). Then choose Propose Values.  The system displays a search help appropriate for the 

search strategy. You can select the values there that you need for this search strategy. 

Example 

Search strategy /HEAT: 

Heating costs 

with individual values search method, contains these service charge keys in the Differentiation 

Criterion column 

           Heating costs 
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           Furnace check 

           Heat and hot water 

           Chimney cleaning 

Search strategy 

/ENERGY: Energy costs contains 

these service charge keys            

Lighting 

           Heating costs 

           Furnace check 

           Heat and hot water            Chimney 

cleaning 

 Enhancements 

 One-Time Postings: Change Default Data 

Use 

Using this Business Add-In (BAdI), you can change the default data for one-time posting documents. The 

data changed by the BAdI is displayed before posting, and the user can modify the data again if 

necessary. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

You can use the following methods: 

- COMPLETE_BASE_DATA: Change or add to basic data of document 

- COMPLETE_HEADER_DATA: Change or add to header data of document 

- COMPLETE_ITEM_DATA: Change or add to item data of document 

In each case, you can change data and/or have the system issue messages. If an error message is issued, 

the document cannot be posted. 

- CHECK_BASE_DATA:  Validation of document basic data 

- CHECK_SINGLE_HEADER: Validation of document header data per document header 

- CHECK_SINGLE_ITEM:  Validation of line item data per line item 
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The CHECK methods are called after data entry (PAI) and for explicit checks ('Check All Entries' key). If 

an error message is issued, the document cannot be posted. 

Example 

You can use the implementation of the COMPLETE_BASE_DATA method as an example. 

First there is a check of whether a contract was entered in the basic data. The system then determines the 

standard posting terms for this contract. If there is an entry in the Note to Payee field there, then it is 

copied to the document reference. The user can still change this entry. 

See also 

For information on using BAdIs, see this documentation. 

Notes for Developers 

 Define Custom Search Methods for Search Strategies 

Use 

Here you define your own custom search methods. You can then process the corresponding 

implementations for them using a BAdI. For more information, see Implement/Activate Search Methods 

for Search Strategies. 

Standard settings 

Some methods are predefined in the system. However, they only deliver the expected results when the 

sample code of the BAdI is activated. 

Activities 

If the predefined search methods are not sufficient to meet your needs, you can define your own methods. 

Choose names for your methods that begin with the letter Y or Z. 

You can assign one method to several search fields. However, doing so makes sense only if the search 

fields point to the same domain (for example, the land registry and the agency responsible for the parcel, 

since both are business partners). 

In addition, specify the following for the search method: 

- A descriptive name 

- The search help for the differentiation criterion (when entering allowed values) 

- The type of the method 

Then implement the BAdI for the search method. 
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 Implement/Activate Search Methods for Search Strategies 

Use 

This BAdI can be used to define your own search methods for a search strategy. Search methods are each 

assigned to a search strategy. The BAdI method that is used depends on the type of search method that is 

entered for the method in table TIVCASHMETH. The following applies: 

Type SPACE - Single Value Method, Values Are in VICASHFVALUES-SHMETHDIFF  

There is no BAdI call, the values for the search strategy are entered directly in table 

VICASHFVALUES. 

Type  - Search Strategy + Possibly Object Data => (Program) Values The BAdI determines the 

possible values solely from the name of the of search strategy and possibly from the object data. 

BAdI method to be implemented: GET_VALUES  

Type   Search Strategy =>SMETHDIFF => (Program) Values 

First a differentiation criterion is determined for the search strategy from the value table 

VICASHFVALUES. The BAdI then determines the possible values from this differentiation 

criterion, possibly dependent on the object data and the name of the search strategy. BAdI method 

to be implemented:  GET_VALUES_FOR_SHMETHDIFF  

Type   Object Data => (Program) SMETHDIFF => (VICASHFVALUES) Values 

The BAdI determines a differentiation criterion from the object data and possibly from the name of the 

search strategy. The values for this differentiation criterion are then read from table 

VICASHFVALUES. 

BAdI method to be implemented: GET_SHMETHDIFF   Search 

strategies are used in the following contexts: 

- One-Time Postings: 

Vendor search field (VENDOR) and service charge key ( SCSCKEY ) 

The search strategy is determined from the Customizing settings for the posting activity (VENDOR) 

or for a specific item of the posting activity (SCSCKEY). An object reference is not transferred. 

- Master Data of Parcel: 

Search fields for main contractual partner (PARCOFF) and for all hierarchical locations 

(LOCHIER). The object reference of the parcel is transferred. 

For the LOCHIER search field, the location structure of the hierarchical location you are searching 

for is also in the ID_CONTEXT field. 

- Master Data of Land Register: 

Search fields for land registry (LROFFICE) and for the hierarchical location ( LOCHIER ). The 

object reference of the land register is transferred. 
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For the LOCHIER search field, the location structure of the hierarchical location you are searching 

for is also in the ID_CONTEXT field. 

The following applies to the search fields for the land register and parcel: 

For each search field, only one search strategy is allowed to be designated as active. 

Activities 

Depending on the type of search method, implement one of the  methods: 

- GET_VALUES 

- GET_VALUES_FOR_SHMETHDIFF       

- GET_SHMETHDIFF     

Description of parameters: 

Method GET_VALUES and GET_SHMETHDIFF: 

FLT_VAL 

Search method 

IO_REF_OBJ   

Reference to the real estate object that is currently being processed. The reference is empty when the call 

is from posting activities. For the land register, the reference contains a reference to the land register 

master data; and for parcels, a reference to the parcel master data. 

The BAdI method can retrieve the current object data using the API that belongs to it. 

ID_CONTEXT   

For the LOCHIER search field, contains the location key of the hierarchical location being searched for; 

otherwise it is empty. 

IS_SHSTRAT   

Contains certain Customizing data for the active search strategy 

IS_SHFIELD   

Contains the system Customizing data for the current search field 

CT_VALUES  

The result of the search is to be placed in this table. The KEY field has to be filled with the determined 

key of the search field. The text for it does not have to be entered. For methods of type , the value of the 

search field is not entered. Instead the differentiation criterion, which should be used to search in 

VICASHFVALUES, should be filled. In this case, wildcard characters ('%') are allowed for a search for 

similar values. 
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CD_DEFAULT_VALUE 

If a default value was determined, it can be returned here. The default value is set when the value of the 

field, for which the search help was called, was initial at the time of the call. 

CF_OTHER_VALUES_ALLOWED 

This value should be returned as TRUE, if you want to have an option to choose "Other Values" in the 

search dialog box, in addition to the search result. If the user chooses this option, then the system calls the 

standard search help. The value does not influence whether the system checks the result of the search help 

(normally there is no check). 

Method GET_VALUES_FOR_SHMETHDIFF 

In addition to the parameters of GET_VALUES, the values that are maintained in the value table for the 

search strategy are also transferred to table IT_SHVALUES. 

Example 

Example class CL_EXM_IM_RECA_SEARCH_METHOD contains examples for the following 

search methods: 

Type  - Search Strategy + Possibly Object Data => (Program) Values 

GET_VALUES for LOCHIER search method 

The hierarchical location of the parcel is derived from hierarchical locations to other location structures 

that are already entered in the system. A value is allowed here if the same text is entered for this location 

in Customizing. 

GET_VALUES for PARTNR search method 

The prerequisite here is that there is external number assignment for land registries ( land register) and 

for the main contractual partner (survey office or responsible agency) of the parcel. 

The partner number of the land register corresponds to the land register district; the number of the 

survey office corresponds to the first  characters of the leading hierarchical location. This method might 

need to be adjusted to agree with the practices of your company regarding partner numbers. For 

example, it is possible that the partners could all have a prefix in the number, such as LR for land 

registry. 

GET_VALUES for ADDR search method 

The assumption here is that the postal code of the land registry corresponds to the land register district. 

All land registries, where postal code = land registry, are offered for selection. For the parcel, the system 

searches for a partner with the "Responsible Agency" role, where the city agrees with the text of the 

hierarchical location of the parcel. 

Type   Search Strategy =>SMETHDIFF => (Program) Values         

GET_VALUES_FOR_SHMETHDIFF for ROLE search method 

This search method is appropriate for the VENDOR search field. The search method returns all vendor 

numbers of partners for the role that are maintained in the value table for the search strategy. 

For example, if you create your own role for insurance, you can assign a search strategy with this search 

method to a posting activity for "insurance costs". 
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Type  - Object Data => (Program) SMETHDIFF => (VICASHFVALUES) Values 

GET_SHMETHDIFF for VALREG search method 

You can use this search method when the land registries for the land register district are entered in the 

value table. The search method determines the land register district for the current land register, or for the 

first  characters of the hierarchical location of the current parcel. 

Notes for Developers 

 Accrual/Deferral 

 Accrual/Deferral Using Accrual Engine in RE Environment 

Use 

The Accrual Engine is used for posting accruals and deferrals periodically in RE-FX. 

Standard settings 

Copy the settings for the RE-FX application component that are delivered by SAP in the standard system 

and adjust them to your enterprise structure (company codes, accounting principles, and so on) if 

necessary. 

To offer more flexibility, the entire Implementation Guide for the Accrual Engine is provided here. 

However, you do not need to configure any settings for RE-FX for the following points: 

- Derived Accrual Types 

- Define Layout for Accrual Objects 

- Extended Account Determination 

- Document Change Using BAdI 

Activities 

- For the activities that are not listed here, check the settings delivered by SAP and adjust them if 

necessary. 

- Create accrual types for the RE-FX component: Define Accrual Types. 

- Specify an accounting principle for the RE component: Define Customer Settings for Components. 

The default accounting principle entered here is adopted automatically when an accrual object is 

created. 

- In addition, you have to define a standard accrual method in Define Standard Settings for Accrual 

Calculation. Since the accrual objects are created automatically, the accrual method you specify here 

is adopted. 
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- Also assign an accrual type and a summarization flow type to the flow type in Conditions and 

Flows: Flow Types. 

Legacy Data Transfer 

The settings for legacy data transfer are not relevant in the context of RE-FX. Do not make any entries for 

the RE component here. Instead, proceed as described in SAP Note . 

 Accrual/Deferral 

 Basic Settings 

 Assign Company Codes 

Use 

In this IMG activity, you have to assign to the Accrual Engine those company codes in which you want to 

calculate and post accruals. This setting is required, as company codes cannot be transferred directly 

from Customizing for the enterprise structure. 

Activities 

For your application component, enter all company codes in which you want to calculate and post 

accruals. 

 Company Code Settings for Accrual/Deferral 

Use 

For the company code, specify whether: 

- Taxes are also to be accrued/deferred 

- Periodic postings are to be taken into account 
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 Accounting Principles 

 Define Accounting Principles 

Use 

In this activity, you define your accounting principles. You have to make this setting if you want to depict 

a parallel valuation method in an additional ledger. You then assign accounting principles to the ledgers 

to which the postings are made. 

Note 

For performance reasons, you can combine several different accounting principles in one entry; for 

example, you create one accounting principle for IAS/US GAAP. This can be useful if, in an application, 

you have to create the data for each accounting principle, even if the postings derived from the data are 

identical for each accounting principle. 

If, for example, you reflect both IAS and US GAAP in your system, in the application Manual Accruals, 

you have to create one accrual item for each accounting principle. However, the accruals are identical for 

IAS and US GAAP. You therefore only have to create one accounting principle in the system, for 

example IAS/US GAAP for Accruals. 

Caution 

The accounting principles that you have defined are available in various functions in Financial 

Accounting, such as in the report for foreign currency valuation, in Manual Accruals and in Provisions 

for Awards. SAP therefore advises you not to delete accounting principles. This is particularly important 

in the case of accounting principles that have already been used. 

Activities 

1. Enter a four-digit key in the Accounting Principle field. 

2. In the Description field, enter a description for your accounting principle. 

3. Save your accounting principle. 

 Assign Accounting Principle to Company Code 

Use 

In this IMG activity, you assign the relevant accounting principle(s) to the company codes that use the 

Accrual Engine. 
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Each time an accrual object is created, the system checks whether the entered company code/accounting 

principle combination is permitted. 

This setting is necessary in order to guarantee that the authorization check is carried out at the company 

code and accounting principle level. For example, it is important to ensure that a German account has 

authorization to carry out an accrual run for his/her local accounting principle only. Meanwhile, the 

group accountant should also be able to carry out the accrual run in the group accounting principle (such 

as GAAP). 

Activities 

Assign the relevant accounting principles to the company codes. 

Example 

In company code  (USA), you want to allow accounting principles GAAP and IAS. You therefore 

create the following combinations: 

- Company code  / Accounting principle GAAP -

 Company code  / Accounting principle IAS 

 Accrual Types 

 Define Accrual Types 

Use 

In this IMG activity, you define the accrual types that you require. 

If you want to perform all postings provided for by the system for an accrual type, the system makes the 

following postings: 

- Opening entry 

With an opening entry, the entire amount to be accrued is posted as the value. Account 

determination is normally set in such a way that the entire amount to be accrued is posted to an 

accruals account. 

- Periodic postings 

When periodic accrual is started, the accrual amount that is due at the key date is calculated and 

posted. Account determination is normally set in such a way that the posting is made from the 

accruals account to a profit and loss account. 

- Closing entry 
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A closing entry is only made if the accrual object has been deactivated, even if all accruals have not 

yet been posted. The amount that has not yet been accrued at the time of deactivation is posted as a 

deactivation amount. 

Activities 

1. Choose New Entries. 

2. In the AccrualType field, enter a text for your accrual type, such as COSTS. 

3. You can create a derived accrual type. To do this, set the derived flag. By setting this flag, you 

specify that this accrual type is to be calculated from other accrual types, for example as the 

difference between or sum of these other accrual types. You then define the calculation rule that 

defines how this accrual type is to be calculated from other accrual types. You do this in 

Customizing, under Derived Accrual Types. 

4. Specify which postings you want to be made for this accrual type: 

- None 

For this accrual type, the amounts to be accrued are calculated but no corresponding postings 

are made. 

- All 

An opening entry, the periodic posting and a closing entry are all posted. 

- Periodic only 

Only periodic postings are made. No opening or closing entries are posted. 

- Opening entry only 

Only the opening entry is posted. 

5. In the Description field, enter a more detailed description for your accrual type. 

6. Save your accrual type. 

 Derived Accrual Types 

 Define Operators for Derived Accrual Types 

Use 
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In this IMG activity, you can define the operators for derived accrual types. An operator specifies how the 

accrual values of a derived accrual type are calculated from the values of the referenced accrual type, for 

example Operator + for adding or - for subtraction. 

Requirements 

You must have already created you accrual types in the IMG activity Define Accrual Types. 

Standard settings 

SAP delivers standard predefined operators. If the predefined operators do not meet your requirements for 

calculation of derived accrual types, you can create your own operators. 

Activities 

To create a new operator, proceed as follows: 

1. In the operator field, enter a one-digit key for your operator. 

2. Enter a text for your operator. 

3. Save your operator. 

 Assign Operators to Function Modules 

Use 

In this IMG activity, you can assign a function module to an operator for a derived accrual type. This 

function module contains a description of how your operator works. You have the option of using SAP 

function module ACE_DS_OPN_ADD as a template. 

Note 

The function module must have a defined interface. 

Requirements 

You must already have created your operator in IMG activity Define Operators for Derived Accrual 

types. 

Activities 

To assign a function module to your operator, proceed as follows: 

1. Enter the key for your operator. 

2. Enter the name of the function module. 

3. Save the assignment. 
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 Define Calculation Guidelines for Derived Accrual Types 

Use 

In this activity, you define the calculation rule that you want the system to use to determine the accrual 

values for derived accrual types. In this calculation rule, you can also use the operators that you have 

defined. 

Requirements 

You must have already created you accrual types in the IMG activity Define Accrual Types. 

Activities 

1. Choose New Entries. 

2. Make the following settings: 

- In the Accrual Type field, enter the derived accrual type for which you want to define the 

calculation rule. 

- Enter the required accounting principle for the derived accrual type. 

- Enter the sort number. 

- Enter an operator, such as Add, according to which you want the accrual values to be 

determined. 

- Enter the referenced accrual type from which you want the derived accrual type to be 

determined. 

- Enter the referenced accounting principle for the referenced accrual type. 

. Save your calculation rule. 

Example 

In this example, you calculate and post your accruals according to just one country-specific accounting 

principle (). 

When you create an accrual object, you can choose between the following accrual types: 

- RVNUES ( revenues ) 

- COSTS 

You also want to accrue the profit using the formula PROFIT = RVNUES - COSTS. To do this, you have 

to make the following settings. 

1. In IMG activity Define Accrual Types, create an additional accrual type PROFIT. The operators Add 

and Subtract are provided by SAP in the standard system. 
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2. Create a calculation rule for adding the revenues with the following entries: 

- Accrual type: PROFIT 

- Accounting principle:  

- Sort number:  

- Operator: Add 

- Referenced accrual type: RVNUES 

- Referenced accounting principle:  

3. Create a calculation rule for subtracting the costs with the following entries: 

- Accrual type: PROFIT 

- Accounting principle:  

- Sort number:  

- Operator: Subtract 

- Referenced accrual type: COSTS 

- Referenced accounting principle:  

In Accrual Engine Reporting, accrual type PROFIT is then taken into account if all referenced accrual 

types necessary for the calculation are available. This means, for example, that the accrual type PROFIT 

is considered provided that the referenced accrual types RVNUES and COSTS are available. If accrual 

type PROFIT is marked as To Be Posted, the value determined is posted during the periodic accrual run. 

 Special Operators 

 Set Percentage Rates for Operator P 

Use 

In this IMG activity, you can define which percentage you want to use for the derived accrual type P 

(percentage). 

Note 

However, you only need to make this setting if you use derived accrual types and use derived accrual type 

P in your calculation rules. 

Activities 
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1. Choose New Entries. 

2. Enter the company code for which you want to define the percentage. 

3. Enter the percentage you have chosen. 

4. Save your settings. 

Example 

In this example, you calculate and post your accruals according to just one country-specific accounting 

principle (). 

You want to accrue costs (accrual type COSTS). In addition to the costs, you also want to accrue the 

interest for this amount. To do this, you have to make the following settings. 

1. In IMG activity Define Accrual Types, create an additional accrual type INTRST ( interest ). 

2. In IMG activity Define Calculation Rule for Derived Accrual Types make the following entries for 

accrual type INTRST. 

- Accrual type: INTRST 

- Accounting principle:  

- Sort number:  

- Operator: Percentage 

- Referenced accrual type: COSTS 

- Referenced accounting principle:  

3. Now define the chosen percentage in this IMG activity. 

 Open Fiscal Year for Accrual Postings 

Use 

In this IMG activity, you specify for your individual company codes which fiscal years are to be open for 

changes to accrual objects and for accrual postings. 

Activities 

1. Enter the required company code. 

2. Make the following settings for the fiscal year: 

- Completed fiscal year 
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Enter the most recent completed fiscal year. 

No more changes can be made to accrual objects in a fiscal year that is already completed. 

However, you can perform periodic accrual postings in closed fiscal years. Fiscal years are 

closed for accrual postings using the period lock in Financial Accounting at the account level. 

- Current fiscal year 

The system finds the current fiscal year automatically if the balance has been carried forward 

in the Accrual Engine. Periodic accrual postings can only be made in the current fiscal year or 

in previous years, but not in future fiscal years. 

 Technical Settings 

 Accrual Objects 
 Define Layout for Accrual Objects 

Use 

In this IMG activity, you can define the layout variants with which you define the screen layout for 

creating, changing and displaying accrual objects. 

In a layout variant, you can define the fields to be displayed and the order in which they are to be 

displayed. You can also determine how the fields are displayed, meaning that you can choose whether the 

values for the fields are to be displayed with values and/or text. 

Requirements 

If you want to add a user-defined field to your layout variant, you must have assigned this to an accrual 

object category. You make this assignment in IMG activity Assign Parameters to Accrual Object 

Categories. 

Standard settings 

SAP delivers layout variant STANDARD in the standard system. If you want to define your own layout 

variants, you must create these in customer namespace Z*. You can also use the SAP standard layout 

variant as a template. 

Activities 

1. Choose New Entries. 

2. Enter a name for your layout variant in the variant field and a descriptive text in the text field. The 

name of the layout variant must begin with Z. 
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3. Select your layout variant and double-click on field sequence in the navigation area. 

4. Choose New Entries. 

5. Via the field field, choose the fields that you want to display and enter the sequence in which you 

want to display these fields in the sequence field. 

6. Choose the display for the individual fields. 

7. Save your layout variant. 

 Define Customer Navigation 

Use 

This BAdI enables a customer-defined navigation to any target from the accrual (sub)object of 

the accrual engine. 

Requirements 

The BAdI is called when you double-click on the field or the fields that identify the accrual 

object uniquely in the display transaction for accrual objects (for example, in transaction 

ACENAVIGATOR). 

These are usually the fields in the upper left of the screen. 

Standard settings 

See the example below. 

Activities 

Since you can use this BAdI more than once, you can also create your own BAdI implementations, for 

example, to define your own navigation logic. 

Example 

For the application "Manual Accruals", SAP delivers the implementation 

ACAC_UI_NAVIGATION. Therefore, the component "ACAC" has been entered as filter value in this 

implementation. 

The implementation is therefore only carried out for the application "Manual Accruals" and not for other 

applications of the accrual engine. 

The BAdI, that is, the implementation, is called when you double-click on the accrual object number in 

transaction ACACTREE or ACACTREE. 
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The following program logic is implemented in the implementation: 

1. The system checks whether the accrual object type = "VENDORINV". 

If this is the case, the system assumes that the accrual object number is an external number in 

the form <FI document number>/<Fiscal year>/<Posting item>. Accrual objects with such 

numbers are created by the data transfer program 

ACAC_DATA_TRANSFER_EXAMPLE. 

This FI document number is the document number of the underlying invoice that is to be accrued. 

2. The FI document number is determined from the accrual object number. 

3. You navigate to the FI document display to display the FI document, that is, the invoice. 

 Basic Settings for Components 

 Make Settings for Components 

Use 

In this IMG activity, you can decide how and in what form you want the Accrual Engine to be 

implemented for a given component. Components are applications that call up the Accrual Engine to 

calculate and/or post accruals. Examples are Manual Accruals or Provisions for Awards. 

Transaction data and Customizing data are stored separately for each component in the Accrual Engine. 

Note 

Changes to the component settings can only be made by SAP AG. 

Activities 

To be able to use the Accrual Engine functions for a component, you have to make the following settings: 

1. Choose Display -> Change. 

You are now in change mode. You can change the settings of an existing component or add a new 

one. To add a new component, proceed as follows: 

2. Choose New Entries. 

You have to make the following settings: 

- Enter the component. 

- Under Type, specify whether you want to use the Accrual Engine for calculating accruals 

and/or posting accruals. 

- Enter the Reference Process, with which the accruals are posted in Accounting. 

- You can enter source fields. You can use source fields in account determiation, for example. 
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3. Save your settings. 

 Assign Alternative Data Elements for Components 

Use 

In this IMG activity, you can assign component-specific data elements to data elements in the Accrual 

Engine. This ensures that the posting lists display the component-specific data elements as column 

headers. 

Note 

Changes to the component settings can only be made by SAP AG. 

Activities 

1. In the ACE Data Element field, enter the technical name of the Accrual Engine data element that 

you want to replace with a component-specific data element. 

2. In the Alt. Data Element field, enter the technical name of the component-specific data element. 

3. Save your assignment. 

 Develop Component-Specific System Exits 

Use 

In this IMG activity, you can define component-specific source code for each component that uses the 

Accrual Engine. System exits are provided in the Accrual Engine at defined points. 

These points are flagged by the following fields: 

- APPL: Area within the Accrual Engine 

This field serves to subdivide the possible system exits and has the classifications: 

- ACE: Accrual Engine 

- ACE-DS: Accrual Engine, Distribution Server 

- ACE-DS: Accrual Engine, Posting Server 
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- EVENT: System Event 

There are a larger number of possible system events, such as 

- REP_COMMND: Component-specific processing OK codes in Reports 

In this view, you have to define a function module for each system exit used. 

Note 

Changes to the component settings can only be made by SAP AG. 

 Develop Component-Specific Program Components 

Use 

In this IMG activity, you enter the component-specific program components that you need for your 

component to use the Accrual Engine. You must specify all program components that you need. 

Note 

Changes to the component settings can only be made by SAP AG. 

Activities 

To enter the required program components, proceed as follows: 

1. Choose New Entries. 

2. Enter your application component in the Component field. 

3. Choose the required program components or enter the names of these program components. Some 

program components are optional. 

For further information on the individual program components, see F possible entries. 

4. Save your settings. 

 Define Customer Settings for Components 

Use 

In this IMG activity, you can define the central properties of your application component: 

- Source Fields 

When defining account determination, you have the option of using user-defined fields 
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(source fields). To be able to use these fields, you have to define your user-defined DDIC structure 

containing your user-defined fields in the Source Fields field in this IMG activity. 

Note 

You only need to define a DDIC structure if too few fields are available to you in the standard. 

The DDIC structure can only contain fields that are stored in table ACEDSOP table in the 

PARAM_NAME field. Entries are generated in the ACEDSOP table when accrual objects are 

created. 

- Default Accounting Principle 

You can define an accounting principle that will always be proposed as a default value whenever 

you create an accrual object. 

- Determine Next Open Period 

If a posting period is locked for a posting date found by the system, you can specify that the system 

should automatically post to the next open posting period. To do this, set the indicator Determine 

Next Open Period. If you do not set this indicator, the system issues an error message. 

- Do not automatically Transfer Postings to Accounting 

You can suppress an automatic transfer of Accrual Engine documents to Accounting. This is useful, 

for example, if you are still testing the manual accrual functions. 

- Layout Variant 

You can define a standard layout variant. This is then used to display the tree structures in the 

functions for processing accrual objects. SAP delivers layout variants for the individual application 

components. 

Requirements 

To be able to define the central properties, the following conditions must be met: 

- DDIS Structure 

The DDIC structure can only contain fields that are stored as entries in the ACEDSOP table in the 

PARAM_NAME field. Entries are generated in the ACEDSOP table when accrual objects are 

created. 

- Standard Accounting Principle 

It can make sense to specify a default accounting principle if you do not want to post and calculate 

accruals according to various accounting principles. When you create an accrual object (such as a 

leasing contract or a provision), the standard accounting principle then applies, meaning that you do 

not have to enter another accounting principle. 

Note 

In some cases, however, you may still have to enter an accounting principle when creating an 

accrual object. 

Activities 

Check whether you have to create a customer-specific DDIC structure or a standard accounting principle. 
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 Legacy Data Transfer 

 Define Legacy Data Transfer 

Use 

In this IMG activity, you can define how you want legacy data to be transferred from the system to the 

Accrual Engine for the required company codes . A distinction is made here between the following types 

of legacy data transfer: 

- Legacy data transfer for test purposes 

This allows you to delete the data again after the transfer. You can repeat the data transfer as often 

as you like. 

- Productive legacy data transfer 

With this type of transfer, you cannot delete the transferred data. 

Activities 

1. Enter the company code for which you want to transfer the legacy data. 

2. Define the following control parameters: 

- Legacy Data Transfer Date 

Enter the date from which you want the legacy data transfer to be carried out. 

- Legacy Data Transfer Mode 

Specify whether you want to perform the legacy data transfer for test purposes or in the 

productive system. 

- Legacy Data Transfer Only 

Specify whether you only want legacy data to be allowed in the Accrual Engine. If you set this 

flag, you cannot create new data in the Accrual Engine. By doing this, you make sure that the 

system contains legacy data only before the system is set to productive. After checking the 

legacy data transferred, you can reset the flag, meaning that you can create new data again in 

the productive system, for example when posting. 

- Legacy Data Transfer Data to Accounting 

Specify whether you want the legacy data to be transferred to Accounting. 

3. Save your settings. 

Example 

 Delete Legacy Data after Transfer 

Use 
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In this IMG activity, you can delete legacy data that has already been transferred. 

 Archiving 

 Prepare Archiving Run 

Use 

In this IMG activity, you carry out a preparation run for archiving accrual objects. You must carry out a 

preparation run before running an archiving session. In a preparation run, the system performs the 

following functions: 

- It selects the accrual objects that you have defined on the selection screen 

- In accordance with pre-defined rules, it assigns all selected accrual objects the status To Be Archived 

or In Processing 

Afterwards, when you run the archiving session, the system will archive all archiving objects with the 

status To Be Archived. 

Note 

In future accrual runs, accrual objects with the status To Be Archived will no longer be incliuded, even if 

you have not yet actually archived them. This means that no more accrual postings will be made for these 

accrual objects. 

However, accrual objects with the status To Be Archived are still displayed in Reporting, as accrual 

postings may have been made for these objects in the past. 

Standard settings 

The rules used to determine the archiving status for the individual accrual objects is provided by SAP. In 

the Manual Accruals component for example, the following conditions must be met for an accrual object 

to have the status To Be Archived: 

- The life of the accrual object ends before today's date. 

- No periodic accrual postings have been made for at least  days. 

You can change the status assigned to an archiving object using the Business Add-In ( BAdI ) 

ACE_ARCHIVING_PREP. To do this, choose IMG activity Correct Archiving Status in Accrual Engine 

Customizing. You can also use this BAdI to define your own rules for status assignment. 
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Activities 

Before starting a preparation run for archiving, run it in test mode: 

1. Enter the company codes in which you want to archive the accrual objects. 

2. Enter the key date for your preparation run. 

3. Set the Display Results List flag. 

4. Set the Test Run flag. 

5. Choose Execute. 

Check the results list for your test run. You have the following options: 

- If you are happy with the status assigned to the individual archiving objects, execute the preparation 

run in update mode. Do not set the Test run flag. 

- If you want to change any of the status assignments, use the BAdI 

ACE_ARCHIVING_PREP. To do this, choose the IMG activity Correct Archiving Status in 

Accrual Engine Customizing. 

Note 

The archiving preparation run can be repeated as many times as you like, even in update mode. 

 Correct Archiving Status 

Use 

This Business Add-In (BAdI) is called during the preparation run for archiving Accrual Engine data. 

During the preparation run for archiving, Accrual Engine data is selected. 

On the basis of predefined rules, the system decides how the data for an accrual object is to be archived. 

The system sets the 

CD_ARCHIVE_OBJ indicator. This flag can have the following values: 

- X 

This accrual object is to be archived. This means that you want the system to change the status of 

this accrual object to To be archived. 

- < initial > 

This accrual object is not to be archived. This status of this accrual object should not be changed to 

To be archived. 
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The rules (conditions) which your system uses to decide whether the accrual object is to be archived or 

not are defined in function module ACE_ARCHPREP_DECIDE. This function module is called up in the 

default implementation of this BADI. 

By creating your own  BAdI implementation for this BAdI, you can replace the standard logic with your 

own logic. 

Description of the parameters in the method: 

- IS_ACEOBJ 

Accrual object. Entry from database table ACEOBJ 

- IT_ACEDSOH 

Table with header data for subobjects of the accrual object. This table contains, for 

example, the validity periods of the accrual subobjects. These are entries from database 

table ACEDSOH. 

- IT_ACEPSOI 

Table with item data for the accrual subobjects. This table contains, for example, the data of the 

most recent periodic accrual posting. It also contains the accrual amounts posted grouped by year. 

These are entries from database table ACEPSOI. 

- ID_KEYDATE 

Key data on which the archiving preparation run is executed. 

Using the parameters described, in the BAdI you can decide whether an accrual object is to be archived or 

not. 

Allgemeine Informationen zur Definition von BAdIs finden Sie in der SAP-Bibliothek unter Basis -> 

ABAP Workbench (BC-DWB) -> Änderungen des SAP-Standards (BC) -> Business Add-Ins -> 
Definition eines Business Add-Ins. 

Example 

The preparation run is executed for the key date December , . A number of accrual subobjects have a 

runtime from January ,  to November ,  

The system therefore sets the CD_ARCHIVE_OBJ indicator to <initial>, meaning that the system would 

not archive this accrual object, as some accrual subobjects are still valid and it is therefore expected that 

accrual postings might still be made to these in future. 

You know, however, that no more accrual postings will be made to these accrual objects, and they can 

therefore be archived. 

You therefore create your own BAdI implementation where the indicator CD_ARCHIVE_OBJ is set to X 

for these accrual objects. 

 Validation 

 Define Validation 

Use 
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In this IMG activity, you can define a validation that the system will work through when you create or 

change accrual objects. You can use the validation, for example, to check whether you can enter a 

certain accrual type is allowed when creating an accrual object for an accounting principle. 

For general information on creating validations, see 

- the Implementation Guide for Special Ledgers, under Tools -> Maintain 

Validation/Substitution/Rules -> Maintain Validation 

- the SAP library, under Accounting -> Financials -> Special Ledgers -> Tools -> Validation, 

Substitution and Rules 

Requirements 

In your validation, you can also use a user-defined field that you have created in your own parameter 

structure. To ensure that you can use this field for defining a validation, you have to make the following 

settings: 

1. You have to define an append structure zu for the SAP structure ACEVSR_VAL_PAR. You have to 

add the required user-defined field to the append structure. Proceed as follows: 

a) From the SAP Easy Access screen, choose Tools -> ABAP Workbench -> Development -> 

Dictionary (transaction SE). 

b) In the database table field, enter ACEVSR_VAL_PAR and choose Change. 

c) Choose Activate and then Append Structure. 

d) Choose New Entries, enter a name in the customer namespace and choose Enter. 

e) Add the required field to your append structure. 

Save your settings. 

2. You have to add the field to the SAP structure ACAC_PARAMETERS. To do so, proceed as 

follows: 

a) From the SAP Easy Access screen, choose Tools -> ABAP Workbench -> Development -> 

Dictionary (transaction SE). 

b) In the database table field, enter ACAC_PARAMETERS and choose Change. 

c) Enter the required user-defined field. 

d) Choose Activate. 

e) Save your settings. 

3. Assign the required user-defined field to the accrual object categories in which you want to use the 

field. 

To do so, call up Customizing for Manual Accruals and choose  Basic Settings -> 

Technical Settings -> Accrual Object Categories -> Assign Parameters to Accrual Object 
Categories 
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Activities 

4. Define your validation. 

5. Activate your validation. 

 Activate Validation 

Use 

In this IMG activity, you activate your validations. You activate the validations on a company code and 

accounting principle basis. 

Requirements 

You must have already created your validations in IMG activity Define Validations. 

Activities 

To activate a validation, proceed as follows: 

1. Choose New Entries. 

2. Enter the time at which you want the validation to be processed. 

3. Enter the company code and the accounting principle for which you want the validation to be valid. 

4. In the Valid. field, enter the name of your validation. 

5. Set the validation to active in the Activate field. You can choose whether the validation is to be 

inactive, active or active without batch input - that is, without background processing. 

6. You can also define a validity period for your validation in the Valid from and Valid to fields. 

7. Save your settings. 

 Performance 

 Specify Package Size for Processing 

Use 

You can use this customer implementation to determine the package size of the accrual objects processed 

in a work process. The size of a package influences the consumption of system resources. 

The higher the number of objects, 
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- The more memory is used 

- The lower the number of times that the database is accessed 

- The lower the number of RFC modules sent 

- The longer it takes to process a processing package 

The package size that allows you to achieve optimum throughput depends on your system. 

Standard settings 

With the default setting, the package size is . 

 Accrual Calculation 

 Accrual Methods 

 Define Accrual Methods 

Use 

In this IMG activity, you define your accrual methods. The accrual method specifies how amounts are to 

be accrued, for example straight-line or declining balance accrual. 

You must assign a function module specifying the calculation of accruals to each accrual method. 

Caution 

The function module for an accrual method must have a defined interface. You can use function module 

ACE_DS_METHOD_LINEAR_P as a template. 

Activities 

1. Enter a key with two or more digits in the accrual method field. 

2. In the Function Module Name field, enter the function module for you accrual method. 
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3. In the Text field, enter a text for your accrual method. 

4. Save your accrual method. 

 Develop Function Modules for Accrual Methods 

Use 

In this IMG activity, you enter the function modules that you can assign to your accrual methods. 

Function modules are used to calculate the accruals (or provisions). 

Standard settings 

SAP delivers a number of function modules in the standard system. You can also use these function 

modules as templates for your own function modules. 

Activities 

Enter the  function modules that you require. 

Example 

 Define Standard Settings for Accrual Calculation 

Use 

In this activity, you define which accrual method the system should use as standard for calculating 

accruals. You do this for each accrual type/accounting principle combination. 

This means that, when creating an accrual object, you no longer need to specify the accrual method to be 

used for calculating amounts to be accrued. However, you can still choose to replace the proposed 

standard accrual method with a different one. 

If you do not define a standard method, you have to enter the required accrual method every time you 

create an accrual object. 

Activities 
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For each combination of accrual type and accounting principle, specify the desired standard method. 

 Accrual/Deferral Posting 

 Define Posting Control 

Use 

In this IMG activity, you have to decide how you want accrual postings (or provisions postings) be made 

for each of your company code/accounting principle combinations. You have to make the following 

settings. 

- Frequency of the periodic accrual postings 

You define the frequency with which you want the accruals to be posted, for example by posting 

period or monthly. 

- Summarization for transfer to Accounting 

You define if and in what form you want to summarize data when transferring accrual postings to 

Accounting. 

If you do not want any summarization at all, a document line will be created in Accounting 

(Account document) for each accrual item or type 

Standard settings 

The following settings are provided by SAP as standard. Unless you make any settings yourself, the 

setting will use these standard settings: 

- Frequency of the periodic accrual postings: Per posting period 

- Summarization for transfer to Accounting: No summarization active 

Activities 

Make the required settings for each of your company code/accounting principle/accrual type 

combinations. 
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 Number Ranges 

 Define Number Ranges for Periodic Posting Runs 

Use 

In this IMG activity, you have to define the number ranges for your posting runs. This ensures that each 

periodic accrual posting run has a unique number. 

Number Range Intervals and Application Components 

Every application component in the Accrual Engine needs its own number range interval. This interval is 

identified by a two-digit number. This number therefore represents an assignment to an application 

component: 

Application component Two-digit number 

Leasing Accounting Engine  

Manual Accruals  

Provisions for Awards  

Revenue Recognition: Rights Management   

Provisions: Rights Management   

You can find assignment of the two-digit number to an application component in Accrual Engine 

Customizing, activity Make Settings for Components. 

Note 

To avoid overlaps between application components, make sure of the following: 

o In each number range definition activity, a number range interval must be created for your application 

component under the assigned two-digit number. 

In the definition of a number range, the number range intervals of the different application components 

must not overlap. 

Activities 

To create a new number range, proceed as follows: 

1. Enter the company code and choose Change Intervals. The Maintain Number Range Intervals 

screen appears. 

2. Choose Insert Interval. 

3. You can make the following settings: 

- Number 

Enter the number of the number range interval, that is, enter the number of your application 

component. 

- From number 

Enter the lower limit of the interval. 
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- To number 

Enter the upper limit of the interval. 

- External 

You can specify that number assignment is to be made externally. If yo do not set this flag, 

number assignment is made internally, meaning that numbers are assigned automatically in 

sequence by the system. The last number assigned is always displayed in the current number 

field. 

4. Save your number range. 

 Define Number Ranges for Application Log 

Use 

In this IMG activity, you have to define the number ranges for the application log. Each application log 

then contains a unique number and can be assigned uniquely to an accrual run. 

Number Range Intervals and Application Components 

Every application component in the Accrual Engine needs its own number range interval. This interval is 

identified by a two-digit number. This number therefore represents an assignment to an application 

component: 

Application component Two-digit number 

Leasing Accounting Engine  

Manual Accruals  

Provisions for Awards  

Revenue Recognition: Rights Management   

Provisions: Rights Management   

You can find assignment of the two-digit number to an application component in Accrual Engine 

Customizing, activity Make Settings for Components. 

Note 

To avoid overlaps between application components, make sure of the following: 

o In each number range definition activity, a number range interval must be created for your application 

component under the assigned two-digit number. 

In the definition of a number range, the number range intervals of the different application components 

must not overlap. 

Activities 
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To create a number range, proceed as follows: 

1. Choose Change intervals. 

The Maintain Number Range Intervals screen appears. 

2. Choose Insert Interval. 

3. You can make the following settings: 

- Number 

Enter the number of the number range interval, that is, enter the number of your application 

component. 

- From number 

Enter the lower limit of the interval. 

- To number 

Enter the upper limit of the interval. 

- External 

You can specify that number assignment is to be made externally. If yo do not set this flag, 

number assignment is made internally, meaning that numbers are assigned automatically in 

sequence by the system. The last number assigned is always displayed in the current number 

field. 

4. Save your number range. 

 Define Number Ranges for Accrual Engine Documents 

Use 

In this activity, you define the number ranges for the Accrual Engine documents. Accrual 

Engine documents are created in addition to Accounting documents during posting of accruals 

(opening entry, periodic posting, closing entry). 

INCLUDE ACC_GL_ACE_NUMBRANGE OBJECT DOKU ID TX LANGUAGE EN 

Activities 

To create a new number range, proceed as follows: 

. Enter the company code and choose Change Ranges ( Intervals ) 

INCLUDE ACC_GL_ACE_NUMBRANGE OBJECT DOKU ID TX LANGUAGE EN 
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 Define Number Ranges for Assigning ACC Doc. to ACE Doc. 

Use 

In this IMG activity, you define number ranges ffor the Accounting documents. When accruals are posted 

(opening entry, periodic posting and closing entry) documents are created both in the Accrual Engine and 

in Accounting. Firstly, Accrual Engine documents are created. These are transferred to Accounting, 

leading to the creation of Accounting documents. A unique external reference is required so that Accrual 

Engine documents can then be assigned uniquely to Accounting documents. 

When transferring Accrual Engine documents to Accounting, you have the option of summarizing 

Accrual Engine documents  to a single summarized document in Financial Accounting. Alternatively, 

you can transfer the documents to several different documents in Financial Accounting (no 

summarization) 

Achtung 

You define the linking of these Accrual Engine documents to Accounting documents using a separate 

number, the reference number. This is part of the reference key. 

Number Range Intervals and Application Components 

Every application component in the Accrual Engine needs its own number range interval. This interval is 

identified by a two-digit number. This number therefore represents an assignment to an application 

component: 

Application component Two-digit number 

Leasing Accounting Engine  

Manual Accruals  

Provisions for Awards  

Revenue Recognition: Rights Management   

Provisions: Rights Management   

You can find assignment of the two-digit number to an application component in Accrual Engine 

Customizing, activity Make Settings for Components. 

Note 

To avoid overlaps between application components, make sure of the following: 

o In each number range definition activity, a number range interval must be created for your application 

component under the assigned two-digit number. 

In the definition of a number range, the number range intervals of the different application components 

must not overlap. 

Activities 

To create a new number range, proceed as follows: 
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1. Enter the company code and choose Change Intervals. The Maintain Number Range Intervals 

screen appears. 

2. Choose Insert Interval. 

3. You can make the following settings: 

- Number 

Enter the number of the number range interval, that is, enter the number of your application 

component. 

- From number 

Enter the lower limit of the interval. 

- To number 

Enter the upper limit of the interval. 

- External 

You can specify that number assignment is to be made externally. If yo do not set this flag, 

number assignment is made internally, meaning that numbers are assigned automatically in 

sequence by the system. The last number assigned is always displayed in the current number 

field. 

4. Save your number range. 

 Account Determination 

 Simple Account Determination 

 Define Set of Rules 

Use 

In this IMG activity, you have to define a set of rules for account determination. 

Account determination is called up when Accrual Engine documents are passed on to Accounting, 

meaning that account determination occurs automatically with every posting ( opening entry, periodic 

accrual posting or closing entry). 

To ensure error-free account determination, the following information must be defined: 

- Document type 

- Start account (such as accrual account) 

- Target account (such as P&L account) 
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With a set of rules, you define the dependencies between the source fields and the target fields from 

which the document type and the accounts are to be derived. You have to define a set of rules before you 

can define the values for it (such as document type, accounts). 

A set of rules is made up of a series of individual rules. When creating the individual rules, you have the 

following options: 

- You can define rules that build on one another. Here, you must create the rules in the order in 

which you want the system to work through them. 

- You can define parallel rules. Here, you must remove the flag Post error message if no value 

found from the Properties tab when defining the individual rules. 

As source fields, you can use standard fields and component-specific fields: 

Standard fields 

ACCRULE Accounting principle ( RLV ) 

ACRTYPE Accrual type 

CHOACC Chart of accounts 

Component-Specific Fields 

You can use the component-specific fields that you defined as source fields in IMG activityMake 

Settings for Components. 

Customer-Specific Fields 

You can use the customer-specific fields that you defined as source fields in IMG activityDefine 

Customer Settings for Components. 

You can also use the component-specific fields that you defined in IMG activity Make Settings for 

Components  as source fields. 

Requirements 

To display or change settings in this IMG activity, you need the authorization in authorization object 

S_DEVELOP. 

To change or display the account determination, you require the authorization for authorization object 

S_TABU_DISS. 

Activities 

To create a set of rules for account determination, proceed as follows: 

1. Choose  Create Step. 

The Accrual Engine - Account Determination: Rule Definition screen appears. 

2. In the Derivation Rule field, you can enter a text for your rule. 

3. In the Definition tab, choose the required source and target fields. 
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4. In the Condition tab, you can enter a condition for linking source and target fields. 

5. In the Properties tab, you can make extra settings for your rule. If you set the Entries Can Be 

Maintained with Validity Date flag, your settings for the set of rules are time-dependent. 

6. Save your rule. 

You can call up IMG activity Define Values for Set of Rules directly, in which you enter the values for 

your rules. To do so, choose Maintain Rule Entries. 

 Define Values for Set of Rules 

Use 

In this IMG activity, you enter the values for the individual rules in a set of rules. For each rule, you enter 

the following: 

- The transaction in the Accrual Engine during which this rule is to be called up 

- The document type document type to be created 

- The start account and the target account to which the posting is to be made The following 

postings can be made, depending on the process: 

- from a start account of your choice to an accrual account as target account 

- from an accrual account as start account to a P&L account as target account ( for example during 

periodic recognition or closing) 

Requirements 

Before you can define the values for a set of rules, you must have defined the set of rules with its 

individual rules. You can find the IMG activity under: - Simple account determination: Define Set of 

Rules/> 

- Extended account determination: Define Set of Rules for Extended Account Determination 

Activities 

To enter the values for account determination, proceed as follows: 

1. Select the rule for which you want to enter the values and choose  Change Rule Entries. 

2. Entering the values for the rule. You can assign several transactions with their own account 

determination to each rule. 
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3. Save your entry. 

 Extended Account Determination 

 Define Account Symbols 

Use 

In this activity, you define your account symbols. Under an account symbol, you can summarize accounts 

from various charts of accounts. For example, you could define account symbol ACCRUALS under which 

you could summarize the individual accruals accounts from the various charts of accounts. This makes it 

possible during an accrual run to post to accounts in various company codes and from various charts of 

accounts. 

INCLUDE ACC_GL_ACE_ACCSYMB OBJECT DOKU ID TX LANGUAGE EN 

Activities 

1. In the Account Symbol field, enter a suitable name for the account symbol. 

2. In the Description field, enter a full description for your account symbol. 

3. Save your account symbol. 

 Define Combination of Characteristics 

Use 

INCLUDE ACC_GL_ACE_CHARACT OBJECT DOKU ID TX 

Activities 

To define an combination of characteristics, proceed as follows: 

1. Choose New Entries. 
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2. In the Rule field, enter a four-digit number for your account determination rule. 

3. In the Description field, enter a descriptive text for your combination of characteristics. 

4. Save your combination of characteristics. 

 Set of Rules with Account Symbols and Characteristic Combinations 

 Define Set of Rules for Extended Account Determination 

Use 

In this IMG activity, you define a set of rules for account determination. In contrast to simple account 

determination, extendend account determination provides you with account symbols and characteristic 

combinations  during definition of the set of rules. 

Account determination is called up when Accrual Engine documents are passed on to Accounting, 

meaning that account determination occurs automatically with every posting ( opening entry, periodic 

accrual posting or closing entry). 

To ensure error-free account determination, the following information must be defined: 

- Document type 

- Start account (such as accrual account) 

- Target account (such as P&L account) 

With a set of rules, you define the dependencies between the source fields and the target fields from 

which the document type and the accounts are to be derived. You have to define a set of rules before you 

can define the values for it (such as document type, accounts). 

A set of rules is made up of a series of individual rules. When creating the individual rules, 

you have the following options: 

- You can define rules that build on one another. Here, you must create the rules in the order in 

which you want the system to work through them. 

- You can define parallel rules. Here, you must remove the flag Post error message if no value 

found from the Properties tab when defining the individual rules. 

As source fields, you can use standard fields and component-specific fields: 

Standard fields 

ACCRULE Accounting principle ( RLV ) 

ACRTYPE Accrual type 

CHOACC Chart of accounts 
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Customer-Specific and Component-Specific Fields You 

can also use the following fields: 

- The customer-specific fields that you have defined as source fields in the IMG activity 

Define Customer Settings for Components 

- The component-specific fields that you have defined as source fields in the IMG activity Make 

Settings for Components 

Requirements 

To be able to use account symbols and characteristic combinations when defining your set of rules, you 

must have already defined these. You can find the settings under: 

- Define Account Symbols 

- Define Characteristic Combinations 

Activities 

1. Choose  Create Step. 

The Accrual Engine - Account Determination: Rule Definition screen appears. 

2. In the Derivation Rule field, you can enter a text for your rule. 

3. In the Definition tab, choose the required source and target fields. 

4. In the Condition tab, you can enter a condition for linking source and target fields. 

5. In the Properties tab, you can make extra settings for your rule. If you set the Entries Can Be 

Maintained with Validity Date flag, your settings for the set of rules are time-dependent. 

6. Save your rule. 

You can call up IMG activity Define Account Determination directly by entering the values for your 

rules. To do so, choose Maintain Rule Entries. 

 Define Values for Set of Rules 

Use 

In this IMG activity, you enter the values for the individual rules in a set of rules. For each rule, you enter 

the following: 

- The transaction in the Accrual Engine during which this rule is to be called up 
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- The document type document type to be created 

- The start account and the target account to which the posting is to be made The following 

postings can be made, depending on the process: 

- from a start account of your choice to an accrual account as target account 

- from an accrual account as start account to a P&L account as target account ( for example during 

periodic recognition or closing) 

Requirements 

Before you can define the values for a set of rules, you must have defined the set of rules with its 

individual rules. You can find the IMG activity under: 

- Simple account determination: Define Set of Rules/> 

- Extended account determination: Define Set of Rules for Extended Account Determination 

Activities 

To enter the values for account determination, proceed as follows: 

1. Select the rule for which you want to enter the values and choose  Change Rule Entries. 

2. Entering the values for the rule. You can assign several transactions with their own account 

determination to each rule. 

3. Save your entry. 

 Rule for Deriving Account from Account Symbol 

 Define Rule with Account Symbol 

Use 

In this IMG activity, you define a rule for your set of rules in order to define how to derive different 

accounts from an account symbol. 

You use this rule to define the dependency between the source fields and the accounts. You have to define 

a rule before you can define any values for it. 

As source fields, you can use standard fields and component-specific fields: 

Standardfelder: 

ACCRULE                        Accounting principle 

CHOACC                         Chart of accounts 
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GLSYMB                         Chart of accounts 

Customer-Specific and Component-Specific Fields You 

can also use the following fields: 

- The customer-specific fields that you have defined as source fields in the IMG activity 

Define Customer Settings for Components 

- The component-specific fields that you have defined as source fields in the IMG activity Make 

Settings for Components 

Requirements 

You must have already defined the set of rules in which you derive the account from the account symbol. 

You can find the IMG activity under Define Set of Rules for Extended Account Determination. 

Activities 

1. Choose  Create Step. 

The Accrual Engine - Account Determination: Rule Definition screen appears. 

2. In the Derivation Rule field, you can enter a text for your rule. 

3. In the Definition tab, choose the required source and target fields. 

4. In the Condition tab, you can enter a condition for linking source and target fields. 

5. In the Properties tab, you can make extra settings for your rule. If you set the Entries Can Be 

Maintained with Validity Date flag, your settings for the set of rules are time-dependent. 

6. Save your rule. 

 Define Values for Rule with Account Symbol 

Use 

In this IMG activity, you enter the values for the rule in which you derive accounts from the account 

symbol. 

Requirements 

You must have defined the rule for deriving the account from the account symbol. You can find the 

setting under Define Rule with Account Symbol. 
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Activities 

1. Select the rule for which you want to enter the values and choose  Change Rule Entries. 

2. Entering the values for the rule. You can assign several transactions with their own account 

determination to each rule. 

3. Save your entry. 

 Document Change Using BAdI 

 Change Document Before Summarization 

Use 

This Business Add-In (BAdI) allows you to change the temporary accounting document or to add 

document lines to it before it is summarized and transferred to Accounting. 

When an Accrual Engine document is transferred to Accounting, the system performs the following 

processes: 

- Firstly, a temporary two-line accounting document is made up from the Accrual Engine in the form 

of BAPI structures. 

- Secondly, a number of these temporary two-line accounting documents are summarized before 

being transferred to Accounting. You can decide whether or not you want these temporary 

accounting documents to be summarized in IMG activity Define Posting Control. 

The BAdI uses the following parameters: 

- IS_ACEDOCITEM 

This parameter represents the Accrual Engine document. 

- CS_BAPI_HEADER 

Header data of the accounting document 

- CT_BAPI_ITEMS 

Items in the accounting document, contains two entries 

- CT_BAPI_CURR 

Currency information for the items 

You can use the BAdI ACEPS_BAPIDOC_MODIFY (Change Document After Summarization) to change 

the accounting document after summarization but before transfer to Accounting. 
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For general information about defining BadIs, see the SAP library under Basis -> ABAP Workbench 

(BC-DWB) -> Changes to the SAP Standard (BC) -> Business Add-Ins -> Defining a Business Add-In. 

 Change Document After Summarization 

Use 

This Business Add-In (BAdI) allows you to change the temporary accounting document or to add 

document lines to it after it is summarized but before it is transferred to Accounting. 

When an Accrual Engine document is transferred to Accounting, the system performs the following 

processes: 

- Firstly, a temporary two-line accounting document is made up from the Accrual Engine in the form 

of BAPI structures. 

- Secondly, a number of these temporary two-line accounting documents are summarized before 

being transferred to Accounting. You can decide whether or not you want these temporary 

accounting documents to be summarized in IMG activity Define Posting Control. 

The subsequent transfer to Accounting is carried out using BAPIs. 

Note 

You also have the option of making as many entries as you like in an EXTENSION table in order to 

change the accounting document. This table is given over to the BAPI. You can evaluate the table 

immediately after calling up the BAPI in Accounting. To do this, you have to activate enhancement 

ACBAPI using transaction CMOD. It can make sense to use the extension table if, for example, you want 

to fill user-defined fields in Accounting that are not available in the BAPI interface (in the BAPI 

structures). 

However, SAP recommends that you change the accounting document directly using this BAdI, without 

using the extension table. 

The BAdI uses the following parameters: 

- ID_TESTRUN 

Flag: This is a test run. 

No data is updated in the test run. 

- ET_EXTENSION 

Extension table when BAPI is called up. 

CS_BAPI_HEADER 

Header data of the Accounting document. 

- CT_BAPI_ITEMS 

Items in the Accounting document, contains 

- two entries if summarization is not active in the Accrual Engine, 
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- at least two entries if summarization is active in the Accrual Engine. 

- CT_BAPI_CURR 

Currency information for the items. 

You can use BAdI ACEPS_BAPIPREDOC_MOD Change Document Before Summarization to change the 

Accounting document before summarization. 

For general information about defining BadIs, see the SAP library under Basis -> ABAP Workbench 

(BC-DWB) -> Changes to the SAP Standard (BC) -> Business Add-Ins -> Defining a Business Add-In. 

 Fill Data Buffer for Document Change 

Use 

You can use this Business Add-In (BAdI) to buffer data that needs to be written to the BAPI document at 

a later point in time. The Accrual Engine creates a package of accruals that are processed together. In this 

way, all of the data for this package can be determined together at the start. Consequently, you can reduce 

the number of times that the database is accessed. 

Example 

You want to add the customer#s region to the FI document. In this case, you use this BAdI to buffer the 

customer data of all accrual objects instead of reading it from the database with the 

BAdIs ACEPS_BAPIPREDOC_MOD and ACPES_BAPIDOC_MODIFY. 

 Make Settings for Accrual/Deferral of Taxes 

 Activate Tax Accrual/Deferral per Company Code 

Use 

For the posting of accruals/deferrals for contracts, you can specify whether or not the tax amount 

should be accrued/deferred in addition to the net amount. This is a common practice in some 

countries, such as Japan. 

Activities 

Set the Tax Accrual/Deferral Active indicator for the company codes, in which you want taxes to be 

accrued/deferred. 
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 Assign Accrual Type to Tax Code 

Use 

Here you assign an accrual type to each tax code. You need to make this setting if you want to post 

accruals or deferrals of tax amounts. 

Requirements 

You already defined accrual types. 

Activities 

Assign an accrual type to each tax type or tax group that is used in company codes where tax 

accrual/deferral is active. You can set up account determination for accrual types used for tax 

accrual/deferral so that the accrued or deferred tax amounts are posted directly to the tax account or to a 

tax clearing account. 

- Posting to a tax account: 

- If you want the accrual/deferral to be posted to a tax account, then enter any tax account for the 

accrual type (= account with tax category ">" (output tax) or "<" (input tax)). 

When the accrual/deferral posting is made, then the system automatically replaces this tax 

account with the account that results from the tax code of the cash flow item concerned. 

- If the accrual/deferral posting is made to a tax account, then the accrual documents show the 

tax data, and are included in the advance return for tax on sales/purchases. 

- Posting to a tax clearing account: 

- If the accrual/deferral posting is made to a tax clearing account, then enter the account you 

want to post to in the account determination for the accrual type. 

- The accruals/deferrals account and the tax clearing account have to have the same tax type. 

- If the tax type is not entered, then the accrual documents do not receive a tax code. 

- If the tax type is "+" or "-", then the accrual documents receive the tax code of the original 

flow. 

- Regardless of the tax type, when you post the accrual/deferral to a tax clearing account, the 

documents are not included in the advance return for taxes on sales/purchases. 
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 Implement Enhancements: Exclude Contracts ( BAdI ) 

Use 

Using this Business Add-In (BAdI), you can exclude the cash flow records of individual contracts from 

the accrual/deferral of net amounts or taxes. To do this, implement the 

IS_CONTRACT_ACR_RELEVANT method. 

SAP Note  makes it possible to use this Business Add-In to exclude individual cash flow records from the 

accrual/deferral of net amounts or taxes. To do this, implement the IS_CFITEM_ACR_RELEVANT 

method. 

The BAdI is called during accruals/deferrals (transaction RERAALCN) for each contract. 

Standard settings 

If you do not implement this BAdI then the accruals/deferrals are performed as follows: 

- The accrual/deferral of net amounts is made for all contracts provided that the used flow types of the 

cash flow are indicated as relevant for accrual/deferral. 

- The accrual/deferral of tax amounts is made for all contracts provided that the tax accrual/deferral 

has been activated in the company code and the used tax types and groups of the cash flow are 

designated as relevant for accrual/deferral. 

Activities 

Implement the IS_CONTRACT_ACR_RELEVANT method using transaction SE. 

The following parameters are used: 

- IO_CONTRACT: Reference to the contract that is currently being processed 

- ID_KEYDATE: Key date of accrual/deferral 

- ID_MODE: Mode of the posting run ('E': update run, 'S': Simulation) 

- CF_TAX_ACR_REL 

Change this indicator if you want to override the company code default setting for tax 

accruals/deferrals for the current contract. 

- CF_NET_ACR_REL 

This indicator should not be set if the contract is to be excluded from the accrual/deferral. This 

indicator is set in the standard system. 

Important: It is not possible to accrue only the taxes but not the net amounts. 

To exclude individual cash flow records from the accrual/deferral, implement the 

IS_CFITEM_ACR_RELEVANT method. 

You can use the following parameters: 
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- IO_CONTRACT: Reference to the contract that is currently being processed 

- ID_KEYDATE: Key date of accrual/deferral 

- ID_MODE: Mode of the posting run ('E': update run, 'S': Simulation) 

- IS_CASHFLOW_PAY: The cash flow record that is currently being processed from the partner-

related cash flow. If the cash flow record that is currently being processed is a record from the object 

cash flow, then this parameter is blank. 

- IS_CASHFLOW_OBJ: The cash flow record that is currently being processed from the object cash 

flow. If the cash flow record that is currently being processed is a record from the partner-related 

cash flow, then this parameter is blank. 

- CF_TAX_ACR_REL 

Change this indicator if you want to override the company code default setting for tax 

accruals/deferrals for the current cash flow record. 

- CF_NET_ACR_REL 

This indicator should not be set if the current cash flow record is to be excluded from the 

accrual/deferral. This indicator is set in the standard system. 

Important: It is not possible to accrue only the taxes but not the net amounts. 

In the standard system, accruals and deferrals that have begun for the cash flow records and that have the 

status "Actual" (CFSTATUS = I) are reversed during the next scheduled accrual/deferral run. In 

subsequent runs, they are not taken into account if the underlying 

contract or condition has expired. This logic can be altered with an implementation of method 

GET_BEHAVIOR_CONTEXT. 

You can use the following parameters: 

- IO_CONTRACT: Reference to the contract that is currently being processed 

- ID_KEYDATE: Key date of accrual/deferral 

- ID_MODE: Mode of the posting run ('E': update run, 'S': Simulation) 

- IS_CASHFLOW_PAY: The cash flow record that is currently being processed from the partner-

related cash flow. If the cash flow record that is currently being processed is a record from the object 

cash flow, then this parameter is blank. 

- IS_CASHFLOW_OBJ: The cash flow record that is currently being processed from the object cash 

flow. If the cash flow record that is currently being processed is a record from the partner-related 

cash flow, then this parameter is blank. 

- CF_REVERSAL_ON_ENDED_CONTRACT 

If you change this indicator to ABAP_FALSE, any accruals/deferrals that have begun are continued 

and new accrual/deferral records are created even if the contract has expired. 

- CF_REVERSAL_ON_ENDED_COND 

If you change this indicator to ABAP_FALSE, any accruals/deferrals that have begun are continued 

and new accrual/deferral records are created even if the underlying condition has expired ( explicitly 

). 
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- CF_CFSTATUS_RELEVANT_FOR_REV 

If you change this indicator to ABAP_FALSE, any accruals/deferrals that have begun are reversed 

regardless of the cash flow status (CFSTATUS) if the underlying contract or condition has expired. 

Implement method SET_ADDITIONAL_PARAM to save additional parameters for the deferral 

subobject (corresponds to a cash flow record). These parameters are stored in table ACEDSOP and can be 

accessed using function module ACEDSDB_PARAM_READ_SID_ALLDAT, for example. The 

following parameters are available: 

- IO_CONTRACT: Reference to the contract that is currently being processed 

- ID_KEYDATE: Key date of accrual/deferral 

- IS_CASHFLOW_PAY: The cash flow record that is currently being processed from the partner-

related cash flow. If the cash flow record that is currently being processed is a record from the object 

cash flow, then this parameter is blank. 
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IS_CASHFLOW_OBJ: The cash flow record that is currently being processed from the object cash 

flow. If the cash flow record that is currently being processed is a record from the partner-related 

cash flow, then this parameter is blank. 

- CT_PARAMETERS: Add the parameters that you want to save for the deferral subobject to this 

table. Caution: Do not use any parameter names (PARAM_NAME field) that are already used by 

SAP. These are TAXCODE, ALLOCATION, and OBJNR. 

Example 

For a contract type EXMP, no taxes should be accrued, regardless of the company code default setting. 

Therefore you determine the contract type for the current contract in the 

IS_CONTRACT_ACR_RELEVANT method. If the contract type is EXMP, you reset the indicator 

CF_TAX_ACR_REL. 

In addition, no planned records from the cash flow should be accrued/deferred for contract type 

EXP. Therefore, determine the contract type of the current contract in the 

IS_CFITEM_ACR_RELEVANT method. For contracts with contract type EXP and planned cash flow 

records, reset the indicators CF_NET_ACR_REL and CF_TAX_ACR_REL. 

Refer to the sample code (Goto -> Sample Code -> Display). 

Notes for Developers 

 Rent Invoice 

 Number Range for Rent Invoice 

Use 

Here you specify the number range interval to be used for the invoice number. 

Activities 

Define at least one number range interval for each company code in which invoices are printed, and for 

each fiscal year for which you want to print invoices. If this interval has the number , you do not need to 

make any number range settings in the IMG activity Company Code-Dependent Settings for Invoice. 

Choose Internal Number Assignment for all intervals. 

 Company-Code-Dependent Settings for Invoice 

Use 
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Here you can make settings for assigning the invoice number for each company code. 

Activities 

- If you want to number invoices that (per balance) contain a receivables amount differently than 

invoices containing (per balance) a credit amount, then edit the number range interval in the 

appropriate columns, SC Invoice or SC Credit. 

If you do not make an entry in these columns, the interval  is used. 

- Set the indicator No Update if the invoice number is not  to be updated in the FI document. See the 

notes in the documentation for updating the invoice number. 

 Implement Enhancements ( BAdI ) 

Use 

By implementing this Business Add-In you can influence the standard system procedure for creating rent 

invoices (transaction RERAIV) and for deleting rent invoices ( transaction RERAIVRV). The methods of 

the Business Add-In are automatically called for all active implementations at certain events during 

creation of invoices. 

To modify the correspondence for the invoices created (such as the layout), use the settings in 

Customizing for correspondence. 

Activities 

The following methods are available for the Creation of Rent Invoices and are executed by the system in 

this order during an invoicing run: 

- CHECK_IGNORE_CONTRACT 

You can exclude contracts that were selected based on the standard settings. To do so, set the return 

parameter CF_IGNORE = 'X'. To determine the contract data, call the 

API_RE_CN_GET_DETAIL function module within the BAdI implementation with the parameter 

IO_OBJECT = IO_CONTRACT. Number of calls: once for each selected contract. 

ADAPT_INVOICE_ITEM_LIST 
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Once the invoice items of a contract have been retrieved, you can modify the individual invoice 

items. To have certain items not invoiced, delete those entries in the internal table 

CT_INVOICE_ITEM. To change items (for example, their text), modify the entries in 

CT_INVOICE_ITEM accordingly. 

Number of calls: once for each partner with a vendor contract of each selected contract ( as long as 

invoice items could be determined). 

- GROUP_INVOICE_ITEM_LIST 

Once all invoice items for the whole invoicing run are determined, the system groups the items 

together based on either the invoice recipient or the contract (setting in the selection screen). 

Following this standard grouping of the items, you can make an additional, more specific grouping 

by entering a sequence number in the invoice number field (INVNO). This number is not the final 

invoice number. The system only uses it to recognize the start of a new invoice. 

Number of calls: once for the entire invoicing run. 

- GET_NUMBER (only in an update run, not for a simulation) 

In Customizing, you can specify which number range interval of the number range object 

RE_INVOICE should be used for invoices. You can use the same or a different number range 

interval for credit memos. If you want to use a different procedure, or want to used your own 

number range object, then return the new invoice number to be used in the CD_INVNO parameter. 

The invoice number has to be unique for the company code and fiscal year. 

Number of calls: once for each invoice created. 

- AFTER_STORE (only in an update run, not for a simulation) 

In Customizing, you can specify if the system should update the invoice number in the XREF field 

of the FI document. If you want to update other information in addition to that, then you can 

perform the needed change operations in this method. However, do not perform COMMIT WORK or 

ROLLBACK WORK, since these controls are the responsibility of the standard program. 

Number of calls: once for each invoice created. 

- GET_FISC_YEAR (only in an update run, not for a simulation) 

In the standard system, the system determines the fiscal year of an invoice based on the company 

code and the current date. If you want to use a different approach instead, then return the fiscal year 

to be used in the parameter CD_FISC_YEAR. The method makes available the importing 

parameters IS_INVOICE (RE invoice header) and 

IT_INVOICE_ITEM (table of RE invoice items). Number of 

calls: once for each invoice created. 

In the IS_OPTIONS parameter, the selection parameters from the selection screen are available to you in 

these methods: CHECK_IGNORE_CONTRACT, ADAPT_INVOICE_ITEM_LIST and 

GROUP_INVOICE_ITEM_LIST. 

The following method is available for Reversal of Rent Invoices: 

- GET_BEHAVIOR_CONTEXT 
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Returns the behavior context of the invoice 

You can exclude invoices selected in the standard way from reversal by setting the return parameter 

CF_IGNORE = 'X'. The method makes available the importing parameters IS_INVOICE (RE 

invoice header) and IT_INVOICE_ITEM (table of RE invoice items). Number of calls: once for 

each invoice to be reversed. 

Note that when implementing the BAdI you are not allowed to use statements that affect the 

interface, such as direct output of messages using MESSAGE. Notes for Developers 

 Cash Management and Forecast 

 Cash Management and Forecast and RE-FX 

Use 

You have to make settings in the following IMG activities if you want to be able to see receivables and 

payables generated by contracts in RE-FX displayed in cash management and forecast (in the liquidity 

forecast). 

Activities 

Specify the following: 

- For which company codes should cash management and forecast be active in RE-FX? 

- Which flow types should be considered in cash management? 

- Which source symbols should planning levels receive in RE-FX? We recommend using source 

symbol REM for RE-FX. 

- Which planning levels should be used in RE-FX? 

- Which planning groups should there be for these levels? 

- Which contract types should use which planning levels? 

The following prerequisites have to be met in order for the cash management data of a contract to be 

updated: 
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- The Cash Management indicator must be active for the company code that the contract belongs to. 

The contract must have at least one condition that is assigned to a flow type, for which cash 

management update is active. 

- A planning level must be assigned to the contract type. 

- The partner (customer/vendor) must be assigned to a planning group. 

 Activate Cash Management and Forecast for RE-FX in Company Code 

Use 

For each company code, you can decide if the contract data for cash management and forecast should be 

updated in the company code. 

Standard settings 

In the standard system, the Activate CM indicator is not set for the standard company codes. 

Activities 

Set the indicator for those company codes where you want to use Flexible Real Estate Management (RE-

FX) with cash management and forecast. If you set this indicator later when your system is already live, 

then you have to recreate the necessary cash management data in the company codes affected. In that 

case, use the IMG activity Prepare Production Startup and Data Setup. 

 Activate Cash Management for Flow Types 

Use 

For each flow type, you can decide if the cash flow data for this flow type should be updated in cash 

management and forecast. 

Standard settings 

In standard Customizing, the Relevant to CM indicator is set for all standard flow types. If the Activate 

CM indicator is set for the company code, then all flow records in the cash flow are updated in cash 

management and forecast. 
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Activities 

Set the Relevant to CM indicator for the flow types that you want to update to cash management and 

forecast. Keep in mind that only those cash flow records that are considered during periodic posting can 

be updated to cash management and forecast. For example, you do not need to set the indicator for flow 

types that are used for posting receivables or credit memos resulting from service charge settlement or 

sales-based settlement. On the other hand, it does not cause problems if this indicator is set for those flow 

types. 

If this indicator is set, you should distinguish between receivables from advance payments and real 

receivables (such as, basic rent). 

If you summarize flow types, then always set this indicator both for the original flow type and the 

summarized flow type. Make sure that the indicator is set uniformly for all flow types that are 

summarized on the same flow type. 

If you set or deselect the indicator when your system is already live, then you have to have the system 

regenerate the cash management data in all company codes in which cash management and forecast is 

active. To do so, use the Reorganize Cash Management IMG activity. 

 Basic Settings for Liquidity Forecast 

 Define Source Symbols 

In this step you define source symbols and allocate them either to the liquidity forecast or to the cash 

position. 

The source symbol divides the planning levels according to the sources that supply them with data, for 

example: 

- Bank accounting 

- Subledger accounting 

- Materials management 

- Sales and distribution 

Actions 

1. Create a symbol for data from bank-related accounting. 

2. Create a symbol for data from subledger accounting. 
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3. Create a symbol for data from Materials Management and a symbol for data from Sales and 

Distribution. 

4. Select the "CM posit." field for bank data in order to assign this data to the cash position. 
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Do not select this field for the other sources, since they supply the liquidity forecast with data. 

Standard settings 

For RE, the source level REM (Real Estate Management) is used in standard Customizing. 

 Define Planning Levels 

In this step, you specify a planning level for each cash account and allocate this planning level to the cash 

position by using the appropriate source symbol. 

Financial transactions in Cash Management are displayed using planning levels in order to explain 

beginning and ending account balances. 

In the standard R/ System, levels starting with "F" or "B" are reserved for automatically updating data during 

posting so that you can easily analyze the cash position.  Manually created payment advice notes or planned 

items, however, are allocated to different levels. 

Recommendation 

SAP recommends using the following levels: 

- Level F for bank accounts 

- Level F for customers and vendors 

- Levels B to Bn for bank clearing accounts 

- Level CP, for example, for confirmed payment advice notes 

- Level UP, for example, for unconfirmed payment advice notes 

- Level NI, for example, for noted items 

When displaying the cash position, you can then see because of level F that the amounts are posted to bank 

accounts.  The other levels reflect planned bank account transactions, which include postings to bank 

clearing accounts or entered payment advice notes. Therefore, you can use the display to compare planned 

data with actual data. 

Actions 

Check the standard planning levels and change them if necessary. 

Standard settings 
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Real Estate Management 

In standard Customizing, planning levels RC (for customer contracts) and RV (for vendor contracts) are 

assigned to the source symbol REM (Real Estate Management). 

 Define and Assign Planning Groups 

 Define Planning Groups 

In this step, you define the planning groups for customers and vendors. A planning group represents 

particular characteristics, behaviors or risks of the customer or vendor group. Therefore, you can break 

down incoming and outgoing payments according to the amount, the probability of the cash inflow or 

outflow, and the type of business relationship. 

Example 

- O      Domestic vendors 

- O      Foreign vendors 

- O      Affiliated companies: vendors 

- O      Major suppliers 

- I      Bank collection: customers 

- I      Domestic customers 

- I      Foreign customers 

- I      Risk customers 

You assign customers and vendors to a planning group by making a entry in the master record. 

In addition, you allocate your planning groups to a planning level. 

Actions 

1. Create planning groups according to your requirements. 

2. Allocate the planning groups to a planning level you have created for your subledger accounts. 

Standard settings 

The assignment of planning groups to partners is company-code-dependent. For example, in standard 

Customizing, E is used for tenants. If you have the business partner with customer account created 
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automatically from RE, you can specify ( in this IMG activity) which planning group this partner receives, 

dependent on the company code. 

The group that the level is assigned to becomes significant when a planned record is generated by periodic 

posting. Assign a level here that is normally used for receivables in Financial Accounting (for example 

level F) found in standard Customizing). 

 Standard Values for Autom. Creation of Customers 

( Company-Code-Dependent ) 

Use 

In this section you make presettings for creating company code-dependent customer data. These presettings 

are used when you process a business partner in the customer role of the respective company code for the 

first time and you access the processing screen in contract management. 

   @AH@The only product type (PTyp) relevant for Real Estate is IMV. 

Activities 

- If the company code you wish to process is not included in the list, create the required presettings 

with the 'New Settings'' function. Otherwise choose the company code you wish to process. 

 Assign Planning Levels to Contract Type 

Use 

You assign planning levels to contract types here. These planning levels are used for updating the planned 

records of the cash flow to cash management and forecast. 

Assigning a planning level is required before cash management data can be updated. 

Requirements 

The planning levels must have been created already and assigned to the appropriate source symbol. 

Standard settings 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 217 

In the standard system, these two planning levels are defined for RE-FX: 

- RC is assigned to all customer contact types. 

- RV is assigned to all vendor contract types. 

Activities 

Assign planning levels to those contract types for which you want cash management data to be updated. 

The system displays the source of the planning level. We recommend that you only create one planning 

level source for RE-FX. If you follow this recommendation, then the source displayed here for all contract 

types having a level assigned to them should be the same. 

Never assign a planning level here that is used by another application (has a different source). Otherwise, it 

is not possible to regenerate the cash management records solely for RE-FX. 

In the table, you can also change the time period for which the cash flow can be updated in advance. 

This is exactly the same time period for which the cash management data is generated. 

If you change, specify, or remove a planning level assigned to a contract type later when your system is 

already live, then you have to have the system regenerate the cash management data in all company codes 

in which cash management and forecast is active. To do so, use the Reorganize Cash Management IMG 

activity. 

Balance-Sheet Valuation of Contracts 

 Balance Sheet Valuation: Overview 

Use 

The functions for the balance sheet valuation of real estate contracts and leases allow you to show 

contracts in the balance sheet according to different accounting principles (such as IFRS, 

US GAAP, HGB). 

Requirements 

1. Activate the  subfunction CE. 

2. Set up contract dialog 

To enable balance sheet valuation, two tabs are provided in the contract. These contain: 

- Valuation rules 

- Results of the valuation with the valuation cash flow 

The tabs for valuation can be shown in the screen sequence for transaction RECN for those contract 

types for which the balance sheet valuation is relevant. The screen sequence used for transaction 

RECN is defined in the Customizing settings for the contract type. For an alternative screen 
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sequence for the contract, you can use transaction RECECN. The screen sequence that is used in 

this transaction can be found in the Customizing settings for Valuation-Specific Attributes for 

Contract Type in Company Code. 

The use of different screen sequences allows you to control access to the contract data by the 

respective users responsible. For example, you could use transaction RECECN to maintain the 

valuation data, while operative contract management uses transaction RECN, where the valuation 

data may be hidden. 

The respective screen sequence used is to be enhanced with the valuation parameters and the 

valuation (views REGC and REGC, subscreens SAPLREGC  and  , sections REGC and REGC, 

screens REGC and REGC). After changing the screen sequences, start transaction BUSP for 

application object REGC and generate all screens. Note that the valuation for contracts with 

contract category  (= Internal Contract) is not supported. 

. Enhance authorizations 

Note the explanations for the authorization objects F_RECE_*. Configure the authorizations for your 

users accordingly. 

Financial accounting 

Parallel accounting 

The balance sheet valuation of real estate contracts and leases allows parallel valuations and postings for 

different accounting principles. While the periodic posting RERAPP always posts to all ledgers, the 

valuation posting RECEEP can post on an accounting-specific basis. You control at valuation rule level 

which accounting principle is used. 

If you are using the ledger solution, you need to make the assignment to the accounting principle in the 

valuation rule. 

If you are using the account solution, you need to control account determination for the individual 

valuation rules in such a way that the posting is made to the correct accounts assigned to the respective 

balance sheet variant. In the valuation rule, you need to assign the relevant depreciation area to asset 

accounting on a company-code-specific basis in this case. 

Account determination 

Account determination for postings of the balance sheet valuation is carried out based on the flow types 

in the valuation rule. Similar to account determination for the periodic posting, you configure the 

account symbols that are used to define posting records (Assign Account Symbol to Flow Type). 

Finally, you specify which accounts replace the account symbols. Postings that affect assets are 

controlled using asset transaction types. These are derived from the flow type stored in the valuation 

rule: Assign Asset Transaction Types. 

Posting real estate contracts and leases to the balance sheet 

According to the rules of IFRS  and FASB , tenants and lessees must show their contracts in the balance 

sheet. The possession dates for the contract object must be shown as right-of-use (RoU) to which a 

leasing liability relates. 

- Initial posting after receipt of contract RoU 

asset to leasing liabilities 

- Postings at period-end closing 
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Leasing interest expense to leasing liabilities 

Leasing liabilities to allocation of rental payments 

Expense from depreciation to RoU asset 

Posting without asset accounting 

If you do not want to use asset accounting, you can post directly to balance sheet accounts as an 

alternative. You can specify whether you want to post to asset accounting or post directly to general 

ledger accounts by defining the integration type in Customizing under Valuation-Specific Attributes for 

Contract Type in Company Code or in the valuation rule. 

Changing account determination for periodic posting 

In the periodic posting (transaction RERAPP), the payment-relevant postings are carried out based on the 

partner-related cash flow. In the case of vendor contracts, the posting: 

Costs of rent/leasing to vendor 

To ensure consistency when valuation is active, the posting of the rent/leasing rate in RERAPP has to be 

redirected from the costs of rent/leasing account to the allocation of rental payments account as soon as 

the valuation is active. To do this, you need to enter the allocation of rental payments account under 

Replace Account Symbols in the Account Valuation field. 

Controlling 

If balance sheet valuation is not active, costs that are assigned to the contract after the partner-related 

cash flow has been posted are transfer posted to the originating objects during the periodic posting 

RERAPP based on the object cash flow. 

Costs of rent/leasing (object) to costs of rent/leasing ( contract ) 

This function of this transfer posting is replaced by the valuation postings. Costs on the controlling 

objects arise if the leading ledger (such as IFRS US GAAP) capitalizes a RoU no longer during the 

periodic posting but through posting of depreciation and interest. This normally leads to a different cost 

distribution over the term of the contract. 

Omission of object cash flow 

The valuation postings replace the function of the postings from the object cash flow. Therefore, the 

object cash flow ends when the valuation starts. 

Note: 

If you are using customer-specific applications in conjunction with the object cash flow, you need to 

modify these. 

Asset accounting 

Asset classes 

According to the accounting principles IFRS and US GAAP, RoU assets are to be managed separately from 

other fixed assets. You therefore need to set up corresponding asset classes. 
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Valuation postings to assets are managed using asset accounting. For example, since in the case of 

acquisition postings, a leasing liabilities account is posted to as the offsetting account, unlike with other 

asset classes for which a clearing account is posted to as the offsetting account, you need to set up separate 

account determination for your leasing assets so that you can assign separate general ledger accounts. 

Asset transaction types 

When classic asset accounting is used, accounting-specific postings to the RoU asset need to be assigned to 

the asset depreciation areas that represent the respective accounting principle. The assignment is made using 

asset transaction types, which are limited to the specific depreciation areas. These asset transaction types are 

derived from the flow type stored in the valuation rule: Assign Asset Transaction Types. 

Depreciation key 

During the depreciation run, the depreciation calculated in the real estate contracts and leases is read from 

the contract valuations by means of a special depreciation key. You create the depreciation key as follows: 

- Transaction AFAMR: Check whether the LERE base method exists. If it exists, use it. Otherwise, 

create a base method with the text Normal: Depreciation from Real Estate 

Leasing. The method is ordinary depreciation and uses the depreciation method B Depreciation 

from Real Estate Leasing. All other indicators are set to No. Save and activate the method. 

- Transaction AFAMS: Create a new multilevel method (such as ZLE) Leasing from Real Estate with 

the validity From ordinary depreciation start date. The multilevel method has only one level with 

acquisition year  and a validity of  years. The base value is  - External Base Value from Real Estate 

Leasing. Save and activate the method. 

- Create the new depreciation key by using transaction AFAMS: Depreciation from Real Estate 

Leasing (such as ZLEA). The key has exactly one phase for ordinary depreciation with the base 

method and multilevel method described above. As the period control method, you can use a 

standard method (depending on what is required, , for example). For multiple shift, scrap value, and 

shutdown, you should set No effect, Cutoff value is ignored or No. Save and activate the key. 

- Assign this key to the asset classes that you want to use for the RoU assets: Enter Default Values in 

Asset Classes. 

 Control Settings for Each Contract Type in Company Code 

Use 

In this dialog, you make specific settings for the balance sheet valuation for each contract type. For more 

details, see the field documentation. 
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 Valuation Relevance 

Use 

Enter the reasons here why balance sheet valuation is carried out for a contract or the contract is not 

valuation relevant. 

 Valuation Rule 

Use 

Rental and lease contracts can be valuated according to different accounting principles. The accounting 

principles contain different rules regarding the way contracts are represented in accounting, and how the 

various contract conditions (periodic payments, one-time payments, service costs) are included in the 

valuation. 

Multiple valuation rules are possible for each accounting principle. The valuation rules determine how the 

valuation for the respective accounting principle is calculated and to which ledgers or accounts the postings 

are made. 

- Define how you want to model your valuation rules. 

- Specify for which contract types the valuation rules are relevant. 

- Define the company code in which valuation rules are to be applied. 

Valuation Rule Parameters 

The central parameter of the valuation rule is the valuation type. It determines the algorithm based on 

which the cash flow is calculated for the valuation and thus also which other parameters are needed, 

particularly for account determination. 

You can use the condition valuation group to specify which contract conditions are to be used in the 

calculation. 

Account Determination 

IFRS and US-GAAP (Valuation Type: Balance-Sheet Capitalization) 

Lease contracts must be capitalized as right-of-use assets according to the rules of IFRS and US-GAAP. 

You need flow types for the acquisition posting, the depreciation of the asset, the interest paid posting, and 

the posting of the payment. Please note that reference flow types must be created for each of the flow 
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types, as described in the field documentation. If percentage shares of conditions (such as service shares) 

are to be linearized, you also require a flow type for the linearization posting. 

To be able to distinguish between US-GAAP contracts with classification type finance lease and operating 

lease in the valuation, you require different valuation rules. 

Linearization (Straightlining, Valuation Type: Linearization) 

Specify a flow type for the linearization posting. Please note that the reference flow types are also needed 

here. 

Use different valuation rules and valuation types for vendor and customer contracts. 

HGB (Valuation Type: Transfer Posting) 

The flow type for the transfer posting of costs according to HGB is analogous to the distribution posting 

using the reference flow type for distribution postings (). 

Requirements 

Create the required flow types and configure the associated account determination. 

Example 

You prepare balance sheets according to IFRS and US GAAP in company code  and only according to 

IRFS and German HGB in company code . Both company codes have concluded tenant rental agreements. 

Lease-outs (operating lease) are carried out in company code  only. 

In this case, it is appropriate to create the following valuation rules: 

- For vendor rental contracts ( lease-in ): 

- IFRS for valuation according to international leasing standard IFRS  

- FASB FL for valuation according to US GAAP as finance lease  

- FASB OL for valuation according to US GAAP as operating lease - HGB K for valuation of 

vendor contracts according to German Commercial Code. 

- For customer rental contracts ( lease-out ): 

- FASB for linearization of revenue from lease-outs (operating lease) 

- HGB D for valuation of customer contracts according to German Commercial Code 

For valuation rules IFRS and FASB, specify the accounting principle that you use for IFRS, for FASB FL 

and FASB OL the accounting principle for US GAAP, for HGB K and HGB D the accounting principle 

for German HGB. 

The valuation rules IFRS, FASB FL, and FASB OL are used in company code  , the valuation rules IFRS, 

FASB, HGB D, and HGB K in company code . 
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The valuation rules IFRS, FASB FL, FASB OL, and HGB K must be assigned the relevant vendor contract 

types (lease-in), the valuation rules FASB and HGB D the customer contract types ( lease-out ). 

Note: 

Linearization of conditions not to be activated (such as service conditions or service shares included in 

rent or lease payments) according to FASB is possible within IFRS and US-GAAP valuation rules and 

therefore does not need to be modeled by an additional FASB valuation rule for vendor contracts. 

 Condition Valuation Groups 

Use 

Contract conditions are included in the valuation in different ways. To control this, you create condition 

valuation groups and assign condition types to them. Using the assignment to the valuation rules, you define 

how the conditions are used in the calculations for the respective valuation. 

Tip: Use statistical conditions 

Contract conditions are typically conditions that model rent, lease payments, or one-time payments and 

are posted during the periodic posting. For proper valuation, these actual rents are not always sufficient. 

Therefore, you should also use statistical conditions in certain cases. 

Examples: 

- In conjunction with the contract origination, payments have already been made in advance (for 

example, to brokers), which means that initial costs have been incurred. These have already been 

posted elsewhere and so must not be posted again. However, they must flow into the present value of 

the RoU asset. In this case, you can use a one-time statistical condition that represents the initial costs. 

- The contract contains multiple contract objects, but there is only one payment condition. However, the 

valuation must be carried out for each contract object. In this case, a proper estimate must be made 

regarding what share of the payment condition is to be assigned to which contract object. The result of 

this estimate can be defined as a statistical condition with reference to the relevant contract object in 

the contract. This statistical condition can then be used as a basis for the valuation for each contract 

object. 

 Asset Classes for Object Types 

Use 
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Specify in which asset class the right-of-use asset is to be created for the leased object. 

 Assign Asset Transaction Types 

Use 

To the RE flow types for the individual contracts, assign the corresponding asset transaction types that 

you want to use for posting to the RoU assets. 

 Enhancements (BAdI) Contract Valuation 

Use 

The following Business Add-Ins (BAdIs) support enhancements to the standard functions for contract 

valuation: 

- BADI_RECE_EVALUATION 

Used to influence general functions. 

- BADI_RECE_EVALUATION_RULE 

Used to influence functions in the context of the valuation rule. 

- BADI_RECE_EVALUATION_PROCESS 

Used to influence functions in the context of the valuation process. 

- BADI_RECE_ASSET_ACCOUNTING 

Used to influence functions in the context of asset integration. 

For more information about enhancements, see: 

- Overview of Enhancement Methods for Master Data Objects and the Real Estate Contract 

- Overview of the Programming Interfaces for RE-FX 

- Information on using BAdIs 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 
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Note that the implementation of the methods has to be independent of the interface and must not contain 

any COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages 

using the MESSAGE statement is not allowed. 

Methods and their parameters 

- BADI_RECE_EVALUATION 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation 

IO_CONTRACT, IS_EVALUATION_RULE, ID_CETYPE, and ID_CERULE 

These parameters can be used for the results analysis. 

CF_PROBABLEEND_ALLOWED 

This allows the Probable End to be entered for the transfer posting valuation type also. 

Otherwise, for unlimited contracts, the system proceeds in the same way as for the partner-

related cash flow with regard to the generation period. 

CD_INTEGRATION_TYPE 

This can be used to influence the Integration Type. 

CF_EXIT_PROCESSED 

The GET_BEHAVIOR_CONTEXT method is called from different places. Only certain 

parameters are of interest here.  Therefore, implementation must always be context based (for 

performance reasons also). To influence the integration type, for example, perform the 

implementation as follows: 

  CF_EXIT_PROCESSED = ABAP_FALSE. 

  IF CD_INTEGRATION_TYPE IS REQUESTED. 

* influence it 

    CD_INTEGRATION_TYPE = ... 

* done! 

    CF_EXIT_PROCESSED = ABAP_TRUE.   ENDIF. 

- GET_ACCOUNT_DETERMINATION_KEY - Returns the account determination value 

IO_CONTRACT, IS_EVALUATION_RULE, ID_CERULE, ID_CFTYPE, 

ID_TERMNO, and ID_KEYDATE 

These parameters can be used for the results analysis. 

CD_ACCDETKEY 

This can be used to influence account determination. 

- BADI_RECE_EVALUATION_RULE 

- COMPLETE_DEFAULTS - Prefill valuation rule data IO_CONTRACT 

This parameter can be used for the results analysis. 

CS_EVALUATION_RULE 

Valuation rule data, which can be changed. 

- COMPLETE_DEFAULTS_CONDITION - Prefill data for condition-specific valuation rule 

IO_CONTRACT, IS_EVALUATION_RULE, and IS_CONDITION 

These parameters can be used for the results analysis. 
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CS_EVALUATION_COND_RULE 

Data for condition-specific valuation rule, which can be changed. 

- CHANGE_STATUSREASON - Change status reason 

IO_CONTRACT, IS_EVALUATION_RULE, and IS_EVALUATION_RULE_OLD 

These parameters can be used for the results analysis. 

CD_STATUSREASON 

Status reason. 

- CHANGE_EVAL_RULE_FOR_INSERT - Changes possible valuation rules for insertion 

IO_CONTRACT 

This parameter can be used for the results analysis. 

CT_CERULE 

Possible valuation rules for insertion. 

- CHECK_RULE - Additional checks for valuation rule IO_CONTRACT 

This parameter can be used for the results analysis. 

IF_CHECK_ALL 

If this parameter is set, the standard check logic is used (error messages prevent a contract from 

being saved). In other cases, the check is called by the execution of the valuation. Therefore, an 

additional message can be sent as a warning during contract maintenance and as an error 

during execution of the valuation, whereby the execution is prevented. 

IS_EVALUATION_RULE 

Valuation rule data. 

CT_MESSAGE 

List of additional messages. 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation IO_CONTRACT 

This parameter can be used for the results analysis. 

CF_EXIT_PROCESSED 

See above. 

CD_MSGTYPE_USEFULLIFEEND 

The message type of the messages RECETM, , and  can hereby be overridden for the check of 

the end of usage RoU. By default, none of these messages are sent. 

- CHANGE_COND_PROPERTY - Changes possible condition valuation property 

IO_CONTRACT 

This parameter can be used for the results analysis. 

IS_EVALUATION_RULE 

Valuation rule data. 

IS_EVALUATION_COND_RULE 

Condition-specific data of valuation rule. 

CT_CONDITION_PROP 

List of condition properties 

- BADI_RECE_EVALUATION_PROCESS 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation 

IO_CONTRACT and IS_EVALUATION_RULE 
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These parameters can be used for the results analysis. 

CF_REMAINING_CAPITAL_INCR_NPV 

If this parameter is set to ABAP_FALSE, the remaining capital (resulting from the present value 

determination) is not added to the present value. 

CF_COMPOUNDED_INTEREST 

When this parameter is set to ABAP_FALSE, compound interest is not calculated. 

CD_KEEP_STEP_EVALUATION 

This parameter applies only to the following valuation types: linearization and transfer posting. 

It specifies the maximum number of steps (number of valuations) to be kept to provide 

transparency of valuations for each valuation rule. The value  is used by default. Furthermore, 

an initial value is treated like a . If the maximum number is exceeded in a subsequent 

valuation, the first step is discarded. The second step becomes the first step, and so on. In 

special cases where the "First Posting From" date has been used in an initial valuation (two 

steps are generated in the initial valuation), the maximum number is corrected to  (provided a 

smaller number has been returned after all implementations have been run). In this case, 

replacement starts only from the third step. 

Note: If the number of existing steps is greater than the maximum number of steps, the existing 

number of steps is kept (in this case, the maximum number of steps is corrected upward to the 

number of existing steps). 

CF_PROCESS_EXECUTION_ALLOWED 

When this parameter is set to ABAP_FALSE, execution of the valuation can be prevented 

(parameter IS_EVALUATION_RULE is not filled in this case). In this way, for example, you 

can use an implementation to prevent a valuation from being executed for inactive contracts 

(simulation cannot be prevented). 

CF_EXIT_PROCESSED 

See above. 

- EVALUATION - Performs contract valuation 

IO_CONTRACT, ID_EVALUATION_POINT, ID_PROCESSMODE, IT_VICERULE, 

IT_VICECONDRULE, IT_VICEPROCESS, and IT_VICECFRULE_PREVIOUS 

These parameters can be used for the results analysis. 

CT_VICECFRULE 

Valuation cash flow. 

CS_PROCESS 

Valuation process. 

CS_PROCESS_ADDITIONAL 

Additional valuation process. 

CT_MESSAGE 

Additional valuation messages. 

CF_EXIT_PROCESSED 

See above. 

Note that the EVALUATION method is currently not fully integrated into the valuation 

process and therefore can only be used to a limited extent. If you need to manipulate the 

results, please create a customer message with a detailed description. As a result, integration 

of the method will be completed step by step. 

- BADI_RECE_ASSET_ACCOUNTING 
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- GET_BEHAVIOR_CONTEXT - Returns the behavior context for asset integration 

IO_CONTRACT and IS_EVALUATION_RULE 

These parameters can be used for the results analysis. 

CF_MESSAGE_DEPRECIATION 

When this parameter is set to ABAP_TRUE, messages are displayed during execution of asset 

accounting functions (that use the depreciation calculation of the valuation functions) to 

indicate that: valuation rules are incomplete or valuations are still open. In this way, for 

example, a depreciation run can be prevented if valuations are still open. 

CD_MESSAGE_DEPRECIATION_TYPE 

You can specify the type of message here. E, W, and I are permitted. Note that the message type 

has no significance in the Asset Explorer, where a message of type I is always sent (provided that 

CF_MESSAGE_DEPRECIATION was set). 

 Enhancements (BAdI) Contract Valuation - Valuation Rule 

Use 

The following Business Add-Ins (BAdIs) support enhancements to the standard functions for contract 

valuation: 

- BADI_RECE_EVALUATION 

Used to influence general functions. 

- BADI_RECE_EVALUATION_RULE 

Used to influence functions in the context of the valuation rule. 

- BADI_RECE_EVALUATION_PROCESS 

Used to influence functions in the context of the valuation process. 

- BADI_RECE_ASSET_ACCOUNTING 

Used to influence functions in the context of asset integration. 

For more information about enhancements, see: 

- Overview of Enhancement Methods for Master Data Objects and the Real Estate Contract 

- Overview of the Programming Interfaces for RE-FX 

- Information on using BAdIs 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

Note that the implementation of the methods has to be independent of the interface and must not contain 

any COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages 

using the MESSAGE statement is not allowed. 
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Methods and their parameters 

- BADI_RECE_EVALUATION 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation 

IO_CONTRACT, IS_EVALUATION_RULE, ID_CETYPE, and ID_CERULE 

These parameters can be used for the results analysis. 

CF_PROBABLEEND_ALLOWED 

This allows the Probable End to be entered for the transfer posting valuation type also. 

Otherwise, for unlimited contracts, the system proceeds in the same way as for the partner-

related cash flow with regard to the generation period. 

CD_INTEGRATION_TYPE 

This can be used to influence the Integration Type. 

CF_EXIT_PROCESSED 

The GET_BEHAVIOR_CONTEXT method is called from different places. Only certain 

parameters are of interest here.  Therefore, implementation must always be context based (for 

performance reasons also). To influence the integration type, for example, perform the 

implementation as follows: 

  CF_EXIT_PROCESSED = ABAP_FALSE. 

  IF CD_INTEGRATION_TYPE IS REQUESTED. 

* influence it 

    CD_INTEGRATION_TYPE = ... 

* done! 

    CF_EXIT_PROCESSED = ABAP_TRUE.   ENDIF. 

- GET_ACCOUNT_DETERMINATION_KEY - Returns the account determination value 

IO_CONTRACT, IS_EVALUATION_RULE, ID_CERULE, ID_CFTYPE, 

ID_TERMNO, and ID_KEYDATE 

These parameters can be used for the results analysis. 

CD_ACCDETKEY 

This can be used to influence account determination. 

- BADI_RECE_EVALUATION_RULE 

- COMPLETE_DEFAULTS - Prefill valuation rule data IO_CONTRACT 

This parameter can be used for the results analysis. 

CS_EVALUATION_RULE 

Valuation rule data, which can be changed. 

- COMPLETE_DEFAULTS_CONDITION - Prefill data for condition-specific valuation rule 

IO_CONTRACT, IS_EVALUATION_RULE, and IS_CONDITION 

These parameters can be used for the results analysis. 

CS_EVALUATION_COND_RULE 

Data for condition-specific valuation rule, which can be changed. 

- CHANGE_STATUSREASON - Change status reason 

IO_CONTRACT, IS_EVALUATION_RULE, and IS_EVALUATION_RULE_OLD 
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These parameters can be used for the results analysis. 

CD_STATUSREASON 

Status reason. 

- CHANGE_EVAL_RULE_FOR_INSERT - Changes possible valuation rules for insertion 

IO_CONTRACT 

This parameter can be used for the results analysis. 

CT_CERULE 

Possible valuation rules for insertion. 

- CHECK_RULE - Additional checks for valuation rule IO_CONTRACT 

This parameter can be used for the results analysis. 

IF_CHECK_ALL 

If this parameter is set, the standard check logic is used (error messages prevent a contract from 

being saved). In other cases, the check is called by the execution of the valuation. Therefore, an 

additional message can be sent as a warning during contract maintenance and as an error 

during execution of the valuation, whereby the execution is prevented. 

IS_EVALUATION_RULE 

Valuation rule data. 

CT_MESSAGE 

List of additional messages. 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation IO_CONTRACT 

This parameter can be used for the results analysis. 

CF_EXIT_PROCESSED 

See above. 

CD_MSGTYPE_USEFULLIFEEND 

The message type of the messages RECETM, , and  can hereby be overridden for the check of 

the end of usage RoU. By default, none of these messages are sent. 

- CHANGE_COND_PROPERTY - Changes possible condition valuation property 

IO_CONTRACT 

This parameter can be used for the results analysis. 

IS_EVALUATION_RULE 

Valuation rule data. 

IS_EVALUATION_COND_RULE 

Condition-specific data of valuation rule. 

CT_CONDITION_PROP 

List of condition properties 

- BADI_RECE_EVALUATION_PROCESS 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation 

IO_CONTRACT and IS_EVALUATION_RULE 

These parameters can be used for the results analysis. 

CF_REMAINING_CAPITAL_INCR_NPV 

If this parameter is set to ABAP_FALSE, the remaining capital (resulting from the present value 

determination) is not added to the present value. 
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CF_COMPOUNDED_INTEREST 

When this parameter is set to ABAP_FALSE, compound interest is not calculated. 

CD_KEEP_STEP_EVALUATION 

This parameter applies only to the following valuation types: linearization and transfer posting. 

It specifies the maximum number of steps (number of valuations) to be kept to provide 

transparency of valuations for each valuation rule. The value  is used by default. Furthermore, 

an initial value is treated like a . If the maximum number is exceeded in a subsequent 

valuation, the first step is discarded. The second step becomes the first step, and so on. In 

special cases where the "First Posting From" date has been used in an initial valuation (two 

steps are generated in the initial valuation), the maximum number is corrected to  (provided a 

smaller number has been returned after all implementations have been run). In this case, 

replacement starts only from the third step. 

Note: If the number of existing steps is greater than the maximum number of steps, 

the existing number of steps is kept (in this case, the maximum number of steps is corrected 

upward to the number of existing steps). 

CF_PROCESS_EXECUTION_ALLOWED 

When this parameter is set to ABAP_FALSE, execution of the valuation can be prevented 

(parameter IS_EVALUATION_RULE is not filled in this case). In this way, for example, you 

can use an implementation to prevent a valuation from being executed for inactive contracts 

(simulation cannot be prevented). 

CF_EXIT_PROCESSED 

See above. 

- EVALUATION - Performs contract valuation 

IO_CONTRACT, ID_EVALUATION_POINT, ID_PROCESSMODE, IT_VICERULE, 

IT_VICECONDRULE, IT_VICEPROCESS, and IT_VICECFRULE_PREVIOUS 

These parameters can be used for the results analysis. 

CT_VICECFRULE 

Valuation cash flow. 

CS_PROCESS 

Valuation process. 

CS_PROCESS_ADDITIONAL 

Additional valuation process. 

CT_MESSAGE 

Additional valuation messages. 

CF_EXIT_PROCESSED 

See above. 

Note that the EVALUATION method is currently not fully integrated into the valuation 

process and therefore can only be used to a limited extent. If you need to manipulate the 

results, please create a customer message with a detailed description. As a result, integration 

of the method will be completed step by step. 

- BADI_RECE_ASSET_ACCOUNTING 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for asset integration 

IO_CONTRACT and IS_EVALUATION_RULE 

These parameters can be used for the results analysis. 

CF_MESSAGE_DEPRECIATION 
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When this parameter is set to ABAP_TRUE, messages are displayed during execution of asset 

accounting functions (that use the depreciation calculation of the valuation functions) to 

indicate that: valuation rules are incomplete or valuations are still open. In this way, for 

example, a depreciation run can be prevented if valuations are still open. 

CD_MESSAGE_DEPRECIATION_TYPE 

You can specify the type of message here. E, W, and I are permitted. Note that the message type 

has no significance in the Asset Explorer, where a message of type I is always sent (provided that 

CF_MESSAGE_DEPRECIATION was set). 

 Enhancements (BAdI) Contract Valuation - Valuation Process 

Use 

The following Business Add-Ins (BAdIs) support enhancements to the standard functions for contract 

valuation: 

- BADI_RECE_EVALUATION 

Used to influence general functions. 

- BADI_RECE_EVALUATION_RULE 

Used to influence functions in the context of the valuation rule. 

- BADI_RECE_EVALUATION_PROCESS 

Used to influence functions in the context of the valuation process. 

- BADI_RECE_ASSET_ACCOUNTING 

Used to influence functions in the context of asset integration. 

For more information about enhancements, see: 

- Overview of Enhancement Methods for Master Data Objects and the Real Estate Contract 

- Overview of the Programming Interfaces for RE-FX 

- Information on using BAdIs 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

Note that the implementation of the methods has to be independent of the interface and must not contain 

any COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages 

using the MESSAGE statement is not allowed. 

Methods and their parameters 

- BADI_RECE_EVALUATION 
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- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation 

IO_CONTRACT, IS_EVALUATION_RULE, ID_CETYPE, and ID_CERULE 

These parameters can be used for the results analysis. 

CF_PROBABLEEND_ALLOWED 

This allows the Probable End to be entered for the transfer posting valuation type also. 

Otherwise, for unlimited contracts, the system proceeds in the same way as for the partner-

related cash flow with regard to the generation period. 

CD_INTEGRATION_TYPE 

This can be used to influence the Integration Type. 

CF_EXIT_PROCESSED 

The GET_BEHAVIOR_CONTEXT method is called from different places. Only certain 

parameters are of interest here.  Therefore, implementation must always be context based (for 

performance reasons also). To influence the integration type, for example, perform the 

implementation as follows: 

  CF_EXIT_PROCESSED = ABAP_FALSE. 

  IF CD_INTEGRATION_TYPE IS REQUESTED. 

* influence it 

    CD_INTEGRATION_TYPE = ... 

* done! 

    CF_EXIT_PROCESSED = ABAP_TRUE.   ENDIF. 

- GET_ACCOUNT_DETERMINATION_KEY - Returns the account determination value 

IO_CONTRACT, IS_EVALUATION_RULE, ID_CERULE, ID_CFTYPE, 

ID_TERMNO, and ID_KEYDATE 

These parameters can be used for the results analysis. 

CD_ACCDETKEY 

This can be used to influence account determination. 

- BADI_RECE_EVALUATION_RULE 

- COMPLETE_DEFAULTS - Prefill valuation rule data IO_CONTRACT 

This parameter can be used for the results analysis. 

CS_EVALUATION_RULE 

Valuation rule data, which can be changed. 

- COMPLETE_DEFAULTS_CONDITION - Prefill data for condition-specific valuation rule 

IO_CONTRACT, IS_EVALUATION_RULE, and IS_CONDITION 

These parameters can be used for the results analysis. 

CS_EVALUATION_COND_RULE 

Data for condition-specific valuation rule, which can be changed. 

- CHANGE_STATUSREASON - Change status reason 

IO_CONTRACT, IS_EVALUATION_RULE, and IS_EVALUATION_RULE_OLD 

These parameters can be used for the results analysis. 

CD_STATUSREASON 

Status reason. 
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- CHANGE_EVAL_RULE_FOR_INSERT - Changes possible valuation rules for insertion 

IO_CONTRACT 

This parameter can be used for the results analysis. 

CT_CERULE 

Possible valuation rules for insertion. 

- CHECK_RULE - Additional checks for valuation rule IO_CONTRACT 

This parameter can be used for the results analysis. 

IF_CHECK_ALL 

If this parameter is set, the standard check logic is used (error messages prevent a contract from 

being saved). In other cases, the check is called by the execution of the valuation. Therefore, an 

additional message can be sent as a warning during contract maintenance and as an error 

during execution of the valuation, whereby the execution is prevented. 

IS_EVALUATION_RULE 

Valuation rule data. 

CT_MESSAGE 

List of additional messages. 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation IO_CONTRACT 

This parameter can be used for the results analysis. 

CF_EXIT_PROCESSED 

See above. 

CD_MSGTYPE_USEFULLIFEEND 

The message type of the messages RECETM, , and  can hereby be overridden for the check of 

the end of usage RoU. By default, none of these messages are sent. 

- CHANGE_COND_PROPERTY - Changes possible condition valuation property 

IO_CONTRACT 

This parameter can be used for the results analysis. 

IS_EVALUATION_RULE 

Valuation rule data. 

IS_EVALUATION_COND_RULE 

Condition-specific data of valuation rule. 

CT_CONDITION_PROP 

List of condition properties 

- BADI_RECE_EVALUATION_PROCESS 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation 

IO_CONTRACT and IS_EVALUATION_RULE 

These parameters can be used for the results analysis. 

CF_REMAINING_CAPITAL_INCR_NPV 

If this parameter is set to ABAP_FALSE, the remaining capital (resulting from the present value 

determination) is not added to the present value. 

CF_COMPOUNDED_INTEREST 

When this parameter is set to ABAP_FALSE, compound interest is not calculated. 

CD_KEEP_STEP_EVALUATION 
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This parameter applies only to the following valuation types: linearization and transfer posting. 

It specifies the maximum number of steps (number of valuations) to be kept to provide 

transparency of valuations for each valuation rule. The value  is used by default. Furthermore, 

an initial value is treated like a . If the maximum number is exceeded in a subsequent 

valuation, the first step is discarded. The second step becomes the first step, and so on. In 

special cases where the "First Posting From" date has been used in an initial valuation (two 

steps are generated in the initial valuation), the maximum number is corrected to  (provided a 

smaller number has been returned after all implementations have been run). In this case, 

replacement starts only from the third step. 

Note: If the number of existing steps is greater than the maximum number of steps, 

the existing number of steps is kept (in this case, the maximum number of steps is corrected 

upward to the number of existing steps). 

CF_PROCESS_EXECUTION_ALLOWED 

When this parameter is set to ABAP_FALSE, execution of the valuation can be prevented 

(parameter IS_EVALUATION_RULE is not filled in this case). In this way, for example, you 

can use an implementation to prevent a valuation from being executed for inactive contracts 

(simulation cannot be prevented). 

CF_EXIT_PROCESSED 

See above. 

- EVALUATION - Performs contract valuation 

IO_CONTRACT, ID_EVALUATION_POINT, ID_PROCESSMODE, IT_VICERULE, 

IT_VICECONDRULE, IT_VICEPROCESS, and IT_VICECFRULE_PREVIOUS 

These parameters can be used for the results analysis. 

CT_VICECFRULE 

Valuation cash flow. 

CS_PROCESS 

Valuation process. 

CS_PROCESS_ADDITIONAL 

Additional valuation process. 

CT_MESSAGE 

Additional valuation messages. 

CF_EXIT_PROCESSED 

See above. 

Note that the EVALUATION method is currently not fully integrated into the valuation 

process and therefore can only be used to a limited extent. If you need to manipulate the 

results, please create a customer message with a detailed description. As a result, integration 

of the method will be completed step by step. 

- BADI_RECE_ASSET_ACCOUNTING 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for asset integration 

IO_CONTRACT and IS_EVALUATION_RULE 

These parameters can be used for the results analysis. 

CF_MESSAGE_DEPRECIATION 

When this parameter is set to ABAP_TRUE, messages are displayed during execution of asset 

accounting functions (that use the depreciation calculation of the valuation functions) to 
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indicate that: valuation rules are incomplete or valuations are still open. In this way, for 

example, a depreciation run can be prevented if valuations are still open. 

CD_MESSAGE_DEPRECIATION_TYPE 

You can specify the type of message here. E, W, and I are permitted. Note that the message type 

has no significance in the Asset Explorer, where a message of type I is always sent (provided that 

CF_MESSAGE_DEPRECIATION was set). 

 Enhancements (BAdI) Asset Integration 

Use 

The following Business Add-Ins (BAdIs) support enhancements to the standard functions for contract 

valuation: 

- BADI_RECE_EVALUATION 

Used to influence general functions. 

- BADI_RECE_EVALUATION_RULE 

Used to influence functions in the context of the valuation rule. 

- BADI_RECE_EVALUATION_PROCESS 

Used to influence functions in the context of the valuation process. 

- BADI_RECE_ASSET_ACCOUNTING 

Used to influence functions in the context of asset integration. 

For more information about enhancements, see: 

- Overview of Enhancement Methods for Master Data Objects and the Real Estate Contract 

- Overview of the Programming Interfaces for RE-FX 

- Information on using BAdIs 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

Note that the implementation of the methods has to be independent of the interface and must not contain 

any COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages 

using the MESSAGE statement is not allowed. 

Methods and their parameters 

- BADI_RECE_EVALUATION 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation 
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IO_CONTRACT, IS_EVALUATION_RULE, ID_CETYPE, and ID_CERULE 

These parameters can be used for the results analysis. 

CF_PROBABLEEND_ALLOWED 

This allows the Probable End to be entered for the transfer posting valuation type also. 

Otherwise, for unlimited contracts, the system proceeds in the same way as for the partner-

related cash flow with regard to the generation period. 

CD_INTEGRATION_TYPE 

This can be used to influence the Integration Type. 

CF_EXIT_PROCESSED 

The GET_BEHAVIOR_CONTEXT method is called from different places. Only certain 

parameters are of interest here.  Therefore, implementation must always be context based (for 

performance reasons also). To influence the integration type, for example, perform the 

implementation as follows: 

  CF_EXIT_PROCESSED = ABAP_FALSE. 

  IF CD_INTEGRATION_TYPE IS REQUESTED. 

* influence it 

    CD_INTEGRATION_TYPE = ... 

* done! 

    CF_EXIT_PROCESSED = ABAP_TRUE.   ENDIF. 

- GET_ACCOUNT_DETERMINATION_KEY - Returns the account determination value 

IO_CONTRACT, IS_EVALUATION_RULE, ID_CERULE, ID_CFTYPE, 

ID_TERMNO, and ID_KEYDATE 

These parameters can be used for the results analysis. 

CD_ACCDETKEY 

This can be used to influence account determination. 

- BADI_RECE_EVALUATION_RULE 

- COMPLETE_DEFAULTS - Prefill valuation rule data IO_CONTRACT 

This parameter can be used for the results analysis. 

CS_EVALUATION_RULE 

Valuation rule data, which can be changed. 

- COMPLETE_DEFAULTS_CONDITION - Prefill data for condition-specific valuation rule 

IO_CONTRACT, IS_EVALUATION_RULE, and IS_CONDITION 

These parameters can be used for the results analysis. 

CS_EVALUATION_COND_RULE 

Data for condition-specific valuation rule, which can be changed. 

- CHANGE_STATUSREASON - Change status reason 

IO_CONTRACT, IS_EVALUATION_RULE, and IS_EVALUATION_RULE_OLD 

These parameters can be used for the results analysis. 

CD_STATUSREASON 

Status reason. 
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- CHANGE_EVAL_RULE_FOR_INSERT - Changes possible valuation rules for insertion 

IO_CONTRACT 

This parameter can be used for the results analysis. 

CT_CERULE 

Possible valuation rules for insertion. 

- CHECK_RULE - Additional checks for valuation rule IO_CONTRACT 

This parameter can be used for the results analysis. 

IF_CHECK_ALL 

If this parameter is set, the standard check logic is used (error messages prevent a contract from 

being saved). In other cases, the check is called by the execution of the valuation. Therefore, an 

additional message can be sent as a warning during contract maintenance and as an error 

during execution of the valuation, whereby the execution is prevented. 

IS_EVALUATION_RULE 

Valuation rule data. 

CT_MESSAGE 

List of additional messages. 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation IO_CONTRACT 

This parameter can be used for the results analysis. 

CF_EXIT_PROCESSED 

See above. 

CD_MSGTYPE_USEFULLIFEEND 

The message type of the messages RECETM, , and  can hereby be overridden for the check of 

the end of usage RoU. By default, none of these messages are sent. 

- CHANGE_COND_PROPERTY - Changes possible condition valuation property 

IO_CONTRACT 

This parameter can be used for the results analysis. 

IS_EVALUATION_RULE 

Valuation rule data. 

IS_EVALUATION_COND_RULE 

Condition-specific data of valuation rule. 

CT_CONDITION_PROP 

List of condition properties 

- BADI_RECE_EVALUATION_PROCESS 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for the valuation 

IO_CONTRACT and IS_EVALUATION_RULE 

These parameters can be used for the results analysis. 

CF_REMAINING_CAPITAL_INCR_NPV 

If this parameter is set to ABAP_FALSE, the remaining capital (resulting from the present value 

determination) is not added to the present value. 

CF_COMPOUNDED_INTEREST 

When this parameter is set to ABAP_FALSE, compound interest is not calculated. 

CD_KEEP_STEP_EVALUATION 
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This parameter applies only to the following valuation types: linearization and transfer posting. 

It specifies the maximum number of steps (number of valuations) to be kept to provide 

transparency of valuations for each valuation rule. The value  is used by default. Furthermore, 

an initial value is treated like a . If the maximum number is exceeded in a subsequent 

valuation, the first step is discarded. The second step becomes the first step, and so on. In 

special cases where the "First Posting From" date has been used in an initial valuation (two 

steps are generated in the initial valuation), the maximum number is corrected to  (provided a 

smaller number has been returned after all implementations have been run). In this case, 

replacement starts only from the third step. 

Note: If the number of existing steps is greater than the maximum number of steps, 

the existing number of steps is kept (in this case, the maximum number of steps is corrected 

upward to the number of existing steps). 

CF_PROCESS_EXECUTION_ALLOWED 

When this parameter is set to ABAP_FALSE, execution of the valuation can be prevented 

(parameter IS_EVALUATION_RULE is not filled in this case). In this way, for example, you 

can use an implementation to prevent a valuation from being executed for inactive contracts 

(simulation cannot be prevented). 

CF_EXIT_PROCESSED 

See above. 

- EVALUATION - Performs contract valuation 

IO_CONTRACT, ID_EVALUATION_POINT, ID_PROCESSMODE, IT_VICERULE, 

IT_VICECONDRULE, IT_VICEPROCESS, and IT_VICECFRULE_PREVIOUS 

These parameters can be used for the results analysis. 

CT_VICECFRULE 

Valuation cash flow. 

CS_PROCESS 

Valuation process. 

CS_PROCESS_ADDITIONAL 

Additional valuation process. 

CT_MESSAGE 

Additional valuation messages. 

CF_EXIT_PROCESSED 

See above. 

Note that the EVALUATION method is currently not fully integrated into the valuation 

process and therefore can only be used to a limited extent. If you need to manipulate the 

results, please create a customer message with a detailed description. As a result, integration 

of the method will be completed step by step. 

- BADI_RECE_ASSET_ACCOUNTING 

- GET_BEHAVIOR_CONTEXT - Returns the behavior context for asset integration 

IO_CONTRACT and IS_EVALUATION_RULE 

These parameters can be used for the results analysis. 

CF_MESSAGE_DEPRECIATION 

When this parameter is set to ABAP_TRUE, messages are displayed during execution of asset 

accounting functions (that use the depreciation calculation of the valuation functions) to 
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indicate that: valuation rules are incomplete or valuations are still open. In this way, for 

example, a depreciation run can be prevented if valuations are still open. 

CD_MESSAGE_DEPRECIATION_TYPE 

You can specify the type of message here. E, W, and I are permitted. Note that the message type 

has no significance in the Asset Explorer, where a message of type I is always sent (provided that 

CF_MESSAGE_DEPRECIATION was set). 

 Adjustment of Conditions 

 Adjustment Rules - Cross-Method 

 Define Adjustment Rules 

Use 

In this activity, you define adjustment rules for each adjustment method that you would like to use. 

Standard settings 

The following adjustment rules are provided by SAP in the standard system and are fixed: 

- Free 

- Index 

- Service charge settlement 

- Representative list of rents 

- Comparative group of apartments 

- Adjustment measure/modernization 

Together with specific contract or rental data, as well as data entered in the adjustment process (such as 

the specification of percentage or absolute adjustment), the adjustment rules define which algorithm is 

used to calculate the adjustment amount. 

Activities 

1. Create at least one rule for each adjustment method. 

2. Give the rule a name that allows it to be easily identified. 

3. If you want to create a rule consisting of several rules, set the Combined Rule indicator. Any rule that 

is not identified as a combined rule can be used as a subrule. If you want to create a rule that should be 

used exclusively as part of a combined rule, set the Part of Comb.Rule indicator. You then have to 

assign it to the combined rule in the Combined Adjustment Rules activity. 

4. Enter the required parameters for each rule. For more information, refer to the information contained in 

the F Help for each field. 
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5. For each parameter, define how it appears on the on the contract or rental object. The options are: 

- Hidden 

- Displayed only 

- Can be modified 

- Required entry Recommendation: 

To simplify processing, create rules with completed parameters for the most important and most frequently 

used adjustment rules. The rules you create should allow only a few or no individual settings to be made on 

the contract or rental agreement. In the case of more complicated or seldom used processes, you should 

create some rules with parameters that can then be specified on the contract or rental object. 

For some methods (such as, INDX or TASK) there are method-independent parameters in addition to the 

method-dependent parameters. You can set these parameters in the Implementation Guide in the section 

for the given method. 

Customizing Relationship - Contract/Rental Object 

If no parameters are changed in the contract/rental object, then the system uses the rule parameters from 

Customizing for the adjustment process. Then changes to the rule parameters in Customizing apply to all 

contracts/rental objects that use this rule. 

However, you can sever the relationship to Customizing by choosing @G@ with quick info Unlink from 

Customizing. The prerequisite for this is that the adjustment rule that has Modifiable in Contract/Rental 

Object entry status. 

Once you unlink Customizing, the modifiable fields are then ready for input, and you can make your own 

modifications to the adjustment rule. Any changes you make the rule parameters in Customizing then 

nolonger affect these contracts/rental objects. When you save an object that has an adjustment rule you 

modified yourself, an icon (@H@ with quick info  Modified), appears next to the changed fields. You 

can choose this icon to compare the rule parameters from Customizing with the modified value of the 

field. 

You can establish the relationship with Customizing again by choosing  @H@ with quick info Link to 

Customizing. The modifiable fields are then no longer available for input, and the system fills them again 

with the rule parameters from Customizing. 

 Define Combined Adjustment Rules 

Use 

In this activity you can assign multiple subrules to an adjustment rule. 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 242 

Requirements 

First create the following rules in the Create Adjustment Rule IMG activity: 

1. The adjustment rule that will be used as the combined rule 

2. All adjustment rules that will be used as subrules 

The Combined Rule indicator has to be set for the combined rule. For subrules, you can use all 

adjustment rules that are not designated as combined rules. If you want an adjustment rule to be available 

only as a subrule, set the Part. Comb. Rule indicator. Then you are not allowed to assign the rule directly 

to a contract or a rental object. 

Activities 

Choose a combined adjustment rule and assign subrules to it. 

 Define Adjustment Reason 

Use 

In the application, you have to enter a reason you define here for the adjustment run. This adjustment 

reason controls which capping provisions apply to the capping, and which conditions are also taken into 

account. 

Activities 

- For each adjustment rule, specify which adjustments can be made using which adjustment reasons. 

Make the settings you need for capping and for the conditions that are considered in addition. This is done 

in the detail screens of the following IMG activities: 

- Define Adjustment Parameters Dependent on Term 

- Define Rounding, Change Reason and Surcharges per Adjustment Rule 

 Define Adjustment Lock 

Use 

If you do not want a condition to be adjusted during a given time period, you can assign a lock reason to 

the adjustment rule. 
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Activities 

For each adjustment method, define the reasons for allowing an adjustment to be prevented, and enter a text 

for the reasons. This text is displayed in the contract when you process the adjustment rule. 

Note: You can only select the reason for the adjustment lock if one of the following is selected for the 

adjustment rule in  Customizing: To Be Fixed in Contract/Rental Object ( recommended setting) or 

Modifiable in Contract/Rental Object. 

Example 

For adjustment method "RLRA" you defined these lock reasons: 

 - Legal dispute 

 - Other lock reason 

For adjustment rule RERACN, the field is set to Modifiable in Contract/Rental Object. 

If you assign adjustment rule RERACN to a contract, the  Lock Reason field then appears. 

 Define Adjustment Parameters (Capping Provisions) Dependent on Term 

Use 

In this activity, you can specify for each adjustment rule, if a maximum limit is set for an increase. You 

also specify the how high this maximum is, and the period for which it is effective. When an adjustment 

is made, the system checks the rules separately for each time period. If the adjustment amount is larger 

than the smallest amount resulting from the application of all the rules, then the system reduces the 

adjustment amount accordingly. 

The maximum increase is usually set by law. 

The maximum increase can be entered using one of the following parameters: 

- Absolute per Measurement  (Maximum Increase per Measurement) 

- Absolute per Condition Amount (Maximum per Condition Increase) 

- Percentage (Maximum Increase in %) 

If you choose a percentage, then you have to enter the capping basis for it. (Is the percentage multiplied 

by the unit price or by the condition amount that results from the calculation?) 

In addition, you can set an upper limit for the resulting new rent. You also have the option here of 

entering either the absolute upper limit per measurement or the absolute upper limit for the entire 

condition amount. If more than one upper limit was entered, then the system satisfies all of the upper 

limits when the condition amount in the adjustment is reduced. 

You can also specify minimum increases. You can use one of the above parameters for a minimum increase 

as well. 

It is also possible to specify minimum increases. The following applies to minimum increases: 
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- If you enter a value in one (or more) of the minimum increase fields, then the system makes the 

adjustment only if the increase amount that is determined is at least the same as the value entered in 

this field. You can make use of this to prevent an adjustment being made for a trivial amount. 

- Above and beyond that, you can also use the Increase to Minimum Increase? indicator. This allows you 

to ensure that the increase is at least the minimum amount that was set, even if the result of the 

calculation is a smaller value. The increase is then performed as if you had used a free adjustment 

method (normally useful only if there is at least a minimum interval between two adjustments). 

If the minimum amount calculated in this case is smaller than the maxium amount determined based 

on the upper limit, then the system ignores the minium amount. 

Example 

For adjustment rule A, you define that the maximum increase within  months can be  %, within  months  %. 

The condition history for contract  for rent is below. Adjustment rule A is assigned to this condition. 

January ,     

January ,     

January ,     

Adjustment rule A calculates a condition amount of  for January , . For a maximum increase within  

months this amount is correct, since the rent was  euros  months before the adjustment date. An 

adjustment amount of up to  euros would be allowed given the maximum allowed increase of  %. 

However, on January , ,  months before the adjustment date, the rent was . The maximum allowed 

increase within  months is %, which means the maximum amount allowed is . The system reduces the 

original adjustment amount of  to . 

 Define Rounding, Change Reason, and Classification ( Surcharges ) 

Use 

You define here  how and which conditions are to be taken into account during adjustment using a 

specific rule. 

In some cases it can be necessary to also take into account other conditions during calculation, for 

example, if an appreciation surcharge defined as a separate condition is to be included in the basic rent. 

Standard settings 

If no entries exist for an adjustment rule in this table, then the new condition amount is determined for the 

conditions to which the adjustment rule is assigned, according to the procedure defined by the rule. 

Activities 

The settings here are dependent on the adjustment rule (see the Define Adjustment ReasonIMG activity). 

Since the adjustment rule is specified in the application in the adjustment run, you can overwrite the 

conditions of the adjustment rule that are normally valid by entering another adjustment reason. 
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Set the following for each condition type to be taken into account: 

- Whether and how it is to be rounded: Make the necessary settings for: 

- The rounding category 

- The number of decimal places - The unit (you find examples here) 

- The adjustment basis: 

You define which amount (unit price or condition amount) is used for rounding. 

- The indicator Round Difference: 

Set this indicator if you want to round the difference (difference between new and old amount). If you 

do not set the indicator, then the new amount that results from the adjustment is rounded. 

- The classification 

Here you define whether the condition is a main condition, a surcharge, or a waiver condition. 

- The reason for change that is set with this rule when adjusting the condition: For example, if a 

surcharge is changed when adjusting the main condition, you can specify the reason inclusion in 

basic rent for the surcharge condition type. 

Set the following for surcharges: 

- The computable indicator 

- The term in months for not being counted 

- The cancellable indicator 

- The term in months, according to which the cancellation is possible at the earliest 

If the adjustment rule is able to create this condition, then you also have to enter the condition purpose to 

be used for the new condition. The condition purpose is particularly important for waiver conditions, since 

they should have a statistical condition purpose (showing the rent increase that was waived in reporting 

and correspondence). 

If no condition type is entered, then the entry for the adjustment rule and adjustment reason is relevant for all 

condition types for which no separate setting was made (default setting for adjustment rule and adjustment 

reason). 

 Index Adjustment 

 Enter Parameters for Index Rule 

Use 

In this activity, you create additional parameters for adjustment rules that are based on the Index 

adjustment method. Also refer to the F documentation for the fields and for the input status. 
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Prerequisites 

You have created the index rules that you need in the Adjustment Rules IMG activity. 

Customizing Relationship - Contract/Rental Object 

If no parameters are changed in the contract/rental object, then the system uses the rule parameters from 

Customizing for the adjustment process. Then changes to the rule parameters in Customizing apply to all 

contracts/rental objects that use this rule. 

However, you can sever the relationship to Customizing by choosing @G@ with quick info Unlink from 

Customizing. The prerequisite for this is that the adjustment rule that has Modifiable in Contract/Rental 

Object entry status. 

Once you unlink Customizing, the modifiable fields are then ready for input, and you can make your own 

modifications to the adjustment rule. Any changes you make the rule parameters in Customizing then 

nolonger affect these contracts/rental objects. When you save an object that has an adjustment rule you 

modified yourself, an icon (@H@ with quick info  Modified), appears next to the changed fields. You 

can choose this icon to compare the rule parameters from Customizing with the modified value of the 

field. 

You can establish the relationship with Customizing again by choosing  @H@ with quick info Link to 

Customizing. The modifiable fields are then no longer available for input, and the system fills them again 

with the rule parameters from Customizing. 

 Enter Index Rebasing Factors 

Use 

Due to the introduction of a new base year for the consumer price index in Germany, SAP has 

standardized all existing consumer price indexes. As a result, certain indexes that can be linked to rent 

changes are no longer available. Therefore, SAP recommends that, over the longterm, you convert 

contracts that are linked to now invalid index series. 

In the interim, SAP provides this conversion table for updating outdated index series with the new 

consumer price index (also called rebasing). 

Activities 

For the target series, enter an index series for which you want to convert the index values to those of the 

target year, but for which index values are no longer reported. For the target year, enter the base year that 

you want to convert the index values to. 
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As source series, enter the index series, for which index values are provided for the source year. For the 

source year, enter the base year for which index values are reported. 

Assign the chaining date (month and year on which the index levels for the rebasing are entered). 

Currently valid index series in Germany per //: Consumer Price Index for 

Germany ( VPI ) 

Currently valid base year per //:  

Currently valid chaining date per //: // 

 Enter Index Levels 

Use 

In this section, you create: 

1. Index class as the basis for further defining indexes for rent adjustments 

2. Index series used in your organization for rent adjustments, including index series with base year 

3. Index points for the index series 

Standard settings 

SAP supplies the index classes  for real estate objects and  for maintenance and operating costs index ( 

Switzerland ). 

Recommendation 

It is recommended that you do not change the standard settings. 

Changes may at best be necessary if you have already entered these index classes (with other characteristic 

values) in Asset Accounting (Asset Accounting uses the same table). In case of uncertainties, please also 

refer to the Asset Accounting System Administration Guide. 

Activities 

1. Check whether you have to make changes to the standard setting. The Real Estate component requires 

the following index classes: 

a) An index class for rent adjustment with the following settings: 

Details on indexing frequency (monthly: entry ) Details on 

base year 
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b) Applies only for Switzerland: a class for maintenance and operating costs index with the 

following settings: 

- Details of an indexing frequency (monthly: entry ) - No base 

year: Check if changes to the standard setting are   necessary. 

2. Index series 

First maintain per index class the required index series and, for index series with base year, the 

required base years for the respective index series. 

3. Index data 

Create the required index data for the index series. 

To do so, navigate over the required entry (index series with or without base year. 

 Representative List of Rents 

 Define Fixt./Fittings Characteristics for Buildings, ROs, and Parcels 

Use 

You specify here which fixtures and fittings characteristics are to be available when processing the rental 

object, building, parcel, and architectural object. The fixtures and fittings characteristics that you define 

here can be assigned to a representative list of rents (see Define Representative List of Rents: 

Characteristic Categories --> Surcharge/Reduction Characteristics). 

For fixtures and fittings characteristics that are not relevant for the representative list of rents, you can 

define a structure using the Specify Structure of Fixtures and Fittings Characteristics Independent of 

Representative List of Rents IMG activity. 

Activities 

- Define all required fixtures and fittings characteristics. 

- For each fixtures and fittings characteristic, specify the objects on which the characteristic is visible: 

rental object, building, and/or parcel. You can then process these fixtures and fittings characteristics on 

the rental object or building by choosing the Fixtures/Fittings tab page. For parcels, you see the fixtures 

and fittings characteristics by choosing the Development tab page. 

If you need fixtures and fittings characteristics in architectural objects, you define them here. Then 

you assign them to architectural objects in the Specify Fixt/Fittings Characteristics for Architectural 

Objects IMG activity. 

When adjusting conditions using the representative list of rents procedure (according to the 

representative list of rents), you can use fixtures and fittings characteristics and their evaluations for 

the calculation of the comparative rent. 

The fixtures and fittings characteristics of the rental object and those of the assigned building 

(provided that this is defined for the representative list of rents) are used in this calculation of the 

comparative rent. If you indicate that a fixtures and fittings characteristic is permitted for both object 

types, you can define the general validity of this characteristic at the building. For the rental objects 
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to which the building attribute does not apply, you can then make a different setting in the 

application (see example). 

- Also define for each fixtures and fittings characteristic whether it is relevant for the representative list 

of rents, that is, whether it should be included in the rent adjustment according to the representative list 

of rents. 

- You can define that a specific fixtures and fittings characteristic should only be visible for objects of 

this category (derived from the usage type of the rental object) using the usage category. If you do not 

enter anything here, the fixtures and fittings characteristic can be selected regardless of the usage type 

of the rental object. 

Example 

For example, if all apartments of a house are equipped with oil central heating, you could define the 

fixtures and fittings characteristic Oil Central Heating for the building instead of separately for 

each apartment. If electric heating is installed in the top-floor apartment ( that was subsequently added), 

then when you process this apartment, you can select the Oil Central Heating characteristic as 

not appropriate and instead specify a fixtures and fittings characteristic Electric Heating. 

 Define Representative List of Rents 

Use 

Here you define the representative lists of rents that you need. Since representative lists of rent differ from 

city to city, there are some menu options here that you only need for specific representative rent lists. 

Representative lists of rents are used primarily in Germany and the Netherlands. The information here 

reflects mainly the German usage for residential rents in cities. However, since you can flexibly define 

the representative list of rents, and since the customer exits offered allow even more room for making 

your own changes, the representative list of rents method can be used on a more general basis to handle 

other types of rent adjustments that are based on rules. This is especially true if the rent (or other 

condition) being adjusted is dependent mainly on the size, location, fittings and fixtures, age, and possibly 

other attributes of the rental object. 

Use this guide for defining new representative lists of rent. You can use the settings for the sample 

representative list of rents that is provided in Customizing as a reference. 

For some representative lists of rents, there are various means of representing them in the system. If you 

are unsure about which means to use, choose the way that is the least complicated for the end user, and 

therefore leads to fewer errors. 

Note 

SAP does not guarantee the correctness of the values in the example. The data provided is intended only as 

an example. 

Requirements 
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You entered an adjustment rule for the representative list of rents in the Define Adjustment Rules IMG 

activity. 

Activities 

- To create a new representative list of rents, choose New Entries. Enter the ID for the 

representative list of rents in the Repr.rent list field. The system uses this ID to address the 

representative list of rents in the adjustment rule. 

If the structure, or even just the values, of the representative list of rents of a city change, then 

create a new representative list of rents (or copy the old one). Link the two representative lists of 

rents by choosing the References dialog structure node. In this case, you do not have to change the 

representative list of rents that is referenced in the master data. The system automatically 

determines from the assignment data that the new representative list of rents is used. However, 

keep in mind that changes to the structure of the representative list of rents can also bring changes 

of master data along with them. 

- On the detail screen of the representative list of rents, you enter the structure and basic data for 

this representative list of rents in the Basic Data screen area. Basic data includes: 

- Validity period 

- Currency for the values in the dependent tables 

- The  for determining the base value for the representative list of rents 

- Area type, that is used for the measurements in the representative list of rents table 

(this is not allowed to be a total measurement type for area) 

- Area unit for these values 

- If the individual cells of the value tables in your representative list of rents have names, and you 

want to process these names, then set the Rep. List of Rents Uses Rent Label indicator. This can 

simplify communication with tenants. 

- Using the Rep. List of Rents Uses Characteristic Categories indicator, you specify if fixtures and 

fittings characteristics for surcharges and reductions are considered in the calculation of rent 

using the representative list of rents. 

- You also specify the structure of the representative list of rents here (Dimensions for Calculating 

Basic Rent). This structure specifies the parameters on which the table of base values for the 

representative list of rents is dependent (key fields of the value table, which you edit in the 

Specify Basic Values for Representative List of Rents IMG activity). These values can be 

dependent on the following classes or categories: 

- The Location Class and 

- The Fixtures and Fittings Category 

You enter both of these on the rental object, and evaluate the location or fixtures and fittings in 

relation to a specified representative list of rents. 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 251 

Some representative lists of rents contain concrete specifications about which sections of the 

city can be placed in which location classes, or which fixtures and fittings an apartment is 

allowed to have or not have to be assigned to a given fixtures and fittings category. 

You might not want to leave the implementation of these specifications to the 

employee who handles the data of the rental object. Instead, you might want to have this take 

place automatically. In that case, you can use the BAdIs for rental object maintenance to make 

the necessary validations or substitutions. For more information, refer to the Define Number 

Assignment, Validation Substitution IMG activity. However, in many cases it is sufficient for 

your employees to refer to the concrete, plaintext representative list of rents that is provided as 

an example. The file stored here in Customizing can be accessed as read-only in the master 

data of the rental object. Use the link to the Business Document Navigator by choosing 

Documents for RLR (PDF or similar.). 

- The Size Class and the Building Age Class 

These are determined automatically from the size and construction year of the rental object. 

- Enter all other data to complete the basic data of the representative list of rents: 

- References (as described above, used if the structure of the representative list of rents in the 

master data has changed) 

- Building age classes 

If the representative list of rents uses building age classes, then define a building age class for 

each time period defined in the representative list of rents. If the representative list of rents does 

not set time limits for the beginning and end of the categories, then leave the From Date in the 

oldest building age category and the To Date in the most recent building age category blank. 

- Location Classes 

If the representative list of rents uses location classes and you specified that in the basic data, 

then you define these location classes here. Enter a text for the location class (this is also 

displayed when you process the rental object). 

- Size Classes 

If the representative list of rents uses size classes, and you specified that in the basic data, then 

you define these size classes here. Enter the size margin for each class. If the representative list 

of rents does not specify an overall upper and lower limit, then omit these values in the smallest 

and largest size class. 

- Fixtures and Fittings Categories 

If the representative list of rents uses fixtures and fittings categories, and you specified that in 

the basic data, then you define these fixtures and fittings categories here. Enter a text for the 

fixtures and fittings category (this is also displayed when you process the rental object). 

- Representative List of Rent Labels 

If the representative list of rents uses representative list of rents labels, and you specified that 

in the basic data, then you define these representative list of rents labels here. Enter the 

assigned text for the representative list of rents label. The representative list of rents label is 
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not maintained on the rental object. Instead, it is determined from the value table during the 

adjustment. 

- Characteristic Categories 

If the representative list of rents uses characteristic categories for surcharge and reduction 

categories, and you specified that in the basic data, then you define these characteristic 

categories here. Enter the assigned text for the characteristic category. Enter the divisor that 

should be used for dividing the total point value of the assessment. Also specify how often 

characteristics in this characteristic category can be designated as "applicable" during 

processing of the rental object. For each characteristic category, you can assign weighting 

factors that are used for calculating rent based on the amenities level sign. For informational 

purposes, you can enter the number of the table of the representative list of rents that should be 

used for this characteristic category. 

- Characteristic groups 

If you use characteristic categories, you can group the characteristics of a characteristic 

category together into characteristic groups. Here you define the groups, and specify for each 

group how often characteristics in this characteristic category can be designated as 

"applicable" during processing of the rental object. 

- Surcharge Characteristics/Reduction Characteristics 

If you use characteristic categories, then you can define all characteristics of the characteristic 

category more exactly here. You assign the characteristics to characteristic groups here. You 

enter default values for assessment on the rental object here, as well as the point spreads that 

can be selected for each characteristic. You can also enter values for interpolation, if 

applicable, and specify how and if each characteristic is used for assessment using the 

amenities level sign. 

- Surcharges/Reduction per Characteristic and Area Interval 

If you use characteristic categories, you can enter an area price per area interval here for each 

characteristic. This price is then determined as the surcharge or reduction. 

 Specify Basic Values for Representative List of Rents 

Use 

In this table you enter the base values for a specific representative list of rents. 

Requirements 

You specified the structure of the representative list of rents in the Define Representative List of Rents 

IMG activity. The following fields in the definition of the basic data of the representative list of rents 

determine its structure: - Rep. List of Rents Uses Characteristic Categories 

- Dimension for calculating the base rent: 

Building Age Category 
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Location Class 

Size Class 

Fixtures and Fittings Category 

- Rep. List of Rents Uses Rep. List of Rents Labels 

These indicators determine the structure (key fields) of the value table you process here. 

Activities 

Depending on how the representative list of rents is structured, you can specify base values here for 

each: 

- Building age category 

- Location class 

- Fixtures and fittings category 

- Size class 

If the setting was made that allows it, you can also enter the representative list of rents label that is 

assigned to the given entry. 

The key entries are automatically defined by the system. You are not allowed to change them here. If you 

need different key entries, then you have to change the structure of the representative list of rents (see 

Requirements). 

 Define Special Rules for Adjustment Using Rep. List of Rents 

Use 

Here you can specify, per adjustment rule, that the construction year of the building is always used for 

determining the building age category. You do this by setting the Construction Year of Building indicator. 

If this indicator is not set or no settings were made for a rule, then the construction year of the building is 

used only if a date of reconstruction or extensive modernization is not entered on the rental object. 

 Make Own Changes to Standard Calculation Rules for Adjustment 

 Create Adjustment Control Rule 

Definition 

For special calculations in condition adjustments, you can define an adjustment control using a formula 

editor. (Refer to the Define Adjustment Control Differing from Standard IMG activity.) For example, 

you could make the rent dependent on parameters that do not influence rent in the standard system. 
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In order to be able to use a set of rules for adjustment control with more than one adjustment rule, you store 

the set of rules with a key as an adjustment control rule. Then you assign this adjustment control rule to the 

actual adjustment rule that is used for adjusting the condition ( see Assign Adjustment Control Rule to 

Adjustment Rule/Rep. List of Rents). 

Activities 

Specify the following for the adjustment control rules you need: 

- Name 

- Language for the language-dependent ID of the variables. 

- If you first want to assign a default comment to each row of the control table. 

- If you only want to assign default comments for fulfilled block conditions. 

- If you also want to assign a block info to the default comment (the block and row number) in the 

comment. 

Here you can also see how the default comment will be output. 

 Assign Adjustment Control Rule to Adjustment Rule/Rep. List of Rents 

Use 

For each adjustment rule, in which the calculation of the adjustment amount should be different 

from the standard, you have to assign an adjustment control rule. The adjustment control rule is then 

executed in addition to the adjustment rule. 

- You can use the representative list of rents as a differentiation characteristic. Entering a 

representative list of rents only makes sense for a representative list of rents method. The adjustment 

control rule is only applied if the entered representative list of rents is used. 

- If you do not enter a representative list of rents for an adjustment rule, then the system uses the 

adjustment control rule for all adjustments that use that adjustment rule. 
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 Define Variables for Adjustment Control 

Use 

The calculation formulas of the representative list of rents are found in the system in the form of 

conditions and actions. These conditions and actions work with variables that you define here. 

Activities 

1. Choose a technical name that uniquely identifies the variable (also refer to the example below). 

Note: Make sure you use the customer name space for your own variables. 

2. Choose the variable type, for example: 

- Character string (for example, name of representative list of rents) -

 Boolian value (true or false)... 

3. Enter the number of decimal places and specify if the variable can be changed. 

4. Specify if the variable is indexed. This means that a block that uses this kind of variable can be called 

more than once by the system. 

5. Specify if the variable can be used for interpolation 

6. Enter the variable name for the formula (also refer to the example below). Note: Make sure you use the 

customer name space here as well. 

7. Assign the variable to the adjustment method in which you want it to be used. 

8. Assign the variable to a variable class. 

Example for Adjustment Control: 

According to the definition in the representative list of rents, all fixtures and fittings characteristics that 

were assessed with less than  EUR/m are to be ignored. The number of these characteristics should be 

counted (for later calculations). 

Meaning of the variables: 

Technical Var. Name Formula Name Description 

FFCHRLRAAMTAR AUSMERKMALBFE  

characteristic (area price ( surcharge/reduction )) 

Value that is considered for 

FFCHFIXFITCHNOTUSEAUSMERKMALNBER calculation Ignore characteristic during 

XNUMC XN Numerical auxiliary variable 

This could be achieved using the following block: 
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BlockNo RowNo Variable (Formula Name) Formula 

  AUSMERKMALBFE <  

  AUSMERKMALNBER TRUE 

  XN XN +  

 Define Adjustment Control Differing from Standard 

Use 

You represent the calculation formulas of the representative list of rents, without using ABAP program code, 

in the form of conditions and activities. 

A condition describes when a specific situation exists and an activity describes how as a result of this, the 

system proceeds with the values of the variables. A condition and the following activities are combined in 

blocks. 

Condition: 

A condition is a mathematical formula in which the arithmetic and logical operators can be linked 

to variables provided by the system. They must be formed so that they always return a Boolean 

result (that is, true or false). 

For example, if the building age class is defined in the variable BAUALTKLA and the building year in 

the variable BAUJAHR, then a condition could be BAUALTKLA = '' AND BAUJAHR > . This 

would then be fulfilled if the building age class of the apartment equals  and the building year is 

greater than . 

Activity: 

An activity is a pair of a variable and a mathematical formula (or constants).The formula can 

have any value (number, character string, Boolean value), that is allocated when you execute the 

respective variable. 

Thus, the activity RENT_NEW , RENT_NEW  +  (< variable, formula for 

variable>) would increase the new rent per area unit by one. 

The simplest case of a formula is the allocation of a constant to a variable. The activity RENT_NEW , 

would set the new rent per area unit to the value . 

Block: 

You combine a condition with as many activities as required in a block. When the condition of the 

block is fulfilled, then all its activities are executed one after the other. The sequence of the blocks 

is defined by a block number, which can be freely allocated. The sequence of activities within a 

block are also defined by a row number, which can be freely allocated and is block internal. The 

condition is independent of the row number. It is always checked first. 

Any number of blocks can be assigned to each adjustment control rule. These are processed sequentially 

during an adjustment (the adjustment control rule is assigned to an adjustment rule) for each rental object 

or contract to be adjusted. 

Requirements 

You have created an Adjustment Control Rule. 
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Activities 

- Allocate a block and row number. 

- Specify whether the following should apply to the row: 

- The row is a comment row (row is not used for evaluation) 

- The default for comments, which has possibly been set on the adjustment control rule, should be 

switched off 

- You normally formulate a condition first. The condition is always checked first, even if this has a 

higher row number than the activities. 

- For a condition in the Formula field, define a mathematical formula, which should be applicable 

or not appliacable for the condition, for example, BAUALTKLA = '' AND BAUJAHR > . 

- For an activity, you specify the formula name of the variable, which you want to use in the 

calculation, in the Variable column. All existing variables are described in the Define Variables 

for Adjustment Control IMG activity. 

- For the variable, specify the mathematical formula that should be executed. 

If certain partial expressions are used a lot in a formula, functions (macros) that can 

be parameterized can be defined for this. They are either stored in the TFKT table or in a table 

that the user created, which has the same structure. For more information, see Macros. 

- Enter a user-defined text for the variable in the field variable number  and . This text should be 

used in the default comment. 

- Specify a message ID, type, and number for this block. 

For more information, special features, and tips & tricks on jumps, typing, and character strings, see 

Special Features on Control Table. 

Example for Adjustment Control: 

According to the definition in the representative list of rents, all fixtures and fittings characteristics that 

were assessed with less than  EUR/m are to be ignored. The number of these characteristics should be 

counted (for later calculations). 

Meaning of the variables: 

Technical Var. Name Formula Name Description 

FFCHRLRAAMTAR AUSMERKMALBFE  

characteristic (area price ( surcharge/reduction )) 

Value that is considered for 

FFCHFIXFITCHNOTUSEAUSMERKMALNBER calculation Ignore characteristic during 
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XNUMC XN Numerical auxiliary variable 

This could be achieved using the following block: 

BlockNo RowNo Variable (Formula Name) Formula 

  AUSMERKMALBFE <  

  AUSMERKMALNBER TRUE 

  XN XN +  

 Implement Enhancements for Rent Adjustment Using Rep. List 

of Rents ( BAdI ) 

Use 

The Business Add-In supports enhancements to the standard functions of adjustment of 

conditions using the representative list of rents procedure. For an overview of the possible 

enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

The following methods exist: 

- GET_BASE_RENT - gets the base rent 

- GET_COMPARATIVE_RENT - gets the comparative rent 

These methods are called automatically during standard processing of the adjustment of conditions. If an 

implementation exists, the methods are always called in addition to standard system behavior. This does 

not mean that it is possible to replace the standard behavior of the basic actions. 

The implementation of the methods has to be independent of the interface. It must not contain any 

COMMIT WORK or ROLLBACK WORK statements. 

For example, direct output of messages using the MESSAGE statement is not allowed. 

Method description 

- GET_BASE_RENT 

This method gets the base rent. The IO_CONTRACT parameter receives a value when the condition 

to be adjusted is a contract condition. Otherwise the IO_RENTAL_OBJECT parameter has a value. 
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The IS_CONDITION parameter contains the values of the condition to be adjusted. The base rent is 

changed using the CD_BASE_RENT parameter.  Returned messages (CT_MESSAGE parameter) 

are displayed in the same list with the messages from standard processing. 

- GET_COMPARATIVE_RENT 

This method gets the comparative rent. The IO_CONTRACT parameter receives a value when the 

condition to be adjusted is a contract condition. Otherwise the 

IO_RENTAL_OBJECT parameter has a value. The IS_CONDITION parameter contains the values of 

the condition to be adjusted. The comparative rent is changed using the 

CD_COMPARATIVE_RENT parameter.  Returned messages (CT_MESSAGE parameter) are 

displayed in the same list with the messages from standard processing. Notes for Developers 

 Comparative Apartments 

 Define Rules for Determining Comparative Rent 

Use 

Here you define which rules are to be valid for rent adjustment using comparative apartments. 

Activities 

Enter the following for each adjustment rule: 

- Comparative group with which you want to carry out the adjustment (consisting of company code and 

comparative group number). 

It is only useful to make entries for these fields if you have defined a standard comparative group 

that can be used for many rental objects in your portfolio. Then you only need to assign the rule to 

these rental objects. 

However, you will normally not define the comparative group here but specify it on every rental 

object. 

- Number of Comparative Apartmentsfrom which the comparative rent is to be determined. 

- Whether the average rent of the rental object of the comparative group is to be determined 

(not permitted for apartments in Germany) 

- Whether internally leased-out rental objects are to be considered when determining the comparative 

rent. 

You do not normally set this indicator since rent can be set arbitrarily for internal contracts. 
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- Measurement type for the space used to determine the comparative rent. You must specify a value for 

this measurement type for all rental objects in the comparative group and for the rental object to be 

adjusted. The comparative rent is calculated based on this measurement type and multiplied by the 

measurement value of the rental object to be adjusted. 

You usually use the same measurement type here that you also used to apportion the space-related 

service charges. 

- Condition purpose to be used to determine the comparative rent of external comparative apartments. 

 Comparative Group of Apartments Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 
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In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields 

of a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, and 

display fields in display mode.) If it is not possible to make a setting for a field group, then the system 

determines how the field is treated (usually dependent on the situation, or on the contents of other 

fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 
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Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of the 

view accordingly (consider the detail screen). Then assign the field groups to the view. You can assign 

your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it is 

surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you want 

to this section. The item number specifies the sequence in which the views are arranged in the section. For 

technical reasons, if you make your own assignments from sections to views, the item numbers have to be 

in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 
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 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 
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You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

For comparative groups of apartments, the system always uses the screen sequence category that is 

defined as Standard. 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Comparative Group of Apartments: Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of comparative groups. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 
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For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 Influence Determination of Comparative Apartments and Comparative Rent 

Use 

This BAdI is run for rent adjustment using comparative apartments. 

- Method  CHANGE_COMP_OBJECTS 

This method is called after the comparative objects are determined. The objects are transferred in 

table CT_COMP_OBJECTS. You can edit the objects, for example by deleting objects that are not 

suitable. 

- Method  CALCULATE_PRICE 

In this method, you can determine the calculated price differently to the way it is done in the 

standard system. The method is called before the standard calculation (and after the method 

CHANGE_COMP_OBJECTS). So that the standard code is no longer run, you have to set the flag 

EF_ADJUSTED to ABAP_TRUE. There is an example implementation for this method in the class 

CL_EXM_REAJ_ADJUSTMENT_COMP. 

- Method CHANGE_CONDTYPE 

In the standard system, the condition type of the condition to be adjusted is used to read the 

conditions in the comparative objects. This means that conditions with this condition type must 

exist in the comparative objects. If this is not the case, the condition type used to read the 

comparative conditions can be changed using this method. Notes for Developers 
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 Adjustment Measure (Such as, Modernization, Expert Opinion) 

 Adjustment Measure 

Use 

An adjustment measure groups together data that forms the basis for adjusting conditions. 

Activities 

Adjustment measures are used for adjusting rent for specific rental objects and their contracts. 

The rental objects and contracts are explicitly assigned to the adjustment measure. Depending on your 

Customizing settings, an adjustment using an adjustment measure is possible even if a rule that allows 

the adjustment is not explicitly assigned to the concrete rental object or contract. 

The adjustment measure is always assigned to an adjustment rule of the TASK method. You 

assign this rule is to an adjustment measure type in the Define Parameters for Adjustment Rule IMG 

activity. The adjustment measure type specifies how the system calculates the condition values for the 

assigned objects. 

These are the adjustment measure types in the system: 

- MO - Modernization  

There is a rule (TASKMO) defined for this adjustment measure type in standard Customizing. This 

rule makes it possible for you enter the costs of modernization and the affected rental objects in the 

adjustment measure. Eleven percent of these costs (based on residential/usable space) are passed on 

to tenants in the form of an annual rent increase. This applies to all rental objects and lease-outs that 

are included in the adjustment measure. You can change the percentage rate and measurement type 

for the distribution in Customizing. 

You can also use this adjustment measure type for other adjustments that require distributing a base 

amount using a measurement type. Therefore, standard Customizing also includes another 

adjustment rule (TASKSA), which makes it possible to adjust the condition for maintenance 

reserves for assessment contracts for condominium assessments. 

- EO - Expert Opinion  

There is a rule (TASKEO) defined for this adjustment measure type in standard Customizing. This 

rule makes it possible to individually set a new rent amount for each rental object and each contract 

that is assigned to the adjustment measure. 

- FR - Custom Measure 

There is a rule (TASKFR) defined for this adjustment measure type in standard Customizing. You 

can use this rule, for instance, to copy externally calculated rents for rental objects and contracts to 

the system, and then to adjust the values using a rent adjustment. 

- Adjustment based on cost efficiency analysis: 
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- MC - Main cost efficiency analysis 

- PC - Partial cost efficiency analysis 

- AC - Additional cost efficiency analysis 

These adjustment measure types are used to comply with German tenancy law and are only applicable 

in Germany. They make it possible to adjust rent for publicly subsidized apartments using the cost 

efficiency analysis method. The main cost efficiency analysis is optional, since it only groups together 

several partial and additional cost efficiency analyses. The partial cost efficiency analysis defines the 

total costs and the financing plan for all objects involved. The additional cost efficiency analysis is 

used for handling subsequent changes, for example, those due to modernization or renovations. 

These adjustment measure types are specifically designed to meet the requirements of German 

tenancy law, and are not suited for other types of measures. 

 Master Data 

 Settings per Adjustment Measure Type 

 Define Possible Statuses of Adjustment Measure for Each Measure Type 

Use 

Here you specify the possible statuses for the following parts of the cost efficiency analysis: 

- Main cost efficiency analysis 

- Partial cost efficiency analysis 

- Additional cost efficiency analysis The status is informational only. 

Example 

For a main cost efficiency analysis, you could enter approval statuses, such as Not Approved or Approved. 

For a partial cost efficiency analysis, you could define processing statuses, such as Requested or  

Deactivated. 

 Define Possible Earmarking of Measure for Each Measure Type 

Use 
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For your own information, you can specify here the purpose that a rental object is supposed to fulfill within 

various cost efficiency analyses. 

Example 

You could define these purposes: Public Housing for Seniors or General Public Housing. 

 Specify Field Status Variants 

Use 

Here you specify the field status variants that should be available when you create an adjustment 

measure. You assign the field status variant to the adjustment rule. This determines which fields are 

ready for input in dialog processing for the adjustment measure. 

Activities 

- Enter a name for the field status variant. 

- In addition, specify the following: 

- Enter the adjustment measure type that you want to use this field status variant for. You have to 

define at least one field status variant for each adjustment measure type that you need. 

- Enter the BDT screen sequence that you want to use this field status variant for. 

- Enter the text you want to appear when you assign the field status variant to an adjustment rule in 

Customizing. 

In the  Define Field Status IMG activity, define the field status of the individual fields. 

 Define Field Status 

Use 

For field status variants that have already been defined, you specify which fields are ready for input and 

which fields are not needed. 
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The settings you make here reduce unneeded data on the dialog screens and help to improve clarity. 

Requirements 

You defined the field status variants. 

Standard settings 

In the standard system, there are predefined field status variants for modernization measures and for 

adjustment based on expert opinion. 

 Settings per Adjustment Rule of Measure 

 Assign Measurement Types to Adjustment Rule 

Use 

In the previous IMG activity Define Parameters for Adjustment Rule, you assigned measurements for 

cost distribution and the amenities level factor to adjustment rules. In addition to those assignments, here 

you can assign additional measurements to the adjustment rules for the calculation of expenses. 

You need this additional measurement in this case: For calculating an expense item, you do not want to 

use the standard measurement value for cost distribution of an object or object group, but instead you want 

to use only the measurement value that is assigned to the adjustment measure for this object or object 

group. 

Example: 

For certain objects, you want an expense item to be calculated based on the number of persons in the 

household. The number of persons in the household is entered on the adjustment measure (independent of 

the object). 

Requirements 

You defined measurement types. 

Activities 

For each measurement type and adjustment rule, enter if the object is allowed for contracts and what the 

object reference is. 
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 Usage Group 

 Define Usage Groups 

Use 

Certain adjustment methods are only allowed to be used for certain rental objects. For example, rent 

adjustments based on cost efficiency analysis are only intended to be used for publicly subsidized housing. 

You have to define a usage group here for each grouping of rental objects that you need. In the next IMG 

activity, Assign Usage Types to Usage Group, you then assign the criteria ( usage type and/or fixtures 

and fittings characteristic) that are used for selecting the affected rental objects. 

Example 

 Publicly subsidized apartments 

 Privately financed apartments 

 Parking spaces 

 Assign Usage Types to Usage Group 

Use 

Here you assign criteria to your usage groups. These criteria can be used for selecting rental objects. The 

criterion can be one or both of the following: 

- The usage type of the rental object 

- A (fixtures and fittings) characteristic that has to be entered on the rental object 

Requirements 

If you want to select rental objects by fixtures and fittings characteristics, then you have to have created 

at least one fixtures and fittings characteristic that expresses both the existence of the public subsidy and 

its duration. 

Activities 
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If the usage group is characterized by several usage types or several characteristics, then you have to 

define one record for the usage group for each usage type or characteristic. Assign the fittings and fixtures 

characteristics that are used for the public subsidy criteria. 

Example 

For example, if you want to allow all usage types or all characteristics, then enter them here. 

 Define Parameters for Adjustment Rule 

Use 

You can specify here how the values entered in the actual adjustment method are included in the 

calculation of the new rent. This applies to adjustment rules using the Adjustment Measure method. 

Requirements 

You defined an adjustment rule that is based on the Adjustment Measure method, and set up all cross-

method parameters for it. Create an entry here for each adjustment rule that you assigned to the 

Adjustment Measure (TASK) method. Specify the values for the parameters explained below. 

Activities 

Specify the following parameters for the adjustment rule: 

- Enter the adjustment measure type. 

The adjustment measure type determines which field status variants are possible. In addition, the 

method implemented for the calculation of the new condition amount can be dependent on this 

adjustment type. 

- Enter the field status variant that you want to use for this adjustment measure. 

- Enter the Percentage Surcharge, and the Time in Months that this percentage relates to. For 

example, in the case of a modernization, only part of the value entered on the adjustment measure 

might be used for calculating the new condition amount. If that is the case, then you enter the 

percentage rate to be used here. 

- Enter the Measurement Type that you want to use for distributing an overall total amount to all 

rental objects involved in the adjustment measure.  You do not need to enter a measurement type 

unless you want to distribute an overall value.  If you do want to distribute, then you also need to 

enter the unit of measurement. The system may have to convert to this unit of measurement. 

- Specify the Rule for Limit that the system uses when calculating the amount that acts as the basis for 

determining an upper limit for the new condition amount. For example, you could specify that a rent 
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is calculated based on the representative list of rents. Using the Factor for Limiting Amount, you 

can specify that the upper limit that is calculated is weighted with this factor. 

For example, you choose the Representative List of Rents rule and a factor of  for an adjustment due 

to modernization. This ensures that the new rent is no more than  % above the standard local rent as 

defined by the representative list of rents. 

- You use the Adjustment Type to specify what objects are adjusted. Usually you enter only rental 

objects on the adjustment measure. The system can, for example, then perform the adjustment for 

the valid lease-out contract and the object (or for the assessment contract and the object). 

- In the Currency field, you specify the default value for the currency of the amounts that are entered 

on the adjustment measure. 

- Set any other indicators that you want to apply for this adjustment rule. For information on these 

indicators, see the F Help. 

 Structuring of Costs 

 Define Costs Item Groups 

Use 

You can break down costs of an adjustment measure further into costs items. This also applies to 

individual costs for each object affected by the adjustment. This breakdown can be helpful in 

correspondence, allowing you to provide a more detailed account of which costs are considered. 

You assign each costs item to only one costs item group. The costs item group is used to group costs 

items together when you enter them. The costs item group is also output in correspondence. You can also 

have the system output subtotals for each costs item group. 

In addition, by assigning costs item groups to an adjustment rule, you can specify which costs items are 

allowed to be used for breakdowns for that adjustment rule. 

Activities 

If you want to use further breakdown by costs items, then specify your costs item groups here. Then 

assign costs items to the costs item group in the Define Costs Items and Assign Them to a Group IMG 

activity. 

 Define Costs Items and Assign Them to a Group 

Use 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 273 

Here you define the costs items that you want to use to break down an adjustment measure further. And you 

assign each costs item to only one costs item group. 

Requirements 

You defined the costs item group. 

Activities 

Define costs items and assign them to a costs item group. 

 Assign Costs Item Group to Adjustment Rule 

Use 

Here you define which adjustment rules are allowed to use which costs items. 

Requirements 

. You defined an  adjustment rule that uses the Adjustment Measure (TASK) method. . You 

defined  costs item groups and  costs items, and assigned them to each other. 

Activities 

If you have adjustment rules, and you want to be able to break down their adjustment measures based on 

costs items, then assign them the necessary costs item groups. 

If you want a costs item group to apply for all adjustment measures of an adjustment measure type, then 

leave the adjustment rule blank, and enter only the adjustment measure type and the costs item group. 

For the adjustment measures, you can assign all costs items that belong to groups that are assigned to the 

adjustment measure by means of the adjustment rule or adjustment measure type. 
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 Cost Efficiency Analysis 

 Adjustment Reason for Cost Efficiency Analysis 

Use 

Example 

There are three expense item changes planned for January ,  after the time period restricted by law (due to 

public funding) expires on December , : 

1. Adjustment of flat payments for maintenance 

2. Adjustment of flat payments for management costs 

3. Adjustment of borrowing costs 

- For adjustments after the expiration of the restricted time period, you can  not count the 

expense item change (), whereas you would be required to count the flat payments ( and ). 

Therefore, you have to create a statistical condition type with a condition type that is not 

countable. The condition amount should be the same as the increase of the conditions that result 

from the adjustment of the borrowing costs (). 

- In addition, the earliest the adjustment can be performed is twelve months after the adjustment 

of the flat payments takes effect (from  and ). 

Therefore, you have to ensure that the subsequent adjustment for the corresponding condition is 

not made before the expiration of the twelve months after the adjustment of the flat payments 

(from  und ). 

In this case, you would create two adjustment reasons for the cost efficiency analysis. 

You assign the flat payment expenses ( and ) to the first reason and the expenses 

of type  to the second reason. By doing so, you can then group and total the adjustment amounts 

resulting from the expenses separately in reports. 

Note: 

Currently there are no automatic functions in the system for the transition from "publicly subsidized 

accommodation" (adjustment using cost efficiency analysis) to "privately-financed accommodation" 

(adjustment, for example, using comparative rent). 
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 Financing Items 

 Define Financing Item Groups 

Use 

Here you set up the structure for the financing of your total costs. To do so, you define groups that are 

used to categorize your individual financing items. 

The following groups are possible: 

- Outside funds 

- Construction subsidies 

- Owner contribution 

- Substitute for owner contribution 

You have to assign one of the predefined financing types to the appropriate group. 

The financing type specifies the relationship between the financing items of the financing plan and the 

expense items of the current expenses. The possible values are: 

- External Financing 

The financing items in this category can be transferred to the borrowing costs under current 

expenses. 

- Owner Financing 

The financing items in this category can be transferred to the costs of equity under current expenses. 

- Other 

This data is informational only and is not related to the current expenses by any system functions. 

You can also specify the sequence in which the financing item groups with their individual financing items 

are displayed in the cost efficiency analysis. 

 Define Financing Items and Assign to Financing Item Group 

Use 

The financing items define the various forms of financing. The following financing items are possible: 

- Loans 

- Mortgages 

- Construction subsidies 

- Owner contributions 

- Tenant loans 
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Requirements 

You defined the financing item group. 

Activities 

To structure the data, you assign each individual financing item to only one financing item group. 

You can also specify the sequence in which the individual financing items are listed in the financing item 

group. 

 Assign Financing Item Group to Adjustment Rule 

Use 

The assignment you make here specifies the adjustment measures for cost efficiency analysis for 

which you want to allow financing data to be entered. You specify this by assigning a financing item group 

to a measure type in conjunction with an adjustment rule. 

If you want a financing item group to apply for all adjustment measures of an adjustment measure type, 

then leave the adjustment rule blank, and enter only the adjustment measure type and the financing item 

group. 

In this way you can exclude individual financing groups from being included in certain types of cost 

efficiency analysis. (This is useful, for example, if you do not want certain subsidies to be included in the 

additional cost efficiency analysis. 

Requirements 

1. You defined an adjustment rule that uses the adjustment measure (TASK) method. 

2. You defined financing item groups and financing items, and assigned them to each other. 
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 Expense Items 

 Define Expense Item Groups 

Use 

You use expense item groups to structure your current expenses. 

Activities 

Keep in mind that it is possible to link current expenses to items of the financing plan. You establish this 

link by assigning financing item groups, or by assigning a financing type to an expense item group. 

You thereby have two options. You can assign a financing item group to one expense item group, or you 

can make the assignment of several financing item groups to an expense item group by assigning a 

financing type. 

Establishing this link is only allowed for the financing types Owner Financing and External Financing, 

since the link is only helpful in these two cases. Any other assignments are not allowed. 

For each expense group, you can also specify whether the system adds a surcharge to the expense amount 

to cover risk of rent loss as a standard setting. In the cost efficiency analysis, you can still decide on an 

individual basis whether a risk of rent loss surcharge should be applied or not. 

You can also specify the sequence in which the expense groups with their individual expense items are 

displayed in the cost efficiency analysis. 

Example 

The expense item groups that are most commonly used are: 

- External Financing Costs 

- Owner Financing Costs 

- Depreciation 

- Management Costs 

- Maintenance Costs 
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 Define Expense Items and Assign Them to Expense Item Groups 

Use 

You can use expense items to define all the types of expense necessary for cost efficiency analysis. To 

classify and structure them, you assign the expense items to expense item groups. 

For each expense item, you can also specify if the item is defaulted in the cost efficiency analysis under 

current expenses. 

You can also specify the sequence in which the individual expense items are listed in the expense item 

group. 

 Assign Expense Item Group to Adjustment Rule 

Use 

The assignment you make here specifies the adjustment measures for cost efficiency analysis for which you 

want current expenses to be entered. You specify this by assigning an expense item group to a measure type 

in conjunction with an adjustment rule. 

Requirements 

1. You defined an adjustment rule that uses the Adjustment Measure (TASK) method. 

2. You defined expense item groups and expense items, and assigned them to each other. 

Activities 

If you want an expense item group to apply for all adjustment measures of an adjustment measure type, 

then leave the adjustment rule blank, and enter only the adjustment measure type and the expense item 

group. 

In this way you can exclude individual expense groups from being included in certain types of cost 

efficiency analysis. 

 Assign Costs Item to Expense Item 

Use 
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This assignment makes it possible for you to determine current expenses based on certain costs related to 

construction. 

Requirements 

You specified costs items and expense items. 

Activities 

To each expense item, assign all costs items that are necessary for calculating the particular expense. You 

then use these items in the calculation algorithm of a calculation rule that you define in a separate step. 

Example 

You want the system to calculate expense for depreciation as % of building costs. To enable the system to 

determine the total costs for the building, assign all costs items for building costs to the "Building 

Depreciation" expense item. 

 Specify Calculation Formula for Expense Items 

Use 

You can use a calculation formula to define how the individual expense items are determined within a cost 

efficiency analysis. 

Important: Since, according to German law, the flat fees for management costs and maintenance costs 

have to be adjusted at regular intervals, we recommend that you specify the calculation formulas for 

expense items on a time-dependent basis. You can do so in the IMG-Aktivität Specify Time-Dependent 

Calculation Formula for Expense Items IMG activity. However, it is not necessary to make a general 

changeover using this activity. 

The calculation formula specifies how the system calculates the  amount per year and the amount per area 

and month of the current expenses. 

A blank calculation formula is automatically assigned to each expense item. You then have to modify the 

calculation formula to meet your needs. However, you do not have to enter a special calculation formula 

for expenses that are derived from financing items. 

You can also specify if expenses are always entered manually, or if they are based on a price per area, a 

price per object, or a percentage rate (for instance, for depreciation). In addition, there is a rule that can be 
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used for determining the risk of rent loss for an expense item. You can also enter your own calculation 

methods using a BAdI implementation. 

The following calculation methods are available: 

- MEAS - Annual value per measurement 

The  amount per year is calculated by multiplying the  nominal amount by the object area of all 

objects that were assigned to the given expense item. (You can assign one of the following to the 

expense items: all rental objects of the measure, an object group or one rental object.) 

- MEAM - Monthly value per measurement 

The amount per year is calculated by multiplying the  nominal amount by the object area of all 

objects that were assigned to the given expense item, and then multiplying this product by twelve. 

- COUN - Number of objects 

The  amount per year is calculated by multiplying the  nominal amount by the number of all the 

objects that were assigned to the given expense item. This number is: for a measure, all rental 

objects of the measure; for an object group, all rental objects in the object group; and for a rental 

object, the number is one. 

- COOB - Object number parameter 

The amount per year is calculated by multiplying the nominal amount by the by the number of all 

objects that were assigned to the calculation rule in the first parameter. For a measure, this is is all 

rental objects of the measure; for an object group it is all rental objects of the object group; and for 

a rental object the number is . 

- PERC - Percentage 

The amount per year equals the percentage share of the nominal amount you enter. However, if a 

costs item is assigned to the expense item, then the system uses the total of the costs item as the basis 

for the calculation. 

- RORL - Risk of rent loss 

The amount per year equals the percentage of the risk of rent loss (RRL) applied to the total of all 

relevant expenses.  The relevant expense items are those for which the Risk of Rent Loss indicator 

was set for the expense item group. 

Keep in mind that the system calculates the risk of rent loss using a particular type of percentage 

calculation. For a risk of rent loss of %, this means that the total cost rent is %. The total of current 

expenses therefore equals % and the risk of rent loss equals %.  This also means: If the risk of rent loss 

is considered, then the current expenses increase by  %. 

The amount of the risk of rent loss is not entered in the calculation formula. Instead, it is entered 

directly in the parameters of the adjustment measure. 

- MANU - Manual 

The amount per year equals the nominal amount. 

- CUST - Custom 

The calculation is made using a BAdI implementation. 

You can also specify (in the detail screen) if the values determined by the calculation formula are allowed 

to be changed in the given cost efficiency analysis. 
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Example 

To calculate flat payments for management costs of  per apartment, enter the following: 

Choose the expense item and assign a calculation formula for Number of Objects. Confirm your entries. 

Enter a price per object of . 

If this expense item is used in a cost efficiency analysis, then the system automatically determines the 

amount of the expense by multiplying the number of objects assigned to this expense item by . 

 Specify Time-Dependent Calculation Formula for Expense Items 

Use 

You can use a calculation formula to define how the individual expense items are determined within a cost 

efficiency analysis. 

Since, according to German law, the flat fees for management costs and maintenance costs have to be 

adjusted at regular intervals, you can assign the calculation formula on a time-dependent basis. This 

enables you to reflect changes that are due on a key date. 

Important: If you do not make any settings for key date and expense items in this IMG activity, the 

settings from the  Specify Calculation Formula for Expense Items IMG activity remain in effect. 

However, we recommend that you make time-dependent settings here for the calculation formula. 

The calculation formula specifies how the system calculates the  amount per year and the amount per area 

and month of the current expenses. 

A blank calculation formula is automatically assigned to each expense item. You then have to modify the 

calculation formula to meet your needs. However, you do not have to enter a special calculation formula 

for expenses that are derived from financing items. 

You can also specify if expenses are always entered manually, or if they are based on a price per area, a 

price per object, or a percentage rate (for instance, for depreciation). In addition, there is a rule that can be 

used for determining the risk of rent loss for an expense item. You can also enter your own calculation 

methods using a BAdI implementation. 

The following calculation methods are available: 

- MEAS - Annual value per measurement 

The  amount per year is calculated by multiplying the  nominal amount by the object area of all 

objects that were assigned to the given expense item. (You can assign one of the following to the 

expense items: all rental objects of the measure, an object group or one rental object.) 

- MEAM - Monthly value per measurement 

The amount per year is calculated by multiplying the  nominal amount by the object area of all 

objects that were assigned to the given expense item, and then multiplying this product by twelve. 

- COUN - Number of objects 
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The  amount per year is calculated by multiplying the  nominal amount by the number of all the 

objects that were assigned to the given expense item. This number is: for a measure, all rental 

objects of the measure; for an object group, all rental objects in the object group; and for a rental 

object, the number is one. 

- COOB - Object number parameter 

The amount per year is calculated by multiplying the nominal amount by the by the number of all 

objects that were assigned to the calculation rule in the first parameter. For a measure, this is is all 

rental objects of the measure; for an object group it is all rental objects of the object group; and for 

a rental object the number is . 

- PERC - Percentage 

The amount per year equals the percentage share of the nominal amount you enter. However, if a 

costs item is assigned to the expense item, then the system uses the total of the costs item as the basis 

for the calculation. 

- RORL - Risk of rent loss 

The amount per year equals the percentage of the risk of rent loss (RRL) applied to the total of all 

relevant expenses.  The relevant expense items are those for which the Risk of Rent Loss indicator 

was set for the expense item group. 

Keep in mind that the system calculates the risk of rent loss using a particular type of percentage 

calculation. For a risk of rent loss of %, this means that the total cost rent is %. The total of current 

expenses therefore equals % and the risk of rent loss equals %.  This also means: If the risk of rent loss 

is considered, then the current expenses increase by  %. 

The amount of the risk of rent loss is not entered in the calculation formula. Instead, it is entered 

directly in the parameters of the adjustment measure. 

- MANU - Manual 

The amount per year equals the nominal amount. 

- CUST - Custom 

The calculation is made using a BAdI implementation. 

You can also specify (in the detail screen) if the values determined by the calculation formula are allowed 

to be changed in the given cost efficiency analysis. 

 Assign Expense Items to Years Ready for Occupancy 

Use 

German law (Second Rent Calculation Ordinance) specifies how much can be charged for 

maintenance costs in relation to the number of years the real estate object has been ready for occupancy. 

In this IMG activity, you assign the number of years ready for occupancy to the appropriate expense items. 

Requirements 
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You defined the necessary expense items according the requirements of German law under Define 

Expense Items and Assign Them to Expense Item Groups. And you assigned them to calculation formulas 

under  Specify Time-Dependent Calculation Formula for Expense Items. 

 Assign Condition Types to Expense Item Group 

Use 

For the cost efficiency analysis, just as for all RE-FX adjustment rules, you enter the conditions to be 

adjusted in Customizing in the Define Rounding, Change Reason, and Classification (Surcharges) IMG 

activity. However, it is also possible to enter a different condition for each expense item group. 

Activities 

For more information: 

For information on passing on the expense item, see message REAJBD . For information on checking 

assignments of expense items and financing items, see message REAJBD . 

 Implement Enhancement ( BAdI ) 

 Calculation Formula 

Use 

The Business Add-In supports enhancements to the standard functions of calculations for current 

expenses of a cost efficiency analysis. Notes for Developers 
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 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 
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 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields 

of a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, and 

display fields in display mode.) If it is not possible to make a setting for a field group, then the system 

determines how the field is treated (usually dependent on the situation, or on the contents of other 

fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Sections 

Verwendung 

Hier legen Sie fest, welche Sichten zu einem Abschnitt zusammengefasst werden sollen. Ein Abschnitt wird 

auf dem Bildschirm durch einen Rahmen gekennzeichnet. Felder, die logisch zusammengehören, sollten zu 

einem Abschnitt zusammengefasst werden. 

Standardeinstellungen 

Lassen Sie die Standardeinstellung unverändert. Sie können neue Abschnitte definieren, um entweder von 

SAP ausgelieferte Sichten anders zusammenzufassen oder um eigene Felder im Stammdatendialog 

einzubinden. 

Kopieren Sie dazu einen vorhandenen Abschnitt in den Kundennamensraum (Y* bzw. Z*) und ordnen 

Sie dann die gewünschten Sichten dem Abschnitt zu. Die Positionsnummer gibt dabei an, in welcher 

Reihenfolge die Sichten in dem Rahmen angeordnet werden. Aus technischen Gründen muss die 

Positionsnummer für kundeneigene Zuordnungen vom Abschnitt zur Sicht im Kundennamensraum liegen 

(sie darf nicht auf  enden). 

Dies ermöglicht Ihnen, auch in SAP-Abschnitten Ihre eigenen Sichten einzubinden. Wählen Sie einen 

Abschnitt aus, wählen Sie im Navigationsbaum Abschnitt -> Sichten und ordnen Sie die gewünschte Sicht 

unter einer entsprechenden Positionsnummer dem Abschnitt zu. 
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 Views 

Verwendung 

Hier legen Sie fest, welche Feldgruppen zu einer Sicht (entspricht einem Teilbildschirm, technisch ein 

Subscreen) zusammengefasst werden sollen. Fassen Sie hier die Feldgruppen zusammen, die bei einer 

Prüfung zusammengehören. 

Beispiel 

Eine Feldgruppe mit einem Gültig-Ab-Datum und eine Feldgruppe mit einem Gültig-Bis-Datum, die in 

einem Modul gegeneinander geprüft werden sollen. 

Das Prüfmodul steht in den Detaildaten bei "Funktionsbaustein - Nach der Ausgabe". 

Standardeinstellungen 

Ändern Sie die Standardeinstellung nicht. Nehmen Sie nur Änderungen vor, wenn Sie neue eigene Felder 

im Stammdatendialog einbinden möchten. 

Kopieren Sie dazu eine vorhandene Sicht in den Kundennamensraum (Y* bzw. Z*) und passen Sie die 

Eigenschaften der Sicht (Detailscreen beachten) entsprechend an. Ordnen Sie dann die gewünschten 

Feldgruppen der Sicht zu. Sie können sowohl eigene Feldgruppen als auch von SAP ausgelieferte 

Feldgruppen Ihrer Sicht zuordnen. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 
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 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 
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 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of adjustment measures. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 Modify Standard Calculation Rules for Adjustment 

 Create Adjustment Control Rule 

Definition 
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For special calculations in condition adjustments, you can define an adjustment control using a formula 

editor. (Refer to the Define Adjustment Control Differing from Standard IMG activity.) For example, you 

could make the rent dependent on parameters that do not influence rent in the standard system. 

In order to be able to use a set of rules for adjustment control with more than one adjustment rule, you store 

the set of rules with a key as an adjustment control rule. Then you assign this adjustment control rule to the 

actual adjustment rule that is used for adjusting the condition ( see Assign Adjustment Control Rule to 

Adjustment Rule/Rep. List of Rents). 

Activities 

Specify the following for the adjustment control rules you need: 

- Name 

- Language for the language-dependent ID of the variables. 

- If you first want to assign a default comment to each row of the control table. 

- If you only want to assign default comments for fulfilled block conditions. 

- If you also want to assign a block info to the default comment (the block and row number) in the 

comment. 

Here you can also see how the default comment will be output. 

 Assign Adjustment Control Rule to Adjustment Rule/Rep. List of Rents 

Use 

For each adjustment rule, in which the calculation of the adjustment amount should be different from the 

standard, you have to assign an adjustment control rule. The adjustment control rule is then executed in 

addition to the adjustment rule. 

- You can use the representative list of rents as a differentiation characteristic. Entering a 

representative list of rents only makes sense for a representative list of rents method. The adjustment 

control rule is only applied if the entered representative list of rents is used. 
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- If you do not enter a representative list of rents for an adjustment rule, then the system uses the 

adjustment control rule for all adjustments that use that adjustment rule. 

 Define Variables for Adjustment Control 

Use 

The calculation formulas of the representative list of rents are found in the system in the form of 

conditions and actions. These conditions and actions work with variables that you define here. 

Activities 

1. Choose a technical name that uniquely identifies the variable (also refer to the example below). 

Note: Make sure you use the customer name space for your own variables. 

2. Choose the variable type, for example: 

- Character string (for example, name of representative list of rents) -

 Boolian value (true or false)... 

3. Enter the number of decimal places and specify if the variable can be changed. 

4. Specify if the variable is indexed. This means that a block that uses this kind of variable can be called 

more than once by the system. 

5. Specify if the variable can be used for interpolation 

6. Enter the variable name for the formula (also refer to the example below). Note: Make sure you use the 

customer name space here as well. 

7. Assign the variable to the adjustment method in which you want it to be used. 

8. Assign the variable to a variable class. 

Example for Adjustment Control: 

According to the definition in the representative list of rents, all fixtures and fittings characteristics that 

were assessed with less than  EUR/m are to be ignored. The number of these characteristics should be 

counted (for later calculations). 

Meaning of the variables: 

Technical Var. Name Formula Name Description 

FFCHRLRAAMTAR AUSMERKMALBFE  

characteristic (area price ( surcharge/reduction )) 

Value that is considered for 

FFCHFIXFITCHNOTUSEAUSMERKMALNBER calculation Ignore characteristic during 
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XNUMC XN Numerical auxiliary variable 

This could be achieved using the following block: 

BlockNo RowNo Variable (Formula Name) Formula 

  AUSMERKMALBFE <  

  AUSMERKMALNBER TRUE 

  XN XN +  

 Define Adjustment Control Differing from Standard 

Use 

You represent the calculation formulas of the representative list of rents, without using ABAP program code, 

in the form of conditions and activities. 

A condition describes when a specific situation exists and an activity describes how as a result of this, the 

system proceeds with the values of the variables. A condition and the following activities are combined in 

blocks. 

Condition: 

A condition is a mathematical formula in which the arithmetic and logical operators can be linked 

to variables provided by the system. They must be formed so that they always return a Boolean 

result (that is, true or false). 

For example, if the building age class is defined in the variable BAUALTKLA and the building year 

in the variable BAUJAHR, then a condition could be BAUALTKLA = '' AND BAUJAHR > . 

This would then be fulfilled if the building age class of the apartment equals  and the building year 

is greater than . 

Activity: 

An activity is a pair of a variable and a mathematical formula (or constants).The formula can 

have any value (number, character string, Boolean value), that is allocated when you execute the 

respective variable. 

Thus, the activity RENT_NEW , RENT_NEW  +  (< variable, formula for 

variable>) would increase the new rent per area unit by one. 

The simplest case of a formula is the allocation of a constant to a variable. The activity RENT_NEW , 

would set the new rent per area unit to the value . 

Block: 

You combine a condition with as many activities as required in a block. When the condition of the 

block is fulfilled, then all its activities are executed one after the other. The sequence of the blocks 

is defined by a block number, which can be freely allocated. The sequence of activities within a 

block are also defined by a row number, which can be freely allocated and is block internal. The 

condition is independent of the row number. It is always checked first. 

Any number of blocks can be assigned to each adjustment control rule. These are processed sequentially 

during an adjustment (the adjustment control rule is assigned to an adjustment rule) for each rental object 

or contract to be adjusted. 

Requirements 
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You have created an Adjustment Control Rule. 

Activities 

- Allocate a block and row number. 

- Specify whether the following should apply to the row: 

- The row is a comment row (row is not used for evaluation) 

- The default for comments, which has possibly been set on the adjustment control rule, should be 

switched off 

- You normally formulate a condition first. The condition is always checked first, even if this has 

a higher row number than the activities. 

- For a condition in the Formula field, define a mathematical formula, which should be applicable 

or not appliacable for the condition, for example, BAUALTKLA = '' AND BAUJAHR > . 

- For an activity, you specify the formula name of the variable, which you want to use in the 

calculation, in the Variable column. All existing variables are described in the Define Variables 

for Adjustment Control IMG activity. 

- For the variable, specify the mathematical formula that should be executed. If certain partial 

expressions are used a lot in a formula, functions (macros) that can be parameterized can be 

defined for this. They are either stored in the TFKT table or in a table that the user created, 

which has the same structure. For more information, see Macros. 

- Enter a user-defined text for the variable in the field variable number  and . This text should be 

used in the default comment. 

- Specify a message ID, type, and number for this block. 

For more information, special features, and tips & tricks on jumps, typing, and character strings, see 

Special Features on Control Table. 

Example for Adjustment Control: 

According to the definition in the representative list of rents, all fixtures and fittings characteristics that 

were assessed with less than  EUR/m are to be ignored. The number of these characteristics should be 

counted (for later calculations). 

Meaning of the variables: 

Technical Var. Name Formula Name Description 

FFCHRLRAAMTAR AUSMERKMALBFE  

characteristic (area price ( surcharge/reduction )) 

Value that is considered for 
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FFCHFIXFITCHNOTUSEAUSMERKMALNBER calculation Ignore characteristic during 

XNUMC XN Numerical auxiliary variable 

This could be achieved using the following block: 

BlockNo RowNo Variable (Formula Name) Formula 

  AUSMERKMALBFE <  

  AUSMERKMALNBER TRUE 

  XN XN +  

 Implement Enhancements for Condition Adjustment ( BAdI ) 

 General Rent Adjustment 

Use 

The Business Add-In (BAdI) supports enhancements to the standard functions of adjustments of conditions 

without your writing program code. 

For information about possible enhancement scenarios, see the Overview of Enhancement Methods for 

Master Data Objects and the Real Estate Contract. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

For information on using BAdIs, see this documentation. 

The following methods exist: 

- GET_ADJUSTMENT_VALUE  

Gets the value of a variable in the control table 

- CAPPING 

Performs capping 

- ADJUSTMENT 

Performs the adjustment 

- MODIFY_ADJUSTMENT 

Modifies the adjustment 

- MODIFY_ADJUSTMENT_CEA  

Modifies an adjustment of a cost efficiency analysis ( Germany ) 

- AFTER_STORE 

Performs additional actions after saving 

- GET_ADJMRULE_FOR_INSERT 

Gets the possible adjustment methods to be added 
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- GET_FIELDCATALOG 

Gets the field catalog for the adjustment transactions 

- GET_FIELDCATALOG_VALUE 

Gets the value for a field catalog entry 

- HIDE_FIELDCATALOG 

Hides certain field catalog columns (for improved performance) 

- MODIFY_TCODE 

During an indirect call of the adjustment, serves to put the transaction code into effect 

- GET_BEHAVIOR_SUBSEQ_COND 

Serves to control the adjustment frequency for adjustments of subsequent conditions. Using this 

method, you can specify using the CF_NO_RHYTHM parameter, if the system should redetermine 

the adjustment date (standard behavior) or not (CF_NO_RHYTHM = abap_true) when the 

subsequent condition becomes the condition to be adjusted. 

- AFTER_ACTIVATION 

Makes it possible to execute follow-up actions on an object after activation of an adjustment 

- AFTER_REVERSAL 

Makes it possible to execute follow-up actions on an object after reversal of an adjustment 

These methods are called automatically during standard processing of the adjustment of conditions. If an 

implementation exists, the methods are always called in addition to standard system behavior. The standard 

behavior of the basic actions is not replaced. 

Warning 

The implementation of the methods has to be independent of the interface. It must not contain any 

COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages using the 

MESSAGE statement is not allowed. 

Method description 

- GET_ADJUSTMENT_VALUE 

This method gets the value of a variable in the control table. The following parameters are used with 

this method: 

- IO_CONTRACT and IO_RENTAL_OBJECT 

These parameters specify whether or not the condition to be adjusted is a contract condition. If 

the condition is a contract condition, then the parameter IO_CONTRACT is filled. Otherwise 

the IO_RENTAL_OBJECT parameter has a value. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IF_FIRST_CALL 
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This parameter indicates whether the method is being called for the first time. If the parameter has 

a value, then this is the first call of the method. 

- ID_VALIDFROM_NEW 

The parameter contains the newly calculated Valid-From date of the condition. 

- ID_VARIABLE and CD_ADJUSTMENT_VALUE 

The ID_VARIABLE parameter contains the names of the variables from which the 

CD_ADJUSTMENT_VALUE parameter requested the value. 

- IT_ADJUSTMENT_VALUE 

This parameter transfers all variables of the method as well as their current values. Then the 

returned messages (CT_MESSAGE parameter) are displayed in the same list with the messages 

from standard processing. 

- CAPPING 

This method performs standard rent capping. The following parameters are used with this method: 

- IO_CONTRACT 

This parameter contains the contract object to be adjusted. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IF_BEFORE_STANDARD 

The parameter has a value before standard capping is performed. 

- IF_AFTER_STANDARD 

This parameter has a value after standard capping was performed. 

- CS_RECORD 

The parameter modifies the adjustment. 

- CF_EXIT_PROCESSED 

This parameter contains the information that the capping was executed by the method. Then the 

returned messages (CT_MESSAGE parameter) are displayed in the same list with the messages 

from standard processing. 

- ID_ADJMRULE and ID_ADJMSUBRULE 

The ID_ADJMRULE (combined adjustment rule) and ID_ADJMSUBRULE ( adjustment rule) 

parameters contain the adjustment rules that the implementation is dependent on. 

- ADJUSTMENT 

This method performs the standard adjustment. The following parameters are used with this method: 

- IO_CONTRACT and IO_RENTAL_OBJECT 

These parameters specify whether or not the condition to be adjusted is a contract condition. If 

the condition is a contract condition, then the parameter IO_CONTRACT is filled. Otherwise 

the IO_RENTAL_OBJECT parameter has a value. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 
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- IS_RHYTHM 

This parameter contains the frequency data of the condition being adjusted. 

- ID_VALIDFROM_NEW 

The parameter contains the newly calculated Valid-From date of the condition. 

- CD_UNITPRICE_NEW 

This parameter influences the new unit price. 

- CD_METHREFGUID, CF_ERROR and CF_NO_ADJUSTMENT 

This parameter is used to store a link from the adjustment to specific data ( see 

AFTER_STORE). 

Then the returned messages (CT_MESSAGE parameter) are displayed in the same list with the 

messages from standard processing. 

If the CF_ERROR parameter is set, then there were errors during execution of the adjustment. 

If the CF_NO_ADJUSTMENT parameter is set, then the system could not find an adjustment. 

- CF_EXIT_PROCESSED 

This parameter contains the information that the adjustment was executed by the method. 

- ID_ADJMRULE and ID_ADJMSUBRULE 

The ID_ADJMRULE (combined adjustment rule) and ID_ADJMSUBRULE ( adjustment rule) 

parameters contain the adjustment rules that the implementation is dependent on. 

- MODIFY_ADJUSTMENT 

This method modifies the standard adjustment. The following parameters are used with this method: 

- CS_RECORD_MODIFY 

This parameter modifies the values of the standard adjustment. 

- IS_RECORD 

This parameter returns the adjustment record calculated by the standard adjustment. 

- MODIFY_ADJUSTMENT_CEA 

This method modifies the values of the standard adjustment that were determined using a cost 

efficiency analysis. The following parameters are used with this method: 

- IO_RENTAL_OBJECT 

This parameter contains the rental object to be adjusted. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IT_RECORD_METH_ALL, IT_RECORD_TASK, IT_RECORD_TASK_OBJECT 

These parameters return the method-specific adjustment values. 

- CS_RECORD_METH 

This parameter influences the adjustment results. 

Then the returned messages (CT_MESSAGE parameter) are displayed in the same list with the 

messages from standard processing. 

- GET_ADJMRULE_FOR_INSERT 
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This method influences the number of adjustment rules for assignment within a contract object or 

rental object. 

- IO_CONTRACT and IO_RENTAL_OBJECT 

These parameters specify whether or not the condition to be adjusted is a contract condition. If 

the condition is a contract condition, then the parameter IO_CONTRACT is filled. Otherwise 

the IO_RENTAL_OBJECT parameter has a value. 

- CT_ADJMRULE 

This parameter influences the number of adjustment rules. 

- GET_FIELDCATALOG 

This method specifies additional output columns for the adjustment transactions, thereby determining 

the field catalog. 

The parameters IF_REVERSAL, IF_SIMULATION, IF_CONTINUATION, IF_DISPLAY tell you 

which transaction you are in. 

Using the CT_FIELDCATALOG parameter, you can specify the following additional output columns: 

- GRIDROLL: Data element in customer namespace that contains the documentation 

- GRIDTEXT: Column header 

- GRIDJUST: Setting of column values (R = right aligned, L = left aligned, C= centered) 

- GRIDCHECK: Specification of whether the column values are displayed as checkboxes 

- GRIDPOS: Position of the column 

- GRIDSUM: Specification of whether a column total is output for the given column 

- GRIDTYPE: Data type of the column value (A = amount, D = date field, < blank > = Other) 

- GRIDCOLOR: Color of the column 

- GET_FIELDCATALOG_VALUE 

This method returns values for the field catalog mentioned above. 

- IO_CONTRACT and IO_RENTAL_OBJECT 

These parameters specify whether or not the condition to be adjusted is a contract condition. If 

the condition is a contract condition, then the parameter IO_CONTRACT is filled. Otherwise 

the IO_RENTAL_OBJECT parameter has a value. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IS_RECORD 

This parameter contains the current adjustment record. 

- ID_GRIDROLL 

This parameter indicates the output column for which the value was requested. Note that the 

additional output columns are defined as type CHAR with a maximum length of  characters. 

- HIDE_FIELDCATALOG 
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This method hides certain columns in the adjustment overview. For example, you can hide the partner 

name or address, since determining them is very demanding on performance. 

- AFTER_ACTIVATION and AFTER_REVERSAL 

These methods make it possible to perform follow-up actions on the adjusted object after the 

activation or reversal of an adjustment. 

- IO_OBJECT 

This parameter contains the adjusted object. 

- IS_RECORD 

This parameter contains the current adjustment record. 

- CT_MESSAGE, CF_ERROR, CF_EXIT_PROCESSED 

Using the parameter CF_EXIT_PROCESSED you can specify if the exit was executed. If the 

activation or reversal should be prevented, set the parameter CF_ERROR. The returned 

messages (parameter CT_MESSAGE) are output in the activation log or the reversal log. 

- AFTER_STORE 

Using this method, you can update your own additional, user-defined data. At this point, all 

checks were performed without any errors occurring. No more changes can be made to the data 

of the standard object. 

Only internal errors are now possible here (such as, data inconsistency, errors in the technical 

infrastructure, programming errors). For these exceptional situations, you can output termination 

messages. This is implicitly linked to a resetting of the last database changes (ROLLBACK 

WORK). 

Warning 

You are not allowed under any circumstances to use a COMMIT WORK or ROLLBACK WORK 

statement within this method, since this can cause internal errors. If you use them, data inconsistencies 

can occur. 

Notes for Developers 

 Customer Fields ( Editable ) 

Use 

The Business Add-In (BAdI) makes it possible to add customer-specific input fields and output fields to 

the processing of adjustments. These fields can be displayed for input or output on a detail dialog box for 

the adjustment record on a customer-specific subscreen (maximum size  x ). 

Requirements 

- You must add the customer fields to table VIAJRECORD and structure 

REAJ_RECORD_MODIFY using append. 

- For you to be able to display the customer-specific fields in the adjustment list, you also have to 

implement the BAdI BADI_REAJ_ADJUSTMENT. Direct output of the append fields in the 

adjustment list is not supported, since the system is not able to determine which fields belong to 

which adjustment method. 
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Description of Methods 

- Method GET_EDIT_CONTEXT 

It returns the context for editability. 

- Import IF_CREATE 

This parameter is set, if the adjustment is in create mode (within transactions that can generate an 

adjustment run, such as REAJPR or REAJPRCEA). 

- Import IF_CONTINUE 

This parameter is set, if the adjustment is in continuation mode (within transactions that can 

continue an adjustment run, such as REAJCH or REAJCHCEA). 

- Import IF_REVERSAL 

This parameter is set, if the adjustment is in reversal mode (within transactions that can reverse 

an adjustment run, such as REAJRV or REAJRVCEA). 

- Import IF_DISPLAY 

This parameter is set, if the adjustment is in display mode (within transactions that can display 

an adjustment run, such as REAJSH or REAJSHCEA). 

- Import IF_SIMULATION 

This parameter is set if the adjustment was not yet converted to an update run. 

- Import IS_RECORD 

It contains the relevant process parameters. 

- Changing CD_GUI_PBO and CD_GUI_PAI 

These parameters are used to communicate the PBO/PAI function modules to the adjustment. 

These modules are called either before or after the customer-specific screen is output. They 

supply the relevant data to the adjustment. You can use function group 

REAJ_GUI_ADJM_EDT_TEMPLATE as a template and adjust your copy to suit your needs. 

- Method MODIFY_RECORD 

This method is used to modify the adjustment data at various events. In contrast to the method 

MODIFY_ADJUSTMENT of the BAdI definition 

BADI_REAJ_ADJUSTMENT, you can use MODIFY_RECORD to also modify data during the 

continuation of adjustments. 

- Import IF_CREATE and IF_CONTINUE 

They indicate if the adjustment run is in create mode or in continuation mode. 

- Import IF_AFTER_PREASSIGNMENT 

This parameter is set, if the call takes place after preassignment is made ( immediately before the 

output of the adjustment list). 

- Import IF_BEFORE_STORE 

This parameter is set, if the call takes place before saving. 

- Import IS_RECORD 

It contains the data of the relevant adjustment record. 
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- Changing CS_RECORD_MODIFY 

It is used to return the changed data. 

- Method AFTER_STORE 

It is called after saving to perform additional actions. Using this method, you can update your 

own additional data, which was possibly created during processing and needs to be saved (in 

addition to the append fields mentioned above). 

Parameters of Method: 

- Import ID_PROCESSGUID 

It contains the GUID under which the adjustment run is stored in the tables VICAPROCESSID 

and VIAJRECORD. 

- Import IF_CREATE and IF_CONTINUE 

They indicate if the adjustment run is in create mode or in continuation mode. 

At this point, make sure all checks were already performed without any errors occurring. No 

more changes can be made to the data. Only internal errors are now possible here (such as, 

data inconsistency, errors in the technical infrastructure, or programming errors). For these 

exceptional situations, you can output termination messages. This is implicitly linked to a 

resetting of the last database changes (ROLLBACK WORK). You are not allowed under 

any circumstances to use a COMMIT WORK or ROLLBACK WORK statement within 

this method, since this can cause internal errors. 

- Method IS_ACTIVATE_DISABLED 

It is used to deactivate the activation function. 

- Import IS_RECORD 

It contains the data of the relevant adjustment record. 

- Changing CF_DISABLED 

The function is deactivated if ABAP_TRUE or 'X' is returned. 

- Method IS_ANNOUNCE_DISABLED 

It is used to deactivate the notification function. The parameter is analogous to 

IS_ACTIVATE_DISABLED. 

- Method IS_APPROVAL_DISABLED 

It is used to deactivate the approval function. 

Note that the methods MODIFY_RECORD, IS_ACTIVATE_DISABLED, 

IS_ANNOUNCE_DISABLED, IS_APPROVAL_DISABLED and IS_DECLINE_DISABLED can only 

be called for adjustment records with the status 'No Errors in Calculation' or 'Warnings Exist for 

Calculation'. They are not called for records that are already complete, reversed, or have errors. 

The methods IS_ACTIVATE_DISABLED, IS_ANNOUNCE_DISABLED, 

IS_APPROVAL_DISABLED and IS_DECLINE_DISABLED are only called if the corresponding 

function would be active in the standard system. For example, the activation function is deactivated, if 

there was no approval yet for adjustments requiring approval. In that case, the method 

IS_ACTIVATE_DISABLED is not called. Notes for Developers 
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 Rounding During Adjustment 

Use 

The Business Add-In (BAdI) supports the control of some rounding settings when you execute the 

standard functions for adjustments of conditions without your writing program code. 

Activities 

Create a BAdI implementation and implement the method GET_ROUNDING_CONTEXT. Then activate 

the BAdI implementation. 

For information on using BAdIs, see this documentation. 

Caution: The implementation of the method has to be independent of the interface. It must not contain any 

COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages using the 

MESSAGE statement is not allowed. 

Parameter Description 

- ID_ADJMRULE and ID_ADJMSUBRULE 

The ID_ADJMRULE (combined adjustment rule) and ID_ADJMSUBRULE (adjustment rule) 

parameters contain the adjustment rules that the implementation is dependent on. 

- IF_INDX_THRESHOLD_PERCENTAGE and IF_INDX_PROPORTION_POINTS 

Using these parameters, the rounding times are reported to the method: 

- IF_INDX_THRESHOLD_PERCENTAGE 

The percentage difference in conjunction with the minimum change in percent is calculated in 

the standard system with  decimal places as follows: Percentage change = (new index level / 

last index level) *  - . The system can round this value if you set the parameters 

CD_ROUNDTYPE, CD_ROUNDDECIMAL and CD_ROUNDUNIT. 

- IF_INDX_PROPORTION_POINTS 

In the standard system, the new unit price is calculated to  decimal places as follows: 

New unit price = last unit price * (new index level / last index level). However, you might 

sometimes want to round the quotient (new index level / last index level) before multiplying. You 

can achieve this by settings the CD_ROUNDTYPE, CD_ROUNDDECIMAL and 

CD_ROUNDUNIT parameters. 

- CD_ROUNDTYPE 

Returns the rounding type. Possible values are: 

- No rounding =  
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There is no rounding. 

- Round down =  

The relevant number is rounded downward. For this option, you also have to enter the number 

of decimal places or the rounding unit. 

- Round up =  

The relevant number is rounded upward. For this option, you also have to enter the number of 

decimal places or the rounding unit. 

- Arithmetic =  

The relevant number is rounded using arithmetic rounding. For this option, you also have to 

enter the number of decimal places or the rounding unit. 

- CD_ROUNDDECIMAL 

Defines the number of decimal places to which the system rounds. 

- CD_ROUNDUNIT 

Defines the unit to which the system rounds. 

Notes for Developers 

 Sales-Based Settlement 

 Sales Rule 
 Type of Sales Rule 

Use 

For conditions related to sales-based rent, you can specify the type of sales rule. 

 Reporting Rule 

 Sales Types 

Use 
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In this activity, you create the sales types you need for reporting sales for sales-based rent. 

Activities 

Enter a unique key and name for each sales type. When the sales type is for sales-based rent settlement 

based on quantitative sales, then you have to enter the unit of measurement for the quantity (such as 

gallons). 

For sales-based rent settlement based on monetary sales, you do not have to enter a unit of measure in this 

activity. The system automatically defaults the company code currency in the sales rule. 

Example 

Complete Assortment 

Clothing 

Tobacco products 

Foodstuffs 

Beverages GAL 

... 

 Sales ID 

Use 

Here you can define the sales IDs you want to use in processing sales reports. 

 Settlement Process 

 Parameters of Sales-Based Rent Settlement 

Use 

In this section, you can predefine the necessary parameters for the settlement run. This makes parameter 

blocks available to users when they start settlement, so they do not need to define the parameters 

individually. 
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Activities 

Active: . 

Parameter blocks are offered for selection during settlement only if they were set to 

active. 

Standard: . 

Set this indicator if you want this parameter block to be proposed as the default when 

you start settlement. 

Tax Calculation: . 

In this field you specify the procedure that is used for calculating output tax (such as 

when the tax rate changes within the settlement period). Currently only the standard 

procedure is supported. 

Open AP: . 

This indicator determines how open advance payments (advance payments that were 

agreed on and posted, but not yet paid) are treated during settlement. 

 Enhancements 

 Implement Enhancements (BAdI): Calculation of Sales-Based Rent 

Use 

The Business Add-In ( BAdI ) 

- Makes it possible to change the sales-based rent of a sales rule that was calculated in the standard 

system 

- Gets the behavior context for the calculation of sales-based rent 

The following methods are available. They are executed by the system during sales-based settlement. 

- CALCULATE - change the standard calculation of sales-based rent The transfer parameters are: 

- IO_CONTRACT - object reference on the contract. You use this parameter for calling the 

API_RE_CN_GET_DETAIL function module, if you need additional data from the contract. 

- ID_RPTERMNO - number of the reporting rule 

- ID_RHYTHMTYPE - frequency type of the reporting rule (sales report or certified sales) 

- IS_SETTLPERIOD - settlement period 

- IS_CALCINCOMPLETE - attributes for pro rata calculations (shortened settlement periods) 

- IT_SALESREPORT - sales reports within the settlement period 

- IS_CALCBASE - attributes of sales rule 

- IT_SALESGRADING - sales grading 

Parameters that can be changed are: 
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- CD_SALESRENTNET - calculated net amount of sales-based rent 

- CT_CALCDETAIL - details of the calculation. The details are stored as part of the sales-based 

rent settlement. They can be printed later in correspondence. 

- CT_MESSAGES - additional messages for the log 

Net sales-based rent and the details for the calculation contain the values determined using the 

standard procedure. 

If there is an error message among the messages returned, the system marks the calculation as 

incorrect. When the BAdI method is called, the CT_MESSAGES parameter is always blank. 

- GET_BEHAVIOR_CONTEXT - gets the behavior context for the calculation of sales-based 

rent 

The transfer parameters are: 

- IO_OBJECT- Generic object reference 

- IS_SRSEPERIOD - List with settlement periods 

- IS_CALCRULE - calculation rule for sales rule 

- IS_SETTLRHYTHM  - Assignment of a frequency rule to the sales rule 

- ID_RHYTHMTYPE - Frequency type 

Parameters that can be changed are: 

- CF_PRORATE_AT_BEGIN - Prorated calculation at contract start 

If you want the gradings to be considered on a prorated basis at the start of the contract within the 

first settlement period, then create a Business Add-In implementation for this, and set the changing 

parameter to CF_PRORATE_AT_BEGIN = 'X' in the method GET_BEHAVIOR_CONTEXT. 

Note: 

If the amounts were already defined as prorated when the gradings were created, you are not allowed 

to set CF_PRORATE_AT_BEGIN to 'X'. 

The BAdI method is only called if the frequency start of the sales rule is not INITIAL and the 

'Frequency Start' date is before the rental start date. 

- GET_SALES - Change the sales to be included by default The transfer parameters are: 

- IO_OBJECT- Generic object reference 

- ID_RPTERMNO - Term number of reporting rule 

- ID_RPFROM - Reporting interval start for sales-based lease-out 

- ID_RPTO - End of reporting interval for sales-based lease-out 

- ID_REPORTINTERVAL - Type of frequency 

Parameters that can be changed: 
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- CT_LIST - Sales reports and additional fields ( VISRREPORT ) 

- CT_MESSAGES - Additional messages for the log 

The CT_LIST parameter contains the sales reports determined by default. 

When the BAdI method is called, the CT_MESSAGES parameter is always blank. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

Note that when implementing the BAdI you are not allowed to use statements that affect the 

interface, such as direct output of messages using MESSAGE. Notes for Developers 

 Implement Enhancements (BAdI): Prevent the Posting of Sales-Based Rent 

Use 

Example  

The BAdI makes it possible for you to prevent the posting of the results of a sales-based settlement. This is 

required especially when legacy data for sales-based settlements is to be transferred to the system. In this 

case, it is necessary that you execute sales-based settlements,which were posted in the legacy system, again 

in the SAP system. The results are needed, for example, to be able to post accumulated settlements or 

corrections due to certified sales at the end of the year. However, you do not want to post to financial 

accounting, since these postings were already made in the legacy system before the go-live date. 

If, in the case that the end of the settlement period is before the date of the first posting, you do not want 

create any postings in the sales-based settlement, create an implementation for BADI_RESR_POSTING. 

You can use the example class CL_EXM_RESR_NO_POSTING as an example (take note of the 

comments in the sample code). Do not forget to activate the implementation. 

Example  

You have designated a real estate contract as 'relevant for sales'. The calculation object and possibly the 

distribution object are not valid in the entire period of the sales-based rent condition, but sales were also 

reported for this period. During the sales-based settlement, no distribution postings are made after the 

validity of the object assignment, but a receivables posting is made. 

If you do both of the following, no receivable posting is made: 

- Issue the message RESRBC  (control using transaction OBA) 

- Implement the method NO_POSTING so that the RETURNING parameter 
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EF_DO_NOT_POST = 'X' is set . The log 

contains a corresponding message. 

If you issue the message as a warning, the step is designated as 'incomplete'. If you issue the message as a 

status or information message, then the posting step is designated as 'not required'. In that case, the 

settlement is also complete without the posting being executed. 

There is an example implementation for this example situation in the class 

CL_EXM_IM_RESR_POSTING. 

Notes for Developers 

 Service Charge Settlement 

 Service Charge Settlement 

Use 

In this section you make settings for service charge settlement. Carry out the following steps: 

1. Enter the attributes for settlement participation (for example, usage types, measurement types, and 

condition types specific to service charge settlement). 

2. Define the master data of the settlement units (for example, characteristics of service charge keys, 

settlement variants, heating days) and of participation groups. 

3. Make settings for generating service charge settlement participation. 

4. Make settings for the settlement process (settlement schemas, account settings in accounting 

specifically for service charge settlement). 

5. Enter the attributes for external settlement. 

6. Make settings related to service charge settlement for adjustment of conditions. 
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 Master Data of Settlement Unit 

 Define Service Charge Keys 
Use 

In this section, you define service charge keys you need for settlement. 

Requirements 

The required measurement types are defined. 

Activities 

Check the standard settings and change them if necessary. Delete all service charge keys that you do not 

need. 

If you want to add service charge keys to those already defined, choose New Entries, or copy an entry and 

use it as a template. 

- Enter an internal key and a name for the service charge key. 

- Specify the settlement processes for which settlement units with this service charge key are taken into 

account. If you use the standard settings, then the settlement units are considered during normal 

service charge settlement and in the COA company code, both for COA settlement and for tenant 

settlement. You have to make other settings for costs that can only be assigned to owners (such as 

management costs). The same applies to costs that can only be assigned to tenants of condominiums 

(for example, property tax). 

- Set the Operating Costs indicator if you want the service charge key to be used for operating costs. 

Do not set that indicator if you want the service charge key to be used for heating costs. 

- If you want to classify service charges using different service charge groups, then enter the service 

charge group that the service charge key belongs to. If you did not yet define service charge groups, 

then you can make this assignment in Customizing later in the Accrual/Deferral of Service 

Charges/Display Costs Not Settled  section. 

- If you want to be able to apportion costs using the service charge key, then set the Can be Apport. 

indicator.  You can also designate that an apportionable service charge key is commercially 

apportionable. Neither of these indicators influence the selection of settlement units. They only 

specify whether or not the costs calculated for a rental object can be passed on to the tenant. 

- If you want to take heating days into account for settlement of heating expenses, set the Use Heating 

Value Days indicator. If you want to be able to use the service charge key for directly assignable 

costs, choose the appropriate real estate object in the Direct Cost Posting field. 

- Specify if the service charge key is for costs directly assigned to the rental object or to both the rental 

object and contract. The default value is SU Assignable to Account for all service charge keys. It 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 309 

means you want to post costs to the settlement unit and then apportion them to the settlement 

participants. 

- If you want to use the service charge key for external settlement, then enter the account symbol to be 

used for finding the reconciliation accounts for the settlement in the account determination. 

You can also define default values that can be used when you create settlement units: 

- Enter the measurement type that is normally used for apportioning the service charges for the key. 

- For master settlement units, you can specify for each service charge key whether the apportionment is 

by measurement type, equivalence number, percent, or meter. 

- You can assign default values for the settlement variant that are dependent on the service charge key. 

The default value entered here is then adopted when a value was not specified on the business entity. 

- If you normally want to apportion a service charge key to more than one measurement type (such as 

% by floor area and % by consumption), you can specify a default value for this as well. The value 

you specify here overrides any value entered directly on the service charge key. 

 Default Values for Distribution Rule of Settlement Unit 

Use 

In the attributes of the service charge key, you can specify the measurement type that this key normally 

uses for distributing service charges. However, for some service charge keys that is not enough, since 

they need to settle, for instance, % by consumption and % by residential/usable space. 

In this step you can specify these more complex rules as defaults. When you create a settlement unit, the 

system first checks if an entry was made here for the given service charge key. If there is no entry here, 

then the system defaults the measurement type that was entered in the characteristics of the service charge 

key. 

Activities 

For the service charge key that should have a more complex rule, enter the default values for the relevant 

apportionment purposes. 

 Settlement Variants 

In this section, you maintain the settlement periods for heating expenses settlement and operating costs 

settlements as well as the sales-based rent settlement. 

An accounting variant generally consists of various settlement periods covering a total of  months. You can 

transfer an accounting variant by period (into the following years). 
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Accounting variants can consist of any number of individual settlement periods. You can transfer in the 

following years only if the total of the settlement periods is  months. 

As a special case, you can also determine accounting variants that are valid only for a certain period. 

These accounting variants are then not updated into the following years. The duration of a year-dependent 

accounting variant can be between  day and ' years -  day'. 

- You can create accounting variants: the accounting variant is used to determine the period to be settled. 

- You can change accounting variants: 

You can change the accounting variant only if no settlements have yet been carried out with the 

variant. 

- You can display or delete accounting variants: 

You can delete accounting variants only if the accounting variants are not yet assigned to settlement 

units. 

Example 

In the following example, you want to define an accounting variant, whose assignment begins on / of the 

current year and is settled monthly. 

Reference   Reference     Year shift          Period      month        day 

                                            

                                            

  (...)       (...)         (...)               (...) 

                                            

                         -                  

  (...)       (...)         (...)               (...) 

                         -                  

Here, the 'Year shift' field is used to refer from the current year to the reference year during processing. 

0 - the current year is the reference year 

1 - the previous year is the reference year 

You can also limit the validity of a settlement period to one year. 

Activities 

1. Create accounting variant 

a) Create a four-digit key for the accounting variant and choose the 'Settlement periods' 

function: 

- Refer to the variant. 

- Year-dependent: Set the indicator only in cases where the accounting variant should have a 

limited validity. 
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- Settlement year: Provided that you set the year-dependent indicator, specify the reference 

year at this point. 

- RM: Specify reference month of first settlement period. 

- RD: Specify reference day of first settlement period. 

- YS: Specify relative year shift of first settlement period. 

- Settlement period: Number the settlement period sequentially. 

- Repeat the entries RM, RD, YS, settlement period for all of the settlement periods required. 

b) Save your entries. 

2. Change settlement period 

a) Choose the accounting variant. 

b) Change the entries, if necessary. 

c) Save your entries. 

3. Delete accounting variant 

a) Choose the required accounting variant. 

b) To display the accounting variant, choose the 'Settlement periods' function. 

- To delete the settlement period, choose the 'Delete' function. 

- Confirm your specifications. 

 Settings Dependent on Tenancy Law: Apportion Vacancy and Reg. Location 

Key 

Use 

The settings you make here are dependent on the tenancy law used. Here you make settings for: 

- Do you want to allow a part of vacancy costs to be passed on to tenants? 

In master data maintenance for the settlement unit (assuming that a tenancy law is assigned to the 

settlement unit), entering a vacancy percentage rate (< %, that is, the owners do not bear the full 

costs) is only allowed if the Vacancy Percentage Rate indicator is set here. 

You also have the option of specifying if a vacancy percentage, which was entered in the master data, 

is ignored during settlement. You specify this in the Define Settlement Parameters IMG activity. 

- In the case of a settlement based on consumption, when there are no meter readings, do you want to 

allow the system to interpolate consumption using the regional location key? The system does not 

consider this indicator until settlement. If this indicator is not set, then the system does not 
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interpolate consumption, even if you entered a regional location key. Instead you receive an error 

message if the meter reading is missing. 

Standard settings 

In most countries, it is uncommon to assign vacancy costs to tenants. Therefore the indicator is not set in 

standard Customizing. 

Entering a regional location key for determining costs based on consumption is allowed by standard 

Customizing. Therefore, whether the system interpolates or not depends on the concrete settlement unit. 

 Heating Days 

In this section you determine the settings for weighting heating expenses depending on regional location by 

- assigning heating value days 

- to different regional location keys. This process is specific to Switzerland, but it can be used in 

other cases as well. 

Example 

Background ( Switzerland-specific ) 

In order to avoid having to carry out interim meter readings when a tenant moves 

out, it is common practice in Switzerland 

- to weight the costs incurred in a settlement period 

- depending on the heating value days, by using related heating value percentage rates. 

Other uses 

You may also use this process in cases when you want to settle the heating expenses using percentage 

rates specially defined for the purpose, for instance 

- % according to the heating area 

- % according to the regional location key with monthly graded heating value percentage rates. 

Activities 

Check your Customizing standard settings and change them, if required. 
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Further notes 

To use this process, you have to make additional Customizing settings: 

Service Charge Settlement -> Make Basic Settings -> Data Specific to Tenancy Law. Set the following 

indicators: 

- Regional location key can be maintained 

- Apportionment factors per settlement unit 

 Define Default Values for Current Occupancy Principle 

Use 

Here you define for each service charge key which default settings should be valid for new settlement 

units based on the current occupancy principle. You can still overwrite the settings made here when you 

process the settlement unit. 

Activities 

At present, only defaults for tenant settlement are implemented. The current occupancy principle is only 

used if service charge keys that are not specified if the appropriate indicator is set on the rental object. 

Example 

In Austria, settlement according to the current occupancy principle is common for older buildings. Certain 

costs (for example, heating expenses according to consumption) cannot be apportioned based on the 

current occupancy principle. 

In this case, set Never settle according to current occupancy principle for the relevant service charge key. 

By implementing a BAdI you can make sure that the current occupancy principle indicator is 

automatically set for buildings based on the construction year (this indicator is copied to the rental unit 

when creating new rental units). 

Note 

Service charge keys that are settled based on the current occupancy principle cannot be settled using the 

same condition type for service charge keys to which the current occupancy principle does not apply. 

The Current Occupancy Principle  indicator can only be set for rental units and rental spaces, not for 

pooled spaces. Note that using it for rental spaces is not recommended if the rental space is returned to the 

pooled space after the end of the contract or if it is extracted in a completely different form for a new 
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rental. If the rental space is returned to the pooled space, the settlement treats it as vacant at the time of 

settlement, even if there is another rental space for the physically and architecturally identical space at the 

time of settlement. 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 
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 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields 

of a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, and 

display fields in display mode.) If it is not possible to make a setting for a field group, then the system 

determines how the field is treated (usually dependent on the situation, or on the contents of other 

fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of the 

view accordingly (consider the detail screen). Then assign the field groups to the view. You can assign 

your own field groups, as well as those delivered by SAP. 
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 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it is 

surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you want 

to this section. The item number specifies the sequence in which the views are arranged in the section. For 

technical reasons, if you make your own assignments from sections to views, the item numbers have to be 

in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. 

The position number for user-specific entries also has to be other than  here. 
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 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

For business entities, the system always uses the screen sequence category that is defined as "Standard." 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 
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SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Number Assignment, Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of settlement units. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more 

detail in Enhance BDT Applications Notes 

for Developers 
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 Master Settlement Unit 

Use 

In this BAdI, you can enter your own formulas for calculating heating costs distribution. 

Standard settings 

In the standard system, the following keys of the domain VVHKVOTYP (data element VVHKVOTYP) are 

reserved for customer implementations: R,S,T,U,V,W,X,Y,Z. 

Activities 

Implement the following methods: 

- SHAREOUT_HEAT_F (Input help for heating costs distribution) 

The transferred table CT_HKVOTYP contains all domain fixed values for domain VVHKVOTYP. 

Delete values that are not needed from the table. Change the text of the values you use. 

- SHAREOUT_HEAT_CALC (Calculation of heating costs distribution) The changing 

parameter CS_HOTWATERVALUES contains the values necessary for the calculation. 

Perform the calculation and fill the necessary fields. 

Example 

For an example implementation, see the class CL_EXM_IM_RESC_MSU. Notes for 

Developers 

 Implement Enhancements (BAdI): "Overviews" - Own 

Evaluations 

Use 

There is an Overviews tab page on the processing screen for contracts and real estate object master data. 

Some overview lists are predefined in the system. You can enhance the existing lists for each object type 

to suit your needs or add your own lists. The procedure is described here using an example. 

 Settings for Rental Objects and Contracts Participating in Settlement 

 Usage Types for Service Charge Settlement 

Use 
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Here you can define the rental objects for which service charge settlement can be performed. All usage 

types, for which you set the indicator, can participate in service charge settlement. Usage types, for which 

you do not set the indicator, are not allowed to participate in service charge settlement. Rental objects 

with these usage types cannot be included in a participation group. 

Activities 

Set the Sett. (Settlement) indicator for usage types that are relevant for settlement. 

 Define Measurement Types 

Use 

In this section, you define measurement types for: 

Architectural objects. 

Usage objects (business . entity, building, property, rental object) 

Contracts (for service .charge settlement) 

Measurements are used to record measurable traits of objects. The measurement type indicates the type of 

trait that is being measured. Area measurements are also recorded as measurements. There is a special 

indicator that identifies area measurements. This makes it possible to run special reports on areas and for 

the system to check the unit of measurement for area. 

The measurements of a rental object are used for example in service charge settlement for determinining 

apportionment, and in option rate determination for determining the option rate. You specify the 

measurement type that plays a role in these calculations in the settlement unit or in the option rate 

method. Measurements are also the basis for the calculation of condition amounts. 

Activities 

Choose New Entries. 

On the detail screen, you can specify the Real Estate object for which the measurement type is allowed. 

If you want a measurement type to be proposed as the default in the application, choose Criterion is 

default for object (on screen) for the object type. To ensure that the measurement type is not deleted, 

choose Criterion for object is required entry (on screen) . The settings Default or required entry are 

recommended for measurements that are needed for subsequent processes. 

- For rental objects, you can also specify per usage type if a measurement type is allowed or not. 

For measurement types that you want to allow for all rental objects, you enter the following in the 

Allowed for RO field: 

- Criterion permitted for object 

- Required entry, or 
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- Default 

Set the No Exception indicator. The system then ignores the differentiation by usage type. 

- The same procedure applies for architectural objects. You can also specify per architectural object 

type if a measurement type is allowed or not. If you set the No Exception indicator, the system 

also ignores the differentiation by architectural object type. 

For contracts you specify in addition the contract reference. You can also define per contract type whether 

a measurement type is allowed or not and whether there is to be an object reference. If you set the No 

Exception indicator, the system also ignores the differentiation by contract type. 

Properties of service charge settlement 

The system applies these settings only if the For Apport. (for apportionment) indicator is set. For more 

information on the individual indicators, refer to the help documentation for these indicators. 

If you use external heating expense settlement, then you have to assign either no or one basic component for 

heating to exactly one measurement type. (You may have to do the same for the basic components for Hot 

water and for Other.) 

Measurement types in Customizing: 

- A = Area: such as floor area 

- M = Measurement: other measurements, such as number of parking spaces 

- U = Usage: consumption, such as water consumption 

 Apport. by Consumption: Define Characteristics and Measuring Point Categ. 

Apportionment by Consumption: Define Characteristics and Measuring Point 

Categories 

In this section, you determine the characteristics for meters and the measuring point categories. 

To measure consumption-dependent apportionment units meters are created on the rental units. 

The value to be measured is the characteristic (for example, water consumption). 

The characteristics can be created in characteristic classes. For information on this, see the subchapter 

"Characteristics" in the chapter "Classification System" under "Cross-Application Components" in the 

standard Implementation Guide. 

The characteristics cannot be transported but have to be manually created in the target system. 

Example 

Characteristic name:  HOTWATERCONSUMPTION 

Base data: 

Name of the characteristic    HOTWATERCONSUMPTION 
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Language key                  E 

 Characteristic description   Hot water consumption 

 Characteristics group        IMMO Characteristics for measurement                               

documents Real Estate 

 Status                        released 

 Data type                    NUM 

 Number of positions           

 Decimal places                

 Unit of measurement          m 

 Template                     __.___.___,_  Heading                     

Hot Water 

 Heading                     Consumption 

Activities 

1. Create your required characteristics. To receive additional help, choose 'Help -> Extended help' 

within the menu path you are processing. 

2. Check the measuring point categories. A measuring point category "Consumption" is needed. For 

details on the measuring point categories, see the Plant Maintenance Implementation Guide. 

 Settlement by Consumption/Meter Reading: Measurement Type Characteristics 

Use 

In this step, you assign characteristics from the Plant Maintenance (PM) component to the measurement 

types. 

To make measurements that are related to consumption, you have to create meters on the rental objects. The 

factor to be measured is the characteristic (such as water consumption). 

Requirements 

In the Measurement Types activity, you have set the Rel. for Apport. indicator for the measurement types 

required for service charge settlement and have entered the necessary characteristics for them. 

In the Apport. by Consumption: Define Characteristics and Measuring Point Categ. activity, you have 

created the characteristics and measuring point categories required. 
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 Condition Types for Advance Payments and Flat Rates 

Use 

In this step you define condition groups condition groups and assign condition types to them. 

@S@ Condition groups are mandatory. The only condition types available in the contract or rental object 

(dependent on the contract or usage type) are those that you have assigned to the given condition group for 

the object type. 

You also need condition groups if you want to use proposed conditions. In this case, the condition groups 

define the condition types for which automatic values should be proposed (Define Proposed Conditions). 

You may: 

a) Use the same condition groups that you assign to usage types of rental objects or contract 

types 

b) Define other condition groups 

Before the condition types can be adopted, the system automatically compares the resulting condition types 

with the condition types that are actually allowed on the object. 

You can also use condition groups to show totals for multiple condition types in one column in reporting. To 

do so, you assign a condition group to a report profile using a condition profile. You should also define 

special condition groups for reporting, such as, net rent before service charges, or advance payments for 

operating costs. 

Requirements 

You have specified the condition types you need in the Condition Types IMG activity. 

Activities 

Check the existing condition . groups. 

Create additional condition . groups if you need them, and define which condition types are allowed in 

which condition groups. You can add condition types to a condition group at any time. 

However, you are not allowed to remove condition types if they were already used in 

rental objects or contracts of the usage type or contract type. 

.Assign condition groups in the Assign Condition Group to Rental Object per Usage Type step 

and the Assign Condition Group to Contract per Contract Type step. 

Keep in mind that you no longer distinguish between condition types for flat rates and advance payments 

using the condition group (as was the case in Classic RE). Instead you make this distinction in the attribute 

of the condition type. 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 324 

Example 

You create a condition group for vendor contracts (commercial) with conditions that generate postings to the 

vendor account (for example, basic office rent, basic warehouse rent, advance payment for operating costs, 

advance payment for heating costs, and so on). 

Note 

You can also use condition groups when you define report profiles; see Configure Condition Profiles. 

If you want to calculate surcharges fro the settlement result from the service charge settlement, which you 

relate to basic rent, you can also work with condition groups. For more information, see Define Calculation 

of Surcharges. 

 Assign Default Condition Type to Service Charge Key 

Use 

In this activity you assign a condition type to a service charge key. The system uses this condition type to 

determine the (reference) flow type (for account determination, for example) in the following cases: 

- You have not defined an explicit settlement participation for the contract, and the system cannot find a 

unique condition type when it generates the settlement participation. 

- There is no condition defined for the settlement unit in a contract (for example, participation type final 

settlement). 

- A settlement unit contains one or more vacant rental objects. 

Standard Settings 

SAP assigns the condition types AP Operating Costs and AP Heating Expense to the corresponding service 

charge key. 

Example 

The final settlement participation type is defined on a contract. Then there is no Advance Payment 

condition on the contract for the settlement unit. In this case, the system uses the condition type that you 

assigned here to the service charge key. 

Note 

Account determination for the receivable posting takes place as follows (for costs on the contract that 

have to be passed on to the tenant): 

You assigned an Advance Payment condition to the settlement unit in the settlement participation. This 

condition is assigned to a flow type that has a reference flow type of the category : Receivable from 

Settlement. This flow type is the crucial factor in the account determination. 
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 Generating of Settlement Participation (for Contract) 

 Assign Condition Type to Service Charge Key/Group 

Use 

Here you specify which conditions for service charge advance payments and which conditions for flat 

payments are cleared against each other. 

Activities 

The various control options are described below. Make an entry in the table for each condition for advance 

payments and each condition for flat-rate payments. Specify the following for each entry: 

- Whether the condition type is only allowed to be cleared by costs of certain service charge keys 

- Whether the condition type can be cleared by all costs on the settlement units of a certain service 

charge group 

- Whether the condition type can be cleared by all costs in the categories "Operating Costs"/"Heating 

Costs" or "Operating and Heating Costs" 

Use 

For the system to be able to check or generate the settlement participation, the condition types, which play a 

role in service charge settlement (advance payments and flat payments), must be linked to the service charge 

key. This can be done as follows: 

- The advance payment condition type is assigned directly to the relevant service charge key Example: 

Condition type:  Elevator advance payment 

Service charge key:  Elevator 

Service charge category:  No general costs ( SCK-specific ) 

Service charge group: < blank > 

- A service charge group is assigned to the advance payment condition type: 

Example: 

Condition type:  Caretaker services advance payment 

Service charge key: < blank > 

Service charge category: <anything> 

Service charge group: Caretaker services 

(The service charge group is assigned in Customizing, for example, to the service charge keys  

Gardening 

 Caretaker 

 House cleaning 

.) 

- The service charge category "operating costs" or "heating expenses" is assigned to the advance 

payment condition type: 

Example: 
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Condition type:  Operating costs advance payment 

Service charge key: < blank > 

Service charge category:  Operating costs 

Service charge group: < blank > 

The service charge key is settled, for which in Customizing in the definition of the service charge key, 

you set the operating costs indicator. 

Advance payment condition types valid for operating costs and heating expenses have service 

charge category  - general service charges. 

Example: 

Condition type:  operating costs/heating expenses advance payment 

Service charge key: < blank > 

Service charge category:  - General service charges 

Service charge group: < blank > 

The settlement participation is generated/checked when you create/change an occupancy contract and 

during service charge settlement.  The system determines the settlement units, to which the rental objects 

are assigned, and which are leased out in this contract. It also attempts to assign the advance payment and 

flat payment condition types that are assigned here. To do this, proceed as follows: 

- First the system searches for an advance payment condition type that is defined exactly for this 

service charge key (see first point above). 

- Then it searches for an advance payment condition type that belongs to the service charge group of 

the service charge key (see the second point above). 

- Finally, it searches for an advance payment condition type that belongs to the category "operating 

costs" or "heating expenses" (depending on whether the operating costs or heating expenses 

indicator is set for the service charge key). 

- If it still cannot assign any condition type, the system searches whether the contract has a condition 

type that is specified in Customizing with the service charge category " General Service Charge." 

- If this condition type also does not exist, the system assumes, depending on the setting in 

Customizing for the Defaults for Settlement Participation per Service Charge Key that it is a final 

settlement (for which no condition type is required) or that the contract does not participate in this 

settlement unit. 

Example 

The advance payment conditions and service charge key are set up as specified in the examples above. 

There are settlement units for the following service charge keys: 

 Property damage and liability insurance 

 Water supply 

 Elevator 

 Street cleaning 

 Garbage removal/disposal 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 327 

 Broad band cable network 

 Caretaker 

 House cleaning 

  Heating expenses 

They are all marked as "operating expenses" except for service charge key . 

- For contract , it is listed explicitly which advance payments have been made for which costs. The 

following conditions are defined: 

 operating costs advance payment 

 Elevator advance payment 

 Caretaker services advance payment 

In the settlement participation, the advance payments for this contract are assigned to the advance 

payment condition types as follows: 

 Property damage and liability insurance  ->  operating costs advance payment 

 Water supply  ->  operating costs advance payment 

 Elevator  ->  Elevator advance payment 

 Street cleaning  ->  operating costs advance payment 

 Garbage removal/disposal  ->  operating costs advance payment 

 Broad band cable network  ->  operating costs advance payment 

 Caretaker  ->  Caretaker services advance payment 

 House cleaning  ->  Caretaker services advance payment 

  Heating expenses  -> No assignment 

- Contract  only has the condition " operating costs advance payment". For this contract, all service 

charge keys except for  are assigned to the condition type  -> operating costs advance payment. 

No condition type can be assigned for both contracts for the settlement unit with the service charge key . It 

would be designated as a final settlement if this has been set up in Customizing. 

 Define Default Values for Settlement Participation per Service Charge Key 

You can create a default for how a service charge key that has no condition type assigned to it is settled. 

For your service charge keys, you can specify either 

- The costs incurred in the respective contract are not to be settled. 

- The costs are to be settled in the form of a final settlement for the contract. 
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Example 

Requirements 

Standard settings 

The table is empty in the standard delivery; this means that service charge keys without condition types do 

not participate in service charge settlement. 

Recommendation 

Activities 

Further notes 

You can change the default value when you process the contract. 

If you leave key fields blank, the system considers the entry while ignoring the concrete contents of the 

field. 

The system searches in the following sequence, moving from specific to general: 

1. Company code, usage type of rental object and service charge key (complete key) 

2. Company code, "usage type blank" and service charge key 

3. Company code, "usage type blank," "service charge key blank" 

4. "Company code blank," usage type and service charge key 

5. "Company code blank," "usage type blank" and service charge key 

6. All key fields blank 

For example, if you want the standard in your system to be that service charge keys, for which 

there is no advance payment, should participate in final settlement, then you simply need to make an entry 

with blank key fields and enter final settlement in the table. 
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 Master Data of Participation Group 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 
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 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields 

of a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, and 

display fields in display mode.) If it is not possible to make a setting for a field group, then the system 

determines how the field is treated (usually dependent on the situation, or on the contents of other 

fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of the 

view accordingly (consider the detail screen). Then assign the field groups to the view. You can assign 

your own field groups, as well as those delivered by SAP. 
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 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it is 

surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP 

differently or to add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you want 

to this section. The item number specifies the sequence in which the views are arranged in the section. For 

technical reasons, if you make your own assignments from sections to views, the item numbers have to be 

in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 332 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define 

other screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and 

then assign the screens you want. The position number for user-specific entries also has to be different 

from  here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

For business entities, the system always uses the screen sequence category that is defined as "Standard." 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 
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SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Number Assignment, Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of participation groups. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 Settlement Process 

 Define Settlement Parameters 

Use 
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In this activity, you can predefine the necessary parameters for the settlement run. This makes 

parameter blocks available to users for selection when they start settlement. As a result, the user does 

not need to enter the parameters individually. 

Activities 

Set the values for the individual indicators: 

- Active: 

Parameter blocks are offered for selection during settlement only if they were set to active. This 

enables you to leave parameter blocks in the system that you have tested but do not want to offer in 

the application. You can then activate them later if you need them. You have to set the Active 

indicator separately for each of the following: "normal" service charge settlement, COA settlement 

(for condominium owners in the COA company code) and tenant settlement (for tenants renting 

condominiums). For accruals and deferrals, there is a similar indicator in the Parameters for 

Accrual/Deferral group box. If you need the current occupancy principle for COA settlement, but 

do not need it for tenant settlement, you can also set the indicator differently for each of them. 

- Standard: 

Set this indicator if you want this parameter block to be proposed as the default when you start 

settlement. 

For this setting there is also a separate indicator for "normal" service charge settlement, COA 

settlement, tenant settlement, and accrual/deferral. 

- Split Receivable If Tax Changes 

This indicator specifies that you want the receivable posting to be split based on time when the tax rate 

changes within the settlement period. 

- Post Balance: 

Set this indicator if you want to balance the receivable with the advance payment. This function is 

currently only available when the Leave Open APs (Planned Principle) indicator is set. 

- Leave Open APs (Planned Principle) 

Set this indicator if you do not want the settlement to automatically clear open advance payments 

(advance payments that were agreed on and posted, but not yet paid). This is advisable in certain cases 

(see long text). 

- Current Occupancy Principle: 

Austria only: Set this indicator to settle rental agreements and rental units with the current occupancy 

principle indicator in service charge settlement based on the current occupancy principle. 

- Print Separately: 

If you set this indicator, correspondence is not printed automatically as part of settlement. Instead, you 

must print it separately. We recommend that you set this indicator for the standard procedure so that 

correspondence is not printed automatically each time a complete settlement run is simulated. 

- Consider Vacancy Percentage 

This indicator must be set if you want to include a vacancy percentage rate (percentage at which 

the cost share of the vacant rental object can be transferred to the other tenants) that can be 

specified on the settlement unit. 

In most countries this is not allowed or is not usual. 

- Use Other Apport. Factor ( Sim./Accr. ) 
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This indicator applies during simulation of service charge settlement or during accrual/deferral of 

service charges. If this indicator is set, then, for all settlement units that have an alternative 

apportionment factor (to be used if it is not possible to determine the measurement), the system uses 

this alternative apportionment factor. This is particularly relevant for settlement units that are 

normally apportioned based on consumption (alternatively based on residential/usable space). If this 

indicator is set, then the system does not base the apportionment on consumption but distributes 

instead immediately using the residential/usable space. The system ignores this indicator during an 

actual settlement. 

- Elimination of Internal Business Volume 

It is possible that a settlement unit could contain rental objects and contracts with different profit 

centers. If that is the case and you want to perform elimination of internal business volume, then set 

this indicator. The system then ensures that posting is always two-sided. 

- Distribute Remainder 

Small differences can arise when costs are distributed from the settlement unit to the rental objects. 

Here you specify if differences are distributed, and if so, how. 

- Surcharge Schema 

The surcharge schema specifies if the system calculates a surcharge on the settlement result, and, if 

so, how this surcharge is calculated. You can define the surcharge schema in the Define 

Calculation of Surcharges IMG activity. 

- Default Values for Data Medium Exchange for External Settlement 

You can make settings here that appear as defaults for settlement but can be overwritten. These 

settings define where files are imported from or exported to for data medium exchange, and the names 

of the files. 

- Parameters for Accrual/Deferral 

First specify if the parameters are allowed to be used for accrual/deferral and whether these are the 

standard parameters (see above). 

If there are no settlement parameters designated as allowed, then the system proposes the parameters 

that are allowed for "normal" service charge settlement. 

- AP Needed for Accrual/Deferral 

Set this indicator for parameters that are used for accrual/deferral, if you want the system to read 

advance payments during the accrual/deferral. Then the system either displays the advance 

payments for information only, or reposts them, depending on whether flow types are set up for this. 

Restrictions related to whether individual parameters can be combined. 

If you select the option "Charge Input Tax to Tenant", then the following options are not allowed to be 

selected: 

- "Post Balance" 

- "Split Receivable If Tax Changes" 
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- "Consider Current Occupancy Principle" 

 Define Calculation of Surcharges 

Use 

Here you specify if (and possibly how) surcharges are calculated during service charge settlement. To do 

so, you define a  surcharge schema. The surcharge schema determines how high the surcharge percentage 

is, while allowing you to have different surcharges for different service charge keys, usage types, and 

contract types. 

You specify the surcharge schema that is used during settlement in the Define Settlement Parameters IMG 

activity. 

Make settings here only if you plan to calculate surcharges. 

Standard settings 

Standard Customizing is set up so that a surcharge of % is imposed on publicly subsidized apartments (for  

apportionment loss risk) when the DE - Germany surcharge schema is used. There is also a second 

surcharge schema CH- Switzerland for Switzerland. It calculates surcharges for all rental objects, but the 

amount of the surcharge varies depending on whether the contract is internal or external. 

Activities 

Define all surcharge schemas you need. 

At the level of the surcharge schema, you specify the  normal amount of the surcharge. You can choose 

to make the amount of the surcharge dependent on the service charge key, the usage type of the rental 

object, and the contract type. In addition, you can specify that the system calculated a surcharge only for 

certain service charge keys, usage types, or contract types. You can also decide how this surcharge is 

posted. 

For more detailed information, see the F documentation for the given fields. Then you 

assign the surcharge schema to  settlement parameters. 
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 Accounting: Account Determination and Accounts for Apportionable Costs 

 Accounts for Service Charge Settlement 

Use 

Here you specify which accounts can be used for posting apportionable costs (on the settlement unit, or 

directly posted to the contract and/or rental object). You also specify how follow-up postings should look 

dependent on the account to which they are posted (credit account for settlement unit, debit of rental object 

and contract, input tax correction, and so on). Requirements 

The accounts used have to exist already as G/L accounts in FI or as cost elements. 

For more information, refer to Account Determination for Service Charge Settlement. 

 Define RE-Specific Account Properties 

Use 

In Customizing for your accounting system, you can specify that particular accounts can be used for real 

estate objects. This is dependent on the account group. 

In this step, you can make detailed settings for these accounts. Accounts for which you make no further 

settings can be used for all real estate objects. However, you cannot use such accounts to directly post 

service charges to rental objects and contracts. 

Activities 

Define the account properties as follows: 

Choose New Entries. 

Enter an internal key and a name for the account property. 

Example 

. 



______________________________________________________________SA

P System  

______________________________________________________________  

SAP AG 338 

You want certain accounts to be available only for certain object types. 

You create the account property NAC - Non-Apportionable Costs. This account property is only allowed 

for the object types business entity, property, building, rental object, and contract ( but not settlement unit). 

Select the corresponding object types. Account assignment to settlement units is then not possible for 

accounts that have this property. 

. 

You want to be able to assign costs directly to rental objects or contracts, and these costs should be 

charged to the corresponding rental object/tenant of the contract. 

Select the rental object and contract fields, and specify a service charge key with the property RO - 

Directly Posted or RO/Contract Directly Posted. In the IMG activity Accounts Allowed for Individual 

Service Charge Keys you can also assign more than one service charge key to the account property. 

@AH@ Account properties for directly posted accounts should be allowed only for rental objects and 

possibly contracts, and not be permitted for any other object type. 

. 

You want certain accounts to be used only for a particular service charge key. 

Enter "Permitted for Certain Service Charge Keys" in the SU field. In the activity Accounts Allowed for 

Individual Service Charge Keys, enter the service charge keys for which the accounts are to be posted 

with this property. If you are using only one service charge key, you can also enter it directly. 

If you want to post settlement units independently of the service charge key, enter "Generally Permitted" in 

the SU field. 

 Define Accounts Allowed for Individual Service Charge Keys 

Use 

In the RE-Specific Account Properties IMG activity, you can specify that certain accounts can only be used 

for settlement units with specific service charge keys. To do so, you choose the entry "Permitted for 

Certain Service Charge Keys" in the SU (settlment unit) field. 

In this activity, assign all service charge keys, for which you want to allow posting, to an account property. 

If you assigned any service charge keys that are for "directly postable costs," then the account properties 

have to be set up so that they are allowed for rental objects, or for both rental object and contract. 

Requirements 

First maintain the account properties 
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Note 

For directly posted costs, the system makes checks during posting to see which settlement unit or 

settlement period the posting belongs to. In addition, the system uses the account property and the 

account to determine the service charge keys that are compatible with them. Then it tries to find the 

posted rental object in a settlement unit that has one of these service charge keys. This indirect 

assignment between the rental object and the directly postable settlement unit therefore has to be unique. 

In order to ensure that settlement master data is not created incorrectly, set up the system so that for each 

account exactly one service charge key can be used for a directly postable rental object. You may also 

want to allow exactly one service charge key to be used for a directly postable rental object/contract. The 

same account can also be used for other settlement units. 

 Assign RE-Specific Properties to G/L Account 

Use 

In this activity, you assign the RE-specific account properties, which you already defined, to the G/L 

accounts to which they apply. 

 Assign Clearing Accounts to Cost Account 

For all postings, service charge settlement uses accounts that are dependent on the account of the original 

cost posting. The only exception is receivable postings for the tenant. These are posted dependent on the 

advance payment condition type. 

In this activity, you specify which clearing accounts and credit accounts are to be used for the cost accounts 

(apportionable service charges). 

The accounts have to have been created as cost elements. 

For information on which account is used for what purpose, refer to the F documentation of 

the given field. 

Note for third party management: 
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The cost accounts entered here are automatically excluded from the selection of cost elements for the 

annual budget of the condominium owners' association. For more information, see the documentation of 

the Specify Cost Elements to Be Excluded from Annual Budget IMG activity. 

 Assign Default Condition Type to Service Charge Key 

Use 

In this activity you assign a condition type to a service charge key. The system uses this condition type to 

determine the (reference) flow type (for account determination, for example) in the following cases: 

- You have not defined an explicit settlement participation for the contract, and the system cannot find a 

unique condition type when it generates the settlement participation. 

- There is no condition defined for the settlement unit in a contract (for example, participation type final 

settlement). 

- A settlement unit contains one or more vacant rental objects. 

Standard Settings 

SAP assigns the condition types AP Operating Costs and AP Heating Expense to the corresponding service 

charge key. 

Example 

The final settlement participation type is defined on a contract. Then there is no Advance Payment 

condition on the contract for the settlement unit. In this case, the system uses the condition type that you 

assigned here to the service charge key. 

Note 

Account determination for the receivable posting takes place as follows (for costs on the contract that 

have to be passed on to the tenant): 

You assigned an Advance Payment condition to the settlement unit in the settlement participation. This 

condition is assigned to a flow type that has a reference flow type of the category : Receivable from 

Settlement. This flow type is the crucial factor in the account determination. 

 Assign Reference Flow Types for Receivables/Credit from SCS 

Use 

Here you assign the reference flow types that you require for settling service charges. 

Activities 
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For all flow types that are assigned to condition types with the attribute advance payment, check whether 

the reference flow types are correctly set up for the following relationships: 

-  SCS: Receivable from Settlements 

This reference flow type is used to invoice the tenant for the total receivable for a contract. If the 

advance payments were posted as revenue, this flow type is used to post the outstanding receivable 

(settlement amount less advance payments, if the settlement calculated a higher amount than the 

advance payments). 

The flow type should be based on account determination with the following posting specification: 

Dr  Customer Cr  Revenue ( Contract ) 

For own-use contracts with advance payment, account determination should be set for the reference 

flow type with key . Example: 

  AP Operating Costs           AP Operating Costs Own Use   AP Operating Costs Own Use 

    Re from sett: Own use OC AP The posting specification for flow type  is then: 

Dr  Costs (Cost Center/Order/Project)  Cr  Revenue ( Contract ) 

The relationship is also used to offset the object transfer made during periodic posting. For this 

reason you should specify a reference flow type for the flow types for object transfer as well: 

  AP Operating Costs           AP oper. costs transfer   AP oper.costs transfer       Neutraliz. 

Repost. AP Oper. Costs 

The posting specification for flow type  is then: 

Dr  Costs Passed On (Contract)    Cr  Revenue (Rental Object) 

The posting specification for flow type : 

Dr  Neutralization of Costs (Rental Object)   Cr  Revenue Dist. ( Contract ) 

-  SCS: Credit from Settlements 

This reference flow type is used post a credit memo for the tenant for the credit calculated for a 

contract. 

Service charge settlement can calculate a credit for the tenant in the following two cases: 

a) The settlement unit has a credit balance for the settlement period (for example, when the 

revenue for a coin-operated washing machine is higher than the costs). 

b) The advance payments were posted as revenue and the outstanding receivable is less 

than the advance payments. 

Posting specification for customer contracts is then: 

Dr  Costs (Contract)   Cr  Credit Customer 

For own use and object transfers, see relationship key  SCS: Receivable from Settlements ( above 

). 

-  SCS: Legacy Data Transfer of Service Charges Not yet supported. 

-  SCS: Receivable from Non-Deductible Input Tax 

Flow type used to post the receivable of the proportional non-deductible input tax. SAP recommends 

the same flow type here as for relationship . 
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-  SCS: Credit Memo from Non-Deductible Input Tax 

Flow type used to post the credit of the proportional non-deductible input tax. SAP recommends the 

same flow type here as for relationship . 

-  SCS: Advance Payments Transfer Credit Balance 

This flow type is used to make a transfer posting for the advance payments. It is only needed when 

the advance payment is not posted as revenue, or when settlement is based on the actual principle. 

If the advance payment is not posted as revenue, the posting specification for this flow type is then: 

Dr  K Customer   Cr  Credit Customer 

If the advance payment is posted as revenue, the posting specification is then: 

Dr  Allocated Costs (Contract)   Cr  Credit Customer 

-  SCS: Transfer Posting Advance Payments Debit Balance 

This flow type is used when the advance payments to be transferred are larger on the debit side than 

on the credit side, such as when condition adjustments on advance payments originally posted for 

the contract resulted in credit memos for the renter. The posting specification is then: 

Dr  Customer receivable   Cr  J Customer 

-  SCS: Transfer Posting Advance Payment to G/L Account 

This flow type is used when advance payments are to be transfer posted to a G/L account. In this 

case, the tenant is not invoiced for the total receivable of the settlement, but only the balance. 

The posting specification is then: 

Dr  K Customer   Cr  G/L account 

The receivable is posted with the reference flow type for the relationship key  or , depending on 

whether the balance produces a credit memo or a receivable. 

-  SCS: Transfer Posting Advance Payments TSC Principle 

This flow type is used if the tenant service charge settlement is applied when transfer posting the 

advance payments, in other words, the payments made by one tenant are credited to the subsequent 

tenant (or the rental object when the object remains unoccupied). The posting schedule is similar to 

the relationship category . 

 Enhancements 

 Implement Enhancements (BAdI): Suppress Clearing 

Use 

You use this Business Add-In (BAdI) if you want to suppress clearing in the context of service charge 

settlement, sales-based settlement, COA settlement, and so on, for example because clearing should take 

place outside of the settlement using your own programs. 

You can also influence the selection of items for clearing with respect to rental contracts (transaction 

RERACL). 
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Requirements 

The advance payment items posted by the service charge settlement then remain open. You have to clear 

them manually, for example using transaction FB, or using your own customer-specific program. 

To be able to clear non-payable special G/L indicators, you have to set message REEXFI  to a warning in 

transaction OBA. 

If it afterwards becomes necessary to reverse the service charge settlement, you first have to reset 

manually made clearings using transaction FBRA. 

Activities 

Implement the method SUPPRESS_CLEARING and set the parameter cf_suppress_clearing there to 'X'. 

Implement the method MODIFY_CLEARING_ITEM_LIST if you want to change the list of open items 

that are intended for automatic clearing (Clearing for RE Contracts RERACL). This makes it possible, 

for example, to exclude certain contracts from clearing. 

Also see the example implementation. 

Notes for Developers 

 Implement Enhancements (BAdI): Prevent Object Transfers 

Use 

You can use this BAdI if you want to suppress object transfers (transfer from the contract to assigned 

rental objects) during periodic posting and service charge settlement. In that case the real estate contract 

remains the object to which account assignment is made in the revenue posting. 

Activities 

Implement the method SUPPRESS_TRANSFER_POSTING and set the parameter cf_suppress_transfer 

there to 'X'. 

Also see the example implementation in class CL_EXM_IM_RERA_TRANSFER_POST. 

Example 
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In the example, the distribution postings are controlled dependent on the contract type of the contract. 

For contracts with customer accounts, the distributions are suppressed, but not for other contract types. 

Notes for Developers 

 External Settlement 

 Characteristics of External Settlement Companies 

Use 

In this step, you enter information for your external settlement companies. 

Activities 

Enter an internal key .of your choice for each settlement company. 

Enter a long and a .short name. 

Enter the company-code-dependent . customer number for the settlement company. 

Specify whether or .not advance payments for heating and service charges are 

cleared by the settlement company. 

CRLF: Set this indicator . if a line break should be introduced when tapes are created. 

 Define Cost Elements of Settlement Company 

Use 

In this section, you assign the cost elements of the settlement company the corresponding service charge 

key of your company. 

- Entry of the cost elements for each settlement company 

Please take the cost elements from the documents your settlement company provides. 

- Assignment of your service charge key to the external cost elements 

In the SAP System, the costs are posted with the service charge key (account assignment settlement 

unit) and are evaluated under the cost elements assigned here at the settlement company. 
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Activities 

1. Choose the settlement company. 

2. Create cost elements of the settlement company 

Create the cost elements and assign cost element groups (predefined by the system) to them. 

3. Assign service charge key 

a) Assign the corresponding service charge key to each cost element 

b) To do this, position the cursor on a cost element and choose the 'Assign service charge key' 

level. 

 Fuel Types 

Use 

In this section, you determine 

1. the names of the fuel types in your system (internal fuel types) as well as which service charges keys 

are to be used to enter the costs of these fuel types. 

2. the name of the fuel types of the settlement company as well as the assignment of your fuel types. 

These objects are needed for the data medium exchange of the fuel costs incurred. Take the fuel 

types from the documents of your settlement company. 

Requirements 

Service charges keys are created for each internal fuel type. 

Activities 

1. Fuel types for real estate management - assignment SCK 

a) Check the standard settings and change them, if necessary 

b) Assign the service charges key corresponding to new fuel types. 

2. Fuel types of the settlement company 

a) Choose the settlement company. 
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b) Define fuel types settlement company Enter the fuel types of the settlement company. 

c) Assignment of fuel types to real estate management 

- Position the cursor on an external fuel type and choose the 'Assignment of fuel types to real 

estate management' level. 

- Assign the corresponding internal fuel type. 

 Adjustment of Conditions 

 Different Calculation of Service Charge Condition 

Use 

Normally, the advance payments are determined on the basis of the measurement amount 

resulting from settlement for a lease-out with reference to a rental object. 

However, this sometimes results in inaccurate advance payments if the settlement factor is usage-based (or 

also on the number of people in the apartment) and the tenant moved into the object only shortly before the 

end of the settlement period. In this case, the tenant may have used significantly more or less than average 

during this short time, and extrapolating the consumption to the entire settlement period would lead to 

disproportionately high or low advance payments. 

For this reason, for individual service charge keys you can specify a certain length of participation in 

settlement ("number of months"). For the period up to this amount of time, the the advance payment 

adjustment for these service charge keys is determined based on the measurement type entered here, 

instead of the measurement type of the SU. 

For service charge keys for which the consumption varies according to the season, a value for the 

"regional location heating value days" can be defined. This key is based on the heating days table which 

specifies how the months are weighted. 

The "regional location heating value days" is independent of the number of months and the measurement 

type. It is always applied when the tenant occupied the rental object during only part of the settlement 

period. 

It is recommended that you create a heating days table to adjust the usage-dependent service charges that 

vary with the season, even if you don't want to use a heating days table for settlement. 
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Example 

For the service charge keys " Water" and " Heating" you want to use the method described above for tenants 

who occupied the apartment for a maximum of  months of the old settlement period. You are using heating 

days table HEAT. 

The following entries were made: 

 Water   A residential/usable space             HEAT 

 Heating  A residential/usable space      

The tenant of RO  occupied the object in the last three months of the settlement period // - //. A total cost of  

euros was incurred for the settlement unit "water," and the total area of the SU is  m². The heating 

settlement unit contains the same objects. The cost incurred here is  euros. The residential/usable space of 

RO  is  m². 

The yearly advance payment for water is calculated independently of the actual costs on the rental object 

as follows: 

 euros /  m² *  m² =  euros 

For heating, the heating day table "HEAT" is used. A total value of % was entered for the time period // to //. 

The total heating oil consumed is , liters. The interim meter reading shows that  liters of this were attributed 

to rental object  in the last three months of the settlement period. The yearly advance payment is calculated 

as follows: ( euros /  l ) * ( l / ) =  euros/liter *  liters =  euros 

 Calculation of Adjustment Date 

Use 

Here you specify how the default date for adjustment of advance payments is determined. The default date is 

dependent on the adjustment rule that is assigned to the advance payment on the contract. 

Activities 

For each adjustment rule, specify how long after the adjustment run you want the adjustment condition to 

be set. You enter the number of months, weeks and days that should follow after the system date of the 

adjustment run (see adjustment key date ). The system then determines the valid-from date of the new 

advance payment condition from this information.  If you set the Next First indicator, then the system 

uses the next occurring first day of the month after the originally determined date. 

The due date of the new advance payment condition is not affected by the settings you make here. The due 

date is determined using the same rule that was used on the previously existing advance payment condition. 
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 Implement Enhancements for SCS Adjustment ( BAdI ) 

Use 

You can use this BadI to influence the adjustment process that takes place during 

- Service charge settlement 

- Assessment adjustment (annual budget settlement) 

- Tenant settlement 

. 

The following methods are available in the interface: 

- CHECK_CONDTYPE Checks if the condition type is allowed for adjustments 

You can use the method to extend the adjustment by service charge settlement for rental objects 

to also include conditions, which were not used in the service charge settlement, but are to be 

adjusted in the same way as the condition types used in the settlement. Using an appropriate 

enhancement implementation, you can decide on an individual basis which condition type is 

equivalent to one contained in the settlement, and should therefore be adjusted in the same way. 

Example: 

A contract was settled using the condition type "Operating costs advance payment" 

id_condtype_scsresult. However, the affected rental object contains the condition type 

"Operating costs flat rate". In this case, the condition type "Operating costs flat rate" is not 

adjusted in the standard system. Using an enhancement implementation by means of the 

BAdI, however, you can have the system also adjust this condition, if you set changing 

parameter cf_adjust_condition to abap_true for this condition type (parameter 

id_condtype_foradjm). 

If the changing parameter cf_adjust_condition is set to 'P', the equivalent condition to be 

adjusted is determined for the adjustment object by regenerating the settlement participation. 

- MODIFY_ADJUSTMENT Modifies the adjustment 

This method is called when the standard adjustment already calculated the new condition 

amount. The new condition amount is transferred to the BADI method using the parameter 

cd_unitprice_new . The calculated adjustment date is found in cd_validfrom_new. Both values 

can be changed in the BADI method. In addition, there is the parameter (table) ct_depend, 

which can be used to return additional adjustment amounts (subsequent adjustments). The 

returned values are only considered during the further processing of the program for the 

adjustment if the parameter cf_exit_processed is also set to abap_true. Using the parameter 

ct_message, you can also return messages that are then also displayed in the adjustment log. 

The generated, method-specific adjustment records are contained in tables it_scajro, it_scajrosu 

and it_scajsettlref. Table it_scajrosu contains the proportional costs per settlement unit for the 

rental object/contract. Using this information, you can determine which settlement units are 

relevant for the special condition. 
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- CHANGE_LOC_KEY Changes the regional location key for heating days You use a regional 

location key in the service charge settlement to take heating days into account for cost 

distribution. You have entered this regional location key in the allocation rules of the settlement 

unit. In this case, the system uses the regional location key also for the annual extrapolation of 

costs in the adjustment. 

Using this method, you can change the regional location key (parameter cd_loc_key) 

determined by the program. If an initial value is returned, then no regional location key is 

considered during the further run of the program. The import parameters have the following 

meanings: 

- io_bus_object - Adjustment object (either contract or rental object) 

- id_nksl - Service charge key 

- it_list_shareout  - Allocation rules of settlement unit 

- it_adjmnksl - Adjustment parameter per service charge key that is passed on when the adjustment 

is executed 

- id_loc_key - Regional location key that is entered in Customizing for the service charge key 

- INCLUDE_LEAPYEAR Consider leap year? 

With regard to the handling of leap years, the standard adjustment works as follows: First the 

system determines the costs of the settlement period that forms the basis for the adjustment of 

the advance payment condition. From these values, the system calculates the new values for the 

conditions, taking the lengths of the periods into account. 

Assessment adjustment based on annual budget: Since the adjustment is based on the 

planned costs at the time of the adjustment, the leap year is not considered here. This means 

that the planned costs in a leap year, which are based on  days, are used as the calculation base 

for the new advance payment amount. Adjustment of advance payments based on service 

charge settlement or tenant settlement: The new advance payments relate to the costs of a 

previous settlement period. Therefore, the leap year is considered in these cases. This means 

that the settled costs of a leap year ( days) are converted to  days, and this converted amount is 

used as the basis for the new advance payment amount. Using the method 

INCLUDE_LEAPYEAR, you can override this standard behavior as best suits your needs. 

This method is called only when the settlement period is a leap year. The method has the 

following import parameters: 

- io_bus_object: Returns the adjustment object (contract or rental object) 

- io_settl_unit: Returns the settlement unit, the costs of which are currently under consideration 

- is_condition: Returns the condition that is adjusted 

- id_process : Returns the process ID (REAA for assessment adjustment, RECO for 

COA settlement, RESC for service charge settlement, RETN for tenant settlement of 

COA) 

Using the changing parameter cf_include_leapyear, you can control how a leap year is taken into 

account. There is a default value for the parameter based on the system behavior. If the field 

contains an 'X', then the costs that are based on  days should be converted to . 
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- CHANGE_PERIOD_PARTICIPATION Changes the period used for settlement participation 

For an adjustment, the system considers special agreements in the settlement participation 

(maximum costs and tenant share) that are effective at the time of the adjustment. Using this 

method, you can change the time period determined by the program for determining the 

relevant settlement participation ( parameters 

CD_DATE_FROM and CD_DATE_TO). The import parameters have the following meanings: 

- IO_CONTRACT - Contract to be adjusted 

- IO_RENTAL_OBJECT - Assigned rental object - IO_SETTL_UNIT - Relevant settlement 

unit 

Example 

For an example implementation, see the class CL_EXM_IM_RESC_SETTLSTEP_AJ. Notes for 

Developers 

 Accrual/Deferral of Service Charges/Display Costs Not Settled 

 Accrual/Deferral of Service Charges 

Use 

The service charges that come due during the course of the year are collected on settlement units and are 

thereby recorded as costs in the profit and loss statement. 

Depending on how the contract conditions for advance payments for service charges are defined, these 

advance payments either appear in the balance sheet (posted as advance payments to a special G/L account) 

or in the profit and loss statement as revenue. 

Using the function for accrual/deferral of service charges, you can have the system list costs and advance 

payments that are due totaled by business entity and service charge group. ( This groups together 

different settlement units based on their service charge keys.) This evaluation is based on a simulation of 

service charge settlement. 

During this process, the system determines the following for each business entity and service charge group: 

- External apportionable costs 

- Costs that arise on vacant rental objects 

- Costs that arise on your own contracts for internal use - Costs that cannot  be apportioned due to 

settlement participation and 
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- Advance payments that were already made for these costs, and which are recorded in the balance sheet 

- Advance payments that were already made for these costs, and which are recorded in the profit and loss 

statement ("Advance Payments as Revenue") 

- Advance payments that were posted for vacant rental objects 

In Customizing, you specify if any of these cost groups are transferred during accrual/deferral. The user 

can still change the amounts before the transfer (for example, because the result of the simulation does 

not correspond to the actually expected rental situation). 

Standard Customizing is set up so that external apportionable costs and advance payments as revenue (with 

inverse posting to the costs) are accrued/deferred. This means that those costs are accrued/deferred that can 

be apportioned externally and for which the advance payments are recorded in the balance sheet. 

Activities 

In this section, you define the service charge groups and assign flow types to them for accrual/deferral. 

You also specify which service charge keys belong to which service charge group. You assign the flow 

types themselves and the resulting account determination in the IMG activities of these sections: 

Condition Types and Flow Types  and Accounting. You assign service charge groups to advance 

payments for settlement participation in the IMG activities of this section: Service Charge Settlement -> 

Settings for Rental Objects and Contracts Participating in Settlement. 

The relevant sections are linked in the IMG documentation for defining service charge groups. 

If you want to use different settlement schemas for accrual/deferral, you need to make additional settings 

for the settlement schema by choosing Service Charge Settlement -> Settlement Process -> Define 

Settlement Parameters. Specify there which settlement schemas are active for accrual/deferral. 

 Assign Condition Type to Service Charge Key/Group 

Use 

Here you specify which conditions for service charge advance payments and which conditions for flat 

payments are cleared against each other. 

Activities 

The various control options are described below. Make an entry in the table for each condition for advance 

payments and each condition for flat-rate payments. Specify the following for each entry: 

- Whether the condition type is only allowed to be cleared by costs of certain service charge keys 
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- Whether the condition type can be cleared by all costs on the settlement units of a certain service 

charge group 

- Whether the condition type can be cleared by all costs in the categories "Operating Costs"/"Heating 

Costs" or "Operating and Heating Costs" 

Use 

For the system to be able to check or generate the settlement participation, the condition types, which play a 

role in service charge settlement (advance payments and flat payments), must be linked to the service charge 

key. This can be done as follows: 

- The advance payment condition type is assigned directly to the relevant service charge key Example: 

Condition type:  Elevator advance payment 

Service charge key:  Elevator 

Service charge category:  No general costs ( SCK-specific ) 

Service charge group: < blank > 

- A service charge group is assigned to the advance payment condition type: 

Example: 

Condition type:  Caretaker services advance payment 

Service charge key: < blank > 

Service charge category: <anything> 

Service charge group: Caretaker services 

(The service charge group is assigned in Customizing, for example, to the service charge keys  

Gardening 

 Caretaker 

 House cleaning 

.) 

- The service charge category "operating costs" or "heating expenses" is assigned to the advance 

payment condition type: 

Example: 

Condition type:  Operating costs advance payment 

Service charge key: < blank > 

Service charge category:  Operating costs 

Service charge group: < blank > 

The service charge key is settled, for which in Customizing in the definition of the service charge key, 

you set the operating costs indicator. 

Advance payment condition types valid for operating costs and heating expenses have service 

charge category  - general service charges. 

Example: 

Condition type:  operating costs/heating expenses advance payment 

Service charge key: < blank > 

Service charge category:  - General service charges 

Service charge group: < blank > 
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The settlement participation is generated/checked when you create/change an occupancy contract and 

during service charge settlement.  The system determines the settlement units, to which the rental objects 

are assigned, and which are leased out in this contract. It also attempts to assign the advance payment and 

flat payment condition types that are assigned here. To do this, proceed as follows: 

- First the system searches for an advance payment condition type that is defined exactly for this 

service charge key (see first point above). 

- Then it searches for an advance payment condition type that belongs to the service charge group of 

the service charge key (see the second point above). 

- Finally, it searches for an advance payment condition type that belongs to the category "operating 

costs" or "heating expenses" (depending on whether the operating costs or heating expenses 

indicator is set for the service charge key). 

- If it still cannot assign any condition type, the system searches whether the contract has a condition 

type that is specified in Customizing with the service charge category " General Service Charge." 

- If this condition type also does not exist, the system assumes, depending on the setting in 

Customizing for the Defaults for Settlement Participation per Service Charge Key that it is a final 

settlement (for which no condition type is required) or that the contract does not participate in this 

settlement unit. 

Example 

The advance payment conditions and service charge key are set up as specified in the examples above. 

There are settlement units for the following service charge keys: 

 Property damage and liability insurance 

 Water supply 

 Elevator 

 Street cleaning 

 Garbage removal/disposal 

 Broad band cable network 

 Caretaker 

 House cleaning 

  Heating expenses 

They are all marked as "operating expenses" except for service charge key . 

- For contract , it is listed explicitly which advance payments have been made for which costs. The 

following conditions are defined: 

 operating costs advance payment 

 Elevator advance payment 

 Caretaker services advance payment 

In the settlement participation, the advance payments for this contract are assigned to the advance 

payment condition types as follows: 
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 Property damage and liability insurance  ->  operating costs advance payment 

 Water supply  ->  operating costs advance payment 

 Elevator  ->  Elevator advance payment 

 Street cleaning  ->  operating costs advance payment 

 Garbage removal/disposal  ->  operating costs advance payment 

 Broad band cable network  ->  operating costs advance payment 

 Caretaker  ->  Caretaker services advance payment 

 House cleaning  ->  Caretaker services advance payment 

  Heating expenses  -> No assignment 

- Contract  only has the condition " operating costs advance payment". For this contract, all service 

charge keys except for  are assigned to the condition type  -> operating costs advance payment. 

No condition type can be assigned for both contracts for the settlement unit with the service charge key . It 

would be designated as a final settlement if this has been set up in Customizing. 

 Define Service Charge Groups and Accrual/Deferral of Service Charges 

Use 

You define service charge groups here. These are used for the following purposes: 

- If you want to use functions for accrual and deferral of service charges, then it is mandatory that 

you define at least one service charge group. You can leave the key of this service charge group 

blank. Then all service charge keys are automatically assigned to this service charge group. 

- You can choose to use service charge groups as a means of controlling settlement participation. 

Using service charge groups can be beneficial if you have an advance payment condition which, 

although it is not assignable to a particular service charge key, is also not valid for all service charge 

keys that are designated for operating or heating costs. 

- When you start a settlement, you can select only those service charge keys belonging to a particular 

service charge group. 

- Certain reports for service charge settlement use the service charge group; so if you use appropriate 

layouts, you can display subtotals for each service charge group. 

Standard settings 

Three service charge groups are provided in standard Customizing. The third of these service charge 

groups is used only to identify advance payments that are not clearly classified as heating costs or 

operating costs. 
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According to standard Customizing, only those costs are transferred that are cleared against advance 

payments, and those which, as long as settlement did not take place, are posted on reconciliation accounts 

of the special general ledger. Therefore, the standard system provides flow type ACC for external 

apportionable costs and flow type ACP for advance payments posted as revenue. These flow types are set 

up so that a value posted using ACC is offset by a value posted using ACP. This means that external 

apportionable costs are accrued/deferred after the deduction of advance payments posted as revenue. 

Activities 

- Create the service charge groups that you need in order to generate settlement participation 

and/or to post accrual or deferral of service charges. 

- Assign flow types to the service charge groups. If you want to transfer only costs during 

accrual/deferral , then enter only values for the flow types that are within the context of costs. 

Standard Customizing is set up so that the system generates accrual/deferral postings for those 

costs from advance payments that are posted on the special general ledger reconciliation 

account as long as settlement did not yet take place. All other costs are not accrued/deferred, 

according to the settings in standard Customizing. To improve performance, the system only 

determines advance payments when this is set up in Customizing for the settlement parameters 

(which you also have to enter during settlement). If this is set up, but no flow types are defined, 

then the system determines the advance payments and displays them as information, but they 

are not transferred. 

- The flow types you assign here have to have been defined already in Customizing for flow 

types. 

- Then assign account symbols to all your newly created flow types in the Assign Account 

Symbol to Flow Type IMG activity. 

- Assign your newly created account symbols to FI accounts in the Replace Account Symbols 

IMG activity. Make sure that the account for the accrual/deferral amount is on the debit side and 

the account for offsetting the accrual/deferral is on the credit side. 

- Then, when you define the service charge key, assign the service charge group that you want the 

service charge key to belong to. 

- If your settlement participation definition is currently set up so that the same advance payment 

condition type is used for different service charge keys, then it can be helpful to group these 

service charge keys together in a service charge group. If you also use the predefined service 

charge groups "operating costs" and "heating costs" then you should also define a service charge 

group, to which you assign these advance payments in settlement participation. No service 

charge keys are then explicitly assigned to this group. In reporting for accruals/deferrals, while 

the advance payments in this group are displayed, they are not shown in relation to the 

corresponding costs. 

If you do not need service charge groups for generating settlement participation or for reporting, but only 

for accruals and deferrals, you have two options: 

- You can create just one service charge group but leave the key blank. In that case, the system 

treats all service charge keys and all advance payment condition types the same during 

accrual/deferral. You do not need to make any other assignments. 
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- You can create two service charge groups: "operating costs" and "heating costs." In this case, 

you have to assign these groups in the IMG activities for defining your service charge keys and 

defining settlement participation. The advantage here is that since you use different flow types 

for the accrual/deferral of operating costs and for the accrual/deferral of heating costs, you can 

use different accounts for them. 

 Assign Service Charge Group to Service Charge Keys 

Use 

Here you assign service charge keys you already defined to service charge groups. This is the same IMG 

activity as the one for defining the service charge keys. 

Activities 

Select the service charge keys you want to assign to a service charge group and choose Details. On the detail 

screen, you can assign the service charge group. 

For the meanings of the other settings, see the Define Service Charge Keys IMG activity. 

 Define Accrual/Deferral Reporting 

Use 

You maintain the indicator for controlling the list output for service charge settlement and settlements in 

COA (condominium owners' association). 

 Controlling 

 Planning 

 Maintain Planning Layouts for Cost Element Planning 

Use 

To be able to plan for cost elements, you first need to define the planning layout. In the planning layout, 

you specify the format of the planning screens. 
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Requirements 

In the standard SAP System, planning layouts are found only in client . To use them as models for user-

defined planning layouts, they must be taken from client  and imported to your production client. Use the 

IMG General Controlling under the section Prepare Production Startup -> Transport System 

Settings -> Transport Planning Settings -> Import Standard Planning Layouts. 

Recommendation 

After installing a new release or update, you should repeat the import of standard planning layouts from 

client  in order to access the latest layouts. 

Activities 

1. Create planning layouts for cost element 

planning based on your requirements. 

2. Change an existing planning layout. Further 

notes 

Procedure for Creating Planning Layouts 

Notes on transport 

For the transport of planning layouts, an individual function is available in Customizing under Controlling -

> General Controlling -> Production Startup Preparation -> Transport System Settings -> 
Transport System Settings -> Transport Planning Layouts.  

Example 

Requirements 

Standard settings 

Recommendation 

Activities 

Further notes 
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 Maintain Planning Layouts for Statistical Key Figures 

Use 

To be able to plan statistical key figures, you first need to define planning layouts for planning statistical key 

figures. You specify the layout of the planning screens in these planning layouts. 

Requirements 

In the standard SAP System, planning layouts are found only in client . To use them as models for user-

defined planning layouts, they must be taken from client  and imported to your production client. Use the 

IMG General Controlling under the section Prepare Production Startup -> Transport System 

Settings -> Transport Planning Settings -> Import Standard Planning Layouts. 

Recommendation 

After installing a new release or update, you should repeat the import of standard planning layouts from 

client  in order to access the latest layouts. 

Activities 

1. Create planning layouts according to your requirements for the planning of statistical key figures. 

2. Change an existing planning layout. 

Additional Notes 

Procedure for Creating Planning Layouts 

Note on transport 

For the transport of planning layouts, an separate function is available in Customizing for Controlling -> 

General Controlling -> Production Start-Up Preparation -> Transport System Settings -> Transport 
Settings for Planning -> Transport Planning Layouts. 

Example 

Requirements 

Standard settings 

Recommendation 
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Activities 

Further notes 

 Import Planning Layouts 

Use 

In this step you import standard planning layouts from client  to the clients in which you are logged on. 

This import can either be carried out online or in the background. 

After a new release or update of the SAP System, the import from client  should be repeated in order to 

access the current standard planning layouts. 

Standard SAP planning layouts 

SAP offers the following standard planning layouts: 

Cost Center Accounting 

Cost Element/Activity Input Planning 

- - CCtr: Cost elements, activity-dependent/-independent 

- - CCtr: Activity inputs, activity-dependent/-independent 

- - CCtr: Costs/revenues/consumption 

- - CCtr: Primary/secondary order costs 

- - CCtr: Cost elements, simplified 

- - CCtr: Cost element central planning, simplified 

- - CCtr: Cost elements in transaction currency 

- - CCtr: Cost element comparison,  quarters 

- - CCtr: Cost element planning,  versions 

- - CCtr: Cost elements with display of previous year 

- - CCtr: Activity output from sender viewpoint 

- - CCtr: Cost element central planning 

- - CCtr: Cost element plan/actual comparison 

Activity/Activity Price Planning 
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- - CCtr: Activity types/prices, standard 

- -C CCtrs: Activity types/prices, central planning 

- - PP planning: Activity types/prices 

- - ATyp: Actual activity price indicator and switch structure 

- - CCtr: Activity types/prices, attributes 

- - CCtr: Activity price, simplified 

- - CCtr: Activity price, centralized 

Manual Actual Prices 

- -N CCtr: Manual actual prices, cost centers 

Resource Planning 

- -R CCtr: Resource planning 

- -R Orders: Resource planning 

- -R WBS elements: Resource planning 

Dependency planning 
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-R: CCtr:   Value-based recipe planning 

-R: KoStellen:   Quantity-based recipe planning 

Statistical Key Figure Planning 

- - CCtr: Statistical key figures, standard 

- - CCtr: Statistical key figures, activity-dependent 

- -C CCtr: Statistical key figures, central 

- - CCtr: Statistical key figures, simplified 

- - CCtr: Statistical key figures, centralized 

Internal Orders 

Cost/Revenue Element Planning 

- - Orders: Cost elements, standard 

- - Orders: Activity inputs, standard 

- -P: Orders: Process inputs 

- - Orders: Primary/secondary order costs 

Cost Planning/Activity Input Planning 

- - Cost elements: Simplified layout 

- - Cost elements: Simplified layout, central 

Statistical Key Figure Planning 

- - Orders: Statistical key figures, standard 

- -C: Orders: Statistical key figures, central 

- - Statistical key figures, simplified 

- - Statistical key figures, simplified, central 

Project Cost Controlling 

Cost Element/Activity Input Planning 

- - WBS elements: Cost element planning 

- - WBS elements: Activity inputs 

- -P: WBS elements: Process inputs 

- - WBS elements: Revenues, revenue cost elements 

- -: WBS elements: Primary/secondary order costs 

Statistical Key Figure Planning 
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- - WBS elements: Statistical key figures, standard - -C WBS elements: Statistical key figures, central 

- -C Networks: Statistical key figures 

- -C Networks: Statistical key figures 

- -CC Networks:Statistical key figures, central 

Activity-Based Costing 

Cost Planning/Activity Input Planning 

- -P Processes: Primary/secondary order costs, processes 

- -P Processes: Activity-dependent/-independent process inputs 

- -D Processes: Cost elements 

- -D Processes: Activity inputs 

- -DP Processes: Process inputs 

Quantities and Prices 

-E Processes: Quantity planning/price planning 

-E Processes: Tax codes 

Statistical Key Figure Planning 

- -F Processes: Statistical key figures, standard - -FC Processes: Statistical key figures, central 

Manual Actual Prices 

- -Q Processes: Manual actual prices, business processes 

Cost Object Accounting 

Cost/Activity Input Planning 

- -G Cost object: Primary costs 

- -G Cost object: Activity inputs, standard 

- -GP Cost object: Process inputs 

Statistical Key Figure Planning 

- -I Cost objects: Statistical key figures, standard 

- -IC  Cost objects: Statistical key figures, central 

Real Estate 

Cost element allocation/activity allocation 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 363 

- -J- Business entity: Cost elements, standard 

- -J- Buildings: Cost elements, standard 

- -J- Property:  Cost elements, standard 

- -J- Rental unit: Cost elements, standard 

- -J- Rental agreement: Cost elements, standard 

- -J- Management contract: Cost elements, standard 

-J- Business entity: Activity inputs, standard 

-J- Buildings: Activity inputs, standard 

- -J- Property: Activity inputs, standard 

- -J- Rental unit: Activity inputs, standard 

- -J- Rental agreement: Activity inputs, standard 

- -J- Management contract: Activity inputs, standard 

Note 

You cannot change standard planning layouts. 

The names of these standard planning layouts begin with a numeral. 

Standard settings 

The standard R/ System stores planning layouts in client  only. To use the layouts, they must be 

transported from client  to the production client. 

Activities 

. Check which planning layouts you require .

 Choose the corresponding layouts in the list 

. Import the layouts either: 

a) Online, with Execute or 

b) In background, with Execute in background. 

Note 

If possible, you should use background jobs and import during times of low system usage. 
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 Transport Planning Layouts 

Use 

In this step you import standard planning layouts from client  to the clients in which you are logged on. 

This import can either be carried out online or in the background. 

After a new release or update of the SAP System, the import from client  should be repeated in order to 

access the current standard planning layouts. 

Standard SAP planning layouts SAP offers the 

following standard planning layouts: 

Cost Center Accounting 

Cost Element/Activity Input Planning 

- - CCtr: Cost elements, activity-dependent/-independent 

- - CCtr: Activity inputs, activity-dependent/-independent 

- - CCtr: Costs/revenues/consumption 

- - CCtr: Primary/secondary order costs 

- - CCtr: Cost elements, simplified 

- - CCtr: Cost element central planning, simplified 

- - CCtr: Cost elements in transaction currency 

- - CCtr: Cost element comparison,  quarters 

- - CCtr: Cost element planning,  versions 

- - CCtr: Cost elements with display of previous year 

- - CCtr: Activity output from sender viewpoint 

- - CCtr: Cost element central planning 

- - CCtr: Cost element plan/actual comparison 

Activity/Activity Price Planning 

- - CCtr: Activity types/prices, standard 

- -C CCtrs: Activity types/prices, central planning 

- - PP planning: Activity types/prices 
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- - ATyp: Actual activity price indicator and switch structure 

- - CCtr: Activity types/prices, attributes 

- - CCtr: Activity price, simplified 

- - CCtr: Activity price, centralized 

Manual Actual Prices 

- -N CCtr: Manual actual prices, cost centers 

Resource Planning 

- -R CCtr: Resource planning 

- -R Orders: Resource planning 

- -R WBS elements: Resource planning 

Dependency planning 

- -R: CCtr:   Value-based recipe planning 

- -R: KoStellen:   Quantity-based recipe planning 

Statistical Key Figure Planning 

1-301 CCtr: Statistical key figures, standard 

1-302 CCtr: Statistical key figures, activity-dependent 

- -C CCtr: Statistical key figures, central 

- - CCtr: Statistical key figures, simplified 

- - CCtr: Statistical key figures, centralized 

Internal Orders 

Cost/Revenue Element Planning 

- - Orders: Cost elements, standard 

- - Orders: Activity inputs, standard 

- -P: Orders: Process inputs 

- - Orders: Primary/secondary order costs 

Cost Planning/Activity Input Planning 

- - Cost elements: Simplified layout 

- - Cost elements: Simplified layout, central 

Statistical Key Figure Planning 

- - Orders: Statistical key figures, standard 
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- -C: Orders: Statistical key figures, central 

- - Statistical key figures, simplified 

- - Statistical key figures, simplified, central 

Project Cost Controlling 

Cost Element/Activity Input Planning 

- - WBS elements: Cost element planning 

- - WBS elements: Activity inputs 

- -P: WBS elements: Process inputs 

- - WBS elements: Revenues, revenue cost elements 

- -: WBS elements: Primary/secondary order costs 

Statistical Key Figure Planning 

- - WBS elements: Statistical key figures, standard - -C WBS elements: Statistical key figures, central 

- -C Networks: Statistical key figures - -C Networks: Statistical key figures 

- -CC Networks:Statistical key figures, central 

Activity-Based Costing 

Cost Planning/Activity Input Planning 

- -P Processes: Primary/secondary order costs, processes 

- -P Processes: Activity-dependent/-independent process inputs 

- -D Processes: Cost elements 

- -D Processes: Activity inputs 

- -DP Processes: Process inputs 

Quantities and Prices 

-E Processes: Quantity planning/price planning 

-E Processes: Tax codes 

Statistical Key Figure Planning 

- -F Processes: Statistical key figures, standard - -FC Processes: Statistical key figures, central 

Manual Actual Prices 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 367 

- -Q Processes: Manual actual prices, business processes 

Cost Object Accounting 

Cost/Activity Input Planning 

- -G Cost object: Primary costs 

- -G Cost object: Activity inputs, standard 

- -GP Cost object: Process inputs 

Statistical Key Figure Planning 

- -I Cost objects: Statistical key figures, standard 

- -IC  Cost objects: Statistical key figures, central 

Real Estate 

Cost element allocation/activity allocation 

- -J- Business entity: Cost elements, standard 

- -J- Buildings: Cost elements, standard 

- -J- Property:  Cost elements, standard 

- -J- Rental unit: Cost elements, standard 

- -J- Rental agreement: Cost elements, standard 

- -J- Management contract: Cost elements, standard 

- -J- Business entity: Activity inputs, standard 

- -J- Buildings: Activity inputs, standard 

- -J- Property: Activity inputs, standard 

-J- Rental unit: Activity inputs, standard 

-J- Rental agreement: Activity inputs, standard 

- -J- Management contract: Activity inputs, standard 

Note 

You cannot change standard planning layouts. 

The names of these standard planning layouts begin with a numeral. 

Standard settings 

The standard R/ System stores planning layouts in client  only. To use the layouts, they must be 

transported from client  to the production client. 
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Activities 

. Check which planning layouts you require .

 Choose the corresponding layouts in the list 

. Import the layouts either: 

a) Online, with Execute or 

b) In background, with Execute in background. 

Note 

If possible, you should use background jobs and import during times of low system usage. 

 Define User-Defined Planner Profiles 

Use 

You use planner profiles to control the way planning is carried out. In a planner profile, you specify per 

planning area which planning layout is to be used with which default values. Per planning area, you can 

create as many planning layouts as you require. The profile item determines the order of the planning 

layouts within a planning area and can be used to assign the same planning layout to a planner profile in 

multiple areas, but with a different default setting each time. 

Planner profiles are hierarchically structured as follows: 

- Planner Profile 

- General Controlling 

- Layouts Controlling 

- Default Parameters 

- Planner Profile 

You can assign an  authorization group to every standard profile and every planner profile that you 

create in the Profile planning overview. 
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The combination of authorization groups and locked default settings (see Default layout) results in 

highly detailed authorization assignments for entering planning data. All the planner profiles in the 

system are defaulted. This is regardless of the component in which you wish to call up planner 

profile processing. This enables you to define allowed entries of planner profiles from other 

components, for each component chosen. 

- General Controlling 

For each planner profile, the system recommends different planning areas, depending on the 

application component. You can create additional planning areas. 

In CuDK you can enter a default value for a distribution key for currency amounts. 

In QtDK you can enter a default value for a distribution key for quantities. The system uses these 

default values for combinations that have not yet been planned, even if you have not selected a 

distribution key in the definition of the planning layout. 

- Layout Controlling 

In each planning area, you determine which planning layouts appear in which sequence. For each 

planning area, you must define at least one profile item and assign a planning layout. 

The Deflt indicator shows whether settings already exist (see: Default settings layout). If you 

deactivate the Over. (=Default settings not protected) indicator, the user must use the entries given 

in planning and may use only the defaulted variables. If the indicator is active, the entries are default 

values which can be overwritten when entering planning. The Excel integration indicator gives you 

the option of entering planning data in an Excel worksheet. If the indicator is active, you can use 

Excel to make your entries. The file description influences the layout of the worksheet. If you move 

the planning data (that you entered in the system) within the worksheet, the file description creates 

the link between the old data and the new location. 

You can also find further information on preparation for planning with Excel in the SAP 

Library under Financials -> CO Controlling -> Cost Center Accounting -> Cost Center 

Planning -> Manual Planning -> Techniques for Supporting Manual Planning -> Integrated 
Excel in Planning. 

- Default parameters 

You can enter default parameters for the selection of planning data of each item in the assigned 

planning layout. 

All variables defined in a layout are referenced during planning as parameters, which you can set 

with values per profile item. 

If you undertake decentralized planning in your organization, the planner profiles assist the organizational 

aspects of the planning process. You can assign particular user groups to profiles in which objects have 

already been preset and precisely delimited. 



 

 

Example 

You set general selection criteria (fiscal year, version, periods and transaction currency) in your planning 

layout PRIMARY. 

From an organizational perspective, it was decided that the cost center managers decentrally plan the 

material expenses first, followed by the personnel expenses. 

- In the Planning profile overview create the planning profile "PLAN". 

- Choose the planning profile "PLAN" and CO General Settings. 

- Choose the planning area "Cost centers: Cost elements/acty inputs" and Layouts CO general. 

- Enter the planning layout "PRIMARY" with both item number  and item number . 

- Choose the item "" and Default parameters and enter the cost element group for material expenses. 

- Choose the item "" and Default parameters and enter the cost element group for personnel 

expenses. 

Also assign the cost center managers in the user parameters to planner profile PLAN via the parameter ID 

"PPP". To do so, choose System -> User profile -> User parameters. 

When the cost center manager calls up planning by choosing "Planning -> CElems/Actvty input -> 

Change", the system suggests profile PLAN and branches to planning layout PRIMARY with the plan 

costs for material expenses. The cost center manager can now enter the plan data and, after it is saved, 

can go to other planning by choosing Next layout. 

Requirements 

To create entire planner profiles, the planning layouts used must be available. Complete the IMG activity 

Create Planning Layout. 

Standard settings 

The standard system includes several defined planner profiles. The names of the profiles begin with SAP. 

These are protected, meaning you cannot create custom profiles beginning with "SAP". 

Note 

Note that as of Release A, the planner profile SAP, SAP, SAP, and SAP and the planning layouts - to - 

contained in these profiles are no longer maintained by SAP. 

Activities 

To assign planner profiles to authorization groups, create the necessary groups in the IMG activity 

Create Custom Authorization Groups. You can use the authorization groups to control which users 

have access to which planner profiles. Assign authorizations with the authorization object "CO: Planner 

Profiles" ( K_TKA ). 
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To create planner profiles, proceed as follows 

1. CO Planner Profile Overview 

a) To create a new planner profile, choose New entries. 

To copy an existing profile, select a reference and choose Edit -> Copy as. 

b) Enter a name and explanatory short text for the object. 

c) If necessary, assign an authorization group to the planner profile. 

2. General Controlling 

a) Select the suggested planning area for which you want to make settings and choose Settings 

for General Controlling. 

b) To create a new planning area, choose New entries. 

3. Layouts for Controlling 

a) Select a planning area for which you want to make settings and choose Layouts for General 

Controlling. 

b) Choose New entries and enter an item and previously defined layout. 

c) Activate the indicator Default settings not protected if users may overwrite the defaulted 

variables. 

d) Activate Excel integration if you want to enter your planning data in an excel worksheet. 

e) Enter a name for the file description. 

If you do not enter a name, the system automatically assigns a name when you save the file. 

f) Save your entries and return to the layout overview screen. 

4. Layout Default Settings 

a) Select a planning area for which you want to make settings and choose Layout Controlling. 

b) Set the parameters of the defined variables per profile item for the planning layout. 

Notes 

To define the excel worksheet, at least one row must exist on the screen. For this reason, you 

need to enter example data as dummy data in the SAP System using the planning layout. 

To be able to plan directly using the corresponding planning layout, you may need to reset any 

planner profile that has been set under Planning -> Set planner profile. 

5. Optional steps: 

- Authorizations 

In the IMG activity Authorization Management, set authorizations as required for object 

K_TKA and assign the authorizations to the authorization profiles of the appropriate users. 

- User parameters 

Assign parameter ID PPP to the users who are to work with the profile in the user parameters 

(choose System -> User profile -> User parameters). 

- Deleting planner profiles 



 

 

When you delete a planner profile, the system checks whether the profile is also used in other 

components. If it is, you first need to delete the dependent entries for the planner profile in all 

components, before you can delete the planner profile itself. 

Note on transport 

To transport planner profiles, see the General Controlling Customizing -> Production 

Start-Up Preparation -> System Configuration Transport -> Planning Configuration Transport -> 
Transport Other Planning Configurations. You can use this function to transport the complete set of 

planner profiles from a test to a productive client. 

Planner profile maintenance is connected to the automatic recording of transport data. 

This also includes the settings for integrated Excel. The system includes file descriptions and Excel sheet 

templates in the transport request, provided you have created them in Customizing. 

The system also transports the settings for integrated Excel if you have manually included a planner 

profile in - or manually deleted a planner profile from - a transport request (you do both by choosing 

Table View -> Transport). 

Warning 

- When performing the transport, ensure that you have not manually created any integrated Excel 
settings in the target system. 

Only supply the target system by means of transports, otherwise inconsistencies could arise. When 

importing the Excel sheet templates from the source system, the system does not overwrite the 

settings already made in the target system. 

- If, however, planner profiles with corresponding Excel sheet templates already exist in the target 

system, you have to delete them before performing any imports. In planner profile maintenance, you 

can delete these Excel sheet templates for specific planner profiles or profile items. 

Further notes 

You can find more information on planner profiles in the SAP Library under Financials -> 

CO Controlling -> Cost Center Accounting -> Cost Center Planning -> Manual Planning -> 
Planning Techniques -> Planning Screen Layout -> Planner Profiles. 

Example 

Requirements 

Standard settings 

Recommendation 
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Activities 

Further notes 

 Actual Postings 

 Assign Measurement Types to Statistical Key Figures 

Use 

To use measurement types in Controlling (CO) as statistical key figures, you can use a function to 

automatically transfer measurement types to statistical key figures. 

Here you define which measurement types you want to change into which statistical key figures. 

Activities 

- For each statistical key figure that you want to derive from measurement values, specify for 

which object type this should be valid. You can choose the following object types (= target 

object type) for this: 

- Business entity 

- Building - Property - Settlement unit 

- Specify from which level the measurement types should come (= source object type). This can 

either be the same object type as the target object type (if the measurement values are defined 

on the same object) or a hierarchically lower level. Therefore, it is possible to determine the 

statistical key figure AREA of a business entity from measurement type A of the rental objects. 

If the there is no entry in the field on the source object, then the system uses the target object 

type to determine the measurement values. You can also use total measurement types. 

Example 



 

 

You want to transfer the measurement residential space for business entities to a statistical key figure. For 

the measurement amount, you want to use the residential space of rental objects subordinate to a business 

entity. 

To achieve this, you specify the following: 

Target object type:   Business entity 

Source object type:   Rental object 

 CO Settlement 

 Edit Settlement Structure 

During settlement, costs incurred under the primary and secondary cost elements by a sender are 

allocated to one or more receivers. When you settle by cost element, you settle using the appropriate 

original cost element. 

An allocation structure comprises one or several settlement assignments. An assignment shows which 

costs (origin: cost element groups from debit cost elements) are to be settled to which receiver type (for 

example, cost center, order, and so on). 

You have two alternatives in settlement assignment: 

- You assign the debit cost element groups to a settlement cost element. 

- You settle by cost element - that is, the debit cost element is the settlement cost element. This is a 

good idea, for example, if the required capital spending for an asset you are building yourself is to 

be monitored. These costs are settled by cost element to an inventory account in Asset Accounting at 

the end of the year, or when the measure is complete. 

Each allocation structure must fulfil the following criteria: 

- Completeness 

An allocation structure is assigned to each object to be settled. All cost elements in which costs 

are incurred, must be represented in the appropriate allocation structure. - Uniqueness 

Each cost element in which costs are incurred may only appear once in an allocation structure. 

Only one settlement cost element may be assigned to a source within a particular allocation 

structure. 

If you require additional debit- or settlement cost elements, you can create these using the function 

Maintain Settlement Cost Elements. 

Note 

When you settle to materials you do not need to create settlement cost elements. 

Activities 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 375 

You create an allocation structure as follows: 

1. Choose New entries and issue identification code and a description for your allocation structure. 

2. Choose Assignments to create a settlement assignment. 

3. Choose New entries and create one or more settlement assigments for your settlement structure. 

4. Highlight the settlement assignment required and choose source. 

Specify the cost elements or the cost element group that are to be settled to particular senders using 

the same settlement cost element. 

If you specify cost element groups assigned to your controlling area, but not yet in the account plan, 

you can use this opportunity to create them. 

5. By choosing settlement cost element you have two alternatives: 

- You assign a account assignment category to the source by receiver category. 

- Choose "By cost element" for the receiver categories that you wish to settle by cost element 

(debit cost element = settlement cost element). 

To improve performance, use as few differing settlement cost elements as possible. You should 

try to use settlement by cost element as sparingly as possible. 

To obtain a hierarchy listing of an allocation structure from the system , choose "Extras -> Overview list" 

in the allocation structures overview. 

 Edit Source Structure 

In this IMG activity, you define the source structures used when settling and costing joint products. 

A source structure contains several source assignments, each of which contains the individual cost 

elements or cost element intervals to be settled using the same distribution rules. 

In the settlement rule for the sender you can define one distribution rule, in which you specify 

the distribution and receivers for the costs for each source assignment. 

Example 

The object in question has incurred both direct and overhead costs. The direct costs are to be divided % 

each between a fixed asset and a cost center, while the overhead is to be settled in full to an 

administration cost center in CO. 

To do this, you would create a source structure with two source assignments: 

1. Direct cost elements 

2. Overhead cost elements 

Activities 



 

 

Check whether you need to use source structures in your settlement procedures. If you are settling to cost 

elements, you do not need a source structure. Otherwise, create a source structure as follows: 

1. Choose New entries, then enter a key and an explanatory text. 

2. Choose assignments. 

3. Choose source data and if requested, set the controlling area. 

4. Choose New entries and store individual cost elements, cost element intervals or cost element 

groups. Save your entries. 

 Edit PA Transfer Structure 

In the PA transfer structure, you determine which cost element groups are assigned to which value fields 

in Profitability Analysis (CO-PA). You make these assignments within so-called "assignment lines". 

Settlement lets you transfer costs, revenues, sales deductions and production variances to costing-based 

Profitability Analysis. The PA transfer structure defines which quantities or values of a sender are to be 

transferred to which value fields in CO-PA as part of settlement. For example, in the case of a marketing 

order, you can assign the cost element group "Personnel costs" to value field VTRGK (= Sales 

overhead). 

Assigning to Value Fields 

You assign value fields in a PA transfer structure in the individual assignment lines. Values and quantities 

must be transferred to different value fields. Values can be assigned separately according to the fixed and 

variable portions (fixed/variable indicator "" and "", respectively) or in total (fixed/variable indicator ""). 

You can assign the fixed and variable costs that are incurred by a cost element group to different value 

fields. 

PA tran. Assignment  Qty/ Fixed/ Value 

structure line   value var.   field  

GK   Personnel costs     VTRGK 

GK   Material costs     VTRGK 

GK   Other costs     VTRGK 

KD   Personnel costs     FERTF 

KD   Personnel costs     FERTP 

KD   Material costs     ROHST 

KD  Revenues     ERLOS 

FA   Material price var.     ABWRP 

Uniqueness and completeness of assignment 

For settlement to Profitability Analysis to proceed smoothly, the assignments you enter must be unique 

and complete: 
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A cost element group or cost element group/variance category combination can be assigned only once to 

a PA transfer structure and will thus only appear once in the structure. You may not assign a cost element 

group or cost element group variance category to more than one field in the operating concern. However, 

you can assign the fixed and variable costs which have been incurred under one cost element group to 

different value fields. (The following example is for PA transfer structure "OH" ( Overhead ). 

Assignment line Origin Group Value field 

  Personnel costs COSTELEM BAB-PERS VTRPS 

  Material costs COSTELEM BAB-MATE VTRGK 

  Other costs COSTELEM BAB-SONST VTRGK 

The PA transfer structure must be complete, meaning it must contain all cost elements under which 

revenues and costs have been incurred. 

Settling of senders with revenues 

When you settle senders with revenues, you can settle the following to profitability segments: 

- Costs 

You can settle costs that have been incurred by primary and secondary cost elements. 

- Revenues, Sales deductions 

You settle the revenues and sales deductions that have been incurred. 

- Results analysis data 

You settle the results analysis data that has been calculated under the results analysis cost elements 

(cost of sales, reserves for imminent losses). 

Assignment of actual costs, actual revenues, and actual sales deductions to the value fields in 

CO-PA is made via the cost elements or revenue elements that were originally posted to the sender. 

You use the results analysis cost elements to assign the results analysis data. This data is recorded in the 

order or project via these cost elements: 

Example: PA transfer structure "CD" ( Cardinality ) 

Assignment line Origin Group Value field 

  Personnel costs COSTELEM BAB-KDUPE FERTF 

  Material costs COSTELEM BAB-KDUMA ROHST 

  Other costs COSTELEM BAB-KDUSO SONST 

  Revenues COSTELEM BAB-ERLO ERLOS 

  Discounts COSTELEM BAB-ERLS RABAT 

  IL reserves COSTELEM BAB-RUEDV RUEDV 

Settlement of Production Orders ( CO,PP ) 

You can settle the variances that have occurred for a cost element or cost element group (differences 

between planned costs and actual costs) to CO-PA separately. To do this, you need to specify a variance 

category for the cost element or cost element group (see cost element group BAB-ROH in the example 

below). If you do not specify a variance category, all the variances occurring under the cost element/cost 



 

 

element group are settled to the value field assigned to the cost element group (in the example, cost 

element group BAB-HILF). 

The system distinguishes between the following variance categories: 

- Input price variances 

- Resource-usage variances 

- Input quantity variances 

- Remaining input variances 

- Scrap variances 

- Remaining variances 

- Mixed price variances 

- Output price variance 

- Lot size variance 

- Remaining variance 

Note that, in particular,  the settlement of Production variances provides you with useful analysis 

possibilities in CO-PA. 

Example: PA settlement structure "PO" (Production Order) 

Assignment line Origin Group Value field 

 PricevarRaw COSTELEM BAB-ROH ABWRP 

VAR:CATEG. PRICE 

 QtyVarRaw COSTELEM BAB-ROH ABWRM 

VAR.CATEG. QUANT 

 ResVarRaw COSTELEM BAB-ROH ABWRS 

VAR.CATEG. REST 

 VarAux.mat. COSTELEM BAB-HILF ABWHS 

 VarProdCost. COSTELEM BAB-FERT ABWFK 

 VarMiscCost. COSTELEM BAB-SONST ABWSO 

Requirements 

- First create the operating concern to which you want to settle, and then create its value fields. 
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- Either the revenue elements or cost elements you want to use must be combined in cost element 

groups or you have already used the Cost Center Accounting IMG activity Create Cost Element 

Groups. 

Activities 

1. Use New entries to enter a short ID and a name for your PA transfer structure, then save your 

entries and goto the overview screen for the PA transfer structure. 

2. Use Detail to create assignment lines. 

3. Use New entries to create one or more assignment lines. 

If you want to copy the invoiced quantity when settling from customer orders or projects, set the 

indicator "Invoiced quantity". 

Save your entries and go to the overview screen for changing the assignment lines. 

4. Use Assign origin to create a cost element group for your operating concern or New entries for the 

assignment line under which the costs or revenues can be posted to the sender (if necessary, with a 

variance category). To do this, you can 

- Use the F key, as origin "COST ELEMENT" or "VARIANCE CATEGORY" or 

- Under "Setname" select an existing cost element group or variance category. Choose a cost 

element group defined in the chart of accounts and which is assigned to the controlling area 

for the sender object. 

For each assignment line in a cost element group you can assign only one variance category. 

Save your entries and goto the overview screen for changing the PA transfer structure. 

5. Define the value field assignment you want to use when settling orders and projects in the operating 

concern. 

Assign the value fields. 

Further notes 

For more information on determining variances, refer to the "Cost Object Accounting" documentation 

and the IMG under "Product Cost Accounting". 

 Edit Settlement Profile 

In the settlement profile, you define a range of control parameters for settlement. You must define the 

settlement profile before you can enter a settlement rule for a sender. 

If you want to settle the costs each time to just one cost center or just one G/L account, you need a 

settlement profile. As you cannot maintain the settlement parameters during settlement to a receiver, you 

must save the settlement profile either in the order type or in the model order or reference order. 

Recommendation 



 

 

The settlement profile includes, among other things, the retention period for the settlement documents. 

You should bear in mind the following when you determine the retention period. 

The settlement documents take up additional storage capacity. When a posting period is finally locked 

against further postings in Financial Accounting and Controlling, you can clear the settlement documents. 

However, you should build in a safety margin, as you will need the settlement documents if you have to 

cancel any settlements or repeat the period end close. 

Activities 

1. Create a settlement profile. 

2. Save the profile in the order type. 

Additional Information 

For more information on this subject, go to the SAP Library and choose AC - Financials -> CO - 

Controlling -> Internal Orders - > CO Settlement. 

 Default Values for Settlement Profile 

 Define Default Value for Settlement Profile per Contract Type 

Use 

Here you can define a settlement profile as a default for contract types. When you create a settlement rule 

for a contract, the system automatically proposes the settlement profile entered here, dependent on the 

contract type. You can overwrite this default manually at any time. 

Requirements 

The settlement profiles used were entered in the Maintain Settlement Profile IMG activity. 

 Define Default Value for Settlement Profile by Usage Type 

Use 

Here you can enter a default settlement profile for usage types. When you create a settlement rule for a 

rental object, then the profile entered here is proposed as a default, dependent on the usage type. You can 

overwrite this default at any time by making a manual entry. 
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Requirements 

The settlement profiles you want to use have to already be created in the Maintain Settlement Profile IMG 

activity. 

 Define Default Settlement Profile per Object Type 

Use 

Here you can define a settlement profile as a default for object types. When you create a settlement rule 

for a business entity, building or property the system automatically proposes the settlement profile 

entered here, dependent on the usage type. You can overwrite this default manually at any time. 

Requirements 

The settlement profiles used were entered in the Maintain Settlement Profile IMG activity. 

 Apportionment 

 Create Actual Apportionment 

In the IMG activity "Define Assessment" you set rules in the form of cycles to allocate primary and 

secondary costs in the actual. 

Requirements 

You must already have completed the IMG activity Create Assessment Cost Elements. 

If you are using an allocation structure, you must have completed the IMG activity Define Allocation 

Structure. 

Recommendation 

When using assessment, distribution, and periodic reposting, note the following: 

- You can use assessment if the origin of the primary costs is not important. If required, you can use 

multiple assessment cost elements for differentiation. 

- Periodic reposting is recommended if the origin of primary costs is important, but the partner object 

does not need to be displayed directly. The partner information, however, is not lost. Proof of origin 

is always possible via the line item document. 



 

 

- If you do need to show the partner object directly in the report, you must use distribution. The data 

volume will grow significantly for the proof of the partner objects, particularly in large distributions. 

Note that the data volume generated for past periods will grow with increased numbers of periods. 

Especially in reporting and for data backups, it is important to keep the data volume generated by 

allocation to a minimum. For this reason, assessment or periodic reposting are to be recommended. 

For performance reasons, you should not use more than  segments in one cycle. If necessary, define 

multiple cycles. A larger number of segments per cycle is only necessary for extensive iterations. 

Also: For performance reasons, never use more than , relationships in an allocation cycle. If you require 

more than that, you must plan a mass test of the allocations beforehand. 

Example 

From a sender cost center with  sender cost elements, allocations are made with one segment to  receiver 

cost centers. 

The following numbers of sender and receiver totals records result from the different allocations that must 

be written in the processed period: 

Allocation                Sender totals recds     Receiver totals recds 

-------------------------- 

 

Assessment                                      

Periodic reposting                              x  

Distribution               x                 x  

--------------------------------------------------------- 

--------------- 

This simple example already demonstrates that 

- far more sender totals records are written for distribution than for periodic reposting 

- far more receiver totals records are written for periodic reposting than for assessment 

In practice, because of the far higher number of senders and receivers, the advantages of assessment and 

periodic posting are even more apparent. 

Activities 

Create an actual assessment cycle as follows: 

1. Enter a name for the cycle 

2. Enter a validity timeframe for the cycle 

3. Maintain the header data for the cycle by entering the following: 

a) In which currencies the costs should be allocated 
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b) Whether the cycle is to be processed iteratively and/or cumulatively. 

4. Create segments for the cycle that contain the following information: 

a) The cost element to be assessed or the cost element of the sender allocation structure 

5. Criteria for the distribution of costs among the receivers 

a) Whether negative tracing factors are to be scaled 

b) Criteria for determining the sender values 

c) The sender objects and the receiver objects 

d) The selection criteria for the receiver tracing factors 

e) The selection criteria for the sender values 

f) Receiver weighting factors for receiver rule  (variable portions): 

6. Save the cycle. 

Notes for Transport 

If, in your client, you have not selected the automatic recording of changes for client-specific objects (in 

Customizing under Basis Components -> System Administration -> Change and Transport 

System -> Configure Clients),  you can transport your settings to the target system in a user-defined 

activity. 

To do this, in Customizing, choose Controlling -> General Controlling -> Production Start-Up 

Preparation -> Transport System Settings and then process the relevant activity. 

Additonal information 

Notes for working with a delta version 

Please note the following during cycle definition: 

If you select a delta version, the following additional allocation characteristics are available for segment 

definition: 

- Business processes and/or groups 

- External value added 

- Internal value added 

- Type 

The receiver objects "order" and "WBS element" become invalid. 

For more information on defining an assessment, see the SAP Library under Financials -> CO 

Controlling -> Cost Center Accounting -> Period-End Closing -> Periodic Allocations or Periodic 
Repostings. 



 

 

 Change Actual Apportionment 

Use 

Here you can edit existing actual apportionment cycles. 

For more information, refer to Create Actual Apportionment. 

 Distribution 

 Create Distribution 

In this activity, you define distributions in the form of cycles by specifying rules for the settlement of 

primary costs on a cost center. 

Recommendation 

Check whether distribution can be replaced here by periodic reposting or assessment in order to achieve 

better system performance. 

- You can use assessment if the origin of the primary costs is not important. If required, you can use 

multiple assessment cost elements for differentiation. 

- Periodic reposting is recommended if the origin of primary costs is important, but the partner object 

does not need to be displayed directly. The partner information, however, is not lost. Proof of origin 

is always possible via the line item document. 

- If you do need to show the partner object directly in the report, you must use distribution. The data 

volume will grow significantly for the proof of the partner objects, particularly in large distributions. 

Note that the data volume generated for past periods will grow with increased numbers of periods. 

Especially in reporting and for data backups, it is important to keep the data volume generated by 

allocation to a minimum. For this reason, assessment or periodic reposting are to be recommended. 

For performance reasons, you should not use more than  segments in one cycle. If necessary, define 

multiple cycles. A larger number of segments per cycle is only necessary for extensive iterations. 

Also: For performance reasons, never use more than , relationships in an allocation cycle. If you require 

more than that, you must plan a mass test of the allocations beforehand. 

Example 
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From a sender cost center with  sender cost elements, allocations are made with one segment to  receiver 

cost centers. 

The following numbers of sender and receiver totals records result from the different allocations that must 

be written in the processed period: 

Allocation                Sender totals recds     Receiver totals recds 

-------------------------- 

 

Assessment                                      

Periodic reposting                              x  

Distribution               x                 x  

--------------------------------------------------------- 

--------------- 

This simple example already demonstrates that 

- far more sender totals records are written for distribution than for periodic reposting 

- far more receiver totals records are written for periodic reposting than for assessment 

In practice, because of the far higher number of senders and receivers, the advantages of assessment and 

periodic posting are even more apparent. 

Activities 

Create a plan distribution cycle by proceeding as follows: 

1. Determine a name for the cycle. 

2. Determine a validity period for the cycle. 

3. Maintain the header data for the cycle by entering the following. 

a) Which currencies are to be used in the allocations 

b) Whether consumption is to be allocated or not 

c) Whether negative tracing factors are scaled or not 

d) Whether cycle processing is to be iterative 

e) In which version the allocation is to take place 

4. Define cycle segments in which you store the following information. 

a) Sender cost element to be distributed 

b) Criteria for cost distribution to the receiver 

c) Sender objects 

d) Receiver objects 



 

 

5. Save the cycle. 

Notes for Transport 

If, in your client, you have not selected the automatic recording of changes for client-specific objects (in 

Customizing under Basis Components -> System Administration -> Change and Transport 

System -> Configure Clients),  you can transport your settings to the target system in a user-defined 

activity. 

To do this, in Customizing, choose Controlling -> General Controlling -> Production Start-Up 

Preparation -> Transport System Settings and then process the relevant activity. 

Further notes 

Distribution 

During distribution, the following information remains: 

- Original primary cost element. 

- Information on the sender cost center is noted in the receiver cost center or receiver order. 

- Information on the receiver cost center or order is noted in the sender cost center. 

For more information, see the "SAP Library" under Financials -> CO Controlling -> Cost Center 
Accounting -> Period-End Closing -> Defining Periodic Repostings or Periodic Allocations. 

 Change Distribution 

Use 

Here you can edit existing actual distribution cycles. 

For more information, refer to Create Distribution. 

 Periodic Reposting 

 Create Periodic Reposting 

Periodic reposting reduces the number of postings in Financial Accounting for document entry. 

The assignment of costs to cost centers in line with the source of these costs occurs in Controlling. The 

complete amount is first assigned to an allocation cost center (such as telephone costs). 
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During reposting to the originating cost center, the posting document is given all controlling-relevant data 

but no sender information. 

Example of Periodic Reposting 

All phone costs (cost element ) are collected in cost center  (Telephone Central). 

At period-end closing, the costs are reposted to the other cost centers on the basis of statistical key figure 

LDC (Long-Distance Calls). 

- The sender cost center is Telephone Central (CCtr ). The receivers are all cost centers in the 

organization. 

Recommendation 

Check whether assessment can be used instead of periodic reposting, as this leads to considerably better 

system performance. 

- You can use assessment if the origin of the primary costs is not important. If required, you can use 

multiple assessment cost elements for differentiation. 

- Periodic reposting is recommended if the origin of primary costs is important, but the partner object 

does not need to be displayed directly. The partner information, however, is not lost. Proof of origin 

is always possible via the line item document. 

- If you do need to show the partner object directly in the report, you must use distribution. The data 

volume will grow significantly for the proof of the partner objects, particularly in large distributions. 

Note that the data volume generated for past periods will grow with increased numbers of periods. 

Especially in reporting and for data backups, it is important to keep the data volume generated by 

allocation to a minimum. For this reason, assessment or periodic reposting are to be recommended. 

For performance reasons, you should not use more than  segments in one cycle. If necessary, define 

multiple cycles. A larger number of segments per cycle is only necessary for extensive iterations. 

Also: For performance reasons, never use more than , relationships in an allocation cycle. If you require 

more than that, you must plan a mass test of the allocations beforehand. 

Example 

From a sender cost center with  sender cost elements, allocations are made with one segment to  receiver 

cost centers. 

The following numbers of sender and receiver totals records result from the different allocations that must 

be written in the processed period: 

Allocation                Sender totals recds     Receiver totals recds 

-------------------------- 

 

Assessment                                      



 

 

Periodic reposting                              x  

Distribution               x                 x  

--------------------------------------------------------- 

--------------- 

This simple example already demonstrates that 

- far more sender totals records are written for distribution than for periodic reposting 

- far more receiver totals records are written for periodic reposting than for assessment 

In practice, because of the far higher number of senders and receivers, the advantages of assessment and 

periodic posting are even more apparent. 

Activities 

Create a cycle for periodic reposting by proceeding as follows: 

1. Enter a name for the cycle. 

2. Enter a validity period for the cycle. 

3. Maintain the header data for the cycle by determining the following: 

a) Which currencies are used for allocation 

b) Whether consumption is to be allocated 

c) Whether negative tracing factors are scaled or not 

d) Whether cycle processing takes place iteratively 

e) The version from which plan data is to be taken 

4. Define the cycle segments, where the following information is stored: 

a) The sender cost element to be reposted 

b) The criteria for distributing the costs onto the receiver 

c) The sender objects 

d) The receiver objects 

5. Save the cycle. 

Notes for Transport 

If, in your client, you have not selected the automatic recording of changes for client-specific objects (in 

Customizing under Basis Components -> System Administration -> Change and Transport 

System -> Configure Clients),  you can transport your settings to the target system in a user-defined 

activity. 

To do this, in Customizing, choose Controlling -> General Controlling -> Production Start-Up 

Preparation -> Transport System Settings and then process the relevant activity. 
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Further notes 

Periodic reposting 

Periodic reposting is a cost controlling aid equivalent to manually- posted cost transfer Periodic 

reposting can be used for plan or actual postings. 

- To simplify cost center planning, you can enter plan values for one center and repost them to other 

CO objects. 

- For actual postings, you can enter controlling-relevant postings in Financial Accounting which the 

system collects on an allocation cost center, which minimizes account assignments during 

document entry. At the end of a period, you can repost the collected costs to other CO objects. 

Reposting uses keys (fixed values or calculated tracing factors) for allocation to the corresponding 

receiver objects (cost centers, internal orders, and so on). 

The original primary cost element remains intact in periodic reposting. The line items do not receive 

updated information about senders and receivers. 

For more information on periodic reposting, see the SAP Library under Financials -> CO 

Controlling -> Cost Center Accounting -> Period-End Closing -> Periodic Allocations -> Defining 
Periodic Repostings or Periodic Allocations. 

 Change Periodic Reposting 

Use 

Here you can edit existing cycles for periodic reposting. 

For more information, refer to Create Periodic Reposting. 



 

 

 Indirect Activity Allocation 

 Create Indirect Activity Allocation You determine rules for indirect activity 
allocation in the form of cycles. 

For cost centers with activities that cannot be measured or measured only with great difficulty, the 

activity quantities can be determined indirectly. 

In indirect activity allocation, the usage of sender activities (cost center/activity type) is determined via 

tracing factors from the viewpoint of the activity receivers. 

The tracing factors are defined as in assessment or distribution. 

Requirements 

- You must maintain activity types for indirect allocation in actual and plan. 

- The requirement for indirect activity allocation in actual and planning data is that all senders and all 

receivers of the cost object cost center/activity type are included in activity type planning for activity 

type category . 

- You enter activity quantities for activity type category  ("Manual entry, automatic allocation") for 

planning data with activity type planning. 

Note: 

Planning activity quantities with the aid of activity type planning is only possible for activity 

type category . For activity type category  the SAP system automatically creates a cost 

center/activity type record. Sender activity quantities are indirectly determined from the 

receiver tracing factors and through fixed quantities. 

- For actual data, a posted sender activity quantity can be created by entering non-allocatable 

activities. 

Note: 

Entering posted activity quantities for activity type category  is not possible, since the activity 

quantities are indirectly determined. 

- The requirement for indirect activity allocation in actual and planning data for activity type category  

is that a value NOT equal to zero is entered in the segment definition for the sender-specific 

weighting factors with the function Sender values. Only then will the corresponding record be 

included in the activity allocation. Examples for Indirect Activity Allocation 

- Activity types of category , "Manual entry, indirect allocation" 

The cost center "Quality control" produces  hours of activity type "Test". Activities go to cost 

centers "Goods receipt" and "Finished products". The allocation is made on the basis of the tracing 

factor "Number of test items" (NI). For "Goods receipt" these are  items, for "Finished products" . 

Price per activity unit for "Quality control" equals  USD/hr. The resulting costs of activity 

production equal USD ,. 

The receiver centers are debited according to the tracing factor  with the following costs: 

Goods receipt:     (, X  NI) / , NI = $ , 

Finished products: (, X  NI) / , NI = $ , 
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- Activity types of category , "Indirect entry, indirect allocation" 

Activity determination for the sender takes place via receiver tracing factors and weighting factors 

defined for each sender. The sender rule here is usually "Indirectly determined quantities"; receiver 

rule can be any rule. 

Using the example above, the receiver tracing factors are: 

                           "Goods receipt"         NI 

                           "Finished products"     NI 

                            Total               , NI 

The sender is credited with , test items. This amount can be valuated with weighting factors defined 

per sender activity type. Weighting factor, activity type "Test":  

Debiting of the sender and the activity type "Test" are thus equal to 

       (,  / , NI) X , NI X , = $ , 

Activities 

Create a cycle for indirect activity allocation as follows: 

1. Determine a name for the cycle. 

2. Determine a date as of which the cycle is to be valid. 

3. Maintain the header data of the cycle by specifying the following: 

a) an explanatory text 

b) the date to which the cycle is to be valid 

c) whether negative tracing factors are to be standardized 

4. Define cycle segments in which you store the following information: 

a) a name and text for each segment 

b) the sender values 

c) the tracing factor 

d) the selection criteria (sender objects and receiver objects) 

5. Save the cycle. 

Notes for Transport 

If, in your client, you have not selected the automatic recording of changes for client-specific objects (in 

Customizing under Basis Components -> System Administration -> Change and Transport 

System -> Configure Clients),  you can transport your settings to the target system in a user-defined 

activity. 



 

 

To do this, in Customizing, choose Controlling -> General Controlling -> Production Start-Up 

Preparation -> Transport System Settings and then process the relevant activity. 

Further notes 

For more information, see the SAP Library under Financials -> CO Controlling -> Cost 

Center Accounting -> Cost Center Planning -> Periodic Allocations -> Indirect Activity Allocation 

or in Period-End Closing -> Defining Periodic Repostings or Periodic Allocations. 

Conceptional Information for Indirect Activity Allocation 

Indirect activity allocation consists of two subfunctions which you can enter as required in a cycle. 

However, one segment can cover only one subfunction in each case: 

1. Sender activity quantities are known and can be entered as totals. Using indirect activity allocation, 

the posted activity quantities are distributed from senders to receivers according to the tracing 

factors defined in the segment. 

A segment uses this method if Posted quantities (rule ) is the sender rule and Fixed quantities 

(rule ) is NOT a receiver rule. 

In a segment to distribute posted sender amounts, you can use activity types of category  manual 

entry, indirect allocation only. 

2. Sender activity quantities are not known because measurement is either impossible or not feasible 

(for example, a joint office working for several cost centers). However, the SAP system can derive 

sender activity quantities indirectly, based on receiver tracing factors adjusted with a sender-specific 

weighting factor. 

A segment uses this method if Indirectly determined quantities (rule ) is the sender rule, or if 

Fixed quantities (rule ) is a sender or receiver rule. Using the Sender values function, you can 

determine sender-specific weighting factors for the sender rule Indirectly determined quantities. 

The default value is "". 

In segments for indirect calculation of sender activity quantities you can only use activity types of 

category  indirect entry, indirect allocation. 

Senders and receivers in indirect activity allocation 

- In indirect activity allocation for actual and plan data, senders  can be objects of the category cost 

center/activity type or business processes. 

In a given segment, you can use category  or category  activity types only. 

- In indirect activity allocation for plan data, all usual CO objects are possible (cost center, cost 

center/activity type, orders, projects, etc.) as receivers 

All of these receiver categories can appear in a cycle. However, cost objects of the category cost 

center/activity type may not be combined with other receiver categories. 

In indirect activity allocation for actual data, you can use the same cost objects as receivers as in 

manual activity allocation, meaning no cost centers/activity types. 

Fixed and variable activity references; evaluating activity quantities 

- In indirect activity allocation for actual data, all quantities are posted as total quantities. The 

division into fixed and variable quantity parts is carried out through actual cost splitting. 
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- In indirect activity allocation for plan data, the determination of fixed and variable quantity quotas 

depends on the receiver category: 

- Receivers of the category cost center/activity type post all activity quantities as variable quantities, 

with tracing factors dividing actual and plan activity into fixed and variable quantity parts. 

- For all other receivers the receiver quantities are posted as fixed. 

- If an activity price is available for a sender object, the activity quantities of the sender and the 

corresponding receivers are valuated using this activity price. 

Updating the databases 

The activity quantity updated on the senders is determined either from read/posted sender 

quantities (subfunction ) or from indirectly calculated activity quantities based on receiver tracing 

factors or predefined sender quantities/receiver quantities (subfunction ). The activity quantity thus 

determined is posted to the respective sender as activity output (quantity credit) and to the 

respective receiver as activity-dependent or activity-independent activity input in relation to their 

tracing factors (quantity debit). The indefinite credit rate is updated for plan data as well (with 

activity type category ). 

Additionally, the following activity postings are based on the sender activity quantities: 

If available quantities are distributed (subfunction ), the scheduled quantity are updated. If the 

sender activity quantities are indirectly determined or fixed, the activity quantity is also updated in 

addition to the scheduled quantity. 

In actual indirect activity allocation, all quantities are treated as fixed quantities. 

You use indirect activity allocation in activity price calculation. 

 Change Indirect Activity Allocation 

Use 

Here you can process existing cycles for indirect activity allocation. 

For more information, see Create Indirect Activity Allocation. 



 

 

 Option Rate Determination and Input Tax Distribution 

 Option Rate Determination 

Option rate 

The option rate of an object specifies the percentage of input tax, which was originally posted as fully 

deductible for this object, that is really deductible. 

The option rate is determined monthly based on the option rate method that is specified for this object at 

the time of the calculation. The option rate method either specifies a fixed option rate, or it triggers an 

automatic calculation. 

For rental contracts, only fixed option rates can be used. 

The option rates of rental objects depend on the option rate of the occupancy contract on the key date of 

the option rate determination. If the object is occupied by a contract that has an option rate of %, then the 

option rate of the rental object is also %. In the case of vacancy, the option rate is determined by the 

option rate of the rental object or of the follow-on contract. 

In the case of automatic determination of the option rate of a superordinate object, the option rate 

corresponds to the proportion of the object that is leased commercially. This proportion can be based, for 

example, on the ratio of area or volume (ratio of commercial space to non-commercial space). The option 

rate is then % if the object is used completely for commercial purposes, that is, when all rental objects of 

the object have an option rate of %. Other values result from the option rates of the affected rental 

objects, weighted by the ratio of area or volume. 

Requirements 

The prerequisite for input tax distribution is that opting is set to active in the company code. For company 

codes in which the indicator is not set, the system can determine and save the option rates using the 

option rate methods entered, but it is not able to distribute input tax. 

 Option Rate Methods 

Use 
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In this step, you can specify  how an option record is specified or calculated for an object. 

You can specify option rate methods for the following objects: 

Business entity - 

Property - 

Building - 

Rental object - 

Occupancy contract - 

Non-occupancy contract - (such as a maintenance service contract) 

Settlement unit - 

Activities 

Here you specify how the option rate for this method should be determined. For each option rate method, 

specify if the option rate should be 

1. Predfined 

2. Freely defined 

3. Automatic 

In regard to : The option rate method specifies the option rate for this object directy. 

In regard to : You can also set up the option rate you want in master data maintenance for 

the object. It is also possible to make the option rate and the option rate method time-dependent, and use 

different ones at different times. 

In regard to : The option record is specified using an automatic procedure during the option rate 

determination run. If you enter a measurement type for the Automatic setting, then during the option rate 

determination run, the system searches for all subordinate rental objects belonging to the object, for 

which the option rate is to be determined. The measurement type you entered here has to be specified on 

these rental objects.  @S@ Choose a measurement type that is derived, or a mandatory measurement for 

rental objects. 

To determine the option rate of the superordinate object, the system determines the option rates of the 

rental object (or of the contract containing the rental object or of the renewal contract) and multiplies 

them with the measurement of the measurement type specified. The option rate is the ratio of the total of 

these products to the overall measurement of all rental objects of the superordinate object. 

In the Permitted for Object Types group box, you specify the objects for which an object method can be 

used: 

- (Superordinate) Objects 

- Non-Occupancy Contracts 

- Settlement Units 



 

 

- Rental Objects 

- Occupancy Contracts 

For rental objects and occupancy contracts, keep in mind that option rate methods here only make sense if 

the option rate is specified independently of the subordinate objects. For determining the option rate of 

pooled spaces, you can specify a separate option rate method. 

In order to have the system propose an option rate method when you create a business entity, you have to 

designate just one allowed method as the default method. Buildings and property adopt the option rate 

method of the business entity as a default value. 

You can set up default methods for rental objects and contracts in the Default Option Rate Method for 

Rental Objects per Usage Type and Default Option Rate Method for Contracts per Contract Type IMG 

activities. 

Example 

Business entity  with option rate method , automatic per measurement type A: 

Residential/Usable Space. It consists of rental objects: 

RO A =  m² 

RO  A  =  m² 

RO  A  =  m² 

RO has option rate method Y with fixed option rate %. RO and RO have option rate method N with fixed 

option rate  %. 

RO and RO are vacant; for RO there is an occupancy contract with option rate method  (manual). An 

option rate of % is specified on the contract. 

The option rate of the business entity is calculated using the following formula: 

(% *   + % *   + % * )  /  ( +  + ) 

= ( +  + )  /   

=  % 

 Default Option Rate Method for Rental Obj. per Usage Type 

Use 

In this section you can specify separate default methods for the rental object that are dependent on the 

usage type. 
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 Default Option Rate Method for Contract per Contract Type 

Use 

In this section you can specify which option rate methods the system should default for a given contract 

type. 

For contract types, for which no tax-relevant postings are made, you can set the No Option Rate Method 

indicator. 

 Input Tax Distribution 

Use 

During input tax distribution, the originally posted input tax is divided into deductible and non-deductible 

tax shares, using the option rate determined for each object by option rate determination. The non-

deductible share is transferred (costs with account assignment to the original object). 

Input tax distribution is not only for real estate objects. It can also be used for cost centers, orders, and 

projects, if the system is set up for it. The cost center, order, or project inherits the option rate from the 

real estate object they are assigned to. 

Activities 

Here you specify the objects for which input tax distribution is performed, and which accounts are used 

for the transfer. 

 Specify Objects for Which Input Tax Distribution Is Performed 

Use 



 

 

Here you specify, dependent on the company code, whether the system should perform input tax 

distribution. If it should, you also specify the objects for which the distribution is performed. 

You could have already made these settings in the Make Basic Settings in Company Code IMG activity. 

The view here is limited only to the fields that are relevant for input tax distribution. 

On the left side of the detail screen, you can specify whether multiple assignment is allowed for the given 

object type. If multiple assignment is allowed, then the input tax distribution may not be able to uniquely 

determine the object that supplies the option rate. In that case, the user has to explicitly specify the object 

that supplies the option rate during master data processing. 

Normally it is better not to allow multiple assignment. 

On the right side of the screen, you specify the objects, for which input tax distribution is performed: 

- First specify whether the company code opts to pay input tax. If this indicator is set, then, 

when a document is posted for one of these objects, the system updates the input tax, and 

the input tax can then be distributed. This affects the following real estate objects: - 

Business entity 

- Building 

- Land 

- Rental object 

- Settlement unit 

- Real estate contract 

When a document is posted for one of these objects, then the system updates the input tax and 

the input tax can then be distributed. 

For company codes that do not opt, the contents of the other fields do not have any 

significance. 

- Specify the object types for which you want input tax distribution to be made. If the 

company code opts, you should select all object types here that are related to real estate. 

For  internal orders, you can distinguish between maintenance orders and other internal 

orders. 

- Using the message type, you can specify whether there always has to be a relationship 

between the object type and the real estate object, or if the assignment (and thereby the 

input tax distribution) is optional. For more information, see the  message type. 
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 Account Determination for Non-Deductible Input Tax per Cost Element 

Use 

In this activity, you specify the account to which the non-deductible input tax for an object should be 

transferred. 

The account depends on the cost element to which the original posting was made. 

Activities 

You can enter the accounts as follows: 

1. You enter an explicit cost element for non-deductible input tax for a cost element. 

Example: 

Original Account           Non-Ded. Input Tax Acct 

                                           

2. You specify that a certain fixed account for non-deductible input tax should be used for all accounts, 

for which an explicit account is not specified. Example: 

Original Account             Non-Ded. Input Tax Acct 

<Blank>                                            

3. You specify that non-deductible input tax is posted to the original account for all accounts. In this 

case, leave the table empty. 

Notes: 

If you want input tax distribution to be possible only for accounts that you entered here explicitly (see 

point ), then there are not allowed to be any entries where the original account is blank. 

- During input tax distribution, the system first checks if an explicit non-deductible input tax account 

is entered for the original account. 

- If none is entered, then the system checks if there is an entry where the original account is blank. 

If an entry is found, then the system posts the input tax distribution to the account entered for non-

deductible input tax. 

- If there is no entry with a blank original account, then the system checks if the table is empty (see 

point ). 

If the table is empty, then the non-deductible input tax is posted to the original account. 

- Otherwise, the document is not distributed and the system writes an error message to the log. 



 

 

 Input Tax Distribution with Multilevel Tax Code 

Use 

Line items with real estate account assignment that are posted with a multi-level tax code are not taken 

into account during input tax distribution. If you nonetheless want the system to take the deductible input 

tax portion of this posting into account, then you need to specify the multilevel tax code and the 

distribution here. 

Requirements 

The multilevel tax code can only have one input tax account key. You assign this key to the tax code in 

the basic settings of Financial Accounting in the Define Tax Codes for Sales and Purchases IMG activity. 

Standard settings 

If there is no entry in this table for a multilevel tax code, then the system does not process the input tax 

amounts in input tax distribution. 

Activities 

1. In the Tax Code field, enter the multilevel tax code, for which you want the input tax portion to be 

processed in input tax distribution of Flexible Real Estate Management. 

2. Set the Distribute indicator for the tax code. 

3. Enter an input tax code in the Input Tax field. 

Since input tax distribution posting cannot process multilevel tax codes, these are replaced 

temporarily by input tax codes for the purpose of input tax distribution only. Assign an input tax 

code to each multilevel tax code here. Note that you have to define the same tax rate for the input 

tax portion of the multilevel tax code and for the input tax code assigned to it in the system (see 

Define Tax Code for Sales and Purchases). 

Example 

You defined multilevel tax code E as follows: 

Tax Type Acct Key Tax Rate Level 

From Level 

CondType 

Acquisition tax, credit ESA -   NLXA 

Acquisition tax, debit ESE -   

You defined input tax code V as follows: 

NLXV 
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Tax Type Acct Key Tax Rate Level 

From Level 

Input tax  VST   MWVS 

Then you would enter the following here: 

Tax Code Meaning Distr Input Tax  Meaning 

E Acquisition tax X   V Input tax 

CondType 

Note 

If you use the function Tax Transfer in Service Charge Settlement and you use multilevel tax codes for 

cost postings, you also have to make entries here. 

 Implement Enhancements ( BAdI ) 

 Option Rate Determination 

Use 

The Business Add-In (BAdI) supports enhancements to the standard functions of option rate 

determination. 

For information about possible enhancement scenarios, see the Overview of Enhancement Methods for 

Master Data Objects and the Real Estate Contract. 

Standard settings 

In the standard system, there is no activated BAdI implementation. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

For information on using BAdIs, see this documentation. 

The following methods exist: 

- CALCULATE_OPTION_RATE 

Calculates the option rate 

- CHECK_FOLLOW_ON_CONTRACT 

Is used for controlling whether a follow-on contract should be considered or not during the 

determination of the option rate 

- CHANGE_PROPOSED_OPTMETH 

Is used to change the default method determined during the creation of new master data 



 

 

Warning 

The implementation of the methods has to be independent of the interface. It must not contain any 

COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages using the 

MESSAGE statement is not allowed. 

Method description 

- CALCULATE_OPTION_RATE 

This method is used for calculating the individual option rate. 

The prerequisite for this is that you defined an option rate method with automatic determination and 

set the Customer Exit indicator in Customizing for Flexible Real Estate Management under 

Option Rate Determination and Input Tax Distribution -> Option Rate Methods. For more 

information, refer to the documentation for the indicator. 

You can use the following input parameters: 

- ID_INTRENO: Internal key of the real estate object for which you want to determine the 

option rate. The data for the object can be read using the API modules for the individual object 

types (name pattern API_RE_*_GET_DETAIL). 

- ID_KEYDATE: Key date for which you want to determine the option rate. 

- ID_OPTMETH: Option rate method. If several methods have been defined with the 

Customer Exit indicator, this value must be queried in the implementation. 

The option rate is output using the CD_OPTRATE parameter. If there are warning or error 

messages during option rate determination, the messages can be passed on to the application using 

the CT_MESSAGE parameter. Information for determining the option rates of subobjects can be 

transferred using the parameter CT_VIITORCSUBOBJ. 

- CHECK_FOLLOW_ON_CONTRACT 

If you want the system to determine the option rate of a rental object dependent on a follow-on 

contract, you can use this method to control whether the system actually uses the follow-on contract 

that is determined. If you do not want to use the follow-on contract, the system determines the 

option rate of the rental object as in the case of a vacancy without a follow-on contract. 

You can use the following input parameters: 

- IO_CONTRACT: This parameter contains the follow-on contract determined by the system. 

- IO_RENTAL_OBJECT: This parameter contains the rental object. 

- ID_ORDATE: This parameter contains the key date for the option rate determination. 

- CF_CN_NOT_BE_USED: Using this indicator, you inform the system if the determined 

follow-on contract should actually be used. Set the indicator to TRUE if you do not want the 

follow-on contract to be considered. 
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- CHANGE_PROPOSED_OPTMETH 

Based on the Customizing settings or through inheritance, an option rate method is determined that 

is used as the default when new master data objects are created. You can change the default method 

using this BAdI method. 

You can use the following parameters: 

- IO_BUSOBJ: This parameter contains the current master data object. 

- IT_VALID_METHOD: This table contains the option rate methods permitted for the object 

type. 

- CS_PROPOSED_OPTRATE: This structure contains the data for the default method 

determined by the system. The individually determined default method must be returned in this 

structure. The option rate method has to be an option rate method that is contained in the table 

IT_VALID_METHOD. Otherwise, the default method determined by the system is used. 

Example 

Example implementations are provided for the corresponding methods. 

- CALCULATE_OPTION_RATE 

Example class CL_EXM_IM_REIT_OPTION_RATE for determining the option rate using the 

revenue of the subobjects. 

- CHECK_FOLLOW_ON_CONTRACT 

Example class CL_EXM_IM_REIT_OR_FOLLOW_ON_CN for considering the follow-on contract 

during option rate determination, if the date the contract was signed ( RECNDAT ) is before the key 

date of option rate determination. 

- CHANGE_PROPOSED_OPTMETH 

Example class CL_EXM_IM_REIT_OR_PROPOSE_METH for replacing the default method for 

settlement units (based on apportionment factors in the system, now based on area ratio) 

See also 

This BAdI uses the interface IF_EX_REIT_OPTION_RATE. For more information, display the 

interface in the Class Builder. Notes for Developers 

 Enter Default Value for Date of Service 

Use 

In Customizing Relevant Obj. for Input Tax Dist./Corr., Default Date of Service, you can specify, for 

example, that the document date is used as the date of service. This BAdI makes it possible to use 



 

 

additional dates from the fields of the document header and document item for determining the date of 

service and to implement your own logic. 

Notes for Developers 

 Exclude Document Items from Input Tax Distribution 

Use 

Using this Business Add-In (BAdI), you can exclude individual items in original documents from input 

tax distribution. To do so, implement the EXCLUDE_FROM_DISTRIBUTION method. 

The BAdI is called during input tax distribution (transaction REITDS) for each individual line item that is 

to be distributed. 

Standard settings 

If you do not implement this BAdI, then the system performs the distribution for all line items determined 

by the selection. 

Activities 

Implement the EXCLUDE_FROM_DISTRIBUTION method using transaction SE. 

The following parameters are used: 

IS_BASE: Data of the distribution item being processed 

ID_MODE: Mode of the posting run (E: update run, S: simulation) 

CF_EXCLUDE 

Set this indicator if you do not want to distribute the item specified in IS_BASE. 

Example 

You defined tax code Z, which you do not want to be considered during input tax distribution. Using the 

EXCLUDE_FROM_DISTRIBUTION method, you can exclude distribution items from the distribution if 

they were posted with tax code Z. 

Have a look at the sample code (Goto -> Sample Code -> Display). 

Notes for Developers 
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 Account Determination for Input Tax Distribution 

Use 

The Business Add-In (BAdI) supports the enhancement of the standard functions of account 

determination for input tax distribution. 

For an overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

For information on using BAdIs, see this documentation. 

The following methods exist: 

- GET_POSTING_RULE - Gets the account for non-deductible input tax 

These methods are called automatically during standard processing of the account determination for input 

tax distribution and during input tax adjustment posting for service charge settlement. If an 

implementation exists, it is also executed in addition to standard system behavior. This does not mean 

that it is possible to replace the standard behavior of the basic actions. 

Caution: 

The implementation of the methods has to be independent of the interface. It must not contain any 

COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages using the 

MESSAGE statement is not allowed. 

Method description 

- GET_POSTING_RULE 

This method gets the account that is to be used for non-deductible input tax. The 

following parameters are transferred to the method: 

- ID_BUKRS - Company code of the input tax distribution posting 

- ID_COSTACCOUNT - Original cost account 

- ID_CHARTOFACC - Chart of accounts for the company code 

- ID_OBJNR - Object number of the account assignment object to which the line item is 

assigned 

- ID_REFDATE - Settlement reference date for the account assignment object (if filled) 



 

 

Using the parameter CD_NONDEDACCOUNT, the account for non-deductible input tax is 

returned. If this parameter is returned empty, the standard coding is run. 

Notes for Developers 

 Room Reservations and Long-Term Seating Arrangements 

 Define RE Search Request Type for Reservations and Seating Arrangements 

Use 

To make use of the functions for room reservations and seating arrangements, you need objects in the 

system that can be reserved or that can be continuously occupied. Most commonly, these are rooms. 

These rooms are represented in the system by  reservation objects. From a technical viewpoint, a 

reservation object is an offered object, as used in the real estate search. 

If you want to reserve a room, you can have the system search for the room (= the reservation object) 

using an RE search request. To be able to distinguish between this search and the search for rental objects 

as part of the usual real estate search, you have to create a suitable RE search request type for the 

reservation object type of the reservation object. It is mandatory that this RE search request type and the 

reservation object type have the same name. 

When making settings for reservation objects, consider the following: 

- The first measurement type that you define has a special function. This measurement type 

defines the capacity of the room. Normally this would be the number of seats in the room. For 

example, if you search for available rooms, then this first measurement appears immediately in 

the date list, while other measurements that are defined for the room only appear when you 

display the detailed data for the room. 

- You use essentially the same procedure for making settings for RE search requests for 

reservations and continuous occupancy as you do for the real estate search. However, there are 

the following important differences in the case of reservations and continuous occupancy: 

- You do not need to assign usage types. 

- Rather than defining condition groups, you define condition types directly. 

- You define the  price basis for RE search request types for continuous occupancy. 

 Define Reservation Object Type 

Use 

You define the object types here that you want to use for room reservations and for continuous occupancy 

of rooms. 

Requirements 
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You defined an RE search request type for each reservation object type in the Define RE Search Request 

Type for Reservations and Seating Arrangements IMG activity. It is mandatory that these RE search 

request types have the same keys as the corresponding reservation object types you define here. 

Activities 

For each RE search request type that is for reservation and occupancy functions, create a reservation 

object type and make the following settings: 

- Enter a name for the reservation object type. This name is displayed in master data processing and 

when you search for rooms. 

- To group reservation objects together based on their location, use the three location fields (location 

levels  to ). Enter the text here that you want to appear for these location fields when reservations are 

made. 

Example: 

Reservation object type:  - Meeting Room 

Loc. Level : City 

Loc. Level : Building 

This setting is helpful if you have meeting rooms located in different cities. On the first level, the 

user can enter the city where the room should be located, and then on the second level the building. 

In this example, the third level would not be displayed. 

You can also have the system generate reservation objects automatically from the architectural view. 

In that case, instead of making entries in the location fields, you enter the name of the architectural 

object type in the three architectural object type fields. 

Example: 

Arch. Obj. Type: AR - Locality 

Arch. Obj. Type: BU - Building 

During the search the system displays the texts for these objects. In addition, when the object is 

generated, the system copies the object ID to the correct field. It is also possible to override this 

behavior using a BAdI. 

If the reservation object is copied from a rental object, then the system enters the number of the 

business entity and the number of the building or land in these fields. You can also override this 

behavior. 

- Enter the following in the Availability field: 

- Can Be Reserved 

Reservations can be placed for the object (such as meeting rooms) to reserve it on an hourly or 

a daily basis, for example. 

- Can Be Continuously Occupied 

Using the functions for continuous occupancy, you can specify for the object who its occupants 

are on a long-term basis. You can use the functions of move planning to plan changes in the 

occupancy of such objects. 



 

 

- The smallest unit of time that can be reserved 

Enter the intervals in which the reservation can be changed, such as hours or minutes. 

- External/Internal 

Specify here if the object can be reserved internally only, externally only, or if it can be reserved 

both internally and externally. For objects that can be continuously occupied internally, the setting 

Internal would be correct. The system does not reject other settings, but they are ignored. 

When an external partner tries to reserve reservation objects that are for short-term reservations, the 

system first checks if there is a framework agreement with this partner. The system searches for any 

contract for the reservation object (direct, or indirect based on the architectural hierarchy) and this 

partner. This contract for the reservation object must have a condition with the calculation 

formulaReservation with Immediate Billing or Reservation with Periodic Billing. The system uses 

this condition to bill for the reservation. 

- Billing indicator 

Specifies that the reservation or continuous occupancy is subject to a fee. 

For internal reservations or occupancy, the system determines the costs and you can post them to 

Controlling. For external reservations, you can post the costs using one-time postings. 

- Specify the role of the host and the reservation requester. 

 Assign Master Data Object Types to Reservation Object Type 

Use 

You specify here whether the objects for reservation and continuous occupancy are generated from 

architectural objects. 

Requirements 

You made settings for the architectural view in Customizing. 

You defined reservation object types. 

Activities 

If you want to create reservation objects without any connection to objects of the architectural view, then 

you do not need to make any settings here. 
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But if you want to have the system automatically derive reservation objects from architectural objects, 

then you have to specify here which reservation objects are derived from which architectural objects. You 

can trigger the derivation and update initially using transaction 

REORRSOBJCREATEUPD. If you then create new architectural objects afterward, and you have made 

the appropriate settings in this IMG activity, the then system automatically creates reservation objects for 

them. 

To have the system automatically create reservation objects for architectural objects, assign the 

reservation object type (of the reservation object to be created) to the architectural object type, and 

possibly to the function. 

If you leave the Function field blank, then the system generates a reservation object with the entered 

reservation object type for all architectural objects of this object type, regardless of their function. 

 Define Reservation Area 

Use 

The reservation area can be used to control the following parameters: 

- What the costs are for temporary or continuous occupancy, and what costs, if any, you choose to 

charge for reversing a reservation 

- At what times of day an object can be reserved 

- What services can be booked along with a temporary reservation 

- Who is authorized to reserve the object 

Activities 

Define the reservation areas you need in your company. 

Example 

A company has three different locations where there are rooms that can be reserved: 

- Department FM-A is responsible for locations  and . The prices for rooms at these locations have 

been specified using one standard, based on the furnishings of the rooms. 

- Department FM-B is responsible for location . This location is in a different country and the 

reservation times and prices differ from those of locations  and . 

In this case, the most logical approach is to define two reservation areas: 



 

 

- Reservation area A for all reservation objects at locations  and  - Reservation area B for all 

reservation objects at location  

 Room Reservations 

 Basic Settings for Price Calculation 

Activities 

- Smallest Unit That Can Be Reserved 

Specify here the intervals at which the reservation can be changed (such as hours or minutes). 

- Billing indicator 

Specifies that the reservation is subject to a fee. 

Information on Posting Costs 

- Can Be Reserved Externally/Internally 

Specify here whether the object can be reserved internally only, externally only, or both internally 

and externally. 

- Frequency and Frequency Unit 

Specify with which frequency the settlements are to be posted. 

 Define Reservation Type 

Use 

You enter the reservation type when you create a reservation. 

The reservation type, with the settings you make for it in Customizing, controls the following: 

- What the costs are for a reservation, and what costs, if any, you charge for canceling a reservation 

- At what times of day a reservation is possible 

- What services can be booked along with the reservation 

- Whether a user is authorized to make a reservation 

Activities 
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Define the reservation types you need in your company. 

Example 

It should be possible to request certain services (such as lunch) for external meetings when making the 

reservation. 

In this case, the most logical approach is to define two reservation types: 

- I for internal meetings (If this is the default value, you can use reservation type " " instead.) 

- E for external meetings 

By making this distinction, you can, for example, make the authorizations for external reservations more 

restrictive than those for internal reservations. You can also specify different prices for external and 

internal reservations. 

 Number Ranges for Reservations 

Use 

When you create reservations and recurring reservations, internal numbers are needed that are drawn from 

the number ranges you set up here. 

Standard settings 

SAP provides the number range interval with the number '.' Generally you do not need to change this 

setting. 

Activities 

If there is no number range interval '' yet, create it. Choose internal number assignment by deselecting 

Ext. Choose the number range from  - . 

 Make General Settings for Reservations 

Use 

Here you make the following general settings for reservations: 

- Cancellation schemas for internal and external reservations 

- Posting activities for billing using one-time postings 



 

 

- Default value for whether a user or business partner should be saved for the reservation (see User or 

Business Partner) 

Activities 

The settings you make are dependent on the following parameters: 

- Reservation area 

- Reservation object type 

- Reservation type 

If the cancellation schema is not dependent on the reservation area or the reservation type ( or both), then 

you can leave these fields blank as applicable. 

 Implement Enhancements ( BAdI ) 

 Reservations 
Use 

The Business Add-In supports enhancements to the standard functions of room reservations without the 

need for writing program code. 

For an overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 
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There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 RE Search: Offered Objects and Meeting Rooms 

Use 

This BAdI is called when you search for 

- Offered objects 

- Meeting rooms 

It allows you to influence the conditions for selection and the results of the search. 

Offered objects 

Meeting rooms 

- Method WHERE_CLAUSE_MODIFY 

You can use the CHANGING parameters to influence the WHERE conditions for the 

selection of meeting rooms. Notes for Developers 

 Reservation Periods 

 Define Recurrence Rule 

Use 

You use the recurrence rule to define the times during which a reservation object is allowed to be 

reserved. 



 

 

Activities 

You can create more than one row for each recurrence rule. The system then interprets the times in these 

rows additively. 

If you set the Exceptions indicator for a row, then the times defined by these rows are excluded 

from the others. Make the following entries: 

- Row 

Sequence number of the row You have to assign a unique number to each recurrence rule. 

- Start/Series End ( Date ) 

Specifies the time period during which the reservation object can be reserved. If you do not want to place 

a limit on the time period, then you can leave both of these fields empty. 

- Start/End (Time) See the example below. 

Specifies the time during which the reservation object can be reserved. This time period is also needed in 

order for the system to be able to convert prices to an hourly price if the prices were entered for a whole 

day or longer period. 

For example: To convert a daily price to an hourly price, the system determines how many hours the 

reservation object can be reserved on that day, and divides by that number. 

- Frequency 

Here you can select the frequency with which the times should be valid. 

- Interval 

- Indicators: Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, Sunday 

Set these indicators if you want to limit the reservation of a reservation object to certain days of the week 

or if you want to exclude certain days from being reserved. For excluding days, you also have to set the 

Exceptions indicator. 

In this way, you can specify, for example, that a reservation object can only be reserved from Monday 

through Friday, or only on Sundays. 

The system ignores these indicators if you set the frequency to Daily. 

- Indicator: Public Holiday 

Set this indicator if you want it to be possible to reserve the reservation object on public holidays. If 

you do not want reservations on public holidays, set this indicator together with the Exceptions 

indicator. 

If no holiday calendar is entered for the row and no holiday calendar is entered for the reservation 

area of the room being reserved, then the system ignores the Public Holiday indicator . 

- Holiday Calendar 

If you want a specific holiday calendar to be used for the rule, enter it here. 

- Day of Month 
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- Month 

When the frequency is Monthly , you can specify the month to which this row of the recurrence rule 

relates. 

- Occurrence/Number 

These fields are used for special recurrences. 

Normally there are no entries in these two fields. 

Example 

Your company has tennis courts. You want to allow internal reservations from Monday through Friday 

from  A.M. to  A.M. and from  P.M. to  P.M. On Saturdays, Sundays, and holidays, you want to allow 

external reservations from  A.M. to  P.M. 

You define two recurrence rules in Customizing: 

- Rule : "Tennis, internal, workdays" has three rows: 

- Row  

Start: : 

End: : 

Indicator is set for Monday, Tuesday, Wednesday, Thursday, Friday. Frequency: 

Weekly 

- Row  

The same as row , but with Start: :, End: : 

- Row  

Indicator for exceptions is set. Indicator 

for Friday is set. 

- Rule : "Tennis, external, Saturday, Sunday, holidays" has  row: 

- Row  

Start: : 

End: : 

Indicators are set for Saturday, Sunday, and public holidays. Frequency: 

Weekly 

You then assign these rules as follows in the next IMG activity, Define Reservation Periods: 

- You assign rule  to the reservation object type "Tennis Court" and to the appropriate reservation 

areas with reservation type "internal." 

- You assign rule  to the reservation type "external." 



 

 

 Define Reservation Periods 

Use 

You assign the times that you defined in the recurrence rule to the reservation object type, the reservation 

area, and the reservation type. 

Requirements 

You defined the times, during which an object can be reserved, in recurrence rules. 

Activities 

If a reservation object can be reserved regardless of the time, then you do not have to make any settings in 

this IMG activity. 

However, you have to specify times here in these two cases: You want to limit the times an object can be 

reserved; or you want the system to automatically calculate hourly prices based on daily prices, and 

therefore need to specify how many hours in the day the object can be reserved. 

- Choose New Entries and enter the reservation object type  for which the specification applies. 

- If you want the specification to apply only to a certain reservation area, enter the reservation area. 

If you do not enter a reservation area, then the specification applies for all reservation areas, for 

which nothing else was defined. 

- If you want the specification to apply only to a certain reservation type, enter the reservation type. 

If you do not enter a reservation type, then the specification applies for all reservation types, for 

which nothing else was defined. 

- Assign the recurrence rule that you created in a previous step. 

In this way, you specify the days and times that an object can be reserved. 

You can go directly to processing of recurrence rules by choosing Recurrence Rule. 

 Services for Reservation 

 Services for Reservation 

Use 

When reserving individual rooms, you can place an order for certain services that are related to the 

reservation. 

To make this possible, you need to define service types in Customizing. Each service type 

represents a service that can be requested along with the room reservation. You can group service 
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types together into service groups. For each reservation type and reservation area, you specify 

which service groups can be offered. 

Activities 

If you want users to be able to request services along with a reservation, then define service types and 

service groups in the following IMG activities. 

 Define Service Types 

Use 

The service type is used to designate a service that you can request individually along with a reservation. 

Dependent on other criteria, such as the reservation type and type of meeting, you can define in 

Customizing that the system calculates costs for a particular service type. You can also specify the 

amount of these costs. 

You can group service types together into service groups in Customizing. For each service group, you 

specify the service types that are available for each reservation object (dependent on the reservation area). 

Activities 

Define the service types that you need. 

Example 

You want to offer the following service types: 

- LNCH - lunch in visitors' cafeteria 

- SWCH - Sandwiches 

- BEAM - Portable beamer 

You want to set up BEAM and SWCH so they can be ordered for all reservations, but you want 

LNCH (lunch in the cafeteria) to be available only for external reservations and only for certain 

reservation areas. 

You therefore define the following service groups: 



 

 

- TECH - "Technical Equipment" with service type BEAM 

- MLEX - "Lunch for External Partners" with service types LNCH and SWCH 

- MLIN - "Lunch for Internal Employees" with service type SWCH Assignment:  

- You assign service groups MLEX and TECH to reservation areas and reservation types that are for 

"External Partners." 

- You assign service groups MLIN and TECH to reservation areas for internal reservations. 

 Assign Service Types to Service Groups 

Use 

Here you define service groups and assign them to service types you already defined. 

Various service types can be grouped together into a service group. The service group is 

assigned to the reservation area and the type of meeting. In this way, the services that you can select and 

request for a given reservation all belong to the appropriate service group for that reservation. 

Activities 

In addition, for each service group, you can overwrite the standard price and other parameters that you 

previously defined for the service type. To do so, go to the Service Types for Service Group group box. If 

you do not make any entries in the fields in this group box, then the settings made in the service type 

apply. 

Example 

You want to offer the following service types: 

- LNCH - lunch in visitors' cafeteria 

- SWCH - Sandwiches 

- BEAM - Portable beamer 
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You want to set up BEAM and SWCH so they can be ordered for all reservations, but you want 

LNCH (lunch in the cafeteria) to be available only for external reservations and only for certain 

reservation areas. 

You therefore define the following service groups: 

- TECH - "Technical Equipment" with service type BEAM 

- MLEX - "Lunch for External Partners" with service types LNCH and SWCH 

- MLIN - "Lunch for Internal Employees" with service type SWCH Assignment:  

- You assign service groups MLEX and TECH to reservation areas and reservation types that are for 

"External Partners." 

- You assign service groups MLIN and TECH to reservation areas for internal reservations. 

 Specify Possible Services for Reservation 

Use 

You can assign the following criteria to a service group here: 

- Reservation area 

- Reservation object type 

- Reservation type 

When a reservation is made, the user can choose to enter the reservation type, for instance "Meeting with 

External Partners." The system then derives the reservation area and the reservation object type from the 

reservation object. 

Depending on the assignments you make here for these three criteria, the system determines which 

services can be booked for the given reservation. If you want to allow a service to be used independently 

of one of these criteria, then do not make an entry for that criterion in the table. 

Example 

You want to offer the following service types: 

- LNCH - lunch in visitors' cafeteria 

- SWCH - Sandwiches 

- BEAM - Portable beamer 



 

 

You want to set up BEAM and SWCH so they can be ordered for all reservations, but you want 

LNCH (lunch in the cafeteria) to be available only for external reservations and only for certain 

reservation areas. 

You therefore define the following service groups: 

- TECH - "Technical Equipment" with service type BEAM 

- MLEX - "Lunch for External Partners" with service types LNCH and SWCH 

- MLIN - "Lunch for Internal Employees" with service type SWCH Assignment:  

- You assign service groups MLEX and TECH to reservation areas and reservation types that are for 

"External Partners." 

- You assign service groups MLIN and TECH to reservation areas for internal reservations. 

You can make this assignment as follows. 

You have the following Reservation Types: 

- I - Meeting with Internal Employees 

- E - Meeting with External Partners You have the following Reservation Areas: -  - Location     

(Only location with food - company cafeteria) 

-  - Location  

-  - Location  

In a row where the reservation area, reservation type, and reservation object type are blank, you assign the 

service groups MLIN and TECH. 

You assign service group MLEX to reservation area  and to reservation type E. This assignment means 

that it is only possible to book lunch at the company cafteria at one location and only for meetings with 

external partners. 

If you also have reservation objects of a completely different nature, such as tennis courts, then you can 

also use the reservation object type to limit the kind of services that can be requested for these objects. 

 Derive Price of Service Dependent on Price Code and Other 

Information 

Use 

In some cases, a price is not entered directly for a service, but is instead stored in the form of a price code. 

Here you specify how the system determines the price using this price code. 
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Activities 

The system derives the price in several steps. Normally you enter a derivation rule for each of these steps. 

The system processes the individual steps in the sequence that you specify. Create at least one derivation 

rule. 

- Enter a name for the rule that makes it clear what is being evaluated in this step. If the derivation is a 

conditional derivation, then name the condition in the text. 

- If the derivation specified in this step should only be performed if certain prerequisites are met, then 

you should specify these prerequisites first. Choose the Condition tab page and enter the 

prerequisites. Then the system performs this step only if all prerequisites contained in the table are 

met. 

- Then choose the Definition tab page to specify the actual derivation. In the Source Fields table, 

you can choose the fields on which the price depends. The following fields are available: 

DAYS          Duration of the appointment in days 

HOURS         Duration of the appointment in hours 

ISALLDAY      This is an all day appointment ISHOLIDAY     The 

appointment falls (wholly or in part) on a public holiday ISWEEKEND     

The appointment falls (wholly or in part) on a 

Sunday 

NEIGHBORH    First location field of reservation object 

NEIGHBORH    Second location field of reservation object 

NEIGHBORH    Third location field of reservation object 

PRICECODE     .Price code 

RECURCOUNT    Number of appointments (for a recurring appointment) 

RSAREA        .Reservation area 

RSOBJID       Object key of reservation object 

RSOBJTYPE     Type of reservation object 

RSTYPE        Reservation type 

TIMEFROM      Starting time 

TIMETO        Ending time 

WEEKDAYFROM   Weekday (start,  = Monday, ...,  = Sunday) 

WEEKDAYTO     Weekday (end,  = Monday, ...,  = Sunday) 

- When you want to find the price for a service, then the system determines the values for these fields 

from the data currently entered for the service. Choose fields in your system that could influence the 

price of a service. Avoid using fields that do not contain relevant information. 

- For example, if twenty different locations are defined in your system, but only two service areas, 

then specify if there is a different price for each location, or only for each service area. If you want 

to have three different price zones, then you could add a third service area, rather then entering the 

same rule many times for a large number of locations. 

- Once you have specified the source fields, choose Maintain Rule Values. For each possible 

combination of source fields that are used in this rule or step, enter the values for the source fields. 



 

 

For each combination of source fields, enter the values to be derived for the target fields. The fields 

have the following meanings: 

FLOWTYPE     Flow type that is used for the account determination 

PRICE        The derived price 

CURRKEY      Currency for the price 

TIMEUNIT     .Time unit that the price relates to 

ISPERMEAS    Is the price per measurement? 

MEAS         Measurement unit 

SRVTYPE      Service type 

SRVGROUP     Service group 

Depending on the value of the ISPERMEAS and TIMEUNIT indicators, the system multiplies the 

price with the measurement value and/or the duration of the appointment. The price that the system 

determines in this way is then billed during periodic settlement of costs or posted to an account 

assignment object in CO. 

As soon as the system finds a price for the current service in a given step, the process stops there and the 

system does not make any further derivations. 

 Calculation of Costs 

 Cancellation Costs 

 Define Cancellation Schema and Cancellation Costs 

Use 

To prevent objects from being reserved unnecessarily, you can specify that when a reservation is 

canceled, the system determines the price and charges the cancellation costs to the reservation requester 

or to his or her cost center. 

Activities 

- Choose New Entries and specify the key and name of the first cancellation schema. 

- Select the cancellation schema. In the navigation area, choose Rule for Calculating 

Cancellation Costs. Choose New Entries. 

You can enter any number of rules for each cancellation schema. Each rule specifies how the system 

determines the cancellation costs when the time interval between the cancellation and the 

appointment being cancelled is at least a certain number (x) of units of time away. Always begin 

with the largest unit of time (smallest sequence number). The largest sequence number must always 
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be for the smallest unit of time. There is an example below that demonstrates how you could set up 

rules. 

- For each rule of the cancellation schema, enter a different Time Until Reservation and a unit of time. 

The rule takes effect when the time interval between the time of the cancellation and the start of the 

appointment is, at a minimum, within the set time period. The first rule should contain the largest 

time period. The time period should become smaller and smaller from the first to the last rule of the 

cancellation schema. 

- In the Rule field, choose the type of price, that is, one of the following: a price per time (time here 

being the duration of the original appointment), a fixed amount, or a percentage of the original costs. 

Depending on your choice, you also have to make the following additional entries: 

- Percentage of Original Costs: 

Here you also have to enter the percentage in the Percentage field. 

- Price per Time: 

In the Cancellation Amount field, enter the basic price. In the Time Unitfield, specify the time 

unit that the price applies to. 

- Fixed Amount: 

In the Cancellation Amount field, enter the price for cancellation. If you do not want to charge 

for cancellation, then do not make any entry in this field. 

- If you entered an amount in the Cancellation Amount field, then enter the currency for this amount 

in the Currency field. 

- You can also enter a minimum and/or a maximum amount that is to be charged regardless of the 

rule. You enter these amounts in the Minimum Amount or Maximum Amount fields. You do not have 

to make any entries in these fields if you use the Fixed Amount rule. 

Example 

You want to specify that an internal cancellation made up to seven days before the appointment date does 

not incur any costs. Cancellations up to three days before the appointment are charged  euros. 

Cancellations with notice of less than three days are charged % of the costs of the reservation, with a 

minimum charge of  and a maximum of . 

Create a cancellation schema with the following three rules: 

- Rule : Time period:  days; rule: Fixed Amount; Cancellation Amount:  

- Rule : Time period:  days; rule: Fixed Amount; Cancellation Amount:  EUR 

- Rule : Time period  hours; Rule: Percentage; Percentage ; Minimum  EUR, 

Maximum  EUR 

You also want to charge for external cancellations if there are less than seven days between the 

cancellation date and the start of the appointment. In that case, create a second cancellation schema. In 

the first rule, enter the fixed amount you want to charge for the cancellation. 



 

 

 Assign Cancellation Schema 

Use 

Here you make the following general settings for reservations: 

- Cancellation schemas for internal and external reservations 

- Posting activities for billing using one-time postings 

- Default value for whether a user or business partner should be saved for the reservation (see User or 

Business Partner) 

Activities 

The settings you make are dependent on the following parameters: 

- Reservation area 

- Reservation object type 

- Reservation type 

If the cancellation schema is not dependent on the reservation area or the reservation type ( or both), then 

you can leave these fields blank as applicable. 

 Long-Term Seating Arrangements and Move Planning 

 Basic Settings for Price Calculation 

Activities 

- Smallest Unit That Can Be Reserved 

Specify here the intervals at which the reservation can be changed (such as hours or minutes). 

- Can Be Reserved Externally/Internally 

For objects that can be continuously occupied internally, the setting Internal is correct. 

- Billing indicator 

Specifies that the continuous occupancy is subject to a fee. 
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The costs are posted directly to CO using transaction REORCOSTPOSTPO. This requires the 

occupant to be specified in the seating arrangements and the service provider in the 

reservation object. The posting is made manually as a manual cost allocation ( transaction 

KAMV). 

- Frequency and Frequency Unit 

Specify with which frequency the settlements are to be posted. 

 Assign Desk Assignments to Reservation Object Type 

Use 

In this activity, you can assign an architectural object type with a certain architectural function to each 

reservation object type. This architectural object type and function represent the actual desk assignments 

in a room. 

When you create or update a reservation object, the system adopts the capacity from the architectural 

object belonging to the reservation object. (Capacity means, for example, the number of desk assignments 

in an office.) When planning occupancy or planning moves, the user can enter a sequence number for 

each individual desk assignment. However, it is not possible to specify a particular desk assignment here. 

By implementing the BADI_REOR_POSITIONS BAdI, you can also change the selection of existing 

desk assignments, or make your own custom implementation. Or you could, for example, evaluate locks 

on the individual desk assignments. For more information, see the documentation for the 

BADI_REOR_POSITIONS BAdI. 

Requirements 

You set up architectural object types. 

You defined the architectural functions. 

Activities 

- For each reservation object type, enter an architectural object type and its function, to be used for 

deriving a reservation object. 

- Implement the methods of BAdI BADI_REOR_POSITIONS, if needed. 

Example 

You have a reservation object type Office. You want to assign the architectural object type Workplace 

with the function Office desk to it as a means of representing the available desk assignments in the office, 

so that the capacity can be transferred to the reservation object. 



 

 

 Specify Default Date for First Posting 

Use 

Here you make basic settings for continuous occupancy and/or move planning. 

Activities 

Specify the following: 

- In the Posting From field, enter the date starting from which you want to be able to allocate costs for 

the use of rooms for continuous occupancy. 

 Define Lock Reasons for Occupancy 

Use 

You can assign a lock, with its lock reason, to reservation objects that are for continuous occupancy. The 

lock applies for a specified period of time. You can also specify that the system does not invoice any 

costs for time periods that are locked. The system also does not allow planning of move-ins for the object 

during the period that is locked. 

Activities 

Define all lock reasons that you need. If you want to use locks, but do not need to distinguish between 

various reasons for the lock, then define just one lock reason (for instance, X Locked). 

 Define Number Range for Move Planning 

Use 

You specify the number range intervals here that you want to use for move planning. 

Activities 
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- If you always want the number for move planning to be assigned externally - meaning by the user - 

then define the intervals in which these numbers can be found. 

- You might also want to make it possible for internal numbers to be assigned. In that case, specify 

that one number range interval is internal, and enter the upper and lower limit for the numbers to be 

assigned by the system. 

The system then follows this logic when a move plan is saved: 

- If the user entered a number or ID for the move plan, then the system checks if this number is within 

a number range interval that was entered here and defined as External. If these criteria are met, and 

the number was not yet assigned, then the system stores the move plan under this number. 

- If an external number range is not defined, or the user did not enter a number or ID before saving, 

then the system checks if an internal number range is defined. (If more than one internal number 

range is defined, the system uses the first one.) If such a number range interval exists, then the 

system uses the next number from this interval. If it does not exist, the system issues an error 

message. 

 Define Move Types 

Use 

You can choose to assign a move type to a move. The move type is used only for classification, 

and you can use it as a selection criterion in reports and search helps. The move type does not 

have any control function in the system. 

Activities 

Define the move types that you want to have in your company. 

Example 

INT - internal move 

EXT - move with external moving company 

 Implement Enhancements ( BAdI ) 

 Desk Assignments on Reservation Object 
Use 



 

 

The BAdI is called in long-term seating arrangements, and serves to provide default values for the items 

that are available for the occupancy of rooms. Notes for Developers 

 Determine Possible Available Desk Assignments 

Use 

Using this business add-in, you can do the following during move planning: 

- Have the system propose desk assignment numbers for target rooms (move plan - target rooms - 

button: Propose Desk Assignments) 

- Set own desk assignment numbers for target rooms in the appropriate fields ( automatically ) 

Standard settings 

The standard system behavior for default values is as follows: 

- The system searches for historic (old) entries for desk assignments. 

- Then the system searches these entries for any desk assignment numbers that are not yet assigned. 

Example 

There is a default implementation, CL_DEF_IM_REOR_PO_SUGGEST_POS, for this BAdI. 

There desk assignment numbers are proposed in ascending order, beginning with the number . 

It ignores desk assignments that are already assigned or which are already planned for the future. 

Notes for Developers 

 Complex Price Determination for Reservations and Seating Arrangements 

 Define Price Code 

Use 
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Specifies the significant criteria for determining a price. 

If it is not possible to enter the price as an amount per unit of time because the method of determining the 

price is more complex, then you can enter a price code, rather than a price, on the reservation object. 

To make this possible, enter all price codes, which the system views as separate entities, in Customizing. 

In addition, you enter rules in Customizing for how the system determines the price dependent on the 

price code. 

Requirements 

You need price codes only in the following cases: 

- The costs for a reservation or for services related to a reservation for a continuously occupied room 

in your company are allocated to Controlling (CO) or to an external party. 

- The price per unit of time is not entered on the reservation object (for instance, because there is a 

graduated price list based on the reservation type, length of the reservation, or other criteria). 

Activities 

Process the price codes you need in your company, and then enter the prices for them. 

Example 

In your company, you decide to calculate prices differently for external bookings than for internal 

bookings: 

- For internal bookings, the price is  euros per hour per room, regardless of the location. 

- For external bookings at Location , the same price is charged as for internal bookings. 

- For external bookings at Location , the charges are as follows: For reservations lasting more than 

four days, the charge is  euros per day. For a reservation for at least one day, the charge is  euros per 

day. For reservations by the hour, the charge is  euros per hour. 

In this case, you define two price codes: 

- CODE (entered for rooms of Location ) 

- CODE (entered for rooms of Location ) 

In the set of rules for determining the price, you then enter the rules described above so that the price can 

be derived. 

Aside from the price code, the price can also be dependent on other factors, such as: 

- The reservation type 

- The duration of the reservation 



 

 

- The reservation object type 

- Attributes of the reservation object 

- And more 

 Derive Price Based on Price Code and Other Criteria 

Use 

In some cases, a price is not entered directly on the reservation object or the service, but is instead stored 

in the form of a price code. Here you specify how the system determines the price using this price code. 

Activities 

The system derives the price in several steps. Normally you enter a derivation rule for each of these steps. 

The system processes the individual steps in the sequence that you specify. 

- Create at least one derivation rule. Enter a name for the rule that makes it clear what is being 

evaluated in this step. If the derivation is a conditional derivation, then name the condition in the 

text. 

- If the derivation specified in this step should only be performed if certain prerequisites are met, then 

you should specify these prerequisites first. Choose the Condition tab page and enter the 

prerequisites. Then the system performs this step only if all prerequisites contained in the table are 

met. 

- Then choose the Definition tab page to specify the actual derivation. 

In the Source Fields table, you can choose the fields on which the price depends. The following 

fields are available: 

DAYS          Duration of the appointment in days 

HOURS         Duration of the appointment in hours 

ISALLDAY      This is an all day appointment ISHOLIDAY     The 

appointment falls (wholly or in part) on a public holiday ISWEEKEND     

The appointment falls (wholly or in part) on a Sunday 

NEIGHBORH    First location field of reservation object 

NEIGHBORH    Second location field of reservation object 

NEIGHBORH    Second location field of reservation object 

PRICECODE     Price code 

RECURCOUNT    Number of appointments (for a recurring appointment) 

RSAREA        Reservation area 

RSOBJID       Object key of reservation object 

RSOBJTYPE     Type of reservation object 
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RSTYPE        Reservation type 

TIMEFROM      Starting time 

TIMETO        Ending time 

WEEKDAYFROM   Weekday (start,  = Monday, ...,  = Sunday) 

WEEKDAYTO   Weekday (end,  = Monday, ...,  = Sunday) 

If you want to determine a price for a reservation, then the system specifies the values for these 

fields from the data currently entered for the reservation. Choose fields in your system that could 

influence the price of a reservation. Avoid using fields that do not contain relevant information. 

For example, if twenty different locations are defined in your system, but only two reservation 

areas, then specify if there is a different price for each location, or only for each reservation area. If 

you want to have three different price zones, then you can add a third reservation area, rather then 

entering the same rule many times for a large number of locations. 

- Once you have specified the source fields, choose Maintain Rule Values. For each possible 

combination of source fields that are used in this rule or step, enter the values for the source fields. 

For each combination of source fields, enter the values to be derived for the target fields. The fields 

have the following meanings: 

FLOWTYPE     Flow type that is used for the account determination 

PRICE        The derived price 

CURRKEY      Currency for the price 

TIMEUNIT     Time unit that the price refers to 

ISPERMEAS    Is the price per measurement? 

MEAS         Measurement unit 

Depending on the value of the ISPERMEAS and TIMEUNIT indicators, the system multiplies the 

price with the measurement value and/or the duration of the appointment. The price that the system 

determines in this way is then billed during periodic settlement of costs or posted to an account 

assignment object in CO. 

As soon as the system finds a price for the current reservation in a given step, the process stops there and 

the system does not make any further derivations. 

 Derive Price of Service Dependent on Price Code and Other 

Information 

Use 



 

 

In some cases, a price is not entered directly for a service, but is instead stored in the form of a price code. 

Here you specify how the system determines the price using this price code. 

Activities 

The system derives the price in several steps. Normally you enter a derivation rule for each of these steps. 

The system processes the individual steps in the sequence that you specify. Create at least one derivation 

rule. 

- Enter a name for the rule that makes it clear what is being evaluated in this step. If the derivation is a 

conditional derivation, then name the condition in the text. 

- If the derivation specified in this step should only be performed if certain prerequisites are met, then 

you should specify these prerequisites first. Choose the Condition tab page and enter the 

prerequisites. Then the system performs this step only if all prerequisites contained in the table are 

met. 

- Then choose the Definition tab page to specify the actual derivation. In the Source Fields table, 

you can choose the fields on which the price depends. The following fields are available: 

DAYS          Duration of the appointment in days 

HOURS         Duration of the appointment in hours 

ISALLDAY      This is an all day appointment ISHOLIDAY     The 

appointment falls (wholly or in part) on a public holiday ISWEEKEND     

The appointment falls (wholly or in part) on a 

Sunday 

NEIGHBORH    First location field of reservation object 

NEIGHBORH    Second location field of reservation object 

NEIGHBORH    Third location field of reservation object 

PRICECODE     .Price code 

RECURCOUNT    Number of appointments (for a recurring appointment) 

RSAREA        .Reservation area 

RSOBJID       Object key of reservation object 

RSOBJTYPE     Type of reservation object 

RSTYPE        Reservation type 

TIMEFROM      Starting time 

TIMETO        Ending time 

WEEKDAYFROM   Weekday (start,  = Monday, ...,  = Sunday) 

WEEKDAYTO     Weekday (end,  = Monday, ...,  = Sunday) 

- When you want to find the price for a service, then the system determines the values for these fields 

from the data currently entered for the service. Choose fields in your system that could influence the 

price of a service. Avoid using fields that do not contain relevant information. 

- For example, if twenty different locations are defined in your system, but only two service areas, 

then specify if there is a different price for each location, or only for each service area. If you want 
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to have three different price zones, then you could add a third service area, rather then entering the 

same rule many times for a large number of locations. 

- Once you have specified the source fields, choose Maintain Rule Values. For each possible 

combination of source fields that are used in this rule or step, enter the values for the source fields. 

For each combination of source fields, enter the values to be derived for the target fields. The fields 

have the following meanings: 

FLOWTYPE     Flow type that is used for the account determination 

PRICE        The derived price 

CURRKEY      Currency for the price 

TIMEUNIT     .Time unit that the price relates to 

ISPERMEAS    Is the price per measurement? 

MEAS         Measurement unit 

SRVTYPE      Service type 

SRVGROUP     Service group 

Depending on the value of the ISPERMEAS and TIMEUNIT indicators, the system multiplies the 

price with the measurement value and/or the duration of the appointment. The price that the system 

determines in this way is then billed during periodic settlement of costs or posted to an account 

assignment object in CO. 

As soon as the system finds a price for the current service in a given step, the process stops there and the 

system does not make any further derivations. 

 Implement Enhancements (BAdI): Price Derivation 

Use 

The BAdI is run 

- In room reservations 

- In long-term seating arrangements 

It allows the derivation of the price for the reservation or the long-term seating arrangement. For this the 

method GET_DERIVATION is called. In this method, the price can be determined based on entries for 

the reserved object and the duration of the reservation, whereby you can specify certain parameters (such 

as, price applies per measurement, price applies for a certain time unit). 

Notes for Developers 



 

 

 Implement Enhancements (BAdI): Price Calculation Outline 

Agreement 

Use 

In an outline agreement, you can specify conditions for leasing out rooms to external tenants. The price 

for a reservation/occupancy is calculated in this case from the unit price in the contract condition and the 

duration of the reservation/occupancy. The BAdI allows you to determine the price of the room 

reservation or a continuous occupancy independently of the contract conditions using your own 

algorithms. 

Requirements 

This BAdI is only run if the reservation/occupancy contains an outline agreement that has a condition 

with calculation formula : Reservation with Periodic Billing. In this case, you can use the method 

CHANGE_PRICE to determine the price using your own algorithms. 

When you save the reservation/occupancy, a planned record for a posting with the calculated price is 

set up in the cash flow for the outline agreement. Notes for Developers 

 Third-Party Management 

 Master Data of COA Mandate and Object Mandate 

 Specify Number Range Interval for COA Mandate and Object Mandate 

Use 

In Flexible Real Estate Management, there are two types of mandate: COA mandate or object mandate. 

For both of these mandate types, the system creates a separate company code that has the number of the 

mandate. 

Here you can specify the number range interval that is used when the mandate is created. 

Activities 

Enter the number range interval you want to use for the mandate type. 
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You should use different number range intervals. You should also define the number ranges to that you 

can immediately see the following in the resulting company code number: 

- Whether the company code is a "normal company code" (that is, a company code in which you 

manage your own objects, or a company code that does not have real estate management) 

- Whether the company code is for managing objects for a third party (object mandate) 

- Whether the company code is a COA company code (COA mandate) You enter the number ranges 

for the number range interval in the  next IMG activity. 

 Specify Number Ranges for Mandate 

Use 

Here you define the concrete number range from which the number for a mandate is assigned (internal 

number assignment) or that is used for checking the number of a mandate. The number range that is used 

depends on the mandate type defined in Customizing. 

When the system checks the number of a mandate, it also checks if there is already a company code with 

the same number.  If there is a company code with the same number, then the system does not create a 

mandate with this number. 

 Activate Time-Dependent Mandate Assignment 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 



 

 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data 

Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 
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The system displays all field groups that know the given application. In order to display the fields of 

a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, 

and display fields in display mode.) If it is not possible to make a setting for a field group, then the 

system determines how the field is treated (usually dependent on the situation, or on the contents of 

other fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of 

the view accordingly (consider the detail screen). Then assign the field groups to the view. You can 

assign your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it 

is surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 



 

 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you 

want to this section. The item number specifies the sequence in which the views are arranged in the 

section. For technical reasons, if you make your own assignments from sections to views, the item 

numbers have to be in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 
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SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 



 

 

 Implement Enhancements ( BAdI ) 

 Number Assignment, Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of mandates. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications 

Notes for Developers 

 Condominium Owner Mandate 

 Information on the Condominium Owner Company Code 

Use 

The condominium owner company code is for all processes that relate to managing the rental of 

condominiums on behalf of the individual condominium owner. 

The condominium management contract is a vendor real estate contract. The vendor is the third-party 

manager to whom the management fees are paid. 

The condominium owner is the second main contractual partner. The condominium owner is copied from 

the assessment contract in the COA company code. 

You assign rental objects (of one or more condominium owners associations) to the condominium 

management contract. All of these condominiums must have the same owner. You create the rental 
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objects in the condominium owner company code. For the purposes of tenant settlement, these rental 

objects have to be linked to the related rental objects in the COA company codes. 

You enter all bank details of the condominium owner, which are needed for condominium management, 

in the condominium management contract (real estate contract). At the latest when the contract is 

activated, these bank details are created as house banks in the condominium owner company code. 

In addition, you have to enter a unique profit center for each owner in the condominium management 

contract. You use this profit center for all postings that do not have a direct reference to a bank account of 

the owner, so that you can assign these postings to the owner. 

The rental objects in the condominium owner company code are leased out using real estate contracts of 

the lease-out category. The tenant is the (customer) main contractual partner of the contract. You can 

enter the owner as an optional additional contractual partner. 

In the real estate contract, you enter the house bank to which the tenant pays the rent. For this house bank, 

it is mandatory to use a house bank account that is entered in the condominium management contract for 

the rental object in the bank details of the owner. The bank details of the tenant are, as usual, managed as 

the partner bank. 

Periodic postings for the tenant are made in the condominium owner company code. The rent is charged 

to the tenant as customer. The tenant pays rent to the house bank account of the owner. 

 Tenant settlement is performed in the COA company code (usually after  COA settlement ). The system 

determines the share owed by the tenant for each rental object that is leased out in the manager company 

code or condominium owner company code. This amount is invoiced to the tenant. The corresponding 

receivable or credit memo is posted in the condominium owner company code. 

 Define Number Range for House Bank 

Use 

When you activate a condominium management contract, the system automatically creates house banks in 

the condominium owner company code for the entered bank details. 

If the bank does not yet exist at that point, then a new house bank ID has to be assigned to it. Here you 

specify the number range that this ID is assigned from. 

Activities 

For interval ',' specify how you want the number range for house banks in the condominium owner 

company code to be. If you want the system to assign the ID automatically, choose internal number 

assignment. If you want the user to assign the number, choose external number assignment. You should 

choose the number range so that it is different from those used for the house banks in other company 

codes. In this way, the generated house bank for an owner can be easily distinguished form manually 

created house bank accounts on the basis of the ID. 



 

 

 Other Settings for Condominium Owner Company Code 

Standard settings 

Standard Customizing contains company code RECO with controlling area RECO for individual 

condominium management. 

Activities 

- Profit center accounting must be activated. 

- For document entry, the House Bank and Account ID for Bank Accounts fields must be active. Both 

fields become active when "Own Bank" is set as OPTIONAL field in the field status variant for 

document entry and RE is active. 

Example in the standard system: 

Field status variant , field status group G, payment transactions, Own Bank field Field Status 

Variants for Document Entry 

 Annual Budget 

 Specify Cost Elements to Be Planned for Annual Budget 

Use 

The  annual budget of a condominium owners' association is similar to cost element planning at the level 

of the settlement unit. Normally the only classification structure that is relevant is one from the viewpoint 

of settlement units (or of the service charge key). 

However, the system also allows a subclassification by cost elements. In this subclassification, you are 

allowed to use all cost elements with which the given settlement unit can be posted. 

Here you enter the cost elements that should be used in addition to the service charge key to classify the 

annual budget. For example, in the detail screen, you can enter the reconciliation accounts, which will be 

relevant later for actual settlement, even if these accounts are not yet relevant for creation of the annual 

budget. 
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 Settlement 

 COA Settlement and Tenant Settlement 

Use 

In third-party management, there are two types of settlement processes related to condominium owners: 

- During COA settlement, the costs on a settlement unit are settled to the owners who are entered in 

the assessment contracts. In the settlement unit, you specify the apportionment rules that are used. 

The measurement types are specified on the rental object in the COA company code. 

- During tenant settlement, the system searches for rental objects that are identical to those in the 

COA company code. These rental objects can be in the  manager company code or in the  

condominium owner company code. If such rental objects are found, then the system apportions 

the costs to the tenants of these objects (based on the occupancy contract in the condominium 

owner company code or manager company code). The apportionment rule used in this case can be 

the same as the one for the COA settlement. 

The process for COA settlement is essentially the same as for normal service charge settlement. However, 

since the assessment contract usually uses different condition types, you have to make a few additional 

settings. Make the necessary additional settings for COA settlement in the following IMG activities: 

- Assign Condition Type to Service Charge Key/Group 

- Define Settlement Parameters 

You make settings for the service charge key, and any settings dependent on the service charge 

key, in the IMG activities under Settlement.  This applies, regardless of whether or not the service 

charge key can only be used for apportionment to owners. If you only have  object mandates in 

third-party management, then you do not have to make any settings for them in the IMG activities 

listed here. In object mandates you perform only normal service charge settlement. You make 

settings for the object mandate in the IMG activities under Service Charge Settlement, just as you 

would for your own rental objects. 

 Assign Condition Type to Service Charge Key/Group 

Use 

Here you specify which conditions for service charge advance payments and which conditions for flat 

payments are cleared against each other. 



 

 

Activities 

The various control options are described below. Make an entry in the table for each condition 

for advance payments and each condition for flat-rate payments. Specify the following for each entry: 

- Whether the condition type is only allowed to be cleared by costs of certain service charge keys 

- Whether the condition type can be cleared by all costs on the settlement units of a certain service 

charge group 

- Whether the condition type can be cleared by all costs in the categories "Operating Costs"/"Heating 

Costs" or "Operating and Heating Costs" 

Use 

For the system to be able to check or generate the settlement participation, the condition types, which play 

a role in service charge settlement (advance payments and flat payments), must be linked to the service 

charge key. This can be done as follows: 

- The advance payment condition type is assigned directly to the relevant service charge key 

Example: 

Condition type:  Elevator advance payment 

Service charge key:  Elevator 

Service charge category:  No general costs ( SCK-specific ) 

Service charge group: < blank > 

- A service charge group is assigned to the advance payment condition type: 

Example: 

Condition type:  Caretaker services advance payment 

Service charge key: < blank > 

Service charge category: <anything> 

Service charge group: Caretaker services 

(The service charge group is assigned in Customizing, for example, to the service charge keys  

Gardening 

 Caretaker 

 House cleaning 

.) 

- The service charge category "operating costs" or "heating expenses" is assigned to the advance 

payment condition type: 

Example: 

Condition type:  Operating costs advance payment 

Service charge key: < blank > 

Service charge category:  Operating costs 

Service charge group: < blank > 

The service charge key is settled, for which in Customizing in the definition of the service charge 

key, you set the operating costs indicator. 
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Advance payment condition types valid for operating costs and heating expenses have service 

charge category  - general service charges. 

Example: 

Condition type:  operating costs/heating expenses advance payment 

Service charge key: < blank > 

Service charge category:  - General service charges 

Service charge group: < blank > 

The settlement participation is generated/checked when you create/change an occupancy contract and 

during service charge settlement.  The system determines the settlement units, to which the rental objects 

are assigned, and which are leased out in this contract. It also attempts to assign the advance payment and 

flat payment condition types that are assigned here. To do this, proceed as follows: 

- First the system searches for an advance payment condition type that is defined exactly for this 

service charge key (see first point above). 

- Then it searches for an advance payment condition type that belongs to the service charge group of 

the service charge key (see the second point above). 

- Finally, it searches for an advance payment condition type that belongs to the category "operating 

costs" or "heating expenses" (depending on whether the operating costs or heating expenses 

indicator is set for the service charge key). 

- If it still cannot assign any condition type, the system searches whether the contract has a condition 

type that is specified in Customizing with the service charge category " General Service Charge." 

- If this condition type also does not exist, the system assumes, depending on the setting in 

Customizing for the Defaults for Settlement Participation per Service Charge Key that it is a final 

settlement (for which no condition type is required) or that the contract does not participate in this 

settlement unit. 

Example 

The advance payment conditions and service charge key are set up as specified in the examples above. 

There are settlement units for the following service charge keys: 

 Property damage and liability insurance 

 Water supply 

 Elevator 

 Street cleaning 

 Garbage removal/disposal 

 Broad band cable network 

 Caretaker 

 House cleaning 

  Heating expenses 

They are all marked as "operating expenses" except for service charge key . 



 

 

- For contract , it is listed explicitly which advance payments have been made for which costs. The 

following conditions are defined: 

 operating costs advance payment 

 Elevator advance payment 

 Caretaker services advance payment 

In the settlement participation, the advance payments for this contract are assigned to the advance 

payment condition types as follows: 

 Property damage and liability insurance  ->  operating costs advance payment 

 Water supply  ->  operating costs advance payment 

 Elevator  ->  Elevator advance payment 

 Street cleaning  ->  operating costs advance payment 

 Garbage removal/disposal  ->  operating costs advance payment 

 Broad band cable network  ->  operating costs advance payment 

 Caretaker  ->  Caretaker services advance payment 

 House cleaning  ->  Caretaker services advance payment 

  Heating expenses  -> No assignment 

- Contract  only has the condition " operating costs advance payment". For this contract, all service 

charge keys except for  are assigned to the condition type  -> operating costs advance payment. 

No condition type can be assigned for both contracts for the settlement unit with the service charge key . 

It would be designated as a final settlement if this has been set up in Customizing. 

 Define Settlement Parameters 

Use 

In this activity, you can predefine the necessary parameters for the settlement run. This makes 

parameter blocks available to users for selection when they start settlement. As a result, the user does 

not need to enter the parameters individually. 

Activities 

Set the values for the individual indicators: 

- Active: 
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Parameter blocks are offered for selection during settlement only if they were set to active. This 

enables you to leave parameter blocks in the system that you have tested but do not want to offer in 

the application. You can then activate them later if you need them. You have to set the Active 

indicator separately for each of the following: "normal" service charge settlement, COA settlement 

(for condominium owners in the COA company code) and tenant settlement (for tenants renting 

condominiums). For accruals and deferrals, there is a similar indicator in the Parameters for 

Accrual/Deferral group box. If you need the current occupancy principle for COA settlement, but 

do not need it for tenant settlement, you can also set the indicator differently for each of them. 

- Standard: 

Set this indicator if you want this parameter block to be proposed as the default when you start 

settlement. 

For this setting there is also a separate indicator for "normal" service charge settlement, COA 

settlement, tenant settlement, and accrual/deferral. 

- Split Receivable If Tax Changes 

This indicator specifies that you want the receivable posting to be split based on time when the tax 

rate changes within the settlement period. 

- Post Balance: 

Set this indicator if you want to balance the receivable with the advance payment. This function is 

currently only available when the Leave Open APs (Planned Principle) indicator is set. 

- Leave Open APs (Planned Principle) 

Set this indicator if you do not want the settlement to automatically clear open advance payments 

(advance payments that were agreed on and posted, but not yet paid). This is advisable in certain 

cases (see long text). 

- Current Occupancy Principle: 

Austria only: Set this indicator to settle rental agreements and rental units with the current 

occupancy principle indicator in service charge settlement based on the current occupancy principle. 

- Print Separately: 

If you set this indicator, correspondence is not printed automatically as part of settlement. Instead, 

you must print it separately. We recommend that you set this indicator for the standard procedure so 

that correspondence is not printed automatically each time a complete settlement run is simulated. 

- Consider Vacancy Percentage 

This indicator must be set if you want to include a vacancy percentage rate (percentage at which 

the cost share of the vacant rental object can be transferred to the other tenants) that can be 

specified on the settlement unit. In most countries this is not allowed or is not usual. 

- Use Other Apport. Factor ( Sim./Accr. ) 

This indicator applies during simulation of service charge settlement or during accrual/deferral of 

service charges. If this indicator is set, then, for all settlement units that have an alternative 

apportionment factor (to be used if it is not possible to determine the measurement), the system uses 

this alternative apportionment factor. This is particularly relevant for settlement units that are 

normally apportioned based on consumption (alternatively based on residential/usable space). If this 

indicator is set, then the system does not base the apportionment on consumption but distributes 

instead immediately using the residential/usable space. The system ignores this indicator during an 

actual settlement. 



 

 

- Elimination of Internal Business Volume 

It is possible that a settlement unit could contain rental objects and contracts with different profit 

centers. If that is the case and you want to perform elimination of internal business volume, then set 

this indicator. The system then ensures that posting is always two-sided. 

- Distribute Remainder 

Small differences can arise when costs are distributed from the settlement unit to the rental objects. 

Here you specify if differences are distributed, and if so, how. 

- Surcharge Schema 

The surcharge schema specifies if the system calculates a surcharge on the settlement result, and, if 

so, how this surcharge is calculated. You can define the surcharge schema in the Define 

Calculation of Surcharges IMG activity. 

- Default Values for Data Medium Exchange for External Settlement 

You can make settings here that appear as defaults for settlement but can be overwritten. These 

settings define where files are imported from or exported to for data medium exchange, and the 

names of the files. 

- Parameters for Accrual/Deferral 

First specify if the parameters are allowed to be used for accrual/deferral and whether these are the 

standard parameters (see above). 

If there are no settlement parameters designated as allowed, then the system proposes the parameters 

that are allowed for "normal" service charge settlement. 

- AP Needed for Accrual/Deferral 

Set this indicator for parameters that are used for accrual/deferral, if you want the system to read 

advance payments during the accrual/deferral. Then the system either displays the advance 

payments for information only, or reposts them, depending on whether flow types are set up for this. 

Restrictions related to whether individual parameters can be combined. 

If you select the option "Charge Input Tax to Tenant", then the following options are not allowed to be 

selected: 

- "Post Balance" 

- "Split Receivable If Tax Changes" 

- "Consider Current Occupancy Principle" 

 Enhancements 

 Implement Enhancements (BAdI): Report on Reserves and 

Investments 
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Use 

The BAdI BADI_REEX_FI_MM_CAPITAL makes it possible for you to change the display in the 

transactions Statement of Reserves and Capital (transaction REISMMCAP) and Detailed Statement of 

Reserves and Capital (transaction REISMMCAPD). The following methods are available: 

- CHANGE_ACCOUNT: You can use this method to edit the selection of accounts that is executed 

for the report. 

- CHANGE_CAPITAL_DATA: In this method, you can change data selected from the accounts 

(totals values), for instance by adding information. 

- CHANGE_CAPITAL_PER_RO: In this method, you can edit or add to values on the individual 

objects (condominiums) (only for transaction REISMMCAPD). Notes for Developers 

 Country-Specific Settings 

 Activate Country-Specifics 
Use 

To meet certain country-specific needs, program code has been written in Flexible Real Estate 

Management (RE-FX) that is only relevant for certain countries. For example, certain fields in master 

data processing only apply to specific countries. In order to keep Customizing as simple as possible, 

these fields are included in the standard screen sequences of standard Customizing. However, they are 

only visible when the given country has been activated here. In a similar way, some countries use BAdIs, 

for example, to help create default settings. These BAdI implementations are delivered as active by SAP, 

but the system exits the program immediately if the required country is not active. 

Standard settings 

In the standard system, all countries that have their own country-specific program code are not active. 

There is country-specific code for the following countries: 

- AT - Austria 

- CH - Switzerland 

- IT - Italy 



 

 

- JP - Japan 

- PT - Portugal 

Activities 

If you are using Flexible Real Estate Management (RE-FX) in one of the countries listed above, set the 

Active indicator for your country. Also check the IMG node for your country to see what other settings 

you need to make. 

While it is technically possible to add other countries here, it has no effect, unless you program project-

specific BAdIs that query this indicator for the given country. 

Note 

This IMG activity is the prerequisite for all  other country-specific settings that you make in the 

Implementation Guide. Therefore this activity is not listed as a prerequisite in the other country-specific 

IMG documents. 

 Germany 

 Land Use Management 

 Central Settings for Land Use Management 

 Activate Subapplication 

Use 

Some enhancements to the standard system are subapplications of Flexible Real Estate Management (RE-

FX) from a technical perspective. One example is land use management (LUM), a country-specific 

development for Germany. 

Activities 

Set the  active indicator for subapplications you need.  The system treats any subapplication that is not 

found in the table as an inactive subapplication. 

 Make General Settings for Land Use Management 

Use 
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In this section you make general settings for Land Use Management ( LUM ). 

Activities 

You enter default values in the Defaults for Land Registers and Defaults for Parcels group boxes. These 

default values apply per master data object in dialog processing. You enter values for units of area, units 

of length and units of time. You can also enter a default currency, if needed. 

For parcels, you can also enter default values for the location structure and for overlays for cadastral 

usage types. 

 Define Hierarchical Location Structure 

Use 

In this activity you define various  location structures. Location structures are used to uniquely identify 

parcels or land registers for different purposes. 

In Germany, you use these settings to create, at the minimum, the following two hierarchies: 

- APR hierarchy for the automated property register of the land registry 

- Administrative hierarchy for the survey office 

Activities 

Enter an ID and a name for your location structure. 

Specify the number of levels for the hierarchy and the names of each level. 

For each location structure, you also specify the following: 

- Allowed Hierarchical Location Structures per Object Type 

Specify if assignment of the object type to this location structure is mandatory. Specify if this is the 

standard location structure. 

- Hierarchical Locations in Location Structure 

Here you enter the possible locations for each defined hierarchy level. 

Example:  

You defined these three levels for the location system: 

1 - Country 

2 - Region 

3 - City 

Then you enter all countries, regions and cities that you need in your system. 



 

 

- Assignment of Hierarchical Locations in Location Structure 

You assign the already defined hierarchical locations to one another and assign a key for each 

location. You can then assign only this key to a parcel or a public register in the application. 

You are not required to assign the keys systematically, but it is a good idea. The key of the 

hierarchical location is not allowed to contain any spaces. 

If the assignment should change due to restructuring of individual hierarchical locations, it is not a 

problem to assign new keys (at the level Assignment of Hierarchical Locations in Location 

Structure) or to assign other locations to an existing key. However, if the key itself should change, 

then you have to change the master data. 

Example 

You defined the following locations at the given level: 

Level  - Country: 

DE - Germany 

CH - Switzerland 

US - USA        

Level  - Region: 

D - North Rhine-Westphalia 

D - Bavaria 

CH - Basel 

CH - Tessin 

US - Michigan 

US - Florida             

Level  - City: 

D-K - Cologne 

D-D - Duesseldorf 

D-M  - Munich 

CH-B - Basel 

CH-LG - Lugano 

US-CH - Chicago 

US-M  - Miami 

US-OL - Orlando 

Assignment of Hierarchical Locations in Location Structure:  

For the assignment of hierarchical locations in the hierarchy, you have to assign a unique key to each 

hierarchical location. 

A hierarchical location cannot be used in object unless it has a key here. 

DE-K   Cologne     DE   D   D-K 

DE-D   Duesseldorf DE   D   D-D 
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DE-M   Munich      DE   D   D-M CH-B   

Basel       CH   CH  CH-B 

CH-LG  Lugano      CH   CH  CH-LG 

US-CH  Chicago     US   US  US-CH 

US-M   Miami       US   US  US-M 

US-OL  Orlando     US   US  US-OL  

In this case, you would assign the location DE-K to a parcel in Cologne. It is then clearly visible, both in 

master data processing and in reports, that this parcel has the following location: 

- Country:  Germany 

- Region:  North Rhine-Westphalia 

- City  Cologne 

 Define Search Strategy for Deriving Hierarchical Location 

Use 

You can use a search strategy so that an appropriate hierarchical location can be proposed for a given 

parcel (or piece of land). 

Search strategies use search methods, which specify how the hierarchical location is determined from the 

object data. 

In order for the system to be able to determine a default value or possible search help value for the 

hierarchical location of the parcel, exactly one search strategy must be active for the LOCHIER search 

field. 

Activities 

Define the search strategy for the LOCHIER search field as follows. 

Set the Active indicator for the search system you want the system to use. (All other search strategies are 

then superfluous and can be deleted. It is only possible in the test phase to define one search strategy for 

each search method being tested.) Enter a name for the search strategy. 

Specify how the search takes place: 

- Name 

Text of search strategy (informational only) 

- Search Method 

This is a method that is predefined in the system. The method describes how the search is 

performed. The way the system processes the values for the search strategy depends on the method 

you select here. Choose a method using the input help. 

- Active? 



 

 

You can only use search strategies. For example, if you copied the search strategies from standard 

Customizing, then set the Active? indicator for those that you want to actually use in your system. 

- Other Values 

Set this indicator, if you also want the standard search help to be available. The system then displays 

a Further Values row, in addition to the values returned by the search strategy.  From there you can 

navigate to the standard search help. 

Only one search method, LOCHIER, is predefined in the system for the hierarchical location. 

You can activate it by copying the sample code in the  BADI_RECA_SEARCH_METHOD 

BAdI: 

LOCHIER: Derive hierarchical location from already existing hierarchical location. 

This search method assumes that the texts of the hierarchical locations in the different location structures 

do not differ. For a hierarchical location being derived, the system therefore checks if a hierarchical 

location was already entered (and if so, which one) and if there is a corresponding hierarchical location 

with the same text in the other location structures. If there are hierarchical locations that meet these 

criteria, then the system proposes them. 

To be able to use this search method (that is delivered with the system), you have to copy the sample 

coding of the implementing class CL_EXM_IM_RECA_SEARCH_METHOD of enhancement spot  

BADI_RE_CA_SH to a customer class. Then you must activate this customer implementation. 

 Set Up Contract Types for Land Use Management 

Use 

If you want to manage contracts for land use management (LUM) in your system, then you should set up 

contract types specifically for land use management here. 

Requirements 

You defined  contract types for land use management. 

Standard settings 

You should use some of the contract types defined in standard Customizing. According to their naming 

convention, these all begin with the letter L. 

Activities 

Check the following settings for contracts related to land use management: 
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- Set the  M.Fee Not. (Municipal Fee Notice) indicator for the contract type that will be used for the 

municipal fee notice. This setting can only be made here. This indicator is not found in the definition 

of the contract types. 

- O/U ( Offerer/User ) 

In this field, choose Offerer for contract types in which properties are offered, from the viewpoint of 

the company code. Usually these are customer contracts. For properties that are offered to you by 

others for your use, choose User. (These contracts are normally vendor contracts.) The system uses 

the information in this field so that it can correctly display the contract areas on the parcel on the 

Contractual Usage tab page. 

- Influence Holdings: 

Specify how the contract influences your real estate holdings, that is, is it a  contract changing 

holdings (sale, purchase, land lease) or a right of use contract (contract using holdings such as, rent, 

lease). If the contracts of this contract type (such as, right of way) do not affect holdings, then leave 

the default value, No Influence on Holdings. This field also controls how the areas of parcels are 

displayed in reports on area. 

- ScnSeq (Screen Sequence): 

Since some screens are irrelevant for land use management contracts, two special screen sequences 

for land use management are provided in standard Customizing: 

- REGCL LUM: Right of use contracts 

- REGCL LUM: Contracts changing holdings 

Enter the appropriate screen sequence for your contract type. 

- BP Role 

Enter the role of the main contractual partner. 

Example 

 Parcel of Land 

 Define Parcel Map Types 

Use 

Parcels are measured in terms of cadastral area. The surveying is performed either by the survey office 

itself or by another recognized and certified surveyor. The results of surveying a tract of land are recorded 

in  parcel maps 

Here you define different types of parcel maps. 



 

 

 Define Soil Parent Material 

Use 

Here you define the geological origin of the soil (parent material) of parcels. The soil parent 

material is an attribute of the cadastral usage of a parcel and can be used for classifying parcels. 

Cadastral usage is based on legal determinations and regulations, and is recorded in the real estate 

cadaster in the form of overlays. 

 Define Soil Textures 

Use 

Here you define the soil texture of parcels. The soil texture is an attribute of the cadastral usage of a 

parcel and can be used for classifying parcels. 

Cadastral usage is based on legal determinations and regulations, and is recorded in the real estate 

cadaster in the form of overlays. 

 Define Overlays 

Use 

Here you define  overlay numbers that are independent of the given German federal state. 

You then assign the overlay numbers to a hierarchy level of the location structure. You make this 

assignment in the  Specify Relevant Overlay Numbers for Certain Hierarchy Levels IMG activity. This 
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assignment allows you to structure overlays in accordance with the separate requirements of each given 

German state. 

 Specify Relevant Overlay Numbers for Certain Hierarchy Levels 

Use 

Here you assign overlay numbers to a given hierarchy level of a location structure. This assignment 

allows you to structure overlays in accordance with the separate requirements of each given German 

state. 

Requirements 

You defined overlay numbers. 

You defined the hierarchical location structure, 

Activities 

Enter the overlay number that is relevant for each hierarchy level of a given location structure. 

 Specify Cadastral Classification 

Use 

Here you define the  cadastral classification of parcels. This classification represents the use of the parcel 

from the viewpoint of the land survey office. 

Cadastral usages of the same type are grouped together by  overlay numbers. 

Requirements 

You defined the overlay numbers 

Activities 

For each overlay number, enter all cadastral classifications, for which you want to be able to enter 

measurements. 

Enter a key and a text for each cadastral classification. 



 

 

 Specify Usage Types and Usage Subtypes 

Use 

In this activity, you define the usage types of the parcel from the viewpoint of the owner. 

You can also further classify these usage types into usage subtypes. Each usage subtype has to be 

assigned to a usage type. 

You use usage subtypes to group together areas based on actual usage or planned actual usage. 

Activities 

- Enter a key and a name for the usage type you want to define for the parcel. - Decide if the usage 

type is an  actual (internal) usage and/or an  other usage. 

- Specify if the usage type should be included in the  area analysis . 

You also have another option for areas with other usage that are used by contracts that are not 

entered in the system. You can enter here that they are used by contracts and therefore are included 

in the area analysis. 

- If you want to define usage subtypes for actual usages, then proceed as follows: 

- Select a usage type for actual usage and choose Subusage Types. 

- Enter the usage type again, and assign a new key to it and a name for the usage subtype. 

 Define Function for Parcels 

Use 

In this activity, you entere the functions allowed for parcels. 

 Fixtures and Fittings Characteristics 

 Define Fixt./Fittings Characteristics for Buildings, ROs, and Parcels 

Use 

You specify here which fixtures and fittings characteristics are to be available when processing the rental 

object, building, parcel, and architectural object. The fixtures and fittings characteristics that you define 
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here can be assigned to a representative list of rents (see Define Representative List of Rents: 

Characteristic Categories --> Surcharge/Reduction Characteristics). 

For fixtures and fittings characteristics that are not relevant for the representative list of rents, you can 

define a structure using the Specify Structure of Fixtures and Fittings Characteristics Independent of 

Representative List of Rents IMG activity. 

Activities 

- Define all required fixtures and fittings characteristics. 

- For each fixtures and fittings characteristic, specify the objects on which the characteristic is visible: 

rental object, building, and/or parcel. You can then process these fixtures and fittings characteristics 

on the rental object or building by choosing the Fixtures/Fittings tab page. For parcels, you see the 

fixtures and fittings characteristics by choosing the Development tab page. 

If you need fixtures and fittings characteristics in architectural objects, you define them here. Then 

you assign them to architectural objects in the Specify Fixt/Fittings Characteristics for Architectural 

Objects IMG activity. 

When adjusting conditions using the representative list of rents procedure (according to the 

representative list of rents), you can use fixtures and fittings characteristics and their evaluations for 

the calculation of the comparative rent. 

The fixtures and fittings characteristics of the rental object and those of the assigned building 

(provided that this is defined for the representative list of rents) are used in this calculation of the 

comparative rent. If you indicate that a fixtures and fittings characteristic is permitted for both 

object types, you can define the general validity of this characteristic at the building. For the rental 

objects to which the building attribute does not apply, you can then make a different setting in the 

application (see example). 

- Also define for each fixtures and fittings characteristic whether it is relevant for the representative 

list of rents, that is, whether it should be included in the rent adjustment according to the 

representative list of rents. 

- You can define that a specific fixtures and fittings characteristic should only be visible for objects of 

this category (derived from the usage type of the rental object) using the usage category. If you do 

not enter anything here, the fixtures and fittings characteristic can be selected regardless of the usage 

type of the rental object. 

Example 

For example, if all apartments of a house are equipped with oil central heating, you could define the 

fixtures and fittings characteristic Oil Central Heating for the building instead of separately for 

each apartment. If electric heating is installed in the top-floor apartment ( that was subsequently added), 

then when you process this apartment, you can select the Oil Central Heating characteristic as 

not appropriate and instead specify a fixtures and fittings characteristic Electric Heating. 



 

 

 Specify Structure of Fixt./Fittings Characteristics Independent of RLR 

Use 

For rental objects and buildings for which a representative list of rents is defined, the structure of fixtures 

and fittings characteristics (hierarchy of characteristic categories, characteristic groups, and the individual 

characteristics that are displayed in the processing dialog, for example, to define new characteristics for 

an object) is determined using the representative list of rents structure. 

You can also define a structure for characteristics that are not dependent on the representative list of rents 

in this dialog. This structure has the following effects on the display of characteristics in the processing 

dialog: 

- If no representative list of rents is specified for a building or rental object on the relevant business 

entity, then the characteristics are displayed according to the structure defined here when you add 

new characteristics. This also applies to parcels, if you are using Land Use Management (country-

specific for Germany). 

- If a representative list of rents is specified for a building or rental object, then in the processing 

dialog you can switch to representative-list-of-rents-independent display  to use the structure 

defined here. 

When you have switched, the system saves this setting and uses the representative-list-of-rents-

independent display the next time for processing. 

During Maintenance of the Structure ofFixtures and Fittings Chraracteristics for Individual List 

ofRepresentative Rents, you can also determine how the individual characteristics are to be evaluated 

(dependent on the respective representative list of rents). 

The structure specified here is stored technically under Representative list of rents <empty>. 

Activities 

- Select the only line of the characteristic structure (representative list of rents <empty>) and define 

which characteristic categories should be distinguished between. 

- Define characteristic groups if necessary. Characteristic groups are cross-category. You can use the 

defined characteristic groups within a category to structure the characteristic assignment further. 

You can also define how many characteristics of a group can be assigned to a category for each 

group. 

- Assign the characteristics that should appear under this category to each characteristic category. 

Each characteristic can be assigned to a maximum of one category. Assign the fixtures and fittings 

characteristics of this category to each characteristic category. Define the characteristic group if 

necessary. If you select Superimpose then this characteristic is superimposed when creating an 

object and only needs to be selected as Applicable. You can only assign characteristics for which the 

Use Only if Relevant to Representative List of Rents indicator is not set. 
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 Infrastructure Characteristics 

 Define Infrastructure Characteristics 

Use 

When processing master data, you can specify how far the real estate object is from given geographical 

points. You define these points using infrastructure characteristics. 

Activities 

Here you specify the infrastructure characteristics for which entries related to distance are possible. 

You can also specify the unit of distance and the time (with the basis for the time measurement) that is 

preferred for entries related to distance. These specifications are optional. The system then proposes this 

unit as a default value. 

Example 

You can enter the following infrastructure characteristics for the real estate search: 

- Kindergarten 

- Elementary school 

- Supermarket 

- Train station 

- Airport 

- Bus stop 

- Recreation area/park 

You can enter the following infrastructure characteristics for Land Use Management: 

- Road/street 

- High-tension tower 

 Specify Basis for Measuring Distance as Time 

Use 



 

 

When processing master data, you can enter the distance to given  infrastructure characteristics. 

You can specify the distance either in the form of a measurement of distance (such as, miles) or as a time. 

If you choose infrastructure characteristics for which the time entry could be based on different 

assumptions (such as different modes of transportation), then you should specify the basis for the time 

entry here. 

Requirements 

You defined infrastructure characteristics infrastructure characteristics. 

Example 

In your infrastructure characteristics, you defined the distance to the elementary school as a time in 

minutes. In that case, you should distinguish between "Minutes on foot" and "Minutes by bus." 

 Default Survey Office/Responsible Agency 

 Define Search Strategy for Main Contractual Partner for Parcel 

Use 

You can use a search strategy so that the system proposes an appropriate main contractual partner 

(usually a survey office or other responsible agency) for a given parcel. Search strategies use 

search methods, which specify how the main contractual partner is determined from the object 

data. 

In order for the system to be able to determine a default value or possible search help value for the main 

contractual partner of the parcel, exactly one search strategy must be active for the PARCOFF search 

field. 

Activities 

Define the search strategies for the PARCOFF search field as follows. Set the Active? indicator for the 

search strategy you want the system to use. (The other search strategies can then be deleted. It only makes 

sense during the test phase to define one strategy for each search method you are testing.) 

Enter a name for the search strategy. 

Specify how the search takes place: 

- Name 

Text of search strategy (informational only) 
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- Search Method 

This is a method that is predefined in the system. The method describes how the search is 

performed. The way the system processes the values for the search strategy depends on the method 

you select here. Choose a method using the input help. 

- Active? 

You can only use search strategies. For example, if you copied the search strategies from standard 

Customizing, then set the Active? indicator for those that you want to actually use in your system. 

- Other Values 

Set this indicator, if you also want the standard search help to be available. The system then displays 

a Further Values row, in addition to the values returned by the search strategy.  From there you can 

navigate to the standard search help. 

The following search methods for the main contractual partner of the parcel are predefined in 

the system: 

ADDR     Main contractual partner from postal code 

PARTNR     Survey office from partner number 

VALREG     Survey office based on hierarchical location 

The ADDR and PARTNR methods assume that the partner numbers are assigned so that their meaning is 

clearly apparent. The systematic way of doing this is described in the Define Search Method IMG 

activity. You can use your own customer-specific numbering system as a reference for the 

implementation. 

For the VALREG method, you have to enter the possible values for each region in the  value table. The 

region in this case is the hierarchical location of the parcel according to the leading hierarchical location 

structure. In the Differentiation Characteristic column, enter the hierarchical location. You can use the 

asterisk (*) and plus sign (+) as wildcard characters. Enter the partner number of the responsible agency 

in the Value column. 

To be able to use these methods delivered with the system, you have to copy the sample code of the 

implementing class CL_EXM_IM_RECA_SEARCH_METHOD of the enhancement spot 

BADI_RE_CA_SH to a customer class. Then you have to activate this customer implementation. 

 Specify Partners Possible for Search Strategy 

Use 

You enter the possible values here for a search strategy that was already defined. For search strategies 

with the VALREG (main contractual partner from hierarchical location) method, enter the hierarchical 



 

 

location in the Differentiation Criterion column, and enter the partner number in the Field Contents 

column. 

If your active search strategy uses a method that does not require entering values, then you do not have to 

have to enter values here. 

Activities 

For each search strategy, enter the search values that are needed based on the search method: 

Where you enter these values is dependent on the search method used by the search strategy. For search 

methods where the values for the strategy are simply entered, you enter the values directly in the 

Differentiation Criterion field. In that case, you can specify only one value for each search strategy as a 

default value. 

For search methods that recognize a differentiation criterion (such as, the location of the current object), 

you have to enter the possible values for each differentiation criterion in the Field Contents field. 

You can use wildcard characters here: An asterisk (*) replaces any number of characters, while a plus 

sign (+) replaces exactly one character. If more than one value is possible for a differentiation criterion, 

then enter a number to distinguish the values in the Seq. Number (sequence number) field.  You are only 

allowed to designate one value as the default value for each combination of search strategy and 

differentiation criteria. 

To help you select possible values more easily, you can choose Propose Values. Position the cursor on the 

search strategy, for which you want to propose values (or, if there is no entry yet for search strategy, on 

the search field). Then choose Propose Values.  The system displays a search help appropriate for the 

search strategy. You can select the values there that you need for this search strategy. 

Note on transport: 

Since you enter partner numbers in the table, transporting to another system only makes sense if the 

partner numbers are the same in both systems! 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 
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 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data 

Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 



 

 

The system displays all field groups that know the given application. In order to display the fields of 

a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, 

and display fields in display mode.) If it is not possible to make a setting for a field group, then the 

system determines how the field is treated (usually dependent on the situation, or on the contents of 

other fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of 

the view accordingly (consider the detail screen). Then assign the field groups to the view. You can 

assign your own field groups, as well as those delivered by SAP. 

 Sections 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 467 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it 

is surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you 

want to this section. The item number specifies the sequence in which the views are arranged in the 

section. For technical reasons, if you make your own assignments from sections to views, the item 

numbers have to be in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 



 

 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 
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SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of parcels. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications 

Notes for Developers 

 Conversion Exits for Parcel Number 

Use 

The Business Add-In supports enhancements to the standard functions of  parcel numbers. For an 

overview of the possible enhancement methods, see this text. 

Activities 



 

 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

The following methods exist: 

- NUMBER_INPUT - Conversion of the parcel number at the time of entry. The method is 

called when a parcel number is entered on the screen. 

- NUMBER_OUTPUT - Conversion of the parcel number at the time of output. The 

method is called when a parcel number is output on the screen. 

The implementation of the methods has to be independent of the interface. It is not allowed to contain any 

COMMIT WORK or ROLLBACK WORK statements. 

For example, direct output of messages using the MESSAGE statement, without using the existing 

exceptions, is not allowed. 

Method description 

- NUMBER_INPUT 

For conversion at the time of input (from the screen to the internal display) 

- NUMBER_OUTPUT 

For conversion at the time of output (from the internal display to the screen) 

Example 

For a sample implementation that shows the conversion of parcel numbers as in the LUM add-on, 

see the class CL_EXM_IM_RELM_NUMBER_PLNO. Notes for Developers 

 Define Custom Search Methods for Search Strategies 

Use 

Here you define your own custom search methods. You can then process the corresponding 

implementations for them using a BAdI. For more information, see Implement/Activate Search Methods 

for Search Strategies. 

Standard settings 

Some methods are predefined in the system. However, they only deliver the expected results when the 

sample code of the BAdI is activated. 

Activities 
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If the predefined search methods are not sufficient to meet your needs, you can define your own methods. 

Choose names for your methods that begin with the letter Y or Z. 

You can assign one method to several search fields. However, doing so makes sense only if the search 

fields point to the same domain (for example, the land registry and the agency responsible for the parcel, 

since both are business partners). 

In addition, specify the following for the search method: 

- A descriptive name 

- The search help for the differentiation criterion (when entering allowed values) 

- The type of the method 

Then implement the BAdI for the search method. 

 Implement/Activate Search Methods for Search Strategies 

Use 

This BAdI can be used to define your own search methods for a search strategy. Search methods are each 

assigned to a search strategy. The BAdI method that is used depends on the type of search method that is 

entered for the method in table TIVCASHMETH. The following applies: 

Type SPACE - Single Value Method, Values Are in VICASHFVALUES-SHMETHDIFF  

There is no BAdI call, the values for the search strategy are entered directly in table 

VICASHFVALUES. 

Type  - Search Strategy + Possibly Object Data => (Program) Values The BAdI determines the 

possible values solely from the name of the of search strategy and possibly from the object data. 

BAdI method to be implemented: GET_VALUES  

Type   Search Strategy =>SMETHDIFF => (Program) Values 

First a differentiation criterion is determined for the search strategy from the value table 

VICASHFVALUES. The BAdI then determines the possible values from this differentiation 

criterion, possibly dependent on the object data and the name of the search strategy. BAdI method 

to be implemented:  GET_VALUES_FOR_SHMETHDIFF  

Type   Object Data => (Program) SMETHDIFF => (VICASHFVALUES) Values 

The BAdI determines a differentiation criterion from the object data and possibly from the name of the 

search strategy. The values for this differentiation criterion are then read from table 

VICASHFVALUES. 

BAdI method to be implemented: GET_SHMETHDIFF   Search 

strategies are used in the following contexts: 



 

 

- One-Time Postings: 

Vendor search field (VENDOR) and service charge key ( SCSCKEY ) 

The search strategy is determined from the Customizing settings for the posting activity (VENDOR) 

or for a specific item of the posting activity (SCSCKEY). An object reference is not transferred. 

- Master Data of Parcel: 

Search fields for main contractual partner (PARCOFF) and for all hierarchical locations 

(LOCHIER). The object reference of the parcel is transferred. 

For the LOCHIER search field, the location structure of the hierarchical location you are searching 

for is also in the ID_CONTEXT field. 

- Master Data of Land Register: 

Search fields for land registry (LROFFICE) and for the hierarchical location ( LOCHIER ). The 

object reference of the land register is transferred. 

For the LOCHIER search field, the location structure of the hierarchical location you are searching 

for is also in the ID_CONTEXT field. 

The following applies to the search fields for the land register and parcel: 

For each search field, only one search strategy is allowed to be designated as active. 

Activities 

Depending on the type of search method, implement one of the  methods: 

- GET_VALUES 

- GET_VALUES_FOR_SHMETHDIFF       

- GET_SHMETHDIFF     

Description of parameters: 

Method GET_VALUES and GET_SHMETHDIFF: 

FLT_VAL 

Search method 

IO_REF_OBJ   

Reference to the real estate object that is currently being processed. The reference is empty when the call 

is from posting activities. For the land register, the reference contains a reference to the land register 

master data; and for parcels, a reference to the parcel master data. 

The BAdI method can retrieve the current object data using the API that belongs to it. 
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ID_CONTEXT   

For the LOCHIER search field, contains the location key of the hierarchical location being searched for; 

otherwise it is empty. 

IS_SHSTRAT   

Contains certain Customizing data for the active search strategy 

IS_SHFIELD   

Contains the system Customizing data for the current search field 

CT_VALUES  

The result of the search is to be placed in this table. The KEY field has to be filled with the determined 

key of the search field. The text for it does not have to be entered. For methods of type , the value of the 

search field is not entered. Instead the differentiation criterion, which should be used to search in 

VICASHFVALUES, should be filled. In this case, wildcard characters ('%') are allowed for a search for 

similar values. 

CD_DEFAULT_VALUE 

If a default value was determined, it can be returned here. The default value is set when the value of the 

field, for which the search help was called, was initial at the time of the call. 

CF_OTHER_VALUES_ALLOWED 

This value should be returned as TRUE, if you want to have an option to choose "Other Values" in the 

search dialog box, in addition to the search result. If the user chooses this option, then the system calls the 

standard search help. The value does not influence whether the system checks the result of the search help 

(normally there is no check). 

Method GET_VALUES_FOR_SHMETHDIFF 

In addition to the parameters of GET_VALUES, the values that are maintained in the value table for the 

search strategy are also transferred to table IT_SHVALUES. 

Example 

Example class CL_EXM_IM_RECA_SEARCH_METHOD contains examples for the following 

search methods: 

Type  - Search Strategy + Possibly Object Data => (Program) Values 

GET_VALUES for LOCHIER search method 

The hierarchical location of the parcel is derived from hierarchical locations to other location structures 

that are already entered in the system. A value is allowed here if the same text is entered for this location 

in Customizing. 

GET_VALUES for PARTNR search method 

The prerequisite here is that there is external number assignment for land registries ( land register) and 

for the main contractual partner (survey office or responsible agency) of the parcel. 

The partner number of the land register corresponds to the land register district; the number of the 

survey office corresponds to the first  characters of the leading hierarchical location. This method might 



 

 

need to be adjusted to agree with the practices of your company regarding partner numbers. For 

example, it is possible that the partners could all have a prefix in the number, such as LR for land 

registry. 

GET_VALUES for ADDR search method 

The assumption here is that the postal code of the land registry corresponds to the land register district. 

All land registries, where postal code = land registry, are offered for selection. For the parcel, the system 

searches for a partner with the "Responsible Agency" role, where the city agrees with the text of the 

hierarchical location of the parcel. 

Type   Search Strategy =>SMETHDIFF => (Program) Values         

GET_VALUES_FOR_SHMETHDIFF for ROLE search method 

This search method is appropriate for the VENDOR search field. The search method returns all vendor 

numbers of partners for the role that are maintained in the value table for the search strategy. 

For example, if you create your own role for insurance, you can assign a search strategy with this search 

method to a posting activity for "insurance costs". 

Type  - Object Data => (Program) SMETHDIFF => (VICASHFVALUES) Values 

GET_SHMETHDIFF for VALREG search method 

You can use this search method when the land registries for the land register district are entered in the 

value table. The search method determines the land register district for the current land register, or for the 

first  characters of the hierarchical location of the current parcel. 

Notes for Developers 

 Parcel Update 

 Define Parcel Update Types 

Use 

You can only define parcel update types for the Official Record of Change parcel update category (see  

parcel update).  The parcel update type specifies the purpose of the change made in the real estate 

cadaster that is documented in the official record of change. 

You can enter parcel update types in the master data of the official record of changed on the 

Change in Holdings tab page. 

Activities 

Enter all purposes that lead to changes of parcels and which are documented using an official record of 

change. 
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Example 

- Entry of a parcel 

- Parcel split due to surveying results 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data 

Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 



 

 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields of 

a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, 

and display fields in display mode.) If it is not possible to make a setting for a field group, then the 

system determines how the field is treated (usually dependent on the situation, or on the contents of 

other fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 
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Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of 

the view accordingly (consider the detail screen). Then assign the field groups to the view. You can 

assign your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it 

is surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you 

want to this section. The item number specifies the sequence in which the views are arranged in the 

section. For technical reasons, if you make your own assignments from sections to views, the item 

numbers have to be in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 



 

 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 
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You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of parcel updates. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 



 

 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications 

Notes for Developers 

 Land Register 

 Define Land Register Types 

Use 

Here you define land register types for the  land register. 

In addition to the "normal" land register, there are other registers, such as: 

- Apartments register 

- Partial ownership land register 

Using the land register type, you specify which data can be entered in the land register. 

For the purposes of reporting, you can assign the land register types to internal land register types, either 

Ownership or Land Lease. 

For more information on the land register, see  Information on the Land Register. 

Activities 

Enter a key for the land register type and a long and short name for it. 

Assign the land register type to an internal land register type. 
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 Define Land Register Districts 

Use 

Separate land registers are maintained by each land registry for each given land register district. One land 

registry can be responsible for several land register districts. 

Activities 

Enter the number of the land register district that is entered on the page of the land register, and the name 

of the land register district. 

If you have a large real estate portfolio, you can also enter the state and region. 

 Define Encumbrance Types 

Use 

Encumbrance types are used in the land register in section II or III. 

Here you define the encumbrance types you need, and specify how they are used. 

Activities 

Specify the following for each encumbrance type: 

- Use in real estate register? 

- Use in section II? 

- Use in section III? 

- Has dominant tenements? 

- Has servient tenement? 

- Has holder? 

- Has obligated party? 

- Has contracts? 



 

 

Depending on how this indicator is set, the corresponding tab pages in master data processing for the land 

register are either hidden or displayed. 

 Default Land Registry 

 Define Search Strategy for Land Registry 

Use 

You can use a search strategy so that the system proposes an appropriate main contractual partner 

(usually a land registry) for a given land register page. 

Search strategies use search methods, which specify how the main contractual partner is determined from 

the object data. 

In order for the system to be able to determine a default value or possible search help values for the main 

contractual partner of the land register page, exactly one search strategy must be active for the 

LROFFICE search field (for the land register). 

Activities 

Define the search strategies for the LROFFICE search field as follows. Set the active indicator for the 

search strategy you want the system to use. (The other search strategies can then be deleted. It only makes 

sense during the test phase to define one strategy for each search method you are testing.) 

Enter a name for the search strategy. 

Specify how the search takes place: 

- Name 

Text of search strategy (informational only) 

- Search Method 

This is a method that is predefined in the system. The method describes how the search is 

performed. The way the system processes the values for the search strategy depends on the method 

you select here. Choose a method using the input help. 

- Active? 

You can only use search strategies. For example, if you copied the search strategies from standard 

Customizing, then set the Active? indicator for those that you want to actually use in your system. 

- Other Values 

Set this indicator, if you also want the standard search help to be available. The system then displays 

a Further Values row, in addition to the values returned by the search strategy.  From there you can 

navigate to the standard search help. 
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The following search methods for the main contractual partner for the land register are predefined in the 

system: 

ADDRNR     Land register from address 

PARTNR     Land register from partner number 

VALREG     Land register from district     

The ADDR and PARTNER methods assume that the partner numbers are assigned so that their meaning 

is clear. The system for doing this is described in the "Define Search Method" section. You can use a 

customer-specific numbering system as an example for the implementation. 

For the VALREG method, you have to enter the possible values for each land register district in the value 

table. In the differentiation criterion column, enter the land register district. You can use the asterisk (*) 

and plus sign (+) as wildcard characters. Enter the partner number of the land registry in the Value 

column. You can designate one land registry in each district as a default value. 

To be able to use these methods delivered with the system, you have to copy the sample code of the 

implementing class CL_EXM_IM_RECA_SEARCH_METHOD of the enhancement spot 

BADI_RE_CA_SH to a customer class. Then you have to activate this customer implementation. 

 Define Partner Numbers Possible for Search Strategy 

Use 

You enter the possible values here for a search strategy that was already defined. For search strategies 

with the VALREG (land register from district) method, enter the land register district in the 

Differentiation Criterion column, and enter the partner number of the land registry in the Field Contents 

column. 

If your active search strategy uses a method that does not require entering values, then you do not have to 

have to enter values here. 

Activities 

For each search strategy, enter the search values that are needed based on the search method: 

Where you enter these values is dependent on the search method used by the search strategy. For search 

methods where the values for the strategy are simply entered, you enter the values directly in the 

Differentiation Criterion field. In that case, you can specify only one value for each search strategy as a 

default value. 



 

 

For search methods that recognize a differentiation criterion (such as, the location of the current object), 

you have to enter the possible values for each differentiation criterion in the Field Contents field. 

You can use wildcard characters here: An asterisk (*) replaces any number of characters, while a plus 

sign (+) replaces exactly one character. If more than one value is possible for a differentiation criterion, 

then enter a number to distinguish the values in the Seq. Number (sequence number) field.  You are only 

allowed to designate one value as the default value for each combination of search strategy and 

differentiation criteria. 

To help you select possible values more easily, you can choose Propose Values. Position the cursor on the 

search strategy, for which you want to propose values (or, if there is no entry yet for search strategy, on 

the search field). Then choose Propose Values.  The system displays a search help appropriate for the 

search strategy. You can select the values there that you need for this search strategy. 

Note on transport: 

Since you enter partner numbers in the table, transporting to another system only makes sense 

if the partner numbers are the same in both systems! 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 
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These are the specifications for how the fields are grouped into field groups for the Business Data 

Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields of 

a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, 

and display fields in display mode.) If it is not possible to make a setting for a field group, then the 

system determines how the field is treated (usually dependent on the situation, or on the contents of 

other fields). 



 

 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of 

the view accordingly (consider the detail screen). Then assign the field groups to the view. You can 

assign your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it 

is surrounded by a frame. Fields that logically belong together should be grouped together in sections. 
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Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you 

want to this section. The item number specifies the sequence in which the views are arranged in the 

section. For technical reasons, if you make your own assignments from sections to views, the item 

numbers have to be in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 



 

 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 
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 Implement Enhancements ( BAdI ) 

 Validation, Substitution 
Use 

The Business Add-In supports enhancements to the standard functions of land registers. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 Conversion Exits for the Page Number of Land Register 

Use 

The Business Add-In supports enhancements to the standard functions of land register page numbers. 

For an overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

The following methods exist: 



 

 

- NUMBER_INPUT - Conversion of the land register page number at the time of entry. The method 

is called when a land register page number is entered on the screen. 

- NUMBER_OUTPUT - Conversion of the land register page number at the time of output 

. 

The method is called when a land register page number is output on the screen. 

The implementation of the methods has to be independent of the interface. It is not allowed to contain any 

COMMIT WORK or ROLLBACK WORK statements. 

For example, direct output of messages using the MESSAGE statement, without using the existing 

exceptions, is not allowed. 

Method description 

- NUMBER_INPUT 

For conversion at the time of input (from the screen to the internal display) 

- NUMBER_OUTPUT 

For conversion at the time of output (from the internal display to the screen) 

Example 

For a sample implementation that shows the conversion of land register page numbers as in the LUM 

add-on, see the class CL_EXM_IM_RELM_NUMBER_LRPAGENO. Notes for Developers 

 Conversion Exits for Numbers in the Real Estate Register 

Use 

The Business Add-In supports enhancements to the standard functions of real estate register numbers. 

For an overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

The following methods exist: 

- NUMBER_INPUT - Conversion of the real estate register number at the time of entry. The method 

is called when a real estate register number is entered on the screen. 

- NUMBER_OUTPUT - Conversion of the real estate register number at the time of output. The 

method is called when a real estate register number is output on the screen. 
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The implementation of the methods has to be independent of the interface. It is not allowed to contain any 

COMMIT WORK or ROLLBACK WORK statements. 

For example, direct output of messages using the MESSAGE statement, without using the existing 

exceptions, is not allowed. 

Method description 

- NUMBER_INPUT 

For conversion at the time of input (from the screen to the internal display) 

- NUMBER_OUTPUT 

For conversion at the time of output (from the internal display to the screen) 

Example 

For a sample implementation that shows the conversion of real estate register numbers as in the LUM 

add-on, see the class CL_EXM_IM_RELM_NUMBER_LRREGNO. Notes for Developers 

 Conversion Exits for Numbers in Sections II and III 

Use 

The Business Add-In supports enhancements to the standard functions of section numbers in sections II 

and III. 

For an overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

The following methods exist: 

- NUMBER_INPUT - Conversion of the section number at the time of entry. The 

method is called when a section number is entered on the screen. 

- NUMBER_OUTPUT - Conversion of the section number at the time of output (from 

the internal representation to the screen). 

The method is called when a section number is output on the screen. 

The implementation of the methods has to be independent of the interface. It is not allowed to contain any 

COMMIT WORK or ROLLBACK WORK statements. 



 

 

For example, direct output of messages using the MESSAGE statement, without using the existing 

exceptions, is not allowed. 

Example 

For a sample implementation that shows the conversion of section numbers as in the LUM add-on, 

see the class CL_EXM_IM_RELM_NUMBER_SECNO. Notes for Developers 

 Allow Manual Entry of Ranking Numbers for Sections II and 

III 

Use 

In the land register, the system automatically calculates the ranking numbers in Sections II and 

III. You can only influence the ranking number indirectly by means of the fields 'Rank Before Sequence 

Number in Section' or 'Add Rank to Current Section Number'. It is not possible for you to enter the 

ranking number directly. 

The BAdI BADI_RELM_LR_RANKINGNO makes it possible to enter the ranking number manually. To 

activate this BAdI, implement the method 

IS_RANKINGNO_FILLED_MANUALLY. The parameters of the method have the following meanings: 

- IO_OBJECT is an import parameter and contains an object reference to the land register. 

- CF_MANUALLY is a changing parameter. If it is set to ABAP_TRUE, then you can enter the 

ranking number directly. 

The example implementation in class CL_EXM_IM_RELM_LR_RANKINGNO shows how you can 

control the option for manually entering the ranking number dependent on the land register district. 

Notes for Developers 

 Define Custom Search Methods for Search Strategies 

Use 

Here you define your own custom search methods. You can then process the corresponding 

implementations for them using a BAdI. For more information, see Implement/Activate Search Methods 

for Search Strategies. 
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Standard settings 

Some methods are predefined in the system. However, they only deliver the expected results when the 

sample code of the BAdI is activated. 

Activities 

If the predefined search methods are not sufficient to meet your needs, you can define your own methods. 

Choose names for your methods that begin with the letter Y or Z. 

You can assign one method to several search fields. However, doing so makes sense only if the search 

fields point to the same domain (for example, the land registry and the agency responsible for the parcel, 

since both are business partners). 

In addition, specify the following for the search method: 

- A descriptive name 

- The search help for the differentiation criterion (when entering allowed values) 

- The type of the method 

Then implement the BAdI for the search method. 

 Implement/Activate Search Methods for Search Strategies 

Use 

This BAdI can be used to define your own search methods for a search strategy. Search methods are each 

assigned to a search strategy. The BAdI method that is used depends on the type of search method that is 

entered for the method in table TIVCASHMETH. The following applies: 

Type SPACE - Single Value Method, Values Are in VICASHFVALUES-SHMETHDIFF  

There is no BAdI call, the values for the search strategy are entered directly in table 

VICASHFVALUES. 

Type  - Search Strategy + Possibly Object Data => (Program) Values The BAdI determines the 

possible values solely from the name of the of search strategy and possibly from the object data. 

BAdI method to be implemented: GET_VALUES  

Type   Search Strategy =>SMETHDIFF => (Program) Values 

First a differentiation criterion is determined for the search strategy from the value table 

VICASHFVALUES. The BAdI then determines the possible values from this differentiation criterion, 

possibly dependent on the object data and the name of the search strategy. 

BAdI method to be implemented:  GET_VALUES_FOR_SHMETHDIFF  



 

 

Type   Object Data => (Program) SMETHDIFF => (VICASHFVALUES) Values 

The BAdI determines a differentiation criterion from the object data and possibly from the name of the 

search strategy. The values for this differentiation criterion are then read from table 

VICASHFVALUES. 

BAdI method to be implemented: GET_SHMETHDIFF   Search 

strategies are used in the following contexts: 

- One-Time Postings: 

Vendor search field (VENDOR) and service charge key ( SCSCKEY ) 

The search strategy is determined from the Customizing settings for the posting activity (VENDOR) 

or for a specific item of the posting activity (SCSCKEY). An object reference is not transferred. 

- Master Data of Parcel: 

Search fields for main contractual partner (PARCOFF) and for all hierarchical locations 

(LOCHIER). The object reference of the parcel is transferred. 

For the LOCHIER search field, the location structure of the hierarchical location you are searching 

for is also in the ID_CONTEXT field. 

- Master Data of Land Register: 

Search fields for land registry (LROFFICE) and for the hierarchical location ( LOCHIER ). The 

object reference of the land register is transferred. 

For the LOCHIER search field, the location structure of the hierarchical location you are searching 

for is also in the ID_CONTEXT field. 

The following applies to the search fields for the land register and parcel: 

For each search field, only one search strategy is allowed to be designated as active. 

Activities 

Depending on the type of search method, implement one of the  methods: 

- GET_VALUES 

- GET_VALUES_FOR_SHMETHDIFF       

- GET_SHMETHDIFF     

Description of parameters: 

Method GET_VALUES and GET_SHMETHDIFF: 
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FLT_VAL 

Search method 

IO_REF_OBJ   

Reference to the real estate object that is currently being processed. The reference is empty when the call 

is from posting activities. For the land register, the reference contains a reference to the land register 

master data; and for parcels, a reference to the parcel master data. 

The BAdI method can retrieve the current object data using the API that belongs to it. 

ID_CONTEXT   

For the LOCHIER search field, contains the location key of the hierarchical location being searched for; 

otherwise it is empty. 

IS_SHSTRAT   

Contains certain Customizing data for the active search strategy 

IS_SHFIELD   

Contains the system Customizing data for the current search field 

CT_VALUES  

The result of the search is to be placed in this table. The KEY field has to be filled with the determined 

key of the search field. The text for it does not have to be entered. For methods of type , the value of the 

search field is not entered. Instead the differentiation criterion, which should be used to search in 

VICASHFVALUES, should be filled. In this case, wildcard characters ('%') are allowed for a search for 

similar values. 

CD_DEFAULT_VALUE 

If a default value was determined, it can be returned here. The default value is set when the value of the 

field, for which the search help was called, was initial at the time of the call. 

CF_OTHER_VALUES_ALLOWED 

This value should be returned as TRUE, if you want to have an option to choose "Other Values" in the 

search dialog box, in addition to the search result. If the user chooses this option, then the system calls the 

standard search help. The value does not influence whether the system checks the result of the search help 

(normally there is no check). 

Method GET_VALUES_FOR_SHMETHDIFF 

In addition to the parameters of GET_VALUES, the values that are maintained in the value table for the 

search strategy are also transferred to table IT_SHVALUES. 

Example 

Example class CL_EXM_IM_RECA_SEARCH_METHOD contains examples for the following 

search methods: 

Type  - Search Strategy + Possibly Object Data => (Program) Values 

GET_VALUES for LOCHIER search method 



 

 

The hierarchical location of the parcel is derived from hierarchical locations to other location structures 

that are already entered in the system. A value is allowed here if the same text is entered for this location 

in Customizing. 

GET_VALUES for PARTNR search method 

The prerequisite here is that there is external number assignment for land registries ( land register) and 

for the main contractual partner (survey office or responsible agency) of the parcel. 

The partner number of the land register corresponds to the land register district; the number of the 

survey office corresponds to the first  characters of the leading hierarchical location. This method might 

need to be adjusted to agree with the practices of your company regarding partner numbers. For 

example, it is possible that the partners could all have a prefix in the number, such as LR for land 

registry. 

GET_VALUES for ADDR search method 

The assumption here is that the postal code of the land registry corresponds to the land register district. 

All land registries, where postal code = land registry, are offered for selection. For the parcel, the system 

searches for a partner with the "Responsible Agency" role, where the city agrees with the text of the 

hierarchical location of the parcel. 

Type   Search Strategy =>SMETHDIFF => (Program) Values         

GET_VALUES_FOR_SHMETHDIFF for ROLE search method 

This search method is appropriate for the VENDOR search field. The search method returns all vendor 

numbers of partners for the role that are maintained in the value table for the search strategy. 

For example, if you create your own role for insurance, you can assign a search strategy with this search 

method to a posting activity for "insurance costs". 

Type  - Object Data => (Program) SMETHDIFF => (VICASHFVALUES) Values 

GET_SHMETHDIFF for VALREG search method 

You can use this search method when the land registries for the land register district are entered in the 

value table. The search method determines the land register district for the current land register, or for the 

first  characters of the hierarchical location of the current parcel. 

Notes for Developers 

 Other Public Registers 

 Contamination/Non-Hazardous Waste 

 Specify Number Range for Contamination/Non-Hazardous Waste 

Use 

Here you specify how numbers are assigned for contamination and non-hazardous waste. Note that the 

system only takes the setting for interval "" into account. 

For external number assignment, you can specify the number range that is available when you create 

master data for contamination or non-hazardous waste. 
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For internal number assignment, the system assigns numbers ascending sequentially, starting from the 

number shown in the  Current number field. 

 Define Types of Contamination/Non-Hazardous Waste 

Use 

In this activity, you define various types of site contamination or non-hazardous waste that might be 

found on a parcel of land. You assign these to one of the two categories, either Contamination or Non-

Hazardous Waste. 

There are two types of waste that can affect parcels and the buildings on them: 

- Contamination: 

This is when the waste on the site is such that it cannot be removed by ordinary measures. The 

contamination presents a health hazard for users of the land and for the general public, so that use of 

the parcel is severely limited, or use may even be impossible. Contamination can stem from toxic 

materials (such as, oils, paints). The owner is obligated to remove the contamination, which is only 

possible by employing intensive cleanup measures. 

Contamination can only affect parcels. 

- Non-hazardous waste: 

This is waste on the parcel or the building on the parcel, such that the problem can be removed by 

ordinary measures. The use of the parcel is limited only slightly or not at all by non-hazardous 

waste. There is no obligation to remove the non-hazardous waste. Non-hazardous waste can affect a 

parcel, a building, or a rental object. 

Activities 

Choose one of these two categories for each type of contamination or non-hazardous waste. 



 

 

 Site Protection 

 Define Number Range for Site Protection 

Use 

Here you specify how numbers are assigned for site protection. Note that the system only takes the setting 

for interval "" into account. 

For external number assignment, you can specify the number range that is available when you create 

master data for site protection. 

For internal number assignment, the system assigns numbers ascending sequentially, starting from the 

number shown in the  Current number field. 

 Define Types of Site Protection 

Use 

In this activity, you define the types of site protection. 

Site protection can fall into different categories, representing a limit on possible usages on the one hand, 

or a requirement to take certain action on the other. 

Example 

- Protection of natural areas 

- Water protection 

- Protection of historical sites 
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 Easement 

 Define Easement Types 

Use 

In this activity, you define types of easements. 

Easements are recorded in the  easement register that is maintained by the building authorities at the 

municipal level. The easements register, together with the land register, record essentially all easements, 

encumbrances and restrictions on a piece of land. 

Example 

- Easement where one parcel provides necessary area for another 

- Easement where one parcel provides necessary distance between buildings to another 

- Right of way 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data 

Toolset. 



 

 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields of 

a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, 

and display fields in display mode.) If it is not possible to make a setting for a field group, then the 

system determines how the field is treated (usually dependent on the situation, or on the contents of 

other fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 
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 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of 

the view accordingly (consider the detail screen). Then assign the field groups to the view. You can 

assign your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it 

is surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you 

want to this section. The item number specifies the sequence in which the views are arranged in the 

section. For technical reasons, if you make your own assignments from sections to views, the item 

numbers have to be in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 



 

 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. 

The position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 
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for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Validation, Substitution 

Use 

Das Business Add-In unterstützt die modifikationsfreie Erweiterung der Standardfunktionalität von 

Weiteren Grundstücksverzeichnissen. 

Einen Überblick über die möglichen Erweiterungstechniken finden Sie hier. 

Activities 



 

 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more 

detail in Enhance BDT Applications Hinweise 

für Entwickler 

 Notice of Assessment 

 Define Land Types for Mill Rate 

Use 

In this activity, you define the land types that the community uses to calculate its mill rates. 

Then in the  next activity you define the land types that are used in the  notice of assessment You assign a 

land type for the mill rate, which you defined here, to each of those land types. This assignment is the 

basis for the calculation of property tax in the application for the municipal fee notice. 

Example 

- Land for construction - full mill rate 

- Fallow land - half of mill rate 

See also 

For more information, see  Information on the Notice of Assessment 
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 Define Land Types in Notice of Assessment 

Use 

In this activity, you enter the land types that are used in the  notice of assessment. 

You assign a land type for the mill rate to each land type. This assignment is the basis for the calculation 

of property tax in the application for the municipal fee notice. 

Requirements 

You defined the  land type for the mill rate. 

See also 

For more information, see  Information on the Notice of Assessment. 

 Define Determination Types 

Use 

In this activity, you enter the determination types that are used in the  notice of assessment This 

assignment is the basis for the calculation of property tax in the application for the municipal fee notice. 

See also 

For more information, see  Information on the Notice of Assessment 

 Define Possible Types of Possession 

Use 

In this activity, you enter the types of possession that are used in the  notice of assessment. This 

assignment is the basis for the calculation of property tax in the application for the municipal fee notice. 



 

 

Example 

- Person in possession 

- Owner 

- Person holding land lease 

See also 

For more information, see  Information on the Notice of Assessment. 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data 

Toolset. 

Standard settings 

Do not change the standard settings. 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 507 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields of 

a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, 

and display fields in display mode.) If it is not possible to make a setting for a field group, then the 

system determines how the field is treated (usually dependent on the situation, or on the contents of 

other fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 



 

 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of 

the view accordingly (consider the detail screen). Then assign the field groups to the view. You can 

assign your own field groups, as well as those delivered by SAP. 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it 

is surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you 

want to this section. The item number specifies the sequence in which the views are arranged in the 

section. For technical reasons, if you make your own assignments from sections to views, the item 

numbers have to be in the customer namespace (that is, they are not allowed to end in ''). 
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This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 



 

 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Validation, Substitution 
Use 
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The Business Add-In supports enhancements to the standard functions of  notices of assessment. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 Alternative Currency 

Use 

This BAdI makes it possible to display the annual values in a second currency. 

Example 

The example implementation in the class CL_EXM_IM_RELM_NOT_ASS_CURR assumes that the 

values were entered in DEM and sees to it that they are also displayed in EUR. The conversion in the 

example implementation takes place using the procedure for notices of assessment. 

Notes for Developers 



 

 

 Joint Liability 

 Dialog 

 Change Screen Layout 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data 

Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 
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 Field Status 

Use 

Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields of 

a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, 

and display fields in display mode.) If it is not possible to make a setting for a field group, then the 

system determines how the field is treated (usually dependent on the situation, or on the contents of 

other fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of 

the view accordingly (consider the detail screen). Then assign the field groups to the view. You can 

assign your own field groups, as well as those delivered by SAP. 



 

 

 Sections 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it 

is surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you 

want to this section. The item number specifies the sequence in which the views are arranged in the 

section. For technical reasons, if you make your own assignments from sections to views, the item 

numbers have to be in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 

SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 
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Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 



 

 

 Tables 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Implement Enhancements ( BAdI ) 

 Validation, Substitution 
Use 

The Business Add-In supports enhancements to the standard functions of joint liabilites. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 
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 Input Tax Correction 

 Master Data 

 Specify Number Range for Correction Object 

Use 

Here you specify for each company code how number assignment is handled for the correction 
object. 

o If you want the system to assign the number automatically, choose internal number 

assignment. For internal number assignment, the system assigns numbers ascending 

sequentially, starting from the number shown in the Current number field. 

o Choose external number assignment, if you want to be able to assign the number or 

alphanumeric ID yourself. For external number assignment, you can specify the number 
range that is available to be assigned when you create the correction object. 

Activities 

For information on how to proceed, see Notes on General Number Assignment. 

You then assign the numbers of the number range intervals defined here to the type of 
correction object. 

 Relevant Objects for Input Tax Distrib. and Correction, Default 

DOS 

Use 

Here you specify the following, dependent on the company code: 

- Whether an input tax distribution is to be performed 

- The objects for which the distribution is to be performed 

- Whether an input tax correction is to be performed 

Note that you can only perform an input tax correction for objects for which a distribution can also be 

performed. 

You also specify whether and how the date of service is to be derived during document entry. 

Activities 



 

 

On the detail screen, in the Uniqueness of Object Assignment area, you specify whether multiple 

assignment is allowed for the given object type. With multiple assignment, the input tax distribution may 

not be able to uniquely determine the object that supplies the option rate. In that case, the user has to 

explicitly specify the real estate object that supplies the option rate during master data processing. 

Normally it is therefore better not to allow multiple assignment. 

In the Input Tax Distribution/Correction area, you specify whether and how an input tax distribution is to 

be performed: 

- First specify whether the company code opts to pay input tax. If this indicator is set, then, 

when a document is posted for one of these objects, the system updates the input tax and 

the input tax can then be distributed. This affects the following real estate objects: - 

Business entity 

- Building 

- Land 

- Rental object 

- Settlement unit 

- Real estate contract 

For company codes that do not opt to pay input tax, the contents of the other fields do not have 

any significance. 

- Specify the object types for which you want input tax distribution to be performed. If the 

company code opts, you should select all object types here that are related to real estate. 

For internal orders, you can distinguish between maintenance orders and other internal 

orders. 

- Using the message type, you can specify whether there always has to be a relationship 

between the object type and the real estate object, or whether the assignment ( and 

thereby the input tax distribution) is optional. For more information, see the message 

type. 

- Specify how the default value for the date of service is to be determined. You can decide 

whether the default date of service is taken from the document date, posting date, or the 

field ABPER (may be filled through validation). 

 Define Asset Classes as Relevant for Input Tax Correction 

Use 

Here you specify the asset classes, for which you want input tax correction to be performed. 
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Activities 

If you want to run input tax correction for asset classes that are not yet listed here, then choose New 

Entries and enter these asset classes here. 

Input tax correction cannot take into account any postings that were made to assets in these asset classes 

before you entered the asset class here. 

 Define Type of Correction Object 

Use 

Here you define the type of correction object. If you plan to use input tax correction, you have to make 

entries for at least one type of correction object in this table. 

The type of the correction object controls the following: 

- The length of the correction period ( proposal ) 

- If the correction is (necessarily) a one-time correction 

- The number range used for the number of the correction object 

- The account determination for correction postings 

Standard settings 

In standard Customizing, a distinction is made between Standard and One-Time Corrections. If you 

want to post input tax corrections differently for fixed assets and current assets, for example, then you 

should make two different entries here with different flow types. 

Activities 

- In the first two columns, enter the key for the type of correction objects and an easily-understood 

name. When creating a correction object, the user has to select the type of correction object. After 

that, you can no longer change it. 

- Length of the correction period in months (default value): 

The system determines the default end date of the correction period from the correction period length 

defined in Customizing. The system calculates this date from the start of the correction period to be 

specified by the processor or, if this is not specified, from the date of first usage. You can overwrite the 

Correction To Date for the correction in the application. If corrections were already made, then the 

system corrects them accordingly during the next run. 

- One-Time Correction indicator 



 

 

Set this indicator, if you want correction objects of this type to be used only for one-time 

corrections. For correction objects of this type, the Correction-To Date field is not ready for input. 

- Number of the number range interval 

Specify the number range interval from which the number of the correction object is assigned. You 

thereby also determine if number assignment is internal or external. You have to define the number 

range intervals first. 

- Flow Types 

Specify the flow types that should be used for determining the accounts for input tax correction. 

You can set up the flow types separately for the current year and previous years, and you can also 

separate them based on these criteria: 

- The correction results in higher input tax. 

- The correction results in lower input tax. 

You must have already defined flow types in the Define Flow Types IMG activity. In addition, you 

have to define the account determination for these flow types in the following IMG activities: 

- Define Account Symbols 

- Assign Account Symbol to Flow Type 

- Replace Account Symbols 

 Specify Allowed Object Types for Correction Object 

Use 

Here you specify which real estate objects and which objects from other components can be assigned to a 

correction object as account assignment objects. 

Activities 

- Choose New Entries. 

- In the Obj. Type column, enter J for correction object. 

- In the Asgn.Obj.Type column, enter one of the object types you want to allow as an account 

assignment, and set the ObjP (Object Assignment Permitted) indicator. 

- Follow the same procedure for all other object types you want to allow as account assignment 

objects. 
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Example 

Assume that in your system business entities, buildings, land, and assets are possible account assignments 

for correction objects. In that case, you enter the following: 

Object Type Asgn. Obj.Type 

J (Correction Object) AN ( Asset ) 

J (Correction Object) IB ( Building ) 

J (Correction Object) IG ( Land ) 

J (Correction Object) IW (Business Entity) 

For each row, set the Object Assignment Permitted indicator. 

 Distribution, Posting, and Correction 

 Define Criteria for Documents Relevant for Input Tax 

Correction 

Use 

Here you specify which items are considered by input tax correction. 

Based on current laws in Germany, taxpayers are required to correct input tax even for current assets and 

other services. This means that even costs that do not increase the value of the asset, such as maintenance 

costs, must be corrected. In cases where land is acquired only to be sold again immediately, you do not 

create a fixed asset account for the land. Instead the posting is made to current assets. In addition, the law 

affects comprehensive maintenance measures, like installing replacement windows in a building, even if 

the measure does not increase the value of the asset. 

On the other hand, you do not need input tax correction for costs that arise at short notice, such as the cost 

of repairs. 

The system is not able to determine on its own if a line item is relevant or not for input tax correction. 

This decision has to be made by the user who enters the document or who later determines the data for 

the input tax correction. 

In the document entry screen, you can set the document to Not relevant for correction. Or you can make 

this decision later, when assigning the correction object (in transaction REITTCASSIGN - Assign 

Original Documents). 

To improve clarity, the items designated as not relevant should not be displayed in transaction 

REITTCASSIGN. 

A line item is not relevant for input tax correction if one of the following is the case: 

- The Do not consider indicator was explicitly set for the item during document entry. 

- Settings were made in this IMG activity that do not apply to this line item. 

For example: If you always post costs for repairs using a certain document type or to a certain account, 

then you can remove this document type or account from selection in this table. Then it is not possible for 

the item to be proposed for input tax correction. 



 

 

If an item of this kind should nonetheless need to be considered in the input tax correction, you can set 

the Display non-relevant items indicator in transaction REITTCASSIGN, thereby assigning a correction 

object to the item. 

Activities 

In your enterprise, if the account and/or document type are criteria for determining which documents are 

relevant for input tax distribution (as opposed to those that are not relevant), then specify the following in 

this table: 

- If the specification is for an account or document type 

- A sequence number, so the entry is unique 

- Set the Inclusive/Exclusive indicator and the Option indicator as though you were searching on the 

selection screen of a report for these line items. 

Note: Multiple rows for the same field (Line Item Attr.) are linked with OR, whereas the 

prerequisites for different fields are linked using AND. 

- From and To Fields 

Enter a comparison value or the lower limit for an interval in the From field. If necessary, enter an 

upper limit for the interval in the To field (for the option BT Between or NB - Not Between). 

Example 

Keep in mind the following with regard to these examples: 

The basic prerequisite for input tax correction is that the line item is relevant for input tax distribution. 

That means, the item must have been posted to a real estate object, an asset, or a CO object that was 

defined in Customizing as relevant for input tax distribution. 

In addition, input tax distribution must be active for the company code. 

Example : 

Attr.   No.  I/E  Option   From         To 

ACC         I    BT                

ACC         I    EQ        

DOCT        I    CP       S*    

Result: In transaction REITTCASSIGN, the system proposes those line items for assignment to a 

correction object, where the items have account assignment to an account with account number  -  or , and 

have a document type beginning with 'S'. 

Example : 

Attr.   No.  I/E  Option   From         To 

ACC         I    NE        

DOCT        I    CP       S*    
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Result: In transaction REITTCASSIGN, the system proposes those line items for assignment to a 

correction object, where the items have a document type beginning with 'S' and were not posted to 

account . 

Example : 

Attr.   No.  I/E  Option   From         To 

ACC         I    NE             

Result: In transaction REITTCASSIGN, the system proposes those line items for assignment to a 

correction object, where the items were not posted to account . 

Example : 

Attr.   No.  I/E  Option   From         To 

DOCT        I    CP       S*    

Result: In transaction REITTCASSIGN, the system proposes those line items for assignment to a 

correction object, where the items have a document type beginning with 'S'. 

 Define Source Object for Option Rate Determination 

Use 

Here you specify which option rate should be used for input tax distribution - the option rate of the 

account assignment object, or the option rate of the correction object. 

Activities 

For each object type, for which the option rate of the correction object should be used, add a row and set 

the OptRate CorrObj. (option rate from correction object) indicator 

- Indicator is set ('X') 

The system uses the option rate of the assigned correction object for input tax distribution. 

For these object types, the system checks during the input tax distribution whether a correction 

object is assigned. If this is not the case, the input tax distribution is not performed and the system 

issues an error message, unless the line item is flagged as Not to Be Corrected. The option rate of 

the account assignment object itself is then used for the input tax distribution. 



 

 

- Indicator is not set (' ') 

The system uses the option rate defined on the account assignment object for input tax 

distribution. 

For these object types, the option rate of the account assignment object itself is used for input tax 

distribution. If documents that must be corrected are posted for these object types, the option rate of 

the assigned correction object is always used for input tax distribution. 

Object types that are not defined in this table behave like object types, for which the OptRate CorrObj. 

(option rate from correction object) indicator is not set. 

 Assign Tax Code for Correction Posting 

Use 

To be able to list correction postings separately in the advance tax return for sales and purchases using the 

ELSTER form generated by the system, you have to use your own tax codes for correction postings. 

Activities 

Here you assign tax codes for correction postings to tax codes for the original posting (tax code of the 

correction basis record). If there is no entry here for a tax code, then the system uses the original tax code 

for the correction posting. 

 Austria 

 Main Rent Statement 

 Basic Settings 

 Set Up Number Range for Schema Item for Cost Element 
Use 
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You need the number range for managing the Customizing entries for defining the calculation basis for 

schema items (see Set Up Settlement Schema). 

The system assigns a unique key for each entry. The system takes these keys from this number range 

interval. 

Activities 

Choose Change Intervals and create a number range interval with the number . Enter the range from  -  

for the interval. Do not select the External Number Assignment field. 

Note that a number assigned by the system (Current Number field) cannot be reset. 

 Set Up Settlement Schema 

Use 

In this section, you define the structuring and items of the  main rent statement, along with the calculation 

base. 

Requirements 

You set up the  number range for schema items for cost elements. 

Activities 

Follow these steps: 

. Create schema items 

- Enter the ID and description for the individual items of the main rent statement. 

- Enter the percentage of the calculated item that should be taken into account in the main rent 

statement. 

- Enter the  calculation method used for creating the settlement. You can choose from: 

- Standard calculation 

- Vacancy 

- Own use 



 

 

- Condominium owner use 

- Investment premium 

- Tax reimbursement 

- BAdI implementation 

2. Define settlement schema 

Here you can enter the different variants for structuring the main rent statement. You create a settlement 

schema for each structuring variant. 

3. Assign schema items to settlement schemas 

Assign those items that will be used for a given settlement to the individual schema. 

4. Define calculation rules for derived schema items 

Here you can define derived schema items, which are calculated using other items. For each item that you 

want to derive, assign the item or interval of items that are used in calculating this item. 

5. Define calculation basis for schema items 

For each schema item that is not derived, enter the cost elements or condition type that is used for the 

calculation. 

You have to assign cost elements if you chose the Standard Calculation calculation method for the 

schema item. The system determines the value from the costs or revenue posted for the cost elements in 

the settlement year. 

You have to assign a condition type for schema items that have these calculation methods: Vacancy, Own 

Use or Condominium Owner Use . The system determines the value using the calculation method. 

 Define Parameters for Vacancy Reason 

Use 

Here you define the relevant parameters for vacancy reasons for the main rent statement. 

For vacant objects, you are not allowed to apply imputed revenue in the main rent statement until after a 

certain amount of time has passed. 

Activities 

For each vacancy reason, enter the amount of time in months that you have to wait. 
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 Correspondence 

 Define List Variants 

Use 

In this activity, you define list variants for the output of correspondence for main rent statements. 

Activities 

- Define the list variant: 

1. Enter the ID and name of the list variant. 

2. Choose the form type and assign the forms you want to use. 

The form types you can choose from are Smart Forms and PDF-based forms. 

- Specify controls for list variant: 

. Enter additional control data for the list variant, such as the schema item and hierarchy level. 

 Implement Enhancements ( BAdI ) 

 Enhancements to Main Rent Statement 

Use 

The Business Add-In (BAdI) supports enhancements to the standard functions of the main rent statement 

without writing program code. 

Activities 

You can use the following methods for the implementation: 

- FILL_SELSCREEN: Selection screen that supplies transaction REXCMS (PAI). You can use it to 

provide default values for fields, for example. 

- BEFORE_CORRDOC_MODIFY: For checking or correcting data before changing an adjustment 

document 

- BEFORE_UPDATE_DB: Before saving the master data 



 

 

- AFTER_UPDATE_DB: After saving the master data For information on using BAdIs, see this 

documentation. 

 Enhancements to Fictitious Calculations 

Use 

Using this BAdI, you can calculate fictitious values for the main rent statement. The method 

CALCULATE is available for this purpose. 

Activities 

Implement the method of the BAdI. 

Caution 

You have to program your own processing for each schema item. 

 Adjustment by Fifteenths 

 Adjustment by Fifteenths 

Use 

In this section, you make the necessary settings for adjustment by fifteenths The calculations for 

adjustment by fifteenths are made within the BAdI for rent adjustment. 

Activities 

Follow these steps: 

1. Create adjustment rule 

Create an adjustment rule and in the Method field, choose BADI (Custom with BadI). 

2. Create BAdI implementation 

Create a BAdI implementation for the  BADI_REAJ_ADJUSTMENT BAdI and implement the 

CALCULATE method. Call the CALC_NEW_UNITPRICE_ method of class 

CL_REXC_AT_AJ_CALC. Then activate the BAdI implementation. 
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Example 

The current rent of  EUR should reach , EUR in  years. This is the target rent (reasonable rent). The 

increase should take effect on January , . 

The conditions have the parameters listed below. If you want guarantee stable values for the target rent, 

you also have to define an index adjustment term and assign it. 

Condition: Current Rent Target Rent Stable Value Guarantee ( Original 

Rent) 

Condition Purpose: Actual rent (A) Statistical (I) One-time statistical ( J ) 

Amount:  EUR  EUR  EUR 

Valid from:  // to // ( years) 

The first adjustment, to  EUR, takes place on January , . 

The condition purposes you set up for this procedure can also be used in the BAdI implementation. 

You create the  BADI adjustment rule and assign the BADI procedure to it. 

METHOD if_ex_reaj_adjustment~adjustment. 

  DATA: ld_cp_static      TYPE recdcondpurposeext,         

ld_cp_static_once TYPE recdcondpurposeext,         ld_cp_rent_rec    

TYPE recdcondpurposeext. 

  CHECK id_adjmrule = 'BADI'. 

* set external condition purposes 

  ld_cp_static      = 'I'.   ld_cp_static_once = 

'J'.   ld_cp_rent_rec    = 'A'. 

* call calculation method 

  CALL METHOD cl_rexc_at_aj_calc=>calc_new_unitprice_ 

    EXPORTING 

      io_contract             = io_contract       

io_rental_object        = io_rental_object       

is_condition            = is_condition       is_rhythm               

= is_rhythm       id_adjmrule             = id_adjmrule       

id_adjmsubrule          = id_adjmsubrule       

id_condpurp_static      = ld_cp_static       

id_condpurp_static_once = ld_cp_static_once       

id_condpurp_rent_rec    = ld_cp_rent_rec     changing       

cd_validfrom_new  = cd_validfrom_new       

cd_unitprice_new  = cd_unitprice_new       

cd_methrefguid    = cd_methrefguid       ct_message        

= ct_message       cf_error          = cf_error       

cf_no_adjustment  = cf_no_adjustment       

cf_exit_processed = cf_exit_processed. 



 

 

ENDMETHOD. 

 Define Adjustment Rules 

Use 

In this activity, you define adjustment rules for each adjustment method that you would like to use. 

Standard settings 

The following adjustment rules are provided by SAP in the standard system and are fixed: 

- Free 

- Index 

- Service charge settlement 

- Representative list of rents 

- Comparative group of apartments 

- Adjustment measure/modernization 

Together with specific contract or rental data, as well as data entered in the adjustment process (such as 

the specification of percentage or absolute adjustment), the adjustment rules define which algorithm is 

used to calculate the adjustment amount. 

Activities 

1. Create at least one rule for each adjustment method. 

2. Give the rule a name that allows it to be easily identified. 

3. If you want to create a rule consisting of several rules, set the Combined Rule indicator. Any rule 

that is not identified as a combined rule can be used as a subrule. If you want to create a rule that 

should be used exclusively as part of a combined rule, set the Part of Comb.Rule indicator. You then 

have to assign it to the combined rule in the Combined Adjustment Rules activity. 

4. Enter the required parameters for each rule. For more information, refer to the information contained 

in the F Help for each field. 

5. For each parameter, define how it appears on the on the contract or rental object. The options are: 

- Hidden 

- Displayed only 

- Can be modified 

- Required entry Recommendation: 
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To simplify processing, create rules with completed parameters for the most important and most 

frequently used adjustment rules. The rules you create should allow only a few or no individual settings 

to be made on the contract or rental agreement. In the case of more complicated or seldom used 

processes, you should create some rules with parameters that can then be specified on the contract or 

rental object. 

For some methods (such as, INDX or TASK) there are method-independent parameters in addition to the 

method-dependent parameters. You can set these parameters in the Implementation Guide in the section 

for the given method. 

Customizing Relationship - Contract/Rental Object 

If no parameters are changed in the contract/rental object, then the system uses the rule parameters from 

Customizing for the adjustment process. Then changes to the rule parameters in Customizing apply to all 

contracts/rental objects that use this rule. 

However, you can sever the relationship to Customizing by choosing @G@ with quick info Unlink from 

Customizing. The prerequisite for this is that the adjustment rule that has Modifiable in Contract/Rental 

Object entry status. 

Once you unlink Customizing, the modifiable fields are then ready for input, and you can make your own 

modifications to the adjustment rule. Any changes you make the rule parameters in Customizing then 

nolonger affect these contracts/rental objects. When you save an object that has an adjustment rule you 

modified yourself, an icon (@H@ with quick info  Modified), appears next to the changed fields. You can 

choose this icon to compare the rule parameters from Customizing with the modified value of the field. 

You can establish the relationship with Customizing again by choosing  @H@ with quick info 

Link to Customizing. The modifiable fields are then no longer available for input, and the system fills 

them again with the rule parameters from Customizing. 

 General Rent Adjustment 

Use 

The Business Add-In (BAdI) supports enhancements to the standard functions of adjustments of 

conditions without your writing program code. 

For information about possible enhancement scenarios, see the Overview of Enhancement Methods for 

Master Data Objects and the Real Estate Contract. 

Activities 



 

 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

For information on using BAdIs, see this documentation. 

The following methods exist: 

- GET_ADJUSTMENT_VALUE  

Gets the value of a variable in the control table 

- CAPPING 

Performs capping 

- ADJUSTMENT 

Performs the adjustment 

- MODIFY_ADJUSTMENT 

Modifies the adjustment 

- MODIFY_ADJUSTMENT_CEA  

Modifies an adjustment of a cost efficiency analysis ( Germany ) 

- AFTER_STORE 

Performs additional actions after saving 

- GET_ADJMRULE_FOR_INSERT 

Gets the possible adjustment methods to be added 

- GET_FIELDCATALOG 

Gets the field catalog for the adjustment transactions 

- GET_FIELDCATALOG_VALUE 

Gets the value for a field catalog entry 

- HIDE_FIELDCATALOG 

Hides certain field catalog columns (for improved performance) 

- MODIFY_TCODE 

During an indirect call of the adjustment, serves to put the transaction code into effect 

- GET_BEHAVIOR_SUBSEQ_COND 

Serves to control the adjustment frequency for adjustments of subsequent conditions. Using this 

method, you can specify using the CF_NO_RHYTHM parameter, if the system should redetermine 

the adjustment date (standard behavior) or not (CF_NO_RHYTHM = abap_true) when the 

subsequent condition becomes the condition to be adjusted. 

- AFTER_ACTIVATION 

Makes it possible to execute follow-up actions on an object after activation of an adjustment 

- AFTER_REVERSAL 

Makes it possible to execute follow-up actions on an object after reversal of an adjustment 
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These methods are called automatically during standard processing of the adjustment of conditions. If an 

implementation exists, the methods are always called in addition to standard system behavior. The 

standard behavior of the basic actions is not replaced. 

Warning 

The implementation of the methods has to be independent of the interface. It must not contain any 

COMMIT WORK or ROLLBACK WORK statements. For example, direct output of messages using the 

MESSAGE statement is not allowed. 

Method description 

- GET_ADJUSTMENT_VALUE 

This method gets the value of a variable in the control table. The following parameters are used with 

this method: 

- IO_CONTRACT and IO_RENTAL_OBJECT 

These parameters specify whether or not the condition to be adjusted is a contract condition. If 

the condition is a contract condition, then the parameter IO_CONTRACT is filled. Otherwise 

the IO_RENTAL_OBJECT parameter has a value. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IF_FIRST_CALL 

This parameter indicates whether the method is being called for the first time. If the parameter 

has a value, then this is the first call of the method. 

- ID_VALIDFROM_NEW 

The parameter contains the newly calculated Valid-From date of the condition. 

- ID_VARIABLE and CD_ADJUSTMENT_VALUE 

The ID_VARIABLE parameter contains the names of the variables from which the 

CD_ADJUSTMENT_VALUE parameter requested the value. 

- IT_ADJUSTMENT_VALUE 

This parameter transfers all variables of the method as well as their current values. Then the 

returned messages (CT_MESSAGE parameter) are displayed in the same list with the 

messages from standard processing. 

- CAPPING 

This method performs standard rent capping. The following parameters are used with this method: 

- IO_CONTRACT 

This parameter contains the contract object to be adjusted. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IF_BEFORE_STANDARD 

The parameter has a value before standard capping is performed. 



 

 

- IF_AFTER_STANDARD 

This parameter has a value after standard capping was performed. 

- CS_RECORD 

The parameter modifies the adjustment. 

- CF_EXIT_PROCESSED 

This parameter contains the information that the capping was executed by the method. Then 

the returned messages (CT_MESSAGE parameter) are displayed in the same list with the 

messages from standard processing. 

- ID_ADJMRULE and ID_ADJMSUBRULE 

The ID_ADJMRULE (combined adjustment rule) and ID_ADJMSUBRULE ( adjustment rule) 

parameters contain the adjustment rules that the implementation is dependent on. 

- ADJUSTMENT 

This method performs the standard adjustment. The following parameters are used with this method: 

- IO_CONTRACT and IO_RENTAL_OBJECT 

These parameters specify whether or not the condition to be adjusted is a contract condition. If 

the condition is a contract condition, then the parameter IO_CONTRACT is filled. Otherwise 

the IO_RENTAL_OBJECT parameter has a value. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IS_RHYTHM 

This parameter contains the frequency data of the condition being adjusted. 

- ID_VALIDFROM_NEW 

The parameter contains the newly calculated Valid-From date of the condition. 

- CD_UNITPRICE_NEW 

This parameter influences the new unit price. 

- CD_METHREFGUID, CF_ERROR and CF_NO_ADJUSTMENT 

This parameter is used to store a link from the adjustment to specific data ( see 

AFTER_STORE). 

Then the returned messages (CT_MESSAGE parameter) are displayed in the same list with 

the messages from standard processing. 

If the CF_ERROR parameter is set, then there were errors during execution of the adjustment. 

If the CF_NO_ADJUSTMENT parameter is set, then the system could not find an 

adjustment. 

- CF_EXIT_PROCESSED 

This parameter contains the information that the adjustment was executed by the method. 

- ID_ADJMRULE and ID_ADJMSUBRULE 

The ID_ADJMRULE (combined adjustment rule) and ID_ADJMSUBRULE ( adjustment rule) 

parameters contain the adjustment rules that the implementation is dependent on. 

- MODIFY_ADJUSTMENT 
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This method modifies the standard adjustment. The following parameters are used with this method: 

- CS_RECORD_MODIFY 

This parameter modifies the values of the standard adjustment. 

- IS_RECORD 

This parameter returns the adjustment record calculated by the standard adjustment. 

- MODIFY_ADJUSTMENT_CEA 

This method modifies the values of the standard adjustment that were determined using a cost 

efficiency analysis. The following parameters are used with this method: 

- IO_RENTAL_OBJECT 

This parameter contains the rental object to be adjusted. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IT_RECORD_METH_ALL, IT_RECORD_TASK, IT_RECORD_TASK_OBJECT 

These parameters return the method-specific adjustment values. 

- CS_RECORD_METH 

This parameter influences the adjustment results. 

Then the returned messages (CT_MESSAGE parameter) are displayed in the same list with 

the messages from standard processing. 

- GET_ADJMRULE_FOR_INSERT 

This method influences the number of adjustment rules for assignment within a contract object or 

rental object. 

- IO_CONTRACT and IO_RENTAL_OBJECT 

These parameters specify whether or not the condition to be adjusted is a contract condition. If 

the condition is a contract condition, then the parameter IO_CONTRACT is filled. Otherwise 

the IO_RENTAL_OBJECT parameter has a value. 

- CT_ADJMRULE 

This parameter influences the number of adjustment rules. 

- GET_FIELDCATALOG 

This method specifies additional output columns for the adjustment transactions, thereby 

determining the field catalog. 

The parameters IF_REVERSAL, IF_SIMULATION, IF_CONTINUATION, IF_DISPLAY tell you 

which transaction you are in. 

Using the CT_FIELDCATALOG parameter, you can specify the following additional output 

columns: 

- GRIDROLL: Data element in customer namespace that contains the documentation 

- GRIDTEXT: Column header 

- GRIDJUST: Setting of column values (R = right aligned, L = left aligned, C= centered) 



 

 

- GRIDCHECK: Specification of whether the column values are displayed as checkboxes 

- GRIDPOS: Position of the column 

- GRIDSUM: Specification of whether a column total is output for the given column 

- GRIDTYPE: Data type of the column value (A = amount, D = date field, < blank > = Other) 

- GRIDCOLOR: Color of the column 

- GET_FIELDCATALOG_VALUE 

This method returns values for the field catalog mentioned above. 

- IO_CONTRACT and IO_RENTAL_OBJECT 

These parameters specify whether or not the condition to be adjusted is a contract condition. If 

the condition is a contract condition, then the parameter IO_CONTRACT is filled. Otherwise 

the IO_RENTAL_OBJECT parameter has a value. 

- IS_CONDITION 

This parameter contains the values of the condition to be adjusted. 

- IS_RECORD 

This parameter contains the current adjustment record. 

- ID_GRIDROLL 

This parameter indicates the output column for which the value was requested. Note that the 

additional output columns are defined as type CHAR with a maximum length of  characters. 

- HIDE_FIELDCATALOG 

This method hides certain columns in the adjustment overview. For example, you can hide the 

partner name or address, since determining them is very demanding on performance. 

- AFTER_ACTIVATION and AFTER_REVERSAL 

These methods make it possible to perform follow-up actions on the adjusted object after the 

activation or reversal of an adjustment. 

- IO_OBJECT 

This parameter contains the adjusted object. 

- IS_RECORD 

This parameter contains the current adjustment record. 

- CT_MESSAGE, CF_ERROR, CF_EXIT_PROCESSED 

Using the parameter CF_EXIT_PROCESSED you can specify if the exit was executed. If the 

activation or reversal should be prevented, set the parameter CF_ERROR. The returned 

messages (parameter CT_MESSAGE) are output in the activation log or the reversal log. 

- AFTER_STORE 

Using this method, you can update your own additional, user-defined data. At this point, all 

checks were performed without any errors occurring. No more changes can be made to the data 

of the standard object. 

Only internal errors are now possible here (such as, data inconsistency, errors in the technical 

infrastructure, programming errors). For these exceptional situations, you can output termination 
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messages. This is implicitly linked to a resetting of the last database changes (ROLLBACK 

WORK). 

Warning 

You are not allowed under any circumstances to use a COMMIT WORK or ROLLBACK WORK 

statement within this method, since this can cause internal errors. If you use them, data inconsistencies 

can occur. Notes for Developers 

 Third-Party Management 

 Calculation of VAT 

 Calculation of VAT 

Use 

The functions for calculating VAT for condominium owners' associations (COA) in Austria can be used 

for the following: 

- To determine and post VAT on expenses paid from the maintenance reserves of rental objects 

belonging to the COA 

- To subsequently allocate these amounts to the individual condominium owners 

In Austria, the VAT does not fall due when funds are allocated to the maintenance reserve. Instead, the 

VAT is not due until the reserve is actually used. For calculating the VAT, the system uses the tax rates 

that are applicable based on the usage of the individual rental objects in the condominium owners' 

association. (Currently the tax rate for non-commercial usage is %; for commercial usage it is %.) The 

calculated VAT is posted and can then be subsequently allocated to the individual condominium owners. 

Requirements 

You made the following settings in standard Customizing for Flexible Real Estate Management: 

- You created an external calculation formula and assigned it to the internal formula BAdI 

Calculation. 

- You set up a contract type for a G/L account contract. 

- You defined flow types for it and set up the account determination. 

- You created condition types for posting the VAT amount and for the subsequent allocation of VAT 

(for instance, a VAT condition and a subsequent allocation condition). You assigned the necessary 

flow types to them. 

- You assigned condition types or condition groups to the contract types. 

In Customizing for Flexible Real Estate Management, you activated the country-specific functions for 

Austria (country code AT). 



 

 

Activities 

You make the settings for calculation of VAT in the following IMG activities: 

- You enter the tax parameters for the service charge keys relevant  for the calculation and posting of 

VAT. 

- You define  tax parameters for the relevant condition types  for posting the calculated VAT and the 

subsequent allocation. 

- You check the implementation of the enhancement (BAdI) for calculating the condition amounts as 

well as for posting the VAT. 

 Specify Parameters for Service Charge Key 

Use 

In this activity, you specify the service charge keys that are relevant for calculating VAT on expense in 

Austria. You enter the tax information to be used for these service charge keys. 

Requirements 

You created service charge keys in standard Customizing. 

Activities 

Enter all service charge keys that you want to use for calculating VAT. 

To calculate the VAT using a fixed tax rate, enter the tax information (tax type, tax group) for the service 

charge key. 

If you do not enter any tax information for a service charge key, then the system calculates the VAT using 

the tax rate of the tax group on the individual contract. 

 Specify Parameters for Condition Type 

Use 

In this activity, you specify the condition types that are relevant for the calculation and subsequent 

allocation of value added tax in Austria. You also specify the tax information to be used for these 

condition types. 
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Requirements 

You created condition types in standard Customizing. 

Activities 

- Condition types for the calculation: 

Create a condition type for each tax rate, for which you want a calculation to be made. Enter the tax 

information for these condition types. Set the Priority indicator for the tax group you want to use for 

non-commercial usage. 

- Condition types for the subsequent allocation: 

For condition types for subsequent allocation, also enter the calculation method. 

 Implement Enhancements for Calculation Formula and Posting 

Use 

Functions for calculating and posting VAT are found in the following BAdI implementations. These are 

active if you have activated the country-specific functions for Austria. 

- BAdI BADI_RECD_CALC_RULE: 

- Implementation: BADI_RE_XC_MM_OT: calculation of VAT on expense 

- Implementation: BADI_RE_XC_MM_OTOP: calculation of subsequent allocation of 

VAT on expense 

- BAdI BADI_RERA_DOC: 

- Implementation: BADI_RE_XC_MM_OT_DOC: posting of VAT on expense - BADI 

BADI_REEX_FI_BAPI: 

- Implementation: BADI_RE_XC_MM_OT_TAX: setting of indicator for direct tax posting 



 

 

 Switzerland 

 Rent Adjustment Based on Swiss Law 

 Location Switzerland: Assign Adjustment Rule to Regional Location 

Use 

In this activity, you enter the location-specific parameters for rent adjustment based on Swiss law. 

Requirements 

You defined a regional location. 

You defined an adjustment rule. 

Activities 

Enter the following for each regional location of the business entity: 

- Official language 

The adjustment letters are printed in this language. 

- Adjustment rule that is used for objects of this business entity. 

- Correspondence activity for the rent adjustment. This correspondence activity is used for 

adjustments at this regional location. 

- Correspondence activity for notice, when notice is given by the landlord at this regional location. 

 Define Reference Interest Rate 

In this section, you define the reference interest rate for the interest adjustment for cash deposits with a 

variable interest rate and for the rent adjustment according to Swiss law. 

In Switzerland, the change to the mortgage loan rate is a relative factor that is used as a basis for rent 

adjustment. The mortgage loan rate is stored in a "reference interest rate table". 

If the mortgage loan rates differ from region to region, you will need a reference interest rate for each 

interest series. 

Activities 
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1. Check which reference interest rates you need for the mortgage loan rate. Create one reference 

interest rate for each interest series. 

2. Before each Swiss rent adjustment, make sure that the reference interest rates for the mortgage loan 

rate series are up-to-date. 

3. If necessary, maintain any missing values. 

Further notes 

The reference interest rates for all of Treasury are stored in the same global table. 

 Enter Index Levels 

Use 

In this section, you create: 

1. Index class as the basis for further defining indexes for rent adjustments 

2. Index series used in your organization for rent adjustments, including index series with base year 

3. Index points for the index series 

Standard settings 

SAP supplies the index classes  for real estate objects and  for maintenance and operating costs index ( 

Switzerland ). 

Recommendation 

It is recommended that you do not change the standard settings. 

Changes may at best be necessary if you have already entered these index classes (with other 

characteristic values) in Asset Accounting (Asset Accounting uses the same table). In case of 

uncertainties, please also refer to the Asset Accounting System Administration Guide. 

Activities 

1. Check whether you have to make changes to the standard setting. The Real Estate component 

requires the following index classes: 

a) An index class for rent adjustment with the following settings: 

Details on indexing frequency (monthly: entry ) Details on 

base year 

b) Applies only for Switzerland: a class for maintenance and operating costs index with the 

following settings: 



 

 

- Details of an indexing frequency (monthly: entry ) - No base 

year: Check if changes to the standard setting are   necessary. 

2. Index series 

First maintain per index class the required index series and, for index series with base year, the 

required base years for the respective index series. 

3. Index data 

Create the required index data for the index series. 

To do so, navigate over the required entry (index series with or without base year. 

 Adjustment Rules Switzerland: Define Parameters for Adjustment Rule 

Use 

In this activity, you enter the parameters for an adjustment rule for an adjustment based on Swiss law. 

Requirements 

You defined   external condition purposes for the absolute factors. 

You defined a  condition group for the basic rent. 

You defined an interest reference. 

You defined an index class. 

Activities 

Enter the following for each adjustment rule: 

- Parameters and entry status in the Adjustment Parameters for Relative Method group box: 

- Interest reference (for example, from the canton bank) 

- The percentage to be used for an adjustment based on maintenance and operating costs 

- Default value and pass-on percentage rate for protection of purchasing power 

- External condition purposes in the Adjustment Parameters for Absolute Method group box -

 Condition group for basic rent for the rent adjustment form 
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 Define Pass-On Rates 

Use 

A change in the mortgage rate can have an influence on the amount of rent. The amount of the pass on 

rates is based on the level of the mortgage rate and on changes to it. The pass on rates increase 

incrementally by different amounts based on these figures. A critical factor in these calculations is that 

when the mortgage rate is lowered, rent is reduced by the amount that it was increased the last time the 

mortgage rate was increased. In this IMG activity, therefore, you enter only values for mortgage rate 

increases. The system calculates the pass on rates for reductions automatically. 

Activities 

Enter the interest rates and pass on rates here that are used when the mortgage rate changes by one-fourth 

of a percent (): 

- Mortgage rate level - lower level 

- Mortgage rate - upper level 

- Resulting pass on rate: This value is the adjustment percentage rate that is used during the 

adjustment run for a mortgage rate increase. 

 Accounting 

 Incoming Payments 

 Define Clearing Parameter for Incoming Payment 

Use 

In this IMG activity, you enter the parameters for processing incoming payments for ISR payments. 

Activities 

For each company code, specify how the system should clear open items during automatic processing of 

incoming payments. 

- Enter the limitations that apply for the reference when clearing. 

- Enter the limitations that apply for the due date of the open items. 



 

 

 Dunning 

 Enter Dunning Area per Process 

Use 

In this activity, you can define your own dunning area for each company code and process. 

Standard settings 

In the standard system (not country-specific), dunning takes place using the dunning area in the contract 

for: net rent, subsequent receivables for heating and service charge settlement, and subsequent receivables 

from sales-based rent settlement. However, in Switzerland, it has to be possible for the user to select from 

different dunning procedures from within different processes. You define the dunning areas for the 

following processes: 

- Sales-based rent settlement (RESR) process 

- Heating and service charge settlement (RESC) process 

These are predefined in the system. 

The dunning area is modified in a BAdI of the posting interface. If you make entries for this process here, 

then the BAdI overwrites the dunning are of the posting record. If no entry is found, then the posting 

record is not changed. 

 Service Charge Settlement 

 Calculation of Fuel Consumption 

 Define Service Charge Key for Fuel Management 

Use 

Fuel management takes place at the level of the settlement unit. Here you define the service charge keys 

for which you want use fuel management.  For each company code, you also define the posting 

parameters that are relevant for additions and removals of fuel, as well as for the initial fuel level. 

Requirements 

You defined  service charge keys for heating expenses in the standard system. 
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Activities 

Enter the posting parameters for each company code and service charge key: 

- Flow types 

- Parameters for updating corrections to the fuel level in Financial Accounting and Controlling 

- Additional parameters, such as rounding, unit of measure, and reason for reversal 

 Implement Enhancements ( BAdI ) 

 Enhancements in Calculation of Fuel Consumption 
Use 

The Business Add-In (BAdI) makes it possible to change the generated flow data in fuel management. 

The following method is available. It is executed by the system within fuel management. 

- BEFORE_POST  Before the posting of the RE document 

(change to document data) 

- CHANGE_NONDEDUCT_TAX Change non-deductible VAT amount 

- CONSUMPTION FI posting of consumption 

- OPEN_BALANCE FI posting of initial fuel level 

- CHANGE_STOCKIND_TEXT Modify name of fuel level indicator 

- CHANGE_SHOWMODE_OB_FIRST_POST Call Transaction: 'N'=Do not display, 

'E'=Display for error 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

Note that when implementing the BAdI you are not allowed to use statements that affect the interface, 

such as direct output of messages using MESSAGE. 

For an overview of the programming interfaces for RE-FX, refer to this text. 



 

 

 Individual Heating Expense Settlement 

 Define Measuring Point ID 

Use 

You need measuring points to be able to enter meter readings, and to be able to settle consumption for 

utilities.  A two-character measuring point ID is transferred in the measurement tape. You enter this 

measuring point ID and a description for it here. 

 Assign Measuring Point ID to Characteristic 

Use 

In this activity, you assign a measuring point ID to a characteristic. Using characteristics, you define the 

purpose for which meters are created (such as for recording the consumption of cold water or electricity) 

and their unit of measurement. Assign clearly understandable names to the characteristics, such as, 

ELECTRICITYUSE. 

 Building and Housing Register 

 Basic settings for Localization Switzerland GWR 

Grundeinstellungen für Gebäude- und Wohnungsregister ( GWR ) 

Diese organisatorische Aktivität beschreibt die grundlegenden Einstellungen, die Sie vornehmen müssen, 

um die Erweiterungsmöglichkeiten für das Gebäude- und Wohnungsregister ( GWR ) nutzen zu können. 

Diese Einstellungen dienen als Voraussetzung, bevor Sie die Aktivitäten zur GWR-Lokalisierung 

Schweiz ausführen. 

1) Rufen Sie über die Transaktion SM die Sicht V_TBZA_RE (RE-FX: BDT-Anwendungen) auf 

und legen Sie einen neuen Eintrag für die Anwendung REAO / AOCH ( Bezeichnung Schweiz: GWR) 

an. 

2) Nehmen Sie dann folgende Dialog-Einstellungen unter Stammdaten --> Architektonische 
Sicht --> Dialog  --> Bildaufbau vor: 

- Legen Sie in der Aktivität Feldgruppen folgende Einträge an: 
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- Feldgruppe  (GWR-Beschreibung (Schweiz) mit Funktionsbaustein 

REXC_AOCH_EVENT_FMOD 

- Feldgruppe  (Grundbuch (CH)) mit Funktionsbaustein 

REXC_PRCH_LR_EVENT_FMOD 

- Legen Sie in der Aktivität Sichten folgende Einträge an: 

- AOCH: 

Gruppenrahmen Allgemeine Daten 

- Bezeichnung: GWR CH ( Liegenschaftsbeschreibung ) 

- Anwendung: AOCH (Schweiz: GWR) - Differenzierungstyp:  Allgemeine Daten 

- Markieren Sie das Ankreuzfeld Eingabesicht. 

Gruppenrahmen Subscreen 

- Programmname: SAPFLREXC_AOCH_AOCH 

- Bildnummer:  

Gruppenrahmen Funktionsbaustein 

- Vor der Ausgabe:  REXC_AOCH_PBO_AOCH  

- Nach der Eingabe: REXC_AOCH_PAI_AOCH 

- Gruppenrahmen Bildkonfiguration Markieren Sie das Ankreuzfeld Datenbild. 

Ordnen Sie unter Sicht --> Feldgruppen der Sicht die Feldgruppe  (GWR-Beschreibung 

(Schweiz)) zu. 

- AOCH: 

Gruppenrahmen Allgemeine Daten 

- Bezeichnung: GWR CH ( Objektbeziehung ) 

- Anwendung: AOCH (Schweiz: GWR) - Differenzierungstyp:  Allgemeine Daten 

- Markieren Sie das Ankreuzfeld Eingabesicht. Gruppenrahmen Subscreen 

- Programmname: SAPFLREXC_PRCH_PRCH 

- Bildnummer:  

Gruppenrahmen Bildkonfiguration 

- Markieren Sie das Feld Datenbild. 

Ordnen Sie unter Sicht Feldgruppen der Sicht die Feldgruppe  (Grundbuch (CH)) zu. 

- Legen Sie in der Aktivität Abteilungen unter Dialogstruktur --> Abschnitte folgende 

Einträge neu an: 



 

 

- Abschnitt AOCH, Bezeichnung Liegenschaftsbeschreibung CH 

- Abschnitt AOCH, Bezeichnung Grundbuch CH 

- Ordnen Sie unter Abschnitt Sichten die Abschnitte folgendermassen neu zu: 

- Abschnitt AOCH: Pos , Sicht AOCH, Bezeichnung GWR CH: 

Liegenschaftsbeschreibung 

- Abschnitt AOCH: Pos , Sicht AOCH, Bezeichnung GWR CH: Objektbeziehung 

- Legen Sie in der Aktivität Bilder unter Dialogstruktur --> Bilder folgenden Eintrag an: 

- Bild: AOCH 

- Bezeichnung: Liegenschaftsbeschreibung CH 

- Bildtitel: Liegenschaftsbeschreibung ( CH ) 

- Nehmen Sie unter Bildfolge --> Bilder die gewünschte Bildfolge entsprechend Ihren 

Anforderungen vor. 

Beispiel: 

Legen Sie die neue Bildfolge REAO, Bezeichnung Standard an. Ordnen Sie unter Bildfolge --> 

Bilder das Bild AOCH (Bildtitel: Liegenschaftsbeschreibung CH)) der gewünschten Position zu. 

 Define Energy Sources for Heating/Hot Water 

Use 

In this Customizing activity, you define energy sources that are used for heating and hot water supply in a 

building or rental object. You must enter the code and description of the energy sources in accordance 

with the code list published by the Federal Building and Dwelling Register ( GWR ). 

Example 

Energy Source Code   Description of Energy Source 
7200 No energy source 

7201 Heating oil 

7202 Coal 
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 Define Heating Types 

Use 

In this Customizing activity, you define heating types that are used in a building. You must enter the 

code and description of the heating types in accordance with the code list published by the Federal 

Building and Dwelling Register ( GWR ). 

Example 

Code of Heating Type Description of Heating Type 

 No heating 

 Individual heating 

 Central heating for the building 

 Define Building Categories 

Use 

In this Customizing activity, you define building categories that are used to classify buildings according 

to their use. You must enter the code and description of the building category in accordance with the code 

list published by the Federal Building and Dwelling Register ( GWR ). 

Example 

Code of Building Category Description of Building Category 

 Temporary accommodation 

 Residential building 

 Building without residential use 

 Define Building Statuses 

Use 

In this Customizing activity, you define building statuses that are used to define the current condition of a 

building. You must enter the code and description of the building status in accordance with the code list 

published by the Federal Building and Dwelling Register ( GWR ). 



 

 

Example 

Code of Building Status Description of Building Status 

 Projected 

 Under construction 

 Define Floors 

Use 

In this Customizing activity, you define floors that you can assign to rental objects. You must enter the 

code and description of the floor in accordance with the code list published by the Federal Building and 

Dwelling Register ( GWR ). 

Example 

Floor Code Description of Floor 

3100 Ground floor including mezzanine 

3101 st floor 

3102 nd floor 

 Define Cooking Facilities 

Use 

In this Customizing activity, you define cooking facilities that you can assign to a rental object. You must 

enter the code and description of the cooking facilities in accordance with the code list published by the 

Federal Building and Dwelling Register ( GWR ). 

Example 

Code of Cooking Facilities Description of Cooking Facilities 

7300 No kitchen 

7301 Kitchen (at least  square meters) 

7302 Kitchen (smaller than  square meters) 
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 Define Dwelling Statuses 

Use 

In this Customizing activity, you define dwelling statuses that are used to define the current condition of a 

dwelling. You must enter the code and description of the dwelling status in accordance with the code list 

published by the Federal Building and Dwelling Register ( GWR ). 

Example 

Code of Dwelling Status Description of Dwelling Status 

 Projected 

 Under construction 

 Define Usage Types for Dwelling 

Use 

In this Customizing activity, you define usage types for rental objects on the basis of the purpose for 

which a rental object is used. You must enter the code and description of the usage type in accordance 

with the code list published by the Federal Building and Dwelling Register ( GWR ). 

Example 

Code of Usage Type Description of Usage Type 

 Dwelling with permanent residents 

 Dwelling with temporary residents 

 Swiss Land Register 

 Central Settings for Land Use Management 

 Activate Swiss Land Register 

Use 

In this Customizing activity, you activate the country-specific data in land register for Switzerland. After 

the activation, all the localized data for Switzerland will be visible in the land register. 



 

 

Requirements 

You have already activated the country code for Switzerland in the Customizing activity Activate 

Country-Specifics. 

 Make General Settings for Land Use Management 

Use 

In this Customizing activity, you make general settings for Land Use Management ( LUM ). 

Activities 

You enter default values in the Defaults for Land Registers and Defaults for Parcels group boxes. These 

default values apply per master data object in dialog processing. You enter values for units of area, units 

of length and units of time. You can also enter a default currency, if needed. 

For parcels, you can also enter default values for the location structure and for overlays for cadastral 

usage types. 

 Define Hierarchical Location Structure 

Use 

In this Customizing activity, you define various location structures. Location structures are used to 

uniquely identify parcels or land registers for different purposes. 

In Switzerland, you use these settings to create, at the minimum, the following two hierarchies: 

- APR hierarchy for the automated property register of the land registry 

- Administrative hierarchy for the survey office 

Activities 

Enter an ID and a name for your location structure. 

Specify the number of levels for the hierarchy and the names of each level. 

For each location structure, you also specify the following: 
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- Allowed Hierarchical Location Structures per Object Type 

Specify if assignment of the object type to this location structure is mandatory. Specify if 

this is the standard location structure. 

- Hierarchical Locations in Location Structure 

Here you enter the possible locations for each defined hierarchy level. 

Example: 

You defined these three levels for the location system: 

1 - Country 

2 - Region 

3 - City 

Then you enter all countries, regions and cities that you need in your system. 

- Assignment of Hierarchical Locations in Location Structure 

You assign the already defined hierarchical locations to one another and assign a key for each 

location. You can then assign only this key to a parcel or a public register in the application. 

You are not required to assign the keys systematically, but it is a good idea. The key of the 

hierarchical location is not allowed to contain any spaces. 

If the assignment should change due to restructuring of individual hierarchical locations, it is not a 

problem to assign new keys (at the level Assignment of Hierarchical Locations in Location 

Structure) or to assign other locations to an existing key. However, if the key itself should change, 

then you have to change the master data. 

Example 

You defined the following locations at the given level: 

Level  - Country: 

DE - Germany 

CH - Switzerland 

US - USA 

Level  - Region: 

D - North Rhine-Westphalia 

D - Bavaria 

CH - Basel 

CH - Tessin 

US - Michigan 

US - Florida 



 

 

Level  - City: 

D-K - Cologne 

D-D - Duesseldorf 

D-M  - Munich 

CH-B - Basel 

CH-LG - Lugano 

US-CH - Chicago 

US-M  - Miami 

US-OL - Orlando 

Assignment of Hierarchical Locations in Location Structure:  

For the assignment of hierarchical locations in the hierarchy, you have to assign a unique key to each 

hierarchical location. 

A hierarchical location cannot be used in object unless it has a key here. 

DE-K  Cologne DE D D-K 

DE-D Duesseldorf DE D D-D 

DE-M Munich DE D D-M 

CH-B Basel CH CH CH-B 

CH-LG Lugano CH CH CH-LG 

US-CH Chicago US US US-CH 

US-M Miami US US US-M 

US-OL Orlando US US US-OL 

In this case, you would assign the location DE-K to a parcel in Cologne. It is then clearly visible, both in 

master data processing and in reports, that this parcel has the following location: 

- Country: Germany 

- Region: North Rhine-Westphalia 

- City Cologne 

 Define Overlays 

Use 

Here you define  overlay numbers that are independent of the given German federal state. 
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You then assign the overlay numbers to a hierarchy level of the location structure. You make this 

assignment in the  Specify Relevant Overlay Numbers for Certain Hierarchy Levels IMG activity. This 

assignment allows you to structure overlays in accordance with the separate requirements of each given 

German state. 

 Specify Cadastral Classification 

Use 

Here you define the  cadastral classification of parcels. This classification represents the use of the parcel 

from the viewpoint of the land survey office. 

Cadastral usages of the same type are grouped together by  overlay numbers. 

Requirements 

You defined the overlay numbers 

Activities 

For each overlay number, enter all cadastral classifications, for which you want to be able to enter 

measurements. 

Enter a key and a text for each cadastral classification. 

 Define Land Register Types 

Use 

In this Customizing activity, you define land register types for the land register. 

In addition to the "normal" land register, there are other registers, such as: 

- Apartments register 

- Partial ownership land register 



 

 

Using the land register type, you specify which data can be entered in the land register. 

For the purposes of reporting, you can assign the land register types to internal land register types, either 

Ownership or Land Lease. 

For more information on the land register, see Information on the Land Register. 

Activities 

Enter a key for the land register type and a long and short name for it. 

Assign the land register type to an internal land register type. 

 Enter Data for Communes 

Use 

In this Customizing activity, you must enter all the communes by specifying their official commune 

number, the canton, and the country in which they are geographically located. 

The data will be used in the land register, or in the master data of buildings or land. 

 Define Encumbrance Types 

Use 

In this Customizing activity, encumbrance types are used in the land register in section II or 

III. 

Here you define the encumbrance types you need, and specify how they are used. 

Activities 
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Specify the following for each encumbrance type: 

- Use in real estate register? 

- Use in section II? 

- Use in section III? 

- Has dominant tenements? 

- Has servient tenement? 

- Has holder? 

- Has obligated party? 

- Has contracts? 

Depending on how this indicator is set, the corresponding tab pages in master data processing for the land 

register are either hidden or displayed. 

 Default Land Registry 

 Define Search Strategy for Land Registry 

Use 

In this Customizing activity, you can use a search strategy so that the system proposes an appropriate 

main contractual partner (usually a land registry) for a given land register page. Search strategies use 

search methods, which specify how the main contractual partner is determined from the object data. 

In order for the system to be able to determine a default value or possible search help value for the main 

contractual partner of the land register page, exactly one search strategy must be active for the 

LROFFICE search field (for the land register). 

Activities 

Define the search strategies for the LROFFICE search field as follows. Set the Active? indicator for the 

search strategy you want the system to use. (The other search strategies can then be deleted. It only makes 

sense during the test phase to define one strategy for each search method you are testing.) 

Enter a name for the search strategy. 

Specify how the search takes place: 



 

 

- Name 

Text of search strategy (informational only) 

- Search Method 

This is a method that is predefined in the system. The method describes how the search is 

performed. The way the system processes the values for the search strategy depends on the method 

you select here. Choose a method using the input help. 

- Active? 

You can only use search strategies. For example, if you copied the search strategies from standard 

Customizing, then set the Active? indicator for those that you want to actually use in your system. 

- Other Values 

Set this indicator, if you also want the standard search help to be available. The system then displays 

a Further Values row, in addition to the values returned by the search strategy.  From there you can 

navigate to the standard search help. 

The following search methods for the main contractual partner are predefined in the system: 

ADDRNR     Land register from address 

PARTNR     Land register from partner number 

VALREG     Land register from district 

The ADDR and PARTNER methods assume that the partner numbers are assigned so that their meaning 

is clearly apparant. The systematic way of doing this is described in the Define Search Method IMG 

activity. You can use your own customer-specific numbering system as a reference for the 

implementation. 

For the VALREG method, you have to enter the possible values for each land register district in the  

value table. In the Differentiation Characteristic column, enter the land register district. You can use the 

asterisk (*) and plus sign (+) as wildcard characters. Enter the partner number of the land registry in the 

Value column. You can designate one land registry in each district as a default value. 

To be able to use these methods delivered with the system, you have to copy the sample code of the 

implementing class CL_EXM_IM_RECA_SEARCH_METHOD of the enhancement spot 

BADI_RE_CA_SH to a customer class. Then you have to activate this customer implementation. 

 Define Partner Numbers Possible for Search Strategy 

Use 

In this Customizing activity, you enter the possible values here for a search strategy that was already 

defined. For search strategies with the VALREG (land register from district) method, enter the land 
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register district in the Differentiation Criterion column, and enter the partner number of the land registry 

in the Field Contents column. 

If your active search strategy uses a method that does not require entering values, then you do not have to 

have to enter values here. 

Activities 

For each search strategy, enter the search values that are needed based on the search method: 

Where you enter these values is dependent on the search method used by the search strategy. For search 

methods where the values for the strategy are simply entered, you enter the values directly in the 

Differentiation Criterion field. In that case, you can specify only one value for each search strategy as a 

default value. 

For search methods that recognize a differentiation criterion (such as, the location of the current object), 

you have to enter the possible values for each differentiation criterion in the Field Contents field. 

You can use wildcard characters here: An asterisk (*) replaces any number of characters, while a plus 

sign (+) replaces exactly one character. If more than one value is possible for a differentiation criterion, 

then enter a number to distinguish the values in the Seq. Number (sequence number) field.  You are only 

allowed to designate one value as the default value for each combination of search strategy and 

differentiation criteria. 

To help you select possible values more easily, you can choose Propose Values. Position the cursor on the 

search strategy, for which you want to propose values (or, if there is no entry yet for search strategy, on 

the search field). Then choose Propose Values.  The system displays a search help appropriate for the 

search strategy. You can select the values there that you need for this search strategy. 

Note on transport: 

Since you enter partner numbers in the table, transporting to another system only makes sense if the 

partner numbers are the same in both systems! 

 Dialog 

 Change Screen Layout 
Use 



 

 

For more information on using the Business Data Toolset, refer to the SAP Library. Choose SAP 

NetWeaver Components --> Cross-Application Functions --> Business Data Toolset. 

 Screen Layout 

 Field Groups 

 Field Groups 

Use 

Use 

These are the specifications for how the fields are grouped into field groups for the Business Data 

Toolset. 

Standard settings 

Do not change the standard settings. 

Exception 

You should make changes only if you want to add your own new fields to the master data dialog. 

Activities 

In that case, copy an existing field group to the customer name range. (Enter a number between  and  in 

the Field Group field.) 

Change the properties of the field group accordingly in the detail screen. Then assign the new fields to the 

field group. 

 Field Status 

Use 

Use 
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Here you can set up the field modification for field groups. Proceed as follows: 

1. Enter the activities for which the setting should apply (if not already displayed). 

2. Select the row and choose Field Modification. 

The system displays all field groups that know the given application. In order to display the fields of 

a field group, position the cursor on the field group and choose Environment -> Field check. 

3. Now you can, for example, suppress field groups that are not needed or define other field groups as 

"Required entry" fields. If you choose the "Not specified" setting, then the system itself determines 

how the field is treated. (Usually these fields are optional entry fields in create and change mode, 

and display fields in display mode.) If it is not possible to make a setting for a field group, then the 

system determines how the field is treated (usually dependent on the situation, or on the contents of 

other fields). 

Note 

Before you suppress multiple field groups of a view, a section or a screen sequence, you should consider 

if it makes more sense to remove the view, section or screen completely from the screen sequence. 

 Views 

Use 

Use 

Here you specify which field groups are grouped together into a view (part of a screen, technically a 

subscreen). You should group together the field groups that necessarily belong together during a check. 

Example 

If you have a field group with a valid-from date and a field group with a valid-to date, and these should be 

checked against each other in a module, then you should group them together into a view. 

The check module is in the detailed data under  "Function Module After Entry". 

Standard settings 

SAP recommends that you not change the standard settings. It is only necessary to make changes if you 

want to add your own new fields to the master data dialog. 

In that case, copy an existing view to the customer namespace (Y* or Z*) and modify the properties of 

the view accordingly (consider the detail screen). Then assign the field groups to the view. You can 

assign your own field groups, as well as those delivered by SAP. 



 

 

 Sections 

Use 

Use 

Here you specify which views are grouped together into sections. You can recognize a section because it 

is surrounded by a frame. Fields that logically belong together should be grouped together in sections. 

Standard settings 

SAP recommends that you not change the standard settings. 

It could be necessary to define new sections, either to arrange views delivered by SAP differently or to 

add your own fields to the master data dialog. 

In that case, copy an existing section to the customer namespace (Y* or Z*) and assign the views you 

want to this section. The item number specifies the sequence in which the views are arranged in the 

section. For technical reasons, if you make your own assignments from sections to views, the item 

numbers have to be in the customer namespace (that is, they are not allowed to end in ''). 

This makes it possible for you to also include your own views in SAP sections. Select a section, and 

choose Section -> Views in the dialog tree, and assign the view to a section using a corresponding item 

number. 

 Screens 

Use 

Use 

Here you specify which tab pages appear in the dialog, and which sections make up these tab pages. 

Standard settings 
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SAP recommends that you do not change the standard tab pages. 

If you want to change a tab page, copy the standard tab page that is closest to the tab page you have in 

mind, and give it a name in the customer name range (Y* or Z*). Then assign the sections you want. The 

position number for user-specific entries also has to be other than  here. 

 Screen Sequences 

Use 

Use 

Here you specify which screen sequences should appear in dialog. A screen sequence consists of different 

screens, and each screen is equivalent to a tab page. 

Standard settings 

SAP recommends that you leave the standard screen sequences unchanged. If you have to define other 

screen sequences, copy a standard screen sequence to the customer name range (Y* or Z*) and then 

assign the screens you want. The position number for user-specific entries also has to be different from  

here. 

Note 

You have to assign the new screen sequences to the standard screen sequence category. Choose Screen 

Sequence Categories or Screen Sequence Category  -> Screen Sequences. 

Where does changing the screen sequence make sense? 

For applications that can relate to different object types or contract types: 

- Architectural object (locality, land, building, floor, space, and so on): 

Here you can define the new screen sequence dependent on the architectural object type. If a new 

screen sequence is not entered, then the system uses the standard screen sequence. This allows you, 

for example, to hide the Land tab page when processing an architectural object of the type Building, 

and vice versa. 

- Rental object: 



 

 

You can define the screen sequence to be dependent on the type of rental object ( rental unit, pooled 

space, rental space). 

- Contract: 

You can define the screen sequence to be dependent on the contract type. If a new screen sequence 

is not defined per contract type, or it cannot be defined (for business entity, building and land, for 

example), then the system uses the screen sequence that is designated as "Standard." 

- RE search request: 

For normal entry, you use the standard screen sequence. For fast entry (ad hoc search) the 

RERRFE screen sequence is used. (This cannot be changed.) 

 Events 

Use 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 

 Tables 

Use 

You need this dialog only if you want to make complex modifications to the standard dialog. 

SAP recommends that you leave the settings delivered here unchanged. 
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 Implementation Enhancements ( BAdI ) 

 Validation, Substitution 

Use 

The Business Add-In supports enhancements to the standard functions of land registers. For an 

overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods needed for your particular enhancement. Then 

activate the BAdI implementation. 

For a description of the methods that are available in all Business Add-Ins for master data objects and the 

real estate contract, refer to Methods and Events. 

For an overview of the programming interfaces for RE-FX, see this text. 

Example 

There is a sample implementation for each of the following in the BAdI Builder: business entity, rental 

object and real estate contract. 

Choose the menu path: Goto -> Sample Code -> Display. 

Enhancements of the user interface using the Business Data Toolset are explained in more detail in 

Enhance BDT Applications Notes for Developers 

 Conversion Exits for the Page Number of Land Register 

Use 

The Business Add-In supports enhancements to the standard functions of land register page numbers. 

For an overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

The following methods exist: 

- NUMBER_INPUT - Conversion of the land register page number at the time of entry. The method 

is called when a land register page number is entered on the screen. 



 

 

- NUMBER_OUTPUT - Conversion of the land register page number at the time of output 

. 

The method is called when a land register page number is output on the screen. 

The implementation of the methods has to be independent of the interface. It is not allowed to contain any 

COMMIT WORK or ROLLBACK WORK statements. 

For example, direct output of messages using the MESSAGE statement, without using the existing 

exceptions, is not allowed. 

Method description 

- NUMBER_INPUT 

For conversion at the time of input (from the screen to the internal display) 

- NUMBER_OUTPUT 

For conversion at the time of output (from the internal display to the screen) 

Example 

For a sample implementation that shows the conversion of land register page numbers as in the LUM 

add-on, see the class CL_EXM_IM_RELM_NUMBER_LRPAGENO. Notes for Developers 

 Conversion Exits for Numbers in the Real Estate Register 

Use 

The Business Add-In supports enhancements to the standard functions of real estate register numbers. 

For an overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

The following methods exist: 

- NUMBER_INPUT - Conversion of the real estate register number at the time of entry. The method 

is called when a real estate register number is entered on the screen. 

- NUMBER_OUTPUT - Conversion of the real estate register number at the time of output. The 

method is called when a real estate register number is output on thescreen. 

The implementation of the methods has to be independent of the interface. It is not allowed to contain any 

COMMIT WORK or ROLLBACK WORK statements. 

For example, direct output of messages using the MESSAGE statement, without using the existing 

exceptions, is not allowed. 
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Method description 

- NUMBER_INPUT 

For conversion at the time of input (from the screen to the internal display) 

- NUMBER_OUTPUT 

For conversion at the time of output (from the internal display to the screen) 

Example 

For a sample implementation that shows the conversion of real estate register numbers as in the LUM 

add-on, see the class CL_EXM_IM_RELM_NUMBER_LRREGNO. Notes for Developers 

 Conversion Exits for Numbers in Sections II and III 

Use 

The Business Add-In supports enhancements to the standard functions of section numbers in sections II 

and III. 

For an overview of the possible enhancement methods, see this text. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. 

Then activate the BAdI implementation. 

The following methods exist: 

- NUMBER_INPUT - Conversion of the section number at the time of entry. The 

method is called when a section number is entered on the screen. 

- NUMBER_OUTPUT - Conversion of the section number at the time of output (from 

the internal representation to the screen). 

The method is called when a section number is output on the screen. 



 

 

The implementation of the methods has to be independent of the interface. It is not allowed to contain any 

COMMIT WORK or ROLLBACK WORK statements. 

For example, direct output of messages using the MESSAGE statement, without using the existing 

exceptions, is not allowed. 

Example 

For a sample implementation that shows the conversion of section numbersas in the LUM add-on, 

see the class CL_EXM_IM_RELM_NUMBER_SECNO. Notes for Developers 

 Allow Manual Entry of Ranking Numbers for Sections II and 

III 

Use 

In the land register, the system automatically calculates the ranking numbers in Sections II and 

III. You can only influence the ranking number indirectly by means of the fields 'Rank Before Sequence 

Number inSection' or 'Add Rank to Current Section Number'. It is not possible foryou to enter the ranking 

number directly. 

The BAdI BADI_RELM_LR_RANKINGNO makes it possible to enter the ranking number manually. To 

activate this BAdI, implement the method 

IS_RANKINGNO_FILLED_MANUALLY. The parameters of the method have the following meanings: 

- IO_OBJECT is an import parameter and contains an object reference to theland register. 

- CF_MANUALLY is a changing parameter. If it is set to ABAP_TRUE, then youcan enter the 

ranking number directly. 

The example implementation in class CL_EXM_IM_RELM_LR_RANKINGNO shows how you can 

control the option for manually entering the ranking number dependent on the land register district. 

Notes for Developers 

 Define Custom Search Methods for Search Strategies 

Use 

Here you define your own custom search methods. You can then process thecorresponding 

implementations for them using a BAdI. For more information, see Implement/Activate Search Methods 

for Search Strategies. 

Standard settings 
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Some methods are predefined in the system. However, they only deliver the expected results when the 

sample code of the BAdI is activated. 

Activities 

If the predefined search methods are not sufficient to meet your needs, you can define your own methods. 

Choose names for your methods that begin with the letter Y or Z. 

You can assign one method to several search fields. However, doing so makes sense only if the search 

fields point to the same domain (for example, the land registry and the agency responsible for the parcel, 

since both are business partners). 

In addition, specify the following for the search method: 

- A descriptive name 

- The search help for the differentiation criterion (when entering allowed values) 

- The type of the method 

Then implement the BAdI for the search method. 

 Implement/Activate Search Methods for Search Strategies 

Use 

This BAdI can be used to define your own search methods for a search strategy. Search methods are each 

assigned to a search strategy. The BAdI method that is used depends on the type of search method that is 

entered for the method in table TIVCASHMETH. The following applies: 

Type SPACE - Single Value Method, Values Are in VICASHFVALUES-SHMETHDIFF  

There is no BAdI call, the values for the search strategy are entered directly in table 

VICASHFVALUES. 

Type  - Search Strategy + Possibly Object Data => (Program) Values The BAdI determines the 

possible values solely from the name of the of search strategy and possibly from the object data. 

BAdI method to be implemented: GET_VALUES  

Type   Search Strategy =>SMETHDIFF => (Program) Values 

First a differentiation criterion is determined for the search strategy from the value table 

VICASHFVALUES. The BAdI then determines the possible values from this differentiation criterion, 

possibly dependent on the object data and the name of the search strategy. BAdI method to be 

implemented:  GET_VALUES_FOR_SHMETHDIFF  

Type   Object Data => (Program) SMETHDIFF => (VICASHFVALUES) Values  



 

 

The BAdI determines a differentiation criterion from the object data and possibly from the name 

of the search strategy. The values for this differentiation criterion are then read from table 

VICASHFVALUES. 

BAdI method to be implemented: GET_SHMETHDIFF   Search 

strategies are used in the following contexts: 

- One-Time Postings: 

Vendor search field (VENDOR) and service charge key ( SCSCKEY ) 

The search strategy is determined from the Customizing settings for the posting activity 

(VENDOR) or for a specific item of the posting activity(SCSCKEY). An object reference is not 

transferred. 

- Master Data of Parcel: 

Search fields for main contractual partner (PARCOFF) and for all hierarchical locations 

(LOCHIER). The object reference of the parcel is transferred. 

For the LOCHIER search field, the location structure of the hierarchicallocation you are searching 

for is also in the ID_CONTEXT field. 

- Master Data of Land Register: 

Search fields for land registry (LROFFICE) and for the hierarchical location ( LOCHIER ). 

The object reference of the land register is transferred. 

For the LOCHIER search field, the location structure of the hierarchicallocation you are searching 

for is also in the ID_CONTEXT field. 

The following applies to the search fields for the land register and parcel: 

For each search field, only one search strategy is allowed to be designated as active. 

Activities 

Depending on the type of search method, implement one of the  methods: 

- GET_VALUES 

- GET_VALUES_FOR_SHMETHDIFF 

- GET_SHMETHDIFF 

Description of parameters: 

Method GET_VALUES and GET_SHMETHDIFF: 

FLT_VAL 
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Search method 

IO_REF_OBJ   

Reference to the real estate object that is currently being processed. The reference is empty when the call 

is from posting activities. For theland register, the reference contains a reference to the land register 

master data; and for parcels, a reference to the parcel master data. 

The BAdI method can retrieve the current object data using the API that belongs to it. 

ID_CONTEXT   

For the LOCHIER search field, contains the location key of the hierarchical location being searched for; 

otherwise it is empty. 

IS_SHSTRAT   

Contains certain Customizing data for the active search strategy 

IS_SHFIELD   

Contains the system Customizing data for the current search field 

CT_VALUES  

The result of the search is to be placed in this table. The KEY field has to be filled with the determined 

key of the search field. The text for it does not have to be entered. For methods of type , the value of the 

search field is not entered. Instead the differentiation criterion, which should be used to search in 

VICASHFVALUES, should be filled. In this case, wildcard characters ('%') are allowed for a search for 

similar values. 

CD_DEFAULT_VALUE 

If a default value was determined, it can be returned here. The default value is set when the value of the 

field, for which the search help was called, was initial at the time of the call. 

CF_OTHER_VALUES_ALLOWED 

This value should be returned as TRUE, if you want to have an option to choose "Other Values" in the 

search dialog box, in addition to the search result. If the user chooses this option, then the system calls the 

standard search help. The value does not influence whether the system checks the result of the search help 

(normally there is no check). 

Method GET_VALUES_FOR_SHMETHDIFF 

In addition to the parameters of GET_VALUES, the values that are maintained in the value table for the 

search strategy are also transferred to table IT_SHVALUES. 



 

 

Example 

Example class CL_EXM_IM_RECA_SEARCH_METHOD contains examples for the following 

search methods: 

Type  - Search Strategy + Possibly Object Data => (Program) Values  

GET_VALUES for LOCHIER search method 

The hierarchical location of the parcel is derived from hierarchical locations to other location structures 

that are already entered in the system. A value is allowed here if the same text is entered for this location 

in Customizing. 

GET_VALUES for PARTNR search method 

The prerequisite here is that there is external number assignment for land registries ( land register) and 

for the main contractual partner (survey office or responsible agency) of the parcel. 

The partner number of the land register corresponds to the land registerdistrict; the number of the 

survey office corresponds to the first  characters of the leading hierarchical location. This method 

might need to be adjusted to agree with the practices of your company regarding partner numbers. For 

example, it is possible thatthe partners could all have a prefix in the number, such as LR for land 

registry. 

GET_VALUES for ADDR search method 

The assumption here is that the postal code of the land registry corresponds to the land register district. 

All land registries, where postal code = land registry, are offered for selection. For the parcel, the system 

searches for a partner with the "Responsible Agency" role, where the city agrees with the text of the 

hierarchical location of the parcel. 

Type   Search Strategy =>SMETHDIFF => (Program) Values 

GET_VALUES_FOR_SHMETHDIFF for ROLE search method 

This search method is appropriate for the VENDOR search field. The search method returns all vendor 

numbers of partners for the role that are maintained in the value table for the search strategy. 

For example, if you create your own role for insurance, you can assign a search strategy with this search 

method to a posting activity for "insurance costs". 

Type  - Object Data => (Program) SMETHDIFF => (VICASHFVALUES) Values 

GET_SHMETHDIFF for VALREG search method 

You can use this search method when the land registries for the land register district are entered in the 

value table. The search method determines the land register district for the current land register, or for the 

first  characters of the hierarchical location of the current parcel. 

Notes for Developers 
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 Italy 

 Tax Calculation for Italy 

 Basic Information 

Use 

In these IMG activities, you set up the system so that you can enter the data required for the calculation of 

the following three taxes in Italy: 

- Property tax - ICI/IMU 

- Registration tax - IRE 

- Stamp Tax - IB 

Requirements 

Before you carry out the IMG activities as listed for each type of tax, you have to first activate the 

country Italy in the IMG activity Activate Country-Specifics in order for country-specific program code 

for Italy to be implemented. 

Furthermore, you also have to set up VAT tax summarization for all Italian company codes by carrying 

out the IMG activity Activate Document or Tax Summarization in Company Code. 

When you have made these basic Customizing settings, you can then proceed to make the settings 

required for each type of tax as listed under the relevant nodes. 

 Master Data 

 Define Control Parameters for Property Tax and Service Tax 

Use 

In this Customizing activity, you can set the following two control parameters: 

- You can specify  the measurement type for the occupied part of a usage object for service tax. 

- You can specify the source of the usage object that is assigned to the architectural object. 

The system uses the Usage tab page in the architectural object as a source. 

Note: 

You must decide whether you want to manually assign usage objects on the IMU Data tab page in 

the architectural object, or you want the system to use the objects that are assigned to the 

architectural object on the Usage tab page. In this Customizing activity,  in the Assigned Object 

from Usage Tab Page in AO field, you can choose which object source you want to use. This setting 

is relevant for the master data of both the property tax and service tax. 



 

 

 Property Tax ( ICI/IMU ) 

 Basic Information 

Use 

In these IMG activities, you set up the system so that you can enter the relevant ICI/IMU data required for 

the ICI/IMU tax calculation, according to Italian requirements. 

Requirements 

Before you carry out the IMG activities specifically for Italian ICI/IMU tax calculation, you have to carry 

out the following standard Real Estate IMG activities: 

- Create Architectural Object Types. In this activity, you create the architectural object type 'Cadastral 

entry', with the following naming convention: Ixx, for example, ICI. Note: you have to set 'Locality' 

as the high level object type. 

If you have not defined 'Cadastral entry' as the top level, you also have to carry out the following standard 

IMG activities: 

- Define Allowed Object Type Hierarchy 

- Specify Rule for Determining Object ID 

- Functions per Architectural Object Type 

Activities 

Carry out these standard IMG activities and the ICI/IMU-specific IMG activities in the order in which 

they are listed. 

 Maintain Cadastral Category Descriptions 

Use 

In this IMG activity, you enter the cadastral categories and corresponding descriptions that you receive 

from the cadastral office. 

For the calculation types AF (building area) and TA  (building), you have to create dummy cadastral 

categories AF and TA respectively. 
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 Maintain Cadastral Categories 

Use 

In this IMG activity, you enter your cadastral data using the cadastral categories that you receive from the 

cadastral office. 

Requirements 

You have carried out the IMG activity Maintain Cadastral Category Descriptions. 

Activities 

For each cadastral category, enter the following data: 

- Valid from year 

- Percentage increase 

- Category coefficient 

If the rental object is residential, you also have to select the Residential checkbox. This is required for 

the tax calculation procedure because particular tax rates have to be used for non-rented residentials. 

Note for ICI Tax Only: 

When you enter the percentage increase and category coefficient of a historical object to the activity, you 

must enter the data to the following columns: 

- Percentage Increase for Historical Objects 

- Category Coefficient for Historical Objects 

For the IMU tax calculation, you must leave these fields empty. 

 Maintain City Parameters 

Use 

In this IMG activity, you enter the parameters for calculating property tax (ICI/IMU). These parameters 

depend on the city in which the building is situated. 

Requirements 

The name of the city must be exactly the same as in the address of the building. 

Activities 



 

 

Enter the following data: 

- Name of the city 

- Account number 

- Tax collection agency 

- Period in months 

 Maintain City Rates 

Use 

In this IMG activity, you enter the city rates defined by the cadastral office. 

Requirements 

You have carried out the IMG activities Maintain City Parameters and Maintain Cadastral Categories. 

Activities 

Enter the following data: 

- Valid from year 

- City code (or city name) 

- Category ID - if no category ID is defined, the ICI/IMU tax rates are valid for all possible 

category IDs, if the '*' value is entered 

- ICI/IMU tax rate 

- Normal tax rate (for rented units in case of residential categories; this rate is always applied if 

no reduction is specified) 

- Long vacancy rate (for non-rented units after a specific number of months) 

- Short vacancy rate (for non-rented units within a specific number of months) 

- Reduced rate (applied in case of a reduction reason with reduction rate ##) 

- Reduced rate  (applied in case of a reduction reason with reduction rate ##) 

- Reduced rate  (applied in case of a reduction reason with reduction rate ##) - Vacancy rate 

and the long vacancy rate Note: 

The system selects the ICI/IMU tax rate for a city from the latest year and for the required category ID. If 

the category ID has not been defined, the system determines the ICI/IMU tax rate based on an entry with 

category ID * from the latest year. 
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 Assign Reduction Rates to Reduction Reasons 

Use 

In this Customizing activity, you define reduction reasons and assign the relevant reduction rates to them. 

Requirements 

You have defined reduction rates in the Customizing activity Maintain City Rates. 

Example 

Reduction ID Description Reduced Rate 

SC Rental object used for social purposes  (this refers to the rate 

that you have entered in the Reduced Rate field in the Maintain City Rates activity) 

SA Rental object for sale  (this refers to the rate that you have entered in the Reduced Rate  

field in the Maintain City Rates activity) 

 Maintain Payment Installments 

Use 

In this IMG activity, you enter data for the minimum amount of property tax and the due dates. 

Activities 

Enter the following data: 

- Tax year 

Note: 

If you enter the year in this field and then you select the Year of IMU Validity checkbox, the system 

considers the year as the validity year of the IMU tax. If you do not select the checkbox, the system 

uses the IMU data as of the given year. 

- The first and second due dates 

- The share of the first installment as a percentage 

- The minimum tax amount 

- Rounding value 



 

 

- Display negative balance for ICI/IMU tax amount 

- You can select the % Split checkbox, if you want the system to split the calculated tax amount into 

two equal parts between the down payment and the balance payment, even if the cadastral object is 

closed before the end date of the down payment. 

 Maintain Coefficients for Building Category 'D' 

Use 

In this IMG activity, you enter the annual revaluation coefficients for the valuation of D-buildings. 

Activities 

Enter the year and corresponding coefficient. 

 Communal Service Tax ( TASI ) 

 Settings for Service Tax 

Use 

Before you make Customizing settings for the communal service tax (TASI), make the following 

prerequisite settings: 

- In the Maintain Cadastral Category Description Customizing activity, you can select the TASI 

Exemption checkbox if your real estate object is exempted from service tax payment. 

- In the Define Control Parameters Customizing activity, define control parameters as described in the 

Customizing documentation. 

You can then make the required settings for processing service tax in the following Customizing 

activities: 

- Define Default Service Tax Rates 

- Define City Rates 

- Define Payment Installments 

- Define Settings for Contract Types 

 Define Default Service Tax Rates 

Use 
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In this Customizing activity, you can enter a general tax rate that is defined by law/government that the 

system can use for the communal service tax (TASI) calculation by default. The system applies the 

default tax rate only if there is no city rate defined in the given city. 

The following service tax rates are defined by the government: 

- Default tax rate for rental objects that have a contract 

- Default tax rate for rental objects that do not have a contract 

- Maximum tax rate 

The sum of the property tax (IMU) and the service tax (TASI) rates cannot exceed the maximum 

rate. 

- Default percentage of service tax that the owner of the rental object must pay This applies only 

when the rental object is leased out and the contract validity exceeds  months. In such a case, the 

owner and the tenant split the service tax amount in a percentage that the government defines. 

In this Customizing activity, enter the validity year of the service tax and enter the default tax rates and 

the percentage of the tax amount that the rental object owner must pay in case the tax amount is split 

between the owner and the tenant. If the tax rates are valid only ofr one year, select the Validity Year 

checkbox. If you do not select it, the system uses the entered tax rates as of their validity year. 

If there are service tax rates defined by cities that differ from the default tax rates, the system applies the 

city rates for the service tax calculation. You can enter the service tax rates defined by cities in the Define 

City Rates Customizing activity. 

 Define City Rates 

Use 

In this Customizing activity, you enter the tax rates for the communal service tax ( TASI ) calculation 

that are defined by the cities.  If there are no service tax rates defined in a city, the system uses the 

default service tax rates that the government defines. You can enter the default service tax rates in the 

Define Default Service Tax Rates Customizing activity. 

The cities can define service tax rates for rented and not rented real estate objects that are based on the 

value of the real estate object (see section Example below). If a city does not define different tax rates 

based on the value of the real estate object, create an entry with value  ( zero ). 

For each city, enter the validity year of the service tax, assign the city, category ID, and a contract type. 

After that, enter the value ranges of real estate objects if the city has defined different rates, and then enter 



 

 

the tax rates that are valid in the given city. After that, enter also the percentage of the tax amount that the 

rental object owner must pay in case the tax amount is split between the owner and the tenant. 

Example 

The city can define service tax rates as follows: 

Value of real estate object Rate of Rented Rate of Not Rented 

,   

,   

,   

This means the following: 

- If the value of the real estate object is between EUR , and EUR ,, the system applies the % as the 

service tax rate if the real estate object is rented, and % as the service tax rate if the real estate object 

is not rented. 

- If the value of the real estate object is between EUR , and EUR ,, the system applies the % as the 

service tax rate if the real estate object is rented, and % as the service tax rate if the real estate object 

is not rented. 

- If the value of the real estate object is above EUR ,, the system applies the % as the service tax rate 

if the real estate object is rented, and % as the service tax rate if the real estate object is not rented. 

 Define Payment Installments 

Use 

In this Customizing activity, you define the due dates (date and month) of the first installment and 

balance (second installment) payments of the service tax in a given calendar year. 

You can select the % Split checkbox, if you want the system to split the calculated tax amount into two 

equal parts between the down payment and the balance payment. 
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 Define Settings for Contract Types 

Use 

In this Customizing activity, you can make the following settings for contract types: 

- If you select the Short Term checkbox, the system always applies the service tax rate that is defined 

for not rented real estate objects when the service tax is calculated for those real estate objects that 

are rented, but their contract validity is equal to or less than  months in the fiscal year. 

If you do not select the checkbox, the system always applies the service tax rate that is defined for 

rented real estate objects whose contract validity is more than  days. 

- If you must always apply the service tax rate that is defined for not rented real estate objects, select 

the Not Rented checkbox. In this case, the system does not consider the contract validity at all when 

calculating the service tax. 

 Registration Tax ( IRE ) 

 Basic Information 

Use 

In these IMG activities, you set up the system so that you can enter the relevant data for the IRE 

registration tax calculation, according to Italian requirements. 

Activities 

Carry out the IMG activities in the order in which they are listed. 

 Maintain Company Code Dependent Registration Tax 

Parameters 

Use 

In this Customizing activity, you maintain company code-dependent parameters for calculating 

registration tax ( IRE ). 



 

 

Activities 

You specify the company code and then indicate if you want to exclude transfers from the calculation of 

registration tax. You select the Exclude Transfers checkbox to exclude transfers of ownership and 

tenancy for the specified compant code. Transfer records will no longer be generated for the company 

code. 

 Maintain Registration Tax Rates 

Use 

In this Customizing activity, you define registration tax (IRE) rates for rental object codes. 

You additionally specify whether the tax authorities allow a certain amount of deduction in case of one-

time payment, and you enter the base condition group that contains all the condition types that are 

relevant for IRE calculation. 

Requirements 

You have defined the base condition group in the Customizing activity Define Condition Groups and 

Assign Condition Types. 

 Maintain Tax Codes for Rental Object Codes 

Use 

In this Customizing activity, you assign tax codes to rental object codes and you specify the type of 

payment. 

Requirements 

You have maintained: 

- The rental object codes in the Customizing activity Maintain Registration Tax Rates 

- The tax codes in the Customizing activity Maintain Tax Code Descriptions 

Activities 

1. Enter the rental object code and its corresponding description. 

2. Specify the parameter that defines whether the tax code is for one-time payment or annual payment. 

3. Specify the tax code. 
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Example 

Rental Object Code Tax Code Det. Parameter Tax Code 

  - One-time payment  T  

 R - Renewal  T  

  - One-time payment  T  

 B - Annual payment-Beginning Year  T 

 

... 

I - Annual payment-Intermediate Year  T 

 B - Annual payment-Beginning Year  T 

 Maintain Calculation Types 

Use 

In this Customizing activity, you define the calculation types that can be used for IRE tax. 

Activities 

Enter an ID and corresponding descriptive text for each calculation type, and select the required 

attributes. 

Note: 

If you use the calculation type for both one-time payment and annual payment, proceed as follows: 

- Enter the calculation type ID and corresponding descriptive text for annual payment 

- Copy the row 

- Select the One-Time Payment checkbox and change the calculation type ID and text accordingly 

Example 

For the calculation type  Contract without VAT, no specific attributes are required. For the calculation 

type  Contract with VAT, you have to select the checkbox for the attribute VAT Included. 

 Maintain Tax Code Descriptions 

Use 

In this Customizing activity, you enter the tax codes that can be used for IRE tax calculation, with a 

corresponding descriptive text, and also specify if the tax code is the main or an additional tax code. 



 

 

 Maintain Time Dependent Parameters 

Use 

In this Customizing activity, you enter the variables that influence the calculation of registration tax 

(IRE), based on a validity date. 

Activities 

Enter the following data: 

- Validity date as of which the parameters take effect 

- Minimum registration tax amount 

- Fixed value for registration tax in case of premature termination 

- Advance Resolution 

- Reduction percentage 

- Rounding value 

- Payback percentage 

- Deduction percentage of one-time payment 

 Maintain Register Office Master Data 

Use 

In this IMG activity, you enter the code to identify the relevant register office and the corresponding 

county name. 

 Select Reason for Notice Relevant to Transfer of Ownership 

Use 

In this Customizing activity, you define reasons for notice relevant to transfer of ownership. 

Requirements 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 585 

You have entered all the reasons for notice that are related to Italy in the Customizing activity Notice 

Reasons. 

 Stamp Tax 

 Maintain IB Stamp Tax Parameters 

Use 

In this Customiying activity, you enter the parameters for calculating stamp tax as defined by the register 

office and as required by your business practice. This is required so that you can determine and post the 

correct amount of stamp tax to the correct account if the value of postings exceeds the minimum value 

set. 

You reverse the invoice or you can send a credit memo with partial or total amounts. 

In case of credit memos, the company must pay the stamp tax of the credit memo. Particularly in case of 

total credit memos, you (as a company) must pay back the stamp tax to the customer. 

Requirements 

You have made the required settings in: 

- Edit G/L Account Centrally 

- Assign Account Symbol to Flow Type 

Example 

An example of the accounting process in case of credit memos: 

Normal invoice (base amount is higher than EUR ): 

Debit Credit Amount 

Customer/tenant Stamp tax account EUR  

Reversal (of invoices the base amount of which is higher than EUR ): 

Debit Credit Amount 

Customer/tenant Stamp tax account EUR  

Partial credit memo: 

Debit Credit Amount 

Expenses account 

Total credit memo: 

Stamp tax account EUR  

Debit Credit Amount 



 

 

Expenses account Stamp tax account EUR  

Expenses account Customer/tenant EUR  

 Define Tax Groups Relevant to Stamp Tax ( IB ) 

Use 

In this IMG activity, you define the tax groups that should be relevant to stamp tax by selecting the Stamp 

Tax Relevancy to Tax Groups indicator. 

In Italy, stamp tax is known as Imposta di Bollo. 

Requirements 

You have defined all the allowed tax groups in the IMG activity Create Tax Groups. 

 Accrual/Deferral Posting 

 Implementation: Exclusion of Not Posted Cash Flow Items 

Use 

You can use this Business Add-In (BAdI) implementation to meet the legal requirements of deferral 

posting in Italy, that is, if there is no revenue posted on the key date in a contract, you must not post any 

deferrals in the given month of the validity period. 

By activating the BAdI, the Accrual Engine (RERAALCN) checks on the key date whether you have 

already posted any revenue with the Periodic Posting: Contracts (RERAPP) program in the contract. If 

there was no revenue posted, the accrual engine does not calculate and post deferrals. 

When you post revenue within the validity period later on, the next time you run the accrual engine, the 

program considers the revenue posting and calculates and posts deferrals retroactively to the previous 

month(s) of the validity period. 
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 Japan 

 Service Charge Settlement Based on Fixed Unit Prices 

 Define Rounding Type for Company Code 

Use 

In this IMG activity, you can assign the following rounding types to the company code: 

- Commercial 

- Round up 

- Round down 

The system uses these rounding types to calculate the distributed consumption costs based on fixed unit 

prices. 

The rounding is applied on the sum of the expenses calculated based on fixed unit prices. 

 Define Flow Types for Posting Fixed Unit Price Based Costs 

Use 

In this IMG activity, you define the flow types for service charge keys with the relevant company code 

necessary for posting the costs calculated with the fixed unit price before the standard service charge 

settlement. Flow types are used to determine cost and tax account numbers for additional postings in the 

Distribute Consumption Costs Based on Fixed Unit Prices program. 

Requirements 

You have defined 

- Service charge keys in the IMG activity Define Service Charge Keys. You must define here the 

Direct Cost Posting parameters (RO - Directly Assignable to Account or SU Assignable to 

Account) 

- Flow types in the IMG activity Define Flow Types 



 

 

 Business Add-Ins ( BAdI ) 

 Implementation: Cost Determination for SCS 

Use 

You can use this Business Add-In (BAdI) implementation to determine the type of collected costs for 

service charge settlement. 

You must activate this BAdI implementation so that the system can collect the consumption costs that 

are based on fixed-unit prices and calculated by the Pre-Step transaction. If you do not activate the BAdI 

implementation, the system collects the consumption costs from Financial Accounting ( FI ). 

Requirements 

If you activate this BAdI implementation, you must also activate the BAdI implementation Cost 

Distribution for SCS. 

 Implementation: Cost Distribution for SCS 

Use 

You can use this Business Add-In (BAdI) implementation to distribute the consumption costs defined by 

cost determination. The system distributes the costs among the real estate objects involved in service 

charge settlement. 

Requirements 

If you activate this BAdI implementation, you must also activate the BAdI implementation Cost 

Determination for SCS. 

 Payment Report for Real Estate Charges 

 Basic Form Settings 

 Define Form Settings 

Use 
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In this IMG activity, you can specify the name and the content structure name of the specific form. The 

settings for this IMG activity are required for the generation of the PDF output. 

Note 

SAP delivers standard forms and interfaces for the legal forms. Use this activity if you want to replace the 

forms or interfaces or if you want to define new legal forms. 

Activities 

1. Define the form settings for your report. 

2. Define the company-specific settings for the different forms, for example, name of context, name of 

PDF interface, name of layout in the IMG activity Define Company-Specific Form Settings. 

Example 

The following table is an example of the settings for forms specific in Japan. 

Legal Form Name Description of the Form DDIC Structure Name 

FORM Forms - (RE-FX Japan) REXCJP_F 

PYMNTREP Payment Report (RE-FX Japan) RE_T_REXCJP_PDF_PAGE 

 Define Company-Specific Form Settings 

Use 

In this IMG activity, you maintain and create company-specific legal forms. 

Note 

SAP delivers standard forms and interfaces for the legal forms. Use this activity if you want to replace the 

forms or interfaces or if you want to define new legal forms. 



 

 

Requirements 

You have defined the: 

- Forms in the IMG activity Form Builder for PDF-Based Forms 

- Form settings for the relevant form in the IMG activity Define Form Settings 

Example 

The following table is an example of the settings for forms specific in Japan. 

CoCd Legal Form Name Form Interface 

JP FORM REXCJPFORM REXCJPFORMIF 

JP PYMNTREP REXCJP_PAYMENTREPORT REXCJP_PAYMENTREP 

ORTIF 

 Define Payment Categories 

Use 

In this IMG activity, you can define payment categories used in Japan, for example, security deposits, 

maintenance fees, premiums, renewals. 

Activities 

1. Define the payment categories for real estate charges in the IMG activity Define Payment 

Categories. 

2. Allocate the payment categories to flow types in the IMG activity Assign Payment Categories to 

Flow Types. 

 Assign Payment Categories to Flow Types 

Use 
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In this IMG activity, you can assign the payment categories to the flow types. 

Requirements 

You have defined the: 

- Payment categories in the IMG activity Define Payment Categories 

- Flow types in the IMG activity Define Flow Types 

 Define Company-Specific Data for Payment Report 

Use 

In this IMG activity, you can maintain information about the real estate company. The system displays 

this information in the output of thePayment Charge Report. 

Activities 

This activity allows you to: 

- Maintain information about the tax office that your company belongs to, as required by the tax 

authorities in Japan 

- Specify thepayment limit for reporting 

- Maintain information about the reporting office of the real estate company to be displayed in the 

report output 

- Specify whether you want the agent commission to be included in the Payment Charge Report 

- Specify the agent commission limit for reporting 

 Define Grouping Order for Payment Charges 

Use 

In this Customizing activity, you define the sequence of the relevant data that appear in the output of the  

Payment Charge Report. You can additionally define for which data you want the report to create a new 



 

 

table, such as for each vendor ID or agent, in the PDF-based output form or to create a new row in the 

ALV list of the output lines. 

If you do not select the Create Table checkbox, the report only creates new payment information in the 

ALV list of the output lines, and a new row in the PDF-based output form. 

If you do not define the grouping order in this Customizing activity, the report uses the following 

grouping order: 

- Company Code 

- Agent 

- Vendor 

- Payment Category 

- Object Number 

Note: 

If you want to define the grouping order of the basis of calculation and details values, you must 

implement the relevant BAdI method to specify values for the basis of calculation and the details as 

described in  BAdI: Maintenance of Payment Charges. 

 Business Add-In ( BAdI ) 

 Notes on Implementation 

Use 

All Business Add-Ins that are grouped under this structure node belong to the enhancement spot 

REXCJP_PAYMENTREP_ENH_SPOT. In this enhancement spot, you can implement the 

BADI_REXCJP_PAYMENTREP BAdI definition. 

You use this enhancement to define your own fields that the system displays in the ALV and PDF output. 

Note! 

SAP delivers this enhancement with an example implementation. You can use this example 

implementation for defining your own settings. 
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Activities 

1. Modify the ABAP Dictionary elements. 

You can make the modifications by customer includes or append structures. You need to make sure 

that you add the new fields paralelly to both ALV and PDF with the same name and type. 

2. Implement the Business Add-In. 

Use the delivered example implementation for this purpose. For your implementation, use your own 

namespace (Z*). 

3. Modify the PDF context and  layout. 

For more information about modifying the PDF form in the SAP Library, see Interactive 

Forms based on Adobe Software 

(http://help.sap.com/saphelp_erpvp/helpdata/en/c/ebacaadbfbb /frameset.htm). 

 BAdI: Maintenance of Payment Charges 

Use 

This Business Add-In (BAdI) is used in the Flexible Real Estate Management ( RE-FX ) component in 

Japan. 

You can use this BAdI to modify or validate the content of the Payment Charge Report. 

The BAdI offers different methods that allow you to: 

- Propose default values for the selection parameters 

- Check and modify the user input 

- Make final modifications in the content of the legal form after data selection 

- Replace the business partner category for a business partner 

- Specify values for the basis of calculation and the details for a given payment data 

- Calculate the value of the total agent commission paid by a given landlord for a given agent 

Standard settings 

In the standard system, there is no activated BAdI implementation. 

Activities 



 

 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

Example 

To display the sample code, choose Goto -> Sample Code -> Display. 

See also: 

This BAdI uses the interface REXCJP_PYMNTREP_BADI_INTERFACE.  For more information, 

display the interface in the Class Builder. 

 Lease-Out Offices in Mega Cities 

 Basic Form Settings 

 Define Form Settings 

Use 

In this IMG activity, you can specify the name and the content structure name of the specific form. The 

settings for this IMG activity are required for the generation of the PDF output. 

Note 

SAP delivers standard forms and interfaces for the legal forms. Use this activity if you want to replace the 

forms or interfaces or if you want to define new legal forms. 

Activities 

1. Define the form settings for your report. 

2. Define the company-specific settings for the different forms, for example, name of context, name of 

PDF interface, name of layout in the IMG activity Define Company-Specific Form Settings. 

Example 

The following table is an example of the settings for forms specific in Japan. 
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Legal Form Name Description of the Form DDIC Structure Name 

FORM Forms - (RE-FX Japan) REXCJP_F 

PYMNTREP Payment Report (RE-FX Japan) RE_T_REXCJP_PDF_PAGE 

 Define Company-Specific Form Settings 

Use 

In this IMG activity, you maintain and create company-specific legal forms. 

Note 

SAP delivers standard forms and interfaces for the legal forms. Use this activity if you want to replace the 

forms or interfaces or if you want to define new legal forms. 

Requirements 

You have defined the: 

- Forms in the IMG activity Form Builder for PDF-Based Forms 

- Form settings for the relevant form in the IMG activity Define Form Settings 

Example 

The following table is an example of the settings for forms specific in Japan. 

CoCd Legal Form Name Form Interface 

JP FORM REXCJPFORM REXCJPFORMIF 

JP PYMNTREP REXCJP_PAYMENTREPORT REXCJP_PAYMENTREP 

ORTIF 

 Define Settings for Tax Office 

Use 



 

 

In this IMG activity, you need to make the settings as required by the tax office. You can: 

- Round the floor area data according to the rounding algorithm required by the tax office 

- Define the decimal length of the measurements for rounding 

- Maintain the layout of  forms for buildings (in Tokyo: Form -) and offices (in Tokyo: Form -) 

- Group of the office data after rental objects or after tenants 

Requirements 

You have assigned the tax office role for the business partner in Maintain Business Partner. 

Activities 

Select a business partner, which has a tax office role and make the required Customizing settings 

described above. 

 Define Kanji and Katakana Name Locations 

Use 

In this IMG activity, you can maintain the location of the Kanji/Katakana names in the master data. The 

information that you define in this activity, allows the system to select the Kanji and Katakana names for 

the Lease-Out Offices in Mega Cities report. 

Activities 

- Assign the location of the Kanji and Katakana names for the company code as used in the company. 

- Assign the location of the Kanji and Katakana names for the business partners as used in the 

company. 

Example 

The Kanji name is located in the Name field and the Katakana name is located in the Name field of the 

company code. 
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 Define Company-Specific Data for Lease-Out Offices in Mega Cities 

Use 

In this IMG activity, you can maintain information about the real estate company. The system displays 

this information in the output of Lease-Out Offices in Mega Cities legal form. 

Activities 

For each company code, maintain the information about the president, contact person, and own business 

partner at the company. 

 Assign Measurement Types to Measurement References 

Use 

In this IMG activity, you define the measurement types that you need to display the floor area data in the 

output of Lease-Out Offices in Mega Cities. 

Requirements 

You have defined the measurement types for the floor area, in the IMG activity Define Measurement 

Types. 

Activities 

Assign the relevant measurement reference, for example, total room for business usage, common floor 

area lent to a tenant, total room for common floor area, common portion floor area in a shared building 

and so on to the measurement type. Then the system displays this data for the floor area in the output of 

Lease-Out Offices in Mega Cities. 

 Business Add-In ( BAdI ) 

 Notes on Implementation 

Use 



 

 

All Business Add-Ins that are grouped under this structure node belong to the enhancement spot 

REXCJP_FORMS_ENH_SPOT. In this enhancement spot, you can implement the 

BADI_REXCJP_FORMS BAdI definition. 

You use this enhancement to define your own fields that the system displays in the ALV and PDF output. 

Note! 

SAP delivers this enhancement with an example implementation. You can use this example 

implementation for defining your own settings. 

Activities 

1. Modify the ABAP Dictionary elements. 

The following table shows an example of how to modify the ABAP Dictionary elements. You can 

make the modifications by customer includes or append structures. You need to make sure that you 

add the new fields paralelly to both ALV and PDF with the same name and type. 

Type Header Detail 

PDF REXCJPF_FSD REXCJPF_STL 

ALV REXCJPF REXCJPF 

2. Implement the Business Add-In. 

Use the delivered example implementation for this purpose. For your implementation, use your own 

namespace (Z*). 

3. Modify the PDF context and  layout. 

For more information about modifying the PDF form in the SAP Library, see Interactive 

Forms based on Adobe Software 

(http://help.sap.com/saphelp_erpvp/helpdata/en/c/ebacaadbfbb /frameset.htm). 

 BAdI: Maintenance of Forms for Lease-Out Offices in Mega Cities 

Use 

This Business Add-In (BAdI) is used in the Flexible Real Estate Management ( RE-FX ) component in 

Japan. 

You can use this BAdI to modify or validate the content of the Lease-Out Offices in Mega Cities legal 

form. 

The BAdI offers different methods that allow you to: 

- Propose default values for the selection parameters 

- Check and modify the user input 
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- Make final modifications in the content of the legal form after data selection 

Standard settings 

In the standard system, there is no activated BAdI implementation. 

Activities 

For information about implementing BAdIs as part of the Enhancement Concept, see SAP Library for 

SAP NetWeaver under BAdIs - Embedding in the Enhancement Framework. 

Example 

To display the sample code, choose Goto -> Sample Code -> Display. 

See also: 

This BAdI uses the interface REXCJP_FORMS_BADI_INTERFACE.  For more information, display 

the interface in the Class Builder. 

 China 

 Contract Version Management 

 Maintain Fields Used in Contract Comparison with Display Order 

Use 

In this Customizing activity, you can change the display order of the results of contract comparison 

reports by manually entering the display order for key names in the required order in this activity. The 

display order you configure here is used in the layout of a Simple Contract Comparison Report, or a 

Detailed Contract Comparison Report. 

Activities 

1. In the Header table column, select a header field. 



 

 

The Header table column in this activity corresponds to the Tab Description in a contract 

comparison report. This information is displayed as a tab page element, such as: a tab page name, 

table name, or table values, and so on; on a tab page in a real estate contract. 

2. In the DispOrder column, for each Key name that you want to configure the order for, enter a 

numeric value for the corresponding Key name in the order as you want the system to display the 

data. 

The Key Name column in this activity corresponds to the Key Info column in the contract 

comparison report. This information is displayed as fields on a tab page in a real estate contract. 

The key name can be an element, for example, can be a tab page name, a table name, or a parameter 

within in a table. 

You can check the key names within a header table parameter, in transaction SE or in transaction 

SE, calling the BAPI_RE_CN_GET_DETAIL function module. 

After you run a contract comparison report, the Key Info data in the report result is displayed in the 

sequence in which it was configured. 

Caution: We recommend that you do not delete or modify any other fields in the table ( such as fields in 

the Header table or Key Name columns). Doing so may cause the application to behave unexpectedly. 

Example 

Use 

 Maintain Change Reason for Contract Version 

Use 

In this Customizing activity, you register the change reason in the system. The change reason states the 

reason for the change to an original contract. 

This change reason is displayed when you view the contract version history, and when you view the 

contract details on the Original Contract tab page of a real estate contract ( transaction RECN). 

Activities 

Registering a change reason is optional and you maintain this attribute when you create a new contract 

version. You can register any reason for the change, and you can register as many change reasons as 

necessary. 

Example 
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For example, you need to update the contract terms for a contract because the contract is renewed on a 

yearly basis. When you create a new version of a contract with the updated terms, you can register the 

reason for this change as Annual Change because this change occurs annually. 

 Assign Number Range Interval to Contract Version 

Use 

In this Customizing activity, you assign a number range interval to a contract version. Whenever a new 

contract version is created, the system generates a unique contract version number that falls within the 

number range specified in this activity. 

Requirements 

A number range interval is defined in the Customizing activity Number Range for Contracts. 

Activities 

In the Number range number field, enter the number for a number range interval. 

 Business Add-Ins 

 BAdI: Contract Comparison Display/Approval 

Use 

You can use this Business Add-In (BAdI) to support the Contract Version Management enhancement 

made for Flexible Real Estate Management (RE-FX) China. 

This BAdI serves two purposes, depending on the mode selected: 

- Approval Mode - You specify the approval criteria required in an approval process. If the 

required approval criteria for an original contract and a contract version are the same, then the 

contract version is automatically approved and processed. Otherwise, the contract version is 

submitted to the standard approval process via a workflow. 

- Display Mode - You specify the criteria to display in a comparison report result. If no criteria 

is specified, then by default, the system displays the results of all differences in a contract 

comparison report. 

The following method is available: 



 

 

- COMPARE_EXT Method - You can use this Business Add-In (BAdI) method to compare 

tables or customized tables. This method is called before the FILTER_DIFFERENCE method. 

- Importing parameter 

IO_CONTRACT_ORIG - object for original contract 

IO_CONTRACT_VERS - object for contract version 

- Changing parameter - Use ct_diff to view the result of the comparison 

- FILTER_DIFFERENCE Method - You can use this Business Add-In (BAdI) method to 

select the method, and change the criteria parameters. 

- Importing parameter - Use iv_mode to select the mode you are using: 

1 - Display 

2 - Approval 

 - Others 

- Changing parameter - Use ct_diff to change the parameters in the table. Depending on the 

mode selected, you can change either the comparison result, or the required criteria in a 

workflow. 

Standard settings 

In the standard system, there is no default implementation. You must create your own BAdI 

implementation. 

 BAdI: Availability of Functions for Contract Version Management 

Use 

You can use this Business Add-In (BAdI) to support the Contract Version Management enhancement 

made for Flexible Real Estate Management (RE-FX) China. You can modify and validate content 

The following methods are available: 

- IF_EX_RECN_CONTRACT~CHECK_ALL Method 

You can use this Business Add-In (BAdI) method to check whether the contract can be edited. 

For a contract version, if it has been processed or deleted, then the contract version cannot be 

edited.  It also checks to see whether the sales type used in the contract is unique. 

For an original contract, if it contains a contract version that is unprocessed, then the original 

contract cannot be edited. 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 603 

This method is called when you save either an original contract or a contract version. 

- IF_EX_RECN_CONTRACT~GET_NUMBER Method 

You can use this Business Add-In (BAdI) method to get the contract number for a contract version 

from another contract number range. 

This method is called when you create a new contract version. 

- IF_EX_RECN_CONTRACT~AFTER_STORE Method 

You can use this Business Add-In (BAdI) method to update the master data for a contract version 

(such as promotion code, promotional category, store information, and material group) on the Stores 

tab page in the Real Estate system 

This method is called when you save either an original contract or a contract version. 

- IF_EX_RECN_CONTRACT~BEFORE_DELETE Method 

You can use this Business Add-In (BAdI) method to check to see if a contract can be deleted. 

This method is called when you delete either an original contract or a contract version. 

- IF_EX_RECN_CONTRACT~AFTER_DELETE Method 

You can use this Business Add-In (BAdI) method to check to see that data related to the contract is 

also deleted from the system when you delete a contract. 

This method is called when you delete either an original contract or a contract version. 

Standard settings 

By default, the BAdI implementation is active. 

 BAdI: Enhancements to Standard Real Estate Contract 

Use 

You can use this Business Add-In (BAdI) implementation to deactivate certain functionalities available 

for contract version management. 

The following method is available: 

IF_EX_RECA_BUS_TRANS~CHECK_TRANSACTION_ALLOWED 

For a contract version, this method deactivates business activity Activate from the menu item and disables 

the Activate button. It also deactivates the Change mode option for a contract version that has been 

processed and approved. 



 

 

For an original contract, this method deactivates the Change mode option only if the original contract 

contains a contract version that is unprocessed. 

This method is called when you open a real estate contract (transaction RECN). 

Standard settings 

By default, the BAdI implementation is active. 

 Workflow Management 

 Define Parameters for Approval Process 

Use 

In this Customizing activity, you define the parameters for a contract version approval such as the number 

of approval levels and whether or not a workflow is enabled.  If workflow is enabled, you can also  assign 

agents to each approval level. An agent can be an individual (user), or a group (job, organization unit, or 

position). 

- Job 

A job describes the position; it is a classification of the function. For example, a financial manager. 

- Organization Unit 

An organization unit is a function within the organization - such as a group, department, or team -  

which the user is assigned to. 

- Position 

A position is a specific role occupied by the user. For example, a manager in the finance 

department. 

- User 

A user is a specific individual within the organization. 

Standard settings 

Default agent level assignment is preconfigured, however you can also create your own user. 

Activities 

Defining the approval parameters 
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1. On the Levels screen, enter the number of approval levels in the No. Levels field. 

2. Select WF enabled to use a workflow to manage the approval process. 

3. Save the changes. 

Defining the user agent assignment 

If you have enabled the workflow, you can also assign user agents to each approval level. 

4. On the Levels screen, select a line entry for which you would like to customize the agent 

assignment. 

5. Double click Level -> Agents in the Dialog Structure menu. The Level -> Agents screen appears. 

6. Define the user agent for each approval level. 

a) In the Type field, enter an object type that the system then assigns to. You can select an 

individual (user), or a group (job, organization unit, or position). 

b) In the Agent ID field,  assign an object type to this individual or group at this particular level. 

Note: The Agent ID must be an agent already defined in the human resource component. 

You must assign one user agent for each approval level. 

7. Save the user agent assignment. 

 Point-of-Sale Data Management Integration 

 BAdI: Retrieval of Master Data 

Use 

You can use this Business Add-In (BAdI) to retrieve master data from the Point-Of-Sales Database 

Management  (POS DM) system, and map it to the Real Estate system. It enhances the data integration 

between two databases in these two different systems. The following master data can be retrieved: 

- Store data such as store number 

- Material data such as material group 

- Promotional data such as promotion category and promotion code The following methods are 

available. 

- CUSTOMER_TO_STORE method - You can use this BAdI method to get the store number 

through a customer number. The parameter IV_KUNNR is imported into this method. After the 

mapping process, a corresponding store number is exported. 



 

 

- STORE_TO_CONTRACT method - You can use this BAdI method to get the contract number 

via a store number. The parameter IV_WERKS is imported into this method. After the mapping 

process, contracts related to this store are exported. 

- LOAD_STORE method - You can use this BAdI method to retrieve store data (such as the store 

ID, store name, and customer number) from an existing system. The method is called when you 

run the Master Data Retrieval ( REFXCN_RETDATA ) report. 

- LOAD_MTG method - You can use this BAdI method to retrieve material group data (such as 

the material group and customer number) from an existing system. The method is called when you 

run the Master Data Retrieval ( REFXCN_RETDATA ) report. 

- LOAD_PRM method - You can use this BAdI method to retrieve promotional data ( such as the 

promotion code and promotion category) from an existing system. The method is called when you 

run the Master Data Retrieval ( REFXCN_RETDATA ) report. 

Standard settings 

In the standard system, the BAdI implementation is active. 

Activities 

If the source system is not SAP retail system, then you must create your own BAdI Implementation. 

 Portugal 

 Municipal Property Tax 

 Location Hierarchy 

 Define Hierarchical Location Structure 

Use 

In this IMG activity, you define various location structures. Location structures are used to uniquely 

identify parcels or land registers for different purposes. 

In Portugal, you use the PT Hierarchical Location Structure to create the hierarchy for Portugal. 

Activities 
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You must first define the location structure ID (PT for Portugal) and its name on the Hierarchical 

Location Structure screen, and specify the number of levels for the hierarchy and the names of each level 

as follows: 

1. Country 

2. District 

3. Municipality 

4. Freguesia 

You must also define the type of real estate object on the Allowed Hier. Location Structures per Object 

Type screen, and then you enter all the possible locations for each defined hierarchy level on the 

Hierarchical Locations in Location Structure screen. In Portugal, the code system is built up as follows: 

- A -digit number (for example ) represents the district 

- A -digit number (for example ) represents the municipality 

- A -digit number (for example ) represents the freguesia 

Then, you assign the already defined hierarchical locations to one another and assign a key for each 

location on the Assignment of Hierarchical Locations in Location Structure screen. You can then assign 

only this key to a parcel or a public register in the application. 

You are not required to assign the keys. The key of the hierarchical location is not allowed to contain any 

spaces. 

If the assignment changes due to restructuring of individual hierarchical locations, you can assign new 

keys (at the level Assignment of Hierarchical Locations in Location Structure) or other locations to an 

existing key. However, if the key itself changes, then you have to change the master data. 

 Make General Settings for Land Use Management 

Use 

In this section you make general settings for Land Use Management ( LUM ). 

Activities 

You enter default values in the Defaults for Land Registers and Defaults for Parcels group boxes. These 

default values apply per master data object in dialog processing. You enter values for units of area, units 

of length and units of time. You can also enter a default currency, if needed. 

For parcels, you can also enter default values for the location structure and for overlays for cadastral 

usage types. 



 

 

 Tax Categories and Tax Rates 

 Define Municipal Property Tax-Rate Limits per Category 

Use 

In this IMG activity, you must define the minimum and maximum limits for tax rates for the tax 

categories defined by law. The limits are required for controlling the tax rates defined in the IMG activity 

Define Municipal Property Tax Rate. 

Activities 

Proceed as follows: 

1. Specify the tax category ( mandatory ). 

2. If required, enter the relevant calendar year. 

3. Enter the minimum and maximum limits (values) that are defined by law, noting the following: 

- If the values are equal, enter the same value in both columns 

- If you enter a tax category, but you do not specify any values, the system considers it as zero. 

In this case, you are not allowed to enter a tax rate other than zero in the IMG activity Define 

Municipal Property Tax Rate. 

If you do not enter a tax category, you are allowed to enter any tax rate specified by the municipality in 

the IMG activity Define Municipal Property Tax Rate. This means that the tax rate is not limited. 

If you do not specify any year, the tax rate limits will be valid for every year. If you enter the same tax 

category with a year in another row, the limits without the year will be valid until the defined year in this 

row. 

You can also enter the same tax category with different years and different tax rate limits in separate 

rows. In this case, the defined limit for the earlier year is valid until the next defined year in chronological 

order. 

 Define Municipal Property Tax Rates 

Use 

In this IMG activity, you assign the official tax-rate values defined by municipalities to the tax categories. 
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Requirements 

You have defined the minimum and maximum limits for tax rates in the IMG activity Define Municipal 

Property Tax Rate Limit per Category. 

Activities 

You enter the tax category, for which you can specify the following data: 

- Code of the municipality ( optional ) 

If you do not specify the municipality, the property tax rate will be valid for all municipalities (for 

example, to tax category State entity owned property) 

- Calendar year ( optional ) 

If you do not specify the year, the property tax rate limits will be valid for every year or until the 

next specified year. 

- Value of tax rate (optional - if you enter the tax rate, it must be within the minimum and maximum 

limit values of tax rates entered in customizing) You can assign more than one municipality to a tax 

category. 

Example 

Tax Category Municipality  Year Tax Rate 

Urban Property Subject to IMI Code Lisboa   % 

Non-Urban Property -  -  % 

State entity owned property -  -  % 

Urban Property not subject to IMI Code Setúbal -  % 

 Exemption Periods 

 Define Exemption Periods 

Use 

In this IMG activity, you enter the number of years for each category for which the owner is exempted in 

case of permanent residential objects. The number of years is defined by law for each exemption period 

category. 

Activities 

You need to enter the codes of following exemption periods as defined by law: 



 

 

Exemption period categories Exemption period ( years ) 

NB (New Buildings)  

SR (Buildings in Exceptional Renting Conditions (Social Renting))  

V (Property Taxable Value: - EUR)  

V (Property Taxable Value: - EUR)  

 Installments 

 Define Installment Limits for Municipal Property Tax 

Use 

In this IMG activity, you specify the limit of installment for the municipal property tax in Portugal. 

The number of installments for municipal property tax in Portugal depends on the limit defined by law for 

all companies in the country. If the amount of tax to be paid is above this limit, there must be two 

installment dates entered with equal amounts in April and September. Otherwise, one date is sufficient. 

You enter the installment dates in the IMG activity Define Installment Dates. 

 Define Installment Dates 

Use 

In this IMG activity, you specify the due dates of installments for paying the property tax. This can be 

more than one date per year, depending on the property tax amount of the reporting company code. 

In Portugal, the installment dates are in April and September. 

For more information on installment limits, see the IMG activity Define Installment Limits for Municipal 

Property Tax. 
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 Technical Settings 

 Define Technical Parameters for Cash Flow Creation 

Use 

In this IMG activity, you define the technical parameters for cash flow creation. 

Requirements 

You have entered: 

- The contract type defined for Portugal in the IMG activity Define Contract Types Contract type 

LMPT is set by default in the system for municipal property tax. 

- The condition types for accruals and installments in the IMG activity Define Condition 

Types 

The following condition types are set by default in the system: 

- PTXA for accruals 

- PTX for installments 

Activities 

You enter the company code and specify the day within a month for the due date of the accruals. 

You also specify: 

- The contract type you use in the municipal property tax contract 

- The condition types for accruals and installments 

You must specify one condition type for accruals and one for installments for each contract of a 

company code that is used in the Real Estate Contract report. 

 Digital Signature 

 Define Settings for Digital Signature 

Use 



 

 

In this Customizing activity, you enter company codes and define document types for real estate invoices 

and credit memos in a given number range interval and a two-digit serial number that the system uses as 

input (as an internal code) for generating digital signature. The system includes the signature information 

and the SAP#s certification number in the printout of invoices and credit memos. 

Note: 

- If you do not enter a Portuguese company code, you receive an error message when trying to create 

an invoice or credit memo with digital signature. 

- If you do not enter a document type for invoices or credit memos, the system uses the document 

type of the first FI document of the corresponding invoice that you want to print. 

 SAF-T 

 Specify Technical Parameters for SAF-T 

Use 

In this Customizing activity you specify technical parameters for the SAF-T output. For a given company 

code you can select the line item calculation method and activate the inclusion of the product list in the 

XML output without defining the products in the material master table. 

Activities 

Select a company code and in Method indicate an option from the dropdown list: 

- Invoice Items 

- Document Items 

These methods control the level of detail in the SAF-T output. Document Items includes a greater level 

of detail as it includes all the line items from the document. 

Select the checkbox under Product to to include the product list in the SAF-T output for the company 

code you have selected. 

 Correspondence 

 Correspondence 

Use 
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In Flexible Real Estate Management, two different types of correspondence are supported. Depending on 

your needs, you can use these two types together or separately. 

1. Correspondence using PDF-based forms is the more powerful of the two types, and the only one 

which allows mass printing. 

2. Correspondence using an office application enables you to create single documents using your 

accustomed word processing software (such as Microsoft Word). 

In addition to the output of documents related to contracts, both types of correspondence support 

document output for real estate objects, such as business entity, rental object and architectural object. 

Both types allow you to store and retrieve documents in the system with a link to the business object 

(contract or real estate object). 

The following brief explanation of the basic functions of these two correspondence types is intended to 

help you decide which better suits your needs. 

. Correspondence Using PDF-Based Forms 

PDF-based forms do not provide word processing in the usual sense. Instead they define the layout, 

output characteristics, and so on, of templates. During the output activity, documents are generated based 

on these templates, but documents are not directly edited. PDF-based forms are cross-client transport 

objects. 

Advantages: 

- PDF-based forms enable high-performance mass printing (also as batch processing) with optional 

document archiving using the SAP ArchiveLink interface. 

- Within the range of typical real estate correspondence, there are almost no limitations on retrieval 

and output of application data. Output of data in table form is directly supported. Enhancements 

(without needing to write program code) are also supported for determining, calculating and 

outputting your own user-defined data. 

- You have flexible, automatic control of the documents that are created for each business partner 

(role). (These are known as correspondence activities.) 

- E-mail and fax are supported, dependent on the settings of the business partner. 

- There is excellent integration in the development landscape, such as transport connection, translation 

tools, and so on. 

Disadvantages: 

- You cannot change a document once it is created. However, this is reduced somewhat by the fact 

that before you create a document you can copy any section of the text into a text editor. This text is 

then output in the correct place in the template. This procedure is suitable for short pieces of 

correspondence such as a general letter, but not for a complicated contract with many unique text 

passages. 

SAP provides PDF-based sample forms in Flexible Real Estate Management starting in ERP . PDF-based 

forms are the type of form now recommended. They replace the functions previously covered by SAP 

Smart Forms, which were used up to now. If you created your own Smart Forms in earlier releases, you 



 

 

can continue to use your existing Smart Forms without making any changes to them. However, if you 

want to set up new forms, you have to use PDF-based forms. The sample forms for Smart Forms that 

were delivered in Flexible Real Estate Management up to and including ERP  are frozen at the level of 

Release ERP  , and will not be developed further. 

. Correspondence Using an Office Application 

The office applications supported are Microsoft ® Word (starting with the Word  version) and 

Ami Pro ®. The office application has to be installed on the desktop. Using the SAP GUI for 

Windows is required, since communication with the office application is not supported in the SAP GUI for 

HTML and SAP GUI for the Java Environment. Due to the attributes of the standard content model, the 

templates are client-dependent and have to be transported manually. 

The main limitation of this correspondence type is that the options for transferring application data to the 

office application are limited. It is only possible to transfer a flat structure of individual fields for each 

document, so that tables with a flexible number of lines are not supported. For example, it is not possible 

to display invoice items or to show the service charge keys in the attachment for service charge 

settlement. The number of potential fields that can be output is limited to . 

Advantages: 

- Since you use standard word processing, you need less time and energy for setting up and learning 

to use the correspondence functions. 

- You can use your existing sample letters directly as templates. Flexible text modules are replaced by 

Mail Merge fields. 

- Immediately after you create a document, you can change it using the functions of the word 

processing program before it is printed or stored. This is especially useful for individual contract 

forms that need to be changed considerably. 

- You can change stored documents at a later date and store the new version under a new number. 

Disadvantages: 

- Data transfer to the office applications is technically limited (see above). 

- Batch processing and automatic creation of multiple documents is not possible. Only single print is 

possible, and you have to execute it from the RE Navigator. 

- The office application (Microsoft Word or Ami Pro) has to be installed locally. SAP GUI for 

Windows is mandatory. 

For more information on correspondence using an office application, see Basic Settings and Document 

Templates 
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 PDF-Based Forms (Mass Print and Single Print) 

 Basic Settings 

Use 

In this section, you make basic settings for print functions for PDF-based forms. 

Specify the following: 

- How the system determines the language when creating documents 

- If the outgoing document should be archived 

- If e-mail and fax are used as output media 

- Which sort variants are used for specifying the output sequence during creation of documents 

Activities 

Language for creating documents 

The system determines the document language for each document (even within the same output activity) 

using the settings you make here. These Customizing settings for language apply for all correspondence 

activities. 

The document language is most relevant for the static texts in a form, such as the titles. In addition, the 

document language is used for language-dependent texts originating in Customizing, such as, texts for the 

contract type. Normally it is not possible for texts of master data and transaction data to be entered as 

language-dependent (for example, names of business entities). 

- Example  

You want to output all documents in one specified language, such as English ( EN ). In the 

Basic Settings, choose Defined Language in the  First Step field and enter the language EN. 

Under Supported Languages enter only EN. 

- Example  

You want to print all documents in the language of the recipient. The languages involved are 

English, French and Italian. 

In the Basic Settings, choose Correspondence Language of Recipient in the First Step field. Under 

Supported Languages enter EN, FR, IT. 

- Example  

You want to specify several language options. 

You can enter up to three options using the fields for the three steps. If no supported language is 

assigned to a business partner, for example, you can still print a document by entering a language 

that is entered as a Defined Language in the nd or rd step. 

Supported Languages 



 

 

You specify here the languages that are available for your correspondence. You can use this setting, 

for example, to prevent the system from trying to create a document in the language of the recipient 

when that language is not supported in your system. Forms are not available in languages that are 

not supported, or no Customizing texts were entered in these languages. 

The sequence of the entries in the table is not significant. 

Archiving 

You can specify that the documents you create are archived using the SAP ArchiveLink interface. To use 

this function, you have to install the archive system and configure the ArchiveLink interface. You make 

these settings in Customizing for SAP NetWeaver in the ArchiveLink IMG activities. 

Afterward you enter your setting for archiving here. You can specify at different levels for your 

correspondence whether or not archiving should be performed. 

The system assigns document types to archive documents. There is a single document type for each 

correspondence application. The name of the document type is always RECP<key of correspondence 

application>, such as RECPA for a General Letter. The document types used are already assigned in 

standard Customizing to the corresponding BOR object types, for instance RECPA is assigned to object 

type BUS (real estate contract). 

Note 

Do not change the standard settings! Check in the current client if all settings in the following activities 

are in accordance with standard Customizing: 

- the document types RECP* 

- the links between BOR object type and document type RECP* 

Additional Output Media 

Depending on the settings of the recipient, you can use e-mail and fax as output media.  To be able to use 

these options, you have to have configured the SAPconnect interface. You make these settings in 

Customizing for SAP NetWeaver in the SAPconnect IMG activities. 

Afterward you enter your settings for output media here. You can specify at different levels whether or 

not e-mail or fax are supported for your correspondence. 

To use these settings in the application, set the appropriate indicator in the Define Correspondence 

Applications and Assign Correspondondence Activities IMG activity. 

Sort Variants 

During mass printing you create a large number of documents. If you do not use a sort variant, the 

system outputs the documents in the following sequence: 

1. Sorted in ascending order by the key fields of the real estate object: For rental objects, 

for example: company code/business entity/rental object 

For contracts, for example: company code/contract number 
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2. Sorted in ascending order by the sequence number of the document in the 

correspondence activity, if multiple documents are created for the object due to the 

correspondence activity 

If you want a different type of sorting, choose New Entries under Sort Variants and enter the sort variant 

you want to use. Select the line for the sort variant and choose Sort Fields. Using the input help, select 

one or more fields that you want to sort by (such as, the contract number). 

The system always applies sort variants to the entire document list. Therefore it is not necessary for 

documents for the same object to follow each other. Possible variants for sort fields include: 

- Postal code/Street/Recipient 

- Processor/Company Code/Contract Number 

You can have the system create a new spool request for each sort field. For example, you could have the 

system create a spool request for each processor when the sort fields Processor/Company Code/Contract 

Number are used. 

Since you define each sort variant for one object type, then the sort variant is available for all 

correspondence applications of this object type. 

For each correspondence application, you can specify a default sort variant and decide if it can be 

changed in the application. You make these settings in the Define Correpondence Applications and 

Define Correspondence Activities IMG activity. 

 Forms 

 Define Forms 

Use 

In this activity, you specify the forms you want to use for correspondence activities. 

Activities 

Define the forms you need (such as, Master Data Summary for Building ) and assign a form object to 

them (PDF-based form or Smart Form). 

In the Define Correspondence Activities IMG activity, you then assign the logical form objects, rather 

than the PDF forms or Smart Forms themselves, to the correspondence activities. The logical form 

objects contain a link to the form itself. 



 

 

- You define all the attributes of your Smart Forms (layout, texts, your own data retrieval, and so on) 

in the Form Builder for Smart Forms and Text Modules IMG activity (transaction 

SMARTFORMS). 

- You define all the attributes of your PDF forms in the Form Builder for PDF-Based Forms IMG 

activity (transaction SFP). 

 Define Company-Code-Dependent Text Modules 

Use 

In order to avoid creating several form versions with different company data, you can define 

company code-dependent text modules. Depending on the company code of the object for output, the 

system determines the text module and inserts it dynamically during document creation. 

Some real estate objects, such as architectural objects, are not assigned directly to a company code. To 

have the configured text modules also available in the form, make the settings in a request with the 

company code blank (standard setting). 

The text modules you assign are independent objects that exist independently of the settings in this 

activity. 

Technical Information 

The new text modules introduced with the Smart Forms are used and not the standard texts on the basis of 

table STXH/STXP. These new text modules are client-specific and have their own transport link (a 

separate transport link is therefore not required). 

If you wish to use the text modules client-specifically, you should use suitable names (client as prefix). 

The texts have the status of development objects and must not be changed in the productive system. 

Standard settings 

The following company code-dependent text modules are available: 

- Header, footer, signature, and sender 

- A maximum of four further texts 

You determine whether or not the text module is output in the document and in which place by means of 

the form definition. Here you use the Form Builder to dynamically include the text modules. The names 

of the text modules are retrieved by means of the specific data retrieval functions of Flexible Real Estate 

Management since the Form Builder itself does not recognize "company code-dependent" text modules. 
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Activities Double-click the entry you wish to process to start 

the editor. 

 Form Builder for PDF-Based Forms 

Use 

You use the Form Builder for PDF-based forms to define the layout for your forms. 

Standard settings 

SAP provides a large number of sample forms for Flexible Real Estate Management. The names of these 

sample forms all begin with RE_. 

Never change a sample form directly. When you set up your correspondence, copy the sample form and 

modify it so that it suits your needs. 

For correspondence that you send to your business partners, you should also work with a copy of the 

sample form, if no changes to the sample form are required. By following this practice, you ensure that 

any changes SAP makes to the sample form in a new release do not affect your correspondence. 

However, in the case of master data summaries, you should use the sample forms directly, as long as you 

do not require any changes in the form. By doing so, you ensure that after a release change, you are 

always using the most up-to-date form, which includes any new data that might have been added to the 

real estate object. 

Note 

For more information on using the Form Builder for PDF-based forms, see the SAP Library. Choose: 

SAP NetWeaver --> Application Platform (SAP Web Application Server) --> Business Services --> PDF-

Based Forms --> Designing Forms with the Form Builder. 

You can access the SAP Library from the initial screen of the transaction by choosing Help --> SAP 

Library, or on the Service Marketplace by choosing SAP Help Portal --> Documentation.  

For more information on correspondence for Flexible Real Estate Management, see the Correspondence 

IMG documentation. 

 Form Builder for Smart Forms and Text Modules 

Use 



 

 

You use the Form Builder for Smart Forms to define the layout for your forms. 

Keep in mind that SAP recommends using PDF-based forms, and that you should therefore use Smart 

Forms only for existing correspondence. 

Standard settings 

SAP provides a large number of sample forms for Flexible Real Estate Management. The names of these 

sample forms all begin with RE_. 

Never change a sample form directly. When you set up your correspondence, first manually copy the 

sample form and modify the copy so that it suits your needs. 

For correspondence that you send to your business partners, you should also work with a copy of the 

sample form, if no changes to the sample form are required. By following this practice, you ensure that 

any changes SAP makes to the sample form in a new release do not affect your correspondence. 

However, in the case of master data summaries, you should use the sample forms directly, as long as you 

do not require any changes in the form. By doing so, you ensure that after a release change, you are 

always using the most up-to-date form, which includes any new data that might have been added to the 

real estate object. 

Activities 

You can access processing of Smart Forms text modules from the initial screen of the Form Builder for 

Smart Forms (cross-client). These text modules can also be used in PDF-based forms. These text modules 

are put to use, for example, for Company-Code-Dependent Text Modules in Flexible Real Estate 

Management. 

Information: 

For more information on using the Form Builder for Smart Forms, see the SAP Library. Choose: 

SAP NetWeaver --> Application Platform (SAP Web Application Server) --> Business Services --> Smart 

Forms --> Designing Forms with the Form Builder. 

You can access the SAP Library from the initial screen of the transaction by choosing Help --> SAP 

Library, or on the Service Marketplace by choosing SAP Help Portal --> Documentation.  

For more information on correspondence for Flexible Real Estate Management, see the Correspondence 

IMG documentation. 

 Correspondence Activities and Applications 

 Define Correspondence Activities 

Use 
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In this step, you define correspondence activities, initially without relating them to a correspondence 

application. You assign the activities in the IMG activity for defining correspondence applications. 

Standard settings 

Standard Customizing contains the usual correspondence activities. 

Activities 

Correspondence activities 

Check the standard settings and change these if necessary. If you want to create additional 

correspondence activities, choose New Entries and enter a name for the activity. 

Assign Recipients and Forms 

1. Select a correspondence activity and choose Assign Recipients and Forms. 

2. Assign the recipient. 

Example 

Seq.No. Recip. Selection Role Cat. 

Hierarchical Search Form  

 Letter Main contractual partner  

 

Contract form 

Main contractual partner  

 Partner with Role Supplier 

x Information 

The Group field offers additional means for controlling the selection of recipients. 

3. Assign the form to the correspondence activity, for example, master data summary ( business entity). 

You have to create forms in the Form Builder IMG activity. 

4. Save. If you want to assign additional recipients and forms to a correspondence activity, choose New 

Entries and proceed as described above. 

 Define Correspondence Applications and Assign Correspondence 

Activities 

Use 

In this step, you first make the basic settings for your correspondence applications. Then you assign one 

or more correspondence activities (for example, general correspondence, master data summary) to each 

correspondence application. In the Flexible Text Modules table, there is a text editor you can use to create 

and store text modules (such as an introductory text), per correspondence application. 



 

 

Standard settings 

Correspondence applications are predefined in the system, and relate to exactly one object type. The 

following correspondence applications are prescribed for usage objects and architectual objects: 

- General Correspondence 

- Master Data Summary 

The following correspondence applications are available for contracts: 

- General Correspondence 

- Master Data Summary 

- Contract Form 

- Contract Account Sheet 

- Service Charge Settlement 

- Sales-Based Settlement 

- Sales-Reports 

- Dunning of Missing Sales Reports 

- Notice/Confirmation of Notice 

Activities 

Basic Settings . 

Make your basic settings for each correspondence application. 

a) Indicator 

Inactive 

Correspondence activity 

nd currency 

Text editor 

Text module 

Sort variant 

b) Role categories/Role types 

In order to be able to use the data of a processor (such as, name, telephone number, and so on), as well as 

the data of up to two additional business partners using a uniform correspondence structure, enter the 

corresponding role categories (and role types, if needed). 
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The business partner data is then available, independently of the actual role, in the document data for use 

as a sort criteria, for example, or to be output in a form. 

Correspondence Activities. 

In this section, you assign the allowed correspondence activities to the correspondence applications. 

Select the correspondence application and double click on Correspondence Activities in the dialog structure. 

Then choose New Entries. If you want to define a correspondence activity as a default value, set the Default 

indicator. Flexible Text Modules. 

In order to support the selection of text modules in the application dialog, enter all allowed text modules 

here per correspondence application. If you want to create a new text module, choose New Entries and 

choose  @Q@ Editor. To change an existing text module, select it and choose @Q@ Editor. Save. 

Regarding the technical background of the modules used, the same applies as for the company-code-

dependent text modules. 

Exception 

 Dunning correspondence: 

You make Customizing settings for dunning correspondence and call this correspondence in the FI 

component. 

 Enhancements 

 Differentiating Characteristics 

Use 

In this activity, you can enter differentiating characteristics for each correspondence application. These 

differentiating characteristics are used within mass correspondence for selecting each correspondence 

activity individually for printing. 

Example 

The system automatically determines a correspondence activity for each object using the differentiating 

characteristics. As a result, the system prints contract  using correspondence activity T and contract  using 

correspondence activity T. 

 Implement Enhancements ( BAdI ) 

Use 



 

 

This Business Add-In (BAdI) allows you to enhance the standard behavior of correspondence. You can: 

- Specify default values for the selection screen options 

- Define your own parameters 

- Define differentiating characteristics 

- Influence how the document list is created 

- Change the output of forms 

Specify default values for the selection screen options 

- APP_OPTIONS_INIT - The method is called once when the selection screen is initialized. You 

can change the fields of the CS_OPTIONS parameter so that the standard defaults for output device, 

correspondence activity, and so on, can be overridden. 

Define your own parameters 

You can add an additional tab page for print parameters for each correspondence application. 

This is in addition to the selection screen for mass printing and the print dialog within the RE Navigator. 

These print parameters can then be applied, for example, when the document list is created, or when the 

form is output. Carry out the following activities: 

- Add the fields you want to the RECP_SF_OPTIONS_BADI DDIC structure using APPEND. 

- Copy the RECP_GUI_SF_BADI_EXAMPLE function group, including the function module, to the 

customer name range. Modify subscreen  so that the fields are displayed. 

- Implement the APP_OPTIONS_INIT method and set the following fields for the CS_OPTIONS 

parameter: 

- SUBSCREENEXTFM - Name of the PBO function module 

- REPIDBADI - Program name of the subscreen 

- DYNNRBADI - Screen number of the subscreen 

- XSUBSCREENEXT - Tab page title ( optional ) 

Example class CL_EXM_IM_RECP_SF contains a corresponding implementation of 

APP_OPTIONS_INIT. 

Define differentiating characteristics 

By using differentiating characteristics, you can have the system determine a specific correspondence 

activity for each real estate object during mass printing. For example, you can set up the system so that 

contracts with contract types A and B are printed using correspondence activity , while all other contracts 

are printed using correspondence activity . 

Before you decide to use differentiating characteristics, you should check if your requirements for 

different documents can be met using conditions within Smart Forms. In general, you should try to 

limit the number of forms you have, since they often contain many of the same parts (form structure, 

information windows, and so on), which increases the time and effort required in maintenance and 

comparisons. 

Using differentiating characteristics makes the most sense when correspondence activities differ in their 

recipient roles. 
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- GET_DIFF_CHARACTERISTIC - The method is called once for each real estate object that is 

processed. The purpose of the method is to derive the differentiating characteristic from the 

properties of the real estate object. The differentiating characteristic itself is a text you define with a 

length of . First create the allowed differentiating characteristics in Customizing for each 

correspondence activity, which can be delivered by the Business Add-In. Then assign the 

differentiation characteristics to the resulting correspondence activities (in Customizing for 

correspondence applications under correspondence activities). 

Since the differentiation characteristic is any text you choose, there are two options for how you can 

implement the example explained above: 

- The contract type can represent the differentiation characteristic, so that many Customizing entries 

are necessary (one entry for each contract type). 

- The resulting correspondence activity can represent the differentiation characteristic, whereby only 

two Customizing entries are required. 

Influence how the document list is created 

In the standard system, real estate objects are selected first. Then the system determines the documents to 

be created for each real estate object based on the correspondence activity. You can change this behavior 

using the following methods: 

- CHECK_BUSOBJ_RELEVANCE - Checks if the real estate object is taken into account when 

documents are created for this correspondence application. Trigger the NOT_RELEVANT exception 

to have the system ignore the real estate object. The correspondence log then does not contain any 

reference to the ignored real estate object. The method is called exactly once for each selected real 

estate object. 

- CHANGE_DOC_DATA - Using this method, you can change the properties of a document that 

was determined in the standard way. For example, you can change the document language or the 

form name (if you are not able to control them enough using the basic settings or the correspondence 

activities). To keep the document from appearing in the document list, add appropriate warning or 

error messages to table CT_MESSAGE. These are displayed in the correspondence log. 

The method is called exactly once for each document. 

- CHANGE_DOC_LIST - Using this method, you can modify the entire document list and change 

how documents are sorted. 

The method is called exactly once for each run, after the standard document list was created. 

Change the output of forms 

In the standard system, the output of forms is handled by function module calls: 

1. SSF_OPEN - Opens the print request 

2. Call of the generated function module for each document to be output 

3. SSF_CLOSE - Closes the print request 

SSF_OPEN and SSF_CLOSE are not absolutely required for output with Smart Forms, but they do 

improve performance when the system generates spool requests in OTF format (for later output to 

printers). 



 

 

There are BAdI methods available for each of the three steps listed above and for displaying the print 

preview: 

- SF_OPEN - Smart Form: Opens new print request 

- SF_PRINT - Smart Form: Prints the document 

- SF_CLOSE - Smart Form: Closes the current print request 

- SF_PREVIEW - Smart Form: Displays the print preview 

These methods are called before the standard function module. The following are available in the 

methods as inbound parameters: 

- IS_OPTIONS - Options of the correspondence application, that is, of the whole current output 

operation, such as all settings on the selection screen 

- IS_DOC - Document properties, such as real estate object, recipient, name of Smart Form 

In these methods, you can change exactly those parameters that also support the corresponding function 

modules. 

If you set another output parameter that is also supported, CF_SUPPRESS_DEFAULT_OUTPUT = 

'X', then the next standard function module is not called, so that you can completely replace the 

standard behavior. In that case, you have to supply the correct values to the return parameters. For 

SF_PRINT these are CS_DOCUMENT_OUTPUT_INFO and CS_JOB_OUTPUT_INFO. This is 

necessary because the messages for the correspondence log are always derived from them. 

If you only want to change form parameters for SF_PRINT, such as CS_OUTPUT_OPTIONS, but still 

want to use the standard output, then CS_DOCUMENT_OUTPUT_INFO and CS_JOB_OUTPUT_INFO 

are irrelevant. 

Changing the standard form output might be advantageous in the following scenarios: 

- You want to use output of Smart Forms to the usual output media, but you want to override certain 

parameters during the call of forms (for example, entries for the spool request, such as name, cover 

sheet, and so on). To do so, for example, implement, SF_PRINT and change the fields in the 

appropriate return parameters, such as CS_OUTPUT_OPTIONS. 

- You want to output using Smart Forms, but you want a different output format, such as 

XSF (XML for Smart Forms). Since output with XSF is technically incompatible with the 

SSF_OPEN  and SSF_CLOSE function modules, implement the SF_OPEN and SF_CLOSE BAdI 

methods by setting CF_SUPPRESS_DEFAULT_OUTPUT = 'X' for each one. The standard call 

of these function modules is thereby suppressed. Implement SF_PRINT and set the corresponding 

parameters in CS_CONTROL_PARAMETERS and 

CS_OUTPUT_OPTIONS. In this way, you can have the system return the form output, for example, 

in XSF format as an internal table, in order to write this data to a file. 

- You want to use an external tool for form output. Set the 

CF_SUPPRESS_DEFAULT_OUTPUT = 'X' return parameter in all four BAdI methods. 

Implement the call of the external tool in SF_PRINT. You can use standard data retrieval again by 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 627 

calling the standard methods SF_PRINT , which are called within the corresponding Smart Form in the 

initialization. Transfer the standard methods of parameter ID_DOCGUID in order to identify the current 

document. Notes for Developers 

 Office Application (Single Print) 

 Basic Settings and Document Templates 

Use 

In this section, you make basic settings for single correspondence using office integration. For an 

overview of the correspondence functions available, along with their pros and cons, refer to 

Correspondence. You can create single correspondence in the application using office integration, for 

example, for a real estate contract. In the RE Navigator choose @DK@ with the quick info text Print 

with Office Application. 

You make separate settings and enter separate document templates for each different real estate object 

type. 

Prerequisites 

From the RE Navigator, you can also choose to store documents that were created. You can choose 

among three different types of storage: database of the SAP System, content server or external archiving 

system. Which strategy is best for you is dependent on the volume of documents you need to store. In the 

standard system, documents are stored in the database of the SAP System. However, this makes sense 

only for a small number of documents. The settings for the storage system are found in the Define 

Content Repositories IMG activity. 

To use a different type of storage, assign the configured content repository to your real estate object types. 

The Customizing settings are in these IMG activities: 

Assign Business Objects to Document Classes 

Maintain Storage Categories 

Standard Settings 

Standard Customizing contains the real estate objects, for which you can make these settings: 

- Business entity 

- Property - Building 

- Rental object 



 

 

- Architectural object 

- Real estate contract 

For each object type, SAP provides an example of a document template for a general letter for 

Microsoft Word (in English and German). The document templates are also stored as Business 

Documents. You display and manage the stored document templates, along with stored documents, using 

the Business Document Navigator. 

Activities 

You use the Inactive indicator to specify if the single correspondence function is needed for a given 

object type. For example, to deactivate the @DK@ button for architectural objects in the RE Navigator, 

set this indicator for the I object type. Existing document templates are not affected by this change. 

To edit and assign document templates for an object type in the Business Document Navigator, double 

click on the object type. The detail view appears, where you choose @Z@ Document Templates with the 

quick info text Change Document Templates. 

Example 

Creating a New Document Template Using Microsoft Word 

You can transfer the documents you currently use to a document template without difficulty. 

1. Start Microsoft Word on your PC and open the existing document. Replace the variable elements in 

the document, such as name, address, contract number, with mail merge fields (see the Supported 

Mail Merge Fields section below). Save the changed document and leave Microsoft Word, so the 

document is not blocked. 

Note: The term Document Template as used by SAP does not refer to the Document Template (.dot) 

file type in Microsoft Word. Save all document templates for your single correspondence as Word 

Document (.doc) file types. 

2. Import the document templates you saved locally to the SAP System. First go to the Business 

Document Navigator for the given object type using this IMG activity by choosing @Z@ Document 

Templates in the detail screen of the object type. 

3. Choose the Create tab page in the lower part of the Business Document Navigator. Double click on 

the Text entry under Standard doc. types. The Open File dialog box appears, where you can import 

the documents. 

Storing and Transporting the Document Templates 

The document templates are assigned to a content model in the standard system. This defines the 

documents as client-dependent and transportable.  The document templates provided by SAP are in client 

. There are two ways to make the document templates available in another system or client. 

1. Go to the Business Document Navigator that shows the document types for the given object type 

using this IMG activity (see step  for description). 

a) To transport documents, select the document templates and choose @A@ with the quick info 

text Transport documents. 

b) To download documents locally, select the document templates and choose @@ with the quick 

info text Export document. Save the document in a directory of your choice (for example, on 
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your PC). Log on to the target system or client and go to the Business Document Navigator 

there. To import the locally saved document as a document template, choose the Create tab 

page in the lower part of the Business Document Navigator. Double click on the Text entry 

under Standard doc. types. The Open File dialog box appears, where you can import the 

documents. 

Display Supported Mail Merge Fields 

For each real estate object type, there is exactly one flat DDIC structure that defines all mail merge fields 

that are supported. Only this data from the SAP System is available to the office application when you 

create documents. The name of the DDIC structure is predefined in the system and is displayed in this 

IMG activity. You can navigate directly from the detail display of the object type attributes to the field 

list of the DDIC structure: 

2. Choose @@ Supported Data Fields (this corresponds to transaction SE). Using an enhancement, 

you can add more fields to this DDIC structure, and fill it with data when a document is created. 

For more information on this enhancement, refer to Implement Enhancements ( BAdI ) 

Adding a Mail Merge Field Using Microsoft Word 

3. Open the document template using Microsoft Word and perform these two steps: 

a) Determine the field name for the mail merge field you want in the DDIC structure (as 

described in step ). Use a separate session for this. 

b) In Microsoft Word, position the cursor where the mail merge field should appear. In the menu, 

choose Insert -> Field, then select Category: Mail Merge -> Field Name: 

MergeField. For the field name, enter the field from the DDIC structure and confirm. 

4. Repeat these two steps for all mail merge fields and save the document. 

There is no option for making a selection within Microsoft Word when you are adding a mail merge field. 

Additional Hints 

Formatting Mail Merge Fields in Microsoft Word 

For technical reasons, replacement of text in mail merge fields during document creation is based on 

simple text replacement (search and replace function). Therefore, the mail merge function of Microsoft 

Word, which can use other data sources, such as ODBC data source, text file, and so on, is not used here. 

As a result, formatting options for mail merge letters, such as different date or currency formatting, as 

well as line compression for blank field contents, are ignored. 

The number of mail merge fields is limited to . If you add technical fields automatically, then this 

maximum number can be reduced slightly. 

The data from the SAP System is displayed in the office application just as it would be in the SAP 

System, taking the current user settings into account (date, number and currency formatting). If you need 

other formatting, add a user-defined field, typed for this formatting, to the DDIC structure. 

File Size of Templates 



 

 

Regardless of the integration with the SAP System, the size of file (bytes) for the documents created is at 

least equal to that of the template.  If you want to store the documents created, you should make sure that 

the file size of the template is as small as possible. Before you import a document into the SAP System as 

a template, make sure you avoid all macros or similar code and delete the processing history. 

Using Key Words for Structuring in the Business Document Navigator 

You can enter up to four key words for a stored document template in the Business Document Navigator. 

When you call single correspondence in the RE Navigator, these key words are evaluated for the display 

of the input help for templates. The system interprets the key words here as grouping criteria. The 

grouping is always at one level. If you want to define more than ten templates for an object type, then it 

makes sense to group the templates by topic or by organizational units. If you assign a template to several 

key words, then the template appears under several nodes in the input help. 

Notes for Correcting Errors 

If mail merge fields are not replaced with data from the SAP System when documents are created, then 

check the following settings: 

- Document protection is not allowed to be active for the stored templates. 

- The mail merge field has to have been added to the template using the appropriate field function (see 

above). 

- The name of the mail merge field has to be exactly the same as the field name from the DDIC 

structure for the given object type. 

 Enhancements 

 Implement Enhancements ( BAdI ) 

Use 

When you create a document for an office application, the system transfers certain application data from 

the SAP System to the office application. This application data is output in the specified areas of the 

template (merge fields). 

SAP's standard delivery includes a wide range of application data for output in your office 

document. Use method CHANGE_DOC_DATA to change application data before transferring it to your 

office application. 

If you require any of the following, you should implement the Business Add-In. 

1. You require additional data that is not included in the SAP standard delivery (for instance, data from 

customer-specific tables). 

2. You wish to change standard data (for instance, modify certain texts). 
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3. You wish to reformat standard data (for instance, number of decimal places). 

If you have already enhanced the CI includes of the master data tables in order to define user fields 

without modifying the code, you do not need to implement the Business Add-In. The data from the CI 

includes is automatically transferred to your office application. 

You can limit the selection of templates using the method CHANGE_TEMPLATE_RANGE. In doing 

to you can have read access to the data of the object. 

Standard settings 

Correspondence using an office application is supported for the following object types: 

- Architectural object 

- Business entity 

- Land 

- Building 

- Rental object 

- Real estate contract 

The Business Add-In supports enhancements for all the above object types and provides a common 

interface. When you implement a Business Add-In, choose the filter attribute corresponding to the 

particular object type. For instance, to change the contract data to be transferred, choose object type IS 

(real estate contract) as the filter attribute. 

Multiple implementation of the Business Add-In in the same system is possible, which means that the 

data to be transferred can be changed by partner add-ons or your own enhancements. 

Activities 

Each of the above object types has exactly one DDIC structure whose data is transferred to the office 

application. The names of these structures are displayed in the IMG activity Correspondence -> Office 

Application (Single Print) ->Basic Settings and Document Templates in the Data Transfer Structure 

field. 

To implement an enhancement, carry out the following steps: 

1. Add the additional fields you want to the transfer structure using an APPEND ( see requirement  or 

). 

Start transaction SE and display the required structure. Choose menu path Goto -> Append 

Structure... and enter the new fields. Activate the structure. 

2. Implement the Business Add-In. Assign the required values to the fields in method 

CHANGE_DOC_DATA. Activate the Business Add-In implementation. 

For more information on Business Add-Ins, choose Goto -> Online Handbook in the BAdI Builder 

or choose @S@ in the toolbar. 



 

 

3. Use the new fields in the template for the office document you wish to create. Open the required 

template in the detail view of the IMG activity Basic Settings and Document Templates. 

To include field ZMYFIELD in a Microsoft Word template, position your cursor on the appropriate 

place in the document and choose Insert -> Field -> Category: Mail Merge -> Field Name: Merge 

Field. In the MERGEFIELD input field, enter the field name ZMYFIELD and confirm. Save the 

template. 

Note on data format: 

The application data is output in the office document as displayed in the SAP System. This is particularly 

relevant for the display of dates and figures, which you can modify with transaction User Settings. 

For technical reasons, the formatting options for the merge field of Microsoft Word are not available. 

If you require another format, add another field of type CHAR to the structure and specify the value 

explicitly in method CHANGE_DOC_DATA (for instance using the ABAP statement WRITE ... TO ...). 

Note that a maximum of  fields per document can be transferred to the office application (standard fields 

and fields added with APPEND). 

Example 

See BAdI Builder under Goto -> Sample Code -> Display. Doubleclick method name 

CHANGE_DOC_DATA. 

Notes for Developers 

 Information System 

 Create Report Profile 

 Report Profile 

Use 

Using a report profile, you can display attributes of master data, where the attributes have a :n 

relationship to this data, in report columns. 

You can enter a report profile on the initial screen of reports that support its use. 

In Customizing, a profile is assigned to this report profile for each relevant aspect: 

- These are: The measurement profile, which determines which measurement types are 

displayed in additional columns 

- The condition profile, which determines which condition types or condition groups are 

displayed in additional columns 

- The fixtures and fittings profile, which determines which fixtures and fittings characteristics 

are displayed in additional columns 
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Adding Columns 

The output structures for the lists contain the following INCLUDE structures for the profiles: 

- Measurements: REIS_PF_MEAS_ALL 

- Conditions for rental objects: REIS_PF_CDBD_ALL 

- Conditions for contracts: REIS_PF_CDCN_ALL 

- Fixtures and fittings characteristics: REIS_PF_CT_ALL 

Each INCLUDE contains five INCLUDEs for the structures 

- REIS_PF_MEAS - REIS_PF_CDBD - REIS_PF_CDCN 

- REIS_PF_CT 

This allows five conditions, measurements, and fixtures and fittings characteristics to be displayed in the 

lists. To display more than five characteristics, you can enhance the list without modifications as 

follows: 

- Measurements 

In transaction SE, create structure CI_REIS_PF_MEAS. In the menu, choose Edit -> Include -> 

Insert, structure:  REIS_PF_MEAS, name suffix: . 

Save your entries and activate structure CI_REIS_PF_MEAS. This adds a new measurement with 

the corresponding columns. If you require more columns, insert the include again and increment the 

name suffix. 

- Conditions for rental objects or contracts 

In transaction SE, create structure CI_REIS_PF_CDBD or CI_REIS_PF_CDCN. In the menu, 

choose Edit -> Include -> Insert, structure: REIS_PF_CDBD or REIS_PF_CDCN, name suffix: . 

Save your entries and activate structure CI_REIS_PF_CDBD or CI_REIS_PF_CDCN. This adds a 

new condition with the corresponding columns. If you require more columns, insert the include 

again and increment the name suffix. 

- Fixtures/fittings characteristics 

In transaction SE, create structure CI_REIS_PF_CT. In the menu, choose Edit -> Include -> Insert, 

structure: REIS_PF_CT, name suffix: . 

Save your entries and activate structure CI_REIS_PF_CT. This adds a new fixtures and fittings 

characteristic with the corresponding columns. If you require more columns, insert the include again 

and increment the name suffix. 

The columns you have inserted are filled automatically by the program without further action on your 

part. 



 

 

 Configure Measurement Profiles 

Use 

Here you define the measurement profile and assign measurement types to it. 

Additional columns are available for each assigned measurement type in the report that uses the 

measurement profile. 

The following columns can be displayed in the report per measurement type: 

- Measurement amount ( available ) 

- Measurement amount ( capacity ) 

- Unit of measure 

- Measurement valid from 

- Measurement valid to 

The column titles tell you which measurement type the data is for. 

Activities 

Create measurement profiles and assign measurement types to them. The measurements that are 

assigned to a profile can be displayed in different columns in one report at the same time. To improve 

performance, SAP recommends defining profiles only for those measurements that you would see in 

normal master data reports. "Residential/usable space" is certainly an indispensable attribute in almost 

every report. The measurement type for it (A in the standard system) should therefore be assigned to 

most measurement profiles. 

Performance is better in the report when this one total measurement is assigned than when you assign 

the measurement types that belong to the total measurement individually. SAP recommends that you use 

special reports for measurements or the reports of the Business Information Warehouse for reporting by 

individual measurements. 

At the present, it is only possible to assign a maximum of five measurement types to a 

measurement profile. 

Assign the measurement profile to a report profile, since only the report profile can be entered on the 

initial screen. 

If you use measurement types in the report that are not allowed on the objects being considered, the 

report does not provide any values for these measurement types. It is possible to create totals for these 

measurement types by reporting on the subordinate objects, if you use an appropriate layout. 
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 Configure Condition Profiles 

Use 

Here you define  condition profiles and assign condition types and condition groups to them. 

Additional columns are available for each assigned condition type/condition group in the report that uses 

the condition profile. 

You can assign a condition profile for rental objects and one for contracts to the report profile. It makes 

sense to define these profiles so that the only difference between them is the condition purpose. This 

makes it possible to compare condition values in the occupancy report, which compares the conditions on 

the object and those on the contract. 

The following columns can be displayed in the report per condition type or condition group: 

- Unit price 

- Currency 

- Gross/net indicator 

- Resulting net condition amount 

- Resulting gross condition amount 

- Net amount per condition 

- Gross amount per condition 

- Condition amount valid from 

- Condition amount valid to 

The column titles tell you which condition type or condition group the data is for. 

Activities 

Create condition profiles and assign condition types or condition groups to them. The condition types or 

condition groups that are assigned to the same profile can be displayed in different columns in one report 

at the same time. 

Specify the following for each condition type or condition group: 

- Number of the column, in which this condition type or condition group should appear. This is a 

purely technical key. It has to be unique for each column of the condition profile. This number 

determines the sequence of the fields in the ALV catalog. However, you can define the sequence of 

columns in the actual report as you like in the definition of ALV layouts, so the number here does 

not influence the display in the report itself. 

- Condition purpose ( mandatory ): 



 

 

Only those condition values are displayed that belong to the condition purpose entered here. By 

defining condition profiles, in which the only difference in the individual columns is the condition 

purpose, you can, for example, display statistical conditions and actual conditions side by side for 

comparison. Always enter the condition purpose, even if it is not yet a required entry. 

- Condition Group/Condition Type: 

Complete only one or the other of these two columns. Here you enter the condition group or 

condition type for which you want to display the extra columns. 

If you enter a condition group, then all condition amounts for all condition types belonging to this 

group are added together. 

@S@ 

Create special condition groups just for reporting in Customizing under Define Condition Groups 

and Assign Condition Types. This enables you to create easily understandable reports on a given 

topic, such as "Net Rent Without Service Charges" or "Advance Payments." 

All condition types, which are not in a column already defined for the same purpose, are totaled in 

the 'Other Condition Amounts' column. 

If you use different condition groups that contain the same condition types in different columns of 

the same condition profile, then the value is included in the calculation of the total in all columns 

affected. If you do not want this to happen, you have to define the condition profiles so that they are 

separate with regard to directly or indirectly referenced condition types in the columns. 

- Currency 

If you do not make any entry here, the system displays the conditions in the currency in which they 

are defined. If you enter a currency, the condition amount is translated into the currency you entered 

on a key date. 

- Measurement Type 

The system converts the condition amount into the measurement type entered here. This conversion 

does not take place unless the measurement type entered is contained in the measurement profile 

that is linked to the condition profile. 

- Frequency/Frequency Unit 

The condition amount is converted to the frequency entered here when displayed. If you have 

contracts/rental objects in your system that have different frequencies, then you should enter a 

frequency and unit here so that you can compare their values. 

To improve performance, you should limit the number of columns in a condition profile to as few as 

possible. The upper limit set by the system is currently eight columns per condition profile. For 

reports on individual condition types, use the special reports for that purpose or the reports in 

Business Intelligence ( BI ). 

Remember to assign the condition profile to a report profile, since only the report profile can be 

entered on the initial screen. 
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 Configure Fixtures and Fittings Profiles 

Use 

Here you define the fixtures and fittings profile and assign fixtures and fittings to it. 

Additional columns are available for all assigned fixtures and fittings in the report that uses the fixtures 

and fittings profile. 

The following columns can be displayed for fixtures and fittings: 

- Fixtures and Fittings Characteristic 

- Date: Valid from 

- Date: Valid to 

- Fixtures and Fittings Characteristic Is Applicable 

- Number of Fixtures/Fittings Characteristics 

- Additional Value for Characteristic 

- Additional Information 

The column titles tell you which fixtures and fittings the data is for. 

Activities 

Create fixtures and fittings profiles and assign the required fixtures and fittings types to them. The 

fixtures and fittings that are assigned to a profile can be displayed in different columns in one report at the 

same time. 

To improve performance, SAP recommends defining profiles only for those fixtures and fittings that you 

want to see in normal master data reports. 

SAP recommends that you use special reports for fixtures and fittings or the reports of SAP Business 

Information Warehouse for reporting by individual fixtures and fittings. 

Then assign the fixtures and fittings profile to a report profile, since only the report profile can be entered 

on the initial screen. 

If you use fixtures and fittings in the report that are not allowed on the objects being considered, the 

report does not provide any values for these fixtures and fittings. 

 Administer Report Profile (Main Profile) 

Use 



 

 

Here you specify which report profiles should be available to the end user on the initial screen of the 

report. Assign to the report profile a measurement profile and/or a condition profile for rental object 

and/or condition profile for real estate contract. 

The report profile relieves users of the report from having to deal with the individual profiles. Since end 

users only see the report profile and not the measurement profile or the condition profile, they cannot use 

measurement and condition profiles that are not assigned to any report profile. 

The system automatically recognizes which aspects of a report profile can be used in the concrete report, 

and ignores any profiles that are not applicable. For example, if the user selects a profile for a building 

report to which both a measurement profile and a condition profile are assigned, only the measurement 

profile is used (since buildings have no conditions). Therefore, it is not necessary to create special report 

profiles for each object type. 

The report "Occupancy of Rental Objects" compares the conditions of the rental object with those of the 

occupancy contract. With all other reports, either the profile for rental object conditions or the profile for 

contract conditions is used for the conditions, depending on the object. 

@S@ 

To improve performance, SAP recommends defining profiles only for aspects that you would see in 

normal master data reports, such as "residential/usable space" or "number of parking spaces." 

With the conditions, it is recommended that you distinguish between basic rent, advance payments for 

service charges, service charges flat rate, and miscellaneous. 

If you want to analyze across all condition types and/or all measurement types, use the special reports for 

conditions and measurements or the corresponding reports in the Business Information Warehouse. 

Requirements 

You must have created the measurement and condition profiles that you want to use. 

Activities 

Create the required report profiles and enter the measurement and/or condition profile. For each profile, 

enter a layout group. You can name it anything you want. ALV layouts can only be reused within the 

same reports and within the same layout group. 

Example 

The layout group is purely technical and cannot be seen by end users. It is recommended that you name it 

systematically: Assume the following report profiles are defined: 

PROFA, measurement profile FL, condition profile GRM 

PROFB, measurement profile FL_ST, condition profile ALL 

PROFC, measurement profile FL, no condition profile 
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PROFD, no measurement profile, condition profile ALL 

PROFE, measurement profile FL, condition profile VGL 

Assume the condition and measurement profiles are defined as follows (in the following, "condition 

group" stands for a logical column that is assigned to the condition profile. The basis for this column can 

be a condition group or a concrete condition type, or the special case of "other conditions"). 

FL:  Measurement type (residential/usable space) 

FL_ST:  Measurement types (residential/usable space, number of parking spaces) 

ALL:  Condition group (all "ledger" conditions) 

GRM:  Condition groups (basic rent, other) VGL:  

Condition groups (basic rent, statistical rent) 

The assigned layout groups could be as follows, for example: 

PROFA: BK 

PROFB: BK 

PROFC: BK PROFD: 

BK 

PROFE: BK 

In this case, layouts created for a report using the report profile PROFA could be reused for 

PROFE. If the settings affect the layout condition columns, the settings for the condition group "basic 

rent" are transferred to the basic rent of the report with profile PROFE, and the settings made for the 

condition group "miscellaneous" are transferred to the "statistical rent" ( and vice-versa). 

Note 

Avoid changing the layout group in Customizing afterwards! If you do so, you can no longer access the 

layouts that you defined for reports with report profiles of the old group! 

 Status Selection 

 Status Selection Profile 

Use 

Note that the examples in the following text are from Classic RE. However, the explanation still applies 

for Flexible Real Estate Management ( RE-FX ). 

When calling up evaluations, you can specify a status selection profile. 

This enables you to select Real Estate objects with a certain system  or user status in a report. 

In this step you define status selection profiles which you use to specify status combinations for the 

selection of objects. A status selection profile is especially useful when you repeatedly select a large 

number of objects according to the same selection criteria, for example, requests for printing documents, 

for collective release or for the creation of request evaluations. 



 

 

Selection procedure 

The selection conditions are evaluated topdown. The following rules apply: 

- Several consecutive lines joined with OR become a block and are evaluated together. The block 

must fulfil at least one selection condition. 

- AND links this type of block as well as individual conditions. All blocks linked with AND or 

individual conditions must be fulfilled. An object is rejected as soon as a block or an individual 

condition is not fulfilled. This means that each AND that is inserted causes parentheses to be placed 

around the preceding statements. In order to select the required status combinations you may have to 

adjust the selection conditions. 

- To summarize: OR is stronger than AND! 

Example 

You want to define a status selection profile for selecting rental units with the following status 

combinations: 

- REL ( released ) 

- PROP AND ACRA (for own use and active rental agreement exists) 

You use the following formulation: 

REL OR (PROP AND ACRA) 

However, the system interprets it in the following way: 

(REL OR PROP) AND ACRA 

This results in the selection of the rental units with the following status combinations: 

- REL AND PROP 

- CRTD AND ACRA 

Therefore, you have to adjust the formulation in the following way: 

(REL OR PROP) AND (REL OR ACRA) 

State of status "Active", "Inactive", "Never active" 

You can also carry out the selection according to a specific status state: 

- If you set the state to Active, the system searches for objects whose status is currently active. 

- If you set the state to Inactive, the system searches for objects whose status is currently inactive. 

- If you set the state to Never active, the system searches for requests whose status has never been 

active. 

Example 

The following is an example of a status selection profile that is to select all released rental units which are 

either for own use or used by a corporate group: 
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Link Status Status 

 REL (released) active 

AND PROP (for own use) active 

OR GRPR (used by group) active 

The selection is carried out in two steps: 

- First, all released rental units are selected (rental units with the active status "REL"). 

- Then, the system selects from this list all rental units with the PROP or GRPR status. 

"Not" indicator 

You can use this indicator to simplify the maintenance of selection conditions in certain cases. Some 

status conditions are easier to display when the "Not" indicator is set. 

Example 

Selection condition without "Not" indicator: 

Link Not State  

<Status> _ Inactive 

OR <Status> 

Same selection condition with "Not" indicator: 

_ Never active 

Link Not State  

<Status> X Inactive 

Recommendation 

To minimize selection time, conditions which greatly limit the selection should be placed at the beginning 

of the status selection profile. 

System status / User status 

In a status selection profile; you can specify both the system status and the user status. If you wish to 

select objects according to user status you have to specify the corresponding status profile. 

Once you have maintained a status profile; in the status selection profile you have to assign this status 

profile to all objects; the selection will only be limited by the status selection profile if the status profile is 

assigned to all the objects. Any system status that you assign in addition to the status profile will not be 

considered by the system if the status profile is not assigned. 

Language dependency of the selection profile 

Once a selection profile is created in a language it can be used in all languages defined in the system. If 

user statuses are defined in a selection profile, make sure that they are translated in the corresponding 

status profile.  If no translation exists, you have to enter the user status in the language in which it was 

created. 



 

 

 Default Values by Object Type 

Use 

Here you specify which selection profile of a report is used as the default. For example, you can define a 

selection profile that excludes objects from the report if the deletion flag is set for them. Then you can set 

this profile as a default. 

 SAP Business Information Warehouse 

 Status Concept 

The status concept allows you to represent SAP status objects in BW. The system can transfer system and 

user statuses from the ERP system to BW. 

In the following steps: 

- To make the SAP default settings available in the productive client, carry out an import from the 

Customizing client for Customizing table BWCUSYSTAT (system status) before the production 

start-up. 

- Assign the ERP status objects to a BW status object. 

Use either a standard BW status object, or create a user-specific BW status object. 

- Generate a DataSource for the BW status object. 

Background Information 

ERP master data usually shows all statuses currently active for an object. Any number of statuses can be 

active simultaneously. 

However, there are some status values that are mutually exclusive, so that only one of them can be active 

at any one time. 

For projects, for example, these statuses include the following: 

- Created 

- Released 

- Technically complete 

- Complete 

You can define a BW status object for these statuses in the source system, in Customizing for 
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BW. 

The statuses are combined under a four-character key. A sequence number is assigned to each status for 

the internal representation of the status value in BW. 

A BW status object can depict either a group of system statuses or a group of user statuses. Use 

transaction BWS in the case of system statuses or BWS in the case of user statuses. 

Additional Hints 

For detailed information on the status concept and implementation, see note . 

 Maintain BW Status Object for System Status 

In this work step, you assign a BW status object to an ERP system status object. You can assign any 

number of ERP system status objects to a BW status object. 

Requirements 

To make the SAP standard settings available in the productive client, carry out an import from the 

Customizing client for the Customizing table BWCUSYSTAT (system status) before the production start-

up. 

Activities 

1. Choose New Entries. 

2. If you want to add an assignment to a standard BW status object, enter the name of the standard BW 

status object. 

3. To create a new BW status object, enter any four-character name for the BW status object. 

4. Choose the ERP system statuses that you want to assign to the BW status object. 

5. Save your entries. 

 Maintain BW Status Object for User Status 

In this work step you assign a BW status object to ERP  user status objects You can assign any number of 

ERP user status objects to a BW status object. 

Activities 



 

 

1. Choose New entries. 

2. If you want to make an assignment to a standard BW status object, enter the name of the standard 

BW status object. 

3. If you want to create a new BW status object, enter any four character name for the BW status 

object. 

4. Choose the ERP user status that you want to assign to the BW status object. 

The system assigns the corresponding status profile to the user status automatically. 

5. Save the entry. 

 Generate Data Source for a BW Status Object 

In this workstep you generate an info object for a BW status object. 

Activities 

1. Enter the four character abbreviation for the BW status object. 

2. Enter a description for the BW status object. 

This will be used in the BW as a column description. 

3. If you want to assign an info object to an application, enter the name of the application. 

If you do not want to assign an info object to any application, enter the abbreviation SAP-R/-IO. 

Assignments help to search info objects in the BW. 

4. Choose Generate. 

The system produces 

- an info object with the name STATUS + four character status abbrev and - a data 

element with the name BWST + four character status abbrev. 

 Enhancements 

 Implement Enhancements (BAdI): Influence Expenditure List 

Use 
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The Business Add-In (BAdI) provides the following options: 

- You can use the method CHANGE_OUTPUT_DATA to modify the output table that an 

information system report transfers to the SAP List Viewer. This means you have the option of 

adjusting the values determined by the report to meet your requirements. In addition, the BAdI 

supports enhancements to the output structure without your having to write program code. There 

you can fill the fields that were added to the output structures using append. 

- You can use the method CHANGE_DISPLAY_OPTIONS to adjust the output characteristics 

(field catalog, print properties, layout, and so on). 

- You can use the method SET_ALV_GRID to set a default value for the 'Grid Control' indicator. 

- You can use method CHANGE_TOOLBAR_BUTTONS to add new buttons with assigned 

function codes to the toolbar. 

- You can use method PROCESS_TOOLBAR_FUNCTION to implement the associated functions. 

The report ID (data element REISREPID) is used as the filter criterion for the BAdI. It identifies the 

report that has been started. Table TIVISREP contains an overview of the report IDs. The table also tells 

you which structure is assigned to a report. 

Exceptions: 

For "Information System: Actual Line Items - Contracts", you use the value "COLICN" as REPID, and 

for "Information System: Actual Line Items Master Data", the value "COLIBD". 

For the information system service charge settlement, the default setting for the grid indicator is 

configured in Customizing for service charge settlement. 

Example 

You can access an example implementation in the BAdI Builder by choosing Goto -> Sample code -> 

Display. 

Notes for Developers 

 Implement Enhancements (BAdI): Default Values Selection Screen 

Use 

When you call the info system programs directly from the object on the Overviews tab page, it is not 

possible to manually set the selection parameters. The Business Add-In (BAdI) allows you to modify the 

selection parameters (that is, their default values). 

The report ID (data element REISREPID) is used as the filter criterion for the BAdI. It identifies the 

report that has been started. Table TIVISREP contains an overview of the report IDs. 

The BAdI is called for the following reports: 

- Overviews of Parcel 



 

 

Activities 

Create a BAdI implementation. Implement the method SET_ADDITIONAL_PARAM and fill the filter 

with the appropriate values. Then activate the BAdI implementation. 

Example 

You can access an example implementation in the BAdI Builder by choosing Goto -> Sample code -> 

Display. 

Notes for Developers 

 Implement Enhancements (BAdI): Set Generation Based on Other Fields 

Use 

Using this Business Add-In (BAdI), you can use your own grouping fields for set selection. 

You can use this BAdI for three reports: 

- Generation of sets for usage objects (transaction REEXSETGENBD) 

- Generation of sets for real estate contracts (transaction REEXSETGENCN) 

- Generation of sets for settlement units (transaction REEXSETGENSU) 

Activities 

1. Structure enhancement 

If you also want to generate sets according to other grouping fields, then first add an 

APPEND containing these grouping fields to the structure of the object. The following 

structures exist for the objects: 

- REBD_BUSINESS_ENTITY_SET for the business entity 

- REBD_PROPERTY_SET for land 

- REBD_BUILDING_SET for buildings 

- REBD_RENTAL_OBJECT_SET for rental objects 

- RECN_CONTRACT_SET for contracts 

The APPEND structure must contain the component that you want to use for generating sets. This 

component can have a maximum of  characters, since the content of the component is used for the 

name of the sets. 

2. BAdI Implementation 

Create a BAdI implementation and implement the method COMPLETE_OUTPUT_DATA. 

In this method you fill the field from your APPEND structure with the necessary content. You can 

also remove or add selected objects here, if you wish. Then activate the BAdI implementation. 
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Example 

You can access an example implementation in the BAdI Builder by choosing Goto -> Sample code. 

Note that that grouping in a set generation run can only take place based on one field. If you want to 

group based on several fields at the same time, then you have to summarize them in one field. 

Notes for Developers 

 Implement Enhancements (BAdI): Tenant Account Overview 

Use 

The Business Add-In (BAdI) makes it possible to enhance or modify the output of the tenant account 

overview, for example, adding fields or modifying text. For example, you can also make fields of Dispute 

Management available ('Dispute Case'). 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. Then 

activate the BAdI implementation. 

- MODIFY_ITEM_LIST: Change of item overview 

In the MODIFY_ITEM_LIST method, you can change the data of the item overview. This method 

is called after data selection and formatting of the standard list. The complete output list is 

transferred in the CT_ITEM_LIST parameter. It can be changed in the method. 

- MODIFY_ACCT_STATEMENT: Change of balance history 

You can change the data of the balance history in the method.  This method is called after data 

selection and formatting of the standard list. The complete output list is transferred in the 

CT_ACCT_STATEMENT parameter. It can be changed in the method. 

- MODIFY_OI_ACCT_DETAIL: Change of detail data for account (such as, customer) You can 

modify the detail data of the customer account in the method. 

To display your own fields on the detail screen, you first have to add the fields you want to the 

DDIC structure REEX_ACCT_SHEET_OIACCT_DET_S in an append structure. 

After that you can fill the fields in this method. 

The IT_ACCT_STATEMENT importing parameter contains the balance history data. The data for 

the item overview is available in the IT_ITEM_LIST importing parameter. 

- MODIFY_SUMMARY:  Adjustment of overview data of tenant account sheet  

In this method, you can adjust the data summarized together in the tenant account sheet by 

overwriting values already calculated, or adding your own values. 

To include your own values in the display, you first have to add the fields you want to an append 

structure and append it to the RERA_ACCT_SHEET_SUMMARY DDIC structure. After that you 

can fill the fields in this method. The importing parameter IS_SEL_OPT contains the current 

selection criteria for the contract account sheet; importing parameter IT_ITEM_LIST contains the 



 

 

selected line items. For user-defined fields to be displayed in the master data dialog of the contract 

(Overviews -> Tenant Account -> Summary), the MODIFY_GRID_SUMMARY method also has to 

be implemented. 

- MODIFY_GRID_SUMMARY:  Adjustment of output of overview data of tenant account 

sheet  

In this method, you can change the display of the summary, for example by switching or 

omitting rows. You can also display new fields that were filled using 

MODIFY_SUMMARY. 

For information on using BAdIs, see this documentation. 

Notes for Developers 

 Performance: Control Parallel Processing 

Use 

Reports that read large amounts of data often have long processing times. To improve the processing time 

for such reports, you can split the task of reading data across a number of processes. Here, you can set for 

each report how many work processes are to be triggered that are to retrieve data in parallel. 

For reports that you frequently start for large amounts of data, configure the settings for the number of 

processes and the size of the data packages for each process. Which settings for which reports result in 

the best results in your system depends primarily on the amounts of data and the number of work 

processes available. This means you need to record values used and adjust these values based on your 

experience, where applicable. 

 Tools 

 Define Groups Responsible 

Use 

All master data objects, contracts, as well as reminder dates in SAP Real Estate Management are assigned 

persons responsible (users). This enables these objects to be accessed, for example, in the RE Navigator 

via "My Objects" or in the information system via the selection by person responsible. 

Selection by group responsible also enables objects to be accessed in the RE Navigator, in the lists of 

reminders, and in reporting for a group responsible. 

A group responsible comprises a number of users responsible.  In the case of selection by group 

responsible, all objects or reminder dates that are assigned to one of the members of the group are 

displayed. 
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Requirements 

The user groups are visible in the application only if at least one group is maintained. 

Example 

The users NEUMANN, MAYER, and KUNZMANN are entered as the person responsible in various 

objects that lie in the postal code zone  in Berlin. The three colleagues are to substitute for each other. 

Create a "Group Responsible" called BER and assign the three named users to this group. 

The colleagues can now, for example, in the RE Navigator, call up not only their own objects but those of 

their colleagues by selecting "Objects of Group Responsible" = BER. 

 Check RE Customizing 

Use 

There are checks you can run for certain Customizing settings in Flexible Real Estate Management. You 

can start these checks here. 

Activities 

- To execute all existing checks, do not make any changes on the initial screen, and choose Execute. 

- If you want to limit the check to certain areas, choose the check you want using the input help for 

the Customizing Check field. If the area you want also has sub-areas, then the system always 

includes these in the check as well. Therefore, do not enter an asterisk (*) as a placeholder. 

- The Language field is relevant for checks that are language-dependent, such as for correspondence. 

- Deselect the Display Warnings/Errors Only indicator, if you want the system to also display 

information messages. The information messages show, among other things, which checks were 

performed successfully. 

- Set the Save Log indicator, if you want to be able to display the log for completed checks later. 

The system runs the checks. In the upper window, it displays how many messages of each error category 

occurred. This is shown in a hierarchical form. You can display a given message in the lower part of the 

window by double clicking on it. By double clicking on the message in the lower part of the screen, you 

can have the system display the long text for the message (if there is one). 

You can go directly to the Customizing dialog, where you can display and correct the data that was 

checked. To do so, choose @@ with the quick info text Detail in the row of the message. 



 

 

 Configurable Messages 

 Change Message Control 

In this IMG activity, you set the appearances of system messages to meet your requirements. 

You can do the following: 

- Determine the message type (error, warning, note) 

- Deactivate messages completely 

You can also make different settings for online and background processing. 

The corresponding determinations can apply to a client or to an individual user if necessary. 

Recommendation 

Use standard system messages at the beginning. If a changeable message appears, you have the option of 

branching to message maintenance from the message long text. 

Activities 

1. Enter the work area from which the messages come. In Controlling, enter "KI" for CO checks. 

2. Choose "Edit -> New entries". 

3. Enter the following data: 

- Message number 

Note that you can change only certain messages in a work area; others are fixed. 

- User name 

If you enter a name, the settings are valid for this user only. If you enter a blank space, the 

settings are valid for all client users. 

- Message type 

Enter the given message type. 

- Save your entries. The message texts are automatically implemented. 

Note on transport 

To transport settings for message transport manually, choose "Table view -> Transport". 

 Implement Differentiation of Message Control 

Use 
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Certain messages can be configured using transaction OBA. You can define a different error type for each 

message (for example, warning or information instead of error) or hide the message. You do not need an 

implementation for this. 

However, if you want to define the error type based on specific attributes of a real estate object (for 

example, dependent on contract type), you need to implement this Business Add-In. 

The message classes in Flexible Real Estate Management (RE-FX) conform to the search string RE++++. 

The plus (+) character stands for one letter. You can only change messages with this Business Add-In if 

the messages can be configured using transaction OBMSG. 

Activities 

Create a BAdI implementation and implement the methods you require for your enhancement. 

Example 

Class CL_EXM_IM_RECA_MESSAGE contains a sample implementation. To display the sample 

implementation, choose Goto -> Sample Code -> Display. Notes for Developers 

 Technical Number Ranges 

 IMKEY Number Range 

Use 

The IMKEY field is used to encrypt real estate objects for accounting. The system assigns the IMKEY as 

soon as a real estate object is released for posting. 

Standard settings 

In the standard system, the number range is set up as follows: Number 

range , from number , to number  The system assigns the numbers 

internally. 

You are not allowed to change the number range. 



 

 

 INTRENO Number Range 

Use 

Real estate objects receive a unique key (field INTRENO) for internal purposes. Internal number 

assignment is used. 

Standard settings 

The number ranges are set up for all object types as follows: 

Number range , from number , to number , internal number assignment. 

You are not allowed to change the number ranges. 

Activities 

Use this transaction only to maintain missing number ranges for affected object types if an error of that 

kind occurs in the application. 

 Technical Views of Customizing Tables 

Use 

The menu option contains technical views for editing special Customizing entries. Here, you can 

postprocess tables that contain entries related to deleted check entries, for example. 

 Enhancements 

 Implement Enhancements (BAdI): BDT 

Use 

The BAdI is called in BDT dialogs in Real Estate Management. 

- Method BDT_FRAME_GET_SCREEN_SEQUENCE 

makes it possible to specify a specific screen sequence of the BDT dialog. 

- Method BDT_APPL_AFTER_CREATE_POPUP 

makes it possible to execute additional actions (such as displaying an additional popup) when 

creating an object. Notes for Developers 
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 Implement Enhancements (BAdI): Authorization Checks 

Use 

You can use this Business Add-In (BAdI) to enhance the authorization check for the master data of the 

following real estate objects: 

- Business entity 

- Building 

- Land 

- Rental object 

- Real estate contract 

- Architectural object 

- Settlement unit 

- Adjustment measure 

- RE search request 

- Offered object/reservation object 

- Contract offer 

In addition, you can use this BAdI to check FI and CO transactions in the posting interface. 

Activities 

Create a BAdI implementation and implement your authorization check. Then activate the BAdI 

implementation. 

- CHECK_AUTHORITY Method: 

This method is called when someone tries to create, change or display one of the above real estate 

objects. At the time of the call, substitutions were already executed. The IO_OBJECT parameter 

contains the instance of the given real estate object. Using the API module for the object makes 

accessing the current attributes of the object possible (even if these were not yet saved). 

The ID_AUTH_OBJECT and IS_AUTH_PARAM parameters contain the parameters used for 

standard authorization checks. 

- CHECK_AUTHORITY_FOR_BUS_TRANS Method: 

You can use this method to check authorizations in conjunction with FI and CO postings. The 

ID_TRANS parameter contains the current transaction, if it is available. Notes for Developers 



 

 

 Implement Enhancements (BAdI): Control Processes 

Use 

Using this BAdI you can intervene in the control of processes. 

Caution: 

Be aware that this BAdI is executed for each process. Therefore it is imperative that you query the type of 

process. 

Examples of processes: 

ORPO    Posting of continuous occupancy 

ORRS    Posting of reservations REAA    

Assessment adjustment 

REAJ   Adjustment of conditions 

REAL    Accrual/deferral 

RECO    COA settlement 

REIT    Input tax distribution 

REIV    Creation of invoices 

REOP    One-time postings 

REOR    Option rate determination 

REPP    Periodic posting: contracts 

RERV    Reversal process 

RESA    Accrual/deferral of service charges 

RESC    Service charge settlement 

RESR    Sales-based settlement 

RETC    Input tax correction 

RETN    Tenant settlement of COA 

REVP    Periodic posting: objects 

Note that within a process other processes can be active. For example, in the process "Accrual/deferral 

of service charges" processes are built up for service charge settlements. The BAdI interface makes 

the following methods available: 
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- IS_REVERSE_ALLOWED: Using this method you can control whether a process is allowed to be 

reversed. You can, for example, implement additional checks in order to prevent processes, for 

which you have executed customer-specific follow-on actions, from being reversed. 

- IS_STEP_EXECUTEABLE: Using this method you control whether substeps of a process can be 

executed. For example, if you want to prevent the results of a settlement from being posted unless an 

approval is entered in a customer-specific table, you can intervene here. 

Notes for Developers 

 Implement Enhancements (BAdI): Occupancy 

Use 

Use this BAdI if you want to change the data of the occupancy history of a rental object. 

Requirements 

The data of the occupancy history of the rental object were changed by another object. This is the case, 

for example, when an offer was created for the rental object, or the validity of a building was changed. In 

that case, the SUBSTITUTE method for the rental object is not run. 

Standard settings 

Only change the data for vacant time periods (ISVACANT = 'X'). 

Activities 

Implement the method CHANGE_OCCUPANCY and change the parameter CT_VIBDROOCC_NEW. 

Example 

There is an example in the related example class CL_EXM_IM_REBD_OCCUPANCY. Notes for 

Developers 



 

 

 Search Strategy 

 Define Search Strategy 

Use 

You can specify the search strategy generically here for each supported search field. 

Activities 

First select the search field. Then proceed as described in the specific IMG activity for the search field: 

- Vendor for Posting Activity 

- Service Charge Key of Posting Activity 

- Land Registry 

- Agency Responsible for Parcel 

 Specify Values for Search Strategy 

Use 

You can enter generic values for each defined search strategy here (for each supported search field). 

Requirements 

The search strategy is active and entering values for it is allowed (see Define Search Strategy). 

Activities 

First select the search field and choose Propose Values. Then proceed as described in the specific IMG 

activity: 

- Vendor of Posting Activity 

- Service Charge Key of Posting Activity 

- Land Registry 

- Agency Responsible for Parcel 
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 Client-Dependent Text Modules 

 Client Copy of Text Modules for RE-FX 

Use 

SAP provides text modules, for example for 

- Predefined renewal rules (refer to this Customizing activity) 

- Predefined notice procedures (refer to this Customizing activity). 

These text modules are client-dependent. Following a system installation, the text modules are in client . 

To make the text modules (those provided by SAP and any you created in addition) available to a 

different client of the same system, copy the text modules using this program. 

To place text modules in a transport request or to edit them directly (expert tool), refer to this 

Customizing activity. 

Text modules within an SAP System are identified by their client, text object, text ID, and language, in 

addition to the text module name. In the Flexible Real Estate Management component, the text object  

RE is used for all text modules. 

You can manage text objects and text IDs using transaction SE. However, this is not absolutely required 

for creating new texts. 

 Manage Text Modules 

Use 

Text modules are client-dependent. They are used within Customizing, for example for standard renewal 

rules and for standard notice procedures. In the application data area, they are used for memos, additional 

texts, and so on. 

Using this program, you can place these texts in a transport request. In addition, you can edit, copy and 

delete texts in a sort of expert tool. 

To execute a client copy of texts within the same system, refer to this Customizing activity. 

Text modules within an SAP System are identified by their client, text object, text ID, and language, in 

addition to the text module name. In the Flexible Real Estate Management component, the text object  

RE is used for all text modules. 



 

 

 Archiving 

 Define Residence Times for Archiving 

Use 

Data Archiving reduces the data volume in your production system by removing data that is no longer 

needed for current work, but should be available in case of inquiries. 

For deleting data that was created in error and not actually used, you can use the Deleting Real Estate 

Objects Without Archiving function, rather than data archiving (refer to the Implementation Guide ). 

For an overview of data archiving of real estate master data and contracts, refer to this text. 

Activities 

In this IMG activity, you specify residence time  and residence time  for data being archived per object 

type. 

Example 

 Activate Archive Information Structures 

Use 

For you to also be able to display archived data in the normal display transactions ( for example, in the 

RE Navigator), you have to activate certain Archive Information Structures. 

Using an Archive Information Structure, the system can create and manage an index table for the archived 

data objects, so that performance is good when the archived data is accessed. 

The Archive Information Structures are redundant and are not a prerequisite for archiving itself. The 

system can also build the index data at a later date for existing archive files. 

Standard settings 

In the standard system, the Archive Information Structures listed below are inactive. 

Activities 
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You need the following Archive Information Structures in the display transactions in order to be able to 

display archived data: 

Info Structure Description Object 

SAP_REFX_AO Architectural object REFX_AO 

SAP_REFX_BE Business entity REFX_BE 

SAP_REFX_PR Land REFX_PR 

SAP_REFX_BU Building REFX_BU 

SAP_REFX_RO Rental object REFX_RO 

SAP_REFX_ROCF Cash flow of rental objects REFX_ROCF 

SAP_REFX_CN Real estate contract REFX_CN 

SAP_REFX_CNCF Cash flow of contracts REFX_CNCF 

SAP_REFX_PG Participation group REFX_PG 

SAP_REFX_SU Settlement unit REFX_SU 

SAP_REFX_CG Comparative group of appartments REFX_CG 

SAP_REFX_AT Adjustment measure REFX_AT 

SAP_REFX_RR RE search request REFX_RR 

SAP_REFX_OO Offered object REFX_OO 

SAP_REFX_OF Contract offer REFX_OF 

SAP_REFX_PL Parcel REFX_PL 

SAP_REFX_RC Parcel update REFX_RC 

SAP_REFX_LR Land register REFX_LR 

SAP_REFX_JL Joint liability REFX_JL 

SAP_REFX_PE Other public register REFX_PE 

SAP_REFX_NA Notice of assessment REFX_NA 

SAP_REFX_RADOC RE invoice REFX_RADOC 

SAP_REFX_SCSE Service charge settlement REFX_SCSE 

To activate an Information Structure, enter the name of the structure and choose @C@ Activate (with the 

quick info Activate). 

This can also be done in the Archive Retrieval Configurator ( SARJ ) 

In addition, you can create new Information Structures to make other views of archived data possible. 

You can then access this data using the Archive Explorer(SARI). 

 Archive Administration 

Use 



 

 

Archive administration (transaction SARA) is the initial screen for all transactions relevant to archiving. 

From here you can start the preprocessing, write and delete programs, and also make the central 

Customizing settings for archiving. 

The technical names of the archiving objects for Flexible Real Estate Management begin with REFX_ 

(for example, REFX_CN for the Real Estate contract). 

The technical names of the archive information structures for Flexible Real Estate Management start with 

SAP_REFX_. SAP provides one archive information structure for each archiving object in the standard 

system (for example, SAP_REFX_CN for the real estate contract). 

 Deletion of Real Estate Objects Without Archiving 

Use 

The Delete function is particularly useful for easily removing any real estate objects created by mistake. 

You can perform the function within the RE Navigator. 

This function deletes the data irretrievably from the database. 

However, the system ensures that a real estate object is deleted only when specific prerequisites are 

fulfilled. In particular, there should not have been any posting to the object. To remove any objects that 

have already been posted, use the Archive function instead. 

Real estate objects with the following object types can be deleted without archiving: 

- Business Entity - see Prerequisites 

- Property - see Prerequisites 

- Building - see Prerequisites 

- Rental Object - see Prerequisites 

- Architectural Object - see Prerequisites 

- Real Estate Contract - see Prerequisites 

- Participation Group - see Prerequisites 

- Settlement Unit - see Prerequisites 

You can use this Customizing activity to deactivate the function for an object type in general. 

Prior to deletion, the system also runs an authorization check for each object to ascertain whether the 

current user has authorization to perform the deletion (). Furthermore, a check is run to see whether the 

transaction RE: Delete object is permitted by status management. By setting a user status, you can also 

prevent specific objects from being deleted. 

Additional Hints on Deleting Without Archiving 

Standard settings 



______________________________________________________________S

AP System  

______________________________________________________________  

SAP AG 661 

By default, the delete function is active for all object types. 

Activities 

Deactivate this function where required for the desired object types. 

 Legacy Data Transfer 

Use 

Legacy data transfer is used to transfer data from a legacy system into the SAP system. 

Activities 

- Use the Data Transfer Workbench (transaction SXDA) to plan and execute the legacy data transfer. 

The only interfaces used for RE-FX are BAPIs. 

These BAPIs are called up automatically by transaction SXDA (after appropriate configuration) 

during legacy data transfer. Since BAPIs are function modules, you can also call up the BAPIs 

directly in your own reports. 

SAP makes BAPIs available for creating, changing and getting data for the master data objects and 

the real estate contract. 

To display all BAPIs for RE-FX, search for modules with the names BAPI_RE_* in SE. 

Alternatively, you can display all BAPIs using the transaction BAPI when you select the entry All 

after choosing Goto -> BAPIs to Display from the menu. 

The BAPIs have the function of direct input programs. Therefore, no direct input programs are 

necessary for RE-FX. Batch input cannot be used to record and process master data processing 

because of the configurable interfaces. 

- There is an iTutor on legacy data transfer for RE-FX in the SAP Service Marketplace at 

service.sap.com under Real Estate / Flexible Real Estate, iTutor Data Transfer. 

- For more information on the Data Transfer Workbench, see the SAP Library under SAP 

NetWeaver Components --> Cross-Application Functions --> Data Transfer Workbench. 

- Use the Legacy System Migration Workbench (transaction LSMW), which you can also access 

using SXDA, to define a mapping of data structures from the legacy system with the SAP data 

structures. 

The documentation on the Legacy System Migration Workbench is in the SAP Service Marketplace 

at service.sap.com /LSMW. 

 Control of Creating Mandates: Exclude Tables 

Use 

When you create a mandate company code, the Customizing settings of the reference company code are 

copied based on rules that are predefined in the system. For example, it is predefined that the house bank 



 

 

data is not copied from the reference company code. Instead it is copied from the mandate master data. 

Other Customizing table entries, on the other hand, are copied completely. 

In exceptional cases, it might be necessary to make certain settings separately for each mandate company 

code. In that case, those settings should be kept from being overwritten by the data of the reference 

company code when the mandate company code is created or updated. 

To prevent these tables, which you should process separately for each company code, from being 

overwritten during copying, you should enter them in the table for the given reference company code 

(adding to the system logic). 

 Other Settings 

 System Settings for Master Data Dialogs 

 Colors and Icons 

 Icons 

Use 

In this section, you assign icons to areas. 

In Flexible Real Estate Management, master data structures are often represented in the form of 

hierarchical structures. In these structures, different object types are represented by icons. Icons are also 

used in other contexts to assist visualization. 

Requirements 

The following areas and their IDs are predefined: 

- Object type 

- Architectural object type 

- Term category 

- Term group 

- Other 

Activities 
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Normally you can adopt the predefined icons. However, if you want to make changes, follow this 

procedure: 

For icons for object type, term category, term group, and other, choose the icon you want using the input 

help. The field remains empty. The number of the icon is displayed in the next field, the icon itself is 

shown in the following field. You assign icons for architectural object types separately in the Assign 

Icons to Architectural Object Types IMG activity. 

If icons are not already predefined, you can copy those from client . Choose Utilities -> Adjust. 

Example 

@A@ Icon Area "Object Type": Business Entity 

@U@ Icon Area  "Term Category": Notice 

@JL@ Icon Area  "Term Group":  Posting Data @AD@ Icon 

Area "Other": Vendor Partner 

 Color Settings 

Use 

You can use colors in list displays to help distinguish the meaning of entries at a glance. In the display of 

time-dependent data, for example, you can use different colors to distinguish entries for past time 

periods from entries for the future. The settings for distinguishing past (historical) and future entries can 

be used, for example, in the following master data dialogs: 

- Measurements (architectural object, business entity, building, property, rental object...) 

- Partners (all objects) 

- Fixtures and fittings characteristics (building and rental object) 

In addition, you can set a color for the main business partner role, to make this role more prominent. If a 

contract type allows two main business partner roles, you can highlight them using two different colors. 

In this step, you can change the existing color settings. 

Requirements 

The following color types are predefined: 

- Date: Current entries 



 

 

- Date: Future entries 

- Date: Past entries 

- Main business partner  

- Main business partner  

Activities 

To set a color, choose a number between  and  in the main window, and if you wish, set the Highlighted 

and Inverted indicators. Choose Enter. 

In a modeless window, the system shows how the color will appear on the screen. If you want to change 

the existing colors, try the combinations that are available until you have the combination you want. 

Save your settings. You cannot close the window continaing the colors directly. It is closed automatically 

when you leave the main dialog. 

 User Interface 

Use 

In this activity, you make settings for the interface of the RE Navigator. 

Activities 

Navigation: Settings for the initial screen and for the navigation area 

- Initial screen 

- Hide Navigation Area: Set this indicator if you want the navigation area for the RE Navigator to be 

turned off as a default.  You still turn it on again in the RE Navigator and in each master data dialog 

by choosing Navigation Area On/Off. 

- Display of Navigation Area: You can have the system display the navigation area as a fixed part of 

the screen (choose: As Part of Window) or in a separate window. 

- Direct Display of Objects 

- Use Standard Icons 

- Maximum Number of "Last Objects" 
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General: Settings for error list 

- Here you decide if the error list should appear in a separate window.  You can also specify that 

errors be displayed hierarchically. However, this is only possible if the error list is displayed in a 

separate window. 

Contract: Settings for the worklist for processing contracts 

- Here you set a default for which contracts are displayed when you call contract processing - either 

your own contracts only, or all contracts in the system. You can limit the number displayed to ten. 

 If you do not  set the Use System Settings indicator in the RE Navigator, you can change all of the 

settings in the Navigator that were made here in Customizing. Choose: 

RE Navigator  -> Extras -> Settings 

Note 

The settings you make here are not transported, so they have to be made separately in each system. 

 Background Graphic 

Use 

In this activity, you can make settings for the background picture that is displayed in the master data 

dialogs. 

Requirements 

These settings are not relevant unless you chose Display Background Picture for the initial screen in the 

User Interface IMG activity. 

Standard settings 

Several background pictures and a default initial screen are available. 

Activities 

To use your own picture instead, choose Specify Own Graphic in the Background Picture field. The Own 

Background Graphic field is then available for input. 

You specify how the picture is displayed in the Display Mode field. 

Note 



 

 

The settings you make here are not transported, so they have to be made separately in each system. 

 Folder for Temporary Data 

Tempory data from various programs is stored on the system level in files. Specify where this data is to 

be stored. 

This file is also used for the data medium exchange used for external heating expenses settlement. 

 Number Range for Logs in SAP Application Log 

Use 

Certain processes in Flexible Real Estate Management (RE-FX) use the SAP Application Log as a basis 

when writing their logs. In order to generate a log, the system requires an internal number. In this step, 

you set up the number range from which this number is taken. 

Standard settings 

SAP provides the number range interval with the number'.'  Generally you do not need to change this 

setting. 

Activities 

If there is no number range interval '' yet, create it. Choose Internal Number Assignment by deselecting 

Ext. Choose the number range from  - . 

 

 

 

 Notes on Required Periodic Procedures 

Use 

Required background job 

RECDCGOL - Cash Flow Update for Contracts 

For more information, refer to the documentation of report RFVICF in Classic RE. 

@@ The report for updating occupancy history, which is also mentioned in this documentation, is not 

relevant in RE-FX.  



 

 

 

 


